Citrix Gateway 13.0
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Gateway Release Notes</td>
<td>3</td>
</tr>
<tr>
<td>About Citrix Gateway</td>
<td>3</td>
</tr>
<tr>
<td>Citrix Gateway Architecture</td>
<td>4</td>
</tr>
<tr>
<td>How User Connections Work</td>
<td>6</td>
</tr>
<tr>
<td>Common Deployments</td>
<td>8</td>
</tr>
<tr>
<td>Deploying in the DMZ</td>
<td>9</td>
</tr>
<tr>
<td>Deploying in the Secure Network</td>
<td>11</td>
</tr>
<tr>
<td>Client Software Requirements</td>
<td>11</td>
</tr>
<tr>
<td>Citrix Gateway plug-in System Requirements</td>
<td>12</td>
</tr>
<tr>
<td>Endpoint Analysis Requirements</td>
<td>13</td>
</tr>
<tr>
<td>Compatibility with Citrix Products</td>
<td>15</td>
</tr>
<tr>
<td>Licensing</td>
<td>16</td>
</tr>
<tr>
<td>Citrix Gateway License Types</td>
<td>17</td>
</tr>
<tr>
<td>Obtaining Your Platform or Universal License Files</td>
<td>18</td>
</tr>
<tr>
<td>To install a license on Citrix Gateway</td>
<td>19</td>
</tr>
<tr>
<td>Verifying Installation of the Universal License</td>
<td>20</td>
</tr>
<tr>
<td>FAQ</td>
<td>20</td>
</tr>
<tr>
<td>Before Getting Started</td>
<td>23</td>
</tr>
<tr>
<td>Planning for Security</td>
<td>24</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>25</td>
</tr>
<tr>
<td>Pre-Installation Checklist</td>
<td>26</td>
</tr>
<tr>
<td>Upgrading</td>
<td>32</td>
</tr>
<tr>
<td>Install the system</td>
<td>33</td>
</tr>
</tbody>
</table>

© 1999-2020 Citrix Systems, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importing and Installing an Existing Certificate</td>
<td>63</td>
</tr>
<tr>
<td>Converting Certificate from PFX Format to PEM Format</td>
<td>65</td>
</tr>
<tr>
<td>Certificate Revocation Lists</td>
<td>70</td>
</tr>
<tr>
<td>Monitoring Certificate Status with OCSP</td>
<td>74</td>
</tr>
<tr>
<td>Configuring OCSP Certificate Status</td>
<td>75</td>
</tr>
<tr>
<td>Testing Your Citrix Gateway Configuration</td>
<td>76</td>
</tr>
<tr>
<td>Creating Virtual Servers</td>
<td>77</td>
</tr>
<tr>
<td>To create virtual servers</td>
<td>78</td>
</tr>
<tr>
<td>Configuring Connection Types on the Virtual Server</td>
<td>79</td>
</tr>
<tr>
<td>Configuring a Listen Policy for Wildcard Virtual Servers</td>
<td>79</td>
</tr>
<tr>
<td>Configuring IP Addresses on Citrix Gateway</td>
<td>81</td>
</tr>
<tr>
<td>Changing or Deleting Mapped IP Addresses</td>
<td>82</td>
</tr>
<tr>
<td>Configuring Subnet IP Addresses</td>
<td>82</td>
</tr>
<tr>
<td>Configuring IPv6 for User Connections</td>
<td>83</td>
</tr>
<tr>
<td>Resolving DNS Servers Located in the Secure Network</td>
<td>84</td>
</tr>
<tr>
<td>Configuring DNS Virtual Servers</td>
<td>85</td>
</tr>
<tr>
<td>Configuring Name Service Providers</td>
<td>86</td>
</tr>
<tr>
<td>Configuring Server-Initiated Connections</td>
<td>87</td>
</tr>
<tr>
<td>Configuring Routing on Citrix Gateway</td>
<td>88</td>
</tr>
<tr>
<td>Configuring Auto Negotiation</td>
<td>89</td>
</tr>
<tr>
<td>Authentication and Authorization</td>
<td>90</td>
</tr>
<tr>
<td>Configuring Default Global Authentication Types</td>
<td>91</td>
</tr>
<tr>
<td>Configuring Authentication Without Authorization</td>
<td>92</td>
</tr>
<tr>
<td>Configuring Authorization</td>
<td>92</td>
</tr>
</tbody>
</table>
Configuring Authorization Policies
Setting Default Global Authorization
Disabling Authentication
Configuring Authentication for Specific Times
How Authentication Policies Work
Configuring Authentication Profiles
Binding Authentication Policies
Setting Priorities for Authentication Policies
Configuring Local Users
Configuring Groups
Adding Users to Groups
Configuring Policies with Groups
Configuring LDAP Authentication
To configure LDAP authentication by using the configuration utility
Determining Attributes in Your LDAP Directory
Configuring LDAP Group Extraction
How LDAP Group Extraction Works from the User Object Directly
How LDAP Group Extraction Works from the Group Object Indirectly
LDAP Authorization Group Attribute Fields
To configure LDAP authorization
Configuring LDAP Nested Group Extraction
Configuring LDAP Group Extraction for Multiple Domains
Creating Session Policies for Group Extraction
Creating LDAP Authentication Policies for Multiple Domains
Configuring Single Sign-On 145
Configuring Single Sign-On with Windows 145
Configuring Single Sign-On to Web Applications 146
Configuring Single Sign-on to Web Applications by Using LDAP 148
Configuring Single Sign-On to a Domain 148
Configuring Single Sign-On for Microsoft Exchange 2010 149
Configuring One-Time Password Use 151
Configuring RSA SecurID Authentication 151
Configuring Password Return with RADIUS 152
Configuring SafeWord Authentication 154
Configuring Gemalto Protiva Authentication 155
nFactor for Gateway Authentication 155
Unified Gateway Visualizer 194
Configure Citrix Gateway to use RADIUS and LDAP Authentication with Mobile/Tablet Devices 214
Configuration support for SameSite cookie attribute 224
Optimizing Citrix Gateway VPN split tunnel for Office365 226
Configuring the VPN User Experience 233
How User Connections Work with the Citrix Gateway plug-in 234
Establishing the Secure Tunnel 234
Operation Through Firewalls and Proxies 235
Citrix Gateway plug-in Upgrade Control 236
Configure full VPN setup on Citrix Gateway 245
Choosing the User Access Method 254
Deploying Citrix Gateway plug-ins for User Access 255
Selecting the Citrix Gateway plug-in for Users 256
Installing the Citrix Gateway plug-in for Windows 258
Deploying the Citrix Gateway plug-in from Active Directory 259
Upgrading and Removing the Citrix Gateway plug-in by Using Active Directory 261
Troubleshooting the Citrix Gateway plug-in Installation Using Active Directory 262
Connecting with the Citrix Gateway plug-in for Java 262
Integrating the Citrix Gateway plug-in with Citrix Workspace app 264
How User Connections Work with Citrix Workspace app 265
Adding the Citrix Gateway plug-in to Citrix Workspace app 265
Decoupling the Citrix Workspace app Icon 268
Configuring IPv6 for ICA Connections 269
Configuring the Citrix Workspace app Home Page on Citrix Gateway 270
Applying the Receiver Theme to the Logon Page 271
Creating a Custom Theme for the Logon Page 271
Customizing the User Portal 272
Configuring Clientless Access 284
Enabling Clientless Access 285
Encoding the Web Address 286
How Clientless Access Policies Work 287
Creating New Clientless Access Policies 288
Advanced Clientless VPN access with Citrix Gateway 289
Configuring Domain Access for Users 292
Configuring Clientless Access for SharePoint 2003, SharePoint 2007, and SharePoint 2013 293
Setting a SharePoint Site as the Home Page 294

© 1999-2020 Citrix Systems, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabling Name Resolution for SharePoint 2007 Servers</td>
<td>294</td>
</tr>
<tr>
<td>Enabling Clientless Access Persistent Cookies</td>
<td>295</td>
</tr>
<tr>
<td>Configuring Persistent Cookies for Clientless Access for SharePoint</td>
<td>296</td>
</tr>
<tr>
<td>Saving User Settings for Clientless Access Through Web Interface</td>
<td>297</td>
</tr>
<tr>
<td>Configuring the Client Choices Page</td>
<td>298</td>
</tr>
<tr>
<td>Showing the Client Choices Page at Logon</td>
<td>299</td>
</tr>
<tr>
<td>Configuring Client Choices Options</td>
<td>300</td>
</tr>
<tr>
<td>Configuring Access Scenario Fallback</td>
<td>302</td>
</tr>
<tr>
<td>Creating Policies for Access Scenario Fallback</td>
<td>303</td>
</tr>
<tr>
<td>Configuring Connections for the Citrix Gateway plug-in</td>
<td>305</td>
</tr>
<tr>
<td>Configuring the Number of User Sessions</td>
<td>306</td>
</tr>
<tr>
<td>Configuring Time-Out Settings</td>
<td>307</td>
</tr>
<tr>
<td>Configuring Forced Time-Outs</td>
<td>308</td>
</tr>
<tr>
<td>Configuring Session or Idle Time-Outs</td>
<td>309</td>
</tr>
<tr>
<td>Connecting to Internal Network Resources</td>
<td>309</td>
</tr>
<tr>
<td>Configuring Split Tunneling</td>
<td>310</td>
</tr>
<tr>
<td>Configuring Client Interception</td>
<td>312</td>
</tr>
<tr>
<td>Configuring Intranet Applications for the Citrix Gateway plug-in</td>
<td>312</td>
</tr>
<tr>
<td>Configuring Intranet Applications for the Citrix Gateway plug-in for Java</td>
<td>314</td>
</tr>
<tr>
<td>Configuring Name Service Resolution</td>
<td>315</td>
</tr>
<tr>
<td>Enabling Proxy Support for User Connections</td>
<td>316</td>
</tr>
<tr>
<td>Configuring Address Pools</td>
<td>317</td>
</tr>
<tr>
<td>Configuring Address Pools</td>
<td>319</td>
</tr>
<tr>
<td>Defining address pool options</td>
<td>320</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Configuring Custom Expressions</td>
<td>359</td>
</tr>
<tr>
<td>Configuring Compound Expressions</td>
<td>360</td>
</tr>
<tr>
<td>Binding Preauthentication Policies</td>
<td>360</td>
</tr>
<tr>
<td>Unbinding and Removing Preauthentication Policies</td>
<td>361</td>
</tr>
<tr>
<td>Configuring Post-Authentication Policies</td>
<td>362</td>
</tr>
<tr>
<td>Configuring a Post-Authentication Policy</td>
<td>363</td>
</tr>
<tr>
<td>Configuring the Frequency of Post-Authentication Scans</td>
<td>363</td>
</tr>
<tr>
<td>Configuring Quarantine and Authorization Groups</td>
<td>364</td>
</tr>
<tr>
<td>Configuring Quarantine Groups</td>
<td>365</td>
</tr>
<tr>
<td>Configuring Authorization Groups</td>
<td>366</td>
</tr>
<tr>
<td>Configuring Security Preauthentication Expressions for User Devices</td>
<td>367</td>
</tr>
<tr>
<td>Configuring Antivirus, Firewall, Internet Security, or Antispam Expressions</td>
<td>367</td>
</tr>
<tr>
<td>Configuring Service Policies</td>
<td>369</td>
</tr>
<tr>
<td>Configuring Process Policies</td>
<td>370</td>
</tr>
<tr>
<td>Configuring Operating System Policies</td>
<td>370</td>
</tr>
<tr>
<td>Configuring Registry Policies</td>
<td>372</td>
</tr>
<tr>
<td>Configuring Compound Client Security Expressions</td>
<td>374</td>
</tr>
<tr>
<td>Advanced Endpoint Analysis Scans</td>
<td>376</td>
</tr>
<tr>
<td>Configuring Advanced Endpoint Analysis Scans</td>
<td>377</td>
</tr>
<tr>
<td>Advanced Endpoint Analysis Policy Expression Reference</td>
<td>388</td>
</tr>
<tr>
<td>Troubleshooting Advanced Endpoint Analysis scans</td>
<td>396</td>
</tr>
<tr>
<td>Managing User Sessions</td>
<td>397</td>
</tr>
<tr>
<td>AlwaysON</td>
<td>398</td>
</tr>
<tr>
<td>AlwaysOn VPN before Windows logon (Formally AlwaysOn service)</td>
<td>404</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Configure AlwaysOn VPN before Windows logon</td>
<td>406</td>
</tr>
<tr>
<td>Configuring Citrix Gateway</td>
<td>417</td>
</tr>
<tr>
<td>Unified Gateway FAQ</td>
<td>420</td>
</tr>
<tr>
<td>Deploying in a Double-Hop DMZ</td>
<td>429</td>
</tr>
<tr>
<td>Deploying Citrix Gateway in a Double-Hop DMZ</td>
<td>430</td>
</tr>
<tr>
<td>How a Double-Hop Deployment Works</td>
<td>431</td>
</tr>
<tr>
<td>Communication Flow in a Double-Hop DMZ Deployment</td>
<td>432</td>
</tr>
<tr>
<td>Authenticating Users</td>
<td>433</td>
</tr>
<tr>
<td>Creating a Session Ticket</td>
<td>434</td>
</tr>
<tr>
<td>Starting Citrix Workspace app</td>
<td>435</td>
</tr>
<tr>
<td>Completing the Connection</td>
<td>435</td>
</tr>
<tr>
<td>Preparing for a Double-Hop DMZ Deployment</td>
<td>436</td>
</tr>
<tr>
<td>Installing and Configuring Citrix Gateway in a Double-Hop DMZ</td>
<td>437</td>
</tr>
<tr>
<td>Configuring Settings on the Virtual Servers on the Citrix Gateway Proxy</td>
<td>438</td>
</tr>
<tr>
<td>Configuring the Appliance to Communicate with the Appliance Proxy</td>
<td>440</td>
</tr>
<tr>
<td>Configuring Citrix Gateway to Handle the STA and ICA Traffic</td>
<td>441</td>
</tr>
<tr>
<td>Opening the Appropriate Ports on the Firewalls</td>
<td>442</td>
</tr>
<tr>
<td>Managing SSL Certificates in a Double-Hop DMZ Deployment</td>
<td>444</td>
</tr>
<tr>
<td>Using High Availability</td>
<td>447</td>
</tr>
<tr>
<td>How high availability works</td>
<td>449</td>
</tr>
<tr>
<td>Configuring settings for high availability</td>
<td>450</td>
</tr>
<tr>
<td>Changing an RPC node password</td>
<td>451</td>
</tr>
<tr>
<td>Configuring the primary and secondary appliances for high availability</td>
<td>453</td>
</tr>
<tr>
<td>Configuring communication intervals</td>
<td>453</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Configuring Citrix Gateway Settings in Web Interface</td>
<td>504</td>
</tr>
<tr>
<td>Adding Citrix Virtual Apps and Desktops to a Single Site</td>
<td>505</td>
</tr>
<tr>
<td>Routing User Connections Through Citrix Gateway</td>
<td>506</td>
</tr>
<tr>
<td>Configuring Communication with the Web Interface</td>
<td>507</td>
</tr>
<tr>
<td>Configuring Policies for Published Applications and Desktops</td>
<td>507</td>
</tr>
<tr>
<td>Configuring Settings with the Published Applications wizard</td>
<td>509</td>
</tr>
<tr>
<td>Configuring the Secure Ticket Authority on Citrix Gateway</td>
<td>509</td>
</tr>
<tr>
<td>Configuring Additional Web Interface Settings on Citrix Gateway</td>
<td>511</td>
</tr>
<tr>
<td>Configuring Web Interface Failover</td>
<td>511</td>
</tr>
<tr>
<td>Configuring Smart Card Access with the Web Interface</td>
<td>512</td>
</tr>
<tr>
<td>Configuring Access to Applications and Virtual Desktops in the Web Interface</td>
<td>512</td>
</tr>
<tr>
<td>Configuring SmartAccess</td>
<td>515</td>
</tr>
<tr>
<td>How SmartAccess Works for Citrix Virtual Apps and Desktops</td>
<td>515</td>
</tr>
<tr>
<td>Configuring Citrix Virtual Apps Policies and Filters</td>
<td>516</td>
</tr>
<tr>
<td>To configure a session policy for SmartAccess</td>
<td>517</td>
</tr>
<tr>
<td>Configuring User Device Mapping on Citrix Virtual Apps</td>
<td>517</td>
</tr>
<tr>
<td>To configure a restrictive policy on Citrix XenApp 6.5</td>
<td>518</td>
</tr>
<tr>
<td>To configure a non-restrictive policy on Citrix XenApp 6.5</td>
<td>519</td>
</tr>
<tr>
<td>Enabling Citrix Virtual Apps as a Quarantine Access Method</td>
<td>519</td>
</tr>
<tr>
<td>Creating a Session Policy and Endpoint Analysis Scan for a Quarantine Group</td>
<td>520</td>
</tr>
<tr>
<td>Configuring Citrix Virtual Desktops for SmartAccess</td>
<td>521</td>
</tr>
<tr>
<td>To configure a session policy for SmartAccess with Citrix Virtual Desktops</td>
<td>521</td>
</tr>
<tr>
<td>To configure policies and filters in Citrix Virtual Desktops 5</td>
<td>522</td>
</tr>
<tr>
<td>To add the Desktop Delivery Controller as the STA</td>
<td>523</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Configuring SmartControl</td>
<td>523</td>
</tr>
<tr>
<td>Configuring Single Sign-On to the Web Interface</td>
<td>565</td>
</tr>
<tr>
<td>To configure single sign-on to Web applications globally</td>
<td>566</td>
</tr>
<tr>
<td>To configure single sign-on to Web applications by using a session policy</td>
<td>566</td>
</tr>
<tr>
<td>To define the HTTP port for single sign-on to web applications</td>
<td>567</td>
</tr>
<tr>
<td>Additional Configuration Guidelines</td>
<td>567</td>
</tr>
<tr>
<td>To test the single sign-on connection to the Web Interface</td>
<td>568</td>
</tr>
<tr>
<td>Configuring Single Sign-On to the Web Interface by Using a Smart Card</td>
<td>568</td>
</tr>
<tr>
<td>To configure the client certificate for single sign-on by using a smart card</td>
<td>570</td>
</tr>
<tr>
<td>To configure single sign-on for Citrix Virtual Apps and file shares</td>
<td>570</td>
</tr>
<tr>
<td>Allowing File Type Association</td>
<td>571</td>
</tr>
<tr>
<td>Creating a Web Interface Site</td>
<td>571</td>
</tr>
<tr>
<td>Configuring Citrix Gateway for File Type Association</td>
<td>572</td>
</tr>
<tr>
<td>Integrate Citrix Gateway with Citrix Virtual Apps and Desktops</td>
<td>574</td>
</tr>
<tr>
<td>Integrate Citrix Gateway with StoreFront</td>
<td>575</td>
</tr>
<tr>
<td>Configuring Settings for Your Citrix Endpoint Management Environment</td>
<td>578</td>
</tr>
<tr>
<td>Configuring Load Balancing Servers for Citrix Endpoint Management or Citrix XenMobile Server</td>
<td>590</td>
</tr>
<tr>
<td>Configuring Load Balancing Servers for Microsoft Exchange with Email Security Filtering</td>
<td>593</td>
</tr>
<tr>
<td>Configuring Citrix Endpoint Management Citrix ADC Connector (XNC) ActiveSync Filtering</td>
<td>595</td>
</tr>
<tr>
<td>Allowing Access from Mobile Devices with Citrix Mobile Productivity Apps</td>
<td>596</td>
</tr>
<tr>
<td>Configuring Domain and Security Token Authentication for Citrix Endpoint Management</td>
<td>602</td>
</tr>
<tr>
<td>Configuring Client Certificate or Client Certificate and Domain Authentication</td>
<td>612</td>
</tr>
<tr>
<td>Optimizing network traffic with CloudBridge</td>
<td>622</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>RfWebUI Persona on Gateway UX Configuration</td>
<td>624</td>
</tr>
<tr>
<td>RDP Proxy</td>
<td>626</td>
</tr>
<tr>
<td>Stateless RDP Proxy</td>
<td>649</td>
</tr>
<tr>
<td>RDP connection redirection</td>
<td>661</td>
</tr>
<tr>
<td>Populate RDP URLs based on LDAP attribute</td>
<td>663</td>
</tr>
<tr>
<td>Randomize RDP file name with RDP proxy</td>
<td>664</td>
</tr>
<tr>
<td>Configure the file name for RDP apps</td>
<td>665</td>
</tr>
<tr>
<td>Citrix Gateway Enabled PCoIP Proxy Support for VMware Horizon View</td>
<td>665</td>
</tr>
<tr>
<td>Configuring Citrix Gateway Enabled PCoIP proxy for VMWare Horizon View</td>
<td>666</td>
</tr>
<tr>
<td>Configuring VMware Horizon View Connection Server</td>
<td>670</td>
</tr>
<tr>
<td>HDX enlightened data transport support</td>
<td>670</td>
</tr>
<tr>
<td>When to Use Enlightened Data Transport Support</td>
<td>671</td>
</tr>
<tr>
<td>Configure Citrix Gateway to support Enlightened Data Transport and HDX Insight</td>
<td>671</td>
</tr>
<tr>
<td>L7 Latency Thresholding</td>
<td>681</td>
</tr>
<tr>
<td>Microsoft Intune Integration</td>
<td>687</td>
</tr>
<tr>
<td>When to Use the Integrated Intune MDM Solution</td>
<td>688</td>
</tr>
<tr>
<td>Understanding the Citrix Gateway-Intune MDM Integration</td>
<td>689</td>
</tr>
<tr>
<td>Configuring Network Access Control device check for Citrix Gateway virtual server for single factor login</td>
<td>690</td>
</tr>
<tr>
<td>Understanding Azure ADAL Token Authentication</td>
<td>704</td>
</tr>
<tr>
<td>Configuring Citrix Gateway Virtual Server for Microsoft ADAL Token Authentication</td>
<td>704</td>
</tr>
<tr>
<td>Set up Citrix Gateway for using micro VPN with Microsoft Endpoint Manager</td>
<td>706</td>
</tr>
<tr>
<td>Type of Service Support for UDP traffic</td>
<td>711</td>
</tr>
<tr>
<td>Proxy Auto Configuration for Outbound Proxy support for Citrix Gateway</td>
<td>711</td>
</tr>
</tbody>
</table>
Citrix Gateway 13.0

Outbound ICA Proxy support 712
Configuring outbound ICA Proxy 713
Integrate Citrix Gateway with Citrix Virtual Apps and Desktops 715
Native OTP support for authentication 715
Push notification for OTP 726
Configuring Server Name Indication Extension 736
Validating the Server Certificate During an SSL Handshake 737
Using Advance Policy to Create VPN Policies 738
Simplified SaaS app configuration using a template 741
Device Certificate in nFactor as an EPA component 751
Citrix Gateway Release Notes

May 27, 2019

Release notes describe how the software has changed in a particular build, and the issues known to exist in that build.

The release notes document includes all or some of the following sections:

- **What's New**: The enhancements and other changes released in the build.
- **Fixed Issues**: The issues that are fixed in the build.
- **Known Issues**: The issues that exist in the build.
- **Points to Note**: The important aspects to keep in mind while using the build.
- **Limitations**: The limitations that exist in the build.

**Note**

- The [# XXXXXX] labels under the issue descriptions are internal tracking IDs used by the Citrix ADC team.
- These release notes do not document security related fixes. For a list of security related fixes and advisories, see the Citrix security bulletin.

To view the latest release notes document, see release notes page.

About Citrix Gateway

April 23, 2019

Citrix Gateway is easy to deploy and simple to administer. The most typical deployment configuration is to locate the Citrix Gateway appliance in the DMZ. You can install multiple Citrix Gateway appliances in the network for more complex deployments.

The first time you start Citrix Gateway, you can perform the initial configuration by using a serial console, the Setup Wizard in the configuration utility, or Dynamic Host Configuration Protocol (DHCP). On the MPX appliance, you can use the LCD keypad on the front panel of the appliance to perform the initial configuration. You can configure basic settings that are specific to your internal network, such as the IP address, subnet mask, default gateway IP address, and Domain Name System (DNS) address. After you configure the basic network settings, you then configure the settings specific to the Citrix Gateway operation, such as the options for authentication, authorization, network resources, virtual servers, session policies, and endpoint policies.
Before you install and configure Citrix Gateway, review the topics in this section for information about planning your deployment. Deployment planning can include determining where to install the appliance, understanding how to install multiple appliances in the DMZ, as well as licensing requirements. You can install Citrix Gateway in any network infrastructure without requiring changes to the existing hardware or software running in the secure network. Citrix Gateway works with other networking products, such as server load balancers, cache engines, firewalls, routers, and IEEE 802.11 wireless devices.

You can write your settings in the Pre-Installation Checklist to have on hand before you configure Citrix Gateway.

<table>
<thead>
<tr>
<th>Citrix Gateway Appliances</th>
<th>Provides information about Citrix Gateway appliances and the appliance installation instructions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Installation Checklist</td>
<td>Provides planning information to review and a list of tasks to complete before you install Citrix Gateway in your network.</td>
</tr>
<tr>
<td>Common Deployments</td>
<td>Provides information about deploying the Citrix Gateway in the network DMZ, in a secure network without a DMZ, and with additional appliances to support load balancing and failover. Also provides information about deploying Citrix Gateway with Citrix Virtual Apps and Desktops.</td>
</tr>
<tr>
<td>Licensing</td>
<td>Provides information about installing licenses on the appliance. Also provides information about installing licenses on multiple Citrix Gateway appliances.</td>
</tr>
</tbody>
</table>

**Citrix Gateway Architecture**

September 10, 2019

The core components of Citrix Gateway are:

- Virtual servers. The Citrix Gateway virtual server is an internal entity that is a representative of all the configured services available to users. The virtual server is also the access point through
which users access these services. You can configure multiple virtual servers on a single appliance, allowing one Citrix Gateway appliance to serve multiple user communities with differing authentication and resource access requirements.

• Authentication, authorization, and accounting. You can configure authentication, authorization, and accounting to allow users to log on to Citrix Gateway with credentials that either Citrix Gateway or authentication servers located in the secure network, such as LDAP or RADIUS, recognize. Authorization policies define user permissions, determining which resources a given user is authorized to access. For more information about authentication and authorization, see Configuring Authentication and Authorization. Accounting servers maintain data about Citrix Gateway activity, including user logon events, resource access instances, and operational errors. This information is stored on Citrix Gateway or on an external server. For more information about accounting, see Configuring Auditing on Citrix Gateway

• User connections. Users can log on to Citrix Gateway by using the following access methods:

  – The Citrix Gateway plug-in for Windows is software that is installed on a Windows-based computer. Users log on by right-clicking an icon in the notification area on a Windows-based computer. If users are using a computer in which the Citrix Gateway plug-in is not installed, they can log on by using a web browser to download and install the plug-in. If users have Citrix Workspace app installed, users log on with the Citrix Gateway plug-in from Citrix Workspace app. When Citrix Workspace app and the Citrix Gateway plug-in are installed on the user device, Citrix Workspace app adds the Citrix Gateway plug-in automatically.

  – The Citrix Gateway plug-in for Mac OS X that allows users running Mac OS X to log on. It has the same features and functions as the Citrix Gateway plug-in for Windows. You can provide endpoint analysis support for this plug-in version by installing Citrix ADC Gateway 10.1, Build 120.1316.e.

  – The Citrix Gateway plug-in for Java that enables Mac OS X, Linux, and optionally, Windows users to log on by using a web browser.

  – Citrix Workspace app that allows user connections to published applications and virtual desktops in a server farm by using the Web Interface or Citrix StoreFront.

  – Citrix Workspace app, Secure Hub, WorxMail, and WorxWeb that allows users access to web and SaaS applications, iOS and Android mobile apps, and ShareFile data hosted in Citrix Endpoint Management.

  – Users can connect from an Android device that uses the Citrix Gateway web address. When users start an app, the connection uses Micro VPN to route network traffic to the internal network. If users connect from an Android device, you must configure DNS settings on Citrix Gateway. For more information, see Supporting DNS Queries by Using DNS Suffixes for Android Devices.
Users can connect from an iOS device that uses the Citrix Gateway web address. You configure Secure Browse either globally or in a session profile. When users start an app on their iOS device, a VPN connection starts and the connection routes through Citrix Gateway.

Clientless access that provides users with the access they need without installing software on the user device.

When configuring Citrix Gateway, you can create policies to configure how users log on. You can also restrict user logon by creating session and endpoint analysis policies.

- Network resources. These include all network services that users access through Citrix Gateway, such as file servers, applications, and web sites.

- Virtual adapter. The Citrix Gateway virtual adapter provides support for applications that require IP spoofing. The virtual adapter is installed on the user device when the Citrix Gateway plug-in is installed. When users connect to the internal network, the outbound connection between Citrix Gateway and internal servers use the intranet IP address as the source IP address. The Citrix Gateway plug-in receives this IP address from the server as part of the configuration.

If you enable split tunneling on Citrix Gateway, all intranet traffic is routed through the virtual adapter. When intercepting intranet bound traffic, the virtual adapter will intercept A and AAAA record type DNS queries while leaving all other DNS queries intact. Network traffic that is not bound for the internal network is routed through the network adapter installed on the user device. Internet and private local area network (LAN) connections remain open and connected. If you disable split tunneling, all connections are routed through the virtual adapter. Any existing connections are disconnected and the user needs to reestablish the session.

If you configure an intranet IP address, traffic to the internal network is spoofed with the intranet IP address through the virtual adapter.

How User Connections Work

September 10, 2019

Users can connect to their emails, file shares, and other network resources from a remote location. Users can connect to internal network resources with the following software:

- Citrix Gateway plug-in
- Citrix Workspace app
- WorxMail and WorxWeb
- Android and iOS mobile devices
Connecting with the Citrix Gateway plug-in

The Citrix Gateway plug-in allows user access to resources in the internal network through the following steps:

1. A user connects to Citrix Gateway for the first time by typing the web address in a web browser. The logon page appears and the user is prompted to enter a user name and password. If external authentication servers are configured, Citrix Gateway contacts the server and the authentication servers verify the user’s credentials. If local authentication is configured, Citrix Gateway performs the user authentication.

2. If you configure a preauthentication policy, when the user types the Citrix Gateway web address in a web browser on a Windows-based computer or a Mac OS X computer, Citrix Gateway checks to see if any client-based security policies are in place before the logon page appears. The security checks verify that the user device meets the security-related conditions, such as operating system updates, antivirus protection, and a properly configured firewall. If the user device fails the security check, Citrix Gateway blocks the user from logging on. A user who cannot log on needs to download the necessary updates or packages and install them on the user device. When the user device passes the preauthentication policy, the logon page appears and the user can enter his or her credentials. You can use Advanced Endpoint Analysis on a Mac OS X computer if you install Citrix Gateway 10.1, Build 120.1316.e.

3. When Citrix Gateway successfully authenticates the user, Citrix Gateway initiates the VPN tunnel. Citrix Gateway prompts the user to download and install the Citrix Gateway plug-in for Windows or Citrix Gateway plug-in for Mac OS X. If you are using the Network Gateway plug-in for Java, the user device is also initialized with a list of preconfigured resource IP addresses and port numbers.

4. If you configure a post-authentication scan, after a user successfully logs on, Citrix Gateway scans the user device for the required client security policies. You can require the same security-related conditions as for a preauthentication policy. If the user device fails the scan, either the policy is not applied or the user is placed in a quarantine group and the user’s access to network resources is limited.

5. When the session is established, the user is directed to a Citrix Gateway home page where the user can select resources to access. The home page that is included with Citrix Gateway is called the Access Interface. If the user logs on by using the Citrix Gateway plug-in for Windows, an icon in the notification area on the Windows desktop shows that the user device is connected and the user receives a message that the connection is established. The user can also access resources in the network without using the Access Interface, such as opening Microsoft Outlook and retrieving email.

6. If the user request passes both preauthentication and post-authentication security checks, Citrix Gateway then contacts the requested resource and initiates a secure connection between the user device and that resource.
7. The user can close an active session by right-clicking the Citrix Gateway icon in the notification area on a Windows-based computer and then clicking Logoff. The session can also time out due to inactivity. When the session is closed, the tunnel is shut down and the user no longer has access to internal resources. The user can also type the Citrix Gateway web address in a browser. When the user presses Enter, the Access Interface appears from which users can log off.

Note: If you deploy Citrix Endpoint Management in your internal network, a user who connects from outside the internal network must connect to Citrix Gateway first. When the user establishes the connection, the user can access web and SaaS applications, Android and iOS mobile apps, and ShareFile data hosted on Citrix Endpoint Management. A user can connect with the Citrix Gateway plug-in through clientless access, or by using Citrix Workspace app or Secure Hub.

Connecting with Citrix Workspace app

Users can connect with Citrix Workspace app to access their Windows-based applications and virtual desktops. Users can also access applications from Endpoint Management. To connect from a remote location, users also install the Citrix Gateway plug-in on their device. Citrix Workspace app automatically adds the Citrix Gateway plug-in to its list of plug-ins. When users log on to Citrix Workspace app, they can also log on to the Citrix Gateway plug-in. You can also configure Citrix Gateway to perform single sign-on to the Citrix Gateway plug-in when users log on to Citrix Workspace app.

Connecting with iOS and Android Devices

Users can connect from an iOS or Android device by using Secure Hub. Users can access their email by using Secure Mail and connect to web sites with WorxWeb.

When users connect from the mobile device, the connections route through Citrix Gateway to access internal resources. If users connect with iOS, you enable Secure Browse as part of the session profile. If users connect with Android, the connection uses Micro VPN automatically. In addition, Secure Mail and WorxWeb use Micro VPN to establish connections through Citrix Gateway. You do not have to configure Micro VPN on Citrix Gateway.

Common Deployments

April 23, 2019

You can deploy Citrix Gateway at the perimeter of your organization’s internal network (or intranet) to provide a secure single point of access to the servers, applications, and other network resources.
that reside in the internal network. All remote users must connect to Citrix Gateway before they can access any resources in the internal network.

Citrix Gateway is most commonly installed in the following locations in a network:

- In the network DMZ
- In a secure network that does not have a DMZ

You can also deploy Citrix Gateway with Citrix Virtual Apps, Citrix Virtual Desktops, StoreFront, and Citrix Endpoint Management to allow users to access their Windows, web, mobile, and SaaS applications. If your deployment includes Citrix Virtual Apps, StoreFront, and Desktops 7, you can deploy Citrix Gateway in a single-hop or double-hop DMZ configuration. A double-hop deployment is not supported with earlier versions of Citrix Virtual Desktops or Citrix Endpoint Management.

For more information about expanding your Citrix Gateway installation with these and other supported Citrix solutions, see Integrating with Citrix Products topic.

**Deploying in the DMZ**

September 10, 2019

Many organizations protect their internal network with a DMZ. A DMZ is a subnet that lies between an organization’s secure internal network and the Internet (or any external network). When you deploy Citrix Gateway in the DMZ, users connect with the Citrix Gateway plug-in or Citrix Workspace app.

Figure 1. Citrix Gateway deployed in the DMZ
In the configuration shown in the preceding figure, you install Citrix Gateway in the DMZ and configure it to connect to both the Internet and the internal network.

**Citrix Gateway Connectivity in the DMZ**

When you deploy Citrix Gateway in the DMZ, user connections must traverse the first firewall to connect to Citrix Gateway. By default, user connections use SSL on port 443 to establish this connection. To allow user connections to reach the internal network, you must allow SSL on port 443 through the first firewall.

Citrix Gateway decrypts the SSL connections from the user device and establishes a connection on behalf of the user to the network resources behind the second firewall. The ports that must be open through the second firewall are dependent on the network resources that you authorize external users to access.

For example, if you authorize external users to access a web server in the internal network, and this server listens for HTTP connections on port 80, you must allow HTTP on port 80 through the second firewall. Citrix Gateway establishes the connection through the second firewall to the HTTP server on the internal network on behalf of the external user devices.
Deploying in the Secure Network

April 23, 2019

You can install Citrix Gateway in the secure network. In this scenario, one firewall stands between the Internet and the secure network. Citrix Gateway resides inside the firewall to control access to the network resources.

When you deploy Citrix Gateway in the secure network, connect one interface on Citrix Gateway to the Internet and the other interface to servers running in the secure network. Putting Citrix Gateway in the secure network provides access for local and remote users. Because this configuration only has one firewall, however, makes the deployment less secure for users connecting from a remote location. Although Citrix Gateway intercepts traffic from the Internet, the traffic enters the secure network before users are authenticated. When Citrix Gateway is deployed in a DMZ, users are authenticated before network traffic reaches the secure network.

When Citrix Gateway is deployed in the secure network, Citrix Gateway plug-in connections must traverse the firewall to connect to Citrix Gateway. By default, user connections use the SSL protocol on port 443 to establish this connection. To support this connectivity, you must open port 443 on the firewall.

Client Software Requirements

April 23, 2019

This section describes the system requirements for the Citrix Gateway client software.

Citrix Gateway supports user connections by using the Citrix Gateway plug-in. When users log on with the plug-in, it establishes a full VPN tunnel. With the Citrix Gateway plug-in, users can connect to and work with the network resources to which you allow access.
If you configure endpoint policies on Citrix Gateway, when users log on, Citrix Gateway downloads and installs the Endpoint Analysis plug-in on the user device automatically.

**Citrix Gateway plug-in System Requirements**

March 6, 2020

Citrix Gateway plug-in establishes a secure connection from the client machine to the Citrix Gateway appliance.

The plug-in is distributed as a desktop app for Microsoft Windows, macOS X, and Linux operating systems. After you authenticate to the secure URL of the Citrix Gateway appliance with your Web browser, the plug-in is downloaded and installed automatically on your machine.

The plug-in is provisioned as a mobile app for Android and iOS devices.

**Note:** To install the plug-in, admin or root privileges are required on the operating system.

Citrix Gateway plug-in as a desktop app is supported for the following operating systems and Web browsers.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Supported Browsers</th>
</tr>
</thead>
<tbody>
<tr>
<td>macOS X (10.9 and later)</td>
<td>Safari 7.1 or later; Google Chrome Release 30 or later; Mozilla Firefox Release 30 or later</td>
</tr>
<tr>
<td>Windows 10 (x86 and x64)</td>
<td>Internet Explorer 11; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later; Edge Chromium</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>Internet Explorer 11; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later; Edge Chromium</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Internet Explorer 9 and 10; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later; Edge Chromium</td>
</tr>
<tr>
<td>Windows 7</td>
<td>Internet Explorer 9, 10, and 11; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later; Edge Chromium</td>
</tr>
<tr>
<td>Linux; Ubuntu 18.04 LTS, 16.04 LTS, 14.04 LTS, and 12.04 LTS. 32-bit and 64-bit OS is supported.</td>
<td>Mozilla Firefox Release 44 and above; Google Chrome 50 and above</td>
</tr>
</tbody>
</table>
Important: Due to a bug (1573408) in Ubuntu 16.04 LTS, the VPN plug-in installation fails. The workaround for the same is listed as follows.

Type the following command using the command line interface:

```bash
sudo dpkg -i nsgclient*.deb
```

If the required dependency packages are missing, the command lists them and the plug-in installation fails. These dependency packages must be manually installed. Administrators can install a missing package by typing the following command using the command line interface.

```bash
apt-get install <dependency package>
```

Citrix Gateway plug-in as a mobile app is supported for the following operating systems.

<table>
<thead>
<tr>
<th>VPN App</th>
<th>Supported Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td>Android 4.1 and later</td>
</tr>
<tr>
<td>iOS</td>
<td>iOS 8 and later</td>
</tr>
</tbody>
</table>

**Endpoint Analysis Requirements**

September 10, 2019

When Citrix Gateway installs the Endpoint Analysis plug-in on the user device, the plug-in scans the user device for the endpoint security requirements that you configured on Citrix Gateway. The requirements include information, such as the operating system, antivirus, or web browser versions.

When Windows users connect to Citrix Gateway using the browser for the first time, the portal requests the installation of the Endpoint Analysis plug-in. On subsequent log on attempts, the plug-in checks the upgrade control configuration to decide if the client endpoint analysis plug-in upgrade is necessary. If it is necessary, the user will receive a prompt to download and install the newer Endpoint Analysis plug-in. The Endpoint Analysis plug-in for Windows is installed as a Windows 32-bit application. No special privileges are required to install or use it.

For Mac OS X, the user is required to install the Endpoint Analysis plug-in. The plug-in for Mac OS X is installed as a 32-bit application. No special privileges are necessary to install it. On subsequent log on attempts, if the plug-in versions do not match, the user will be prompted to download and install the plug-in.

To use the Endpoint Analysis plug-in, the following software is required on the user device:
<table>
<thead>
<tr>
<th>Operating System</th>
<th>Supported Browsers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X (10.9 and later)</td>
<td>Safari 7.1 or later; Google Chrome Release 30 or later; Mozilla Firefox Release 30 or later</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Internet Explorer 11; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later; Microsoft Edge is not supported</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>Internet Explorer 11; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later</td>
</tr>
<tr>
<td>Windows 8</td>
<td>Internet Explorer 9 and 10; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later</td>
</tr>
<tr>
<td>Windows 7</td>
<td>Internet Explorer 9 and 10, and 11; Google Chrome Release 30 or later; Mozilla Firefox Release 24 or later</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>Internet Explorer 9; Mozilla Firefox Release 9 and 10</td>
</tr>
<tr>
<td>Linux; Ubuntu 12.04 LTS, 14.04 LTS and 16.04 LTS</td>
<td>Mozilla Firefox Release 44 and above; Google Chrome 50 and above</td>
</tr>
</tbody>
</table>

**Note:** 32-bit and 64-bit OS are supported.

**Note 1:** All editions of the operating system variants mentioned above are supported.

**Note 2:** For Windows editions, all service packs and critical updates must be installed.

**Note 3:** For Internet Explorer versions, cookies must be enabled. The minimum required version is 7.0.

**Note 4:** For Mozilla Firefox versions, Endpoint Analysis must be plug-in enabled, the minimum required version is 3.0.

**Important:** In case of Pre-Authentication Endpoint Analysis, if a user does not install the Endpoint Analysis plug-in on the user device or chooses to skip the scan, the user cannot log on with the Citrix Gateway plug-in. In case of Post-Authentication Endpoint Analysis, the user can access resources for which a scan is not required by using either clientless access or by using Citrix Workspace app.
Compatibility with Citrix Products

April 15, 2020

The following table provides the Citrix products and versions with which Citrix Gateway 13.0 is compatible.

**Note:** Citrix Gateway features are available on Citrix ADC VPX.

### Citrix products and supported versions

<table>
<thead>
<tr>
<th>Citrix product</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix SD-WAN</td>
<td>10.2, 11.0</td>
</tr>
<tr>
<td>Citrix ADC Platforms</td>
<td>All current MPX and VPX models including FIPS compliant appliances.</td>
</tr>
<tr>
<td>StoreFront</td>
<td>All currently supported StoreFront versions.</td>
</tr>
<tr>
<td>Web Interface</td>
<td>5.4</td>
</tr>
<tr>
<td>Citrix Virtual Apps and Desktops</td>
<td>7.6, 7.12, 7.13, 7.14, 7.15, 7.16, 7.17, 7.18, 1808, 1811, 1903, 1906, 1909, 2003, 1912 LTSR</td>
</tr>
<tr>
<td>XenMobile</td>
<td>10.5, 10.6, 10.7, 10.8, 10.9, 10.10, 10.11, 10.12</td>
</tr>
</tbody>
</table>

**Note:** Citrix XenApp 6.5 is supported.

### Citrix Workspace apps, Citrix Mobile Productivity Apps, and plug-ins

<table>
<thead>
<tr>
<th>Citrix Workspace app or plug-in</th>
<th>Minimum supported version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Gateway plug-in for macOS X</td>
<td>3.1.8</td>
</tr>
<tr>
<td>Citrix Gateway plug-in for Windows</td>
<td>12.0</td>
</tr>
<tr>
<td>Citrix Gateway plug-in for iOS</td>
<td>3.1.4</td>
</tr>
<tr>
<td>Citrix Gateway plug-in for Android</td>
<td>2.0.14</td>
</tr>
<tr>
<td>Citrix Workspace app for Android</td>
<td>3.11</td>
</tr>
<tr>
<td>Citrix Workspace app for iOS</td>
<td>7.1.3</td>
</tr>
<tr>
<td>Citrix Workspace app for Mac</td>
<td>12.4</td>
</tr>
</tbody>
</table>
### Citrix Gateway 13.0

The following features are supported in Citrix Gateway 13.0 build 36.27 and later.

- Device guard support
- nFactor support
- Opswat v4 support
- SAML support
- AlwaysOn service

### Licensing

November 20, 2019

Before you can deploy Citrix Gateway to support user connections, the appliance must be properly licensed.

**Important:** Citrix recommends that you retain a local copy of all license files you receive. When you save a backup copy of the configuration file, all uploaded licenses files are included in the backup. If you need to reinstall Citrix Gateway appliance software and do not have a backup of the configuration, you will need the original license files.

Before installing licenses on Citrix Gateway, set the host name of the appliance and then restart Citrix Gateway. You use the Setup Wizard to configure the host name. When you generate the Universal...
license for Citrix Gateway, the host name is used in the license.

Citrix Gateway License Types

February 28, 2020

Citrix Gateway requires a Platform license. The Platform license allows an unlimited number of connections to Citrix Virtual Apps, Citrix Virtual Desktops, or StoreFront by using ICA Proxy. To allow VPN connections to the network from the Citrix Gateway plug-in, a SmartAccess logon point, or Secure Hub, WorxWeb, or Secure Mail, you must also add a Universal license. Citrix Gateway VPX comes with the Platform license.

The Platform license is supported on the following Citrix Gateway versions:

- Citrix Gateway 13.0
- Citrix Gateway 12.1
- NetScaler Gateway 12.0
- NetScaler Gateway 11.1
- NetScaler Gateway 11.0
- NetScaler Gateway 10.5
- NetScaler Gateway 10.1
- Access Gateway 10
- Citrix ADC VPX

Important: Citrix recommends that you retain a local copy of all license files that you receive. When you save a backup copy of the configuration file, all uploaded license files are included in the backup. If you need to reinstall the Citrix Gateway appliance software and do not have a backup of the configuration, you need the original license files.

The Platform License

The Platform license allows unlimited user connections to published applications on Citrix Virtual Apps or virtual desktops from Citrix Virtual Desktops. Connections by using Citrix Workspace app do not use a Citrix Gateway Universal license. These connections only need the Platform license. The Platform license is delivered electronically with all new Citrix Gateway orders, whether physical or virtual. If you already own an appliance covered by a warranty or maintenance agreement, you can obtain the Platform license from the Citrix website.

Important: Based on the Platform license, the following number of Universal licenses are included.
Citrix Gateway 13.0

- Standard edition – 500
- Advanced edition – 1000
- Premium – Unlimited

The Universal License

The Universal license limits the number of concurrent user sessions to the number of licenses you purchase.

The Universal license supports the following features:
  - Full VPN tunnel
  - Micro VPN
  - Endpoint analysis
  - Policy-based SmartAccess
  - Clientless access to websites and file shares

If you purchase a Standard edition license, you can have 500 concurrent sessions at any time. When a user ends a session, that license is released for the next user. A user who logs on to Citrix Gateway from more than one computer occupies a license for each session.

If all licenses are occupied, no additional connections can be opened until a user ends a session or you terminate the session. When a connection is closed, the license is released and can be used for a new user.

When you receive your Citrix Gateway appliance, licensing occurs in the following order:
  - You receive the License Authorization Code (LAC) in e-mail.
  - You use the Setup Wizard to configure Citrix Gateway with the host name.
  - You allocate the Citrix Gateway licenses from the Citrix website. Use the host name to bind the licenses to the appliance during the allocation process.
  - You install the license file on Citrix Gateway.

For more details on the Universal license, see Citrix Gateway Universal License

Obtaining Your Platform or Universal License Files

April 23, 2019

After you install Citrix Gateway, you are ready to obtain your Platform or Universal license files from Citrix. You log on to the Citrix web site to access your available licenses and generate a license file. After the license file is generated, you download it to a computer. When the license file is on the computer,
you then upload it to Citrix Gateway. For more information about Citrix licensing, see Citrix Licensing System.

Before obtaining your license files, make sure you configure the host name of the appliance by using the Setup Wizard and then restart the appliance.

Important: You must install licenses on Citrix Gateway. The appliance does not obtain licenses from Citrix License Server.

To obtain your licenses, go to the Activate, upgrade and manage Citrix licenses web page. On this page, you can get your new license and activate, upgrade, and manage Citrix licenses.

To install a license on Citrix Gateway

April 23, 2019

After you successfully download the license file to your computer, you can then install the license on Citrix Gateway. The license is installed in the /nsconfig/license directory.

If you used the Setup Wizard to configure the initial settings on Citrix Gateway, the license file is installed when you run the wizard. If you allocate part of your licenses and then at a later date, you allocate an additional number, you can install the licenses without using the Setup Wizard.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click Licenses.

2. In the details pane, click Manage Licenses.

3. Click Add New License, then click Browse, navigate to the license file and then click OK.

A message appears in the configuration utility that you need to restart Citrix Gateway. Click Reboot.

To set the maximum number of users

After you install the license on the appliance, you need to set the maximum number of users that are allowed to connect to the appliance. You set the maximum user count in the global authentication policy.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change authentication AAA settings.
3. In Maximum Number of Users, type the total amount of users and then click OK.

The number in this field corresponds to the number of licenses contained within the license file. This number should be less than or equal to the total number of licenses installed on the appliance. For example, you install one license that contains 100 user licenses and a second license that contains 400 user licenses. The total number of licenses equals 500. The maximum number of users who can log on is equal to or less than 500. If 500 users are logged on, any users who attempt to log on beyond that number are denied access until a user logs off or you terminate a session.

Verifying Installation of the Universal License

April 23, 2019

Before proceeding, verify that your Universal license is installed correctly.

To verify installation of the Universal license by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click Licenses.

   In the Licenses pane, you will see a green check mark next to Citrix Gateway. The Maximum Citrix Gateway Users Allowed field displays the number of concurrent user sessions licensed on the appliance.

To verify installation of the Universal license by using the command line

1. Open a Secure Shell (SSH) connection to the appliance by using an SSH client, such as PuTTY.
2. Log on to the appliance using the administrator credentials.
3. At a command prompt, type: show license The license is installed correctly if the parameter SSL VPN equals Yes and the maximum users parameter equals the number of licenses.

FAQ

February 28, 2020
Licensing

What is a Universal License (CCUs)?

Universal License is an add-on license on top of Citrix ADC platform licenses. These licenses are required for the following:

Securing ICA sessions
1. SmartAccess
2. SmartControl
3. EPA

SSL VPN
1. For all SSL VPN use cases (Unified Gateway, CVPN, RDP proxy etc.)
2. Portal

What is the change in the new Licensing policy?

Universal License were priced as following:
1. 0-2499 users - $100 per user
2. 2500+ users - $50 per user

The earlier packaging was as following:
1. Standard and Advanced included 5 Universal Licenses
2. Premium License includes 100 Universal Licenses

The change is as follows:
1. Standard will include 500 licenses
2. Advanced will include 1000 licenses
3. Premium does not have any CCU requirement – meaning customers do not need CCUs with Premium

On the other hand, if users purchase Premium 11.1 or above, they can use universal licenses for ALL USE CASES.

<table>
<thead>
<tr>
<th>User count</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-10000</td>
<td>$5</td>
</tr>
<tr>
<td>10001-20000</td>
<td>$2</td>
</tr>
</tbody>
</table>

© 1999-2020 Citrix Systems, Inc. All rights reserved.
When is the new pricing available for customers?

New packaging will be included in NS 11.1.49.16 build released on September 26th, 2016. The new SKUs will go live on September 19 2016.

What version of Citrix ADC do we need?

Customers need NS 11.1-49.16 or above to get the new packaging with CCUs.

How do existing customers get this?

Existing customers need to upgrade their existing NS versions to 11.1.49.xx to get the new packaging. If a customer is unwilling to upgrade and wants to use NS for SSL VPN, below are the key things to ensure:

1. Unified Gateway is available with Advanced or Premium versions ONLY
2. If they have received CCUs for free with Citrix Virtual Apps and Desktops, Premium edition, they need to purchase CCUs for SSL VPN OR purchase NS Premium edition running 11.1.49.xx
3. Online EULA is being updated at this time to reflect the usage scenarios. It will be posted here: https://www.citrix.com/buy/licensing/product.html
4. They can get the same pricing through sales exception process

If a customer running Standard edition, want to buy 5000 licenses, how much do they pay?

If a customer is running standard edition, they get first 500 universal licenses for free. For the rest they will be charged per the new pricing which is $5 for 1-10000 users.

What if the same customer comes back and purchases another 6000 licenses, how much do they pay?

If the customer comes back to purchase another 6000 licenses, they will be charged 6000 users*$5 per user = $30,000. They will not get the benefit of using the row for 11,000 licenses.

Annual maintenance will also be charged on this price.
**If a customer running Standard edition, want to buy 11000 licenses, how much do they pay?**

If a customer is running Standard edition, they will get first 500 licenses for free. For the rest they will pay 10,500 users * $2 per user = $21,000

**How are the other vendors charging, and what do I need to tell my customer?**

All SSL VPN vendors charge per user session license. Citrix is the only company that does not charge per user session license if a customer is purchasing Citrix ADC Premium edition.

**If my customer has 100 CCUs they received with Citrix Virtual Apps and Desktops, Premium edition, and they buy 100 CCUs for Unified Gateway, do they now have 200 CCUs?**

Yes. They do have 200 CCUs. But, they can only use 100 CCUs for SSL VPN use case. They can, however, use 200 CCUs for Citrix Virtual Apps and Desktops use case.

**Before Getting Started**

September 10, 2019

Before you install Citrix Gateway, you should evaluate your infrastructure and collect information to plan an access strategy that meets the specific needs of your organization. When you define your access strategy, you need to consider security implications and complete a risk analysis. You also need to determine the networks to which users are allowed to connect and decide on policies that enable user connections.

In addition to planning for the resources available for users, you also need to plan your deployment scenario. Citrix Gateway works with the following Citrix products:

- Citrix Endpoint Management
- Citrix Virtual Apps
- Citrix Virtual Desktops
- StoreFront
- Web Interface
- CloudBridge

For more information about deploying Citrix Gateway, see [Common Deployments](#) and [Integrating With Citrix Products](#)

As you prepare your access strategy, take the following preliminary steps:
• Identify resources. List the network resources for which you want to provide access, such as web, SaaS, mobile or published applications, virtual desktops, services, and data that you defined in your risk analysis.

• Develop access scenarios. Create access scenarios that describe how users access network resources. An access scenario is defined by the virtual server used to access the network, endpoint analysis scan results, authentication type, or a combination thereof. You can also define how users log on to the network.

• Identify client software. You can provide full VPN access with the Citrix Gateway plug-in, requiring users to log on with Citrix Workspace app, Secure Hub, or by using clientless access. You can also restrict email access to Outlook Web App or WorxMail. These access scenarios also determine the actions users can perform when they gain access. For example, you can specify whether users can modify documents by using a published application or by connecting to a file share.

• Associate policies with users, groups, or virtual servers. The policies you create on Citrix Gateway enforce when the individual or set of users meets specified conditions. You determine the conditions based on the access scenarios that you create. You then create policies that extend the security of your network by controlling the resources users can access and the actions users can perform on those resources. You associate the policies with appropriate users, groups, virtual servers, or globally.

This section includes the following topics to help you plan your access strategy:

• Planning for Security includes information about authentication and certificates.
• Prerequisites that define network hardware and software you might need.
• The Pre-Installation Checklist that you can use to write down your settings before you configure Citrix Gateway.

**Planning for Security**

October 17, 2019

When planning your Citrix Gateway deployment, you should understand basic security issues associated with certificates, and with authentication and authorization.

**Configuring Secure Certificate Management**

By default, Citrix Gateway includes a self-signed Secure Sockets Layer (SSL) server certificate that enables the appliance to complete SSL handshakes. Self-signed certificates are adequate for testing or for sample deployments, but Citrix does not recommend using them for production environments.
Before you deploy Citrix Gateway in a production environment, Citrix recommends that you request and receive a signed SSL server certificate from a known Certificate Authority (CA) and upload it to Citrix Gateway.

If you deploy Citrix Gateway in any environment where Citrix Gateway must operate as the client in an SSL handshake (initiate encrypted connections with another server), you must also install a trusted root certificate on Citrix Gateway. For example, if you deploy Citrix Gateway with Citrix Virtual Apps and the Web Interface, you can encrypt connections from Citrix Gateway to the Web Interface with SSL. In this configuration, you must install a trusted root certificate on Citrix Gateway.

**Authentication Support**

You can configure Citrix Gateway to authenticate users and to control the level of access (or authorization) that users have to the network resources on the internal network.

Before deploying Citrix Gateway, your network environment should have the directories and authentication servers in place to support one of the following authentication types:

- LDAP
- RADIUS
- TACACS+
- Client certificate with auditing and smart card support
- RSA with RADIUS configuration
- SAML authentication

If your environment does not support any of the authentication types in the preceding list, or you have a small population of remote users, you can create a list of local users on Citrix Gateway. You can then configure Citrix Gateway to authenticate users against this local list. With this configuration, you do not need to maintain user accounts in a separate, external directory.

**Secure your Citrix Gateway deployment**

Different deployments might require different security considerations. The Citrix ADC secure deployment guidelines provide general security guidance to help you decide on an appropriate secure deployment based on your specific security requirements.

For details, see [Citrix ADC secure deployment guidelines](#).

**Prerequisites**

April 23, 2019
Before you configure settings on Citrix Gateway, review the following prerequisites:

- Citrix Gateway is physically installed in your network and has access to the network. Citrix Gateway is deployed in the DMZ or internal network behind a firewall. You can also configure Citrix Gateway in a double-hop DMZ and configure connections to a server farm. Citrix recommends deploying the appliance in the DMZ.
- You configure Citrix Gateway with a default gateway or with static routes to the internal network so users can access resources in the network. Citrix Gateway is configured to use static routes by default.
- The external servers used for authentication and authorization are configured and running. For more information, see Authentication and Authorization.
- The network has a domain name server (DNS) or Windows Internet Naming Service (WINS) server for name resolution to provide correct Citrix Gateway user functionality.
- You downloaded the Universal licenses for user connections with the Citrix Gateway plug-in from the Citrix web site and the licenses are ready to be installed on Citrix Gateway.
- Citrix Gateway has a certificate that is signed by a trusted Certificate Authority (CA). For more information, see Installing and Managing Certificates.

Before you install Citrix Gateway, use the Pre-Installation Checklist to write down your settings.

**Pre-Installation Checklist**

April 23, 2019

The checklist consists of a list of tasks and planning information you should complete before you install Citrix Gateway.

Space is provided so that you can check off each task as you complete it and make notes. Citrix recommends that you make note of the configuration values that you need to enter during the installation process and while configuring Citrix Gateway.

For steps to install and configure Citrix Gateway, see Installing Citrix Gateway.

**User Devices**

- Ensure that user devices meet the installation prerequisites described in Citrix Gateway plug-in System Requirements
- Identify the mobile devices with which users connect. **Note:** If users connect with an iOS device, you need to enable Secure Browse in a session profile.
Citrix Gateway Basic Network Connectivity

Citrix recommends that you obtain licenses and signed server certificates before you start to configure the appliance.

- Identify and write down the Citrix Gateway host name. **Note:** This is not the fully qualified domain name (FQDN). The FQDN is contained in the signed server certificate that is bound to the virtual server.
- Obtain Universal licenses from the Citrix Website
- Generate a Certificate Signing Request (CSR) and send to a Certificate Authority (CA). Enter the date you send the CSR to the CA.
- Write down the system IP address and subnet mask.
- Write down the subnet IP address and subnet mask.
- Write down the administrator password. The default password that comes with Citrix Gateway is nsroot.
- Write down the port number. This is the port on which Citrix Gateway listens for secure user connections. The default is TCP port 443. This port must be open on the firewall between the unsecured network (Internet) and the DMZ.
- Write down the default gateway IP address.
- Write down the DNS server IP address and port number. The default port number is 53. In addition, if you are adding the DNS server directly, you must also configure ICMP (ping) on the appliance.
- Write down the first virtual server IP address and host name.
- Write down the second virtual server IP address and host name (if applicable).
- Write down the WINS server IP address (if applicable).

Internal Networks Accessible Through Citrix Gateway

- Write down the internal networks that users can access through Citrix Gateway. Example: 10.10.0.0/24
- Enter all internal networks and network segments that users need access to when they connect through Citrix Gateway by using the Citrix Gateway plug-in.

High Availability

If you have two Citrix Gateway appliances, you can deploy them in a high availability configuration in which one Citrix Gateway accepts and manages connections, while a second Citrix Gateway monitors the first appliance. If the first Citrix Gateway stops accepting connections for any reason, the second Citrix Gateway takes over and begins actively accepting connections.

- Write down the Citrix Gateway software version number.
• The version number must be the same on both Citrix Gateway appliances.
• Write down the administrator password (nsroot). The password must be the same on both appliances.
• Write down the primary Citrix Gateway IP address and ID. The maximum ID number is 64.
• Write down the secondary Citrix Gateway IP address and ID.
• Obtain and install the Universal license on both appliances.
• You must install the same Universal license on both appliances.
• Write down the RPC node password.

Authentication and Authorization

Citrix Gateway supports several different authentication and authorization types that can be used in a variety of combinations. For detailed information about authentication and authorization, see Authentication and Authorization.

LDAP Authentication

If your environment includes an LDAP server, you can use LDAP for authentication.

• Write down the LDAP server IP address and port.

  If you allow unsecure connections to the LDAP server, the default is port 389. If you encrypt connections to the LDAP server with SSL, the default is port 636.

• Write down the security type.

  You can configure security with or without encryption.

• Write down the administrator bind DN.

  If your LDAP server requires authentication, enter the administrator DN that Citrix Gateway should use to authenticate when making queries to the LDAP directory. An example is cn=administrator,cn=Users,dc=ace,dc=com.

• Write down the administrator password.

  This is the password associated with the administrator bind DN.

• Write down the Base DN.

  DN (or directory level) under which users are located; for example, ou=users,dc=ace,dc=com.

• Write down the server logon name attribute.

  Enter the LDAP directory person object attribute that specifies a user’s logon name. The default is sAMAccountName. If you are not using Active Directory, common values for this setting are
cn or uid.
For more information about LDAP directory settings, see Configuring LDAP Authentication
• Write down the group attribute.
Enter the LDAP directory person object attribute that specifies the groups to which a user belongs. The default is memberOf. This attribute enables Citrix Gateway to identify the directory groups to which a user belongs.
• Write down the subattribute name.

RADIUS Authentication and Authorization
If your environment includes a RADIUS server, you can use RADIUS for authentication.
RADIUS authentication includes RSA SecurID, SafeWord, and Gemalto Protiva products.
• Write down the primary RADIUS server IP address and port. The default port is 1812.
• Write down the primary RADIUS server secret (shared secret).
• Write down the secondary RADIUS server IP address and port. The default port is 1812.
• Write down the secondary RADIUS server secret (shared secret).
• Write down the type of password encoding (PAP, CHAP, MS-CHAP v1, MSCHAP v2).

SAML Authentication
The Security Assertion Markup Language (SAML) is an XML-based standard for exchanging authentication and authorization between Identity Providers (IdP) and Service Providers.
• Obtain and install on Citrix Gateway a secure IdP certificate.
• Write down the redirect URL.
• Write down the user field.
• Write down the signing certificate name.
• Write down the SAML issuer name.
• Write down the default authentication group.

Opening Ports Through the Firewalls (Single-Hop DMZ)
If your organization protects the internal network with a single DMZ and you deploy the Citrix Gateway in the DMZ, open the following ports through the firewalls. If you are installing two Citrix Gateway appliances in a double-hop DMZ deployment, see Opening the Appropriate Ports on the Firewalls.
On the Firewall Between the Unsecured Network and the DMZ

- Open a TCP/SSL port (default 443) on the firewall between the Internet and Citrix Gateway. User devices connect to Citrix Gateway on this port.

On the Firewall Between the Secured Network

- Open one or more appropriate ports on the firewall between the DMZ and the secured network. Citrix Gateway connects to one or more authentication servers or to computers running Citrix Virtual Apps and Desktops in the secured network on these ports.
- Write down the authentication ports.
  - For LDAP connections, the default is TCP port 389.
  - For a RADIUS connection, the default is UDP port 1812. Write down the Citrix Virtual Apps and Desktops ports.
- If you are using Citrix Gateway with Citrix Virtual Apps and Desktops, open TCP port 1494. If you enable session reliability, open TCP port 2598 instead of 1494. Citrix recommends keeping both of these ports open.

Citrix Virtual Desktops, Citrix Virtual Apps, the Web Interface, or StoreFront

Complete the following tasks if you are deploying Citrix Gateway to provide access to Citrix Virtual Apps and Desktops through the Web Interface or StoreFront. The Citrix Gateway plug-in is not required for this deployment. Users access published applications and desktops through Citrix Gateway by using only web browsers and Citrix Receiver.

- Write down the FQDN or IP address of the server running the Web Interface or StoreFront.
- Write down the FQDN or IP address of the server running the Secure Ticket Authority (STA) (for Web Interface only).

Citrix Endpoint Management

Complete the following tasks if you deploy Citrix Endpoint Management in your internal network. If users connect to Endpoint Management from an external network, such as the Internet, users must connect to Citrix Gateway before accessing mobile, web, and SaaS apps.

- Write down the FQDN or IP address of Endpoint Management.
- Identify web, SaaS, and mobile iOS or Android applications users can access.
Double-Hop DMZ Deployment with Citrix Virtual Apps

Complete the following tasks if you are deploying two Citrix Gateway appliances in a double-hop DMZ configuration to support access to servers running Citrix Virtual Apps.

Citrix Gateway in the First DMZ

The first DMZ is the DMZ at the outermost edge of your internal network (closest to the Internet or unsecure network). Clients connect to Citrix Gateway in the first DMZ through the firewall separating the Internet from the DMZ. Collect this information before installing Citrix Gateway in the first DMZ.

- Complete the items in the Citrix Gateway Basic Network Connectivity section of this checklist for this Citrix Gateway.

  When completing those items, note that Interface 0 connects this Citrix Gateway to the Internet and Interface 1 connects this Citrix Gateway to Citrix Gateway in the second DMZ.

- Configure the second DMZ appliance information on the primary appliance.

  To configure Citrix Gateway as the first hop in the double-hop DMZ, you must specify the host name or IP address of Citrix Gateway in the second DMZ on the appliance in the first DMZ. After specifying when the Citrix Gateway proxy is configured on the appliance in the first hop, bind it to Citrix Gateway globally or to a virtual server.

- Write down the connection protocol and port between appliances.

  To configure Citrix Gateway as the first hop in the double DMZ, you must specify the connection protocol and port on which Citrix Gateway in the second DMZ listens for connections. The connection protocol and port is SOCKS with SSL (default port 443). The protocol and port must be open through the firewall that separates the first DMZ and the second DMZ.

Citrix Gateway in the Second DMZ

The second DMZ is the DMZ closest to your internal, secure network. Citrix Gateway deployed in the second DMZ serves as a proxy for ICA traffic, traversing the second DMZ between the external user devices and the servers on the internal network.

- Complete the tasks in the Citrix Gateway Basic Network Connectivity section of this checklist for this Citrix Gateway.

  When completing those items, note that Interface 0 connects this Citrix Gateway to Citrix Gateway in the first DMZ. Interface 1 connects this Citrix Gateway to the secured network.
Upgrading

April 16, 2020

You can upgrade the software that resides on Citrix Gateway when new releases are made available. You can check for updates on the Citrix website. You can upgrade to a new release only if your Citrix Gateway licenses are under the Subscription Advantage program when the update is released. You can renew Subscription Advantage at any time. For more information, see the Citrix Support website.

The upgrade path and compatible products information are also available in the Citrix Upgrade Guide. For information about the latest Citrix Gateway maintenance release, see the Citrix Knowledge Center.

To check for software updates

1. Go to the Citrix website.
2. Click My Account and log on.
3. Click Downloads.
4. Under Find Downloads, select Citrix Gateway.
5. In Select Download Type, select Product Software and then click Find.
   You can also select Virtual Appliances to download Citrix ADC VPX. When you select this option, you receive a list of software for the virtual machine for each hypervisor.
6. On the Citrix Gateway page, expand Citrix ADC Gateway or Access Gateway.
7. Click the appliance software version you want to download.
8. On the appliance software page for the version you want to download, select the virtual appliance, and then click Download.
9. Follow the instructions on your screen to download the software.

When the software is downloaded to your computer, you can use the Upgrade Wizard or the command prompt to install the software.

To upgrade the Citrix Gateway by using the Upgrade Wizard

1. In the configuration utility, on the Configuration tab, in the navigation pane, click System.
2. In the details pane, click Upgrade Wizard.
3. Click Next and then follow the directions in the wizard.

To upgrade the Citrix Gateway by using a command prompt

1. To upload the software to Citrix Gateway, use a secure FTP client, such as WinSCP, to connect to the appliance.
2. Copy the software from your computer to the /var/nsinstall directory on the appliance.
3. Use a Secure Shell (SSH) client, such as PuTTY, to open an SSH connection to the appliance.
4. Log on to Citrix Gateway.
5. At a command prompt, type: shell
6. To change to the nsinstall directory, at a command prompt, type: cd /var/nsinstall
7. To view the contents of the directory, type: ls
8. To unpack the software, type: tar -xvzf build_X_XX.tgz, where build_X_XX.tgz is the name of the build to which you want to upgrade.
9. To start the installation, at a command prompt, type: ./installns
10. When the installation is complete, restart Citrix Gateway.

After Citrix Gateway restarts, to verify successful installation, start the configuration utility. The Citrix Gateway version that is on the appliance appears in the upper-right corner.

Install the system

April 23, 2019

When you receive your Citrix Gateway appliance, you unpack the appliance and prepare the site and rack. After you determine that the location where you will install your appliance meets the environmental standards and the server rack is in place according to the instructions, you install the hardware. After you mount the appliance, you connect it to the network, to a power source, and to the console terminal that you use for initial configuration. After you turn on the appliance, you perform the initial configuration, and assign management and network IP addresses. Be sure to observe the cautions and warnings listed with the installation instructions.

When installing a Citrix ADC VPX virtual appliance, you must first acquire the virtual appliance image and install it on a hypervisor or other virtual machine monitor.

Citrix recommends using the Citrix Gateway Pre-Installation Checklist topic so you can make a note of your settings before attempting to configure a Citrix Gateway appliance. The checklist includes information about installing Citrix Gateway as well as an appliance.

Configuring Citrix Gateway

April 23, 2019

After you configure the base network settings on Citrix Gateway, you then configure the detailed settings so users can connect to network resources in the secure network. These settings include:
• Virtual servers. You can configure multiple virtual servers on Citrix Gateway, which allows you to create different policies depending on the user scenario you need to implement. Each virtual server has its own IP address, certificate, and policy set. For example, you can configure a virtual server and restrict users to network resources in the internal network depending on their membership in groups and the policies you bind to the virtual servers. You can create virtual servers by using the following methods:
  – Quick Configuration wizard
  – Citrix Gateway wizard
  – Configuration utility

• High availability. You can configure high availability when you deploy two Citrix Gateway appliances in your network. If the primary appliances fail, the secondary appliance can take over without affecting user sessions.

• Certificates. You can use certificates to secure user connections to Citrix Gateway. When you create a Certificate Signing Request (CSR), you add the fully qualified domain name to the certificate. You can bind certificates to virtual servers.

• Authentication. Citrix Gateway supports several authentication types, including Local LDAP, RADIUS, SAML, client certificates, and TACACS+. In addition, you can configure cascading and two-factor authentication.
  Note: If you use RSA, Safeword, or Gemalto Protiva for authentication, you configure these types by using RADIUS.

• User connections. You can configure user connections by using session profiles. Within the profile, you can determine the plug-ins users can log on with, along with any restrictions users might require. Then, you can create a policy with one profile. You can bind session policies to users, groups, and virtual servers.

• Home page. You can use the default Access Interface as your home page, or you can create a custom home page. The home page appears after users successfully log on to Citrix Gateway.

• Endpoint analysis. You can configure policies on Citrix Gateway that check the user device for software, files, registry entries, processes, and operating systems when users log on. Endpoint analysis allows you to increase the security of your network by requiring the user device to have the required software.

**Using the Configuration Utility**

April 23, 2019

The configuration utility allows you to configure most of the Citrix Gateway settings. You use a web browser to access the configuration utility.
To log on to the configuration utility

1. In a web browser, type the system IP address of Citrix Gateway, such as http://192.168.100.1.
   Note: Citrix Gateway is preconfigured with a default IP address of 192.168.100.1 and subnet mask of 255.255.0.0.
2. In User Name and Password, type nsroot
3. In Deployment Type, select Citrix Gateway and then click Login.

When you log on to the configuration utility for the first time, the Dashboard opens by default on the Home tab. On the Home tab, you can use the Quick Configuration wizard to configure the settings for a virtual server, authentication, certificates, and Citrix Endpoint Management. You can also configure either StoreFront or Web Interface settings in the Quick Configuration wizard.

For more information about configuring Citrix Gateway, see:

- Configuring Initial Settings Using the Setup Wizard.
- Configuring Settings with the Quick Configuration Wizard
- Configuring Settings by Using the Citrix Gateway Wizard.

Policies and Profiles on Citrix Gateway

April 23, 2019

Policies and profiles on Citrix Gateway allow you to manage and implement configuration settings under specified scenarios or conditions. An individual policy states or defines the configuration settings that go into effect when a specified set of conditions are met. Each policy has a unique name and can have a profile bound to the policy.

For more information about policies with Citrix Gateway, see the following topics:

How Policies Work

April 23, 2019

A policy consists of a Boolean condition and collection of settings called a profile. The condition is evaluated at runtime to determine if the policy should be applied.
A profile is a collection of settings, using specific parameters. The profile can have any name and you can reuse it in more than one policy. You can configure multiple settings within the profile, but you can only include one profile per policy.

You can bind policies, with the configured conditions and profiles, to virtual servers, groups, users, or globally. Policies are referred to by the type of configuration settings they control. For example, in a session policy, you can control how users log on and the amount of time users can stay logged on.

If you are using Citrix Gateway with Citrix Virtual Apps, Citrix Gateway policy names are sent to Citrix Virtual Apps as filters. When configuring Citrix Gateway to work with Citrix Virtual Apps and SmartAccess, you configure the following settings in Citrix Virtual Apps:

- The name of the virtual server that is configured on the appliance. The name is sent to Citrix Virtual Apps as the Citrix Gateway farm name.
- The names of the pre-authentication or session policies are sent as filter names.

For more information about configuring Citrix Gateway to work with Citrix Endpoint Management, see Configuring Settings for Your Citrix Endpoint Management Environment.

For more information about configuring Citrix Gateway to work with Citrix Virtual Apps and Desktops, see Accessing Citrix Virtual Apps and Citrix Virtual Desktops Resources with the Web Interface and Integrating with Citrix Endpoint Management or StoreFront.

For more information about preauthentication policies, see Configuring Endpoint Policies.

### Setting the Priorities of Policies

April 23, 2019

Policies are prioritized and evaluated in the order in which the policy is bound.

The following two methods determine policy priority:

- The level to which the policy is bound: globally, virtual server, group, or user. Policy levels are ranked from highest to lowest as follows:
  - User (highest priority)
  - Group
  - Virtual server
  - Global (lowest priority)
- Numerical priority takes precedence regardless of the level at which the policy is bound. If a policy that is bound globally has a priority number of one and another policy bound to a user has a priority number of two, the global policy takes precedence. A lower priority number gives the policy a higher precedence.
Configuring Conditional Policies

April 23, 2019

When configuring policies, you can use any Boolean expression to express the condition for when the policy applies. When you configure conditional policies, you can use any of the available system expressions, such as the following:

- Client security strings
- Network information
- HTTP headers and cookies
- Time of day
- Client certificate values

You can also create policies to apply only when the user device meets specific criteria, such as a session policy for SmartAccess.

Another example of configuring a conditional policy is varying the authentication policy for users. For example, you can require users who are connecting with the Citrix Gateway plug-in from outside the internal network, such as from their home computer or by using Micro VPN from a mobile device, to be authenticated by using LDAP and users who are connecting through a wide area network (WAN) to be authenticated using RADIUS.

Note: You cannot use policy conditions based on endpoint analysis results if the policy rule is configured as part of security settings in a session profile.

Creating Policies on Citrix Gateway

April 23, 2019

You can use the configuration utility to create policies. After you create a policy, you bind the policy to the appropriate level: user, group, virtual server, or global. When you bind a policy to one of these levels, users receive the settings within the profile if the policy conditions are met. Each policy and profile has a unique name.

If you have Citrix Endpoint Management or StoreFront as part of your deployment, you can use the Quick Configuration wizard to configure the settings for this deployment. For more information about the wizard, see Configuring Settings with the Quick Configuration Wizard.
Configuring System Expressions

April 23, 2019

A system expression specifies the conditions under which the policy is enforced. For example, expressions in a preauthentication policy are enforced while a user is logging on. Expressions in a session policy are evaluated and enforced after the user is authenticated and logged on to Citrix Gateway.

Expressions on Citrix Gateway include:

- General expressions that limit the objects users can use when establishing a connection to Citrix Gateway
- Client security expressions that define the software, files, processes, or registry values that must be installed and running on the user device
- Network-based expressions that restrict access based on network settings

Citrix Gateway can also be used as a Citrix ADC appliance. Some expressions on the appliance are more applicable to Citrix ADC. General and network-based expressions are used commonly with Citrix ADC and are not generally used with Citrix Gateway. Client security expressions are used on Citrix Gateway to determine that the correct items are installed on the user device.

Configuring Client Security Expressions

Expressions are a component of a policy. An expression represents a single condition that is evaluated against a request or a response. You can create a simple expression security string to check for conditions, such as:

- User device operating system including service packs
- Antivirus software version and virus definitions
- Files
- Processes
- Registry values
- User certificates

Creating Simple and Compound Expressions

April 23, 2019

Simple expressions check for a single condition. An example of a simple expression is:

REQ.HTTP.URL == HTTP://www.mycompany.com
Compound expressions check for multiple conditions. You create compound expressions by connecting to one or more expression names using the logical operators && and . You can use the symbols to group the expression in the order of evaluation.

Compound expressions can be categorized as:

- **Named expressions.** As an independent entity, a named expression can be reused by other policies and are part of the policy. You configure named expressions at the system level in the configuration utility. You can use a predefined named expression in the policy or create one of your own.
- **Inline expressions.** An inline expression is one that you build within the policy that is specific to the policy.

To create a named expression

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand AppExpert and then click Expressions.
2. In the details pane, click Add.
3. In the Create Policy Expression dialog box, in Expression Name, type a name for the expression.
4. To create an expression, click Add.
5. Do one of the following:
   a) In Frequently Used Expression, select an expression from the list, click OK, click Create and then click Close.
   b) Under Construct Expression, select the parameters for the expression string, click OK, click Create and then click Close.

Adding Custom Expressions

April 23, 2019

If you are creating a policy, you can create a custom expression while configuring the policy. For example, you are creating a session profile to allow users to log on with the Citrix Gateway plug-in, set a time limit for the session, and allow single sign-on with Windows. After you create the session profile,
in the Create Session Policy dialog box, you can create the expression. The following example shows an expression that checks for a process and antivirus application:

CLIENT.APPLICATION.PROCESS(ccapp.exe)EXISTS -frequent 5 && CLIENT.APPLICATION.AV(Symantec).VERSION==14.20.0.29 -freshness 5 && ns_true

Using Operators and Operands in Policy Expressions

April 23, 2019

An operator is a symbol that identifies the operation—mathematical, Boolean, or relational, for example—that manipulates one or more objects, or operands. The first section in this topic defines the operators you can use and provides a definition. The second section lists the operators you can use with specific qualifiers, such as method, URL and query.

Operators and Definitions

This section defines the operators that you can use when creating a policy expression and provides a description of the operator.

- **==, !=, EQ, NEQ**
  These operators test for exact matches. They are case-sensitive (“cmd.exe” is NOT EQUAL to “cMd.exe”). These operators are useful for creating permissions to allow particular strings that meet an exact syntax, but to exclude other strings.

- **GT**
  This operator is used for numerical comparisons; it is used on the length of the URLs and query strings.

- **CONTAINS, NOTCONTAINS**
  These operators perform checks against the specified qualifier to determine if the specified string is contained in the qualifier. These operators are not case-sensitive.

- **EXISTS, NOTEXISTS**
  These operators check for the existence of particular qualifier. For example, these operators can be applied to HTTP headers to determine if a particular HTTP header exists or if the URL Query exists.

- **CONTENTS**
  This operator checks if the qualifier exists and if it has contents (that is, whether or not a header exists and has a value associated with it, no matter what the value).
Qualifiers, Operators, Operands, Actions, and Examples

This section shows the parameters you can use for operators and operands. Each item starts with the qualifier and then lists the associated operator and operand, describes the action that the expression will carry out, and provides an example.

• Method
  Operator: EQ, NEQ
  Operands: Required:
  – Standard HTTP methods
  – Supported methods
  – GET, HEAD, POST, PUT, DELETE OPTIONS, TRACE, CONNECT
  Actions: Verifies the incoming request method to the configured method.
  Example: Method EQ GET

• URL
  Operator: EQ, NEQ
  Operands: Required: URL (Format: /[prefix][*][.suffix])
  Actions: Verifies the incoming URL with the configured URL.
  Example:
  URL EQ / foo*.asp
  URL EQ /foo*
  URL EQ /*.asp
  URL EQ /foo.asp

• Operator: CONTAINS, NOTCONTAINS
  Operands: Required: Any string (in quotes)
  Actions: Verifies the incoming URL for the presence of the configured pattern. (Includes URL and URL query.)
  Example: URL CONTAINS ‘ZZZ’

• URL LEN
  Operator: GT
  Operands: Required: Length (as an integer value)
  Actions: Compares the incoming URL length with the configured length. (Includes URL and URL query.)
  Example: URLLEN GT 60

• URL QUERY
  Operator: CONTAINS, NOTCONTAINS
  Operands: Required: Any string (in quotes).
Optional: Length and offset
Actions:
Verifies the incoming URL query for the presence of the configured pattern.
Used similarly to CONTENTS.
If no option is specified, the whole URL query after the pattern is used.
If options are present, only the length of the query after the pattern is used.
The offset is used to indicate from where to start the search for the pattern.
Example: URLQUERY CONTAINS ‘ZZZ’

- URL QUERY LEN
  Operator: GT
  Operands: Required: Length (as an integer value)
  Actions: Compares the incoming URL query length with the configured length.
  Example: URLQUERYLN GT 60

- URL TOKENS
  Operator: EQ, NEQ
  Operands: Required: URL tokens (Supported URL tokens =, +, %, !, &, ?).
  Actions: Compares the incoming URL for the presence of configured tokens. A backward slash (\) must be entered in front of the question mark.
  Example: URLTOKENS EQ ‘% , +, &, \?’

- VERSION
  Operator: EQ, NEQ
  Operands: Required: Standard HTTP versions. Valid HTTP version strings HTTP/1.0, HTTP/1.1
  Actions: Compares the incoming request’s HTTP version with the configured HTTP version.
  Example: VERSION EQ HTTP/1.1

Header

- Operator: EXISTS, NOTEXISTS
  Operands: None
  Actions: Examines the incoming request for the presence of the HTTP header.
  Example: Header Cookie EXISTS

- Operator: CONTAINS, NOTCONTAINS
  Operands: Required: Any string (in quotes).
  Optional: Length and offset
  Actions: Verifies the incoming request for the presence of a configured pattern in the specific header. Used similarly to CONTENTS. If no option is specified, the whole HTTP header value after the pattern is used. If options are present, only the length of the header after the pattern is used. The offset is used to indicate from where to start the search for the pattern.
  Example: Header Cookie CONTAINS “\&sid”
• Operator: CONTENTS
  Operands: Optional: Length and offset
  Actions: Uses the contents of the HTTP header. If no option is specified, the whole HTTP header value is used. If options are present, only the length of the header starting from the offset is used.
  Example: Header User-Agent CONTENTS

• SOURCEIP
  Operator: EQ, NEQ
  Operands: Required: IP address
  Optional: Subnet mask
  Actions: Verifies the source IP address in the incoming request against the configured IP address. If the optional subnet mask is specified, the incoming request is verified against the configured IP address and subnet mask.
  Example: Sourceip EQ 192.168.100.0 -netmask 255.255.255.0

• DESTIP
  Operator: EQ, NEQ
  Operands: Required: IP address
  Optional: Subnet mask
  Actions: Verifies the destination IP address in the incoming request against the configured IP address. If the optional subnet mask is specified, the incoming request is verified against the configured IP address and subnet mask.
  Example: Sourceip EQ 192.168.100.0 -netmask 255.255.255.0

• SOURCEPORT
  Operator: EQ, NEQ
  Operands: Required: Port number
  Optional: Port range
  Actions: Verifies the source port number in the incoming request against the configured port number.
  Example: SOURCEPORT EQ 10-20

• DESTPORT
  Operator: EQ, NEQ
  Operands: Required: Port number
  Optional: Port range
  Actions: Verifies the destination port number in the incoming request against the configured port number.
  Example: DESTPORT NEQ 80
• CLIENT.SSL.VERSION
  Operator: EQ, NEQ
  Operands: Required: SSL version
  Actions: Checks the version of the SSL or TLS version used in the secure connection.
  Example: CLIENT.SSL.VERSION EQ SSLV3

• CLIENT.CIPHER.TYPE
  Operator: EQ, NEQ
  Operands: Required: Client cipher type
  Actions: Checks for the type of the cipher being used (export or non-export).
  Example: CLIENT.CIPHER.TYPE EQ EXPORT

• CLIENT.CIPHER.BITS
  Operator: EQ, NEQ, GE, LE, GT, LT
  Operands: Required: Client cipher bits
  Actions: Checks for the key strength of the cipher being used.
  Example: CLIENT.CIPHER.BITS GE 40

• CLIENT.CERT
  Operator: EXISTS, NOTEXISTS
  Operands: none
  Actions: Checks whether or not the client sent a valid certificate during the SSL handshake.
  Example: CLIENT.CERT EXISTS

• CLIENT.CERT.VERSION
  Operator: EQ, NEQ, GE, LE, GT, LT
  Operands: Client certificate version
  Actions: Checks the version of the client certificate.
  Example: CLIENT.CERT.VERSION EQ 2

• CLIENT.CERT.SERIALNUMBER
  Operator: EQ, NEQ
  Operands: Required: Client certificate serial number
  Actions: Checks the serial number of the client certificate. The serial number is treated as a string.
  Example: CLIENT.CERT.SERIALNUMBER EQ 2343323

• CLIENT.CERT.SIGALGO
  Operator: EQ, NEQ
  Operands: Required: Client certificate signature algorithm.
Actions: Checks the signature algorithm used in the client certificate.
Example: CLIENT.CERT.SIGALGO EQ md5WithRSAEncryption

- CLIENT.CERT.SUBJECT
  Operator: CONTAINS, NOTCONTAINS
  Operands: Required: Client certificate subject
  Optional: Length, offset
  Actions: Checks the subject field of the client certificate.
  Example: CLIENT.CERT.SUBJECT CONTAINS CN=Access_Gateway

- CLIENT.CERT.ISSUER
  Operator: CONTAINS, NOTCONTAINS
  Operands: Required: Client certificate issuer
  Optional: Length, offset
  Actions: Checks the issuer field of the client certificate.
  Example: CLIENT.CERT.ISSUER CONTAINS O=VeriSign

- CLIENT.CERT.VALIDFROM
  Operator: EQ, NEQ, GE, LE, GT, LT
  Operands: Required: Date
  Actions: Checks the date from which the client certificate is valid.
  Valid date formats are:
  Tue, 05 Nov 1994 08:12:31 GMT
  Tuesday, 05-Nov-94 08:12:31 GMT
  Tue Nov 14 08:12:31 1994
  Example: CLIENT.CERT.VALIDFROM GE ‘Tue Nov 14 08:12:31 1994’

- CLIENT.CERT.VALIDTO
  Operator: EQ, NEQ, GE, LE, GT, LT
  Operands: Required: Date
  Actions: Checks the date until which the client certificate is valid.
  Valid date formats are:
  Tue, 05 Nov 1994 08:12:31 GMT
  Tuesday, 05-Nov-94 08:12:31 GMT
  Tue Nov 14 08:12:31 1994
  Example: CLIENT.CERT.VALIDTO GE ‘Tue Nov 14 08:12:31 1994’
Viewing Citrix Gateway Configuration Settings

April 23, 2019

When you make configuration changes to Citrix Gateway, the changes are saved in log files. You can view several types of configuration settings:

- **Saved configuration.** You can view the settings you have saved on Citrix Gateway.
- **Running configuration.** You can view active settings, such as a virtual server or authentication policy, that you have configured but have not saved as a saved configuration to Citrix Gateway.
- **Running versus saved configuration.** You can compare side by side the running and saved configuration on Citrix Gateway.

You can also clear configuration settings on Citrix Gateway.

**Important:** If you choose to clear settings on Citrix Gateway, certificates, virtual servers, and policies are removed. Citrix recommends that you do not clear the configuration.

Saving the Citrix Gateway Configuration

April 23, 2019

You can save your current configuration on Citrix Gateway to a computer in your network, view the current running configuration, and compare the saved and running configurations.

**To save the configuration on Citrix Gateway**

1. In the configuration utility, above the details pane, click the Save icon and then click Yes.

**To view and save the configuration file on Citrix Gateway**

The saved configuration are the settings that are saved in a log file on Citrix Gateway, such as settings for virtual servers, policies, IP addresses, users, groups, and certificates.

When you configure settings on Citrix Gateway, you can save the settings to a file on your computer. If you need to reinstall the Citrix Gateway software or you accidentally remove some settings, you can use this file to restore your configuration. If you need to restore the settings, you can copy the file to Citrix Gateway and restart the appliance by using the command-line interface or a program, such as WinSCP, to copy the file to Citrix Gateway.
1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under View Configuration, click Saved configuration.
3. In the Saved Configuration dialog box, click Save output text to a file, name the file, and then click Save.
   Note: Citrix recommends saving the file using the file name ns.conf.

**To view the current running configuration**

Any changes to Citrix Gateway that occur without an effort to save them is called the running configuration. These settings are active on Citrix Gateway, but are not saved on the appliance. If you configured additional settings, such as a policy, virtual server, users, or groups, you can view these settings in the running configuration.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under View Configuration, click Running configuration.

**To compare the saved and running configuration**

You can see which settings are saved on the appliance and compare those settings against the running configuration. You can choose to save the running configuration or make changes to the configuration.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under View Configuration, click Saved v/s running.

**Clearing the Citrix Gateway Configuration**

April 23, 2019

You can clear the configuration settings on Citrix Gateway. You can choose from among the following three levels of settings to clear:

Important: Citrix recommends saving your configuration before you clear the Citrix Gateway configuration settings.

- Basic. Clears all settings on the appliance except for the system IP address, default gateway, mapped IP addresses, subnet IP addresses, DNS settings, network settings, high availability settings, administrative password, and feature and mode settings.
Citrix Gateway 13.0

- Extended. Clears all settings except for the system IP address, mapped IP addresses, subnet IP addresses, DNS settings, and high availability definitions.
- Full. Restores the configuration to the original factory settings, excluding the system IP (NSIP) address and default route, which are required to maintain network connectivity to the appliance.

When you clear all or part of the configuration, the feature settings are set to the factory default settings.

When you clear the configuration, files that are stored on Citrix Gateway, such as certificates and licenses, are not removed. The file ns.conf is not altered. If you want to save the configuration before clearing the configuration, save the configuration to your computer first. If you save the configuration, you can restore the ns.conf file on Citrix Gateway. After you restore the file to the appliance and restart Citrix Gateway, any configuration settings in ns.conf are restored.

Modifications to configuration files, such as rc.conf, are not reverted.

If you have a high availability pair, both Citrix Gateway appliances are modified identically. For example, if you clear the basic configuration on one appliance, the changes are propagated to the second appliance.

To clear Citrix Gateway configuration settings

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under Maintenance, click Clear configuration.
3. In Configuration Level, select the level you want to clear and then click Run.

Configuring the Citrix Gateway by Using Wizards

April 17, 2020

Citrix Gateway has the following six wizards that you can use to configure settings on the appliance:

- The First-time Setup Wizard appears when you log on to the Citrix Gateway appliance for the first time.
- The Setup Wizard helps you configure basic Citrix Gateway settings for the first time.
- Citrix Endpoint Management Integrated Configuration helps you configure your Citrix Gateway and Citrix Endpoint Management environment.
- The Quick Configuration wizard helps you configure the correct policies, expressions, and settings for connections to Citrix Endpoint Management, StoreFront, and the Web Interface.
• The Citrix Gateway wizard helps you configure Citrix Gateway-specific settings.
• The Published Applications wizard helps you configure settings for user connections by using Citrix Workspace app.

How the First-time Setup Wizard Works

When you finish installing and configuring the initial settings on the Citrix Gateway appliance, when you log on to the configuration utility for the first time, the First-time Setup wizard appears if the following conditions are not met:

• You did not install a license on the appliance.
• You did not configure a subnet or mapped IP address.
• If the default IP address of the appliances is 192.168.100.1.

How the Setup Wizard Works

You use the Setup Wizard to configure the following initial settings on the appliance:

• System IP address and subnet mask
• Mapped IP address and subnet mask
• Host name
• Default gateway
• Licenses

Note: Before running the Setup Wizard, download your licenses from the Citrix website. For more information, see Licensing Citrix Gateway

How Integrated Citrix Endpoint Management Configuration Works

You can deploy Citrix Gateway with Citrix Endpoint Management MDM that provides the ability to scale, ensure high availability for apps, and maintain security. To use the Citrix Endpoint Management configuration, you need to install Version 10.1, Build 120.1316.e.

The Integrated Citrix Endpoint Management Configuration creates the following:

• Load balancing servers for Device Manager.
• Load balancing servers for Microsoft Exchange with email filtering.
• Load balancing servers for ShareFile.

For more information about creating settings with the Integrated Citrix Endpoint Management Configuration, see Configuring Settings for Your Citrix Endpoint Management Environment
How the Quick Configuration Wizard Works

The Quick Configuration wizard allows you to configure multiple virtual servers on Citrix Gateway. You can add, edit, and remove virtual servers.

The Quick Configuration wizard allows for seamless configuration for the following deployments:

- Web Interface connections to Citrix Virtual Apps and Desktops, with the ability to configure multiple instances of the Secure Ticket Authority (STA)
- Citrix Endpoint Management only
- StoreFront only
- Citrix Endpoint Management and StoreFront together

The Quick Configuration wizard allows you to configure the following settings on the appliance:

- Virtual server name, IP address, and port
- Redirection from an unsecure to a secure port
- LDAP server
- RADIUS server
- Certificates
- DNS server
- Citrix Endpoint Management and Citrix Virtual Apps and Desktops

Note: To enable SSO, you have to manually enable the Single Sign-on to web applications option in the Create Citrix Gateway Session Profile > Client Experience tab for the session action.

Citrix Gateway supports user connections directly to Citrix Endpoint Management, which gives users access to their web, SaaS, and mobile apps, along with access to ShareFile. You can also configure settings to StoreFront which gives users access to their Windows-based applications and virtual desktops.

When you run the Quick Configuration wizard, the following policies are created based on your Citrix Endpoint Management, StoreFront, and Web Interface settings:

- Session policies, including policies and profiles for Receiver, Receiver for Web, Citrix Gateway plug-in, and Program Neighborhood Agent
- Clientless access
- LDAP and RADIUS authentication

How the Citrix Gateway Wizard Works

You use the Citrix Gateway wizard to configure the following settings on the appliance:
How the Published Applications Wizard Works

You use the Published Applications wizard to configure Citrix Gateway to connect to servers running Citrix Virtual Apps and Desktops in the internal network. With the Published Applications wizard, you can:

- Select a virtual server for connections to the server farm.
- Configure the settings for user connections for the Web Interface or StoreFront, single sign-on, and the Secure Ticket Authority.
- Create or select session policies for SmartAccess.

Within the wizard, you can also create session policy expressions for user connections. For more information about configuring Citrix Gateway to connect to a server farm, see Providing Access to Published Applications and Virtual Desktops Through the Web Interface.

Configuring Citrix Gateway with the First-time Setup Wizard

April 23, 2019

To configure the Citrix Gateway (the physical appliance or the VPX virtual appliance) for the first time, you need an administrative computer configured on the same network as the appliance.

You must assign a Citrix Gateway IP (NSIP) address as the management IP address of your appliance and a subnet IP (SNIP) address to which your servers can connect. You assign a subnet mask that applies to both Citrix Gateway and SNIP addresses. You must also configure a time zone. If you assign a host name, you can access the appliance by specifying its name instead of the NSIP address.

There are two sections in the First-time Setup Wizard. In the first section, you configure the basic system settings for the Citrix Gateway appliance including:

- NSIP address, SNIP address, and subnet mask
- Appliance host name
In the second section, you install licenses. If you specify the address of a DNS server, you can use the hardware serial number (HSN) or license activation code (LAC) to allocate your licenses, instead of uploading your licenses from a local computer to the appliance.

Note: Citrix recommends saving your licenses to your local computer.

When you finish configuring these settings, Citrix Gateway prompts you to restart the appliance. When you log on to the appliance again, you can use other wizards and the configuration utility to configure additional settings.

**Configuring Settings with the Quick Configuration Wizard**

April 23, 2019

You can configure settings in Citrix Gateway to enable communication with Citrix Endpoint Management, StoreFront, or Web Interface by using the Quick Configuration wizard. When you complete the configuration, the wizard creates the correct policies for communication between Citrix Gateway, Endpoint Management, StoreFront, or the Web Interface. These policies include authentication, session, and clientless access policies. When the wizard completes, the policies are bound to the virtual server.

When you complete the Quick Configuration wizard, Citrix Gateway can communicate with Endpoint Management or StoreFront, and users can access their Windows-based applications and virtual desktops and web, SaaS, and mobile apps. Users can then connect directly to Endpoint Management.

During the wizard, you configure the following settings:

- Virtual server name, IP address, and port
- Redirection from an unsecure to a secure port
- Certificates
- LDAP server
- RADIUS server
- Client certificate for authentication (only for two-factor authentication)
- Endpoint Management, StoreFront, or Web Interface

The Quick Configuration wizard supports LDAP, RADIUS, and client certificate authentication. You can configure two-factor authentication in the wizard by following these guidelines:

- If you select LDAP as your primary authentication type, you can configure RADIUS as the secondary authentication type.
If you select RADIUS as your primary authentication type, you can configure LDAP as the secondary authentication type.

If you select client certificates as your primary authentication type, you can configure LDAP or RADIUS as the secondary authentication type.

You cannot create multiple LDAP authentication policies by using the Quick Configuration wizard. For example, you want to configure one policy that uses `sAMAccountName` in the Server Logon Name Attribute field and a second LDAP policy that uses the User Principal Name (UPN) in the Server Logon Name Attribute field. To configure these separate policies, use the Citrix Gateway configuration utility to create the authentication policies. For more information, see Configuring LDAP Authentication.

You can configure certificates for Citrix Gateway in the Quick Configuration wizard by using the following methods:

- Select a certificate that is installed on the appliance.
- Install a certificate and private key.
- Select a test certificate.
  
  Note: If you use a test certificate, you must add the fully qualified domain name (FQDN) that is in the certificate.

You can open the Quick Configuration wizard in one of the following two ways:

- When you are on the Citrix Gateway logon page and select Citrix Gateway in Deployment Type, the Home tab appears. If you select any other option in Deployment Type, the Home does not appear.
- From the link Create/Monitor Citrix Gateway in the Citrix Gateway details pane. The link appears if you install a license that enables Citrix ADC features. If you license the appliance for Citrix Gateway only, the link does not appear.

After you initially run the wizard, you can run the wizard again to create additional virtual servers and settings.

Important: If you use the Quick Configuration wizard to configure an additional Citrix Gateway virtual server, you must use an unique IP address. You cannot use the same IP address that is used on an existing virtual server. For example, you have a virtual server with the IP address 192.168.10.5 with a port number of 80. You run the Quick Configuration wizard to create a second virtual server with the IP address 192.168.10.5 with port number 443. When you try to save the configuration, an error occurs.

### To configure settings with the Quick Configuration wizard

1. In the configuration utility, do one of the following:
   a) If the appliance is licensed for Citrix Gateway only, click the Home tab.
   b) If the appliance is licensed to include Citrix ADC features, on the Configuration tab, in the navigation pane, click Citrix Gateway and then in the details pane, under Getting Started,
click Configure Citrix Gateway for Enterprise Store.

2. In the dashboard, click Create New Citrix Gateway.

3. In Citrix Gateway Settings, configure the following:
   a) In Name, type a name for the virtual server.
   b) In IP address, type the IP address for the virtual server.
   c) In Port, type the port number. The default port number is 443.
   d) Select Redirect requests from port 80 to secure port to allow user connections from port 80 to go to port 443.

4. Click Continue.

5. On the Certificate page, do one of the following:
   a) Click Choose Certificate and then in Certificate, select the certificate.
   b) Click Install Certificate and then in Choose Certificate and in Choose Key, click Browse to navigate to the certificate and private key.
   c) Click Use Test Certificate and then in Certificate FQDN enter the fully qualified domain name (FQDN) contained in the test certificate.

6. Click Continue.

7. In Authentication Settings, do the following:
   a) In Primary Authentication, select LDAP, RADIUS, or Cert.
   b) Select an authentication server or configure the settings for the authentication type you selected in the previous step. If you select Cert, either select the client certificate or install a new client certificate.
   c) In Secondary Authentication, select the authentication type and then configure the authentication server settings.

8. Click Continue.

When you finish configuring the network and authentication settings, you can then configure Citrix Endpoint Management or Citrix Virtual Apps and Desktops (StoreFront or Web Interface) settings.

**Configuring Enterprise Store Settings**

Citrix Gateway supports user access to web, SaaS, and mobile apps and ShareFile only through Endpoint Management. If you also deploy StoreFront or the Web Interface, users have access to Windows-based apps and virtual desktops. You can configure settings for the following options:

- **Endpoint Management only**
- **StoreFront only**
- **Endpoint Management and StoreFront together**
- **Web Interface only**

When you click Continue from the preceding procedure, you can then configure the settings for your deployment scenario. The following procedures start on the Citrix Integration Settings page.
After you create the virtual server, editing the virtual server in the Quick Configuration wizard does not allow you to change Citrix Endpoint Management or Citrix Virtual Apps and Desktops settings. For example, if you cancel the configuration of a virtual server at any stage before configuring the Citrix Enterprise Store settings, the wizard automatically selects the Web interface without configuring any settings. When this situation occurs, you can edit the virtual server details for configuring the Web Interface, but you cannot switch to Citrix Endpoint Management. To switch, you must create a new virtual server and must not cancel the wizard at any time during the configuration. If you do not need the Web Interface virtual server, you can delete it by using the Quick Configuration wizard.

**To configure settings for StoreFront only**

1. Click Citrix Virtual Apps and Desktops.
2. In Deployment Type, select StoreFront.
3. In StoreFront FQDN, enter the fully qualified domain name (FQDN) of the StoreFront server.
4. In Receiver for Web Path, leave the default path or enter your own path.
5. Select HTTPS for secure user connections.
6. In Single Sign-on Domain, enter the domain for StoreFront.
7. In STA URL, enter the complete IP address or FQDN of the server running the Secure Ticket Authority (STA) if you deploy StoreFront and provide access to published applications from Citrix Virtual Apps or virtual desktops from Citrix Virtual Desktops.
8. Click Done.

When users connect through Citrix Gateway to StoreFront, users can start their apps and desktops from either Receiver for Web or Receiver.

**To configure settings for Endpoint Management only**

1. Click Citrix Endpoint Management.
2. In App Controller FQDN, enter the FQDN for Endpoint Management.
3. Click Done.

**To configure Web Interface settings**

1. In the Quick Configuration wizard, click Citrix Virtual Apps and Desktops.
2. In Deployment Type, select Web Interface and then configure the following:
   a) In Citrix Virtual Apps Site URL, type the complete IP address or FQDN of the Web Interface.
   b) In Citrix Virtual Apps Services Site URL, type the complete IP address or FQDN of the Web Interface with the PNAgent Path. You can enter the default path or enter your own path.
   c) In Single Sign-on Domain, enter the domain to use.
d) In STA URL, type the complete IP address or FQDN of the server running the STA.

3. Click Done.

Configuring Settings by Using the Citrix Gateway Wizard

April 23, 2019

After you run the Setup Wizard, you can run the Citrix Gateway wizard to configure additional settings on Citrix Gateway. You run the Citrix Gateway wizard from the configuration utility.

Citrix Gateway comes with a test certificate. If you do not have a signed certificate from a Certificate Authority (CA), you can use the test certificate when using the Citrix Gateway wizard. When you receive the signed certificate, you can remove the test certificate and install the signed certificate. Citrix recommends obtaining the signed certificate before making Citrix Gateway publicly available for users.

Note: You can create a Certificate Signing Request (CSR) from within the Citrix Gateway wizard. If you use the Citrix Gateway wizard to create the CSR, you must exit from the wizard and then start the wizard again when you receive the signed certificate from the CA. For more information about certificates, see Installing and Managing Certificates.

You can configure user connections for Internet Protocol version 6 (IPv6) in the Citrix Gateway wizard when you configure a virtual server. For more information about using IPv6 for user connections, see Configuring IPv6 for User Connections.

To start the Citrix Gateway wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Getting Started, click Citrix Gateway wizard.
3. Click Next and then follow the directions in the wizard.

Configuring the Host Name and FQDN on Citrix Gateway

April 23, 2019

The host name is the name of the Citrix Gateway appliance that is associated with the license file. The host name is unique to the appliance and is used when you download the Universal license. You define the host name when you run the Setup Wizard to configure Citrix Gateway for the first time.
The fully qualified domain name (FQDN) is included in the signed certificate that is bound to a virtual server. You do not configure the FQDN on Citrix Gateway. One appliance can have a unique FQDN assigned to each virtual server that is configured on Citrix Gateway by using certificates.

You can find the FQDN of a certificate by viewing the details of the certificate. The FQDN is located in the subject field of the certificate.

**To view the FQDN of a certificate**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and then click Certificates.
2. In the details pane, select a certificate, click Action and then click Details.
3. In the Certificate Details dialog box, click Subject. The FQDN of the certificate appears in the list.

**Installing and Managing Certificates**

April 23, 2019

On Citrix Gateway, you use certificates to create secure connections and to authenticate users.

To establish a secure connection, a server certificate is required at one end of the connection. A root certificate of the Certificate Authority (CA) that issued the server certificate is required at the other end of the connection.

- **Server certificate.** A server certificate certifies the identity of the server. Citrix Gateway requires this type of digital certificate.
- **Root certificate.** A root certificate identifies the CA that signed the server certificate. The root certificate belongs to the CA. A user device requires this type of digital certificate to verify the server certificate.

When establishing a secure connection with a web browser on the user device, the server sends its certificate to the device.

When the user device receives a server certificate, the web browser, such as Internet Explorer checks to see which CA issued the certificate and if the CA is trusted by the user device. If the CA is not trusted, or if it is a test certificate, the web browser prompts the user to accept or decline the certificate (effectively accepting or declining the ability to access the site).

Citrix Gateway supports the following three types of certificates:

- A test certificate that is bound to a virtual server and can also be used for connections to a server farm. Citrix Gateway comes with a pre-installed test certificate.
- A certificate in PEM or DER format that is signed by a CA and is paired with a private key.
A certificate in PKCS#12 format that is used for storing or transporting the certificate and private key. The PKCS#12 certificate is typically exported from an existing Windows certificate as a PFX file and then installed on Citrix Gateway.

Citrix recommends using a certificate signed by a trusted CA, such as Thawte or VeriSign.

Creating a Certificate Signing Request

April 8, 2020

To provide secure communications using SSL or TLS, a server certificate is required on Citrix Gateway. Before you can upload a certificate to Citrix Gateway, you need to generate a Certificate Signing Request (CSR) and private key. You use the Create Certificate Request included in the Citrix Gateway wizard or the configuration utility to create the CSR. The Create Certificate Request creates a .csr file that is emailed to the Certificate Authority (CA) for signing and a private key that remains on the appliance. The CA signs the certificate and returns it to you at the email address you provided. When you receive the signed certificate, you can install it on Citrix Gateway. When you receive the certificate back from the CA, you pair the certificate with the private key.

Important: When you use the Citrix Gateway wizard to create the CSR, you must exit the wizard and wait for the CA to send you the signed certificate. When you receive the certificate, you can run the Citrix Gateway wizard again to create the settings and install the certificate. For more information about the Citrix Gateway wizard, see Configuring Settings by Using the Citrix Gateway Wizard.

To create a CSR by using the Citrix Gateway wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix ADC Gateway.
2. In the details pane, under Getting Started, click Citrix ADC Gateway wizard.
3. Follow the directions in the wizard until you come to the Specify a server certificate page.
4. Click Create a Certificate Signing Request and complete the fields.
   Note: The fully qualified domain name (FQDN) does not need to be the same as the Citrix Gateway host name. The FQDN is used for user logon.
5. Click Create to save the certificate on your computer and then click Close.
6. Exit the Citrix Gateway wizard without saving your settings.
To create a CSR by using the Citrix ADC GUI

You can also use the Citrix ADC GUI to create a CSR, without running the Citrix Gateway wizard.

1. Navigate to **Traffic Management > SSL > SSL Files** and select **Create Certificate Signing Request (CSR)**.
2. Complete the settings for the certificate and then click **Create**.

After you create the certificate and private key, email the certificate to the CA, such as Thawte or Verisign.

For detailed procedure, see [Create a certificate signing request](#).

Installing the Signed Certificate on Citrix Gateway

April 23, 2019

When you receive the signed certificate from the Certificate Authority (CA), pair it with the private key on the appliance and then install the certificate on Citrix Gateway.

To pair the signed certificate with a private key

1. Copy the certificate to Citrix Gateway to the folder nsconfig/ssl by using a Secure Shell (SSH) program such as WinSCP.
2. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and then click Certificates.
3. In the details pane, click Install.
4. In Certificate-Key Pair Name, type the name of the certificate.
5. In Certificate File Name, select the drop-down box in Browse and then click Appliance.
6. Navigate to the certificate, click Select and then click Open.
7. In Private Key File Name, select the drop-down box in Browse and then click Appliance. The name of the private key is the same name as the Certificate Signing Request (CSR). The private key is located on Citrix Gateway in the directory \nsconfig\ssl.
8. Choose the private key and then click Open.
9. If the certificate is PEM-format, in Password, type the password for the private key.
10. If you want to configure notification for when the certificate expires, select Notifies When Expires.
11. In Notification Period, type the number of days, click Create and then click Close.
**To bind the certificate and private key to a virtual server**

After you create and link a certificate and private key pair, bind it to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. On the Certificates tab, under Available, select a certificate, click Add and then click OK.

**To unbind test certificates from the virtual server**

After you install the signed certificate, unbind any test certificates that are bound to the virtual server. You can unbind test certificates using the configuration utility.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. On the Certificates tab, under Configured, select the test certificate and then click Remove.

**Configuring Intermediate Certificates**

April 23, 2019

An intermediate certificate is a certificate that goes between Citrix Gateway (the server certificate) and a root certificate (usually installed on the user device). An intermediate certificate is part of a chain.

Some organizations delegate the responsibility for issuing certificates to resolve the issue of geographical separation between organization units, or to apply different issuing policies to different sections of the organization.

Responsibility for issuing certificates can be delegated by setting up subordinate Certificate Authorities (CAs). CAs can sign their own certificates (that is, they are self-signed) or they can be signed by another CA. The X.509 standard includes a model for setting up a hierarchy of CAs. In this model, as shown in the following figure, the root CA is at the top of the hierarchy and is a self-signed certificate by the CA. The CAs that are directly subordinate to the root CA have CA certificates signed by the root CA. CAs under the subordinate CAs in the hierarchy have their CA certificates signed by the subordinate CAs.

*Figure 1. The X.509 model showing the hierarchical structure of a typical digital certificate chain*
If a server certificate is signed by a CA with a self-signed certificate, the certificate chain is composed of exactly two certificates: the end entity certificate and the root CA. If a user or server certificate is signed by an intermediate CA, the certificate chain is longer.

The following figure shows that the first two elements are the end entity certificate (in this case, gwy01.company.com) and the certificate of the intermediate CA, in that order. The intermediate CA's certificate is followed by the certificate of its CA. This listing continues until the last certificate in the list is for a root CA. Each certificate in the chain attests to the identity of the previous certificate.

Figure 2. A typical digital certificate chain
To install an intermediate certificate

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and then click Certificates.
2. In the details pane, click Install.
3. In Certificate-Key Pair Name, type the name of the certificate.
4. Under Details, in Certificate File Name, click Browse (Appliance) and in the drop-down box, select Local or Appliance.
5. Navigate to the certificate on your computer (Local) or on Citrix Gateway (Appliance).
6. In Certificate Format, select PEM.
7. Click Install and then click Close.

When you install an intermediate certificate on Citrix Gateway, you do not need to specify the private key or a password.

After the certificate is installed on the appliance, the certificate needs to be linked to the server certificate.

To link an intermediate certificate to a server certificate

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and then click Certificates.
2. In the details pane, select the server certificate and then in Action, click Link.
3. Next to CA Certificate Name, select the intermediate certificate from the list and then click OK.

Using Device Certificates for Authentication

September 11, 2019

Citrix Gateway supports device certificate check that enables you to bind the device identity to a certificate’s private key. The device certificate check can be configured as part of classic or advanced EPA policies. In classic EPA policies, device certificate can be configured only for preauthentication EPA.
If you install two or more device certificates on Citrix Gateway, users need to select the correct certificate when they start to log on to Citrix Gateway or before the endpoint analysis scan runs.

When you create the device certificate, it must be an X.509 certificate.

**Important:** By default, Windows mandates admin privileges for accessing device certificates. To add device certificate check for non-admin users, you must install the VPN plug-in. The VPN plug-in version must be the same version as the EPA plug-in on the device.

For more information about creating device certificates, see the following:

- Network Device Enrollment Service (NDES) in Active Directory Certificate Services (AD CS) on the Microsoft website.
- Step-by-Step Example Deployment of the PKI Certificates for Configuration Manager: Windows Server 2008 Certification Authority on the Microsoft System Center website.
- How to request a certificate from a Microsoft Certificate Authority using DCE/RPC and the Active Directory Certificate profile payload on the Apple support website.
- iPad / iPhone Certificate Issuance on the Ask the Directory Services Team Microsoft support blog.
- Setting Up Network Device Enrollment Service on the Windows IT Pro website.

**To enable and bind device certificates on a virtual server for classic EPA policy**

After you create the device certificate, you install the certificate on Citrix Gateway by using the procedure for Importing and Installing an Existing Certificate to Citrix Gateway. After you install the certificate, you bind the certificate to the virtual server.

1. In the configuration utility, navigate to **Citrix Gateway > Virtual Servers**.
2. In the details pane, click a virtual server and then click **Edit**.
3. In the Virtual Server details pane, click the pencil icon then expand More.
4. Select **Enable Device Certificate**.
5. In the selection dialog that appears, select **Add** and then click a device certificate to enable. Click the plus icon next to the chosen device certificate and then click **OK**.

**Note:** For information on enabling and binding device certificates on a virtual server for advanced EPA policy, see Device Certificate in nFactor as an EPA component.

**Importing and Installing an Existing Certificate**

April 23, 2019
You can import an existing certificate from a Windows-based computer running Internet Information Services (IIS) or from a computer running the Secure Gateway.

When you export the certificate, make sure you also export the private key. In some cases, you cannot export the private key, which means you cannot install the certificate on Citrix Gateway. If this occurs, use the Certificate Signing Request (CSR) to create a new certificate. For details, see Creating a Certificate Signing Request.

When you export a certificate and private key from Windows, the computer creates a Personal Information Exchange (.pfx) file. This file is then installed on Citrix Gateway as a PKCS#12 certificate.

If you are replacing the Secure Gateway with Citrix Gateway, you can export the certificate and private key from the Secure Gateway. If you are doing an in-place migration from the Secure Gateway to Citrix Gateway, the fully qualified domain name (FQDN) on the application and the appliance must be the same. When you export the certificate from the Secure Gateway, you immediately retire the Secure Gateway, install the certificate on Citrix Gateway, and then test the configuration. The Secure Gateway and Citrix Gateway cannot be running on your network at the same time if they have the same FQDN.

If you are using Windows Server 2003 or Windows Server 2008, you can use the Microsoft Management Console to export the certificate. For more information, see the Windows online Help.

Leave the default values for all the other options, define a password, and save the .pfx file to your computer. When the certificate is exported, you then install it on Citrix Gateway.

To install the certificate and private key on Citrix Gateway

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.

2. In the details pane, under Getting Started, click Citrix Gateway wizard.

3. Click Next, select an existing virtual server and then click Next.

4. In Certificate Options, select Install a PKCS#12 (.pfx) file.

5. In PKCS#12 File Name, click Browse, navigate to the certificate and then click Select.

6. In Password, type the password for the private key.

   This is the password you used when converting the certificate to PEM format.

7. Click Next to finish the Citrix Gateway wizard without changing any other settings.

When the certificate is installed on Citrix Gateway, the certificate appears in the configuration utility in the SSL > Certificates node.
To create a private Key

1. In the configuration utility, on the Configuration tab, in the navigation pane, click SSL.
2. In the details pane, under SSL Keys, click Create RSA Key.
3. In Key Filename, type the name of the private key or click Browse to navigate to an existing file.
4. In Key Size (Bits), type the size of the private key.
5. In Public Exponent Value, select F4 or 3.

   The public exponent value for the RSA key. This is part of the cipher algorithm and is required
   for creating the RSA key. The values are F4 (Hex: 0x10001) or 3 (Hex: 0x3). The default is F4.
6. In Key Format, select PEM or DER. Citrix recommends PEM format for the certificate.
7. In PEM Encoding Algorithm, select DES or DES3.
8. In PEM Passphrase and Verify Passphrase, type the password, click Create and then click Close.

   Note: To assign a passphrase, the
   Key Format must be PEM and you must select the encoding algorithm.

To create a DSA private key in the configuration utility, click Create DSA Key. Follow the same steps
above to create the DSA private key.

Converting Certificate from PFX Format to PEM Format

April 23, 2019

SSL certificates are used for SSL load balancing virtual servers and Citrix Gateway virtual servers.
The PEM certificates are Base64 encoded ASCII files. PEM certificates can be opened in Text
Editor/Notepad and you will find that they contain “—–BEGIN CERTIFICATE—–” and “—–END
CERTIFICATE—–” statements.

For secure, trusted access you must install an SSL server certificate on the Citrix Gateway server. The
uploaded certificate file must have the following characteristics:

- The server certificate must be issued by a Certification Authority (CA) that is trusted by end users.
  For best results, use a commercial CA such as VeriSign, Thawte or GeoTrust.
- The certificate must be in Privacy Enhanced Mail (PEM) format, a text-based format that is a
  Base64 encoding of the binary Distinguished Encoding Rules (DER) format.
- The certificate file must include a private key and the private key must not be encrypted. There
  should be no password required to use the PEM file.
- Any necessary intermediate certificates must also be appended to the end of the PEM file.

Complete one of the following procedure to convert PFX certificate to PEM format for use with Citrix Gateway:

Citrix Gateway Wizard
Complete the following procedure to convert a PFX certificate to PEM format using Citrix Gateway Wizard:

1. Navigate to Traffic Management, Select the SSL node.
2. Click the Import PKCS#12 link.
3. Specify a file name you want for the PEM certificate in the Output File Name field.
4. Click Browse and select the PFX certificate that you want to convert to PEM format. Some users prefer to upload the certificate to /ncsconfig/SSL directory and use it from there. If PFX certificate is stored on Citrix Gateway then choose option Appliance and if it stored on your workstation then use Local.
5. Specify the Import Password.

6. Click OK.

7. If the file is encoded, then select DES or 3DES as the Encoding Format:
8. Specify the PEM Passphrase and the Verify PEM Passphrase.

9. Click the Manage Certificates / Keys / CSRs link to view the converted PEM certificate files.

10. You can view the uploaded PFX file with the converted PEM file.

11. Expand the SSL node.

12. Select the Certificates node.

13. Click Install.


15. Browse to the PEM file for both the Certificate File Name and Private Key File Name.

16. Specify the Password.
17. Click Install.

**OpenSSL Utility**

If you have requested and installed a certificate onto a Windows server using the Internet Information Service (IIS) certificate wizard, you can export that certificate with its private key to a Personal Information Exchange (PFX) file. To import this certificate onto Citrix Gateway, you must convert the PFX file to unencrypted PEM format.

You can use the open source utility OpenSSL to perform the conversion from PFX to PEM. Download a Win32 distribution of OpenSSL from Win32 OpenSSL.

You might also need C++ redistributable files if you want to use OpenSSL. Download this from Microsoft Visual C++ 2008 redistributable Package (x86).

To convert a PFX file to a PEM file, complete the following steps on a Windows machine:

1. Download and install the Win32 OpenSSL package from Win32 OpenSSL.
2. Create a folder c:\certs and copy the file yourcert.pfx into the c:\certs folder.
3. Open command prompt and change into the OpenSSL\bin directory: cd %homedrive%\OpenSSL\bin
4. Run the following command to convert the PFX file to an unencrypted PEM file (all in one line):

```bash
openssl pkcs12 -in c:\certs\yourcert.pfx -out c:\certs\cag.pem -nodes
```
5. When prompted for the import password, enter the password you used when exporting the certificate to a PFX file. You should receive a message that says MAC verified OK.

6. Point a browser to the Citrix Gateway administration portal or HTTPS port 9001: https://netscaler-gateway-server:9001.

7. Log on as root. The default password is rootadmin.

8. Click the Maintenance link at the top of the page.

9. Click the Browse button next to the Upload Private Key+Certificate (.pem) field. Browse to the c:\certs\cag.pem file and click Upload.

10. Restart Citrix Gateway for the new SSL certificate to be applied.

Certificate Revocation Lists

April 23, 2019

From time to time, Certificate Authorities (CAs) issue certificate revocation lists (CRLs). CRLs contain information about certificates that can no longer be trusted. For example, suppose Ann leaves XYZ Corporation. The company can place Ann’s certificate on a CRL to prevent her from signing messages with that key.

Similarly, you can revoke a certificate if a private key is compromised or if that certificate expired and a new one is in use. Before you trust a public key, make sure that the certificate does not appear on a CRL.
Citrix Gateway 13.0

Citrix Gateway supports the following two CRL types:

- CRLs that list the certificates that are revoked or are no longer valid
- Online Certificate Status Protocol (OSCP), an Internet protocol used for obtaining the revocation status of X.509 certificates

**To add a CRL**

Before you configure the CRL on the Citrix Gateway appliance, make sure that the CRL file is stored locally on the appliance. In the case of a high availability setup, the CRL file must be present on both Citrix Gateway appliances, and the directory path to the file must be the same on both appliances.

If you need to refresh the CRL, you can use the following parameters:

- CRL Name: The name of the CRL being added on the Citrix ADC. Maximum 31 characters.
- CRL File: The name of the CRL file being added on the Citrix ADC. The Citrix ADC looks for the CRL file in the /var/netscaler/ssl directory by default. Maximum 63 characters.
- URL: Maximum 127 characters
- Base DN: Maximum 127 characters
- Bind DN: Maximum 127 characters
- Password: Maximum 31 characters
- Day(s): Maximum 31

1. In the configuration utility, on the Configuration tab, expand SSL and then click on CRL.
2. In the details pane, click Add.
3. In the Add CRL dialog box, specify the values for the following:
   - CRL Name
   - CRL File
   - Format (optional)
   - CA Certificate (optional)
4. Click Create and then click Close. In the CRL details pane, select the CRL that you just configured and verify that the settings that appear at the bottom of the screen are correct.

**To configure CRL autorefresh by using LDAP or HTTP in the configuration utility**

A CRL is generated and published by a CA periodically or, in some cases, immediately after a particular certificate is revoked. Citrix recommends that you update CRLs on the Citrix Gateway appliance regularly for protection against clients trying to connect with certificates that are not valid.

The Citrix Gateway appliance can refresh CRLs from a web location or an LDAP directory. When you specify refresh parameters and a web location or an LDAP server, the CRL does not have to be present on the local hard disk drive at the time you run the command. The first refresh stores a copy on the
local hard disk drive, in the path specified by the CRL File parameter. The default path for storing the CRL is /var/netscaler/ssl.

CRL Refresh Parameters

- **CRL Name**
  The name of the CRL being refreshed on the Citrix Gateway.

- **Enable CRL Auto Refresh**
  Enable or disable CRL auto refresh.

- **CA Certificate**
  The certificate of the CA that has issued the CRL. This CA certificate must be installed on the appliance. The Citrix ADC can update CRLs only from CAs whose certificates are installed on it.

- **Method**
  Protocol in which to obtain the CRL refresh from a web server (HTTP) or an LDAP server. Possible Values: HTTP, LDAP. Default: HTTP.

- **Scope**
  The extent of the search operation on the LDAP server. If the scope specified is Base, the search is at the same level as the base DN. If the scope specified is One, the search extends to one level below the base DN.

- **Server IP**
  The IP address of the LDAP server from which the CRL is retrieved. Select IPv6 to use an IPv6 IP address.

- **Port**
  The port number on which the LDAP or the HTTP server communicates.

- **URL**
  The URL for the web location from which the CRL is retrieved.

- **Base DN**
  The base DN used by the LDAP server to search for the CRL attribute.
  Note: Citrix recommends using the base DN attribute instead of the Issuer-Name from the CA certificate to search for the CRL in the LDAP server. The Issuer-Name field may not exactly match the LDAP directory structure’s DN.

- **Bind DN**
  The bind DN attribute used to access the CRL object in the LDAP repository. The bind DN attributes are the administrator credentials for the LDAP server. Configure this parameter to restrict unauthorized access to the LDAP servers.
• **Password**

The administrator password used to access the CRL object in the LDAP repository. This is required if the access to the LDAP repository is restricted, that is, anonymous access is not allowed.

• **Interval**

The interval at which the CRL refresh should be carried out. For an instantaneous CRL refresh, specify the interval as NOW. Possible values: MONTHLY, DAILY, WEEKLY, NOW, NONE.

• **Days**

The day on which CRL refresh should be performed. The option is not available if interval is set to DAILY.

• **Time**

The exact time in 24-hour format when the CRL refresh should be performed.

• **Binary**

Set the LDAP-based CRL retrieval mode to binary. Possible values: YES, NO. Default: NO.

1. In the navigation pane, expand SSL and then click CRL.
2. Select the configured CRL for which you want to update refresh parameters and then click Open.
3. Select the Enable CRL Auto Refresh option.
4. In the CRL Auto Refresh Parameters group, specify values for the following parameters:
   
   Note: An asterisk (*) indicates a required parameter.
   
   • Method
   • Binary
   • Scope
   • Server IP
   • Port*
   • URL
   • Base DN*
   • Bind DN
   • Password
   • Interval
   • Day(s)
   • Time

5. Click Create. In the CRL pane, select the CRL that you just configured and verify that the settings that appear at the bottom of the screen are correct.
Monitoring Certificate Status with OCSP

April 23, 2019

Online Certificate Status Protocol (OCSP) is an Internet protocol that is used to determine the status of a client SSL certificate. Citrix Gateway supports OCSP as defined in RFC 2560. OCSP offers significant advantages over certificate revocation lists (CRLs) in terms of timely information. Up-to-date revocation status of a client certificate is especially useful in transactions involving large sums of money and high-value stock trades. It also uses fewer system and network resources. Citrix Gateway implementation of OCSP includes request batching and response caching.

Citrix Gateway Implementation of OCSP

OCSP validation on an Citrix Gateway appliance begins when Citrix Gateway receives a client certificate during an SSL handshake. To validate the certificate, Citrix Gateway creates an OCSP request and forwards it to the OCSP responder. To do so, Citrix Gateway either extracts the URL for the OCSP responder from the client certificate or uses a locally configured URL. The transaction is in a suspended state until Citrix Gateway evaluates the response from the server and determines whether to allow the transaction or to reject it. If the response from the server is delayed beyond the configured time and no other responders are configured, Citrix Gateway allows the transaction or displays an error, depending on whether you set the OCSP check to optional or mandatory. Citrix Gateway supports batching of OCSP requests and caching of OCSP responses to reduce the load on the OCSP responder and provide faster responses.

OCSP Request Batching

Each time Citrix Gateway receives a client certificate, it sends a request to the OCSP responder. To help avoid overloading the OCSP responder, Citrix Gateway can query the status of more than one client certificate in the same request. For request batching to work efficiently, you need to define a time-out so that processing of a single certificate is not delayed while waiting to form a batch.

OCSP Response Caching

Caching of responses received from the OCSP responder enables faster responses to the user and reduces the load on the OCSP responder. Upon receiving the revocation status of a client certificate from the OCSP responder, Citrix Gateway caches the response locally for a predefined length of time. When a client certificate is received during an SSL handshake, Citrix Gateway first checks its local cache for an entry for this certificate. If an entry is found that is still valid (within the cache time-out limit),
the entry is evaluated and the client certificate is accepted or rejected. If a certificate is not found, Citrix Gateway sends a request to the OCSP responder and stores the response in its local cache for a configured length of time.

**Configuring OCSP Certificate Status**

April 23, 2019

Configuring Online Certificate Status Protocol (OCSP) involves adding an OCSP responder, binding the OCSP responder to a signed certificate from a Certificate Authority (CA), and binding the certificate and private key to a Secure Sockets Layer (SSL) virtual server. If you need to bind a different certificate and private key to an OCSP responder that you already configured, you need to first unbind the responder and then bind the responder to a different certificate.

**To configure OCSP**

1. On the Configuration tab, in the navigation pane, expand SSL and then click OCSP Responder.
2. In the details pane, click Add.
3. In Name, type a name for the profile.
4. In URL, type the web address of the OCSP responder.
   This field is mandatory. The Web address cannot exceed 32 characters.
5. To cache the OCSP responses, click Cache and in Time-out, type the number of minutes that Citrix Gateway holds the response.
6. Under Request Batching, click Enable.
7. In Batching Delay, specify the time, in milliseconds, allowed for batching a group of OCSP requests.
   The values can be from 0 through 10000. The default is 1.
8. In Produced At Time Skew, type the amount of time Citrix Gateway can use when the appliance needs to check or accept the response.
9. Under Response Verification, select Trust Responses if you want to disable signature checks by the OCSP responder.
   If you enable Trust Responses, skip Step 8 and Step 9.
10. In Certificate, select the certificate that is used to sign the OCSP responses.
If a certificate is not selected, the CA that the OCSP responder is bound to is used to verify responses.

11. In Request Time-out, type the number of milliseconds to wait for an OCSP response. This time includes the Batching Delay time. The values can be from 0 through 120000. The default is 2000.

12. In Signing Certificate, select the certificate and private key used to sign OCSP requests. If you do not specify a certificate and private key, the requests are not signed.

13. To enable the number used once (nonce) extension, select Nonce.

14. To use a client certificate, click Client Certificate Insertion.

15. Click Create and then click Close.

Testing Your Citrix Gateway Configuration

April 23, 2019

After you configure the initial settings on Citrix Gateway, you can test your settings by connecting to the appliance.

To test the Citrix Gateway settings, create a local user account. Then, using either the virtual server IP address or the fully qualified domain name (FQDN) of the appliance, open a web browser and type the web address. For example, in the address bar, type https://my.company.com or https://192.168.96.183.

At the logon screen, enter the user name and password of the user account you created earlier. After you log on, you are prompted to download and install the Citrix Gateway plug-in.

After you install and then successfully connect with the Citrix Gateway plug-in, the Access Interface appears. The Access Interface is the default home page for Citrix Gateway.

Creating a new user account by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > User Administration, and then click AAA Users.
2. In the details pane, click Add.
3. In User Name, type the user name.
4. If using local authentication, clear the External Authentication check box. Authenticating users with external authentication types, such as LDAP or RADIUS, is the default. If you clear this check box, Citrix Gateway authenticates users.
5. In Password and Confirm Password, type the password for the user, click Create and then click Close.

When you add users by using the configuration utility, you can bind the following policies to the user:

- Authorization
- Traffic, session, and auditing
- Bookmarks
- Intranet applications
- Intranet IP addresses

If you have problems logging on with the test user account, check the following:

- If you receive a certificate warning, either a test certificate or an invalid certificate is installed on Citrix Gateway. If a certificate signed by a Certificate Authority (CA) is installed on the appliance, make sure that there is a corresponding root certificate on the user device.
- If you used a CA-signed certificate, verify that you generated the site certificate correctly by using the signed Certificate Signing Request (CSR), and that the Distinguished Name (DN) data entered in the CSR is accurate. The problem may also be that the host name does not match the IP address that is on the signed certificate. Check that the configured certificate’s common name corresponds to the configured virtual server IP address information.
- If the logon screen does not appear or if any other error message appears, review the setup process and confirm that you performed all steps correctly and entered all parameters accurately.

Creating Virtual Servers

April 23, 2019

A virtual server is an access point to which users log on. Each virtual server has its own IP address, certificate, and policy set. A virtual server consists of a combination of an IP address, port, and protocol that accepts incoming traffic. Virtual servers contain the connection settings for when users log on to the appliance. You can configure the following settings on virtual servers:

- Certificates
- Authentication
- Policies
- Bookmarks
- Address pools (also known as IP pools or intranet IPs)
- Double-hop DMZ deployment with Citrix Gateway
- Secure Ticket Authority
- SmartAccess ICA Proxy Session Transfer
If you run the Citrix Gateway wizard, you can create a virtual server during the wizard. You can configure additional virtual servers in the following ways:

- **From the virtual servers node.** This node is on the navigation pane in the configuration utility. You can add, edit, and remove virtual servers by using the configuration utility.
- **With the Quick Configuration wizard.** If you deploy Citrix Endpoint Management, StoreFront or the Web Interface in your environment, you can use the Quick Configuration wizard to create the virtual server and all of the policies needed for your deployment.

If you want users to log on and use a specific authentication type, such as RADIUS, you can configure a virtual server and assign the server a unique IP address. When users log on, they are directed to the virtual server and then prompted for their RADIUS credentials.

You can also configure the ways users log on to Citrix Gateway. You can use a session policy to configure the type of user software, the access method, and the home page users see after logging on.

### To create virtual servers

**April 7, 2020**

You can add, modify, enable or disable, and remove virtual servers by using the Citrix Gateway GUI or the Quick Configuration wizard. For more information about configuring a virtual server with the Quick Configuration wizard, see Configuring Settings with the Quick Configuration Wizard.

### To create a virtual server by using the GUI

1. On the Configuration tab, Navigate to **Citrix Gateway > Virtual Servers**.
2. In the details pane, click **Add**.
3. Configure the settings as per your requirement.
4. Click **Create** and then click **Close**.

### To create a virtual server by using the CLI

At the command prompt, type;

```bash
1 add vpn vserver <name> <serviceType> [<IPAddress> [<port>]]
```

**Example:**

```bash
1 add vpn vserver gatewayserver SSL 1.1.1.1 443
```
Configuring Connection Types on the Virtual Server

When you create and configure a virtual server, you can configure the following connection options:

- Connections with Citrix Workspace app only to Citrix Virtual Apps and Desktops without SmartAccess, endpoint analysis, or network layer tunneling features.
- Connections with the Citrix Gateway plug-in and SmartAccess, which allows the use of SmartAccess, endpoint analysis, and network layer tunneling functions.
- Connections with Secure Hub that establishes a Micro VPN connection from mobile devices to Citrix Gateway.
- Parallel connections made over the ICA session protocol by a user from multiple devices. The connections are migrated to a single session to prevent the use of multiple Universal licenses.

If you want users to log on without user software, you can configure a clientless access policy and bind it to the virtual server.

To configure Basic or SmartAccess connections on a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click Add.
3. In Name, type a name for the virtual server.
4. In IP Address and Port, type the IP address and port number for the virtual server.
5. Do one of the following:
   - To allow ICA connections only, click Basic Mode.
   - To allow user logon with Secure Hub, the Citrix Gateway plug-in and SmartAccess, click SmartAccess Mode.
   - To allow SmartAccess to manage ICA Proxy sessions for multiple user connections, click ICA Proxy Session Migration.
6. Configure the other settings for the virtual server, click Create and then click Close.

Configuring a Listen Policy for Wildcard Virtual Servers

You can configure Citrix Gateway virtual servers to restrict the ability for a virtual server to listen on a specific virtual local area network (VLAN). You can create a wildcard virtual server with a listen policy...
that restricts it to processing traffic on the specified VLAN.

The configuration parameters are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the virtual server. The name is required and you cannot change it after you create the virtual server. The name cannot exceed 127 characters and the first character must be a number or letter. You can also use the following characters: at symbol (@), underscore (_), dash (-), period (.), colon (:), pound sign (#), and a space.</td>
</tr>
<tr>
<td>IP</td>
<td>The IP address of the virtual server. For a wildcard virtual server bound to the VLAN, the value is always *.</td>
</tr>
<tr>
<td>Type</td>
<td>The behavior of the service. Your choices are HTTP, SSL, FTP, TCP, SSL_TCP, UDP, SSL_BRIDGE, NNTP, DNS, ANY, SIP-UDP, DNS-TCP, and RTSP.</td>
</tr>
<tr>
<td>Port</td>
<td>The port on which the virtual server listens for user connections. The port number must be between 0 and 65535. For the wildcard virtual server bound to a VLAN, the value is usually *.</td>
</tr>
<tr>
<td>Listen Priority</td>
<td>The priority that is assigned to the listen policy. Priority is evaluated in reverse order; the lower the number, the higher the priority assigned to the listen policy.</td>
</tr>
<tr>
<td>Listen Policy Rule</td>
<td>The policy rule to use to identify the VLAN to which the virtual server should listen. The rule is: CLIENT.VLAN.ID.EQ(&lt;ipaddressat&gt;) For &lt;ipaddressat&gt;, substitute the ID number assigned to the VLAN.</td>
</tr>
</tbody>
</table>

To create a wildcard virtual server with a listen policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click Add.
3. In Name, type a name for the virtual server.
4. In Protocol, select the protocol.
5. In IP Address, type the IP address for the virtual server.
6. In Port, type the port for the virtual server.
7. On the Advanced tab, under Listen Policy, in Listen Priority, type the priority for the listen policy.
9. In the Create Expression dialog box, click Add, configure the expression and then click OK.
10. Click Create and then click Close.

Configuring IP Addresses on Citrix Gateway

April 23, 2019

You can configure IP addresses to log on to the configuration utility and for user connections. Citrix Gateway is configured with a default IP address of 192.168.100.1 and subnet mask of 255.255.0.0 for management access. The default IP address is used whenever a user-configured value for the system IP (NSIP) address is absent.

- **NSIP address.** The management IP address for Citrix Gateway that is used for all management-related access to the appliance. Citrix Gateway also uses the NSIP address for authentication.
- **Default gateway.** The router that forwards traffic from outside the secure network to Citrix Gateway.
- **Subnet IP (SNIP) address.** The IP address that represents the user device by communicating with a server on a secondary network. This is similar to the mapped IP (MIP) address.

The SNIP address uses ports 1024 through 64000.

How Citrix Gateway Uses IP Addresses

Citrix Gateway sources traffic from IP addresses based on the function that is occurring. The following list describes several functions and the way Citrix Gateway uses IP addresses for each, as a general guideline:

- **Authentication.** Citrix Gateway uses the SNIP address.
- **File transfers from the home page.** Citrix Gateway uses the SNIP address.
- **DNS and WINS queries.** Citrix Gateway uses either the MIP address or SNIP address.
- **Network traffic to resources in the secure network.** Citrix Gateway uses the MIP address, the SNIP address, or IP pooling, depending on the configuration on Citrix Gateway.
- **ICA proxy setting.** Citrix Gateway uses the MIP address or SNIP address.
Changing or Deleting Mapped IP Addresses

April 23, 2019

Citrix Gateway supports one mapped IP address. If you configure one mapped IP address on the appliance, you cannot change or delete the address. If you need to change the mapped IP address, you first create a new mapped IP address and then delete the original mapped IP address.

You can use either the Setup Wizard or the Network node in the configuration utility to configure additional mapped IP addresses.

To create a new mapped IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > Network, and then click IPs.
2. In the details pane, click Add.
3. In the Create IP dialog box, in IP Address, type the IP address.
4. In Netmask, type the subnet mask.
5. Under IP Type, select Mapped IP and then click Create.

To delete a mapped IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > Network, and then click IPs.
2. In the details pane, click the mapped address and then click Remove.

Configuring Subnet IP Addresses

April 23, 2019

The subnet IP address allows the user to connect to Citrix Gateway from an external host that resides on another subnet. When you add a subnet IP address, a corresponding route entry is made in the route table. Only one entry is made per subnet. The route entry corresponds to the first IP address added in the subnet.

Unlike the system IP address and the mapped IP address, it is not mandatory to specify the subnet IP address during initial configuration of Citrix Gateway.

The mapped IP address and subnet IP addresses use ports 1024 through 64000.
To add a subnet IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > Network, and then click IPs.
2. In the details pane, click Add.
3. In the Create IP dialog box, in IP Address, type the IP address.
4. In Netmask, type the subnet mask.
5. Under IP Type, select Subnet IP, click Close and then click Create.

Configuring IPv6 for User Connections

September 10, 2019

You can configure Citrix Gateway to listen for user connections by using Internet Protocol version 6 (IPv6). When you configure one of the following settings, you can select the IPv6 check box and then enter the IPv6 address in the dialog box:

- Global Settings - Published Applications - ICA Proxy
- Global Authentication - Radius
- Global Authentication - LDAP
- Global Authentication - TACACS
- Session Profile - Published Applications - ICA Proxy
- Citrix Gateway Virtual Servers
- Create Authentication Server - Radius
- Create Authentication Server - LDAP
- Create Authentication Server - TACACS
- Create Auditing Server
- High Availability Setup
- Bind / Unbind Route Monitors for High Availability
- Virtual server (Load Balancing)

When you configure the Citrix Gateway virtual server to listen on an IPv6 address, users can connect only with Citrix Workspace app. User connections with the Citrix Gateway plug-in are not supported with IPv6.

You can use the following guidelines for configuring IPv6 on Citrix Gateway:

- Citrix Virtual Apps and Web Interface. When you configure IPv6 for user connections and if there is a mapped IP address that uses IPv6, Citrix Virtual Apps and Web Interface servers can also use IPv6. The Web Interface must be installed behind Citrix Gateway. When users connect through
Citrix Gateway, the IPv6 address is translated to IPv4. When the connection returns, the IPv4 address is translated to IPv6.

- Virtual servers. You can configure IPv6 for a virtual server when you run the Citrix Gateway wizard. In the Citrix Gateway wizard on the Virtual Servers page, click IPv6 and enter the IP address. You can only use configure an IPv6 address for a virtual server by using the Citrix Gateway wizard.
- Other. To configure IPv6 for ICA Proxy, authentication, auditing, and high availability, select the IPv6 check box in the dialog box and then type the IP address.

**Resolving DNS Servers Located in the Secure Network**

April 23, 2019

If your DNS server is located in the secure network behind a firewall and the firewall is blocking ICMP traffic, you cannot test connections to the server because the firewall is blocking the request. You can resolve this issue by doing the following steps:

- Creating a DNS service with a custom DNS Monitor that resolves to a known fully qualified domain name (FQDN).
- Creating a non-directly addressable DNS virtual server on Citrix Gateway.
- Binding the service to the virtual server.

**Note:**

- Configure a DNS virtual server and DNS service only if your DNS server is located behind a firewall.
- If you install a Citrix ADC load balancing license on the appliance, the Virtual Servers and Services node does not appear in the navigation pane. You can perform this procedure by expanding Load Balancing and then clicking Virtual Servers.

**To configure a DNS service and DNS Monitor**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Virtual Servers and Services and then click Virtual Servers.
2. In the details pane, click Add.
3. In Name, type a name for the service.
4. In Protocol, select DNS.
5. In IP Address, type the IP address of the DNS server.
6. In Port, type the port number.
7. On the Services tab, click Add.
8. On the Monitors tab, under Available, select dns, click Add, click Create and then click Close.
9. In the Create Virtual Server (Load Balancing) dialog box, click Create and then click Close.

Next, create the DNS virtual server by using the procedure To configure a DNS virtual server and then bind the DNS service to the virtual server.

To bind a DNS service to a DNS virtual server

1. In the Configure Virtual Service (Load Balancing) dialog box, on the Services tab, click Add, select the DNS service, click Create and then click Close.

Configuring DNS Virtual Servers

April 23, 2019

To configure a DNS virtual server, you specify a name and IP address. Like the Citrix Gateway virtual server, you must assign an IP address to the DNS virtual server. However, this IP address must be on the internal side of the targeted network so that user devices resolve all internal addresses. You must also specify the DNS port.

Note: If you install a Citrix ADC load balancing license on the appliance, the Virtual Servers and Services node does not appear in the navigation pane. You can configure this feature by using the load balancing virtual server. For more information, see the Citrix ADC documentation in Citrix eDocs.

To configure a DNS virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Virtual Servers and Services and then click Virtual Servers.
2. In the details pane, click Add.
3. In Name, type a name for the virtual server.
4. In IP Address, type the IP address of the DNS server.
5. In Port, type the port on which the DNS server listens.
6. In Protocol, select DNS and then click Create.

Finally, associate the DNS virtual server with Citrix Gateway through one of the following two methods, depending on the needs of your deployment:

- Bind the server globally to Citrix Gateway.
- Bind the DNS virtual server on a per-virtual server basis.
If you deploy the DNS virtual server globally, all users have access to it. Then, you can restrict users by binding the DNS virtual server to the virtual server.

**Configuring Name Service Providers**

April 23, 2019

Citrix Gateway uses name service providers to convert web addresses to IP addresses.

When you run the Citrix Gateway wizard, you can configure either a DNS server or a WINS server. You can use the configuration utility to also configure additional DNS or WINS servers.

**To add a DNS server to Citrix Gateway**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Network Configuration tab, click Add.
4. In the Insert Name Server dialog box, in IP Address, type the IP address of the DNS server, click Create, and then click Close.
5. Click OK in the configuration utility.

**To add a WINS server to Citrix Gateway**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Network Configuration tab, in WINS Server IP, type the IP address of the WINS server and then click OK.

Next, specify the DNS virtual server name and IP address. Like the Citrix Gateway virtual server, an IP address must be assigned to the virtual server. However, this IP address must be on the internal side of the targeted network so that user devices resolve all internal addresses properly. You must also specify the DNS port.

If you configure a DNS server and WINS server for name resolution, you can then use the Citrix Gateway wizard to select which server performs name lookup first.
To specify name lookup priority

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Getting Started, click Citrix Gateway wizard.
3. Click Next to accept the current settings until you come to the Name Service Providers page.
4. In Name Lookup Priority, select WINS or DNS and then continue to the end of the wizard.

Configuring Server-Initiated Connections

April 23, 2019

For each user logged on to Citrix Gateway with IP addresses enabled, the DNS suffix is appended to the user name and a DNS address record is added to the appliance's DNS cache. This technique helps in providing users with a DNS name rather than the IP addresses of the users.

When an IP address is assigned to a user’s session, it is possible to connect to the user’s device from the internal network. For example, users connecting with Remote Desktop or a virtual network computing (VNC) client can access the user device for diagnosing a problem application. It is also possible for two Citrix Gateway users with internal network IP addresses who are remotely logged on to communicate with each other through Citrix Gateway. Allowing discovery of the internal network IP addresses of the logged-on users on the appliance aids in this communication.

A remote user can use the following ping command to discover the internal network IP address of a user who could be logged on to Citrix Gateway at that time:

grep <username.domainname>

A server can initiate a connection to a user device in the following different ways:

- TCP or UDP connections. The connections can originate from an external system in the internal network or from another computer logged on to Citrix Gateway. The internal network IP address that is assigned to each user device logged on to Citrix Gateway is used for these connections. The different types of server-initiated connections that Citrix Gateway supports are described below.

  For TCP or UDP server-initiated connections, the server has prior knowledge about the user device’s IP address and port and makes a connection to it. Citrix Gateway intercepts this connection.

  Then, the user device makes an initial connection to the server and the server connects to the user device on a port that is known or derived from the first configured port.
In this scenario, the user device makes an initial connection to the server and then exchanges ports and IP addresses with the server by using an application-specific protocol where this information is embedded. This enables the Citrix Gateway to support applications, such as active FTP connections.

- Port command. This is used in an active FTP and in certain Voice over IP protocols.
- Connections between plug-ins. Citrix Gateway supports connections between plug-ins through the use of the internal network IP addresses.

With this type of connection, two Citrix Gateway user devices that use the same Citrix Gateway can initiate connections with each other. An example of this type is using instant messaging applications, such as Office Communicator or Yahoo! Messenger.

If a user logs off Citrix Gateway and the logoff request did not reach the appliance, the user can log on again by using any device and replace the previous session with a new session. This feature might be beneficial in deployments where one IP address is assigned per user.

When a user logs on to Citrix Gateway for the first time, a session is created and an IP address is assigned to the user. If the user logs off but the logoff request gets lost or the user device fails to perform a clean logoff, the session is maintained on the system. If the user tries to log on again from the same device or another device, after successful authentication, a transfer logon dialog box appears. If the user chooses to transfer logon, the previous session on Citrix Gateway is closed and a new session is created. The transfer of logon is active for only two minutes after logoff, and if logon is attempted from multiple devices simultaneously, the last logon attempt replaces the original session.

### Configuring Routing on Citrix Gateway

April 23, 2019

To provide access to internal network resources, Citrix Gateway must be capable of routing data to your internal, secure networks. By default, Citrix Gateway uses a static route.

The networks to which Citrix Gateway can route data are determined by the way you configure the Citrix Gateway routing table and the default gateway that you specify for Citrix Gateway.

The Citrix Gateway routing table must contain the routes necessary to route data to any internal network resource that a user may need to access.

Citrix Gateway supports the following routing protocols:

- Routing Information Protocol (RIP v1 and v2)
- Open Shortest Path First (OSPF)
- Border Gateway Protocol (BGF)
Configuring a Static Route

When setting up communication with another host or network, you may need to configure a static route from Citrix Gateway to the new destination if you do not use dynamic routing.

To configure a static route

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > Network > Advanced and then click Routes.
2. In the details pane, on the Basic tab, click Add.
3. Configure the settings for the route and then click Create.

To test a static route

1. In the configuration utility, in the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under Utilities, click Ping.
3. Under Parameters, in Host name, type the name of the device.
4. Under Advanced, in Source IP Address, type the IP address of the device and then click Run.

   If you are successfully communicating with the other device, messages indicate that the same number of packets were transmitted and received, and zero packets were lost.

   If you are not communicating with the other device, the status messages indicate that zero packets were received and all the packets were lost. To correct this lack of communication, repeat the procedure to add a static route.

To stop the test, in the Ping dialog box, click Stop and then click Close.

Configuring Auto Negotiation

April 23, 2019

By default, the appliance is configured to use auto negotiation, in which Citrix Gateway transmits network traffic both directions simultaneously and determines the appropriate adapter speed. If you leave the default setting to Auto Negotiation, Citrix Gateway uses full-duplex operation, in which the network adapter is capable of sending data in both directions simultaneously.
If you disable auto negotiation, Citrix Gateway uses half-duplex operation, in which the adapter can send data in both directions between two nodes, but the adapter can only use one direction or the other at a time.

For first time installation, Citrix recommends that you configure Citrix Gateway to use auto negotiation for ports that are connected to the appliance. After you log on initially and configure Citrix Gateway, you can disable auto negotiation. You cannot configure auto negotiation globally. You must enable or disable the setting for each interface.

**To enable or disable auto negotiation**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > Network and then click Interfaces.
2. In the details pane, select the interface and then click Open.
3. Do one of the following in the Configure Interface dialog box:
   - To enable auto negotiation, click Yes next to Auto Negotiation and then click OK.
   - To disable auto negotiation, click No next to Auto Negotiation and then click OK.

**Authentication and Authorization**

April 23, 2019

Citrix Gateway employs a flexible authentication design that permits extensive customization of user authentication for Citrix Gateway. You can use industry-standard authentication servers and configure Citrix Gateway to authenticate users with the servers. Citrix Gateway also supports authentication based on attributes present in a client certificate. Citrix Gateway authentication is designed to accommodate simple authentication procedures that use a single source for user authentication, as well as more complex, cascaded authentication procedures that rely upon multiple authentication types.

Citrix Gateway authentication incorporates local authentication for the creation of local users and groups. This design centers around the use of policies to control the authentication procedures that you configure. The policies you create can be applied at Citrix Gateway global or virtual server levels and can be used to set authentication server parameters conditionally based on the user’s source network.

Because policies are bound either globally or to a virtual server, you can also assign priorities to your policies to create a cascade of multiple authentication servers as part of authentication.

Citrix Gateway includes support for the following authentication types.

- Local
Citrix Gateway 13.0

- Lightweight Directory Access Protocol (LDAP)
- RADIUS
- SAML
- TACACS+
- Client certificate authentication (including smart card authentication)

Citrix Gateway also supports RSA SecurID, Gemalto Protiva, and SafeWord. You use a RADIUS server to configure these types of authentication.

While authentication allows users to log on to Citrix Gateway and connect to the internal network, authorization defines the resources within the secure network to which users have access. You configure authorization with LDAP and RADIUS policies.

Configuring Default Global Authentication Types

April 23, 2019

When you installed Citrix Gateway and ran the Citrix Gateway wizard, you configured authentication within the wizard. This authentication policy is bound automatically to the Citrix Gateway global level. The authentication type you configure within the Citrix Gateway wizard is the default authentication type. You can change the default authorization type by running the Citrix Gateway wizard again or you can modify the global authentication settings in the configuration utility.

If you need to add additional authentication types, you can configure authentication policies on Citrix Gateway and bind the policies to Citrix Gateway by using the configuration utility. When you configure authentication globally, you define the type of authentication, configure the settings, and set the maximum number of users that can be authenticated.

After configuring and binding the policy, you can set the priority to define which authentication type takes precedence. For example, you configure LDAP and RADIUS authentication policies. If the LDAP policy has a priority number of 10 and the RADIUS policy has a priority number of 15, the LDAP policy takes precedence, regardless of where you bind each policy. This is called cascading authentication.

You can select to deliver logon pages from the Citrix Gateway in-memory cache or from the HTTP server running on Citrix Gateway. If you choose to deliver the logon page from the in-memory cache, the delivery of the logon page from Citrix Gateway is significantly faster than from the HTTP server. Choosing to deliver the logon page from the in-memory cache reduces the wait time when a large number of users log on at the same time. You can only configure the delivery of logon pages from the cache as part of a global authentication policy.

You can also configure the network address translation (NAT) IP address that is a specific IP address for authentication. This IP address is unique for authentication and is not the Citrix Gateway subnet, mapped, or virtual IP addresses. This is an optional setting.
**Note:** You cannot use the Citrix Gateway wizard to configure SAML authentication.

You can use the Quick Configuration wizard to configure LDAP, RADIUS, and client certificate authentication. When you run the wizard, you can select from an existing LDAP or RADIUS server configured on Citrix Gateway. You can also configure the settings for LDAP or RADIUS. If you use two-factor authentication, Citrix recommends using LDAP as the primary authentication type.

**To configure authentication globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change authentication settings.
3. In Maximum Number of Users, type the number of users who can be authenticated by using this authentication type.
4. In NAT IP address, type the unique IP address for authentication.
5. Select Enable static caching to deliver logon pages faster.
6. Select Enable Enhanced Authentication Feedback to provide a message to users if authentication fails. The message users receive include password errors, account disabled or locked, or the user is not found, to name a few.
7. In Default Authentication Type, select the authentication type.
8. Configure the settings for your authentication type and then click OK.

**Configuring Authentication Without Authorization**

April 23, 2019

Authorization defines the resources to which users are allowed to connect through Citrix Gateway. You configure authorization policies by using an expression and then setting the policy to be allowed or denied. You can configure Citrix Gateway to use authentication only, without authorization.

When you configure authentication without authorization, Citrix Gateway does not perform a group authorization check. The policies that you configure for the user or group are assigned to the user.

For more information about configuring authorization, see [Configuring Authorization](#).

**Configuring Authorization**

April 23, 2019
Citrix Gateway 13.0

Authorization specifies the network resources to which users have access when they log on to Citrix Gateway. The default setting for authorization is to deny access to all network resources. Citrix recommends using the default global setting and then creating authorization policies to define the network resources users can access.

You configure authorization on Citrix Gateway by using an authorization policy and expressions. After you create an authorization policy, you can bind it to the users or groups that you configured on the appliance.

Configuring Authorization Policies

March 19, 2020

When you configure an authorization policy, you can set it to allow or deny access to network resources in the internal network. For example, to allow users access to the 10.3.3.0 network, use the following expression:

CLIENT.IP.DST.IN_SUBNET(10.3.0.0/16)

Authorization policies are applied to users and groups. After a user is authenticated, Citrix Gateway performs a group authorization check by obtaining the user’s group information from either an RADIUS, LDAP, or TACACS+ server. If group information is available for the user, Citrix Gateway checks the network resources allowed for the group.

To control which resources users can access, you must create authorization policies. If you do not need to create authorization policies, you can configure default global authorization.

If you create an expression within the authorization policy that denies access to a file path, you can only use the subdirectory path and not the root directory. For example, use fs.path contains “\dir1\dir2” instead of fs.path contains “\rootdir\dir1\dir2”. If you use the second version in this example, the policy fails.

After you configure the authorization policy, you then bind it to a user or group as shown in the tasks below.

By default, authorization policies are validated first against policies that you bind to the virtual server and then against policies bound globally. If you bind a policy globally and want the global policy to take precedence over a policy that you bind to a user, group, or virtual server, you can change the priority number of the policy. Priority numbers start at zero. A lower priority number gives the policy higher precedence.

For example, if the global policy has a priority number of one and the user has a priority of two, the global authentication policy is applied first.
Important:

- Classic authorization policies are applied only on TCP traffic.
- Advanced authorization policy can be applied on all types of traffic (TCP/UDP/ICMP/DNS).
  - To apply policy on UDP/ICMP/DNS traffic, policies must be bound at type UDP_REQUEST, ICMP_REQUEST, and DNS_REQUEST respectively.
  - While binding, if “type” is not explicitly mentioned or “type” is set to REQUEST, the behavior does not change from earlier builds, that is these policies are applied only to TCP traffic.
  - The policies bound at UDP_REQUEST do not apply for DNS traffic. For DNS, policies must be explicitly bound to DNS_REQUEST TCP_DNS is similar to other TCP requests.

For more details on advanced authorization policies, see article https://support.citrix.com/article/CTX232237.

To configure an authorization policy by using the GUI

2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. In Action, select Allow or Deny.
5. In Expression, click Expression Editor.
6. To start to configure the expression, click Select and choose the necessary elements.
7. Click Done when your expression is complete.
8. Click Create.

To bind an authorization policy to a user by using the GUI

1. Navigate to Citrix Gateway > User Administration.
2. Click AAA Users.
3. In the details pane, select a user and then click Edit.
5. In Policy Binding page, select a policy or create a policy.
6. In Priority, set the priority number.
7. In Type, select the request type and then click OK.

To bind an authorization policy to a group by using the GUI

1. Navigate to Citrix Gateway > User Administration.
2. Click **AAA Groups**.
3. In the details pane, select a group and then click **Edit**.
4. In **Advanced Settings**, click **Authorization Policies**.
5. In **Policy Binding** page, select a policy or create a policy.
6. In **Priority**, set the priority number.
7. In **Type**, select the request type and then click **OK**.

## Setting Default Global Authorization

April 23, 2019

To define the resources to which users have access on the internal network, you can configure default global authorization. You configure global authorization by allowing or denying access to network resources globally on the internal network.

Any global authorization action you create is applied to all users who do not already have an authorization policy associated with them, either directly or through a group. A user or group authorization policy always overrides the global authorization action. If the default authorization action is set to Deny, you must apply authorization policies for all users or groups in order to make network resources accessible to those users or groups. This requirement helps to improve security.

To set default global authorization:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Security tab, next to Default Authorization Action, select Allow or Deny then and click OK.

## Disabling Authentication

April 23, 2019

If your deployment does not require authentication, you can disable it. You can disable authentication for each virtual server that does not require authentication.

Important: Citrix recommends disabling authentication with caution. If you are not using an external authentication server, create local users and groups to allow Citrix Gateway to authenticate users. Disabling authentication stops the use of authentication, authorization, and accounting features that
control and monitor connections to Citrix Gateway. When users type a web address to connect to Citrix Gateway, the logon page does not appear.

**To disable authentication**

1. In the configuration utility, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. On the Authentication tab, under User Authentication, click to clear Enable Authentication.

**Configuring Authentication for Specific Times**

April 23, 2019

You can configure an authentication policy so users are allowed access to the internal network at specific times, such as during normal working hours. When users try to log on at a different time, logon is denied.

To restrict when users log on to Citrix Gateway, create an expression within the authentication policy and then bind it to a virtual server or globally.

**To configure authentication for time, date, or day of week**

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Under Authentication, select the authentication type.
3. In the details pane, click the Policies tab, select an authentication policy and then click Open.
4. In the Configure Authentication Policy dialog box, under Expression, next to Match Any Expression, click Add.
5. In the Add Expression dialog box, in Expression Type, select Date/Time.
6. In Qualifier, select one of the following:
   - TIME to configure the time users cannot log on.
   - DATE to configure the date users cannot log on.
   - DAYOFWEEK to configure the day users cannot log on.
7. In Operator, select the value.
8. In Value, click the calendar next to the text box and then select the day, date, or time.
9. Click OK twice, click Close, and click OK.
How Authentication Policies Work

April 23, 2019

When users log on to Citrix Gateway, they are authenticated according to a policy that you create. The policy defines the authentication type. A single authentication policy can be used for simple authentication needs and is typically bound at the global level. You can also use the default authentication type, which is local. If you configure local authentication, you must also configure users and groups on Citrix Gateway.

You can configure multiple authentication policies and bind them to create a detailed authentication procedure and virtual servers. For example, you can configure cascading and two-factor authentication by configuring multiple policies. You can also set the priority of the authentication policies to determine which servers and the order in which Citrix Gateway checks user credentials. An authentication policy includes an expression and an action. For example, if you set the expression to True value, when users log on, the action evaluates user logon to true and then users have access to network resources.

After you create an authentication policy, you bind the policy at either the global level or to virtual servers. When you bind at least one authentication policy to a virtual server, any authentication policies that you bound to the global level are not used when users log on to the virtual server, unless the global authentication type has a higher precedence than the policy bound to the virtual server.

When a user logs on to Citrix Gateway, authentication is evaluated in the following order:

• The virtual server is checked for any bound authentication policies.
• If authentication policies are not bound to the virtual server, Citrix Gateway checks for global authentication policies.
• If an authentication policy is not bound to a virtual server or globally, the user is authenticated through the default authentication type.

If you configure LDAP and RADIUS authentication policies and want to bind the policies globally for two-factor authentication, you can select the policy in the configuration utility and then select if the policy is the primary or secondary authentication type. You can also configure a group extraction policy.

Configuring Authentication Profiles

April 23, 2019
You can create an authentication profile by using the Citrix Gateway wizard or the configuration utility. The profile contains all of the settings for the authentication policy. You configure the profile when you create the authentication policy.

With the Citrix Gateway wizard, you can use the chosen authentication type to configure authentication. If you want to configure additional authentication policies after running the wizard, you can use the configuration utility. For more information about the Citrix Gateway wizard, see Configuring Settings by Using the Citrix Gateway Wizard.

To create an authentication policy by using the configuration utility

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, under Authentication, select an authentication type.
3. In the details pane, on the Policies tab, click Add.
4. If you are using an external authentication type, next to Server, click New.
5. In the Create Authentication Server dialog box, configure the settings for your authentication type, click Create and then click Close.
6. In the Create Authentication Policy dialog box, next to Named Expressions, select True value, click Add Expression, click Create and then click Close.
   Note: When you select an authentication type and save the authentication profile, you cannot change the authentication type. To use a different authentication type, you must create a new policy.

To modify an authentication policy by using the configuration utility

You can modify configured authentication policies and profiles, such as the IP address of the authentication server or the expression.

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, under Authentication, select an authentication type.
3. In the details pane, on the Servers tab, select a server and then click Open.

To remove an authentication policy

If you changed or removed an authentication server from your network, remove the corresponding authentication policy from Citrix Gateway.

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, under Authentication, select an authentication type.
3. In the details pane, on the Policies tab, select a policy and then click Remove.

**Binding Authentication Policies**

April 23, 2019

After you configure the authentication policies, you bind the policy either globally or to a virtual server. You can use either the configuration utility to bind an authentication policy.

To bind an authentication policy globally by using the configuration utility:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Click an authentication type.
3. In the details pane, on the Policies tab, click a server and then in Action, click Global Bindings.
4. On the Primary or Secondary tab, under Details, click Insert Policy.
5. Under Policy Name, select the policy and then click OK.

   **Note:** When you select the policy, Citrix Gateway sets the expression to True value automatically.

To unbind a global authentication policy by using the configuration utility:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
3. In the Bind/Unbind Authentication Policies to Global dialog box, on the Primary or Secondary tab, in Policy Name, select the policy, click Unbind Policy and then click OK.

**Setting Priorities for Authentication Policies**

April 23, 2019

By default, authentication polices are validated first against policies that you bind to the virtual server and then against policies bound globally. If you bind an authentication policy globally and want the global policy to take precedence over a policy that you bind to a virtual server, you can change the priority number of the policy. Priority numbers start at zero. A lower priority number gives the authentication policy higher precedence.
For example, if the global policy has a priority number of one and the virtual server has a priority of two, the global authentication policy is applied first.

**To set or change the priority for global authentication policies**

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
3. In the Bind/Unbind Authentication Global Policies dialog box, on either the Primary or Secondary tab, under Priority, type the number and then click OK.

**To change the priority for an authentication policy bound to a virtual server**

You can also modify an authentication policy that is bound to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. Select a virtual server and then click Open.
3. Click the Authentication tab and then select either Primary or Secondary.
4. Select the policy and in Priority, type the number of the priority and then click OK.

**Configuring Local Users**

April 23, 2019

You can create user accounts locally on Citrix Gateway to supplement the users on authentication servers. For example, you might want to create local user accounts for temporary users, such as consultants or visitors, without creating an entry for those users on the authentication server.

If you are using local authentication, create users and then add them to groups that you create on Citrix Gateway. After configuring users and groups, you can apply authorization and session policies, create bookmarks, specify applications, and specify the IP address of file shares and servers to which users have access.

**To create local users**

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Users.
2. In the details pane, click Add.
3. In User Name, type the user name.
4. If you are using local authentication, clear External Authentication.
   Note: Select External Authentication to have users authenticate against an external authentication server, such as LDAP or RADIUS. Clear the check box to have Citrix Gateway authenticate against the local user database.
5. In Password and Confirm Password, type the password for the user, click Create and then click Close.

To change a user password

After creating a local user, you can change the user’s password or configure the user account to be authenticated against an external authentication server.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Users.
2. In the details pane, select a user and then click Open.
3. In Password and Confirm Password, type the new password for the user and then click OK.

To change a user’s authentication method

If you have users who are configured for local authentication, you can change the authentication to an external authentication server. To do this, enable external authentication.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Users.
2. In the details pane, select a user and then click Open.
3. Select External Authentication and then click OK.

To remove a user

You can also remove a user from Citrix Gateway.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Users.
2. In the details pane, select a user and then click Remove.

When you remove a user from Citrix Gateway, all associated policies are also removed from the user profile.
You can have groups on Citrix Gateway that are local groups and can authenticate users with local authentication. If you are using external servers for authentication, groups on Citrix Gateway are configured to match groups configured on authentication servers in the internal network. When a user logs on and is authenticated, if a group name matches a group on an authentication server, the user inherits the settings for the group on Citrix Gateway. After you configure groups, you can apply authorization and session policies, create bookmarks, specify applications, and specify the IP address of file shares and servers to which the user has access. If you are using local authentication, create users and add them to groups that are configured on Citrix Gateway. The users then inherit the settings for that group.

Important: If users are a member of an Active Directory group, the name of the group on Citrix Gateway must be the same as the Active Directory group.

To create a new group

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Groups.
2. In the details pane, click Add.
3. In Group Name, type a name for the group, click Create and then click Close.

To delete a group

You can also delete user groups from Citrix Gateway.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Groups.
2. In the details pane, select the group and then click Remove.

Adding Users to Groups

You can add users to a group either during creation of the group or at a later time. You can add users to multiple groups so users can inherit the policies and settings that are bound to those groups.
To add users to groups:

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand Citrix Gateway > User Administration and then click AAA Groups.
2. In the details pane, select a group, and then click Open.
3. On the Users tab, under Available Users, select the users, click Add and click OK.

**Configuring Policies with Groups**

April 23, 2020

After you configure groups, you can use the Group dialog box to apply policies and settings that specify user access. If you are using local authentication, you create users and add them to groups that are configured on Citrix Gateway. The users then inherit the settings for that group.

You can configure the following policies or settings for a group of users in the Group dialog box:

- Users
- Authorization policies
- Auditing policies
- Session policies
- Traffic policies
- Bookmarks
- Intranet applications
- Intranet IP addresses

In your configuration, you might have users that belong to more than one group. In addition, each group might have one or more bound session policies, with different parameters configured. Users that belong to more than one group inherit the session policies assigned to all the groups to which the user belongs. To ensure which session policy evaluation takes precedence over the other, you must set the priority of the session policy.

For example, you have group1 that is bound with a session policy configured with the home page www.homepage1.com. Group2 is bound with a session policy configured with home page www.homepage2.com. When these policies are bound to respective groups without a priority number or with a same priority number, the home page that appears to users who belong to both the groups depends on which policy is processed first. By setting a lower priority number, which gives higher precedence, for the session policy with home page www.homepage1.com, you can ensure that users who belong to both the groups receive the home page www.homepage1.com.

If session policies do not have a priority number assigned or have the same priority number, precedence is evaluated in the following order:
• User
• Group
• Virtual server
• Global

If policies are bound to the same level, without a priority number or if the policies have the same priority number, the order of evaluation is per the policy bind order. Policies that are bound first to a level receive precedence over policies bound later.

If we have a user bound to multiple groups with each group having IIP bound, the user can get free IP from any of the bound groups.

Configuring LDAP Authentication

April 23, 2019

You can configure the Citrix Gateway to authenticate user access with one or more LDAP servers.

LDAP authorization requires identical group names in Active Directory, on the LDAP server, and on Citrix Gateway. The characters and case must also match.

By default, LDAP authentication is secure by using Secure Sockets Layer (SSL) or Transport Layer Security (TLS). There are two types of secure LDAP connections. With one type, the LDAP server accepts the SSL or TLS connections on a port separate from the port that the LDAP server uses to accept clear LDAP connections. After users establish the SSL or TLS connections, LDAP traffic can be sent over the connection.

The port numbers for LDAP connections are:

• 389 for unsecured LDAP connections
• 636 for secure LDAP connections
• 3268 for Microsoft unsecure LDAP connections
• 3269 for Microsoft secure LDAP connections

The second type of secure LDAP connections use the StartTLS command and uses port number 389. If you configure port numbers 389 or 3268 on Citrix Gateway, the server tries to use StartTLS to make the connection. If you use any other port number, the server attempts to make connections by using SSL or TLS. If the server cannot use StartTLS, SSL, or TLS, the connection fails.

If you specify the root directory of the LDAP server, Citrix Gateway searches all of the subdirectories to find the user attribute. In large directories, this approach can affect performance. For this reason, Citrix recommends that you use a specific organizational unit (OU).

The following table contains examples of user attribute fields for LDAP servers:

© 1999-2020 Citrix Systems, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>LDAP server</th>
<th>User attribute</th>
<th>Case sensitive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Active Directory Server</td>
<td>sAMAccountName</td>
<td>No</td>
</tr>
<tr>
<td>Novell eDirectory</td>
<td>ou</td>
<td>Yes</td>
</tr>
<tr>
<td>IBM Directory Server</td>
<td>uid</td>
<td>Yes</td>
</tr>
<tr>
<td>Lotus Domino</td>
<td>CN</td>
<td>Yes</td>
</tr>
<tr>
<td>Sun ONE directory (formerly iPlanet)</td>
<td>uid or cn</td>
<td>Yes</td>
</tr>
</tbody>
</table>

This table contains examples of the base DN:

<table>
<thead>
<tr>
<th>LDAP server</th>
<th>Base DN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Active Directory Server</td>
<td>DC=citrix,DC=local</td>
</tr>
<tr>
<td>Novell eDirectory</td>
<td>ou=users,ou=dev</td>
</tr>
<tr>
<td>IBM Directory Server</td>
<td>cn=users</td>
</tr>
<tr>
<td>Lotus Domino</td>
<td>OU=City,O=Citrix, C=US</td>
</tr>
<tr>
<td>Sun ONE directory (formerly iPlanet)</td>
<td>ou=People,dc=citrix,dc=com</td>
</tr>
</tbody>
</table>

The following table contains examples of bind DN:

<table>
<thead>
<tr>
<th>LDAP server</th>
<th>Bind DN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Active Directory Server</td>
<td>CN=Administrator, CN=Users, DC=citrix, DC=local</td>
</tr>
<tr>
<td>Novell eDirectory</td>
<td>cn=admin, o=citrix</td>
</tr>
<tr>
<td>IBM Directory Server</td>
<td>LDAP_dn</td>
</tr>
<tr>
<td>Lotus Domino</td>
<td>CN=Notes Administrator, O=Citrix, C=US</td>
</tr>
<tr>
<td>Sun ONE directory (formerly iPlanet)</td>
<td>uid=admin,ou=Administrators, ou=TopologyManagement,o=NetscapeRoot</td>
</tr>
</tbody>
</table>

**Note:** For more information regarding LDAP server settings, see [Determining Attributes in Your LDAP Directory](#).
To configure LDAP authentication by using the configuration utility

October 22, 2019

1. Navigate to Citrix Gateway >Policies > Authentication.
2. Click LDAP.
3. In the details pane, on the Policies tab, click Add.
4. In Name, type a name for the policy.
5. Next to Server, click New.
6. In Name, type the name of the server.
7. Under Server, in IP Address and Port, type the IP address and port number of the LDAP server.
8. In Type, select either AD for Active Directory or NDS for Novell Directory Services.
9. Under Connection Settings, complete the following:
   a) In Base DN (location of users), type the base DN under which users are located. Base DN search the users located under the selected directory (AD or NDS).

   The base DN is derived from the Bind DN by removing the user name and specifying the group where users are located. Examples of syntax for base DN are:

   - 1 ou=users,dc=ace,dc=com
   - 2 cn=Users,dc=ace,dc=com

   b) In Administrator Bind DN, type the administrator bind DN for queries to the LDAP directory. Examples for syntax of bind DN are:

   - 1 domain/username
   - 2 ou=administrator,dc=ace,dc=com
   - 3 user@domain.name (for Active Directory)
   - 4 cn=Administrator,cn=Users,dc=ace,dc=com

   For Active Directory, the group name specified as cn=groupname is required. The group name that you define in Citrix Gateway and the group name on the LDAP server must be identical.

   For other LDAP directories, the group name either is not required or, if necessary, is specified as ou=groupname.

   Citrix Gateway binds to the LDAP server using the administrator credentials and then searches for the user. After locating the user, Citrix Gateway unbinds the administrator credentials and rebinds with the user credentials.
c) In **Administrator Password and Confirm Administrator Password**, type the administrator password for the LDAP server.

10. To retrieve more LDAP settings automatically, click **Retrieve Attributes**.

   When you click **Retrieve Attributes**, the fields under Other Settings populate automatically. If you want to ignore this step, continue with Steps 12 and 13. Otherwise, skip to Step 14.

11. Under **Other Settings**, in Server Logon Name Attribute, type the attribute under which Citrix Gateway should look for user logon names for the LDAP server that you are configuring. The default is `samAccountName`.

12. In **Search Filter**, type the value to search for the users associated with single or multiple active directory groups.

   For example, “memberOf=CN=GatewayAccess,OU=Groups,DC=Users,DC=lab”.

   **Note**
   
   You can use the preceding example to restrict Citrix Gateway access only to the members of a specific AD group.

13. In **Group Attribute**, leave the default `memberOf` for Active Directory or change the attribute to the attribute of the LDAP server type you are using. This attribute enables Citrix Gateway to obtain the groups associated with a user during authorization.

14. In **Security Type**, select the security type and then click **Create**.

15. To allow users to change their LDAP password, select **Allow Password Change**.

   **Note:**
   
   - If you select **PLAINTEXT** as the security type, allowing users to change their passwords is not supported.
   - If you select **PLAINTEXT** or **TLS** for security, use port number 389. If you select **SSL**, use port number 636.

### Determining Attributes in Your LDAP Directory

April 23, 2019

If you need help determining your LDAP directory attributes so you can configure authentication settings on Citrix Gateway, you can easily look them up with the free LDAP browser from Softerra.

You can download the LDAP browser from the [Softerra LDAP Administrator Web site](#). After you install the browser, set the following attributes:
• The host name or IP address of your LDAP server.
• The port of your LDAP server. The default is 389.
• The base DN field, which you can leave blank. The information provided by the LDAP browser can help you determine the base DN that you need to configure this setting on Citrix Gateway.
• The Anonymous Bind check determines if the LDAP server requires user credentials to connect to it. If the LDAP server requires credentials, leave the check box cleared.

After completing the settings, the LDAP browser displays the profile name in the left pane and connects to the LDAP server.

Configuring LDAP Group Extraction

April 23, 2019

If you are using two-factor authentication, groups extracted from both the primary and secondary authentication sources are concatenated. Authorization policies can be applied to the group that is extracted from the primary or secondary authentication server.

The group names obtained from the LDAP server are compared with the group names created locally on Citrix Gateway. If the two group names match, the properties of the local group apply to the group obtained from the LDAP servers.

If users belong to more than one LDAP group, Citrix Gateway extracts user information from all the groups to which users belong. If a user is a member of two groups on Citrix Gateway and each group has a bound session policy, the user inherits the session policies from both groups. To make sure that users receive the correct session policy, set the priority for the session policy.

For more information about LDAP group membership attributes that will and will not work with Citrix Gateway authorization, see the following:
• How LDAP Group Extraction Works from the User Object Directly
• How LDAP Group Extraction Works from the Group Object Indirectly

How LDAP Group Extraction Works from the User Object Directly

April 23, 2019

LDAP servers that evaluate group memberships from group objects work with Citrix Gateway authorization.
Some LDAP servers enable user objects to contain information about groups to which the objects belong, such as Active Directory (by using the memberOf attribute) or IBM eDirectory (by using the groupMembership attribute). A user's group membership can be attributes from the user object, such as IBM Directory Server (by using ibm-allGroups) or Sun ONE directory server (by using nsRole). Both of these types of LDAP servers work with Citrix Gateway group extraction.

For example, in IBM Directory Server, all group memberships, including the static, dynamic, and nested groups, can be returned through the use of the ibm-allGroups attribute. In Sun ONE, all roles, including managed, filtered, and nested, are calculated through the use of the nsRole attribute.

**How LDAP Group Extraction Works from the Group Object Indirectly**

April 23, 2019

LDAP servers that evaluate group memberships from group objects indirectly will not work with Citrix Gateway authorization.

Some LDAP servers, such as Lotus Domino, enable group objects only to contain information about users. These LDAP servers do not enable the user object to contain information about groups and thus will not work with Citrix Gateway group extraction. For this type of LDAP server, group membership searches are performed by locating the user in the member list of groups.

**LDAP Authorization Group Attribute Fields**

April 23, 2019

The following table contains examples of LDAP group attribute fields:

<table>
<thead>
<tr>
<th>LDAP servers</th>
<th>LDAP attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Active Directory Server</td>
<td>memberOf</td>
</tr>
<tr>
<td>Novell eDirectory</td>
<td>groupMembership</td>
</tr>
<tr>
<td>IBM Directory Server</td>
<td>ibm-allGroups</td>
</tr>
<tr>
<td>Sun ONE directory (formerly iPlanet)</td>
<td>nsRole</td>
</tr>
</tbody>
</table>
**To configure LDAP authorization**

April 23, 2019

You configure LDAP authorization in the authentication policy by setting the group attribute name and the subattribute.

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Under Authentication, click an authentication type.
3. In the details pane, click Add.
4. In Name, type a name for the policy.
5. Next to Server, click New.
6. In Name, type the name of the server.
7. Under Server, type the IP address and port of the LDAP server.
8. In Group Attribute, type memberOf.
9. In Sub attribute Name, type CN and then click Create.
10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expression, click Add Expression, click Create and then click Close.

**Configuring LDAP Nested Group Extraction**

April 23, 2019

Citrix Gateway can query LDAP groups and extract group and user information from ancestor groups that you configure on the authentication server. For example, you created group1 and within that group, you created group2 and group3. If the user belongs to group3, Citrix Gateway extracts information from all the nested ancestor groups (group2, group1) up to the specified level.

You can use an authentication policy to configure LDAP nested group extraction. When the query is run, Citrix Gateway searches the groups until it reaches the maximum nesting level or until it searches all available groups.

**To configure LDAP nested group extraction**

1. In the configuration utility, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization > Authentication >> Authentication and then click LDAP.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Server, click New.
5. In Name, type the name of the server.
6. Configure the settings for the LDAP server.
7. Expand Nested Group Extraction and then click Enable.
8. In Maximum Nesting Level, type the number of levels that Citrix Gateway checks.
9. In Group Name Identifier, type the LDAP attribute name that uniquely identifies a group name on the LDAP server, such as sAMAccountName.
10. In Group Search Attribute, type the LDAP attribute name that is to be obtained in the search response to determine the parent groups of any group, such as memberOf.
11. In Group Search Sub-Attribute, type the LDAP subattribute name that is to be searched for as part of the Group Search Attribute to determine the parent groups of any group. For example, type CN.
12. In Group Search Filter, type the query string. For example, the filter could be (&(samaccountname=test)(objectClass=*)).
13. Click Create and then click Close.
14. In the Create Authentication Policy dialog box, next to Named Expressions, select the expression, click Add Expression, click Create and then click Close.

Configuring LDAP Group Extraction for Multiple Domains

April 23, 2019

If you have multiple domains for authentication and are using StoreFront or the Web Interface, you can configure Citrix Gateway to use group extraction to send the correct domain name to the Web Interface.

In Active Directory, you need to create a group for each domain in your network. After you create the group, you add users that belong to the group and specified domain. After the groups are configured in Active Directory, you configure LDAP group extraction for multiple domains on Citrix Gateway.

To configure Citrix Gateway for group extraction for multiple domains, you need to create the same number of session and authentication policies as the number of domains in your network. For example, you have two domains, named Sampa and Child. Each domain receives one session policy and one authentication policy.

After creating the policies, you create groups on Citrix Gateway, and you bind the session policies to the group. Then, you bind the authentication policies to a virtual server.

If you deploy StoreFront in multiple domains, there must be a trust relationship between domains.

If you deploy Citrix Endpoint Management or the Web Interface in multiple domains, the domains do not need to trust each other.
Creating Session Policies for Group Extraction

April 23, 2019

The first step when you create session policies for group extraction is to create two session profiles and set the following parameters:

- Enable ICA proxy.
- Add the Web Interface Web address.
- Add the Windows domain.
- Add the profile to a session policy and set the expression to true.

To create the session profiles for group extraction

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click the Profiles tab and then click Add.
3. In Name, type a name for the profile. For example, type Sampa.
4. On the Published Applications tab, do the following:
   a) Next to ICA Proxy, click Override Global and then select ON.
   b) Next to Web Interface Address, click Override Global and then type the Web address of the Web Interface.
   c) Next to Single Sign-On Domain, click Override Global, type the name of the Windows domain and then click Create.
5. In Name, clear the name of the first domain and type the name of the second domain, such as Child.
6. Next to Single Sign-On Domain, clear the name of the first Windows domain and type the name of the second domain, click Create and then click Close.

After you create the session profiles, you create two session policies. Each session policy uses one of the profiles.

To create a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. In Request Profile, select the profile for the first domain.
5. Next to Named Expressions, click General, select True value, click Add Expression and then click Create.
6. In Name, change the name to the second domain.
7. In Request Profile, select the profile for the second domain, click Create and then click Close.

Creating LDAP Authentication Policies for Multiple Domains

April 23, 2019

After you create session policies on Citrix Gateway, you create LDAP authentication policies that are almost identical. When configuring the authentication policy, the important field is Search Filter. In this field, you must type the name of the group you created in Active Directory.

Create the authentication profiles first and then create the authentication policy.

To create authentication profiles for multiple domain group extraction

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, click LDAP.
3. In the details pane, click the Servers tab and then click Add.
4. In Name, type the name of the first domain, such as Sampa.
5. Configure the settings for the LDAP server and then click Create.
6. Repeat Steps 3, 4, and 5 to configure the authentication profile of the second domain and then click Close.

After you create and save the profiles, create the authentication policies.

To create authentication policies for multiple domain group extraction

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the details pane, click the Policies tab and then click Add.
3. In Name, type the name of the first domain.
4. In Authentication Type, select LDAP.
5. In Server, select the authentication profile for the first domain.
6. Next to Named Expressions, click General, select True value, click Add Expression and then click Create.
7. In Name, type the name of the second domain.
8. In Server, select the authentication profile for the second domain, click Create and then click Close.

Creating Groups and Binding Policies for LDAP Group Extraction for Multiple Domains

April 23, 2019

After you create authentication policies, you create groups on Citrix Gateway. After you create the groups, you bind the authentication policy to a virtual server.

To create groups on Citrix Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > User Administration, and then click AAA Groups.
2. In the details pane, click Add.
3. In Group Name, type the name of the first Active Directory group.
   Important: When creating groups on Citrix Gateway for group extraction from multiple domains, group names must be the same as the groups you defined in Active Directory. Group names are also case-sensitive and the case must match the case you entered in Active Directory.
4. On the Policies tab, click Session and then click Insert Policy.
5. Under Policy Name, double-click the policy and then click Create.

To bind the authentication policies to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the configuration utility, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
3. In the details pane, click a virtual server and then click Open.
4. On the Authentication tab, click Primary, under Policy Name, double-click Insert Policy and then select the first authentication policy.
5. Under Policy Name, click Insert Policy, double-click the second authentication policy and then click OK.
Configuring Client Certificate Authentication

April 23, 2019

Users logging on to a Citrix Gateway virtual server can also be authenticated based on the attributes of the client certificate that is presented to the virtual server. Client certificate authentication can also be used with another authentication type, such as LDAP or RADIUS, to provide two-factor authentication.

To authenticate users based on the client-side certificate attributes, client authentication should be enabled on the virtual server and the client certificate should be requested. You must bind a root certificate to the virtual server on Citrix Gateway.

When users log on to the Citrix Gateway virtual server, after authentication, the user name information is extracted from the specified field of the certificate. Typically, this field is Subject:CN. If the user name is extracted successfully, the user is then authenticated. If the user does not provide a valid certificate during the Secure Sockets Layer (SSL) handshake or if the user name extraction fails, authentication fails.

You can authenticate users based on the client certificate by setting the default authentication type to use the client certificate. You can also create a certificate action that defines what is to be done during the authentication based on a client SSL certificate.

To configure the client certificate as the default authentication type

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change authentication settings.
3. In Maximum Number of Users, type the number of users who can be authenticated using the client certificate.
4. In Default Authentication Type, select Cert.
5. In User Name Field, select the type of certificate field that holds the user names.
6. In Group Name Field, select the type of the certificate field that holds the group name.
7. In Default Authorization Group, type the name of the default group and then click OK.

Extracting the User Name from the Client Certificate

If client certificate authentication is enabled on Citrix Gateway, users are authenticated based on certain attributes of the client certificate. After authentication is completed successfully, the user name or the user and group name of the user are extracted from the certificate and any policies specified for that user are applied.
Configuring and Binding a Client Certificate Authentication Policy

April 23, 2019

You can create a client certificate authentication policy and bind it to a virtual server. You can use the policy to restrict access to specific groups or users. This policy takes precedence over the global policy.

To configure a client certificate authentication policy:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, under Authentication, click CERT.
3. In the details pane, click Add.
4. In Name field, type a name for the policy.
5. Next to Server, click New.
6. In Name, type a name for the profile.
7. Next to Two Factor, select OFF.
8. In User Name field and Group Name field, select the values and then click &Create.
   Note: If you previously configured client certificates as the default authentication type, use the same names that you used for the policy. If you completed the User Name field and Group Name field for the default authentication type, use the same values for the profile.
9. In the Create Authentication Policy dialog box, next to Named Expressions, select the expression, click Add Expression, click Create and then click Close.

To bind a client certificate policy to a virtual server:

After you configure the client certificate authentication policy, you can bind it to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. In the configure Citrix Gateway Virtual Server dialog box, click the Authentication tab.
4. Click Primary or Secondary.
5. Under Details, click Insert Policy.
6. In Policy Name, select the policy and then click OK.

To configure a virtual server to request the client certificate:

When you want to use a client certificate for authentication, you must configure the virtual server so that client certificates are requested during the SSL handshake.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a **Virtual Server** and then click **Open**.
3. On the **Certificates** tab, click **SSL Parameter**.
4. Under **Others**, click **Client Authentication**.
5. In **Client Certificate**, select **Optional** or **Mandatory** and then click OK twice. Select **Optional** if you want to allow other authentication types on the same virtual server and do not require the use of client certificates.

**Note**
- For more information about Callback URL, see **Import a Citrix Gateway**.
- For more information about certificates, see **Install, link, and update certificates**.

### Configuring Two-Factor Client Certificate Authentication

**April 23, 2019**

You can configure a client certificate to authenticate users first and then require users to log on with a secondary authentication type, such as LDAP or RADIUS. In this scenario, the client certificate authenticates users first. Then, a logon page appears where they can enter their user name and password. When the Secure Sockets Layer (SSL) handshake is complete, the logon sequence can take one of the following two paths:

- Neither the user name nor the group is extracted from the certificate. The logon page appears to the user with a prompt to enter valid logon credentials. Citrix Gateway authenticates the user credentials as in the case of normal password authentication.
- The user name and group name are extracted from the client certificate. If only the user name is extracted, a logon page appears to the user in which the logon name is present and the user cannot modify the name. Only the password field is blank.

Group information that Citrix Gateway extracts during the second round of authentication is appended to the group information, if any, that Citrix Gateway extracted from the certificate.

### Configuring Smart Card Authentication

**September 10, 2019**

You can configure Citrix Gateway to use a cryptographic smart card to authenticate users.

To configure a smart card to work with Citrix Gateway, you need to do the following:
• Create a certificate authentication policy. For more information, see Configuring Client Certificate Authentication.

• Bind the authentication policy to a virtual server.

• Add the root certificate of the Certificate Authority (CA) issuing the client certificates to Citrix Gateway. For more information, see To install a root certificate on Citrix Gateway.

Important: When you add the root certificate to the virtual server for smart card authentication, you must select the certificate from the Select CA Certificate drop-down box, as shown in the following figure.

Figure 1. Adding a root certificate for smart card authentication

After you create the client certificate, you can write the certificate, known as flash, onto the smart card. When you complete that step, you can test the smart card.

If you configure the Web Interface for smart card passthrough authentication, if either of the following conditions exist, single sign-on to the Web Interface fails:

• If you set the domain on the Published Applications tab as mydomain.com instead mydomain.
• If you do not set the domain name on the Published Applications tab and if you run the command wi-sso-split-upn setting the value to 1. In this instance, the UserPrincipalName contains the domain name “mydomain.com.”
You can use smart card authentication to streamline the logon process for your users while also enhancing the security of user access to your infrastructure. Access to the internal corporate network is protected by certificate-based two-factor authentication using public key infrastructure. Private keys are protected by hardware controls and never leave the smart card. Your users get the convenience of accessing their desktops and applications from a range of corporate devices using their smart cards and PINs.

You can use smart cards for user authentication through StoreFront to desktops and applications provided by Citrix Virtual Apps and Desktops. Smart card users logging on to StoreFront can also access applications provided by Citrix Endpoint Management. However, users must authenticate again to access Endpoint Management web applications that use client certificate authentication.

For more information, see Configure smart card authentication in the StoreFront documentation.

**Configuring Smart Card Authentication with Secure ICA Connections**

Users who log on and establish a secure ICA connection by using a smart card with single sign-on configured on Citrix Gateway might receive prompts for their personal identification number (PIN) at two different times: when logging on and when trying to start a published resource. This situation occurs if the web browser and the Citrix Workspace app are using the same virtual server that is configured to use client certificates. Citrix Workspace app does not share a process or a Secure Sockets Layer (SSL) connection with the web browser. Therefore, when the ICA connection completes the SSL handshake with Citrix Gateway, the client certificate is required a second time.

To prevent users from receiving the second PIN prompt, you have to change two settings:

- Client authentication on the VPN Virtual Server must be disabled.
- SSL renegotiation must be enabled.

After you configure the virtual server, bind one or more STA servers to the virtual server, as described in Configuring Citrix Gateway Settings in Web Interface 5.3.

You might also want to test smart-card authentication.

To disable client authentication:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. Select the relevant virtual server in the main details pane, and then click Edit.
3. In the Advanced options pane, click SSL Parameters.
4. Clear the Client Authentication check box.
5. Click Done.

To enable SSL renegotiation:
Using the configuration utility, from the Configuration tab, navigate to Traffic Management, and then click SSL.

In the main panel, click Change advanced SSL settings.

From the Deny SSL Renegotiation menu, select NO.

To test smart card authentication:

1. Connect the smart card to the user device.
2. Open your web browser and log on to Citrix Gateway.

**Configuring a Common Access Card**

April 23, 2019

The United States Department of Defense uses common access cards for identification and authentication.

To configure a common access card:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. On the Servers tab, click Add.
3. In Name, type a name.
4. In Authentication Type, select Cert.
5. In User Name Field, type SubjectAltName:PrincipalName and then click Create.
6. On the Policies tab, create a policy that uses this server and then bind the policy to the virtual server.

**Configuring RADIUS Authentication**

April 23, 2019

You can configure Citrix Gateway to authenticate user access with one or more RADIUS servers. If you are using RSA SecurID, SafeWord, or Gemalto Protiva products, each of these is configured by using a RADIUS server.

Your configuration might require using a network access server IP address (NAS IP) or a network access server identifier (NAS ID). When configuring Citrix Gateway to use a RADIUS authentication server, use the following guidelines:
• If you enable use of the NAS IP, the appliance sends its configured IP address to the RADIUS server, rather than the source IP address used in establishing the RADIUS connection.
• If you configure the NAS ID, the appliance sends the identifier to the RADIUS server. If you do not configure the NAS ID, the appliance sends its host name to the RADIUS server.
• When you enable the NAS IP, the appliance ignores any NAS ID that is configured using the NAS IP to communicate with the RADIUS server.

**Configuring Gemalto Protiva**

Protiva is a strong authentication platform that Gemalto developed to use the strengths of Gemalto’s smart card authentication. With Protiva, users log on with a user name, password, and a one-time password that the Protiva device generates. Similar to RSA SecurID, the authentication request is sent to the Protiva authentication server and the server either validates or rejects the password. To configure Gemalto Protiva to work with Citrix Gateway, use the following guidelines:

• Install the Protiva server.
• Install the Protiva SAS Agent Software, that extends the Internet Authentication Server (IAS), on a Microsoft IAS RADIUS server. Make sure you note the IP address and port number of the IAS server.
• Configure a RADIUS authentication profile on Citrix Gateway and enter the settings of the Protiva server.

**Configuring SafeWord**

The SafeWord product line provides secure authentication using a token-based passcode. After the user enters the passcode, SafeWord immediately invalidates the passcode and it cannot be used again. When you configure the SafeWord server, you need the following information:

• The IP address of Citrix Gateway. This should be the same IP address that you configured in the RADIUS server client configuration. Citrix Gateway uses the internal IP address to communicate with the RADIUS server. When you configure the shared secret, use the internal IP address. If you configure two appliances for high availability, use the virtual internal IP address.
• A shared secret.
• The IP address and port of the SafeWord server. The default port number is 1812.

**To configure RADIUS authentication**

April 23, 2019
1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Click RADIUS, and then in the details pane, on the Policies tab, click Add.
3. In the Create Authentication Policy dialog box, in Name, type a name for the policy.
4. In Name, type a name for the policy.
5. Next to Server, click New.
6. In the Create Authentication Policy dialog box, in Name, type a name for the server.
7. Under Server, in IP Address, type the IP address of the RADIUS server.
8. In Port, type the port. The default is 1812.
9. Under Details, in Secret Key and Confirm Secret Key, type the RADIUS server secret.
10. In NAS ID, type the identifier number and then click Create.
11. In the Create Authentication Policy dialog box, next to Named Expressions, select the expression, click Add Expression, click Create and then click Close.

Choosing RADIUS Authentication Protocols

April 23, 2019

Citrix Gateway supports implementations of RADIUS that are configured to use several protocols for user authentication, including:

- Password Authentication Protocol (PAP)
- Challenge-Handshake Authentication Protocol (CHAP)
- Microsoft Challenge-Handshake Authentication Protocol (MS-CHAP Version 1 and Version 2)

If your deployment of the Citrix Gateway is configured to use RADIUS authentication and your RADIUS server is configured to use PAP, you can strengthen user authentication by assigning a strong shared secret to the RADIUS server. Strong RADIUS shared secrets consist of random sequences of uppercase and lowercase letters, numbers, and punctuation and are at least 22 characters long. If possible, use a random character generation program to determine RADIUS shared secrets.

To further protect RADIUS traffic, assign a different shared secret to each Citrix Gateway appliance or virtual server. When you define clients on the RADIUS server, you can also assign a separate shared secret to each client. If you do this, you must configure separately each Citrix Gateway policy that uses RADIUS authentication.

When you create a RADIUS policy, you configure shared secrets on Citrix Gateway as part of the policy.
Configuring IP Address Extraction

April 23, 2019

You can configure Citrix Gateway to extract the IP address from a RADIUS server. When a user authenticates with the RADIUS server, the server returns a framed IP address (also called RADIUS Attribute 8 Framed-IP-Address in Access Requests) that is assigned to the user. The following are components for IP address extraction:

- Allows a remote RADIUS server to supply an IP address from the internal network for a user logged on to Citrix Gateway.
- Allows configuration for any RADIUS attribute using the type ipaddress, including attributes that are vendor encoded.

When configuring the RADIUS server for IP address extraction, you configure the vendor identifier and the attribute type. The vendor ID and attributes are used to make the association between the RADIUS client and the RADIUS server.

- The vendor identifier (ID) enables the RADIUS server to assign an IP address to the client from a pool of IP addresses that are configured on the RADIUS server. The vendor ID is the attribute in the RADIUS response that provides the IP address of the internal network. A value of zero indicates that the attribute is not vendor encoded
- The attribute type is the remote IP address attribute in a RADIUS response. The minimum value is 1 and the maximum value is 255.

A common configuration is to extract the RADIUS attribute framed IP address. The vendor ID is set to 0 or is not specified. The attribute type is set to 8.

To configure IP address extraction from a RADIUS server:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Click RADIUS, and then in the details pane, on the Policies tab, select a RADIUS policy and then click Open.
3. In the Configure Authentication Policy dialog box, next to Server, click Modify.
4. Under Details, in Group Vendor Identifier, type the value.
5. In Group Attribute Type, type the value and then click OK twice.

Configuring RADIUS Group Extraction

April 23, 2019
You can configure RADIUS authorization by using a method called group extraction. Configuring group extraction allows you to administer users on your RADIUS server instead of adding them to Citrix Gateway.

You configure RADIUS authorization by using an authentication policy and configuring the group vendor identifier (ID), the group attribute type, the group prefix, and a group separator. When you configure the policy, you add an expression, and then bind the policy either globally or to a virtual server.

**Configuring RADIUS on Windows Server 2003**

If you are using Microsoft Internet Authentication Service (IAS) for RADIUS authorization on Windows Server 2003, during configuration of Citrix Gateway, you need to provide the following information:

- **Vendor ID** is the vendor-specific code that you entered in IAS.
- **Type** is the vendor-assigned attribute number.
- **Attribute name** is the type of attribute name that you defined in IAS. The default name is CTXSUserGroups=

If IAS is not installed on the RADIUS server, you can install it from Add or Remove Programs in Control Panel. For more information, see the Windows online Help.

To configure IAS, use the Microsoft Management Console (MMC) and install the snap-in for IAS. Follow the wizard, making sure you select the following settings:

- **Select local computer.**
- **Select Remote Access Policies and create a custom policy.**
- **Select Windows-Groups for the policy.**
- **Select one of the following protocols:**
  - Microsoft Challenge-Handshake Authentication Protocol version 2 (MS-CHAP v2)
  - Microsoft Challenge-Handshake Authentication Protocol (MS-CHAP)
  - Challenge-Handshake Authentication Protocol (CHAP)
  - Unencrypted authentication (PAP, SPAP)
- **Select the Vendor-Specific Attribute.**

  The Vendor-Specific Attribute needs to match the users whom you defined in the group on the server with the users on Citrix Gateway. To meet this requirement, you send the Vendor-Specific Attributes to Citrix Gateway. Make sure you select RADIUS=Standard.

- **The RADIUS default is 0. Use this number for the vendor code.**
- **The vendor-assigned attribute number is 0.**

  This is the assigned number for the User Group attribute. The attribute is in string format.
• Select String for the Attribute format.

The Attribute value requires the attribute name and the groups.

For the Access Gateway, the attribute value is CTXSUserGroups=groupname. If two groups are defined, such as sales and finance, the attribute value is CTXSUserGroups=sales;finance. Separate each group with a semicolon.

• Remove all other entries in the Edit Dial-in Profile dialog box, leaving the one that says Vendor-Specific.

After you configure the Remote Access Policy in IAS, you configure RADIUS authentication and authorization on Citrix Gateway.

When configuring RADIUS authentication, use the settings that you configured on the IAS server.

**Configuring RADIUS for Authentication on Windows Server 2008**

On Windows Server 2008, you configure RADIUS authentication and authorization by using the Network Policy Server (NPS), which replaces Internet Authentication Service (IAS). You can use Server Manager and add NPS as a role to install NPS.

When you install NPS, select the Network Policy Service. After installation, you can configure RADIUS settings for your network by starting the NPS from Administrative Services on the Start menu. When you open the NPS, you add Citrix Gateway as a RADIUS client and then configure server groups.

When you configure the RADIUS client, make sure you select the following settings:

• For the vendor name, select RADIUS Standard.
• Make note of the shared secret because you will need to configure the same shared secret on Citrix Gateway.

For the RADIUS groups, you need the IP address or host name of the RADIUS server. Do not change the default settings.

After you configure the RADIUS client and groups, you then configure settings in the following two policies:

• Connection Request Policies where you configure the settings for the Citrix Gateway connection including the type of network server, the conditions for the network policy, and the settings for the policy.
• Network Policies where you configure the Extensible Authentication Protocol (EAP) authentication and the vendor-specific attributes.

When you configure the connection request policy, select Unspecified for the type of network server. You then configure your condition by selecting NAS Port Type as the condition and Virtual (VPN) as the value.
When you configure a network policy, you need to configure the following settings:

- Select Remote Access Server (VPN Dial-up) as the type of network access server.
- Select Encrypted Authentication (CHAP) and Unencrypted Authentication (PAP and SPAP) for the EAP.
- Select RADIUS Standard for the Vendor-Specific Attribute.
  The default attribute number is 26. This attribute is used for RADIUS authorization.
  Citrix Gateway needs the vendor-specific attribute to match the users defined in the group on the server with those on Citrix Gateway. This is done by sending the vendor-specific attributes to the Citrix Gateway.
- Select String for the attribute format.
  The Attribute value requires the attribute name and the groups.
  For Citrix Gateway, the attribute value is CTXSUserGroups= groupname. If two groups are defined, such as sales and finance, the attribute value is CTXSUserGroups=sales;finance. Separate each group with a semicolon.
- The separator is that which you used on the NPS to separate groups, such as a semicolon, a colon, a space, or a period.

When you are finished configuring the remote access policy in IAS, you can configure RADIUS authentication and authorization on Citrix Gateway.

**To configure RADIUS authorization**

April 23, 2019

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Click RADIUS.
3. In the Policies tab, click Add.
4. In Name, type a name for the policy.
5. Below the Server* click +
6. In Name, type the name of the RADIUS server.
7. Under Server, type the IP address and port of the RADIUS server.
8. Under Details, enter the values for Group Vendor Identifier and Group Attribute Type.
9. In Password Encoding, select the authentication protocol and then click Create.
10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expression, click Add Expression, click Create and then click Close.
Configuring RADIUS user accounting

April 23, 2019

Citrix Gateway can send user-session start and stop messages to your RADIUS accounting server. The messages, which are sent for each user session, include a subset of the attributes defined in RFC2866. Table 1 lists the supported attributes and the types of RADIUS accounting messages (RAD_START and RAD_STOP) in which they are sent. Table 2 lists the predefined values that can be assigned to the Acct-Terminate-Cause attribute, and the corresponding Citrix Gateway events.

Table 1. Supported RADIUS Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Meaning</th>
<th>RAD_START</th>
<th>RAD_STOP</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-Name</td>
<td>Name of user associated with the session.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Session-Id</td>
<td>The NetScaler session ID.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Acct-Session-Time</td>
<td>Session duration seconds.</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Acct-Terminate-Cause</td>
<td>Reason for account termination (see below).</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2. RADIUS Termination Causes

<table>
<thead>
<tr>
<th>Netscaler Logout Method</th>
<th>RADIUS Termination Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGOUT_SESSN_TIMEDOUT</td>
<td>RAD_TERM_SESSION_TIMEOUT</td>
</tr>
<tr>
<td>LOGOUT_SESSN_INITIATEDBYUSER</td>
<td>RAD_TERM_USER_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_KILLEDBYADMIN</td>
<td>RAD_TERM_ADMIN_RESET</td>
</tr>
<tr>
<td>LOGOUT_SESSN_TLOGIN</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_MAXLICRCHD</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_CLISECCHK_FAILED</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_PREAUTH_CHANGED</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_COOKIE_MISMATCH</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
</tbody>
</table>
Configuration of RADIUS user accounting requires the creation of a pair of policies. The first policy is a RADIUS authentication policy that designates a RADIUS server to which to send accounting messages. The second is a session policy that uses the RADIUS accounting policy as its action.

To configure RADIUS user accounting, you must:

1. Create a RADIUS policy to define the RADIUS accounting server. The accounting server can be the same server that you use for RADIUS authentication.
2. Create a session policy, using the RADIUS policy as an action that specifies the RADIUS user accounting server.
3. Bind the session policy either globally, so that it applies to all traffic, or to a Citrix Gateway virtual server, so that it applies only to traffic flowing through that virtual server.

**To create a RADIUS policy**

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then Policies.
2. Expand Authentication and select RADIUS.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the policy.
5. Select a server from the Server menu, or click the + icon and follow the prompts to add a new RADIUS server.
6. In the Expression pane, from the Saved Policy Expressions menu, select ns_true.
7. Click Create.

**To create a session policy**

After configuring a RADIUS policy that specifies the RADIUS accounting server, create a session policy that applies this accounting server in an action, as follows:

<table>
<thead>
<tr>
<th>Netscaler Logout Method</th>
<th>RADIUS Termination Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGOUT_SESSS_DHT</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSS_2FACTOR_FAIL</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_ICALIC</td>
<td>RAD_TERM_NAS_REQUEST</td>
</tr>
<tr>
<td>LOGOUT_SESSN_INTERNALERR</td>
<td>RAD_TERM_NAS_ERROR</td>
</tr>
<tr>
<td>Other</td>
<td>RAD_TERM_NAS_ERROR</td>
</tr>
</tbody>
</table>
1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then Policies.
2. Select Session.
3. In the main details pane, select Add.
4. Enter a name for the policy.
5. In the Action menu, click the + icon to add a new session action.
6. Enter a name for the session action.
7. Click the Client Experience tab.
8. In the Accounting Policy menu, select the RADIUS policy that you created earlier.
9. Click Create.
10. In the Expression pane, from the Saved Policy Expressions menu, select ns_true.
11. Click Create.

To bind the session policy globally

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then Policies.
2. Select Session.
3. From the Action menu in the main details pane, select Global Bindings.
4. Click Bind.
5. In the Policies pane, select the session policy that you created earlier, and then click Insert.
6. In the Policies listings, click the Priority entry for the session policy and enter a value from 0 to 64000.
7. Click OK.

To bind the session policy to a Citrix Gateway virtual server

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then select Virtual Servers.
2. In the main details pane, select a virtual server, and then click Edit.
3. In the Policies pane, click the + icon to select a policy.
4. From the Choose Policy menu, select Session and make sure that Request is selected in the Choose Type menu.
5. Click Continue.
6. Click Bind.
7. In the Policies pane, select the session policy that you created earlier, and then click Insert.
8. Click OK.
Configuring SAML Authentication

April 13, 2020

The Security Assertion Markup Language (SAML) is an XML-based standard for exchanging authentication and authorization between Identity Providers (IdP) and Service Providers. Citrix Gateway supports SAML authentication.

When you configure SAML authentication, you create the following settings:

- **IdP Certificate Name.** This is the public key that corresponds to the private key at the IdP.
- **Redirect URL.** This is the URL of the authentication IdP. Users who are not authenticated are redirected to this URL.
- **User Field.** You can use this field to extract the user name if the IdP sends the user name in a different format than the NameIdentifier tag of the Subject tag. This is an optional setting.
- **Signing Certificate Name.** This is the private key of the Citrix Gateway server that is used to sign the authentication request to the IdP. If you do not configure a certificate name, the assertion is sent unsigned or the authentication request is rejected.
- **SAML Issuer name.** This value is used when the authentication request is sent. There must be a unique name in the issuer field to signify the authority from which the assertion is sent. This is an optional field.
- **Default authentication group.** This is the group on the authentication server from which users are authenticated.
- **Two Factor.** This setting enables or disables two-factor authentication.
- **Reject unsigned assertion.** If enabled, Citrix Gateway rejects user authentication if the signing certificate name is not configured.

Citrix Gateway supports HTTP POST-binding. In this binding, the sending party replies to the user with a 200 OK that contains a form-auto post with required information. Specifically, that default form must contain two hidden fields called SAMLRequest and SAMLResponse, depending on whether the form is a request or response. The form also includes RelayState, which is a state or information used by the sending party to send arbitrary information that is not processed by relying party. The relying party simply sends the information back so that when the sending party gets the assertion along with RelayState, the sending party knows what to do next. Citrix recommends that you encrypt or obfuscate RelayState.

Configuring Active Directory Federation Services 2.0

You can configure Active Directory Federation Services (AD FS) 2.0 on any Windows Server 2008 or Windows Server 2012 computer that you use in a federated server role. When you configure the AD FS
server to work with Citrix Gateway, you need configure the following parameters by using the Relying Party Trust Wizard in Windows Server 2008 or Windows Server 2012.

Windows Server 2008 Parameters:

- **Relying Party Trust.** You provide the Citrix Gateway metadata file location, such as https://vserver.fqdn.com/ns.metadata.xml, where vserver.fqdn.com is the fully qualified domain name (FQDN) of the Citrix Gateway virtual server. You can find the FQDN on the server certificate bound to the virtual server.
- **Authorization Rules.** You can allow or deny users access to the relying party.

Windows Server 2012 Parameters:

- **Relying Party Trust.** You provide the Citrix Gateway metadata file location, such as https://vserver.fqdn.com/ns.metadata.xml, where vserver.fqdn.com is the fully qualified domain name (FQDN) of the Citrix Gateway virtual server. You can find the FQDN on the server certificate bound to the virtual server.
- **AD FS Profile.** Select the AD FS profile.
- **Certificate.** Citrix Gateway does not support encryption. You do not need to select a certificate.
- **Enable support for the SAML 2.0 WebSSO protocol.** This enables support for SAML 2.0 SSO. You provide the Citrix Gateway virtual server URL, such as https://netScaler.virtualServerName.com/cgi/samlauth.
  
  This URL is the Assertion Consumer Service URL on the Citrix Gateway appliance. This is a constant parameter and Citrix Gateway expects a SAML response on this URL.
- **Relying party trust identifier.** Enter the name Citrix Gateway. This is a URL that identifies relying parties, such as https://netscalerGateway.virtualServerName.com/adfs/services/trust.
- **Authorization Rules.** You can allow or deny users access to the relying party.
- **Configure claim rules.** You can configure the values for LDAP attributes by using Issuance Transform Rules and use the template Send LDAP Attributes as Claims. You then configure LDAP settings that include:
  - Email addresses
  - sAMAccountName
  - User Principal Name (UPN)
  - MemberOf
- **Certificate Signature.** You can specify the signature verification certificates by selecting the Properties of a Relaying Party and then adding the certificate.

If the signing certificate is less than 2048 bits, a warning message appears. You can ignore the warning to proceed. If your are configuring a test deployment, disable the Certificate Revocation
List (CRL) on the Relaying Party. If you do not disable the check, AD FS tries the CRL to validate the certificate.

You can disable the CRL by running the following command: Set-ADFWRelayingPartyTrust -SigningCertificateRevocationCheck None-TargetName NetScaler

After you configure the settings, verify the relying party data before you complete the Relaying Party Trust Wizard. You check the Citrix Gateway virtual server certificate with the endpoint URL, such as https://vserver.fqdn.com/cgi/samlauth.

After you finish configuring settings in the Relaying Party Trust Wizard, select the configured trust and then edit the properties. You need to do the following:

• Set the secure hash algorithm to SHA-1.
  
  Note: Citrix supports SHA-1 only.

• Delete the encryption certificate. Encrypted assertions are not supported.

• Edit the claim rules, including the following:
  
  – Select Transform Rule
  – Add Claim Rule
  – Select Claim Rule Template: Send LDAP attributes as claims
  – Give a Name
  – Select Attribute Store: Active Directory
  – Select LDAP attribute: <Active Directory parameters>
  – Select Out Going Claim Rule as “Name ID”

  Note: Attribute Name XML tags are not supported.

• Configure the Logout URL for Single Sign-off. The claim rule is Send logout URL. The custom rule should be the following:


After you configure AD FS settings, download the AD FS signing certificate and then create a certificate key on Citrix Gateway. You can then configure SAML authentication on Citrix Gateway by using the certificate and key.

**Configuring SAML Two-Factor Authentication**

You can configure SAML two-factor authentication. When you configure SAML authentication with LDAP authentication, use the following guidelines:
• If SAML is the primary authentication type, disable authentication in the LDAP policy and configure group extraction. Then, bind the LDAP policy as the secondary authentication type.
• SAML authentication does not use a password and only uses the user name. Also, SAML authentication only informs users when authentication succeeds. If SAML authentication fails, users are not notified. Since a failure response is not sent, SAML has to be either the last policy in the cascade or the only policy.
• Citrix recommends that you configure actual user names instead of opaque strings.
• SAML cannot be bound as the secondary authentication type.

To configure SAML authentication

April 23, 2019

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.

2. In the navigation pane, click SAML.

3. In the details pane, click Add.

4. In the Create Authentication Policy dialog box, in Name, type a name for the policy.

5. Next to Server, click New.

6. In Name, type a name for the server profile.

7. In IdP Certificate Name, select a certificate or click Install. This is the certificate installed on the SAML or IDP server.

   If you click Install, add the certificate and private key. For more information, see Installing and Managing Certificates.

8. In Redirect URL, enter the URL of the authentication Identity Provider (IdP).

   This is the URL for user logon to the SAML server. This is the server to which Citrix Gateway redirects the initial request.

9. In User Field, enter the user name to extract.

10. In Signing Certificate Name, select the private key for the certificate you selected in Step 9.

    This is the certificate that is bound to the AAA virtual IP address. The SAML Issuer Name is the fully qualified domain name (FQDN) to which users log on, such as lb.example.com or ng.example.com.

11. In SAML Issuer Name, enter the FQDN of the load balancing or Citrix Gateway virtual IP address to which the appliance sends the initial authentication (GET) request.
Using SAML authentication to log in to Citrix Gateway

April 23, 2019

You can use SAML authentication to log in to Citrix Gateway using Citrix VPN clients and Workspace app. The plug-in supports SAML authentication only through advanced SAML policies bound to the authentication virtual server, that is nfactor authentication.

**Important:** The plug-in does not support SAML authentication when SAML policies are bound directly to VPN virtual server, that is non-nfactor authentication.

**Supported platforms and apps**

The following table lists the platforms and applications that support SAML authentication for logging in to Citrix Gateway.

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Gateway</td>
<td>Version 12.0 build 41.16 and later</td>
</tr>
<tr>
<td>VPN client</td>
<td>Version 12.1 build 49.37 and later. <strong>Supported platforms:</strong> Windows 7, Windows 8, Windows 8.1, Windows 10</td>
</tr>
<tr>
<td>Workspace app versions</td>
<td>Windows: 1808; Mac: 1808</td>
</tr>
</tbody>
</table>

**Configure for SAML authentication using advanced SAML policies**

For details on configuring SAML authentication using advanced SAML policies see, [Citrix ADC as a SAML IdP](#).
Auth Improvements for SAML Authentication

April 23, 2019

This feature is for those with SAML knowledge, and fundamental authentication proficiency is required to use this information. The reader must understand FIPS to use this information.

The following Citrix ADC features can be used with third party applications/servers that are compatible with the SAML 2.0 specification:

- SAML Service Provider (SP)
- SAML Identity Provider (IdP)

SP and IdP allow a SingleSignOn (SSO) between cloud services. The SAML SP feature provides a way of addressing user claims from an IdP. The IdP could be a third party service or another Citrix ADC appliance. The SAML IdP feature is used to assert user logons and provide claims consumed by SPs.

As part of the SAML support, both IdP and SP modules digitally sign the data that is sent to peers. The digital signature includes an authentication request from SP, Assertion from IdP, and logout messages between these two entities. The digital signature validates the message authenticity.

The current implementation of SAML SP and IdP do the signature computation in a packet engine. These modules use SSL certificates to sign the data. In a FIPS compliant Citrix ADC, the private key of the SSL certificate is not available in the packet engine or user space, so the SAML module today is not ready for FIPS hardware.

This document describes the mechanism to offload signature calculations to the FIPS card. Signature verification is done in the software, as the public key is available.

Solution

The SAML feature set is enhanced to use an SSL API for signature offload. See docs.citrix.com for details about these affected SAML sub-features:

1. SAML SP Post Binding – Signing of AuthnRequest
2. SAML IdP Post Binding – Signing of Assertion/Response/Both
3. SAML SP Single Logout scenarios – Signing of LogoutRequest in SP initiated model and Signing of LogoutResponse in IdP initiated model
4. SAML SP Artifact binding – Signing of ArtifactResolve request
5. SAML SP Redirect Binding – Signing of AuthnRequest
6. SAML IdP Redirect Binding – Signing of Response/Assertion/Both
7. SAML SP Encryption support – Decryption of Assertion
**Platform**

The API can be offloaded only to a FIPS platform.

**Configuration**

Offload configuration is performed automatically on the FIPS platform.

However, since SSL private keys are not available to user space in FIPS hardware, there is a slight configuration change in creating the SSL certificate on FIPS hardware.

Here’s the configuration information:

- add ssl fipsKey fips-key
  
  You would then need to create a CSR and use it at the CA server to generate a certificate. You can then copy that certificate in /nsconfig/ssl. Let’s assume that file is fips3cert.cer.

- add ssl certKey fips-cert -cert fips3cert.cer -fipsKey fips-key
  
  You would then need to specify this certificate in the SAML action for SAML SP module.

- set samlAction <name> -samlSigningCertName fips-cert
  
  Likewise, you need to use this in samlIdpProfile for SAML IdP module

- set samlidpprofile fipstest –samlIdpCertName fips-cert

The first time, you will not have the fips-key described above. If there’s no FIPS key, create one as described at: [https://support.citrix.com/servlet/KbServlet/download/9539-102-665378/NS9000\_FIPS\_6\[1\]\[1\]\[1\].1.pdf](https://support.citrix.com/servlet/KbServlet/download/9539-102-665378/NS9000\_FIPS\_6\[1\]\[1\]\[1\].1.pdf)

```
create ssl fipskey <fipsKeyName> -modulus <positive_integer> [-exponent ( 3

```

- create certreq <reqFileName> -fipsKeyName <string>

**Configuring TACACS+ Authentication**

April 23, 2019

You can configure a TACACS+ server for authentication. Similar to RADIUS authentication, TACACS+ uses a secret key, an IP address, and the port number. The default port number is 49.
To configure Citrix Gateway to use a TACACS+ server, provide the server IP address and the TACACS+ secret. You need to specify the port only when the server port number in use is something other than the default port number of 49.

To configure TACACS+ authentication using user interface, perform the following steps.

1. In the configuration utility, on the Configuration tab, expand **Citrix Gateway > Policies > Authentication**.
2. Click **TACACS**.
3. In the details pane, click **Add**.
4. In **Name** field, type a name for the policy.
5. Next to **Server** field, click **Add** to create a new TACACS server or click **Edit** to make changes to an existing TACACS server.
6. In **Name** field, type a name for the server.
7. Under **IP Address**, type the IP address.
8. Under **Port**, use the default port number 49.
9. In **TACACS Key** field, type the key. In **Confirm TACACS key** field, type the same key to confirm.
10. Click **More**.
11. In **Authorization**, select **ON** and then click **Create**.
12. In the **Create Authentication TACACS Policy** dialog box, select the Expression, click Create and then click Close.

To configure TACACS+ authentication using command line interface, type the following command.

```bash
1 add authentication tacacsAction <name> [-serverIP <ip_addr|ipv6_addr [*>]] [-serverPort <port>] [-authTimeout <positive_integer>] {
2   -tacacsSecret
3 }
4 [-authorization ( ON | OFF )] [-accounting ( ON | OFF )][-auditFailedCmds ( ON | OFF )] [-defaultAuthenticationGroup <string>] [-Attribute1 <string>] [-Attribute2 <string>] [-Attribute3 <string>] [-Attribute4 <string>]
```

After you configure the TACACS+ server settings in Citrix Gateway, bind the policy to make it active. You can bind the policy on either the global or virtual server level. For more information about binding authentication policies, see **Binding Authentication Policies**.
Clear Config Basic Should Not Clear TACACS Config

April 23, 2019

Overview

This enhancement focuses on NOT CLEARING all RBA (Role Based Access) related configurations when the clear config command is executed.

The current clear config command is performed in one of three levels:

- Basic
- Extended
- Full

Based on the level chosen, NetScaler configurations are cleared and reset to the factory default.

The command used is:

```
1 clear ns config [-force] \<level>\n```

The new command adds a knob to allow/deny the deletion of all RBA related configurations.

New Command

Described are the Clear RBACconfig features:

1. YES/NO knob with Default: YES.
   
   The admin decides whether to retain the RBA config or not.

2. ONLY the BASIC LEVEL of clear config is supported.

3. The following configurations not cleared:

   - Add/bind system user/group.
   - Add cmd policy.
   - TACACS commands.(add TACACS action/policy).
   - Bind system global

   **Note:** TACACS related config (action/policy) is preserved if the policy is bound to system global or else it is cleared
**CLI Configuration**

The command used

```
1 clear config [-force] <level> [-RBAconfig]
```

By default it is set to YES, and clears the configurations based on the level specified.

If –RBAconfig is set to NO, the RBA related config is retained. The following is included:

- Add /bind system user /group
- Bind system global
- tacacs related commands (add tacacs action/policy)
- Add cmd policy

**Configuring Multifactor Authentication**

April 23, 2019

You can configure two types of multifactor authentication in Citrix Gateway:

- Cascading authentication that sets the authentication priority level
- Two-factor authentication that requires users to log on by using two types of authentication

If you have multiple authentication servers, you can set the priority of your authentication policies. The priority levels you set determine the order in which the authentication server validates users’ credentials. A policy with a lower priority number takes precedence over a policy with a higher number.

You can have users authenticate against two different authentication servers. For example, you can configure an LDAP authentication policy and an RSA authentication policy. When users log on, they authenticate first with their user name and password. Then, they authenticate with a personal identification number (PIN) and the code from the RSA token.

**Configuring Cascading Authentication**

April 23, 2019

Authentication allows you to create a cascade of multiple authentication servers using policy prioritization. When you configure a cascade, the system traverses each authentication server, as defined by the cascaded policies, to validate a user’s credentials. Prioritized authentication policies are cascaded
in ascending order and can have priority values in the range of 1 to 9999. You define these priorities when binding your policies at either the global or the virtual server level.

During authentication, when a user logs on, the virtual server is checked first and then global authentication policies are checked. If a user belongs to an authentication policy on both the virtual server and globally, the policy from the virtual server is applied first and then the global authentication policy. If you want users to receive the authentication policy that is bound globally, change the priority of the policy. When a global authentication policy has a priority number of one and an authentication policy bound to a virtual server has a priority number two, the global authentication policy takes precedence. For example, you could have three authentication policies bound to the virtual server and you can set the priority of each policy.

If a user fails to authenticate against a policy in the primary cascade, or if that user succeeds in authenticating against a policy in the primary cascade but fails to authenticate against a policy in the secondary cascade, the authentication process stops and the user is redirected to an error page.

Note: Citrix recommends that when you bind multiple policies to a virtual server or globally, you define unique priorities for all authentication policies.

**To set the priority for global authentication policies**

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. Select the policy that is bound globally and then in Action, click Global Bindings.
3. In the Bind/Unbind Authentication Global Polices dialog box, under Priority, type the number and then click OK.

**To change the priority for an authentication policy bound to a virtual server**

You can also modify an authentication policy that is bound to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. Click the Authentication tab and then click either Primary or Secondary.
4. Next to the authentication policy, under Priority, type the number and then click OK.

**Configuring Two-Factor Authentication**

April 23, 2019
Citrix Gateway supports two-factor authentication. Normally, when authenticating users, Citrix Gateway stops the authentication process as soon as it successfully authenticates a user through any one of the configured authentication methods. In certain instances, you may need to authenticate a user to one server, but extract groups from a different server. For example, if your network authenticates users against a RADIUS server, but you also use RSA SecurID token authentication and user groups are stored on that server, you may need to authenticate users to that server so you can extract the groups.

If users are authenticated by using two authentication types, and if one of those types is client certificate authentication, you can configure the certificate authentication policy as the second method of authentication. For example, you use LDAP as your primary authentication type and the client certificate as the secondary authentication. When users log on with their user name and password, they then have access to network resources.

When you configure two-factor authentication, you select if the authentication type is the primary or secondary type.

**To configure two-factor authentication**

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
3. In the Bind/Unbind Authentication Policies to Global dialog box, click Primary.
4. Click Insert Policy.
5. Under Policy Name, select the authentication policy.
6. Click Secondary, repeat Steps 4 and 5 and then click OK.

**Selecting the Authentication Type for Single Sign-On**

April 23, 2019

If you have single sign-on and two-factor authentication configured on Citrix Gateway, you can select which password to use for single sign-on. For example, you have LDAP configured as the primary authentication type and RADIUS configured as the secondary authentication type. When users access resources that require single sign-on, the user name and primary password are sent by default. You set which password should be used for single sign-on to web applications within a session profile.
To configure authentication for single sign-on

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click the Profiles tab and then do one of the following:
   - To create a new profile, click Add.
   - To modify an existing profile, click Open.
3. On the Client Experience tab, next to Credential Index, click Override Global, select either Primary or Secondary.
4. If this is a new profile, click Create and then click Close.
5. If you are modifying an existing profile, click OK.

Configuring Client Certificates and LDAP Two-Factor Authentication

April 23, 2019

You can use a secure client certificate with LDAP authentication and authorization, such as using smart card authentication with LDAP. The user logs on and then the user name is extracted from the client certificate. The client certificate is the primary form of authentication and LDAP is the secondary form. The client certificate authentication must take priority over the LDAP authentication policy. When you set the priority of the policies, assign a lower number to the client certificate authentication policy than the number you assign to the LDAP authentication policy.

To use a client certificate, you must have an enterprise Certificate Authority (CA), such as Certificate Services in Windows Server 2008, running on the same computer that is running Active Directory. You can use the CA to create a client certificate.

To use a client certificate with LDAP authentication and authorization, it must be a secure certificate that uses Secure Sockets Layer (SSL). To use secure client certificates for LDAP, install the client certificate on the user device and install a corresponding root certificate on Citrix Gateway.

Before configuring a client certificate, do the following:

- Create a virtual server.
- Create an LDAP authentication policy for the LDAP server.
- Set the expression for the LDAP policy to True value.

To configure client certificate authentication with LDAP

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, under Authentication, click Cert.
3. In the details pane, click Add.
4. In Name, type a name for the policy.
5. In Authentication Type, select Cert.
7. In Name, type a name for the server, and then click Create.
8. In the Create Authentication Server dialog box, in Name, type the name of the server.
9. Next to Two Factor, select ON.
10. In the User Name Field, select Subject:CN and then click Create.
11. In the Create Authentication Policy dialog box, next to Named Expressions, select True value, click Add Expression, click Create and then click Close.

After you create the certificate authentication policy, bind the policy to the virtual server. After binding the certificate authentication policy, bind the LDAP authentication policy to the virtual server.

**Important:** You must bind the certificate authentication policy to the virtual server before you bind the LDAP authentication policy to the virtual server.

**To install a root certificate on Citrix Gateway**

After you create the certificate authentication policy, you download and install a root certificate from your CA in Base64 format and save it on your computer. You can then upload the root certificate to Citrix Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and then click Certificates.
2. In the details pane, click Install.
3. In Certificate - Key Pair Name, type a name for the certificate.
4. In Certificate File Name, click Browse and in the drop-down box, select either Appliance or Local.
5. Navigate to the root certificate, click Open and then click Install.

**To add a root certificate to a virtual server**

After installing the root certificate on Citrix Gateway, add the certificate to the certificate store of the virtual server.

**Important:** When you add the root certificate to the virtual server for smart card authentication, you must select the certificate from the

**Select CA Certificate** drop-down box, as shown in the following figure.

Figure 1. Adding a root certificate as a CA
1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.

3. On the Certificates tab, under Available, select the certificate, next to Add, in the drop down box, click as CA and then click OK.

4. Repeat Step 2.

5. On the Certificates tab, click SSL Parameters.

6. Under Others, select Client Authentication.

7. Under Others, next to Client Certificate, select Optional and then click OK twice.

8. After configuring the client certificate, test the authentication by logging on to Citrix Gateway with the Citrix Gateway plug-in. If you have more than one certificate installed, you receive a prompt asking you to select the correct certificate. After you select the certificate, the logon screen appears with the user name populated with the information obtained from the certificate. Type the password and then click Login.
If you do not see the correct user name in the User Name field on the logon screen, check the user accounts and groups in your LDAP directory. The groups that are defined on Citrix Gateway must be the same as those in the LDAP directory. In Active Directory, configure groups at the domain root level. If you create Active Directory groups that are not in the domain root level, incorrect reading of the client certificate could result.

If users and groups are not at the domain root level, the Citrix Gateway logon page displays the user name that is configured in Active Directory. For example, in Active Directory, you have a folder called Users and the certificate says CN=Users. In the logon page, in User Name, the word Users appears.

If you do not want to move your group and user accounts to the root domain level, when configuring the certificate authentication server on Citrix Gateway, leave User Name Field and Group Name Field blank.

## Configuring Single Sign-On

April 23, 2019

You can configure Citrix Gateway to support single sign-on with Windows, to Web applications (such as SharePoint), to file shares, and to the Web Interface. Single sign-on also applies to file shares that users can access through the file transfer utility in the Access Interface or from the Citrix Gateway icon menu in the notification area.

If you configure single sign-on when users log on, they are automatically logged on again without having to enter their credentials a second time.

## Configuring Single Sign-On with Windows

April 23, 2019

Users open a connection by starting the Citrix Gateway plug-in from the desktop. You can specify that the Citrix Gateway plug-in start automatically when the user logs on to Windows by enabling single sign-on. When you configure single sign-on, users' Windows logon credentials are passed to Citrix Gateway for authentication. Enabling single sign-on for the Citrix Gateway plug-in facilitates operations on the user device, such as installation scripts and automatic drive mapping.

Enable single sign-on only if user devices are logging on to your organization's domain. If single sign-on is enabled and a user connects from a device that is not on your domain, the user is prompted to log on.
You configure single sign-on with Windows either globally or by using a session profile that is attached to a session policy.

**To configure single sign-on with Windows globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Single Sign-on with Windows and then click OK.

**To configure single sign-on with Windows by using a session policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Single Sign-On with Windows, click Override Global, click Single Sign-on with Windows and then click OK.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

**Configuring Single Sign-On to Web Applications**

April 23, 2019

You can configure Citrix Gateway to provide single sign-on to servers in the internal network that use web-based authentication. With single sign-on, you can redirect the user to a custom home page, such as a SharePoint site or to the Web Interface. You can also configure single sign-on to resources through the Citrix Gateway plug-in from a bookmark configured on the home page or a web address that users type in the web browser.

If you are redirecting the home page to a SharePoint site or Web Interface, provide the web address for the site. When users are authenticated, either by Citrix Gateway or an external authentication server, users are redirected to the specified home page. User credentials are passed transparently to the web server. If the web server accepts the credentials, users are logged on automatically. If the web server denies the credentials, users receive an authentication prompt asking for their user name and password.
You can configure single sign-on to web applications globally or by using a session policy.

**To configure single sign-on to web applications globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Single sign-on to Web Applications and then click OK.

**To configure single sign-on to web applications by using a session policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. On the Client Experience tab, next to Single Sign-On to Web Applications, click Global Override, click Single Sign-On to Web Applications and then click OK.

**To define the HTTP port for single sign-on to web applications**

Single sign-on is attempted only for network traffic where the destination port is considered an HTTP port. To allow single sign-on to applications that use a port other than port 80 for HTTP traffic, add one or more port numbers on Citrix Gateway. You can enable multiple ports. The ports are configured globally.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Network Configuration tab, click Advanced Settings.
4. Under HTTP Ports, type the port number, click Add and then click OK twice.

   You can repeat Step 4 for each port you want to add.

**Note:** If web applications in the internal network use public IP addresses, single sign-on does not function. To enable single sign-on, split tunneling must be enabled as part of the global policy setting, regardless if clientless access or the Citrix Gateway plug-in is used for user device connections. If it is not possible to enable split tunneling on a global level, create a virtual server that use a private address range.
Configuring Single Sign-on to Web Applications by Using LDAP

December 26, 2019

When you configure single sign-on and users log on by using the user principal name (UPN) with a format of username@domain.com, by default single sign-on fails and users must authenticate two times. If you need to use this format for user logon, modify the LDAP authentication policy to accept this form of user name.

To configure single sign-on to web applications

1. In the configuration utility, on the **Configuration** tab, expand **Citrix Gateway > Policies > Authentication**.
2. In the details pane, on the **Policies** tab, select an LDAP policy and then click **Open**.
3. In the **Configure Authentication Policy** dialog box, next to **Server**, click **Modify**.
4. Under **Connection Settings**, in Base DN (location of users), type DC=domainname,DC=com.
5. In **Administrator Bind DN**, type LDAPaccount@domainname.com, where domainname.com is the name of your domain.
6. In **Administrator Password** and **Confirm Administrator Password**, type the password.
7. Under **Other Settings**, in **Server Logon Name Attribute**, type UserPrincipalName.
8. In **Group Attribute**, type memberOf.
9. In **Sub Attribute Name**, type CN.
10. In **SSO Name Attribute**, type the format by which users log on and then click **OK** twice. This value is either SamAccountName or UserPrincipalName.

Configuring Single Sign-On to a Domain

April 23, 2019

If users connect to servers running Citrix Virtual Apps and use SmartAccess, you can configure single sign-on for users connecting to the server farm. When you configure access to published applications using a session policy and profile, use the domain name for the server farm.

You can also configure single sign-on to file shares in your network.
To configure single sign-on to a domain

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. In the Configure Session Profile dialog box, on the Published Applications tab, in Single-sign-on Domain, click Override Global, type the domain name and then click OK twice.

For more information about configuring the Citrix Gateway with Citrix Virtual Apps, see Integrate Citrix Gateway with Citrix Virtual Apps and Desktops.

Configuring Single Sign-On for Microsoft Exchange 2010

January 20, 2020

The following section describes the configuration of Single Sign-On (SSO) for Microsoft Exchange 2010 on Citrix Gateway. The SSO for Outlook Web Access (OWA) 2010 does not work in the following conditions:

- Using the forms based authentication on Microsoft Exchange 2010.
- Load balancing virtual server with authentication, authorization, and auditing traffic management policy.

**Note**

This configuration works only for load balancing virtual server with authentication, authorization, and auditing traffic management policy. It does not work for SSO in OWA 2010 with clientless VPN.

The following steps is a prerequisites that you must consider before configuring SSO for Microsoft Exchange 2010 on Citrix Gateway.

- The Action URL for SSO form is different in OWA 2010. You must modify the traffic management policy.
- You require a rewrite policy to set the PBack cookie in the logon.aspx request. In normal scenarios, you set the PBack cookie at the client and click Submit.
- When you are using SSO, the response to logon.aspx is consumed and the Citrix Gateway generates the form request. The cookie is not attached in the form submission request.
- The OWA server expects the PBack cookie in the form submission request. The rewrite policy is required to attach the PBack cookie in the form submission request.
Perform the following by using the CLI

1. Configure the authentication, authorization, and auditing traffic management

   ```
   add tm formSSOAction OWA_Form_SSO_SSOPro -actionURL "/owa/auth.owa"
   -userField username -passwdField password -ssoSuccessRule "http.
   RES_SET_COOKIE.COOKIE("cadata\")\".VALUE("cadata\")\".LENGTH.GT(70"
   -responsize 15000 -submitMethod POST
   ```

2. Configure the traffic management policy and bind the policy

   ```
   • add tm trafficAction OWA_2010_Prof -appTimeout 1 -SSO ON -formSSO
     Action OWA_Form_SSO_SSOPro
   • add tm trafficPolicy owa2k10_pol "HTTP.REQ.URL.CONTAINS("ow
     a/auth/logon.aspx\")"OWA_2010_Prof
   • bind tm global -policyName owa2k10_pol -priority 100
   ```

Rewrite configuration using CLI

At the command prompt, type:

```
• add rewrite action set_pback_cookie insert_after "http.REQ.COOKI
E.VALUE("OutlookSession\")\";PBack=0\""-bypassSafetyCheck YES
• add rewrite policy set_pback_cookie "http.REQ.URL.CONTAINS("lo
 gon.aspx\")\"set_pback_cookie
• bind rewrite global set_pback_cookie 100 END -type REQ_DEFAULT
```  

Alternate rewrite configuration

In rare cases, the Microsoft Outlook might not issue OWA session cookies and the Pback cookies might also not get inserted. The issue might occur after you have executed the preceding commands to implement the rewrite configuration.

To overcome such scenarios and as a workaround, you can configure the following commands instead of the rewrite configuration.

At the command prompt, type:

```
• add rewrite action set_pback_cookie insert_http_header "Cookie":"PBack=0"
• add rewrite policy set_pback_cookie "http.REQ.URL.CONTAINS("lo
 gon.aspx\")\"set_pback_cookie
```
Citrix Gateway 13.0

- set rewrite policy set_pback_cookie -action set_pback_cookie
- bind rewrite global set_pback_cookie 100 END -type REQ_DEFAULT

Configuring One-Time Password Use

September 10, 2019

You can configure Citrix Gateway to use one-time passwords, such as a token personal identification number (PIN) or passcode. After a user enters the passcode or PIN, the authentication server immediately invalidates the one-time password and the user cannot enter the same PIN or password again.

Products that include using a one-time password include:

- RSA SecurID
- Imprivata OneSign
- SafeWord
- Gemalto Protiva
- Nordic SMS PASSCODE

To use each of these products, configure the authentication server in the internal network to use RADIUS. For more information, see Configuring RADIUS Authentication.

If you configure authentication on Citrix Gateway to use a one-time password with RADIUS, as provided by an RSA SecurID token, for example, Citrix Gateway attempts to reauthenticate users by using the cached password. This reauthentication occurs when you make changes to Citrix Gateway or if the connection between the Citrix Gateway plug-in and Citrix Gateway is interrupted and then restored.

An attempt to reauthenticate can also occur when connections are configured to use Citrix Workspace app and users connect to the Web Interface by using RADIUS or LDAP. When a user starts an application and uses the application, and then returns to Receiver to start another application, Citrix Gateway uses cached information to authenticate the user.

Configuring RSA SecurID Authentication

April 23, 2019

When configuring the RSA/ACE server for RSA SecureID authentication, you need to complete the following steps:

Configure the RADIUS client with the following information:
• Provide the name of the Citrix Gateway appliance.
• Provide a description (not mandatory).
• Provide the system IP address.
• Provide the shared secret between Citrix Gateway and the RADIUS server.
• Configure the make/model as Standard RADIUS.

In the agent host configuration, you need the following information:

• Provide the fully qualified domain name (FQDN) of Citrix Gateway (as it appears on the certificate bound to the virtual server). After providing the FQDN, click the Tab key and the Network Address window populates itself.

  After you enter the FQDN, the network address automatically appears. If it does not, enter the system IP address.

• Provide the Agent Type by using Communication Server.

• Configure to import all users or a set of users who are allowed to authenticate through Citrix Gateway.

If it is not already configured, create an Agent Host entry for the RADIUS server, including the following information:

• Provide the FQDN of the RSA server.

  After you enter the FQDN, the network address automatically appears. If it does not, provide the IP address of the RSA server.

• Provide the Agent Type, which is the RADIUS server.

For more information about configuring an RSA RADIUS server, see the manufacturer’s documentation.

To configure RSA SecurID, create an authentication profile and policy and then bind the policy globally or to a virtual server. To create a RADIUS policy to use RSA SecurID, see Configuring RADIUS Authentication.

After creating the authentication policy, bind it to a virtual server or globally. For more information, see Binding Authentication Policies.

### Configuring Password Return with RADIUS

April 23, 2019

You can replace domain passwords with a one-time password that a token generates from a RADIUS server. When users log on to Citrix Gateway, they enter a personal identification number (PIN) and
the passcode from the token. After Citrix Gateway validates their credentials, the RADIUS server returns the user’s Windows password to Citrix Gateway. Citrix Gateway accepts the response from the server and then uses the returned password for single sign-on instead of using the passcode that users typed during logon. This password return with RADIUS feature allows you to configure single sign-on without requiring users to recall their Windows password.

When users log on by using password return, they can access all of the allowed network resources in the internal network, including Citrix Endpoint Management, StoreFront, and the Web Interface.

To enable single sign-on by using returned passwords, you configure a RADIUS authentication policy on Citrix Gateway by using the Password Vendor Identifier and Password Attribute Type parameters. These two parameters return the user’s Windows password to Citrix Gateway.

Citrix Gateway supports Imprivata OneSign. The minimum required version of Imprivata OneSign is 4.0 with service pack 3. The default password vendor identifier for Imprivata OneSign is 398. The default password attribute type code for Imprivata OneSign is 5.

You can use other RADIUS servers for password return, such as RSA, Cisco, or Microsoft. You must configure the RADIUS server to return the user single sign-on password in a vendor-specific attribute value pair. In an Citrix Gateway authentication policy, you must add the Password Vendor Identifier and Password Attribute Type parameters for these servers.

You can find a complete list of vendor identifiers on the Internet Assigned Numbers Authority (IANA) web site. For example, the vendor identifier for RSA security is 2197, for Microsoft, it is 311, and for Cisco Systems, it is 9. The vendor-specific attribute that a vendor supports must be confirmed with the vendor. For example, Microsoft has published a list of vendor-specific attributes at Microsoft Vendor-specific RADIUS Attributes.

You can select any of the vendor-specific attributes to store the single sign-on password for users on the RADIUS server of the vendor. If you configure Citrix Gateway with the vendor identifier and attribute where the user password is stored on the RADIUS server, Citrix Gateway requests the value of the attribute in the access request packet that is sent to the RADIUS server. If the RADIUS server responds with the corresponding attribute-value pair in the access-accept packet, password return works regardless of the RADIUS server you use.

To configure single sign-on by using returned passwords:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies > Authentication.
2. In the navigation pane, click RADIUS.
3. In the details pane, click Add.
4. In the Create Authentication Policy dialog box, in Name, type a name for the policy.
5. Next to Server, click New.
6. In Name, type the name of the server.
7. Configure the settings for the RADIUS server.
8. In Password Vendor Identifier, type the vendor identifier that is returned by the RADIUS server. This identifier must have a minimum value of 1.
9. In Password Attribute Type, type the attribute type that is returned by the RADIUS server in the vendor-specific AVP code. The value can range from 1 through 255.
10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expression, click Add Expression, click Create and then click Close.

Configuring SafeWord Authentication

April 23, 2019

The SafeWord product line helps to provide secure authentication through the use of a token-based passcode. After users enter a passcode, it is immediately invalidated by SafeWord and cannot be used again.

If Access Gateway is replacing the Secure Gateway in a Secure Gateway and Web Interface deployment, you can choose to not configure authentication on Access Gateway and continue to allow the Web Interface to provide SafeWord authentication for incoming HTTP traffic.

Access Gateway supports SafeWord authentication for the following products:

- SafeWord 2008
- SafeWord PremierAccess
- SafeWord for Citrix
- SafeWord RemoteAccess

You can configure Access Gateway to authenticate using SafeWord products in the following ways:

- Configure authentication to use a PremierAccess RADIUS server that is installed as part of SafeWord PremierAccess and allow it to handle authentication.
- Configure authentication to use the SafeWord IAS agent, which is a component of SafeWord RemoteAccess, SafeWord for Citrix, and SafeWord PremierAccess 4.0.
- Install the SafeWord Web Interface Agent to work with the Citrix Web Interface. Authentication does not have to be configured on Access Gateway and can be handled by the Citrix Web Interface. This configuration does not use the PremierAccess RADIUS server or the SafeWord IAS Agent.

When configuring the SafeWord RADIUS server, you need the following information:

- The IP address of Access Gateway. When you configure client settings on the RADIUS server, use the Access Gateway IP address.
- A shared secret.
- The IP address and port of the SafeWord server.
Citrix Gateway 13.0

Configuring Gemalto Protiva Authentication

April 23, 2019

Protiva is a strong authentication platform that was developed to use the strengths of Gemalto’s smart card authentication. With Protiva, users log on with a user name, password, and one-time password generated by the Protiva device. Similar to RSA SecurID, the authentication request is sent to the Protiva Authentication Server and the password is either validated or rejected.

To configure Gemalto Protiva to work with the Citrix Gateway, use the following guidelines:

• Install the Protiva server.
• Install the Protiva Internet Authentication Server (IAS) agent plug-in on a Microsoft IAS RADIUS server. Make sure you note the IP address and port number of the IAS server.

nFactor for Gateway Authentication

March 13, 2020

Introduction

nFactor authentication enables a whole new set of possibilities regarding authentication. Administrators using nFactor enjoy authentication, authorization, and auditing flexibility when configuring authentication factors for virtual servers.

Two policy banks or two factors no longer restrict an administrator. The number of policy banks can be extended to suit different needs. Based on previous factors, nFactor determines a method of authentication. Dynamic login forms and on-failure actions are possible by using nFactor.

Note: nFactor is not supported for Citrix ADC Standard Edition. It is supported for Citrix ADC Advanced Edition and Citrix ADC Premium Edition.

Use-cases

nFactor authentication enables dynamic authentication flows based on the user profile. Sometimes, these can be simple flows to be intuitive to the user. In other cases, they can be coupled with securing active directory or other authentication servers. The following are some requirements specific to Gateway:
1. **Dynamic username and password selection.** Traditionally, Citrix clients (including Browsers and Receivers) use the active directory (AD) password as the first password field. The second password is reserved for the One-Time-Password (OTP). However, to secure AD servers, OTP is required to be validated first. nFactor can do this without requiring client modifications.

2. **Multi-Tenant Authentication End-point.** Some organizations use different Gateway servers for Certificate and non-certificate users. With users using their own devices to log in, user’s access levels vary on Citrix ADC based on the device being used. Gateway can cater to different authentication needs.

3. **Authentication based on group membership.** Some organizations obtain user properties from AD servers to determine authentication requirements. Authentication requirements can be varied for individual users.

4. **Authentication co-factors.** Sometimes, different pairs of authentication policies are used to authenticate different sets of users. Providing pair policies increases effective authentication. Dependent policies can be made from one flow. In this manner, independent sets of policies become flows of their own that increase efficiency and reduce complexity.

**Authentication Response Handling**

The Citrix Gateway callback registers handle authentication responses. AAAD (authentication daemon) responses and success/failure/error/dialogue codes are feed to the callback handle. The success/failure/error/dialogue codes direct Gateway to take the appropriate action.

**Clients Support**

The following table details configuration details.

<table>
<thead>
<tr>
<th>Client</th>
<th>nFactor Support</th>
<th>Authentication Policy</th>
<th>EPA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browsers</td>
<td>Yes</td>
<td>Auth</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Workspace app</td>
<td>No</td>
<td>VPN</td>
<td>N</td>
</tr>
<tr>
<td>Gateway Plug-in</td>
<td>No</td>
<td>VPN</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Command Line Configuration**

The Gateway virtual server needs an authentication virtual server named as an attribute. This is the only configuration required for this model.
The authnVsName is the name of authentication virtual server. This virtual server is configured with advanced authentication policies and is used for nFactor authentication.

```
1 add authnProfile <name-of-profile> -authnVsName <name-of-auth-vserver>
```

Where authnProfile is the previously created authentication profile.

**Interop Challenges**

Most of the Legacy Gateway clients, in addition to rfWeb clients, are modeled on responses sent by Gateway. For example, a 302 response to /vpn/index.html is expected for many clients. Also, these clients depend on various Gateway cookies such as “pwcount”, “NSC_CERT”, and so forth.

**End Point Analysis (EPA)**

EPA in nFactor is not supported for Citrix ADC authentication, authorization, and auditing module. Hence, the Citrix Gateway virtual server performs EPA. After EPA, the login credentials are sent to the authentication virtual server using the previously mentioned API. Once authentication is complete, Gateway continues to the post authentication process and it establishes the user session.

**Misconfiguration Considerations**

The Gateway client sends the user credentials only once. Gateway gets either one or two credentials from the client with the login request. In the legacy mode, there are a maximum of two factors. The passwords obtained are used for these factors. However, with nFactor the number of factors that can be configured is practically unlimited. Passwords obtained from the Gateway client are reused (as per configuration) for configured factors. Care must be taken such that one-time-password (OTP) should not be reused multiple times. Likewise, administrator must ensure that password reused at a factor is indeed applicable to that factor.

**Defining Citrix Clients**

The configuration option is provided to help Citrix ADC determine browser clients vs. thick clients such as Receiver.
A pattern set, ns_vpn_client_useragents, is provided for the administrator to configure patterns for all Citrix clients.

Likewise, binding the “Citrix Receiver” string to the above patset to ignore all Citrix clients that have “Citrix Receiver” in the User-Agent.

**Restricting nFactor for Gateway**

nFactor for Gateway authentication will not happen if the following conditions are present.

1. The authnProfile is not set at Citrix Gateway.
2. Advanced authentication policies are not bound to authentication virtual server and the same authentication virtual server is mentioned in authnProfile.
3. The User-Agent string in HTTP request matches the User-Agents configured in patset ns_vpn_client_useragents.

If these conditions are not met, the classic authentication policy bound to Gateway is used.

If a User-Agent, or portion of it is bound to the previously mentioned patset, requests coming from those user-agents do not participate in the nFactor flow. For example, the command below restricts configuration for all browsers (assuming all browsers contain “Mozilla” in the user-agent string):

bind patset ns_vpn_client_useragents Mozilla

**LoginSchema**

LoginSchema is a logical representation of the logon form. The XML language defines it. The Syntax of the loginSchema conforms to Citrix’s Common Forms Protocol specification.

LoginSchema defines the “view” of the product. An Administrator can provide a customized description, assistive text, and so forth of the form. This includes the labels of the form itself. A customer can provide success/failure message that describes the form presented at a given point.

**LoginSchema and nFactor Knowledge Required**

Pre-built loginSchema files are found in the following Citrix ADC location /nsconfig/loginschema/LoginSchema/. These pre-built loginSchema files cater to common use cases, and can be modified for slight variations if necessary.

Also, most single factor use cases with few customizations do not need loginSchema(s) configuration.

The administrator is advised to check documentation for additional configuration options that enable Citrix ADC to discover the factors. Once the user submits the credentials, the administrator can configure more than one factor to flexibly choose and process the authentication factors.
Configuring Dual Factor Authentication Without Using LoginSchema

Citrix ADC automatically determines dual factor requirements based on configuration. Once the user presents these credentials, the administrator can configure the first set of policies at the virtual server. Against each policy there can be a “nextFactor” configured as a “passthrough.” A “passthrough” implies that the Citrix ADC should process the logon using the existing credential set without going to the user. By using “passthrough” factors, an administrator can programmatically drive the authentication flow. Administrators are advised to read the nFactor specification or the deployment guides for further details. See Multi-Factor (nFactor) authentication.

User name and password Expressions

To process the login credentials, the administrator must configure the loginSchema. Single factor or dual factor use cases with few loginSchema customizations does not need a specified XML definition. The LoginSchema has other properties such as userExpression and passwdExpression that can be used to alter username/password that user presents. These are advanced policy expressions and can be used to override the user input as well.

High-level steps in nFactor configuration

The following diagram illustrates the high-level steps involved in nFactor configuration.
GUI Configuration

The following topics are described in this section:

• Create a Virtual Server
• Create Authentication Virtual Server
• Create Authentication CERT Profile
• Create an Authentication Policy
• Add an LDAP authentication server
• Add an LDAP authentication policy
• Add a RADIUS authentication server
• Add a RADIUS Authentication Policy
• Create an Authentication Login Schema
• Create a Policy Label

Create a Virtual Server

1. Navigate to Citrix Gateway -> Virtual Servers.
2. Click the **Add** button to create a Load Balancing Virtual server.

3. Enter the following information.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Parameter Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the Name of the virtual server.</td>
<td>Name for the Citrix Gateway virtual server. Must begin with an ASCII alphabetic or underscore (_) character, and must contain only ASCII alphanumeric, underscore, hash (#), period (.), space, colon (:), at (@), equals (=), and hyphen (-) characters. Can be changed after the virtual server is created. The following requirement applies only to the Citrix ADC CLI: If the name includes one or more spaces, enclose the name in double or single quotation marks (for example, “my server” or ‘my server’).</td>
</tr>
<tr>
<td>Enter the IP Address Type for the virtual server</td>
<td>Select an IP Address or Non-addressable option from the drop-down menu.</td>
</tr>
<tr>
<td>Enter the IP Address of the virtual server.</td>
<td>An Internet Protocol address (IP address) is a numerical label assigned to each device participating in the computer network that uses the Internet Protocol for communication.</td>
</tr>
<tr>
<td>Enter the Port number for the virtual server</td>
<td>Enter the port number.</td>
</tr>
<tr>
<td>Enter the Authentication Profile.</td>
<td>Authentication Profile entity on virtual server. This entity can be used to offload authentication to authentication, authorization, and auditing virtual server for multi-factor (nFactor) authentication</td>
</tr>
<tr>
<td>Enter the RDP Server Profile.</td>
<td>Name of the RDP server profile associated with the virtual server.</td>
</tr>
<tr>
<td>Enter the Maximum Users.</td>
<td>Maximum number of concurrent user sessions allowed on this virtual server. The actual number of users allowed to log on to this virtual server depends on the total number of user licenses.</td>
</tr>
<tr>
<td>Enter the Max Login Attempts.</td>
<td>Maximum number of logon attempts.</td>
</tr>
<tr>
<td>Enter the Failed Login Timeout.</td>
<td>Number of minutes an account will be locked if user exceeds maximum permissible attempts.</td>
</tr>
<tr>
<td>Enter the Windows EPA plug-in Upgrade.</td>
<td>Option to set plug-in upgrade behavior for Win.</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Parameter Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter the Linux EPA plug-in upgrade.</td>
<td>Option to set plug-in upgrade behavior for Linux.</td>
</tr>
<tr>
<td>Enter the MAC EPA plug-in upgrade</td>
<td>Option to set plug-in upgrade behavior for Mac.</td>
</tr>
<tr>
<td>Login Once</td>
<td>This option enables/disables seamless SSO for this virtual server.</td>
</tr>
<tr>
<td>ICA Only</td>
<td>When set to ON, it implies Basic mode where the user can log on using either the Citrix Workspace app or a browser and get access to the published apps configured at the Citrix Virtual Apps and Desktops environment pointed out by the Winhome parameter. Users are not allowed to connect using the Citrix Gateway plug-in and end point scans cannot be configured. The numbers of users that can log in and access the apps are not limited by the license in this mode. - When set to OFF, it implies SmartAccess mode where the user can log on using either the Citrix Workspace app or a browser or a Citrix Gateway plug-in. The admin can configure end point scans to be run on the client systems and then use the results to control access to the published apps. In this mode, the client can connect to the gateway in other client modes namely VPN and clientless VPN. The numbers of users that can log in and access the resources are limited by the CCU licenses in this mode.</td>
</tr>
<tr>
<td>Enable Authentication</td>
<td>Require authentication for users connecting to Citrix Gateway.</td>
</tr>
<tr>
<td>Double Hop</td>
<td>Use the Citrix Gateway appliance in a double-hop configuration. A double-hop deployment provides an extra layer of security for the internal network by using three firewalls to divide the DMZ into two stages. Such a deployment can have one appliance in the DMZ and one appliance in the secure network.</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Parameter Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Down State Flush</td>
<td>Close existing connections when the virtual server is marked DOWN, which means the server might have timed out. Disconnecting existing connections frees resources and in certain cases speeds recovery of overloaded load balancing setups. Enable this setting on servers in which the connections can safely be closed when they are marked DOWN. Do not enable DOWN state flush on servers that must complete their transactions.</td>
</tr>
<tr>
<td>DTLS</td>
<td>This option starts/stops the turn service on the virtual server</td>
</tr>
<tr>
<td>AppFlow Logging</td>
<td>Log AppFlow records that contain standard NetFlow or IPFIX information, such as time stamps for the beginning and end of a flow, packet count, and byte count. Also log records that contain application-level information, such as HTTP web addresses, HTTP request methods and response status codes, server response time, and latency.</td>
</tr>
<tr>
<td>ICA Proxy Session Migration</td>
<td>This option determines if an existing ICA Proxy session is transferred when the user logs on from another device.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the virtual server, as UP, DOWN, BUSY, and so on.</td>
</tr>
<tr>
<td>Enable Device Certificate</td>
<td>Indicates whether device certificate check as a part of EPA is on or off.</td>
</tr>
</tbody>
</table>
4. Select the **No Server Certificate** section of the page.
5. Click > to Select the Server Certificate.

6. Select the SSL Certificate and click the Select button.

7. Click Bind.
8. If you see a warning about **No usable ciphers**, click OK

9. Click the **Continue** button.

10. In the Authentication section, click the + icon in the top right.

**Create Authentication Virtual Server**

1. Navigate to **Security -> Citrix ADC AAA – Application Traffic -> Virtual Servers.**
2. Click the Add button.

3. Complete the following Basic Settings to create the Authentication Virtual Server.

   **Note:** The mandatory fields are indicated by * to the right of the setting name.

   - Enter the **Name** for the new authentication virtual server.
   - Enter the **IP Address Type**. The IP Address Type can be configured as Non-addressable.
   - Enter the **IP Address**. The IP Address can be zero.
   - Enter the **Protocol** type of the authentication virtual server.
   - Enter the **TCP Port** on which the virtual server accepts connections.
   - Enter the **domain** of the authentication cookie set by Authentication virtual server.
4. Click **OK**.

5. Click the **No Server Certificate**.
6. Select the desired Server Certificate from the list.

![Server Certificate Binding](image)

7. Choose the desired SSL Certificate and click the **Select** button.

**Note**: The Authentication virtual server does not need a certificate bound to it.

![SSL Certificates](image)

8. Configure the **Server Certificate Binding**.
   - Check the **Server Certificate for SNI** box to bind one or more Certkeys used for SNI processing.
   - Click the **Bind** button.

![Server Certificate Binding](image)
Create Authentication CERT Profile


2. Select the Profiles tab and then select Add.

3. Complete the following fields to create the Authentication CERT Profile. The mandatory fields are indicated by an * to the right of the setting name.

   • **Name** - Name for the client cert authentication server profile (action).
   • **Two factor** – In this instance the two-factor authentication option is NOOP.
   • **User Name Field** – enter the client-cert field from which the user name is extracted. Must be set to either ““Subject”” or ““Issuer”” (include both sets of double quotation marks).
• **Group Name Field** - enter the client-cert field from which the group is extracted. Must be set to either ""Subject"" or ""Issuer"" (include both sets of double quotation marks).

• **Default Authentication Group** - This is the default group that is chosen when the authentication succeeds in addition to extracted groups.

4. Click **Create**.

![Create Authentication CERT Profile](image)

**Create an Authentication Policy**

1. Navigate to **Security -> Citrix ADC AAA – Application Traffic -> Policies -> Authentication -> Advanced Policies -> Policy.**
2. Select the **Add** button

3. Complete the following information to Create Authentication Policy. The mandatory fields are indicated by an * to the right of the setting name.
a) **Name** – enter the Name for the advance AUTHENTICATION policy. Must begin with a letter, number, or the underscore character (_), and must contain only letters, numbers, and the hyphen (-), period (.), pound (#), space (), at (@), equals (=), colon (:), and underscore characters. Cannot be changed after AUTHENTICATION policy is created.

The following requirement applies only to the Citrix ADC CLI: If the name includes one or more spaces, enclose the name in double or single quotation marks (for example, “my authentication policy” or ‘my authentication policy’).

b) **Action Type** - enter the type of the Authentication Action.

c) **Action** - enter the name of the authentication action to be performed if the policy matches.

d) **Log Action** - enter the name of message log action to use when a request matches this policy.

e) **Expression** - enter the name of the Citrix ADC named rule, or a default syntax expression, that the policy uses to determine whether to attempt to authenticate the user with the AUTHENTICATION server.

f) **Comments** – enter any comments to preserve information about this policy.

4. Click **Create**

![Create Authentication Policy](image)

**Add an LDAP Authentication Server**

1. Navigate to **Security -> Citrix ADC AAA – Application Traffic -> Policies -> Authentication -> Basic Policies -> LDAP.**
2. Add an LDAP server by selecting the Server tab and selecting the Add button.

Add an LDAP Authentication Policy

2. Click **Add** to add an Authentication Policy.

3. Complete the following information to Create Authentication Policy. The mandatory fields are indicated by an * to the right of the setting name.

   a) **Name** - Name for the advance AUTHENTICATION policy.
   Must begin with a letter, number, or the underscore character (_), and must contain only letters, numbers, and the hyphen (-), period (.), pound (#), space (), at (@), equals (=), colon (:), and underscore characters. Cannot be changed after AUTHENTICATION policy is created.
The following requirement applies only to the Citrix ADC CLI: If the name includes one or more spaces, enclose the name in double or single quotation marks (for example, “my authentication policy” or ‘my authentication policy’).

b) **Action Type** - Type of the Authentication Action.

c) **Action** - Name of the authentication action to be performed if the policy matches.

d) **Log Action** - Name of message log action to use when a request matches this policy.

e) **Expression** - Name of the Citrix ADC named rule, or a default syntax expression, that the policy uses to determine whether to attempt to authenticate the user with the AUTHENTICATION server.

f) **Comments** - Any comments to preserve information about this policy.

4. Click **Create**

Add a RADIUS Authentication Server

2. To add a Server select the **Servers** tab and select the **Add** button.

3. Enter the following to create an Authentication RADIUS Server. The mandatory fields are indicated by an * to the right of the setting name.
   a) Enter a **Name** for the RADIUS Action.
   b) Enter the **Server Name** or **Server IP Address** assigned to the RADIUS server.
   c) Enter the **Port** number on which the RADIUS server listens for connections.
   d) Enter the **Time-out** value in few seconds. This is the value that the Citrix ADC appliance waits for a response from the RADIUS server.
   e) Enter the **Secret Key** that is shared between the RADIUS server and the Citrix ADC appliance. The Secret Key is required to allow the Citrix ADC appliance to communicate with the RADIUS server.
server.

f) Confirm the Secret Key.

4. Click Create

![](image)

Add a RADIUS Authentication Policy

2. Click **Add** to create an Authentication Policy.

3. Complete the following information to Create Authentication Policy. The mandatory fields are indicated by an * to the right of the setting name.

   a) **Name** - Name for the advance AUTHENTICATION policy. Must begin with a letter, number, or the underscore character (_), and must contain only letters, numbers, and the hyphen (-), period (.), pound (#), space (), at (@), equals (=), colon (:), and underscore characters. Cannot be changed after AUTHENTICATION policy is created.
The following requirement applies only to the Citrix ADC CLI: If the name includes one or more spaces, enclose the name in double or single quotation marks (for example, “my authentication policy” or ‘my authentication policy’).

b) **Action Type** - Type of the Authentication Action.

c) **Action** - Name of the authentication action to be performed if the policy matches.

d) **Log Action** - Name of message log action to use when a request matches this policy.

e) **Expression** - Name of the Citrix ADC named rule, or a default syntax expression, that the policy uses to determine whether to attempt to authenticate the user with the AUTHENTICATION server.

f) **Comments** - Any comments to preserve information about this policy.

4. Click **OK**

5. Verify that your Authentication Policy is listed.
Create an Authentication Login Schema


2. Select the Profiles tab and Click the Add button.

3. Complete the following fields to Create Authentication Login Schema:
   a) Enter Name – this is the name for the new login schema.
   b) Enter Authentication Schema – this is the name of the file for reading authentication schema to be sent for Login Page UI. This file should contain xml definition of elements as per Citrix Forms Authentication Protocol to be able to render login form. If administrator does not want
to prompt users for additional credentials but continue with previously obtained credentials, then “noschema” can be given as argument. Please note that this applies only to loginSchemas that are used with user-defined factors, and not the virtual server factor.

c) Enter **User Expression** - this is the expression for user name extraction during login.

d) Enter **Password Expression** - this is the expression for password extraction during login.

e) Enter **User Credential Index** - this is the index at which user entered user name should be stored in session.

f) Enter **Password Credential Index** - this is the index at which user entered password should be stored in session.

g) Enter **Authentication Strength** - this is the weight of the current authentication.

4. **Click Create**

a) Verify that your Login Schema Profile is listed.
Create a Policy Label

A policy label specifies the authentication policies for a particular factor. Each policy label corresponds to a single factor. The policy label specifies the login form that must be presented to the user. The policy label must be bound as the next factor of an authentication policy or of another authentication policy label. Typically, a policy label includes authentication policies for a specific authentication mechanism. However, you can also have a policy label that has authentication policies for different authentication mechanisms.


2. Click the Add button.
3. Complete the following fields to Create Authentication Policy Label:
   a) Enter the **Name** for the new authentication policy label.
   b) Enter the **Login Schema** associated with authentication policy label.
   c) Click **Continue**.

4. **Select a Policy** from the drop-down menu.

5. Choose the desired **Authentication Policy** and click the **Select** button.
6. Complete the following fields:
   a) Enter the **Priority** of the policy binding.
   b) Enter the **Goto Expression** – the expression specifies the priority of the next policy that will be evaluated if the current policy rule evaluates to TRUE.

7. Select the desired Authentication Policy and click the **Select** button.

8. Click the **Bind** button.
9. Click Done.

10. Review the Authentication Policy Label.

**reCaptcha configuration for nFactor authentication**

Starting from Citrix ADC release 12.1 build 50.x, Citrix Gateway supports a new first class action ‘captchaAction’ that simplifies Captcha configuration. As Captcha is a first class action, it can be a factor of its own. You can inject Captcha anywhere in the nFactor flow.

Previously, you had to write custom WebAuth policies with changes to RfWeb UI as well. With the introduction of captchaACtion, you do not have to modify the JavaScript.
**Important**

If Captcha is used along with user name or password fields in the schema, submit button is disabled until Captcha is met.

**Captcha configuration**

Captcha configuration involves two parts.

1. Configuration on Google for registering Captcha.
2. Configuration on Citrix ADC appliance to use Captcha as part of login flow.

**Captcha configuration on Google**

Register a domain for Captcha at [https://www.google.com/recaptcha/admin#list](https://www.google.com/recaptcha/admin#list).

1. When you navigate to this page, the following screen appears.
2. After a domain is registered, the “SiteKey” and “SecretKey” are displayed.

Note
Use reCAPTCHA v2 only. Invisible reCAPTCHA is still in preview.

The “SiteKey” and “SecretKey” are grayed out for security reasons. “SecretKey” must be
Captcha configuration on Citrix ADC appliance

Captcha configuration on Citrix ADC appliance can be divided into three parts:

- Display Captcha screen
- Post the Captcha response to Google server
- LDAP configuration is second factor for user logon (optional)

Display Captcha screen

The login form customization is done through the SingleAuthCaptcha.xml login schema. This customization is specified at authentication virtual server and is sent to UI for rendering the login form. The built-in login schema, SingleAuthCaptcha.xml, is at /nsconfig/loginSchema/LoginSchema directory on the Citrix ADC appliance.

Important

- Based on your use case and different schemas, you can modify the existing schema. For instance if you need only Captcha factor (without user name or password) or dual authentication with Captcha.
- If any custom modifications are performed or the file is renamed, Citrix recommends copying all loginSchemas from /nsconfig/loginschema/LoginSchema directory to parent directory, /nsconfig/loginschema.

To configure display of Captcha using CLI

- add authentication loginSchema singleauthcaptcha -authenticationSchema /nsconfig/loginSchema/SingleAuthCaptcha.xml
- add authentication loginSchemaPolicy singleauthcaptcha -rule true -action singleauthcaptcha
- add authentication vserver auth SSL <IP> <Port>
- add ssl certkey vserver-cert -cert <path-to-cert-file> -key <path-to-key-file>
- bind ssl vserver auth -certkey vserver-cert
- bind authentication vserver auth -policy singleauthcaptcha -priority 5 -gotoPriorityExpression END

Post the Captcha response to Google server

After you have configured the Captcha that must be displayed to the users, admins post add the configuration to the Google server to verify the Captcha response from browser.
To verify Captcha response from the browser

- add authentication captchaAction myrecaptcha -sitekey <sitekey-copied-from-google> -secretkey <secretkey-from-google>
- add authentication policy myrecaptcha -rule true -action myrecaptcha
- bind authentication vserver auth -policy myrecaptcha -priority 1

The following commands are required to configure if AD authentication is desired. Else, you can ignore this step.

- add authentication ldapAction ldap-new -serverIP x.x.x.x -serverPort 636 -ldapBase "cn=users,dc=aaatm,dc=com" -ldapBindDn adminuser@aaatm.com -ldapBindDnPassword <password> -encrypted -encryptmethod ENCMTHD_3 - ldapLoginName sAMAccountName -groupAttrName memberof -subAttributeName CN -secType SSL -passwdChange ENABLED -defaultAuthenticationGroup ldapGroup
- add authenticationpolicy ldap-new -rule true -action ldap-new

LDAP configuration is second factor for user logon (optional)

The LDAP authentication happens after Captcha, you add it to the second factor.

- add authentication policylabel second-factor
- bind authentication policylabel second-factor -policy ldap-new -priority 10
- bind authentication vserver auth -policy myrecaptcha -priority 1 -nextFactor second-factor

Administrator needs to add appropriate virtual servers depending on whether load balancing virtual server or Citrix Gateway appliance is used for access. Administrator must configure the following command if load balancing virtual server is required:

```
add lb vserver lbtest HTTP <IP> <Port> -authentication ON -authenticationHost nssp.aaatm.com
```

nssp.aaatm.com – Resolves to authentication virtual server.

User validation of Captcha

Once you have configured all the steps mentioned in the previous sections, you must see the UI screen-shots shown below.

1. Once the authentication virtual server loads the login page, the logon screen is displayed. Log On is disabled until Captcha is complete.
2. Select I'm not a robot option. The Captcha widget is displayed.
3. You are navigated through series of Captcha images, before the completion page is displayed.

4. Enter the AD credentials, select the **I'm not a robot** check box and click **Log On**. If authentication succeeds, you are redirected to the desired resource.
Notes

- If Captcha is used with AD authentication, Submit button for credentials is disabled until Captcha is complete.
- The Captcha happens in a factor of its own. Therefore, any subsequent validations like AD must happen in the ‘nextfactor’ of Captcha.

Unified Gateway Visualizer

April 23, 2019

Overview

The Unified Gateway Visualizer provides a visual representation of the configurations using the Unified Gateway Wizard. The Unified Gateway Visualizer is used to add and edit configuration, and diagnose a backend issues.

The Unified Gateway Visualizer shows the following:
<table>
<thead>
<tr>
<th>Configuration</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-authentication policies</td>
<td>Authentication policies</td>
</tr>
<tr>
<td>CS virtual servers</td>
<td>VPN virtual servers</td>
</tr>
</tbody>
</table>
Unified Gateway deployment enables secure remote access through one URL to your Enterprise or SaaS applications, clientless access applications, Citrix Virtual Apps, and Desktops resources.

**Configure Unified Gateway**

1. Select Unified Gateway from the menu.

2. At the next screen, verify that you have the following information, then click **Get Started**:

   1. Public IP address for the Unified Gateway.
   2. Server certificate chain (.PFX or .PEM) with optional Root-CA certificate.
   4. Application details (URLs for Saas applications or Citrix Virtual Apps and Desktops server details).
Create a Unified Gateway Configuration virtual server.

1. Enter the configuration Name for the virtual server.
2. Enter the public facing Unified Gateway IP address for the Unified Gateway deployment.
3. Enter the Port number. The port number range is 1 - 65535.
4. Click Continue.
Complete the following information to specify the Server Certificate.

1. Select either the **Use existing certificate** or **Install Certificate** radio buttons.
2. Select a **Server Certificate** from the drop down menu.
3. Click the **Continue** button.

Complete the following information to specify Authentication.

1. Select a **Primary authentication method** from the pull-down menu.
2. Select either the **Use existing server** or **Add new server** radio buttons.
3. Click the **Continue** button.
1. Select the **Portal Theme** from the pull-down menu.
2. Click **Continue**.

1. Select either the **Web Application** or **Citrix Virtual Apps Desktops** radio buttons.
2. Click **Continue**.
Complete the following information to specify Web Application.

1. Enter the Name of the bookmark link.

2. Select the type of application the VPN URL represents. The possible values are:
   - Intranet Application
   - Clientless Access
   - SaaS
   - PreConfigured application on this Citrix ADC

3. Check this box to make this application accessible through the Unified Gateway URL.

4. Enter the URL for the bookmark link.

5. From the Icon URL choose a file to fetch an icon file. The MaxLength = 255

6. Click the Continue button.
1. Click **Done**.

1. Click **Continue**.
1. Click **Done**.
GUI Configuration

1. Select Unified Gateway from the menu.
1. Click the Unified Gateway Visualizer icon to access configured Gateway instances.

The Unified Gateway Visualizer looks like the following graphic:
The Unified Gateway Visualizer has PreAuth, Auth, and an Apps section. If the vpn virtual server has pre-authentication policy, only then will the pre-auth be shown in the Unified Gateway Visualizer.

The Unified Gateway Visualizer uses a color coding scheme for the load balancing and VPN virtual servers to indicate their state.

<table>
<thead>
<tr>
<th>Colour</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>means the server is down.</td>
</tr>
<tr>
<td>Grey</td>
<td>means webapps/Citrix Virtual Appss have not been configured.</td>
</tr>
<tr>
<td>Green</td>
<td>means everything is fine with the virtual server.</td>
</tr>
<tr>
<td>Orange</td>
<td>means one of the load balancing virtual server services is down, but still it is functioning properly.</td>
</tr>
</tbody>
</table>
Details of VPN Virtual Servers

To get the details of the vpn virtual servers, click on the vpn virtual servers node. The popup renders details like the C/S rule and all policies.

1. Add Policies to the vpn entity by clicking on the (+) icon.

The following policies are bound by default.

1. Click on the desired node for details of policies already configured.
For VPN virtual server information, the VPN title in the popup is a clickable entity that goes to a slider that details the VPN virtual server.

The details of the VPN server are shown here.
The Pre Auth Block

If a vpn virtual server has pre authentication policies associated with it, the Unified Gateway Visualizer shows a PreAuth block. The Pre Auth block shows the policies, and provides an option to add pre authentication policies to the vpn.

1. Click the + to add a preauth policy.
In a case where no pre authentication policies have been associated, this block would be hidden from the view.

**The Auth Block**

The Auth block lists the primary and secondary policies. The Auth block provides an option to add policies.

1. Click + in the Primary list to add a Primary Authentication Binding or Click + in the Secondary list to add a Secondary Authentication Binding.
1. Select an option from the **Primary authentication method** drop down menu. This is a mandatory field.
2. Specify if it is an use **existing server** or **Add new server** by selecting the radio button.
3. Select an option from the **LDAP Policy Name** drop down menu. This is a mandatory field.
4. Select an option from the **Secondary authentication method** drop down menu. This is a mandatory field.

   1. Specify if you want to **use existing server** or **Add new server** by selecting the radio button.
   2. Select an option from the **RADIUS** drop down menu. This is a mandatory field.
   3. Click **Continue**.
Adding Storefront

Click + near the XA/XD, and it takes you to adding “XA/XD” apps.

You can choose your integration point. The options are Storefront, WI, or WionNS. Click Continue.

1. Complete the following fields to configure StoreFront:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFront FQDN*</td>
<td>Enter the FQDN of the StoreFront server. Max length: 255 char. Example://storefront.xendt.net</td>
</tr>
<tr>
<td>Site Path*</td>
<td>Enter the path to Receiver for Web site already configured on the StoreFront.</td>
</tr>
<tr>
<td>Single Sign-on Domain*</td>
<td>Enter the default domain for user authentication</td>
</tr>
<tr>
<td>Store Name*</td>
<td>Enter the name for the STOREFRONT monitors.</td>
</tr>
</tbody>
</table>
The STORENAME is an argument defining storefront service store name to probe the health of StoreFront servers. Applicable to STOREFRONT monitors. Maximum Length: 31

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Ticket Authority Server*</td>
<td>Enter the secure ticket authority URL. This is typically present on the delivery controller.</td>
</tr>
<tr>
<td>Example: <a href="http://sta">http://sta</a></td>
<td></td>
</tr>
<tr>
<td>StoreFront Server*</td>
<td>Enter the IP Address of the StoreFront Server</td>
</tr>
<tr>
<td>Protocol*</td>
<td>Enter the protocol used by the server.</td>
</tr>
<tr>
<td>Port*</td>
<td>Enter the port used by the server.</td>
</tr>
<tr>
<td>Load Balancing</td>
<td>Enter the load balancing configuration for the StoreFront servers.</td>
</tr>
<tr>
<td>Virtual Server*</td>
<td>Enter the public facing IP address for the Unified Gateway deployment.</td>
</tr>
</tbody>
</table>

2. Click **Continue**
Adding SaaS

1. Click + to add SaaS apps, it will take you to the Add SaaS page. Complete the following fields to configure SaaS. The fields that require mandatory information are noted with the *.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Enter the name of the bookmark link.</td>
</tr>
</tbody>
</table>
Adding WebApps

1. Click + to add Web apps, it will take you to the Add Web apps page. Complete the following fields to configure a Web Application. The fields that require mandatory information are noted with the *.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Enter the name of the bookmark link.</td>
</tr>
<tr>
<td>Application Type</td>
<td>Enter the type of application this VPN URL represents. Possible values are: Intranet Application/Clientless Access/SaaS/PreConfigured application on this Citrix ADC</td>
</tr>
<tr>
<td>Enter URL*</td>
<td>Enter URL of the Intranet application.</td>
</tr>
<tr>
<td>Choose File</td>
<td>Enter the URL to fetch the icon file for displaying this resource. MaxLength = 255</td>
</tr>
</tbody>
</table>

If an application is accessible through the Unified Gateway URL, the details of the Load Balancing server can be accessed by clicking on the app:
New policies can be added by clicking on (+) and all the bound policies can be viewed by clicking on the node that displays policy information.

The number of services bound to the LB are also shown, along with the overall state information. Further click will list all the services. New services can be added to the LB.

For further details of the LB, the title of the popup is clickable that lands to the LB virtual server details page.

**Configure Citrix Gateway to use RADIUS and LDAP Authentication with Mobile/Tablet Devices**

September 10, 2019
This section describes how to configure Citrix Gateway appliance to use RADIUS authentication as primary and LDAP authentication as secondary with mobile/tablet devices.

The configuration demonstrated in the section still allows all other connections to use LDAP first and RADIUS second.

When you configure two-factor authentication on Citrix Workspace app for use with mobile/tablet devices, you must add the RSA SecureID (RADIUS authentication) as the primary authentication. But when the users get the prompt for Username and Password, Passcode on Receiver they will be putting LDAP first and RADIUS as second credentials. From administrator point of view it is a different configuration as compared to non-mobile configuration.

Complete the following procedure to configure Citrix Gateway appliance to use RADIUS authentication as primary and LDAP authentication as secondary with mobile/tablet devices.

1. From the Configuration Utility, select Citrix Gateway > Policies > Authentication and create an authentication policy for LDAP and RSA for mobile devices and non-mobile devices. This is necessary to avoid a logic condition that could allow users to bypass the RADIUS authentication.

   ![Configuration Utility Screenshot]

2. Enter LDAP Server details after clicking add option under Servers tab for LDAP.
For more details on how to configure authentication server refer to the section “Creating authentication Server” of How to Configure LDAP Authentication on NetScaler

3. Create LDAP policy for the mobile devices by choosing the required LDAP Server.

To bind this policy to only mobile devices, use the following expression:

```
'REQ.HTTP.HEADER User-Agent CONTAINS CitrixReceiver'
```

4. Click Expression Editor to create policy:
5. Create a RADIUS policy and RADIUS Server for the mobile devices.

(a) Navigate to RADIUS option from Citrix Gateway > Policies > Authentication > RADIUS. Click Add under Server tab.

(b) Add the required details. The default port for RADIUS authentication is 1812.
(c) To bind this policy to only mobile devices, use the following expression:

```
REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver
```

6. Follow the same step to create an LDAP policy for non-mobile devices. To bind this policy to only non-mobile devices, use the following expression:

```
REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver
```
7. Create a RADIUS policy for non-mobile devices. To bind this policy to only non-mobile devices, use the following expression:

`REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver`
8. Go to the Properties of the Citrix Gateway Virtual Server and click the Authentication tab. On the Primary Authentication Policies, add the RSA_Mobile policy as top priority and the LDAP_NonMobile policy as secondary priority:

9. On the Secondary Authentication Policies, add the LDAP_Mobile policy as top priority, followed by the RSA_NonMobile policy as secondary priority:
The session policy must have the correct Single Sign-on Credential Index, that is, it must be the LDAP credentials. For mobile devices, Credential Index under Session Profile > Client Experience should be set to Secondary which is LDAP.

Therefore you need two session policies, one for mobile devices and the other for non-mobile devices.

(a) For mobile devices session policy and session profile will look as shown in the following screenshot. To create session policy, navigate to required virtual server and, click Edit, go to policy section and click + sign:

(b) Choose Session option from the drop-down.

(c) Enter the desired Session Policy name and click + to create a new profile. For mobile devices, Credential Index under Session Profile > Client Experience should be set to Secondary which is LDAP.
(d) For non-mobile device follow the same steps. Credential Index under Session Profile > Client Experience should be set to Primary which is LDAP.

The expression should be changed to:

```
'REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver'
```

(e) To create new profile for non-mobile user, click + sign.
1. Policies and profiles under the required virtual server will look similar to the following screenshot:

2. Additionally on the StoreFront, under the Citrix Gateway configuration set to use “Logon Type” = “Domain and Security token”
Configuration support for SameSite cookie attribute

March 12, 2020

The SameSite attribute indicates the browser whether the cookie can be used for cross-site context or only for same-site context. Also, if an application intends to be accessed in cross-site context then it can do so only via HTTPS connection. For details, see RFC6265.

Until Feb 2020, the SameSite attribute was not explicitly set in Citrix ADC. The browser took the default value (None). The non-setting of SameSite attribute did not impact the Citrix Gateway and Citrix ADC AAA deployments.

With certain browsers upgrade, such as Google Chrome 80, there is a change in the default cross-domain behavior of cookies. The SameSite attribute can be set to one of the following values. Default value for Google Chrome is set to Lax. For certain version of other browsers, the default value for SameSite attribute might still be set to None.

- **None**: Indicates the browser to use cookie in cross-site context only on secure connections.
- **Lax**: Indicates the browser to use cookie for requests on the same-site context. In cross-site context, only safe HTTP methods like GET request can use the cookie.
- **Strict**: Use the cookie only in the same site context.

If there is no SameSite attribute in the cookie, the Google Chrome assumes the functionality of SameSite = Lax.

As a result, for deployments within an iframe with cross-site context that require cookies to be inserted by the browser, Google Chrome does not share cross site cookies. As a result, the iframe within the website might not load.

Configure SameSite cookie attribute

A new cookie attribute named SameSite is added to the VPN and Citrix ADC AAA virtual servers. This attribute can be set at the global level and at the virtual server level.

To configure SameSite attribute, you must perform the following:

1. Set the SameSite attribute for the virtual server
2. Bind cookies to the patset (if the browser drops cross-site cookies are dropped by the browser)

Setting the SameSite attribute by using the CLI

To set the SameSite attribute at the virtual server level, use the following commands.
To set the SameSite attribute at the global level, use the following commands.

1. `set vpn param VP1 -SameSite [ STRICT | LAX | None ]`
2. `set aaa param VP1 -SameSite [ STRICT | LAX | None ]`

**Note:** The virtual server level setting takes preference over the global level setting. Citrix recommends setting the SameSite cookie attribute at the virtual server level.

**Binding cookies to the patset by using the CLI**

If the browser drops cross-site cookies, you can bind that cookie string to the existing `ns_cookies_SameSite` patset so that the SameSite attribute is added to the cookie.

**Example:**

1. `bind patset ns_cookies_SameSite "NSC_TASS"
2. `bind patset ns_cookies_SameSite "NSC_TMAS"

**Setting the SameSite attribute by using the GUI**

**To set the SameSite attribute at the virtual server level:**

1. Navigate to Citrix Gateway > Virtual Servers.
2. Select a virtual server and click Edit.
3. Select the edit icon in the Basic Settings section and click More.

4. In SameSite, select the option as required.
To set the SameSite attribute at the global level:

1. Navigate to Citrix Gateway > Global Settings > Change Global Settings.
2. Click the Security tab.
3. In SameSite, select the option as required.

Optimizing Citrix Gateway VPN split tunnel for Office365

April 9, 2020
As organizations are adapting to the remote work options more rapidly than before, the remote access infrastructure must be optimized to facilitate seamless connectivity during increased traffic load conditions.

*Microsoft recommends excluding traffic destined to key Office 365 services from the scope of VPN connection by configuring split tunneling using published IPv4 and IPv6 address ranges. For best performance and most efficient use of VPN capacity, traffic to this dedicated IP address ranges associated with Office 365 Exchange Online, SharePoint Online and Microsoft Teams (referred to as Optimize category in Microsoft documentation) should be routed directly, outside of the VPN tunnel. Please refer to [Microsoft guidance](https://docs.microsoft.com/en-us/Office365/Enterprise/office-365-vpn-split-tunnel) for more detailed information about this recommendation.*

Microsoft’s recommendation in Citrix Gateway is achieved by routing the Microsoft provided list of IP addresses directly to the internet for the O365 traffic by using the split tunnel reverse configuration.

The configuration involves the following that can be performed manually by using the **GUI or CLI** commands.

- Configure split tunnel for reverse configuration
- Configure intranet applications for user access to resources

**Configuration by using the GUI**

**To configure split tunneling by using the GUI**

1. On the Configuration tab, Navigate to **Citrix Gateway > Global Settings**.
2. In the details pane, under **Settings**, click **Change Global Settings**.
3. On the **Client Experience** tab, in **Split Tunnel**, select **Reverse**.
4. Click **OK**.
To create VPN intranet application by using the GUI

1. On the Configuration tab, Navigate to Citrix Gateway > Global Settings.
2. In the details pane, under Intranet Applications, click the link.
3. In the Configure VPN Intranet Application page, click Add, and then click New.
4. In **Name**, type a name for the profile.

5. In **Protocol**, select the protocol that applies to the network resource.

6. In **Destination Type**, select **IP Address and Netmask**.

7. In **IP Address**, enter the IP address that must be routed directly to the internet for O365 traffic. For the list of IP address, see List of IP addresses.

8. In **Netmask**, enter the netmask IP address.
9. Click **Create** and then click **Close**.

**Note:** Repeat this procedure for all the IP addresses.
**Configuration by using the CLI**

- To set split tunnel to reverse, at the command prompt, type;
  
  ```bash
  set vpn parameter -splitTunnel REVERSE
  ```

- To add VPN intranet application, at the command prompt, type;
  
  ```bash
  add vpn intranetApplication intranetapp1 ANY 13.107.6.152 -netmask 255.255.255.254 -destPort 1-65535 -interception TRANSPARENT
  ```

**Note:** Repeat this procedure for all the IP addresses.

- To bind the intranet application, at the command prompt type;
  
  ```bash
  bind vpn global -intranetApplication intranetapp1
  ```

**List of IP addresses of Office 365 services (EXO, SPO, and Teams)**


**Note from Microsoft:**

As part of Microsoft’s response to the COVID-19 situation, Microsoft has declared a temporary moratorium on some planned URL and IP address changes. This moratorium is intended to provide customer IT teams with confidence and simplicity in implementing recommended network optimizations for work-from-home Office 365 scenarios. From March 24, 2020 through June 30, 2020 this moratorium will halt changes for key Office 365 services (Exchange Online, SharePoint Online, and Microsoft Teams) to IP ranges and URLs included in the Optimize category.

**IPv4 address range**

- 104.146.128.0/17
- 13.107.128.0/22
- 13.107.136.0/22
- 13.107.18.10/31
- 13.107.6.152/31
- 13.107.64.0/18
- 131.253.33.215/32
- 132.245.0.0/16
- 150.171.32.0/22
- 150.171.40.0/22
- 191.234.140.0/22
204.79.197.215/32
23.103.160.0/20
40.104.0.0/15
40.108.128.0/17
40.96.0.0/13
52.104.0.0/14
52.112.0.0/14
52.96.0.0/14
52.120.0.0/14

**IPv6 address range**

2603:1006::/40
2603:1016::/36
2603:1026::/36
2603:1036::/36
2603:1046::/36
2603:1056::/36
2603:1096::/38
2603:1096:400::/40
2603:1096:600::/40
2603:1096:a00::/39
2603:1096:c00::/40
2603:10a6:200::/40
2603:10a6:400::/40
2603:10a6:600::/40
2603:10a6:800::/40
2603:10d6:200::/40
2620:1ec:4::152/128
2620:1ec:4::153/128
2620:1ec:900::/46
2620:1ec:a92::152/128
2620:1ec:a92::153/128
2a01:111:f400::/48
Users can use the following methods to connect to your organization’s network resources through Citrix Gateway:

- Citrix Workspace app that contains all Citrix plug-ins installed on the user device.
- Citrix Workspace app for Web that allows user connections to applications, desktops, and ShareFile by using a Web browser.
- Secure Hub to allow users to access Secure Mail, WorxWeb and mobile apps from their iOS and Android devices.
- Citrix Gateway plug-in for Windows, Mac OS X, or Linux.
- Citrix Gateway App for iOS and Android.
- Citrix Gateway plug-in for Java.
- Clientless access that provides users with the access they need without installing user software.
- Interoperability with Citrix Repeater plug-in.

If users install the Citrix Gateway plug-in and then install Citrix Workspace app from Citrix XenApp 6.5 for Windows Server 2008 (including Feature Pack and Feature Pack 2), Citrix Virtual Desktops 7.0 or newer, Citrix Workspace app automatically adds the Citrix Gateway plug-in. Users can connect with the Citrix Gateway plug-in from a web browser or from Citrix Workspace app.

SmartAccess determines automatically the methods of access that are allowed for a user device based on the results of an endpoint analysis scan. For more information about SmartAccess, see Configuring SmartAccess topic.

Citrix Gateway supports Citrix Endpoint Management Worx apps for iOS and Android mobile devices. Citrix Gateway contains Secure Browse that allows connections to Citrix Gateway from iOS mobile devices that establishes the Micro VPN tunnel. Android devices that connect with Secure Hub also establish a Micro VPN tunnel automatically that provides secure web and mobile application-level access to resources in your internal network. If users connect from an Android device with Worx apps, you must configure DNS settings on Citrix Gateway. For details, see Supporting DNS Queries by Using DNS Suffixes for Android Devices topic.
How User Connections Work with the Citrix Gateway plug-in

April 23, 2019

Citrix Gateway operates as follows:

- When users attempt to access network resources across the VPN tunnel, the Citrix Gateway plug-in encrypts all network traffic destined for the organization’s internal network and forwards the packets to Citrix Gateway.
- Citrix Gateway terminates the SSL tunnel, accepts any incoming traffic destined for the private network, and forwards the traffic to the private network. Citrix Gateway sends traffic back to the remote computer over a secure tunnel.

When users type the web address, they receive a logon page where they enter their credentials and log on. If the credentials are correct, Citrix Gateway finishes the handshake with the user device.

If the user is behind a proxy server, the user can specify the proxy server and authentication credentials. For more information, see Enabling Proxy Support for User Connections.

The Citrix Gateway plug-in is installed on the user device. After the first connection, if users log on by using a Windows-based computer, they can use the icon in the notification area to establish the connection.

Establishing the Secure Tunnel

September 10, 2019

When users connect with the Citrix Gateway plug-in, Secure Hub, or Citrix Workspace app, the client software establishes a secure tunnel over port 443 (or any configured port on Citrix Gateway) and sends authentication information. When the tunnel is established, Citrix Gateway sends configuration information to the Citrix Gateway plug-in, Secure Hub, or Citrix Workspace app describing the networks to be secured and containing an IP address if you enable address pools.

Tunneling Private Network Traffic over Secure Connections

When the Citrix Gateway plug-in starts and the user is authenticated, all network traffic destined for specified private networks is captured and redirected over the secure tunnel to Citrix Gateway. Citrix Workspace app must support the Citrix Gateway plug-in to establish the connection through the secure tunnel when users log on.
Secure Hub, Secure Mail, and WorxWeb use Micro VPN to establish the secure tunnel for iOS and Android mobile devices.

Citrix Gateway intercepts all network connections that the user device makes and multiplexes them over Secure Sockets Layer (SSL) to Citrix Gateway, where the traffic is demultiplexed and the connections are forwarded to the correct host and port combination.

The connections are subject to administrative security policies that apply to a single application, a subset of applications, or an entire intranet. You specify the resources (ranges of IP address/subnet pairs) that remote users can access through the VPN connection.

The Citrix Gateway plug-in intercepts and tunnels the following protocols for the defined intranet applications:

- TCP (all ports)
- UDP (all ports)
- ICMP (types 8 and 0 - echo request/reply)

Connections from local applications on the user device are securely tunneled to Citrix Gateway, which reestablishes the connections to the target server. Target servers view connections as originating from the local Citrix Gateway on the private network, thus hiding the user device. This is also called reverse Network Address Translation (NAT). Hiding IP addresses adds security to source locations.

Locally, on the user device, all connection-related traffic, such as SYN-ACK, PUSH, ACK, and FIN packets, is recreated by the Citrix Gateway plug-in to appear from the private server.

**Operation Through Firewalls and Proxies**

April 23, 2019

Users of the Citrix Gateway plug-in are sometimes located inside another organization's firewall, as shown in the following figure:

Figure 1. Connection from user device through two internal firewalls

![Diagram of network connections](image-url)
NAT firewalls maintain a table that allows them to route secure packets from Citrix Gateway back to the user device. For circuit-oriented connections, Citrix Gateway maintains a port-mapped, reverse NAT translation table. The reverse NAT translation table enables Citrix Gateway to match connections and send packets back over the tunnel to the user device with the correct port numbers so that the packets return to the correct application.

**Citrix Gateway plug-in Upgrade Control**

April 23, 2019

**Overview**

System Administrators control how the Citrix ADC plug-in performs when its version does not match the Citrix Gateway revision. The new options control the plug-in upgrade behavior for Mac, and Windows or operating systems.

For VPN plug-ins, the upgrade option can be set in two places in the Citrix ADC user interface:

- At the Global Settings
- At the Session Profile level

**plug-in Behaviors**

For each client type, Citrix Gateway allows the following three options to control plug-in upgrade behavior:

- **Always**
  The plug-in always gets upgraded whenever the end user’s plug-in version doesn’t match with the plug-in shipped with Citrix ADC. This is the default behavior. Choose this option if you don’t want multiple plug-in versions running in your enterprise.

- **Essential** (and security)
  The plug-in only upgraded when it is deemed necessary. Upgrades are deemed necessary in following two circumstances:
  - Installed plug-in is incompatible with current Citrix ADC version.
  - Installed plug-in needs to be updated for necessary security fix.

You should choose this option if you want to minimize the number of plug-in upgrades, but don’t want to miss any plug-in security updates.
c. **Never**

The plug-in does not get upgraded.

---

**CLI Parameters for Controlling VPN plug-in Upgrade**

Citrix Gateway supports two types of plug-ins (EPA and VPN) for Windows and Mac operating systems. To support VPN plug-in upgrade control at the session level, Citrix Gateway supports two session profile parameters named WindowsinPluginUpgrade and MacPluginUpgrade.

These parameters are available at global, virtual server, group, and user level. Each parameter can have a value of Always, Essential or Never. For a description of these parameters see plug-in Behaviors.

---

**CLI Parameters for Controlling EPA plug-in Upgrade**

Citrix Gateway supports EPA plug-ins for Windows and Mac operating systems. To support EPA plug-in upgrade control at the Vserver level, Citrix Gateway supports two Vserver parameters named windowsEPAPPluginUpgrade and macEPAPPluginUpgrade.

The parameters are available at the virtual server level. Each parameter can have a value of Always, Essential or Never. For a description of these parameters see plug-in Behaviors.

---

**VPN Configuration**

Follow these steps for the VPN configuration of Windows, Linux and Mac plug-ins.

1. Go to Citrix NetScaler>Policies>Session.
2. Select the desired session policy, and then click **Edit**.
3. Click the + icon.

4. Select the Client Experience tab.

5. These dialog boxes options affect the upgrade behavior.
   - Always
   - Essential
   - Never
   
   The default is Always.

   1. Select the check box to the right of each option. Select the frequency to apply the upgrade behavior.
EPA Configuration

Follow these steps for the EPA configuration of Windows, Linux and Apple plug-ins.

1. Go to Citrix Gateway > Virtual Servers.
2. Select a Server and click the **Edit** button.
3. Click the pencil icon.

4. Click More
5. The dialog boxes that appear affect the upgrade behavior. The options available are:

- Always
- Essential
- Never
Requirements

- Windows EPA and VPN plug-in version should be greater than 11.0.0.0
- Mac EPA plug-in version should be greater than 3.0.0.31
• Mac VPN plug-in version should be greater than 3.1.4 (357)

Note: If Citrix ADC is upgraded to 11.0 release, all previous VPN (and EPA) plug-ins will upgrade to the latest version irrespective of upgrade control configuration. For subsequent upgrades, they will respect the above upgrade control configuration.

Configure full VPN setup on Citrix Gateway

April 8, 2020

This section describes how to configure full VPN setup on a Citrix Gateway appliance. It contains networking considerations and the ideal approach for resolving issues from the networking perspective.

Prerequisites

• SSL certificate: Must be installed and bound to the VPN Virtual Server (virtual server).
  - CTX109260 - How to Generate and Install a Public SSL Certificate on a NetScaler Appliance
  - CTX122521 - How to Replace the Default Certificate of a NetScaler Appliance with a Trusted CA Certificate that Matches the Hostname of the Appliance
  - Citrix Documentation - Binding the Certificate-Key Pair to the SSL-Based Virtual Server
• Authentication profile: Must be created and functional on Citrix Gateway.
  - For additional information, refer to Citrix Documentation - Configuring External User Authentication
  - For additional information, refer to Checklist: Use AD FS to implement and manage single sign-on
• Download Citrix VPN Client
• Session Policy (allowing full VPN connections)

When users connect with the Citrix Gateway plug-in, Secure Hub, or Citrix Workspace app, the client software establishes a secure tunnel over port 443 (or any configured port on Citrix Gateway) and sends authentication information. Once the tunnel has been established, Citrix Gateway sends configuration information to the Citrix Gateway plug-in, Citrix Secure Hub, or Citrix Workspace app describing the networks to be secured. That information also contains an IP address if you enable intranet IPs.

You configure user device connections by defining the resources users can access in the internal network. Configuring user device connections includes the following:
• Split tunneling
• IP addresses for users, including address pools (intranet IPs)
• Connections through a proxy server
• Defining the domains to which users are allowed access
• Time-out settings
• Single sign-on
• User software that connects through Citrix Gateway
• Access for mobile devices

You configure most user device connections by using a profile that is part of a session policy. You can also define user device connection settings by using per-authentication, traffic, and authorization policies. They can also be configured using intranet applications.

**Configure a full VPN Setup on a Citrix Gateway Appliance**

To configure a VPN setup on Citrix Gateway appliance, complete the following procedure:

1. Navigate to Traffic Management > DNS.
2. Select the Name Servers node, as shown in the following screenshot. Ensure that the DNS Name Server is listed. If it is not available, add a DNS Name Server.
4. Select the Session node.
5. In the Citrix Gateway Session Policies and Profiles page, click the Profiles tab click Add. For each component you configure in the Configure Citrix Gateway Session Profile dialog box, ensure that you select the Override Global option for the respective component.
6. Click the Client Experience tab.
7. Type the intranet portal URL in the Home Page field if you would like to present any URL when the user logs into the VPN. If home page parameter is set to “nohomepage.html,” home page is not displayed. When the plug-in starts, a browser instance starts and gets killed automatically.
8. Ensure to select the desired setting from the Split Tunnel list (for more information about this setting, check above).

9. Select **OFF** from the **Clientless Access** list if you want FullVPN.

10. Ensure that **Windows/Mac OS X** is selected from the **plug-in Type** list.

11. Select the **Single Sign-on to Web Applications** option if desired.

12. Ensure that the **Client Cleanup Prompt** option is selected if necessary, as shown in the following screenshot:
13. Click the **Security** tab.

14. Ensure that **ALLOW** is selected from the **Default Authorization Action** list, as shown in the following screenshot:

15. Click the **Published Applications** tab.

16. Ensure that **OFF** is selected from the **ICA Proxy** list under **Published Applications** option.

17. Click **Create**.
18. Click Close.

19. Click the Policies tab of the Citrix Gateway Session Policies and Profiles page in the virtual server or activate the Session Policies at the GROUP/USER Level as required.

20. Create a session policy with a required expression or ns_true, as shown in the following screenshot:

![Session Policy Screenshot]

21. Bind the Session policy to the VPN virtual server.

   Go to Citrix Gateway virtual server > Policy. Choose the required session policy (in this example Session_Policy) from the drop-down list.

22. If Split Tunnel was configured to ON, you must configure the Intranet Applications you would like the users to access when connected to the VPN. Go to Citrix Gateway > Resources > Intranet Applications.

   For details on Intranet Applications, see Configuring Intranet Applications for the Citrix Gateway plug-in.

![Intranet Applications Screenshot]

23. Create an Intranet Application. Select Transparent for FullVPN with Windows client. Select the protocol you would like to allow (TCP, UDP, or ANY), destination type (IP address and mask, IP address range, or host name).
24. Set a new policy for Citrix VPN on iOS and Android using following expression:

\[
\text{REQ.HTTP.HEADER } \text{User-Agent CONTAINS } \text{CitrixVPN } \&\& \ (\text{REQ.HTTP.HEADER User-Agent CONTAINS NSGiOSplugin } \| \ \text{REQ.HTTP.HEADER User-Agent CONTAINS Android})
\]

25. Bind the Intranet Applications created at the USER/GROUP/VSERVER level as required.

**Additional Parameters**

The following are some of the parameters we can configure and a brief description of each:

**Split Tunnel Off**

When split tunnel is set to off, the Citrix Gateway plug-in captures all network traffic originating from a user device and sends the traffic through the VPN tunnel to Citrix Gateway. In other words, the VPN client establishes a default route from the client PC pointing to the Citrix Gateway VIP, meaning that all the traffic needs to be sent through the tunnel to get to the destination. Since all the traffic is going to be sent through the tunnel, authorization policies must determine whether the traffic is allowed to pass through to internal network resources or be denied.

While set to “off,” all traffic is going through the tunnel including Standard Web traffic to websites. If the goal is to monitor and control this web traffic then we should forward these requests to an external
Proxy using NetScaler. User devices can connect through a proxy server for access to internal networks as well.

Citrix Gateway supports the HTTP, SSL, FTP, and SOCKS protocols. To enable proxy support for user connections, you must specify these settings on Citrix Gateway. You can specify the IP address and port used by the proxy server on Citrix Gateway. The proxy server is used as a forward proxy for all further connections to the internal network.

For more information review the following links:

- Enabling Proxy Support for User Connections
- Split Tunnel OFF

**Split Tunnel ON**

You can enable split tunneling to prevent the Citrix Gateway plug-in from sending unnecessary network traffic to Citrix Gateway. If split tunnel is enabled, the Citrix Gateway plug-in sends only traffic destined for networks protected (intranet applications) by Citrix Gateway through the VPN tunnel. The Citrix Gateway plug-in does not send network traffic destined for unprotected networks to Citrix Gateway. When the Citrix Gateway plug-in starts, it obtains the list of intranet applications from Citrix Gateway and establishes a route for each subnet defined on the intranet application tab in the client PC. The Citrix Gateway plug-in examines all packets transmitted from the user device and compares the addresses within the packets to the list of intranet applications (routing table created when the VPN connection was started). If the destination address in the packet is within one of the intranet applications, the Citrix Gateway plug-in sends the packet through the VPN tunnel to Citrix Gateway. If the destination address is not in a defined intranet application, the packet is not encrypted and the user device then routes the packet appropriately using the default routing originally defined on the client PC. “When you enable split tunneling, intranet applications define the network traffic that is intercepted and send through the tunnel”.

For more information review the following link:

- Split Tunnel ON

**Reverse Split Tunnel**

Citrix Gateway also supports reverse split tunneling, which defines the network traffic that Citrix Gateway does not intercept. If you set split tunneling to reverse, intranet applications define the network traffic that Citrix Gateway does not intercept. When you enable reverse split tunneling, all network traffic directed to internal IP addresses bypasses the VPN tunnel, while other traffic goes through Citrix Gateway. Reverse split tunneling can be used to log all non-local LAN traffic. For example, if users have a home wireless network and are logged on with the Citrix Gateway plug-in, Citrix Gateway does not intercept network traffic destined to a printer or another device within the wireless network.
To configure split tunneling

1. Navigate to **Configuration > Citrix Gateway > Policies > Session**.

2. In the details pane, on the Profiles tab, select a profile and then click **Edit**.

3. On the **Client Experience** tab, next to **Split Tunnel**, select **Global Override**, select an option and then click **OK**.

Configuring Split Tunneling and Authorization

When planning your Citrix Gateway deployment, it is important to consider split tunneling and the default authorization action and authorization policies.

For example, you have an authorization policy that allows access to a network resource. You have split tunneling set to ON and you do not configure intranet applications to send network traffic through Citrix Gateway. When Citrix Gateway has this type of configuration, access to the resource is allowed, but users cannot access the resource.

If the authorization policy denies access to a network resource, you have split tunneling set to ON, and intranet applications are configured to route network traffic through Citrix Gateway, the Citrix Gateway plug-in sends traffic to Citrix Gateway, but access to the resource is denied.

For more information about authorization policies, review the following:

- Configuring Authorization
- Configuring Authorization Policies
- Setting Default Global Authorization

To configure network access to internal network resources

1. Navigate to **Configuration > Citrix Gateway > Resources > Intranet Applications**.

2. In the details pane, click **Add**.

3. Complete the parameters for allowing network access, click **Create**, and then click **Close**.

When we do not set up intranet IPs for the VPN users, the user sends the traffic to the Citrix Gateway VIP and then from there the NetScaler builds a new packet to the intranet application resource on the
internal LAN. This new packet is going to be sourced from the SNIP toward the intranet application. From here, the intranet application gets the packet, processes it and then attempts to reply to the source of that packet (the SNIP in this case). The SNIP gets the packet and sends the reply to the client who made the request.

For more information review the following link:

No Intranet IPs

When Intranet IP address is used, the user sends the traffic to the Citrix Gateway VIP and then from there the NetScaler is going to map the client IP into one of the configured INTRANET IPs from the Pool. Be advised that the NetScaler is going to own the Intranet IP pool and for this reason these ranges must not be used in the internal network. The Citrix ADC assigns an Intranet IP for the incoming VPN connections like a DHCP server would do. The NetScaler builds a new packet to the intranet application on the LAN the user would access. This new packet is going to be sourced from one of the Intranet IPs toward the intranet application. From here, intranet applications get the packet, process it and then attempt to reply to the source of that packet (the INTRANET IP). In this case the reply packet needs to be routed back to the NetScaler, where the INTRANET IPs are located (Remember, the NetScaler owns the Intranet IPs subnets). To accomplish this task, the network administrator must have a route to the INTRANET IP, pointing to one of the SNIPs (it would be recommended to point the traffic back to the SNIP that holds the route from which the packet leaves the NetScaler the first time to avoid any asymmetric traffic).

For more information, review the following link:

Intranet IPs

Configuring Name Service Resolution

During installation of Citrix Gateway, you can use the Citrix Gateway wizard to configure additional settings, including name service providers. The name service providers translate the fully qualified domain name (FQDN) to an IP address. In the Citrix Gateway wizard, you can configure a DNS or WINS server, set the priority of the DNS lookup, and the number of times to retry the connection to the server.

When you run the Citrix Gateway wizard, you can add a DNS server then. You can add additional DNS servers and a WINS server to Citrix Gateway by using a session profile. You can then direct users and groups to connect to a name resolution server that is different from the one you originally used the wizard to configure.

Before configuring an additional DNS server on Citrix Gateway, create a virtual server that acts as a DNS server for name resolution.

To add a DNS or WINS server within a session profile

1. In the configuration utility, configuration tab > Citrix Gateway > Policies > Session.
2. In the details pane, on the Profiles tab, select a profile and then click Open.
3. On the Network Configuration tab, do one of the following:

- To configure a DNS server, next to DNS Virtual Server, click Override Global, select the server, and then click OK.

- To configure a WINS server, next to WINS Server IP, click Override Global, type the IP address and then click OK.

Choosing the User Access Method

September 10, 2019

You can configure Citrix Gateway to provide user connections through the following scenarios:

- User connections by using Citrix Workspace app. Citrix Workspace app works with StoreFront or the Web Interface to provide users with access to published applications or virtual desktops in a server farm. Citrix Workspace app is software that uses the ICA network protocol to establish user connections. Users install Citrix Workspace app on the user device. When users install Citrix Workspace app on their Windows-based or Mac-based computer, Citrix Workspace app subsumes all plug-ins, including the Citrix Gateway plug-in for user connections. Citrix Gateway also supports connections from Citrix Workspace app for Android and Citrix Workspace app for iOS. Users can connect to their virtual desktops and Windows-based, web, mobile, and SaaS applications through Citrix Endpoint Management, StoreFront, or the Web Interface.

- User connections with Secure Hub. Users can connect to mobile, web, and SaaS applications configured in Endpoint Management. Users install Secure Hub on their mobile device (Android or iOS). When users log on to Secure Hub, they can install WorxMail and WorxWeb, along with any other mobile app you installed in Endpoint Management. Secure Hub, Secure Mail, and WorxWeb use Micro VPN technology to establish connections through Citrix Gateway.

- User connections by using the Citrix Gateway plug-in as a standalone application. The Citrix Gateway plug-in is software that users can download and install on a user device. When users log on with the plug-in, users can access resources in the secure network as if they were in the office. Resources include email servers, file shares, and intranet Web sites.

- User connections by using clientless access. Clientless access provides users with the access they need without requiring installation of software, such as the Citrix Gateway plug-in or Citrix Workspace app, on the user device. Clientless access allows connections to a limited set of web resources, such as Outlook Web Access or SharePoint, applications published on Citrix Virtual Apps, virtual desktops from Citrix Virtual Apps and Desktops, and file shares in the secure network through the Access Interface. Users connect by entering the Citrix Gateway web address in a web browser and then select clientless access from the choices page.
• User connections if a preauthentication or post-authentication scan fails. This scenario is called access scenario fallback. Access scenario fallback allows a user device to fall back from the Citrix Gateway plug-in to StoreFront or the Web Interface, by using Citrix Workspace app, if the user device does not pass the initial endpoint analysis scan.

If users log on to Citrix Gateway through Citrix Workspace app, the preauthentication scan does not work. Post-authentication scans do work when Citrix Gateway establishes the VPN tunnel.

Users can download and install the Citrix Gateway plug-in by using the following methods:

• Connecting to Citrix Gateway by using a web browser.
• Connecting to StoreFront that is configured to accept Citrix Gateway connections.
• Installing the plug-in by using a Group Policy Object (GPO).
• Uploading the Citrix ADC plug-in to Merchandising Server.

Deploying Citrix Gateway plug-ins for User Access

September 10, 2019

Citrix Gateway comes with the following plug-ins for user access:

• Citrix Gateway plug-in for Windows
• Citrix Gateway plug-in for Mac
• Citrix Gateway plug-in for Java

When users log on to Citrix Gateway for the first time, they download and install the Citrix Gateway plug-in from a web page. Users log on by clicking the Citrix Gateway icon in the notification area on a Windows-based computer. On a Mac OS X computer, users can log on from the Dock or the Applications menu. If you upgrade Citrix Gateway to a new software version, the Citrix Gateway plug-in updates automatically on the user device.

The Citrix Gateway plug-in for Java can be used on any user device that supports Java. The Citrix Gateway plug-in for Java supports most TCP-based applications, but provides only some of the features of the Citrix Gateway plug-in for Windows or Citrix Gateway plug-in for Mac OS X. The Citrix Gateway plug-in for Java provides limited access to the network resources you define. For more information about the Java plug-in, see Connecting with the Citrix Gateway plug-in for Java.

Deploying the Citrix Gateway plug-in with Citrix Workspace app Updater

You can also deploy the Citrix Gateway plug-in with Citrix Workspace app Updater. When users install Citrix Workspace app Updater, it automatically adds all user plug-ins installed on the user device to Citrix Workspace app. Users log on to the Citrix Gateway plug-in with Citrix Workspace app by opening...
Citrix Workspace app and then right-clicking the Citrix Gateway plug-in and then clicking Logon. If you upgrade the Citrix Gateway appliance to a new version, the Citrix Gateway plug-in within Citrix Workspace app upgrades automatically to the new version.

**Deploying the Citrix Gateway plug-in by Using the MSI Installer Package**

You can deploy the Citrix Gateway plug-in by using a Microsoft Active Directory infrastructure or a standard third-party MSI deployment tool, such as Windows Server Update Services. If you use a tool that supports Windows Installer packages, you can deploy the packages with any tool that supports MSI files. Then, you use your deployment tool to deploy and install the software on the appropriate user devices.

Advantages of using a centralized deployment tool include:

- Ability to adhere to security requirements. For example, you can install user software without enabling software installation privileges for non-administrative users.
- Control over software versions. You can deploy an updated version of the software to all users simultaneously.
- Scalability. A centralized deployment strategy easily scales to support additional users.
- Positive user experience. You can deploy, test, and troubleshoot installation-related issues without involving users in this process.

Citrix recommends this option when administrative control over the installation of user software is preferred and access to user devices is readily available.

For more information, see Deploying the Citrix Gateway plug-in from Active Directory.

**Determining Which Software plug-in to Deploy**

If your Citrix Gateway deployment does not require any software plug-in on user devices, your deployment is considered to provide clientless access. In this scenario, users need only a Web browser to access network resources. However, certain features require the plug-in software on the user’s device.

**Selecting the Citrix Gateway plug-in for Users**

April 23, 2019

When you configure Citrix Gateway, you can choose how users log on. Users can log on with one of the following plug-ins:
You complete the configuration by creating a session policy and then binding the policy to users, groups, or virtual servers. You can also enable plug-ins by configuring global settings. Within the global or session profile, you select either Windows/Mac OS X or Java as the plug-in type. When users log on, they receive the plug-in as defined globally or in the session profile and policy. You must create separate profiles for the plug-in type. You can only choose either Windows/Mac OS X or Java in the session profile. To configure the Citrix Gateway plug-in for Java, see Connecting with the Citrix Gateway plug-in for Java.

To configure the plug-in globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to plug-in Type, select Windows/Mac OS X and then click OK.

To configure the plug-in type for Windows or Mac OS X in a session profile

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. Do one of the following:
   • If you are creating a new session policy, in the details pane, click Add.
   • If you are changing an existing policy, select a policy and then click Open.
3. Create a new profile or modify an existing profile. To do so, do one of the following:
   • Next to Request Profile, click New.
   • Next to Request Profile, click Modify.
4. On the Client Experience tab, next to plug-in Type, click Override Global and then select Windows/Mac OS X.
5. Do one of the following:
   • If you are creating a new profile, click Create, set the expression in the policy dialog box, click Create and then click Close.
   • If you are modifying an existing profile, after making the selection, click OK twice.

To set the interception mode for the Citrix Gateway plug-in for Windows

If you are configuring the Citrix Gateway plug-in for Windows, you also need to configure the interception mode and set it to transparent.
1. In the configuration utility, click the Configuration tab, expand Citrix Gateway > Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Click Transparent.
5. In Protocol, select ANY.
6. In Destination Type, select IP Address and Netmask.
7. In IP address type the IP address.
8. In Netmask, type the subnet mask, click Create and then click Close.

**Installing the Citrix Gateway plug-in for Windows**

April 23, 2019

When users log on to Citrix Gateway, they download and install the Citrix Gateway plug-in on the user device.

To install the plug-in, users must be a local administrator or a member of the Administrators group. This restriction applies for first-time installation only. plug-in upgrades do not require administrator level access.

To enable users to connect to and use Citrix Gateway, you need to provide them with the following information:

- Citrix Gateway web address, such as https://NetScalerGatewayFQDN/
- Any system requirements for running the Citrix Gateway plug-in if you configured endpoint resources and policies

Depending on the configuration of the user device, you might also need to provide the following information:

- If users run a firewall on their computer, they might need to change the firewall settings so that the firewall does not block traffic to or from the IP addresses corresponding to the resources for which you granted access. The Citrix Gateway plug-in automatically handles Internet Connection Firewall in Windows XP and Windows Firewall in Windows XP Service Pack 2, Windows Vista, Windows 7, Windows 8, or Windows 8.1.
- Users who want to send traffic to FTP over an Citrix Gateway connection must set their FTP application to perform passive transfers. A passive transfer means that the remote computer establishes the data connection to your FTP server, rather than the establishment of the data connection by the FTP server to the remote computer.
- Users who want to run X client applications across the connection must run an X server, such as XManager, on their computers.
• Users who install Receiver for Windows or Receiver for Mac can start the Citrix Gateway plug-in from Receiver or by using a web browser. Provide instructions to users about how to log on with the Citrix Gateway plug-in through Receiver or a web browser.

Because users work with files and applications as if they were local to the organization’s network, you do not need to retrain users or configure applications.

To establish a secure connection for the first time, log on to Citrix Gateway by using the web logon page. The typical format of a web address is https://companyname.com. When users log on, they can download and install the Citrix Gateway plug-in on their computer.

**To install the Citrix Gateway plug-in for Windows**

1. In a web browser, type the web address of Citrix Gateway.
2. Type the user name and password and then click Logon.
3. Select Network Access and then click Download.
4. Follow the instructions to install the plug-in.

When the download is complete, the Citrix Gateway plug-in connects and displays a message in the notification area on a Windows-based computer.

If you want users to connect with the Citrix Gateway plug-in without using a web browser, you can configure the plug-in to display the logon dialog box when users right-click the Citrix Gateway icon in the notification area on a Windows-based computer or start the plug-in from the Start menu.

**To configure the logon dialog box for the Citrix Gateway plug-in for Windows**

To configure the Citrix Gateway plug-in to use the logon dialog box, users must be logged on to complete this procedure.

1. On a Windows-based computer, in the notification area, right-click the Citrix Gateway icon and then click Configure Citrix Gateway.
2. Click the Profile tab and then click Change Profile.
3. On the Options tab, click Use the Citrix Gateway plug-in for logon.
   - Note: If users open the Configure Citrix Gateway dialog box from within Receiver, the Options tab is not available.

**Deploying the Citrix Gateway plug-in from Active Directory**

April 23, 2019
If users do not have administrative privileges to install the Citrix Gateway plug-in on the user device, you can deploy the plug-in for users from Active Directory.

When you use this method to deploy the Citrix Gateway plug-in, you can extract the installation program and then use a group policy to deploy the program. The general steps for this type of deployment are:

- Extracting the MSI package.
- Distributing the plug-in by using a group policy.
- Creating a distribution point.
- Assigning the Citrix Gateway plug-in package by using a Group Policy Object.

Note: Distribution of the Citrix Gateway plug-in from Active Directory is only supported on Windows XP, Windows Vista, Windows 7, and Windows 8.

You can download the MSI package from the configuration utility or from the Citrix web site.

To download the Citrix Gateway plug-in MSI package from the configuration utility

1. In the configuration utility, click Downloads.
2. Under Citrix Gateway Plugin, click Download Citrix Gateway Plugin for Windows and then save the file nsvpnc_setup.exe to your Windows server.

   Note: If the File Download dialog box does not appear, press the CTRL key when you click the link Download Citrix Gateway Plugin for Windows.

3. At a command prompt, navigate to the folder where you saved nsvpnc_setup.exe to and then type:
   
   nsvpnc_setup /c
   
   This extracts the file agee.msi.

4. Save the extracted file to a folder on the Windows server.

After you extract the file, you use a group policy on Windows Server to distribute the file.

Before starting the distribution, install the Group Policy Management Console on Windows Server 2003, Windows Server 2008 or Windows Server 2012. For more information, see the Windows online help.

Note: When you use a group policy to publish the Citrix Gateway plug-in, Citrix recommends assigning the package to the user device. The MSI package is designed to be installed on a per-device basis.

Before you can distribute the software, create a distribution point on a network share on a publishing server, such as Microsoft Internet Security and Acceleration (ISA) Server.
To create a distribution point

1. Log on to the publishing server as an administrator.
2. Create a folder and share it on the network with read permission for all accounts that need access to the distribution package.
3. At a command prompt, navigate to the folder where you save the extracted file and then type: msiexec -a agee.msi
4. On the Network Location screen, click Change and then navigate to the shared folder where you want to create the administrative installation of the Citrix Gateway plug-in.
5. Click OK and then click Install.

After you have put the extracted package on the network share, assign the package to a Group Policy Object in Windows.

After you configure the Citrix Gateway plug-in successfully as a managed software package, the plug-in is installed automatically the next time the user device starts.

Note: When the installation package is assigned to a computer, the user must restart the computer.

When the installation starts, users receive a message that the Citrix Gateway plug-in is installing.

Upgrading and Removing the Citrix Gateway plug-in by Using Active Directory

April 23, 2019

Each release of the Citrix Gateway plug-in is packaged as a full product installation, instead of as a patch. When users log on and the Citrix Gateway plug-in detects a new version of the plug-in, the plug-in upgrades automatically. You can also deploy the Citrix Gateway plug-in to upgrade by using Active Directory.

To do so, create a new distribution point for the Citrix Gateway plug-in. Create a new Group Policy Object and assign the new version of the plug-in to it. Then, create a link between the new package and the existing package. After you create the link, the Citrix Gateway plug-in is updated.

Removing the Citrix Gateway plug-in from User Devices

To remove the Citrix Gateway plug-in from user devices, remove the assigned package from the Group Policy Object Editor.
When the plug-in is removed from the user device, users receive a message that the plug-in is uninstalling.

Troubleshooting the Citrix Gateway plug-in Installation Using Active Directory

April 23, 2019

If the assigned package fails to install when the user device starts, you might see the following warning in the application event log:

Failed to apply changes to software installation settings. Software installation policy application has been delayed until the next logon because an administrator has enabled logon optimization for group policy. The error was: The group policy framework should call the extension in the synchronous foreground policy refresh.

This error is caused by Fast Logon Optimization in Windows XP in which users are allowed to log on before the operating system initialized all of the networking components, including Group Policy Object processing. Some policies might require more than one restart to take effect. To resolve this issue, disable Fast Logon Optimization in Active Directory.

To troubleshoot other installation issues for managed software, Citrix recommends using a group policy to enable Windows Installer Logging.

Connecting with the Citrix Gateway plug-in for Java

April 23, 2019

The Citrix Gateway plug-in for Java can be used on any user device that supports Java.

Note: Java Runtime Environment (JRE) Version 1.4.2 up to the most recent version of JRE is required for the following operating systems and web browsers.

- Mac OS X
- Linux
- Windows XP (all versions), Windows Vista, Windows 7, and Windows 8
- Internet Explorer
- Firefox
- Safari 1.2 up to the most recent version of the web browser

© 1999-2020 Citrix Systems, Inc. All rights reserved.
The Citrix Gateway plug-in for Java supports most TCP-based applications, but provides only some of the features of the Citrix Gateway plug-in for Windows or Citrix Gateway plug-in for Mac OS X.

Users do not require administrative privileges on the user device to use the Citrix Gateway plug-in for Java. For security reasons, you might want to require using this plug-in version for a particular virtual server, group, or user, regardless of which user device is used.

To configure Citrix Gateway to install the Citrix Gateway plug-in for Java on user devices, configure a session policy and then bind it to the virtual server, group, or user.

If users log on from a computer running Windows 7, the proxy server information is not set automatically in Internet Explorer. Users must manually configure the proxy server on the computer running Windows 7.

**To configure the Citrix Gateway plug-in for Java**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click the Profiles tab.
3. Select a session profile and then click Open.
4. On the Client Experience tab, next to plug-in Type, click Override Global, select Java and then click OK.

**To set the interception mode**

After creating the session policy, create an intranet application to define the interception mode for users who log on with the Citrix Gateway plug-in for Java.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name.
4. Click Proxy.
5. In Destination IP Address, type the IP address.
6. In Destination Port, type the port number.
7. In Source IP Address, type the IP address.
8. In Source Port, type the port number, click Create and then click Close.

If you do not specify a source IP address and port number, Citrix Gateway automatically uses 127.0.0.1 for the IP address and 0 for the port.
**Updating the HOSTS File on Windows-Based Computers**

When users log on using the Citrix Gateway plug-in for Java on a computer running Windows Vista, Windows 7, or Windows 8, network traffic for TCP intranet applications is not tunneled. The HOSTS file is not updated automatically on computers running Vista and Windows 7. You must add the intranet applications manually to the HOSTS file.

On a Windows-based computer, you can edit the HOSTS file in Notepad or another text editor. If you edit the HOSTS file in Notepad, you must run Notepad as an administrator. Add the mapping entries for the intranet application for the Citrix Gateway plug-in for Java and then save the file.

**Integrating the Citrix Gateway plug-in with Citrix Workspace app**

September 10, 2019

Citrix Gateway supports Citrix Workspace app. The orchestrated system consists of the following components:

- Citrix Workspace app for Windows 3.4 or newer
- Citrix Workspace app for Mac
- Citrix Workspace app for Android
- Citrix Workspace app for iOS
- StoreFront 2.1 or newer
- AppController 2.8 and newer or Citrix Endpoint Management 10
- Citrix Update Service that is hosted on the Citrix Web site

For more information about Citrix Gateway compatibility with Citrix products, see [Compatibility with Citrix Products](#).

You can configure Citrix Gateway so that when users log on to the appliance, the Citrix Gateway plug-in opens a web browser that allows single sign-on to the Citrix Workspace app home page. Users can download Citrix Workspace app from the home page.

When users log on with Citrix Workspace app, user connections can route through Citrix Gateway in the following manner:

- Directly to Endpoint Management
- Directly to StoreFront
- To StoreFront and then Endpoint Management if you do not configure MDX mobile apps in Endpoint Management
- To Endpoint Management and then StoreFront if you do configure MDX mobile apps in Endpoint Management

© 1999-2020 Citrix Systems, Inc. All rights reserved.
Note: Connections that are routed directly to Endpoint Management are supported in AppController 2.0, AppController 2.5, AppController 2.6, App Controller 2.8, and App Controller 2.9 only. If you have AppController 1.1 deployed in your network, user connections must route through StoreFront.

How User Connections Work with Citrix Workspace app

September 10, 2019

Users can connect to the following applications, desktops, and data from Citrix Workspace app:

• Windows-based applications and virtual desktops published in StoreFront and the Web Interface
• ShareFile data accessed through Citrix Endpoint Management

Users can log on by using any of the following Citrix Workspace apps:

• Citrix Workspace app for Web
• Citrix Workspace app for Windows
• Citrix Workspace app for Mac
• Citrix Workspace app for iOS
• Citrix Workspace app for Android

Users can log on with Citrix Workspace app for Web by using a web browser or from the Citrix Workspace app icon on the user device.

When users log on with any version of Citrix Workspace app, applications, ShareFile data, and desktops appear in the browser or Citrix Workspace app window.

Adding the Citrix Gateway plug-in to Citrix Workspace app

September 10, 2019

When Citrix Workspace app is installed on the user device, users can log on with the Citrix Gateway plug-in through Citrix Workspace app. You upload the Citrix Gateway plug-in to Merchandising Server, which then downloads and installs the plug-in to Citrix Workspace app on the user device. If users have the Citrix Gateway plug-in installed when they install Citrix Workspace app for the first time, the plug-in is automatically added to Citrix Workspace app.
Delivering plug-ins to User Devices

To deliver plug-ins to user devices, you must upload and configure the Citrix Gateway plug-in on the Merchandising Server. When users make a selection, the plug-in downloads and installs from the Merchandising Server.

If users install the Citrix Gateway plug-in and then later install Citrix Workspace app, when the Citrix Workspace app installation is complete, the Citrix Gateway plug-in appears in the Citrix Workspace app menu.

If users have Citrix Workspace app for Windows, users can install Citrix Workspace app Updater for Windows. This is an optional component that updates the plug-ins and communicates with Merchandising Server. Citrix Workspace app includes all of the plug-ins available for delivery, including the Citrix Gateway plug-in. For more information about Citrix Workspace app Updater for Windows, see the Citrix Workspace apps and plug-ins section in the Citrix eDocs library.

Connecting to Citrix Gateway with Citrix Workspace app

If users connect with Citrix Workspace app for Windows, they can right-click the Citrix Workspace app icon in the notification area, click Preferences and then click plug-in status. If the Citrix Gateway plug-in is installed on the user device, users right-click the Citrix Gateway plug-in and then click Logon. When authentication succeeds, the Citrix Gateway plug-in establishes the connection to Citrix Gateway and establishes a full VPN tunnel.

Users can also log on with a web browser. Users enter the fully qualified domain name (FQDN) of Citrix Gateway and log on. When Citrix Gateway establishes the connection, users can verify the connection on the Preferences > plug-in status panel in Citrix Workspace app.

The Citrix Gateway web address is part of the metadata configured on Merchandising Server and users cannot change the address. The Citrix Gateway plug-in initiates the logon to Citrix Gateway. If the version of Citrix Gateway plug-in for Windows that is installed on the user device is different than the version on the Citrix Gateway appliance, the plug-in downgrades or upgrades automatically when users log on. The Citrix Gateway plug-in for Mac OS X does not downgrade automatically. To install an earlier version of the plug-in on a Mac computer, users must first uninstall the Citrix Gateway plug-in and then download the earlier version from Citrix Gateway.

Upgrading or Downgrading the Citrix Gateway plug-in

During an upgrade or downgrade of the Citrix Gateway plug-in, the appliance removes, downloads, and then installs the correct version of the plug-in. Users can confirm the new installation by checking the plug-in entry on the Preferences > plug-in status panel in Citrix Workspace app. The newly
installed version of the Citrix Gateway plug-in might be a different version than what is configured on Merchandising Server.

**Adding the Citrix Gateway plug-in to Merchandising Server**

You can also configure Citrix Gateway plug-in delivery on Merchandising Server, which provides a web configuration interface that allows you to upload the Citrix Gateway plug-in MSI installation package. On Merchandising Server, you can:

- Specify the version and metadata for the Citrix Gateway plug-in.
- Configure one or more Web addresses for the Citrix Gateway appliance.
- Associate specific rules based on operating system or other parameters for delivery.

Users cannot add or remove servers from the list of servers configured on Merchandising Server, although they can select a different server from the configured list in the Network Settings panel in Citrix Workspace app.

If you are using Access Scenario Fallback or load balancing, you can configure a fixed set of Citrix Gateway web addresses and designate Merchandising Server as the default address. Users connect to the default server when they select Log On from the Citrix Workspace app menu. Users can select a different address from the provided list by using the Citrix Workspace app’s Preferences > Network Settings panel in Citrix Workspace app.

Users can continue to use a web browser to log on to any Citrix Gateway. If users log on by using a web browser, the Citrix Gateway plug-in upgrades or downgrades automatically to the version that is on Citrix Gateway.

The following are general steps for adding the Citrix Gateway plug-in to Merchandising Server. For specific configuration steps, see Merchandising Server in the Technologies section in the Citrix eDocs library.

- Configure the settings on the General tab in the Merchandising Server Administrator Console.
- Add the Citrix Gateway plug-in to Merchandising Server.
- Select the appropriate plug-in version for the target platform. The Citrix Gateway plug-in must be added to the main page of Merchandising Server for the plug-in to appear in the Add plug-ins to Delivery page.
- Configure delivery for the Citrix Gateway plug-in.
- Use a friendly name for the location that identifies the Citrix Gateway Web address. This name appears in Citrix Workspace app. You can also add additional Citrix Gateway appliances.
- Specify authentication type and customize specific labels that appear in the Citrix Workspace app logon dialog box, such as the user name, password, or personal identification number (PIN).
Citrix Gateway 13.0

- Add rules for the delivery.
- You must create rules if you want rules to appear in the Add Rule to Delivery page.
- Schedule the delivery.

Decoupling the Citrix Workspace app Icon

September 10, 2019

When a Citrix Virtual Apps and Desktops deployment is configured with the Citrix Gateway plug-in integrated with Citrix Workspace app, the plug-in’s icon is not visible to a user who is connected to the VPN. The Citrix Gateway plug-in icon normally resides in the Windows system tray or the Mac OS X Finder’s menu bar. This icon is the interface into the plug-in’s settings and controls. For Windows users, when Citrix Workspace app and the Citrix Gateway plug-in are integrated, the About dialog in Citrix Workspace app displays the controls for the Citrix Gateway plug-in. For Mac OS X users, there are no controls for the Citrix Gateway plug-in available after integration.

Some integrated deployments might present a need to expose the plug-in controls while retaining the integration of the underlying functionality. To do so, use the following CLI command or Citrix ADC configuration utility task to toggle the icon integration for VPN clients.

**Setting icon integration using the command line**

Use the following command:

```
set vpn parameter [-iconWithReceiver (ON/OFF)]
```

**Setting icon integration using the configuration utility**

Using the Citrix ADC configuration utility:

1. On the Configuration tab, navigate to Citrix Gateway > Global Settings.
2. Click Change Global Settings, and then select the Client Experience tab.
3. Click Advanced Settings
4. Select Show VPN plug-in icon with Citrix Workspace app.
Configuring IPv6 for ICA Connections

April 23, 2019

Citrix Gateway supports IPv6 addresses for ICA connections. Connections with IPv6 to the Web Interface or StoreFront work the same as IPv4 connections. When users connect by using the Citrix Gateway web address, Citrix Gateway proxies the connection to the Web Interface or StoreFront.

You can configure IPv6 for Citrix Gateway deployed in one DMZ or deployed in a double-hop DMZ.

You enable IPv6 on Citrix Gateway by using the command line. You can use the following guidelines:

- Enable IPv6 on the appliance.
- Configure subnet IP addresses.
- Set the DNS resolution order.
- Set the Web Interface or StoreFront web address.
- Bind the Secure Ticket Authority (STA) to Citrix Gateway.

By default, the mapped IP address does not support IPv6 addresses. To route user communications to the internal network, you need to create subnet IP addresses and then configure Citrix Gateway to use the subnet IP addresses.

If you deploy multiple IPv6 subnets in your network, create multiple IPv6 subnet IP address on Citrix Gateway, one for each subnet in your network. Network routing sends the IPv6 packets to the respective subnets by using the subnet IP addresses.

To configure IPv6 for ICA proxy

To configure IPv6 for ICA proxy:

1. Log on to Citrix Gateway by using a Secure Shell (SSH) connection, such as from PuTTY.
2. At the command prompt, type enable ns feature IPv6PT. This enables IPv6.
3. At the command prompt, type enable ns mode USNIP. This enables the use of the subnet IP addresses.
4. At the command prompt, type: set dns parameter -resolutionOrder AAAAThenAQuery AThenAAAAQuery OnlyAAAAQuery OnlyAQuery
5. At the command prompt, type: set vpn parameter -wihome http://XD_domain/Citrix/ StoreWeb.
Where is either the domain name or IP address of StoreFront.

For example, set vpn parameter -wihome http://storefront.domain.com/Citrix/StoreWeb.

or

set vpn parameter -wihome http://[1000:2000::3000]/Citrix/StoreWeb

If you use the IPv6 address to configure this parameter, the IP address must be contained in brackets.

### Configuring the Citrix Workspace app Home Page on Citrix Gateway

September 10, 2019

You can configure the Citrix Workspace app home page either globally or as part of a session profile. If you want to configure Citrix Workspace app for Web and earlier Citrix Workspace app versions that do not recognize StoreFront through Citrix Gateway, you need to create two separate session profiles. The field Citrix Workspace app Home Page needs to have the correct web address for each profile so users can log on successfully.

For Citrix Workspace apps that recognize StoreFront through Citrix Gateway, you can have Citrix Workspace app for Web and Citrix Workspace app share a profile. However, Citrix recommends that you configure a session profile for Citrix Workspace app for Web and a separate session profile for all other Citrix Workspace apps.

#### To configure the Citrix Workspace app home page globally

To configure the Citrix Workspace app home page globally:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. In the Global Citrix Gateway Settings dialog box, click the Published Applications tab.
4. In Citrix Workspace app Home Page, type the web address for Citrix Workspace app or the Citrix Workspace app for Web home page and then click OK.

#### To configure the Citrix Workspace app home page in a session profile

To configure the Citrix Workspace app home page in a session profile:
1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.

2. In the details pane, on the Profiles tab, click Add.

3. In the Create Citrix Gateway Session Profile dialog box, on the Published Application tab, next to Citrix Receiver Home Page, click Override Global.

4. In Citrix Workspace app home page, type the web address for the Citrix Workspace app or Citrix Workspace app for Web home page and then click Create.

Applying the Receiver Theme to the Logon Page

April 23, 2019

You can use the configuration utility to apply the Receiver theme to the logon page for Citrix Gateway. You can switch between the Receiver theme, the default theme, or a custom theme that you create. The feature is available on the following Citrix Gateway versions:

- Citrix Gateway 10.1 or newer.
- Access Gateway 10, Build 71.6014.e
- Access Gateway 10, Build 73.5002.e

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.

3. In the Global Citrix Gateway Settings dialog box, click the Client Experience tab.

4. Next to UI Theme, click Green Bubble and then click OK.

This command overwrites the original logon page with the Receiver theme. Note: After you apply a different theme, advise users to clear the browser cache to prevent cached pages from appearing.

Creating a Custom Theme for the Logon Page

September 10, 2019

You can use the configuration utility to create a custom theme for the logon page for Citrix Gateway. You can also leave the default theme or use the Citrix Workspace app theme. When you choose to
apply a custom theme to the logon page, you use the Citrix Gateway command line to create and deploy the theme. You then use the configuration utility to set the custom theme page.

You configure the custom theme page by using Citrix Gateway global settings.

You can use this feature with the following versions of Citrix Gateway:

- Citrix Gateway 10.1
- Access Gateway 10, Build 73.5002.e (you must install this build after Build 71.6104.e to use this feature with AppController Versions 2.5, 2.6, or 2.8)
- Access Gateway 10, Build 71.6104.e

Create and deploy the custom theme by using the command line

To create and deploy the custom theme by using the command line:

1. Log on to the Citrix Gateway command line.
2. At a command prompt, type shell.
3. At a command prompt, type mkdir /var/ns_gui_custom; cd /netscaler; tar -cvzf /var/ns_gui_custom/customtheme.tar.gz ns_gui/*.
4. Use the configuration utility to switch to the custom theme and then make customization changes under /var/ns_gui_custom/ns_gui/vpn. You can:
   - Make edits to the css/ctx.authentication.css file.
   - Copy a custom logo to the /var/ns_gui_custom/ns_gui/vpn/media folder. Note: You can use WinSCP to transfer the files.
5. If you have multiple Citrix Gateway appliances, repeat Steps 3 and 4 for all appliances.

Customizing the User Portal

February 13, 2020

Citrix Gateway installations that serve the portal to VPN users include an option to select a portal theme to create a customized look and feel for the portal pages. You can select from a supplied set of themes, or you can use a theme as a template to build a customized or branded portal. Using the configuration utility, you can modify a theme by adding new logos, background images, custom input box labels, and various other attributes of the CSS based portal design. The built-in portal themes include content for five languages: English, French, Spanish, German, and Japanese. Different users are served in different languages, depending on the locales reported by their web browsers.
You have the option to create a custom end-user license agreement (EULA) that is presented to VPN users before they are allowed to sign in. The EULA feature supports locale-specific versions of a EULA, which are presented to users based on their web browsers reported locales.

Both portal themes and EULA configurations can be bound independently at the VPN virtual server and VPN global levels.

**Important:** Citrix does not support customization that requires code modifications and does not offer support to resolve issues beyond reverting to a default theme.

### Applying a Portal Theme

By default, the VPN portal is configured to use the Caxton theme. The Caxton theme is named Default.

#### Caxton Theme

![Caxton Theme](image)

Citrix Gateway includes two additional themes that can be applied to the portal: The Greenbubble and X1 themes.
Greenbubble Theme

You can apply any of the supplied themes directly to a VPN virtual server or as a global VPN binding.

X1 Theme

You can bind a portal theme on an existing virtual server or when creating a new virtual server.
Using the command line to bind a portal theme to an existing VPN virtual server

At the command prompt, type:

```
bind vpn vserver <name> - portaltheme <name>
```

Using the configuration utility to bind a portal theme to an existing VPN virtual server

1. On the Configuration tab, Navigate to Citrix Gateway and click Virtual Servers.
2. Select a virtual server, and then click Edit.
3. If a portal theme has not yet been bound to the virtual server, click Portal Theme under Advanced Settings in the details pane. Otherwise, the Portal Theme option is already expanded in the details pane.
4. In the details pane, under Portal Themes, click No Portal Theme to expand the Portal Theme binding window.
5. Click Click to select.
6. In the Portal Themes window, click a theme name, and then click Select.
7. Click Bind.
8. Click Done.

If you are creating a VPN Virtual Server, you can follow the steps above starting with step 3 while in the VPN Virtual Server edit pane to bind a Portal Theme.

Binding a Portal Theme to VPN Global

Using the command line to bind a portal theme to the VPN global scope

At the command prompt, type:

```
bind vpn global portaltheme <name>
```

Using the configuration utility to bind a portal theme to the VPN global scope

1. On the Configuration tab, Navigate to Citrix Gateway.
2. In the main details pane, click Citrix Gateway Policy Manager.
3. Click the ‘+’ icon.
4. In the Bind Point list, select Resources.
5. In the Connection Type list, select Portal Theme.
6. Click Continue.
7. In the Bind Point screen, click Add Binding.
8. Click **Click to select**.
9. In the **Portal Themes** window, click a theme name, and then click **Select**.
10. Click **Bind**.
11. Click **Close**.
12. Click **Done**.

**Tip:** When you’ve completed a set of changes, use the ‘save ns config’ command on the command line or click the save icon in the configuration utility to ensure your changes are saved to Citrix ADC configuration file.

---

**Creating a Portal Theme**

To create a custom portal design, you use one of the supplied portal themes as a template. The system makes a copy of the selected template theme with a name that you specify.

**Using a stock Portal Theme as a template for a custom Portal Theme**

To create a Portal Theme, you can use the configuration utility or the command line to create the theme entity. However, the detailed customization controls are available only within the configuration utility.

**Using the command line to create a portal theme**

At the command prompt, type;

```
1   add portaltheme <name> basetheme <name>
```

**Using the configuration utility to create a portal theme**

1. On the **Configuration** tab, Navigate to **Citrix Gateway** and click **Portal Themes**.
2. In the main details pane, click **Add**.
3. Enter a name for the theme and select a template from the template list, and then click **OK**.
4. At this point, you are presented with the first-time view of the portal theme editing window. Click **OK** to exit.

You can proceed to customize the new portal theme with the first-time view. However, you should read the following Portal Theme Customization section about the interface, and the pop-up descriptions of the customizable portal attributes within the interface before continuing to edit a portal theme.
Once a new theme is created, you can bind it as described in Binding a Portal Theme to a VPN Virtual Server or Binding a Portal Theme to VPN Global. You can bind a new theme immediately after creation or after completing your customizations.

Portal Theme Customization

To customize a Portal Theme, use the Portal Theme interface in the configuration utility. To get the best results, you should understand the various elements of this interface before you use it.

About the Portal Theme Interface

To open the Portal Theme interface in the Citrix Gateway configuration utility, on the Configuration tab, Navigate to Citrix Gateway and click Portal Themes. You can either create a theme as described in Creating a Portal Theme or select an existing theme in the main details pane and click Edit.

The portal theme customization page has four primary component panes for modifying a portal design: the Portal Theme pane, the Look & Feel pane, the Advanced Settings pane, and the Language pane.
Portal Theme interface

The Portal Theme pane at the top of the page reports what theme is loaded for editing and what template theme it is based on. The viewing option here allows you to view your customizations without accessing the VPN with a user connection. Using the viewing option requires binding the theme to a VPN virtual server and the binding remains in effect after the viewing window is closed.

With the Look & Feel pane in the center of the page, you configure a theme's general properties, such as headers, background colors and images, font properties, and logos. When this pane is in edit mode, attribute legends are available for guidance on where the Look & Feel attributes are used on portal pages.

The Advanced Settings pane contains the onscreen content controls for the individual portal pages. To load a page's content for editing, click one of the pages listed. The page controls then open below the other center panes. A page remains collapsed in the Advanced Settings pane across Portal Theme edits as long as the page has not been modified.

In the Language pane, you can select which of the languages will be loaded when a page is selected for edit from the Advanced Settings pane. The English language pages are loaded by default.
Types of Customizable Page Attributes

When customizing a Portal Theme, you can modify a range of attributes in the Portal Theme interface. Along with the text and the supported languages that can be edited, all of the graphical elements of the portal’s layout can be tailored to suit your needs. Each of the page element types has parameters or recommendations to consider before modifying them.

Colors

The portal design specifies the colors for attributes such as page backgrounds, highlights, text for titles and body content, button controls, and hover responses. To customize a color attribute, you can enter a color value directly for a selected item, or you can use the supplied color picker to generate a color value. The interface supports entering valid HTML color values in RGBA format, HTML hexadecimal triplet format, and X11 color names. The color picker can be accessed for any applicable color attribute by clicking the color box next to the attribute’s input field.

The Color Picker
Fonts
Along with font colors, you can modify font sizes for some page attributes. For each of these attributes, a menu offers the sizes available for each attribute, as determined by the portal's design.

Images
For images, a pop-up description available for each control provides size recommendations and other requirements. The descriptions vary according to an attribute's location on the page and its function. You can use PNG or JPEG image file formats. You can select an image to upload by selecting the check box beneath an item's file name and then browsing to where the image resides on your local computer's drive.

Labels
In the Advanced Settings section, you can select a specific portal page's text to modify. If you modify the default English text for a page, the text for other languages is not retranslated. The alternative language page content is provided as a convenience but requires manual updates for any customiza-
tions. To edit another language version for a page, first collapse the window, if it is open, by clicking the X icon for the open portal page. Then select the language in the Language pane and click OK. All of the portal pages opened from the Advanced Settings pane will then be in that language until you select a different one.

**Important**

In high availability or clustered deployments, Portal Themes are distributed across the shared configuration only when Portal Theme settings are made on the primary or configuration coordinator Citrix ADC entities respectively.

**A Note on Older Portal Customizations**

For installations with manually modified custom portal design created in Citrix Gateway or Access Gateway releases earlier than 11.0, Citrix strongly recommends starting with a new portal theme in the customization interface. If you can’t do that, you can apply a customization manually, but direct support for that is not provided.

When using a manually customized portal, you must set the customized portal as a global portal configuration. Doing so though means that an applied global portal configuration cannot be overridden with VPN virtual server level portal theme bindings. Attempting to create a VPN virtual server binding in this case with the configuration utility or the command line returns an error.

Also, in the case of high availability and cluster configurations, any manual customizations must be performed on every node in the deployment as the underlying files on the Citrix ADC file system are not distributed in the automatically shared configuration.

**Manually creating a custom portal configuration**

To manually apply an older customized portal configuration after upgrading to Citrix Gateway 11.0, you need to modify a copy of an existing portal page, put the customized portal files into the Citrix ADC file system, and select CUSTOM as the UI_THEME parameter.

You can use WinSCP or any other secure copy program to transfer files to the Citrix ADC file system.

1. Log on to the Citrix Gateway command line.
2. At the command prompt, type **shell**
3. At the command prompt, type **mkdir /var/ns_gui_custom; cd /netscaler; tar -cvzf /var/ns_gui_custom/customtheme.tar.gz ns_gui/***.
4. At command prompt, type **cd /var/netscaler/logon/themes/**
   - If you want to customize the Greenbubble theme, enter **cp -r Greenbubble Custom** to make a copy of the Greenbubble theme.
   - If you want to customize the Default theme (Caxton), type **cp -r Default Custom**.
To customize the X1 theme, type `cp -r X1 Custom`.

5. Make the needed changes to the copied files under `/var/netscaler/logon/themes/Custom` to customize the theme manually.
   - Make the necessary edits to `css/base.css`.
   - Copy any custom images to the `/var/ns_gui_custom/ns_gui/vpn/media` directory.
   - Make changes to labels in the files present in the `resources/` directory. These files correspond to the portal supported locales.
   - If changes to HTML pages or javascript files are also needed, you can make the relevant to the files in `/var/ns_gui_custom/ns_gui/`.

6. After all customization changes are complete, at the prompt enter: `tar -cvzf /var/ns_gui_custom/customtheme.tar.gz /var/ns_gui_custom/ns_gui/*`

**Important**

When copying a theme directory in the preceding steps, the copied folder name must be entered exactly as ‘Custom’ since directory names are case-sensitive within the Citrix ADC shell interface. If the directory name is not entered precisely, the folder is not recognized when the `UITHEME` setting is configured to `CUSTOM`.

**Select the Customized Theme as a VPN Global Parameter**

Once the manually customized portal configuration is complete and copied to the Citrix ADC file system, it needs to be applied to the Citrix Gateway configuration. This is done by setting the `UITHEME` parameter to `CUSTOM` and can be completed with the command line or the configuration utility.

To use the command line, enter the following command to set the `UITHEME` parameter.

```
set vpn parameter UITHEME CUSTOM
```

To set the `UITHEME` parameter using the configuration utility, use the following procedure.

1. On the Configuration tab, Navigate to Citrix Gateway > Global Settings.
2. Click Change Global Settings.
3. Click the Client Experience tab.
4. Scroll to the bottom of the screen then select CUSTOM from the UI Theme list menu.
5. Click OK.

Your manually customized portal is now the portal design presented to VPN users.

**Creating an End User License Agreement**

The VPN portal system provides the option to apply an end-user license agreement (EULA) to a portal configuration. Once a EULA is bound to the Citrix Gateway configuration, either at the VPN global
scope or to a relevant VPN virtual server, VPN users must agree to the EULA as Terms and Conditions before they are allowed to authenticate into the VPN.

As with the portal themes, users are served a language specific EULA based on the locale reported by their web browser. In cases of a locale that doesn’t match to any of the supported languages, the default language served is English. For each EULA, you can enter a custom message in each of the supported languages. Pre-translated content is not provided for EULA configurations as it is for the portal themes. If a user’s reported locale matches for a language where no EULA content is entered, the user is returned a blank page when they click the “Terms & Conditions” link in on the VPN login page.

To create a EULA, you can use either of the controls in the configuration utility on the Configuration tab at Citrix Gateway > Global Settings > EULA or Citrix Gateway > Resources > EULA. The controls in the Global Settings pane are used to manage VPN global EULA bindings while the control on the Resources > EULA node is for general operations on EULA configurations. You can manage VPN virtual server EULA bindings by editing a VPN virtual server at Citrix Gateway > Virtual Servers. Some commands are also available with the command line for managing EULA entities. However, the full EULA management controls are available only in the configuration utility.

Using the command line to create a EULA entity

At the command prompt, type;

```
add vpn eula <name>
```

Using the configuration utility to create a EULA entity

1. Navigate to Citrix Gateway > Resources > EULA.
2. Click Add to create an entity.
3. Enter a name for the entity.
4. For each of the languages, paste in the content under the relevant tabs. You can use plain text or HTML tags to format the content, including a `<br>` tag to add line breaks.
5. Click Create.

Once a EULA entity has been created, it can be globally bound to the VPN configuration, or can be bound to a VPN virtual server.

Using the command line to bind a EULA to VPN Global

At the command prompt, type;
Using the configuration utility to make a global EULA VPN binding

1. On the Configuration tab, navigate to Citrix Gateway > Global Settings.
2. In the main details pane, click Configure an End User License Agreement.
3. Click Add Binding.
4. Click Click to select.
5. Select a EULA entity then click Select.
6. Click Bind.
7. Click Close.

Using the command line to bind a EULA to a VPN Virtual Server

At the command prompt, type;

```
bind vpn global eula <name>
```

Using the configuration utility to bind a EULA to a VPN Virtual Server

1. At the Configuration tab browse to Citrix Gateway > Virtual Servers.
2. In the main details pane, select a VPN virtual server and click Edit.
3. From the Advanced Settings pane on the right side of the page, click EULA.
4. In the newly added EULA pane, click No EULA.
5. Click Click to select.
6. Select a EULA entity and click Select.
7. Click Bind.
8. Click Done.

Configuring Clientless Access

April 23, 2019

Clientless access allows users the access they need without requiring them to install user software, such as the Citrix Gateway plug-in or Receiver. Users can use their web browser to connect to web applications, such as Outlook Web Access.
You use the following steps to configure clientless access:

- Enabling clientless access either globally or by using a session policy bound to a user, group, or virtual server.
- Selecting the web address encoding method.

To enable clientless access for only a specific virtual server, disable clientless access globally, and then create a session policy to enable it.

If you use the Citrix Gateway wizard to configure the appliance, you have the choice of configuring clientless access within the wizard. The settings in the wizard are applied globally. Within the Citrix Gateway wizard, you can configure the following client connection methods:

- Citrix Gateway plug-in. Users are allowed to log on by using the Citrix Gateway plug-in only.
- Use the Citrix Gateway plug-in and allow access scenario fallback. Users log on to Citrix Gateway with the Citrix Gateway plug-in. If the user device fails an endpoint analysis scan, users are permitted to log on using clientless access. When this occurs, users have limited access to network resources.
- Allow users to log on using a Web browser and clientless access. Users can log on only by using clientless access and receive limited access to network resources.

### Enabling Clientless Access

*April 23, 2019*

When you enable clientless access on a global level, all users receive the settings for clientless access. You can use the Citrix Gateway wizard, a global policy, or a session policy to enable clientless access.

In a global setting or a session profile, clientless access has the following settings:

- **On.** Enables clientless access. If you disable client choices and you do not configure or disable StoreFront or the Web Interface, users log on by using clientless access.
- **Allow.** Clientless access is not enabled by default. If you disable client choices, and you do not configure or disable StoreFront or the Web Interface, users log on with the Citrix Gateway plug-in. If endpoint analysis fails when users log on, users receive the choices page with clientless access available.
- **Off.** Clientless access is turned off. When you select this setting, users cannot log on by using clientless access and the icon for clientless access does not appear on the choices page.

Note: If you configure clientless access by using the command-line interface, the options are ON, OFF, or Disabled.

If you did not enable clientless access by using the Citrix Gateway wizard, you can enable it globally or in a session policy by using the configuration utility.
To enable clientless access globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Clientless Access, select ON and then click OK.

To enable clientless access by using a session policy

If you want only a select group of users, groups, or virtual servers to use clientless access, disable or turn off clientless access globally. Then, using a session policy, enable clientless access and bind it to users, groups, or virtual servers.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Clientless Access, click Override Global, select On and then click Create.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.
8. Click Create and then click Close.

After you create the session policy that enables clientless access, you bind it to a user, group, or virtual server.

Encoding the Web Address

April 23, 2019

When you enable clientless access, you can choose to encode the addresses of internal web applications or to leave the address as clear text. The settings are:

- Obscure. This uses standard encoding mechanisms to obscure the domain and protocol part of the resource.
- Clear. The web address is not encoded and is visible to users.
- Encrypt. The domain and protocol are encrypted by using a session key. When the web address is encrypted, the URL is different for each user session for the same web resource. If users bookmark the encoded web address, save it in the web browser and then log off, when users log on
and try to connect to the web address again using the bookmark, they cannot connect to the web address.

Note: If users save the encrypted bookmark in the Access Interface during their session, the bookmark works each time the user logs on.

You can configure this setting either globally or as part of a session policy. If you configure encoding as part of session policy, you can bind it to the users, groups, or a virtual server.

**To configure web address encoding globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Clientless Access URL Encoding, select the encoding level and then click OK.

**To configure web address encoding by creating a session policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Clientless Access URL Encoding, click Override Global, select the encoding level and then click OK.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

**How Clientless Access Policies Work**

April 23, 2019

You configure clientless access to web applications by creating policies. You can configure the settings for a clientless access policy in the configuration utility. A clientless access policy is composed of a rule and a profile. You can use the preconfigured clientless access policies that come with Citrix Gateway. You can also create your own custom clientless access policies.

Citrix Gateway provides preconfigured policies for the following:
Citrix Gateway 13.0

- Outlook Web Access and Outlook Web App
- SharePoint 2007
- All other Web applications

Keep in mind the following characteristics of the preconfigured clientless access policies:

- They are configured automatically and cannot be changed.
- Each policy is bound at the global level.
- Each policy is not enforced unless you enable clientless access either globally or by creating a session policy.
- You cannot remove or modify global bindings, even if you do not enable clientless access.

Support for other web applications depends on the level of rewrite policies you configure on Citrix Gateway. Citrix recommends testing any custom policies that you create to ensure that all components of the application rewrite successfully.

If you allow connections from Receiver for Android, Receiver for iOS, or WorxHome, you must enable clientless access. For WorxHome that runs on an iOS device, you must also enable Secure Browse within the session profile. Secure Browse and clientless access work together to allow connections from iOS devices. You do not have to enable Secure Browse if users do not connect with iOS devices.

The Quick Configuration wizard configures the correct clientless access policies and settings for mobile devices. Citrix recommends running the Quick Configuration wizard to configure the correct policies for connections to StoreFront and Citrix Endpoint Management.

You can bind custom clientless access policies either globally or to a virtual server. If you want to bind clientless access policies to a virtual server, you need to create a new custom policy and then bind it. To enforce different policies for clientless access either globally or for a virtual server, change the priority number of the custom policy so it has a lower number than the preconfigured policies, thereby giving the custom policy higher priority. If no other clientless access policies are bound to the virtual server, the preconfigured global policies take precedence.

Note: You cannot change the priority numbers of the preconfigured clientless access policies.

Creating New Clientless Access Policies

April 23, 2019

If you want to use the same settings as for the default clientless access policies but you want to bind the policy to a virtual server, you can copy the default policies, providing a new name for the policy. You can use the configuration utility to copy the default policies.

After you bind the new policy to the virtual server, you can set the priority of the policy so that it executes first when a user logs on.
To create a new clientless access policy using default settings

1. In the configuration utility, on the navigation pane, expand Citrix Gateway > Policies and then click Clientless Access.
2. In the details pane, on the Policies tab, click a default policy and then click Add.
3. In Name, type a new name for the policy, click Create and then click Close.

To bind a clientless access policy to a virtual server

After you create the new policy, bind it to the virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. In the configure Citrix Gateway Virtual Server dialog box, click the Policies tab and then click Clientless.
4. Click Insert Policy, select a policy from the list and then click OK.

Creating and Evaluating Clientless Access Policy Expressions

When you create a new policy for clientless access, you can create your own expression for the policy. When you are finished creating the expression, you can then evaluate the expression for accuracy.

1. In the configuration utility, on the navigation pane, expand Citrix Gateway > Policies and then click Clientless Access.
2. In the details pane, on the Policies tab, click a default policy and then click Add.
3. In Name, type a name for the policy.
4. Next to Profile, click New.
5. In Name, type a name for the profile.
6. Configure the rewrite settings and then click Create.
7. In the Create Clientless Access Policy dialog box, under Expression, click Add.
8. In the Add Expression dialog box, create the expression and then click OK.
9. In the Create Clientless Access Policy dialog box, click Evaluate, and if the expression tests as correct, click Create.

Advanced Clientless VPN access with Citrix Gateway

August 22, 2019
Clientless VPN (CVPN) sees a way of providing remote access to corporate’s intranet resources through Citrix Gateway without a VPN client application at the client machine. CVPN provides remote access to enterprise web-applications, portals, and other resources using a web browser at the client’s end. Advanced CVPN solution eliminates the following limitations pertaining to CVPN:

- Relative URLs cannot be identified at times.
- Relative URLs generated dynamically cannot be identified.

Advanced Clientless VPN identifies the absolute URL and host names and rewrites them in a new and unique manner instead of trying to rewrite relative URLs present in the HTTP-responses/Web-Pages. SharePoint no longer needs to use the default folder for rewriting URLs and a custom SharePoint access is supported.

**Prerequisites**

The following are the prerequisites to configure Advanced CVNP.

1. **WildCard Server Certificate** - VPN virtual server requires a wildcard server certificate. If the server is hosted with `https://vpn.com` then the server certificate now should have entries for `{vpn.com and .vpn.com}` as part of certificates CN or SAN (where CN=common name, SAN=Subject Alternative Name). The process of binding this certificate remains the same on Citrix Gateway.

2. **WildCard DNS entry** - The clients (web browsers) would need to resolve the Advanced CVNP app’s FQDN. While setting up the Citrix Gateway server, you would have configured a DNS entry to resolve `vpn.com`. You need to configure a subdomain for `.` so that `.vpn.com` now resolves to `vpn.com` as well.

**Configure Advanced Clientless VPN access**

To configure Advanced Clientless VPN access using the command line interface, at the command prompt, type:

```
1 set vpn parameter -clientlessVpnMode ON
2 set vpn parameter -advancedClientlessVpnMode ENABLED
```

If a session action is bound to the virtual server, you must enable the Advanced Clientless VPN Mode option for that session action as well.

**Example:**

```
1 set vpn sessionaction SessionActionName -advancedclientlessvpn ENABLED
```
To configure Advanced Clientless VPN access using the Citrix ADC GUI:

1. In the NetScaler GUI, navigate to **Configuration>Citrix NetScaler>Global Settings**.

2. On the **Global Settings** page, click **Change Global Settings**, and then select the **Client Experience** tab.

3. On the **Client Experience** tab, from the **Clientless Access** list, click **On**.

4. On the **Client Experience** tab, from the **Advanced Clientless VPN Mode** list, click **Enabled**.

   **Note:**
   - If a session action is bound to the virtual server, you must enable the **Advanced Clientless VPN Mode** option for that session action as well from the **Client Experience** tab in the **Configure Citrix Gateway Session Profile** page.
   - You can select the **Override Global** option to override the global settings.

### Clientless Access

- **On**

### Clientless Access URL Encoding

- **Clear**

### Clientless Access Persistent Cookie

- **DENY**

### Advanced Clientless VPN Mode

- **ENABLED**

---

**Caveats**

Advanced CVPN is aimed at providing access to Enterprise Web-Apps. Such apps have only one FQDN for every kind of resource they need (JavaScript, css, images, and so on). Since we encode the complete FQDN of internal apps into a single-octet (cvpn), we lose out on the subdomain relationship. As a result, whenever an Enterprise WebApp is configured with CORS, sometimes you may notice issues while accessing it over Advanced CVPN.
Configuring Domain Access for Users

April 23, 2019

If users connect by using clientless access, you can restrict the network resources, domains, and web sites users are permitted to access. You can use the Citrix Gateway wizard or global settings to create lists for including or excluding access to domains.

You can allow access to all network resources, domains, and web sites and then create an exclusion list. The exclusion list cites a specific set of resources that users are not allowed to access. Users cannot access any domains that are in the exclusion list.

You can also deny access to all network resources, domains, and web sites and then create a specific inclusion list. The inclusion list cites the resources that users can access. Users cannot access any domains that do not appear on the list.

Note: If you configure clientless access policies for Citrix Endpoint Management or StoreFront and users connect with Receiver for Web, you need to allow the domains that Receiver for Web can access. This is required so Citrix Gateway can rewrite network traffic for StoreFront and Endpoint Management.

To configure domain access by using the Citrix Gateway wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Getting Started, click Citrix Gateway wizard.
3. Click Next and then follow the directions in the wizard until you reach the Configure clientless access page.
4. Click Configure Domains for Clientless Access and do one of the following:
   • To create a list of excluded domains, click Exclude domains.
   • To create a list of included domains, click Allow domains.
5. Under Domain Names, type the domain name and then click Add.
6. Repeat Step 5 for each domain you want to add to the list and then click OK when finished.
7. Continue configuring the appliance by using the Citrix Gateway wizard.

To configure domain settings by using the configuration utility

You can also create or modify the domain list by using global settings in the configuration utility.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Clientless Access, click Configure Domains for Clientless Access.
3. Do one of the following:
   • To create a list of excluded domains, click Exclude domains.
   • To create a list of included domains, click Allow domains.
4. Under Domain Names, type the domain name and then click Add.
5. Repeat Step 4 for each domain you want to add to the list and then click OK when finished.


April 23, 2019

Citrix Gateway can rewrite content from one or more SharePoint 2003 or SharePoint 2007 or SharePoint 2013 sites so that the content is available to users without requiring the Citrix Gateway plug-in. For the rewrite process to complete successfully, you must configure Citrix Gateway with the host name for each SharePoint server in your network.

You can use the Citrix Gateway wizard or the configuration utility to configure the host name for SharePoint sites.

In the Citrix Gateway wizard, navigate through the wizard to configure your settings. When you come to the Configure clientless access page, type the web address for the SharePoint site and then click Add.

To add additional Web sites or to configure SharePoint for the first time after running the Citrix Gateway wizard, you use the configuration utility.

To configure clientless access for SharePoint by using the Citrix ADC GUI

1. Navigate to Citrix Gateway > Global Settings.
2. In the details pane, under Clientless Access, click Configure Clientless Access for SharePoint.
3. Under Clientless Access for SharePoint, in Host name of SharePoint server, type the host name for the SharePoint site and then click Add.
4. Repeat Step 3 for each SharePoint site you want to add to the list and then click OK when finished.
Setting a SharePoint Site as the Home Page

April 23, 2019

If you want to set a SharePoint site as the users’ home page, configure a session profile and enter the host name of the SharePoint site.

To configure a SharePoint site as the home page

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Home Page click Override Global and then type the name of the SharePoint site.
7. Next to Clientless Access, click Override Global, select On and then click Create.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

After completing the session policy, bind it to users, groups, virtual servers, or globally. When users log on, they see the SharePoint Web site as their home page.

Enabling Name Resolution for SharePoint 2007 Servers

April 23, 2019

SharePoint 2007 servers send the configured server name as the host name within various URLs as part of the response. If a configured SharePoint server name is not the fully qualified domain name (FQDN), Citrix Gateway cannot resolve the IP address using the SharePoint server name, and some user functions time out with the error message “HTTP:1.1 Gateway Time-out.” These functions can include checking files in and out, viewing the workspace, and uploading multiple files when users are logged on using clientless access.

To resolve this issue, you can try one of the following:

- Configure a DNS suffix on Citrix Gateway so that the SharePoint host name is converted to an FQDN before name resolution.
- Configure a local DNS entry on Citrix Gateway for every SharePoint server name.
- Change all the SharePoint server names to use the FQDN, such as SharePoint.intranetdomain instead of SharePoint,

**To configure a DNS suffix**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand DNS and then click DNS Suffix.
2. In the details pane, click Add.
3. In DNS Suffix, type the intranet domain name as the suffix, click Create and then click Close.
   
   You can repeat Step 3 for each domain you want to add.

**To configure a local DNS record for every SharePoint server name on Citrix Gateway**

1. In the configuration utility, in the navigation pane, expand DNS > Records and then click Address Records.
2. In the details pane, click Add.
3. In Host Name, type the SharePoint host name for the DNS address record.
4. In IP Address, type the IP address of the SharePoint server, click Add, click Create and then click Close.
   
   The host name for which an A record is added should not have a CNAME record. Also, there cannot be duplicate A records on the appliance.

**Enabling Clientless Access Persistent Cookies**

April 23, 2019

Persistent cookies are required for accessing certain features of SharePoint, such as opening and editing Microsoft Word, Excel, and PowerPoint documents hosted on the SharePoint server.

A persistent cookie remains on the user device and is sent with each HTTP request. Citrix Gateway encrypts the persistent cookie before sending it to the plug-in on the user device, and refreshes the cookie periodically as long as the session exists. The cookie becomes stale if the session ends.

In the Citrix Gateway wizard, administrators can enable persistent cookies globally. You can also create a session policy to enable persistent cookies per user, group, or virtual server.

The following options are available for persistent cookies:
Citrix Gateway 13.0

- Allow enables persistent cookies and users can open and edit Microsoft documents stored in SharePoint.
- Deny disables persistent cookies and users cannot open and edit Microsoft documents stored in SharePoint.
- Prompt prompts users to allow or deny persistent cookies during the session.

Persistent cookies are not required for clientless access if users do not connect to SharePoint.

**Configuring Persistent Cookies for Clientless Access for SharePoint**

April 23, 2019

You can configure persistent cookies for clientless access for SharePoint either globally or as part of a session policy.

**To configure persistent cookies globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Clientless Access Persistent Cookies, select an option and then click OK.

**To configure persistent cookies as part of a session policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Clientless Access Persistent Cookies, click Override Global, select an option and then click Create.
7. In the Create authentication policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.
Saving User Settings for Clientless Access Through Web Interface

April 23, 2019

When users log on and log off from the Web Interface by using clientless access, Citrix Gateway does not forward the client-consumed cookie set from the previous session, even if the cookies are persistent when users log on multiple times. You can use the configuration utility or command line to bind cookies to a pattern set of client cookies to preserve Web Interface settings between sessions.

To bind cookies for Web Interface persistence by using the configuration utility

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies and then click Clientless Access.
2. In the right pane, on the Policies tab, click Add.
3. In the Create Clientless Access Policy dialog box, in Name, type a name for the policy.
4. Next to Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Cookies tab, in Client Cookies, select ns_cvpn_default_client_cookies and then click Modify.
7. In the Configure Pattern Set dialog box, under Specify Pattern, in Pattern, enter the following parameters:
   • WIUser and then click Add.
   • WINGDevice and then click Add.
   • WINGSession and then click Add.
8. Click OK and then click Create.
9. In the Create Clientless Access Policy dialog box, in Expression, type true, click Create and then click Close.

To bind cookies for Web Interface persistence by using the command line

1. Log on to the Citrix Gateway command line by using a Secure Shell (SSH) connection, such as PuTTY.
2. At the command prompt, type shell.
3. At the command prompt, enter the following commands:
   • bind policy patset ns_cvpn_default_client_cookies WIUser and then press ENTER.
   • bind policy patset ns_cvpn_default_client_cookies WINGDevice and then press ENTER.
   • bind policy patset ns_cvpn_default_client_cookies WINGSession and then press ENTER.
Configuring the Client Choices Page

April 23, 2019

You can configure Citrix Gateway to provide users with multiple logon options. By configuring the client choices page, users have the option of logging on from one location with the following choices:

- Citrix Gateway plug-in for Windows
- Citrix Gateway plug-in for Mac OS X
- Citrix Gateway plug-in for Java
- StoreFront
- Web Interface
- Clientless access

Users log on to Citrix Gateway by using the web address in the certificate bound to Citrix Gateway or the virtual server. By creating a session policy and profile, you can determine the logon choices users receive. Depending on how you configure Citrix Gateway, the client choices page displays up to three icons representing the following logon choices:

- Network Access. When users log on to Citrix Gateway for the first time by using a web browser and then select Network Access, the download page appears. When users click Download, the plug-in downloads and installs on the user device. When the download and installation is complete, the Access Interface appears. If you install a newer or revert to an older version of Citrix Gateway, the Citrix Gateway plug-in for Windows silently upgrades or downgrades to the version on the appliance. If users connect by using the Citrix Gateway plug-in for Mac, the plug-in silently upgrades if a new appliance version is detected when users log on. This version of the plug-in does not silently downgrade.
- Web Interface or StoreFront. If users select the Web Interface to log on, the Web Interface page appears. Users can then access their published applications or virtual desktops. If users select StoreFront to log on, Receiver opens and users can access applications and desktops.
  Note: If you configure StoreFront as a client choice, applications and desktops do not appear in the left pane of the Access Interface.
- Clientless access. If users select clientless access to log on, the Access Interface or your customized home page appears. In the Access Interface, users can navigate to file shares, web sites, and use Outlook Web Access.

If users select the Citrix Gateway plug-in for Java, the plug-in starts and users are logged on. The choices page does not appear.

Secure Browse allows users to connect through Citrix Gateway from an iOS device. If you enable Secure Browse, when users log on by using Secure Hub, Secure Browse disables the client choices page.
Showing the Client Choices Page at Logon

April 23, 2019

When you enable the client choices option, users can log on with the Citrix Gateway plug-in, the Web Interface, Receiver or clientless access from one web page after successful authentication to Citrix Gateway. When log on is successful, icons appear in the web page from which users can choose the method to establish a connection. You can also configure the Citrix Gateway plug-in for Java to appear on the choices page.

You can enable client choices without using endpoint analysis or implementing access scenario fallback. If you do not define a client security expression, users receive connection options for the settings that are configured on Citrix Gateway. If a client security expression exists for the user session and the user device fails the endpoint analysis scan, the choices page offers only the option to use the Web Interface if it is configured. Otherwise, users can use clientless access to log on.

You configure client choices either globally or by using a session profile and policy.

**Important:** When configuring client choices, do not configure quarantine groups. User devices that fail the endpoint analysis scan and are quarantined are treated the same as user devices that pass the endpoint scan.

**To enable client choices options globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the General tab, click Client Choices and then click OK.

**To enable client choices as part of a session policy**

You can also configure client choices as part of a session policy and then bind it to users, groups, and virtual servers.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, click Advanced.
7. On the General tab, next to Client Choices, click Override Global, click Client Choices, click OK and then click Create.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

Configuring Client Choices Options

April 23, 2019
In addition to enabling client choices by using a session profile and policy, you need to configure the settings for the user software. For example, you want users to log on using either the Citrix Gateway plug-in, StoreFront or the Web Interface, or clientless access. You create one session profile that enables all three options and client choices. Then, you create a session policy with the expression set to True value with the profile attached. Next, you bind the session policy to a virtual server.

Before creating the session policy and profile, you need to create an authorization group for users.

To create an authorization group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > User Administration, and then click AAA Groups.
2. In the details pane, click Add.
3. In Group Name, type the name of the group.
4. On the Users tab, select the users, click Add for each one, click Create and then click Close.

The following procedure is an example session profile for client choices with the Citrix Gateway plug-in, StoreFront, and clientless access.

To create a session profile for client choices

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click the Profiles tab and then click Add.
3. In Name, type a name for the profile.
4. On the Client Experience tab, do the following:
   a) Next to Home Page, click Override Global and then clear Display Home Page. This disables the Access Interface.
   b) Next to Clientless Access, click Override Global and then select OFF.
c) Next to plug-in Type, click Override Global and then select Windows/Mac OS X.
d) Click Advanced Settings and next to Client Choices, click Override Global, click Client Choices.

5. On the Security tab, next to Default Authorization Action, click Override Global and then select ALLOW.


7. Under Authorization Groups, click Override Global, click Add and then select the group.

8. On the Published Applications tab, do the following:
   a) Next to ICA Proxy, click Override Global and then select OFF.
   b) Next to Web Interface Address, click Override Global and then type the Web address of StoreFront, such as http://ipAddress/Citrix/.
   c) Next to Web Interface Portal Mode, click Override Global and then select COMPACT.
   d) Next to Single Sign-On Domain, click Override Global and then type the name of the domain.

9. Click Create and then click Close.

If you want to use the Citrix Gateway plug-in for Java as a client choice, on the Client Experience tab, in plug-in Type, select Java. If you select this choice, you must configure an intranet application and set the interception mode to Proxy.

After creating the session profile, create a session policy. Within the policy, select the profile, and set the expression to True value.

To use StoreFront as a client choice, you must also configure the Secure Ticket Authority (STA) on the Citrix Gateway. The STA is bound to the virtual server.

**Note:** If the server running the StoreFront is not available, the Citrix Virtual Apps choice does not appear on the choices page.

**To configure the STA server globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Servers, click Bind/Unbind STA Servers to be used by the Secure Ticket Authority.
3. In the Bind/Unbind STA Servers dialog box, click Add.
4. In the Configure STA Server dialog box, in URL, type the web address of the STA server and then click Create.
5. Repeat Steps 3 and 4 to add more STA servers and then click OK.
To bind the STA to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. On the Published Applications tab, under Secure Ticket Authority, under Active, select the STA servers and then click OK.

You can also add STA servers on the Published Applications tab.

Configuring Access Scenario Fallback

September 10, 2019

SmartAccess allows Citrix Gateway to determine automatically the methods of access that are allowed for a user device based on the results of an endpoint analysis scan. Access scenario fallback further extends this capability by allowing a user device to fall back from the Citrix Gateway plug-in to the Web Interface or StoreFront by using Citrix Workspace app if the user device does not pass the initial endpoint analysis scan.

To enable access scenario fallback, you configure a post-authentication policy that determines whether or not users receive an alternative method of access when logging on to Citrix Gateway. This post-authentication policy is defined as a client security expression that you configure either globally or as part of a session profile. If you configure a session profile, the profile is associated to a session policy that you then bind to users, groups, or virtual servers. When you enable access scenario fallback, Citrix Gateway initiates an endpoint analysis scan after user authentication. The results for user devices that do not meet the requirements of a fallback post-authentication scan are as follows:

- If client choices is enabled, users can log on to the Web Interface or StoreFront by using Citrix Workspace app only.
- If clientless access and client choices are disabled, users can be quarantined into a group that provides access only to the Web Interface or StoreFront.
- If clientless access and the Web Interface or StoreFront are enabled on Citrix Gateway and ICA proxy is disabled, users fall back to clientless access.
- If the Web Interface or StoreFront is not configured and clientless access is set to allow, users fall back to clientless access.

When clientless access is disabled, the following combination of settings must be configured for the access scenario fallback:

- Define client security parameters for the fallback post-authentication scan.
- Define the Web Interface home page.
- Disable client choices.
- If user devices fail the client security check, users are placed into a quarantine group that allows access only to the Web Interface or StoreFront and to published applications.

Creating Policies for Access Scenario Fallback

September 10, 2019

To configure Citrix Gateway for access scenario fallback, you need to create policies and groups in the following ways:

- Create a quarantine group in which users are placed if the endpoint analysis scan fails.
- Create a global Web Interface or StoreFront setting that is used if the endpoint analysis scan fails.
- Create a session policy that overrides the global setting and then bind the session policy to a group.
- Create a global client security policy that is applied if the endpoint analysis fails.

When configuring access scenario fallback, use the following guidelines:

- Using client choices or access scenario fallback requires the Endpoint Analysis plug-in for all users. If endpoint analysis cannot run or if users select Skip Scan during the scan, users are denied access.
  Note: The option to skip the scan is removed in Citrix Gateway 10.1, Build 120.1316.e
- When you enable client choices, if the user device fails the endpoint analysis scan, users are placed into the quarantine group. Users can continue to log on with either the Citrix Gateway plug-in or the Citrix Workspace app to the Web Interface or StoreFront.
  Note: Citrix recommends that you do not create a quarantine group if you enable client choices. User devices that fail the endpoint analysis scan and are quarantined are treated in the same way as user devices that pass the endpoint scan.
- If the endpoint analysis scan fails and the user is put in the quarantine group, the policies that are bound to the quarantine group are effective only if there are no policies bound directly to the user that have an equal or lower priority number than the policies bound to the quarantine group.
- You can use different web addresses for the Access Interface and, the Web Interface or StoreFront. When you configure the home pages, the Access Interface home page takes precedence for the Citrix Gateway plug-in and the Web Interface home page takes precedence for Web Interface users. The Citrix Workspace app home page takes precedence for StoreFront.
To create a quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > User Administration, and then click AAA Groups.
2. In the details pane, click Add.
3. In Group Name, type a name for the group, click Create and then click Close.
   Important: The name of the quarantine group must not match the name of any domain group to which users might belong. If the quarantine group matches an Active Directory group name, users are quarantined even if the user device passes the endpoint analysis security scan.

After creating the group, configure Citrix Gateway to fall back to the Web Interface if the user device fails the endpoint analysis scan.

To configure settings to quarantine user connections

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. In the Global Citrix Gateway Settings dialog box, on the Published Applications tab, next to ICA Proxy, select OFF.
4. Next to Web Interface Address, type the web address for StoreFront or the Web Interface.
5. Next to Single Sign-On Domain, type the name of your Active Directory domain and then click OK.

After configuring the global settings, create a session policy that overrides the global ICA proxy setting and then bind the session policy to the quarantine group.

To create a session policy for Access Scenario Fallback

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. On the Published Applications tab, next to ICA Proxy, click Override Global, select On and then click Create.
6. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

After creating the session policy, bind the policy to a quarantine group.
To bind the session policy to the quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > User Administration, and then click AAA Groups.
2. In the details pane, select a group and then click Open.
3. Click Session.
4. On the Policies tab, select Session, and then click Insert Policy.
5. Under Policy Name, select the policy and then click OK.

After creating the session policy and profile enabling the Web Interface or StoreFront on Citrix Gateway, create a global client security policy.

To create a global client security policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
4. In Client Security, enter the expression. For more information about configuring system expressions, see Configuring System Expressions and Configuring Compound Client Security Expressions
5. In Quarantine Group, select the group you configured in the group procedure and then click OK twice.

Configuring Connections for the Citrix Gateway plug-in

January 16, 2020

You configure user device connections by defining the resources users can access in the internal network. Configuring user device connections includes:

- Defining the domains to which users are allowed access.
- Configuring IP addresses for users, including address pools (intranet IPs).
- Configuring time-out settings.
- Configuring single sign-on.
- Configuring client interception.
- Configuring split tunneling.
- Configuring connections through a proxy server.
- Configuring user software to connect through Citrix Gateway.
• Configuring access for mobile devices.

You configure most user device connections by using a profile that is part of a session policy. You can also define user device connection settings by using intranet applications, preauthentication, and traffic policies.

**Note:** Windows VPN plug-in and EPA plug-ins collect telemetry data for its various operations. To disable the functionality do the following on the client machine.

Set registry “HKLM\Software\Citrix\Secure Access Client\DisableGA” of type REG_DWORD to 1.

### Configuring the Number of User Sessions

April 23, 2019

You can configure the maximum number of users who are allowed to connect to Citrix Gateway at a particular point in time, at either the global level or on a per virtual server level. Sessions are not created on Citrix Gateway when the number of users connecting to the appliance exceeds the value that you configure. If the number of users exceeds the number you allow, users receive an error message.

**To set the global user limit**

When you configure the user limit globally, the restriction applies to all users who establish sessions to different virtual servers on the system. When the number of user sessions reaches the value you set, no new sessions can be established on any virtual server present on Citrix Gateway.

You set the maximum number of users at the global level when you set the default authentication type for Citrix Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change authentication settings.
3. In the Global Authentication Settings dialog box, in Maximum Number of Users, type the number of users and then click OK.

**To set the user limit per virtual server**

You can also apply the user limit to each virtual server on the system. When you configure the user limit per virtual server, the restriction applies only to users who establish sessions with the particular virtual server. Users who establish sessions with other virtual servers are not affected by this limit.
1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. In Max Users, type the number of users and then click OK.

**Configuring Time-Out Settings**

September 10, 2019

You can configure Citrix Gateway to force a disconnection if there is no activity on the connection for a specified number of minutes. One minute before a session times out (disconnects), the user receives an alert indicating the session will close. If the session closes, the user must log on again.

There are three time-out options:

- **Forced time-out.** If you enable this setting, Citrix Gateway disconnects the session after the time-out interval elapses regardless of what the user is doing. There is no action the user can take to prevent the disconnection from occurring when the time-out interval elapses. This setting is enforced for users who connect with the Citrix Gateway plug-in, Citrix Workspace app, Secure Hub, or through a web browser. The default setting is 30 minutes. If you set this value to zero, the setting is disabled.

- **Session time-out.** If you enable this setting, Citrix Gateway disconnects the session if no network activity is detected for the specified interval. This setting is enforced for users who connect with the Citrix Gateway plug-in, Citrix Workspace app, Citrix Secure Hub, or through a web browser. The default time-out setting is 30 minutes. If you set this value to zero, the setting is disabled.

- **Idle session time-out.** The duration after which the Citrix Gateway plug-in terminates an idle session if there is no user activity, such as from the mouse, keyboard, or touch for the specified interval. This setting is enforced for users who connect with the Citrix Gateway plug-in only. The default setting is 30 minutes. If you set this value to zero, the setting is disabled.

**Note:** Some applications, such as Microsoft Outlook, automatically send network traffic probes to email servers without any user intervention. Citrix recommends that you configure Idle session time-out with Session time-out to ensure that a session left unattended on a user device times out in a reasonable time.

You can enable any of these settings by entering a value between 1 and 65536 to specify a number of minutes for the time-out interval. If you enable more than one of these settings, the first time-out interval to elapse closes the user device connection.
You configure time-out settings by configuring global settings or by using a session profile. When you add the profile to a session policy, the policy is then bound to a user, group, or virtual server. When you configure the time-out settings globally, the settings are applied to all user sessions.

**Configuring Forced Time-Outs**

April 23, 2019

A forced time-out disconnects the Citrix Gateway plug-in automatically after a specified amount of time. You can configure a forced time-out globally or as part of a session policy.

**To configure a global forced time-out**

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand Citrix Gateway and then click **Global Settings**.
2. In the details pane, under **Settings**, click **Change global settings**.
3. On the **Network Configuration** tab, click **Advanced Settings**.
4. In Forced Time-out (mins), type the number of minutes users can stay connected.
5. In Forced Time-out Warning (mins), type the number of minutes before users are warned that the connection is due to be disconnected and then click **OK**.

**To configure a forced time-out within a session policy**

If you want to have further control over who receives the forced time-out, create a session policy and then apply the policy to a user or group.

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand Citrix Gateway > Policies and then click **Session**.
2. In the details pane, click **Add**.
3. In Name, type a name for the policy.
4. Next to Request Profile, click **New**.
5. In Name, type a name for the profile.
6. On the **Network Configuration** tab, click **Advanced**.
7. Under Timeouts, click Override Global and in Forced Time-out (mins) type the number of minutes users can stay connected.
8. Next to Forced Time-out Warning (mins), click **Override Global** and type the number of minutes users are warned that the connection is due to be disconnected. Click **OK** twice.
9. In the **Create Session Policy** dialog box, next to **Named Expressions**, select General, select **True value**, click **Add Expression**, click **Create** and then click **Close**.
Configuring Session or Idle Time-Outs

April 23, 2019

You can use the configuration utility to configure session and client time-out settings globally or to create a session policy. When you create a session policy and profile, set the expression to True.

To configure a session or client idle time-out globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, do one or both of the following:
   • In Session Time-out (mins), type the number of minutes.
   • In Client Idle Time-out (mins), type the number of minutes and then click OK.

To configure session or client idle time-out settings by using a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, do one or both of the following:
   • Next to Session Time-out (mins), click Override Global and then type the number of minutes and then click Create.
   • Next to Client Idle Time-out (mins), click Override Global, type the number of minutes and then click Create.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

Connecting to Internal Network Resources

April 23, 2019

© 1999-2020 Citrix Systems, Inc. All rights reserved.
You can configure Citrix Gateway to enable users to access resources in the internal network. If you disable split tunneling, all network traffic from the user device is sent to Citrix Gateway and authorization policies determine whether the traffic is allowed to pass through to internal network resources. When you enable split tunneling, only traffic destined for the internal network is intercepted by the user device and sent to Citrix Gateway. You configure which IP addresses Citrix Gateway intercepts by using intranet applications.

If you are using the Citrix Gateway plug-in for Windows, set the interception mode to transparent. If you are using the Citrix Gateway plug-in for Java, set the interception mode to proxy. When you set the interception mode to transparent, you can allow access to network resources using:

- A single IP address and subnet mask
- A range of IP addresses

If you set the interception mode to proxy, you can configure destination and source IP addresses and port numbers.

To configure network access to internal network resources

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway, expand Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. Complete the parameters for allowing network access, click Create and then click Close.

Configuring Split Tunneling

September 10, 2019

You can enable split tunneling to prevent the Citrix Gateway plug-in from sending unnecessary network traffic to Citrix Gateway.

When you do not enable split tunneling, the Citrix Gateway plug-in captures all network traffic originating from a user device and sends the traffic through the VPN tunnel to Citrix Gateway.

If you enable split tunneling, the Citrix Gateway plug-in sends only traffic destined for networks protected by Citrix Gateway through the VPN tunnel. The Citrix Gateway plug-in does not send network traffic destined for unprotected networks to Citrix Gateway.

When the Citrix Gateway plug-in starts, it obtains the list of intranet applications from Citrix Gateway. The Citrix Gateway plug-in examines all packets transmitted on the network from the user device and compares the addresses within the packets to the list of intranet applications. If the destination address in the packet is within one of the intranet applications, the Citrix Gateway plug-in sends the
packet through the VPN tunnel to Citrix Gateway. If the destination address is not in a defined intranet application, the packet is not encrypted and the user device routes the packet appropriately. When you enable split tunneling, intranet applications define the network traffic that is intercepted.

**Note:** If users connect to published applications in a server farm by using Citrix Workspace app, you do not need to configure split tunneling.

Citrix Gateway also supports reverse split tunneling, which defines the network traffic that Citrix Gateway does not intercept. If you set split tunneling to reverse, intranet applications define the network traffic that Citrix Gateway does not intercept. When you enable reverse split tunneling, all network traffic directed to internal IP addresses bypasses the VPN tunnel, while other traffic goes through Citrix Gateway. Reverse split tunneling can be used to log all non-local LAN traffic. For example, if users have a home wireless network and are logged on with the Citrix Gateway plug-in, Citrix Gateway does not intercept network traffic destined to a printer or another device within the wireless network.

For more information about intranet applications, see Configuring Client Interception.

You configure split tunneling as part of the session policy.

**To configure split tunneling**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Policies and then click Session.
2. In the details pane, on the Profiles tab, select a profile and then click Open.
3. On the Client Experience tab, next to Split Tunnel, select Global Override, select an option and then click OK twice.

**Configuring Split Tunneling and Authorization**

When planning your Citrix Gateway deployment, it is important to consider split tunneling and the default authorization action and authorization policies.

For example, you have an authorization policy that allows access to a network resource. You have split tunneling set to ON and you do not configure intranet applications to send network traffic through Citrix Gateway. When Citrix Gateway has this type of configuration, access to the resource is allowed, but users cannot access the resource.

If the authorization policy denies access to a network resource, you have split tunneling set to ON, and intranet applications are configured to route network traffic through Citrix Gateway, the Citrix Gateway plug-in sends traffic to Citrix Gateway, but access to the resource is denied.
Configuring Client Interception

April 23, 2019

You configure interception rules for user connections on Citrix Gateway by using Intranet Applications. By default, when you configure the system IP address, a mapped IP address, or a subnet IP address on the appliance, subnet routes are created based on these IP addresses. Intranet applications are created automatically based on these routes and can be bound to a virtual server. If you enable split tunneling, you must define intranet applications in order for client interception to occur.

You can configure intranet applications by using the configuration utility. You can bind intranet applications to users, groups, or virtual servers.

If you enable split tunneling and users connect by using WorxWeb or WorxMail, when you configure client interception, you must add the IP addresses for Citrix Endpoint Management and your Exchange server. If you do not enable split tunneling, you do not need to configure the Endpoint Management and Exchange IP addresses in Intranet Applications.

Configuring Intranet Applications for the Citrix Gateway plug-in

April 1, 2020

You create intranet applications for user access to resources by defining the following:

- One IP address
- A range of IP addresses
- A host name

When you define an intranet application on Citrix Gateway, the Citrix Gateway plug-in for Windows intercepts user traffic that is destined to the resource and sends the traffic through Citrix Gateway.

When configuring intranet applications, consider the following:

- Intranet applications need not be defined if the following conditions are met:
  - Interception mode is set to transparent
  - Users are connecting to Citrix Gateway with the Citrix Gateway plug-in for Windows
  - Split tunneling is disabled
- If users connect to Citrix Gateway by using the Citrix Gateway plug-in for Java, you must define intranet applications. The Citrix Gateway plug-in for Java intercepts traffic only to network resources defined by intranet applications. If users connect with this plug-in, set the interception mode to proxy.
When configuring an intranet application, you must select an interception mode that corresponds to the type of plug-in software used to make connections.

Note: You cannot configure an intranet application for both proxy and transparent interception. To configure a network resource to be used by both the Citrix Gateway plug-in for Windows and Citrix Gateway plug-in for Java, configure two intranet application policies and bind the policies to the user, group, virtual server, or Citrix Gateway global.

To create an intranet application for one IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name for the profile.
4. In the Create Intranet Application dialog box, select Transparent.
5. In Destination Type, select IPAddress and Netmask.
6. In Protocol, select the protocol that applies to the network resource.
7. In IPAddress, type the IP address.
8. In Netmask, type subnet mask, click Create and then click Close.

To configure an IP address range

If you have multiple servers in your network, such as web, email, and file shares, you can configure a network resource that includes the IP range for network resources. This setting allows users access to the network resources contained in the IP address range.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name for the profile.
4. In Protocol, select the protocol that applies to the network resource.
5. In the Create Intranet Application dialog box, select Transparent.
6. In Destination Type, select IPAddress Range.
7. In IP Start, type the starting IP address and in IP End, type the ending IP address, click Create and then click Close.

To create an intranet application for a host name

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name for the profile.
4. In the Create Intranet Application dialog box, select Transparent.
5. In Destination Type, select hostname.
6. In Protocol, select ANY, click Create and then click Close.

Important:
- From Citrix Gateway release 13.0 build 36.27 and later, Windows VPN plug-in supports host name (FQDN) based rules for split tunneling.
- Wildcard host names are also supported. For example, if intranet application with host name “*.example.com” is configured, a1.example.com, b2.example.com, and so on gets tunneled.
- Host name based intranet application works only when you have split tunneling set to ON.
- Host name based rules are not supported for reverse split tunneling.

Configuring Intranet Applications for the Citrix Gateway plug-in for Java

April 23, 2019

If users connect with the Citrix Gateway plug-in for Java, you must configure an intranet application and set the interception mode to proxy. The Citrix Gateway plug-in for Java intercepts traffic by using the user device loopback IP address and port number specified in the profile.

If users are connecting from a Windows-based device, the Citrix Gateway plug-in for Java attempts to modify the HOST file by setting the application HOST name to access the loopback IP address and port specified in the profile. Users must have administrative privileges on the user device for HOST file modification.

If users are connecting from a non-Windows device, you must configure applications manually by using the source IP address and port values specified in the intranet application profile.

To configure an intranet application for the Citrix Gateway plug-in for Java

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name for the profile.
4. Click Proxy.
5. In **Destination IP Address** and **Destination Port**, type the destination IP address and port.

6. Under **Source IP Address** and **Source Port**, type the source IP address and port.

   **Note:** You should set the source IP address to the loopback IP address of 127.0.0.1. If you do not specify an IP address, the loopback IP address is used. If you do not enter a port value, the destination port value is used.

### Configuring Name Service Resolution

April 23, 2019

During installation of Citrix Gateway, you can use the Citrix Gateway wizard to configure additional settings, including name service providers. The name service providers translate the fully qualified domain name (FQDN) to an IP address. In the Citrix Gateway wizard, you can configure a DNS or WINS server, set the priority of the DNS lookup, and the number of times to retry the connection to the server.

When you run the Citrix Gateway wizard, you can add a DNS server at that time. You can add additional DNS servers and a WINS server to Citrix Gateway by using a session profile. You can then direct users and groups to connect to a name resolution server that is different from the one you originally used the wizard to configure.

Before configuring an additional DNS server on Citrix Gateway, create a virtual server that acts as a DNS server for name resolution.

### To add a DNS or WINS server within a session profile

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway Policies** and then click **Session**.
2. In the details pane, on the Profiles tab, select a profile and then click **Open**.
3. On the Network Configuration tab, do one of the following:
   - To configure a DNS server, next to DNS Virtual Server, click **Override Global**, select the server and then click **OK**.
   - To configure a WINS server, next to WINS Server IP, click **Override Global**, type the IP address and then click **OK**.
Enabling Proxy Support for User Connections

April 23, 2019

User devices can connect through a proxy server for access to internal networks. Citrix Gateway supports the HTTP, SSL, FTP, and SOCKS protocols. To enable proxy support for user connections, you specify the settings on Citrix Gateway. You can specify the IP address and port used by the proxy server on Citrix Gateway. The proxy server is used as a forward proxy for all further connections to the internal network.

To configure proxy support for user connections

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the Proxy tab, under Proxy Settings, select On.
5. For the protocols, type the IP address and port number and then click OK.

Note: If you select Appliance, you can configure proxy servers that support secure and unsecure HTTP connections only.

After you enable proxy support on Citrix Gateway, you specify configuration details on the user device for the proxy server that corresponds to the protocol.

After you enable proxy support, Citrix Gateway sends the proxy server details to the client Web browser and changes the proxy configuration on the browser. After the user device connects to Citrix Gateway, the user device can communicate with the proxy server directly for connection to the user’s network.

To configure one proxy server to use all protocols for Citrix Gateway

You can configure one proxy server to support all of the protocols that Citrix Gateway uses. This setting provides one IP address and port combination for all of the protocols.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the Proxy tab, under Proxy Settings, select On.
5. For the protocols, type the IP address and port number.
6. Click Use the same proxy server for all protocols and then click OK.
When you disable split tunneling and set all proxy settings to On, proxy settings are propagated to user devices. If proxy settings are set to Appliance, the settings are not propagated to user devices.

Citrix Gateway makes connections to the proxy server on behalf of the user device. The proxy settings are not propagated to the user’s browser, so no direct communication between the user device and the proxy server is possible.

To configure the Citrix Gateway to be a proxy server

When you configure Citrix Gateway as a proxy server, unsecure and secure HTTP are the only supported protocols.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the Proxy tab, under Proxy Settings, select Appliance.
5. For the protocols, type the IP address and port number and then click OK.

Configuring Address Pools

April 3, 2020

In some situations, users who connect with the Citrix Gateway plug-in need a unique IP address for Citrix Gateway. For example, in a Samba environment, each user connecting to a mapped network drive needs to appear to originate from a different IP address. When you enable address pools (also known as IP pooling) for a group, Citrix Gateway can assign a unique IP address alias to each user.

You configure address pools by using intranet IP addresses. The following types of applications might need to use a unique IP address that is drawn from the IP pool:

- Voice over IP
- Active FTP
- Instant messaging
- Secure shell (SSH)
- Virtual network computing (VNC) to connect to a computer desktop
- Remote desktop (RDP) to connect to a client desktop

You can configure Citrix Gateway to assign an internal IP address to users that connect to Citrix Gateway. Static IP addresses can be assigned to users or a range of IP addresses can be assigned to a group, virtual server, or to the system globally.
Citrix Gateway 13.0

Citrix Gateway allows you to assign IP addresses from your internal network to your remote users. A remote user can be addressed by an IP address on the internal network. If you choose to use a range of IP addresses, the system dynamically assigns an IP address from that range to a remote user on demand.

When you configure address pools, be aware of the following:

- Assigned IP addresses must be routed correctly. To ensure the correct routing, consider the following:
  - If you do not enable split tunneling, make sure that the IP addresses can be routed through network address translation (NAT) devices.
  - Any servers accessed by user connections with intranet IP addresses must have the proper gateways configured to reach those networks.
  - Configure gateways or a static route on Citrix Gateway so that network traffic from user software is routed to the internal network.
- Only contiguous subnet masks can be used when assigning IP address ranges. A subset of a range can be assigned to a lower-level entity. For example, if an IP address range is bound to a virtual server, bind a subset of the range to a group.
- IP address ranges cannot be bound to multiple entities within a binding level. For example, a subset of an address range that is bound to a group cannot be bound to a second group.
- Citrix Gateway does not allow you to remove or unbind IP addresses while they are actively in use by a user session.
- Internal network IP addresses are assigned to users by using the following hierarchy:
  - User’s direct binding
  - Group assigned address pool
  - Virtual server assigned address pool
  - Global range of addresses
- Only contiguous subnet masks can be used in assigning address ranges. However, a subset of an assigned range might be further assigned to a lower-level entity.

A bound global address range can have a range bound to the following:
  - Virtual server
  - Group
  - User

A bound virtual server address range can have a subset bound to the following:
  - Group
  - User

A bound group address range can have a subset bound to a user.

When an IP address is assigned to a user, the address is reserved for the user’s next logon until the address pool range is exhausted. When the addresses are exhausted, Citrix Gateway reclaims the IP address from the user who is logged off from Citrix Gateway the longest.
If an address cannot be reclaimed and all addresses are actively in use, Citrix Gateway does not allow the user to log on. You can prevent this situation by allowing Citrix Gateway to use the mapped IP address as an intranet IP address when all other IP addresses are unavailable.

**Intranet IP DNS registration**

If an intranet IP is allotted to a client machine and after VIP tunnel establishment, VPN plug-in checks if that client machine is domain joined. If the client machine is a domain-joined machine, VPN plug-in initiates the DNS registration process to tie the machine’s host name intranet with the allotted intranet IP address. This registration is reverted before tunnel de-establishment.

For successful DNS registration, make sure that the following nsapimgr knobs are set. Also make sure that the authoritative DNS server is set to allow “non-secure” DNS updates.

- **nsapimgr -ys enable_vpn_dns_override=1**: This flag is sent to the NetScaler Gateway VPN client along with the other configuration parameters. If this flag is unset and when the VPN client intercepts a DNS/WINS request, it sends a corresponding “GET /DNS” http-request to the NetScaler Gateway virtual server over the tunnel to get the resolved IP address. However, if the ‘enable_vpn_dns_truncate_fix’ flag is set, the VPN client forwards the DNS/WINS requests transparently to the NetScaler Gateway virtual server. In this case, the DNS packet is sent as is to the NetScaler Gateway virtual server over the VPN tunnel. This helps in cases when the DNS records coming back from the name servers configured in the NetScaler Gateway are huge and do not fit in the UPD response packet. In this case, when the client falls back to using TCP-DNS, this TCP-DNS packet reaches NetScaler Gateway server as is, and hence the NetScaler Gateway server makes a TCP-DNS query to a DNS server.

- **nsapimgr -ys enable_vpn_dns_truncate_fix=1**: This flag is used by the NetScaler Gateway server itself. If this flag is set, NetScaler Gateway overrides destination for the “TCP-connections on DNS-port” to the DNS servers configured on NetScaler Gateway (instead of trying to send them to the DNS-server-IP originally present in the incoming TCP-DNS packet). For UDP DNS requests, the default is to use the configured DNS servers for DNS resolution.

For more information on setting these knobs, see [https://support.citrix.com/article/CTX200243](https://support.citrix.com/article/CTX200243).

**Configuring Address Pools**

April 23, 2019

You use the configuration utility to configure address pools at the level to which you want to bind the policy. For example, if you want to create an address pool for a virtual server, configure the intranet IP
addresses on that node. After you configure the address pool, the policy is bound to the entity where it is configured. You can also create an address pool and bind it globally on Citrix Gateway.

**To configure address pools for a user, group, or virtual server**

1. In the configuration utility, in the navigation pane, expand **Citrix Gateway**, do one of the following:
   - Expand **Citrix Gateway User Administration** and then click **AAA Users**.
   - Expand **Citrix Gateway > User Administration** and then click **AAA Groups**.
   - Expand **Citrix Gateway** and then click **Virtual Servers**.
2. In the details pane, click a user, group, or virtual server and then click **Open**.
3. On the **Intranet IPs** tab, in IP Address and Netmask, type the IP address and subnet mask and then click **Add**.
4. Repeat Step 3 for each IP address you want to add to the pool and then click **OK**.

**To configure address pools globally**

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway** and then click **Global Settings**.
2. In the details pane, under **Intranet IPs**, click **To assign a unique, static IP Address or pool of IP Addresses for use by all client Citrix Gateway sessions, configure Intranet IPs**.
3. In the **Bind Intranet IPs** dialog box, click **Action** and then click **Insert**.
4. In IP Address and Netmask, type the IP address and subnet mask and then click **Add**.
5. Repeat Step 3 and 4 for each IP address you want to add to the pool and then click **OK**.

**Defining address pool options**

**April 23, 2019**

You can use a session policy or the global Citrix Gateway settings to control whether or not intranet IP addresses are assigned during a user session. Defining address pool options allows you to assign intranet IP addresses to Citrix Gateway, while disabling the use of intranet IP addresses for a particular group of users.

You can configure address pools by using a session policy in one of the following three ways:

- **Nospillover** - When you configure address pools for intranet IP address, you get a session with an available IP from the pool. For users who have used all available intranet IP addresses, the Transfer Login page appears.
• Spillover - When you configure address pools and the mapped IP is used as an intranet IP address, the mapped IP address is used for users who have used all available intranet IP addresses.
• Off - Address pools are not configured.

Note: If the mapped IP address is not configured then SNIP is used.

To configure address pools

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Network Configuration tab, click Advanced.
7. Next to Intranet IP, click Override Global and then select an option.
8. If you select SPILLOVER in Step 9, next to Mapped IP, click Override Global, select the host name of the appliance, click OK and then click Create.
9. In the Create Session Policy dialog box, create an expression, click Create and then click Close.

Configuring the transfer login page

If a user does not have an intranet IP address available and then tries to establish another session with Citrix Gateway, the Transfer Login page appears. The Transfer Login page allows users to replace their existing Citrix Gateway session with a new session.

The Transfer Login page can also be used if the logoff request is lost or if the user does not perform a clean logoff. For example:

• A user is assigned a static intranet IP address and has an existing Citrix Gateway session. If the user tries to establish a second session from a different device, the Transfer Login page appears and the user can transfer the session to the new device.
• A user is assigned five intranet IP addresses and has five sessions through Citrix Gateway. If the user tries to establish a sixth session, the Transfer Login page appears and the user can choose to replace an existing session with a new session.

Note: If the user does not have an assigned IP address available and a new session cannot be established by using the Transfer Login page, the user receives an error message.

The Transfer Login page appears only if you configure address pools and disable spillover.
Configuring a DNS suffix

When a user logs on to Citrix Gateway and is assigned an IP address, a DNS record for the user name and IP address combination is added to the Citrix Gateway DNS cache. You can configure a DNS suffix to append to the user name when the DNS record is added to the cache. This allows users to be referenced by the DNS name, which can be easier to remember than an IP address. When the user logs off from Citrix Gateway, the record is removed from the DNS cache.

To configure a DNS suffix

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway > Policies** and then click **Session**.
2. In the details pane, on the **Policies** tab, select a session policy and then click **Open**.
3. Next to Request Profile, click **Modify**.
4. On the **Network Configuration** tab, click **Advanced**.
5. Next to Intranet IP DNS Suffix, click **Override Global**, type the DNS suffix and then click **OK** three times.

Supporting VoIP Phones

April 23, 2019

When you install Citrix Gateway as a standalone appliance and users connect with the Citrix Gateway plug-in, Citrix Gateway supports two-way communication with Voice over IP (VoIP) softphones.

Real-time applications, such as voice and video, are implemented over User Datagram Protocol (UDP). Transmission Control Protocol (TCP) is not appropriate for real-time traffic due to the delay introduced by acknowledgments and retransmission of lost packets. It is more important to deliver packets in real time than to ensure that all packets are delivered. However, with any tunneling technology over TCP, such real-time performances cannot be met.

Citrix Gateway supports the following VoIP softphones.

- Cisco Softphone
- Avaya IP Softphone

Secure tunneling is supported between the IP PBX and the softphone software running on the user device. To enable the VoIP traffic to traverse the secure tunnel, you must install the Citrix Gateway plug-in and one of the supported softphones on the same user device. When the VoIP traffic is sent over the secure tunnel, the following softphone features are supported:
• Outgoing calls that are placed from the IP softphone
• Incoming calls that are placed to the IP softphone
• Bidirectional voice traffic

Support for VoIP softphones is configured by using intranet IP addresses. You must configure an intranet IP address for each user. If you are using Cisco Softphone Communication, after configuring the intranet IP address and binding it to a user, no additional configuration is required. For more information about configuring an intranet IP address, see Configuring Address Pools.

If you enable split tunneling, create an intranet application and specify the Avaya Softphone application. In addition, you must enable transparent interception.

Configuring Application Access for the Citrix Gateway plug-in for Java

April 23, 2019

You can configure the access level and the applications users are allowed to access in the secure network. If users are logged on by using the Citrix Gateway plug-in for Java, in the Secure Access Remote Session dialog box, users can click Applications. The Intranet Applications dialog box appears and lists all of the applications the user is authorized to access.

When users are connected with the Citrix Gateway plug-in for Java, you can configure one of two methods that allow users to access applications.

• HOSTS File Modification method
• SourceIP and SourcePort method

Accessing Applications by Using the HOSTS File Modification Method

When you use the HOSTS File Modification method, the Citrix Gateway plug-in for Java adds an entry that corresponds to the applications that you configure in the HOSTS file. To modify this file on a Windows-based device, you must be logged on as an administrator or have administrator privileges. If you are not logged on with administrator privileges, manually edit the HOSTS file and add the appropriate entries.

Note: On a Windows-based computer, the HOSTS file is located in the following directory path: %systemroot%\system32\drivers\etc. On a Macintosh or Linux computer, the HOSTS file is located at /etc/hosts.

For example, you want to use Telnet to connect to a computer in the secure network. You use the remote computer to work both within your secure network and remotely—for example, from home.
The IP address should be the localhost IP address, 127.0.0.1. In the HOSTS file, you add the IP address and the application name, such as:

127.0.0.1 telnet1

When the HOSTS file is edited and saved on the user device, you test your connection. You can test your connection by opening a command prompt and using Telnet to connect. If users are employing a user device that is not within the secure network, log on to Citrix Gateway before starting Telnet.

To connect to a computer in the secure network:

1. Start a Telnet session using the available software for your computer.
2. From a command prompt, type: Open telnet
   The logon prompt of the remote computer appears.

**Accessing Applications by Using the SourceIP and SourcePort Method**

If users need to access an application in the secure network and do not have administrative rights on the user device, configure the HOSTS file by using the source IP address and port number that is located in the Intranet Applications dialog box.

To open the Intranet Applications dialog box and locate the IP address and port number:

1. When users log on with the plug-in, in the Secure Remote Access dialog box, click Applications.
2. Find the application in the list and note the SourceIP address and SourcePort number.

When you have the IP address and port number, start a Telnet session to connect to the computer in the remote network.

**Configuring the Access Interface**

April 23, 2019

Citrix Gateway includes a default home page that is a web page that appears after users log on. The default home page is called the Access Interface. You use the Access Interface as the home page, or configure the Web Interface as the home page, or a custom home page.

The Access Interface contains three panels. If you have the Web Interface in your deployment, users can log on to Receiver in the left panel of the Access Interface. If you have StoreFront in your deployment, users cannot log on to Receiver from the left panel.

The Access Interface is used to provide links to web sites, both internal and external, and links to file shares in the internal network. You can customize the Access Interface in the following ways:
• Changing the Access Interface.
• Creating Access Interface links.

Users can customize the Access Interface as well by adding their own links to web sites and file shares. Users can also use the home page to transfer files from the internal network to their device.

Note: When users log on and attempt to open file shares from the Access Interface, the file share does not open and users receive the error message “Failed to make TCP connection to the server.” To resolve this problem, configure your firewall to allow traffic from the Citrix Gateway system IP address to the file server IP address on TCP ports 445 and 139.

Replacing the Access Interface with a Custom Home Page

April 23, 2019

You can use either global settings or a session policy and profile to configure a custom home page to replace the default home page, the Access Interface. After you configure the policy, you can bind the policy to a user, group, virtual server, or globally. When you configure a custom home page, the Access Interface does not appear when users log on.

To configure custom home page globally

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway** and then click **Global Settings**.
2. In the details pane, under **Settings**, click Change global settings.
3. On the **Client Experience** tab, in **HomePage**, click **Display HomePage** and then enter the web address of your custom home page.
4. Click **OK** and then click **Close**.

To configure a custom home page in a session profile

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway Policies** and then click **Session**.
2. In the details pane, on the **Policies** tab, click **Add**.
3. In **Name**, type a name for the policy.
4. Next to **Request Profile**, click **New**.
5. In **Name**, type a name for the profile.
6. On the **Client Experience** tab, next to **Home Page**, click **Override Global**, click **Display HomePage** and then type the web address of the home page.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

Changing the Access Interface

April 23, 2019

You might want to direct users to a customized home page, rather than relying on the Access Interface. To do this, install the home page on Citrix Gateway and then configure the session policy to use the new home page.

To install a customized home page

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Customize Access Interface, click Upload the Access Interface.
3. To install the home page from a file on a computer in your network, in Local File, click Browse, navigate to the file and then click Select.
4. To use a home page that is installed on Citrix Gateway, in Remote Path, click Browse, select the file and then click Select.
5. Click Upload and then click Close.

Creating and Applying Web and File Share Links

April 23, 2019

You can configure the Access Interface to display a set of links to internal resources that are available to users. Creating these links requires that you first define the links as resources. Then, you bind them to a user, group, virtual server, or globally to make them active in the Access Interface. The links you create appear on the Web Sites and File Shares panes under Enterprise Web Sites and Enterprise File Shares. If users add their own links, these links appear under Personal Web Sites and Personal File Shares.

To create an Access Interface link in a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Resources and then click Portal Bookmarks.
2. In the details pane, click **Add**.
3. In **Name**, type a name for the bookmark.
4. In **Text to display**, type the description of the link. The description appears in the **Access Interface**.
5. In **Bookmark**, type the web address, click **Create** and then click **Close**.

If you enable clientless access, you can make sure that requests to web sites go through Citrix Gateway. For example, you added a bookmark for Google. In the Create Bookmark dialog box, select the Use Citrix Gateway as a reverse proxy check box. When you select this check box, web site requests go from the user device to Citrix Gateway and then to the web site. When you clear the check box, requests go from the user device to the web site. This check box is only available if you enable clientless access.

**To bind bookmarks globally**

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway** and then click **Global Settings**.
2. In the details pane, under **Bookmarks**, click **Create** links to the HTTP and Windows File Share applications that you want to make accessible on the **Citrix Gateway** portal page.
3. In the **Configure VPN Global Binding** dialog box, click **Add**.
4. Under **Available**, select one or more bookmarks, click the right arrow to move the bookmarks under **Configured** and then **OK**.

**To bind an Access Interface link**

You can bind Access Interface links to the following locations:

- Users
- Groups
- Virtual servers

After you save the configuration, the links are available to users in the Access Interface on the Home tab, which is the first page that users see after they successfully log on. The links are organized on the page according to type, as web site links or as file share links.

1. In the configuration utility, in the navigation pane, do one of the following:
   - Expand **Citrix Gateway User Administration** and then click **AAA Users**.
   - Expand **Citrix Gateway User Administration** and then click **AAA Groups**.
   - Expand **Citrix Gateway** and then click **Virtual Servers**.
2. In the details pane, do one of the following:
   - Select a user and then click Open.
   - Select a group and then click Open.
   - Select a virtual server and then click Open.
3. In the dialog box, click the **Bookmarks** tab.

4. Under **Available Bookmarks**, select one or more bookmarks, click the right arrow to move the bookmarks under **Configured Bookmarks** and then **OK**.

## Configuring User Name Tokens in Bookmarks

April 23, 2019

You can configure bookmark and file share URLs using a special token, `%username%`. When users log on, the token is replaced with each users’ logon name. For example, you create a bookmark for an employee named Jack for a folder as `\EmployeeServer\%username\`. When Jack logs on, the file share URL is mapped to `\EmployeeServer\Jack\`. When you configure user name tokens in bookmarks, keep the following situations in mind:

- If you are using one authentication type, the user name replaces the token `%username%`.
- If you are using two-factor authentication, the user name from the primary authentication type is used to replace the `%username%` token.
- If you are using client certificate authentication, the user name field in the client certificate authentication profile is used to replace the `%username%` token.

## How a Traffic Policy Works

April 23, 2019

Traffic policies allow you to configure the following settings for user connections:

- Enforcing shorter time-outs for sensitive applications that are accessed from untrusted networks.
- Switching network traffic to use TCP for some applications. If you select TCP, you need to enable or disable single sign-on for certain applications.
- Identifying situations where you want to use other HTTP features for Citrix Gateway plug-in traffic.
- Defining the file extensions that are used with file type association.

## Creating a Traffic Policy

April 23, 2019
To configure a traffic policy, you create a profile and configure the following parameters:

- Protocol (HTTP or TCP)
- Application time-out
- Single sign-on to web applications
- Form single sign-on
- File type association
- Repeater plug-in
- Kerberos Constrained Delegated (KCD) accounts

After you create the traffic policy, you can bind the policy to virtual servers, users, groups, or globally.

For example, you have the web application PeopleSoft Human Resources installed on a server in the internal network. You can create a traffic policy for this application that defines the destination IP address, the destination port, and you can set the amount of time a user can stay logged on to the application, such as 15 minutes.

If you want to configure other features, such as HTTP compression to an application, you can use a traffic policy to configure the settings. When you create the policy, use the HTTP parameter for the action. In the expression, create the destination address for the server running the application.

**To configure a traffic policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Traffic.
2. In the details pane, on the Policies tab, click Add.
3. In the Create Traffic Policy dialog box, in Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. In Protocol, select either HTTP or TCP.

   **Note:** If you select TCP as the protocol, you cannot configure single sign-on and the setting is disabled in the profile dialog box.

7. In AppTimeout (minutes), type the number of minutes. This setting limits the time users can stay logged on to the web application.
8. To enable single sign-on to the web application, in Single Sign-On, select ON.

   **Note:** If you want to use form-based single sign-on, you can configure the settings within the traffic profile. For more information, see Configuring Form-Based Single Sign-On.
9. To specify a file type association, in File Type Association, select ON.

10. To use the Repeater plug-in to optimize network traffic, in Branch Repeater, select ON, click Create and then click Close.

11. If you configure KCD on the appliance, in KCD Account, select the account.
    
    For more information about configure KCD on the appliance, see Configuring Kerberos Constrained Delegation on a NetScaler Appliance.

12. In the Create Traffic Policy dialog box, create or add an expression, click Create and then click Close.

## Configuring Form-Based Single Sign-On

**August 21, 2019**

Form-based single sign-on allows users to log on one time to all protected applications in your network. When you configure form-based single sign-on in Citrix Gateway, users can access web applications that require an HTML form-based logon without having to type their password again. Without single sign-on, users are required to log on separately to access each application.

After creating the form single sign-on profile, you then create a traffic profile and policy that includes the form single sign-on profile. For more information, see Creating a Traffic Policy.

### To configure form-based single sign-on

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Traffic.

2. In the details pane, click the Form SSO Profiles tab and then click Add.

3. In Name, type a name for the profile.

4. In Action URL, type the URL to which the completed form is submitted.
   
   **Note:** The URL is the root relative URL.

5. In User Name Field, type the name of the attribute for the user name field.

6. In Password Field, type the name of the attribute for the password field.

7. In SSO Success Rule, create an expression that describes the action that this profile takes when invoked by a policy. You can also create the expression by using the Prefix, Add, and Operator buttons under this field.

   This rule checks if single sign-on is successful or not.
8. In Name Value Pair, type the user name field value, followed by an ampersand (&), and then the password field value.

   Value names are separated by an ampersand (&), such as name1=value1&name2=value2.

9. In Response Size, type the number bytes to allow for the complete response size. Type the number of bytes in the response to be parsed for extracting the forms.

10. In Extraction, select if the name/value pair is static or dynamic. The default setting is Dynamic.

11. In Submit Method, select the HTTP method used by the single sign-on form to send the logon credentials to the logon server. The default is Get.

12. Click Create and then click Close.

### Configuring SAML Single Sign-On

April 23, 2019

You can create a SAML 1.1 or SAML 2.0 profile for single sign-on (SSO). Users can connect to web applications that support the SAML protocol for single sign-on. Citrix Gateway supports the identity provider (IdP) single sign-on for SAML web applications.

#### To configure SAML single sign-on

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Traffic.
2. In the details pane, click the SAML SSO Profile tab.
3. In the details pane, click Add.
4. In Name, type a name for the profile.
5. In Signing Certificate Name, enter the name of the X.509 certificate.
6. In ACS URL, enter the assertion consumer service of the identity provider or service provider. The AssertionConsumerServiceURL (ACS URL) provides SSO capability for users.
7. In Relay State Rule, build the expression for the policy from Saved Policy Expressions and Frequently Used Expressions. Select from the Operator list to define how the expression is evaluated. To test the expression, click Evaluate.
8. In Send Password select ON or OFF.
9. In Issuer Name enter the identity for the SAML application.
10. Click Create and then click Close.
**Binding a Traffic Policy**

April 23, 2019

You can bind traffic policies to virtual servers, groups, users, and to Citrix Gateway Global. You can use the configuration utility to bind a traffic policy.

**To bind a traffic policy globally by using the configuration utility**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Traffic.
2. In the details pane, select a policy and then in Action, click Global Bindings.
3. In the Bind / Unbind Traffic Policies dialog box, under Details, click Insert Policy.
4. Under Policy Name, select the policy and then click OK.

**Removing Traffic Policies**

April 23, 2019

You can use either the configuration utility to remove traffic policies from Citrix Gateway. If you use the configuration utility to remove a traffic policy and the policy is bound to the user, group, or virtual server level, you must first unbind the policy. Then, you can remove the policy.

**To unbind a traffic policy by using the configuration utility**

1. In the configuration utility, in the navigation pane, do one of the following:
   - Expand Citrix Gateway and then click Virtual Servers.
   - Expand Citrix Gateway > User Administration and then click AAA Groups.
   - Expand Citrix Gateway > User Administration and then click AAA Users.
2. In the details pane, select a virtual server, group, or user and then click Open.
3. In the configure Citrix Gateway Virtual Server, Configure AAA Group, or Configure AAA User dialog box, click the Policies tab.
4. Click Traffic, select the policy and then click Unbind Policy.
5. Click OK and then click Close.

After the traffic policy is unbound, you can remove the policy.
To remove a traffic policy by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Traffic.
2. In the details pane, on the Policies tab, select the traffic policy and then click Remove.

Configuring Session Policies

September 10, 2019

A session policy is a collection of expressions and settings that are applied to users, groups, virtual servers, and globally.

You use a session policy to configure the settings for user connections. You can define settings to configure the software users log on with, such as the Citrix Gateway plug-in for Windows or the Citrix Gateway plug-in for Mac. You can also configure settings to require users to log on with Citrix Workspace app or Secure Hub. Session policies are evaluated and applied after the user is authenticated.

Session policies are applied according to the following rules:

- Session policies always override global settings in the configuration.
- Any attributes or parameters that are not set using a session policy are set on policies established for the virtual server.
- Any other attributes that are not set by a session policy or by the virtual server are set by the global configuration.

Important: The following instructions are general guidelines for creating session policies. There are specific instructions for configuring session policies for different configurations, such as clientless access or for access to published applications. The instructions might contain directions for configuring a specific setting; however, that setting can be one of many settings that are contained within a session profile and policy. The instructions direct you to create a setting within a session profile and then apply the profile to a session policy. You can change settings within a profile and policy without creating a new session policy. In addition, you can create all of your settings on a global level and then create a session policy to override global settings.

If you deploy Citrix Endpoint Management or StoreFront in your network, Citrix recommends using the Quick Configuration wizard to configure session policies and profiles. When you run the wizard, you define the settings for your deployment. Citrix Gateway then creates the required authentication, session and clientless access policies.
To create a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. Complete the settings for the session profile and then click Create.
7. In the Create Session Profile dialog box, add an expression for the policy, click Create and then click Close.
   Note: In the expression, select True value so the policy is always applied to the level to which it is bound.

Creating a Session Profile

September 10, 2019

A session profile contains the settings for user connections.

Session profiles specify the actions that are applied to a user session if the user device meets the policy expression conditions. Profiles are used with session policies. You can use the configuration utility to create session profiles separately from a session policy and then use the profile for multiple policies. You can only use one profile with a policy.

Configuring Network Settings for User Connections in a Session Profile

You can use the Network Configuration tab in the session profile to configure the following network settings for user connections:

- DNS server
- WINS server IP address
- Mapped IP address that you can use as an intranet IP address
- Spillover settings for address pools (intranet IP addresses)
- Intranet IP DNS suffix
- HTTP ports
- Forced time-out settings
**Configuring Connection Settings in a Session Profile**

You can use the Client Experience tab in the session profile to configure the following connection settings:

- Access Interface or customized home page
- Web address for web-based email, such as Outlook Web Access
- plug-in type (Citrix Gateway plug-in for Windows, Citrix Gateway plug-in for Mac OS X, or Citrix Gateway plug-in for Java)
- Split tunneling
- Session and idle time-out settings
- Clientless access
- Clientless access URL encoding
- plug-in type (Windows, Mac, or Java)
- Single sign-on to web applications
- Credential index for authentication
- Single sign-on with Windows
- Client cleanup behavior
- Logon scripts
- Client debug settings
- Split DNS
- Access to private network IP addresses and local LAN access
- Client choices
- Proxy settings

For more information about configuring settings for user connections, see **Configuring Connections for the Citrix Gateway plug-in**.

**Configuring Security Settings in a Session Profile**

You can use the Security tab in a session profile to configure the following security settings:

- Default authorization action (allow or deny)
- Secure Browse for connections from iOS devices
- Quarantine groups
- Authorization groups

For more information about configuring authorization on Citrix Gateway, see **Configuring Authorization**.
Configuring Citrix Virtual Apps and Desktops Settings in a Session Profile

You can use the Published Applications tab in a session profile to configure the following settings for connections to servers running Citrix Virtual Apps and Desktops:

- ICA proxy, which are client connections using Citrix Workspace app
- Web Interface address
- Web Interface portal mode
- Single sign-on to the server farm domain
- Citrix Workspace app home page
- Account Services Address

For more information about configuring settings for connecting to published applications in a server farm, see Providing Access to Published Applications and Virtual Desktops Through the Web Interface.

You can create session profiles independently of a session policy. When you create the policy, you can select the profile to attach to the policy.

To create a session profile by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, click the Profiles tab and then click Add.
3. Configure the settings for the profile, click Create and then click Close.

After you create a profile, you can include it in a session policy.

To add a profile to a session policy by using the configuration utility

1. In the configuration utility, in the navigation pane, expand Access Gateway > Policies and then click Session.
2. On the Policies tab, do one of the following:
   - Click Add to create a new session policy.
   - Select a policy and then click Open.
3. In Request Profile, select a profile from the list.
4. Finish configuring the session policy and then do one of the following:
   a) Click Create and then click Close to create the policy.
   b) Click OK and then click Close to modify the policy.
Binding Session Policies

April 23, 2019

After you create a session policy, bind it to a user, group, virtual server, or globally. Session policies are applied as a hierarchy in the following order:

• Users
• Groups
• Virtual servers
• Globally

To bind a session policy by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then do one of the following:
   a) Click Virtual Servers.
   b) Expand User Administration and then click AAA Groups.
   c) Expand User Administration and then click AAA Users.
2. Depending on your selection in Step 1, click the Policies tab in one of the following dialog boxes:
   • Create Citrix Gateway Virtual Server
   • Configure AAA Group
   • Configure AAA Users
3. Click Session to add the session policy.
4. Click Insert Policy, select the session policy and then click OK.

Configure Citrix Gateway Session Policies for StoreFront

February 28, 2020

This article describes how to configure a Citrix Gateway domain only authentication with StoreFront for users who are using Citrix Workspace app or a web browser.
Minimum requirements

- Citrix StoreFront 2.x or 3.0
- Citrix ADC 10.5 and higher
- Citrix Workspace app for Windows 4.x
- Citrix Workspace app for Mac 11.8
- Web browser (Citrix Workspace app for Web)
- Authentication configured on the Citrix ADC appliance as outlined in CTX108876 - How to Configure LDAP Authentication on a Citrix ADC appliance
- SSL Certificates configured for StoreFront Server and Citrix Gateway. For details on the following topics, see StoreFront Documentation.
  - Install and set up for StoreFront 2.6
    - Windows 2012 Server Certificates
    - To add an SSL binding to a site
    - Installing and Managing Certificates for Citrix ADC appliance 10.5

Configure Citrix Gateway with StoreFront
Create a session policy for web browser based access

1. To create session policy, navigate to Citrix Gateway > Policies > Session.

2. In the Session Policies field, click Add.

3. In the Name field, type the name of the Session Policy. For example, Web_Browser_Policy.

4. Click the box with the + sign.

5. Type in the name of the new Session Profile in the Configure Citrix Gateway Session Profile window.

6. In the Client Experience tab, enable the following settings:
   - Clientless Access: set to On
   - Single sign-on to Web Application: Select the check box
   - Plug-in Type: Set to Windows/MAC OS X
Unchecked Override Global check box indicates that the value is inherited from Global Citrix Gateway Parameters.

<table>
<thead>
<tr>
<th>Network Configuration</th>
<th>Client Experience</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Policy</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Home Page</td>
<td></td>
</tr>
<tr>
<td>Home Page</td>
<td></td>
</tr>
<tr>
<td>URL for Web-Based Email</td>
<td></td>
</tr>
<tr>
<td>Split Tunnel*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Override Global</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Session Time-out (mins)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Override Global</td>
</tr>
<tr>
<td>Client Idle Time-out (mins)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Override Global</td>
</tr>
<tr>
<td>Clientless Access*</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Override Global</td>
</tr>
<tr>
<td>Clientless Access URL Encoding*</td>
<td></td>
</tr>
<tr>
<td>Obscure</td>
<td>Override Global</td>
</tr>
<tr>
<td>Clientless Access Persistent Cookie*</td>
<td></td>
</tr>
<tr>
<td>DENY</td>
<td>Override Global</td>
</tr>
<tr>
<td>Advanced Clientless VPN Mode*</td>
<td></td>
</tr>
<tr>
<td>DISABLED</td>
<td>Override Global</td>
</tr>
<tr>
<td>Plug-in Type*</td>
<td></td>
</tr>
<tr>
<td>Java</td>
<td>Override Global</td>
</tr>
<tr>
<td>Windows Plugin Upgrade</td>
<td></td>
</tr>
<tr>
<td>Always</td>
<td>Override Global</td>
</tr>
<tr>
<td>Linux Plugin Upgrade</td>
<td></td>
</tr>
<tr>
<td>Always</td>
<td>Override Global</td>
</tr>
<tr>
<td>MAC Plugin Upgrade</td>
<td></td>
</tr>
<tr>
<td>Always</td>
<td>Override Global</td>
</tr>
</tbody>
</table>
7. In the **Security** tab, enable **Default Authorization Actions** and set it to **ALLOW**.

8. In the **Published Application** tab, enable the following settings:
   - **ICA Proxy**: Set to ON.
• **Web Interface Address**: FQDN of the StoreFront server followed by the path to the store for web

• **Single Sign-on Domain**: NetBIOS name for the domain

9. Click **Create**.

10. If you are using Classic Policy expression, in the **Expression** field, add the following information and click **Create**.

   ```
   REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver
   ```

11. If using Advanced Policy expression, in the **Expression** field, add the following information and click **Create**.

   ```
   HTTP.REQ.HEADER("User-Agent").CONTAINS("CitrixReceiver").NOT
   ```
This policy is needed for the Citrix ADC to differentiate between web browser based and Citrix Workspace app based connections. This policy is applied to web browser based connections.

Create a session policy for Citrix Workspace app for Windows or Mac, and Mobile Devices on Citrix Gateway

1. Navigate to Citrix Gateway > Policies > Session.
2. In the Session Policies field, click Add.
3. In the Name field, type the name of the session policy. For example, Receiver_Policy
4. Click the box with the + sign.
5. Type in the name of the new session profile in the Configure Citrix Gateway Session Profile window.
6. In the **Client Experience** tab, enable the following settings:
- **Home Page**: Set to **None**
- **Split Tunnel**: Set to **OFF**
- **Clientless Access**: Set to **On**
- **Single Sign-on to Web Application**: Select the check box
- **Plug-in Type**: Set to **Java**
7. In the **Security** tab, set **Default Authorization Actions** to **ALLOW**.

8. In the **Published Application** tab, enable the following settings:
   - **ICA Proxy**: Set to ON.
   - **Web Interface Address**: FQDN of the StoreFront server followed by the path to the store
- **Single Sign-on Domain**: NetBIOS name for the domain
- **Account Services Address**: Enter the account services address. The last back slash is important.

![Receiver_Profile](image)

Unchecked Override Global check box indicates that the value is inherited from Global Citrix Gateway Parameters.

<table>
<thead>
<tr>
<th>Network Configuration</th>
<th>Client Experience</th>
<th>Security</th>
<th>Published Applications</th>
<th>Remote Desktop</th>
<th>PCoIP</th>
</tr>
</thead>
</table>

- ICA Proxy
  - **OFF**

- Web Interface Address

- Web Interface Address Type

- Web Interface Portal Mode

- Single Sign-on Domain

- Citrix Receiver Home Page

- Account Services Address

| OK | Close |

9. Click **Create**.

10. If using Classic Policy expression, in the **Expression** field, add the following information and click **Create**.

   ```
   REQ.HTTP.HEADER User-Agent CONTAINS CitrixReceiver
   ```
11. If using Advanced Policy expression, in the **Expression** field, add the information listed below and click **Create**.

```
1 HTTP.REQ.HEADER("User-Agent").CONTAINS("CitrixReceiver")
```

This policy is needed for the Citrix ADC to differentiate between the web browser based and Citrix Workspace app based connections. This policy is applied for Citrix Workspace app based connections.

**Configure authentication on the Citrix ADC appliance**

For information about configuring LDAP authentication on a Citrix ADC appliance, see [Configuring LDAP Authentication](#).

**Create Citrix Gateway virtual server and bind the session policies**

1. Navigate to **Citrix Gateway > Virtual Server** and click **Add** to add a new virtual server.
2. After the virtual server is created, bind the specific session policy to the virtual server based on your company's requirements.

Configure authentication for StoreFront

1. Enable the pass-through authentication from Citrix Gateway on StoreFront. For more information, see Configure the authentication service.

   StoreFront must trust the issuer of the Citrix Gateway virtual server’s bound certificate (Root and/or Intermediate certificates) for the Authentication Callback service.

2. Add Citrix Gateway to StoreFront. For more information, see Add a Citrix Gateway connection.

   The Gateway URL must match exactly with what the users are typing into the web browser address bar.

3. Enable remote access on the StoreFront store. For more information, see Manage remote access to stores through Citrix Gateway.

Advanced policy support for Enterprise bookmarks

May 13, 2019
Enterprise bookmarks (VPN URL) can now be configured as an advanced policy.

**Configure VPN URL as an advanced policy**

To configure VPN URL as an advanced policy, the following tasks need to be performed.

- Create a VPN URL action
- Create VPN URL policy
- Bind the policy to bind point

**Create a VPN URL action**

At the command prompt, type the following:

```
1 add vpn urlAction <name> -linkName <string> -actualURL <string> [-vServerName <string>] [-clientlessAccess ( ON | OFF )] [-comment <string>] [-iconURL <URL>] [-ssotype <ssotype>] [-applicationtype <applicationtype>] [-samlSSOProfile <string>]
```

**Create a VPN URL action**

At the command prompt, type the following:

```
1 add vpn urlAction <name> -linkName <string> -actualURL <string> [-vServerName <string>] [-clientlessAccess ( ON | OFF )] [-comment <string>] [-iconURL <URL>] [-ssotype <ssotype>] [-applicationtype <applicationtype>] [-samlSSOProfile <string>]
```

**Create a VPN URL action**

At the command prompt, type the following:

```
1 add vpn urlAction <name> -linkName <string> -actualURL <string> [-vServerName <string>] [-clientlessAccess ( ON | OFF )] [-comment <string>] [-iconURL <URL>] [-ssotype <ssotype>] [-applicationtype <applicationtype>] [-samlSSOProfile <string>]
```
Following operations for VPN URL action are supported

- add

```bash
add vpn urlAction <name> [-linkName <string>] [-actualURL <string>] [-vServerName <string>] [-clientlessAccess (ON | OFF)] [-comment <string>] [-iconURL <URL>] [-ssotype <ssotype>] [-applicationtype <applicationtype>] [-samlSSOProfile <string>]
```

- set

```bash
set vpn urlAction <name> [-vServerName <string>] [-clientlessAccess (ON | OFF)] [-comment <string>] [-iconURL <URL>] [-ssotype <ssotype>] [-applicationtype <applicationtype>] [-samlSSOProfile <string>]
```

- unset

```bash
```

- show

```bash
show vpn urlAction <name>
```

- remove

```bash
remove vpn urlAction <name>
```

- rename

```bash
rename vpn urlAction <name>@<newName>@
```

Following operations for VPN URL policy are supported

- add

```bash
add vpn urlPolicy <name> [-rule <expression>] [-action <string>] [-comment <string>] [-logAction <string>]
```

- set

```bash
set vpn urlPolicy <name> [-rule <expression>] [-action <string>] [-comment <string>] [-logAction <string>]
```
Citrix Gateway 13.0

- **unset**
  
  ```
  1  unset vpn urlPolicy <name> [-comment] [-logAction]
  ```

- **show**
  
  ```
  1  show vpn urlPolicy [<<name>>]
  ```

- **remove**
  
  ```
  1  remove vpn urlPolicy <name>
  ```

- **rename**
  
  ```
  1  rename vpn urlpolicy <name>@ <newName>@
  ```

- **stat**
  
  ```
  1  stat vpn urlpolicy [<<name>>] [-detail] [-fullValues] [-ntimes <positive_integer>] [-logFile <input_filename>] [-clearstats (basic | full)]
  ```

- **bind**
  
  ```
  1  bind vpn vserver <vserver name> -policy <string> -priority <positive_integer> [-gotoPriorityExpression <expression>]
  2  bind vpn global -policyName <string> -priority <positive_integer> [-gotoPriorityExpression <expression>]
  3  bind aaa user <userName> -policy <string> [-priority <positive_integer>] [-type <type>] [-gotoPriorityExpression <expression>]
  4  bind aaa group <groupName> -policy <string> [-priority <positive_integer>] [-type <type>] [-gotoPriorityExpression <expression>]
  ```

- **unbind**
  
  ```
  1  unbind vpn vserver <name> -policy <string>
  2  unbind vpn global -policyName <string>
  3  unbind aaa user <name> -policy <string>
  4  unbind aaa group <name> -policy <string>
  ```

**Note:** Bind Points are aaaunder, aaagroup, vpnvserver and vpnglobal.
Configuring Endpoint Policies

April 23, 2019

Endpoint analysis is a process that scans a user device and detects information, such as the presence and version level of an operating system, and of antivirus, firewall, or web browser software. You can use endpoint analysis to verify that the user device meets your requirements before allowing it to connect to your network or remain connected after users log on. You can monitor files, processes, and registry entries on the user device during the user session to ensure that the device continues to meet requirements.

How Endpoint Policies Work

April 23, 2019

You can configure Citrix Gateway to check if a user device meets certain security requirements before a user logs on. This is called a preauthentication policy. You can configure Citrix Gateway to check a user device for antivirus, firewall, antispam, processes, files, registry entries, Internet security, or operating systems that you specify within the policy. If the user device fails the preauthentication scan, users are not allowed to log on.

If you need to configure additional security requirements that are not used in a preauthentication policy, you configure a session policy and bind it to a user or group. This type of policy is called a post-authentication policy, which runs during the user session to ensure the required items, such as antivirus software or a process, is still true.

When you configure a preauthentication or post-authentication policy, Citrix Gateway downloads the Endpoint Analysis plug-in and then runs the scan. Each time a user logs on, the Endpoint Analysis plug-in runs automatically.

You use the following three types of policies to configure endpoint policies:

- Preauthentication policy that uses a yes or no parameter. The scan determines if the user device meets the specified requirements. If the scan fails, the user cannot enter credentials on the logon page.
- Session policy that is conditional and can be used for SmartAccess.
- Client security expression within a session policy. If the user device fails to meet the requirements of the client security expression, you can configure users to be placed into a quarantine group. If the user device passes the scan, users can be placed into a different group that might require additional checks.
You can incorporate detected information into policies, enabling you to grant different levels of access based upon the user device. For example, you can provide full access with download permission to users who connect remotely from user devices that have current antivirus and firewall software requirements. For users connecting from untrusted computers, you can provide a more restricted level of access that allows users to edit documents on remote servers without downloading them.

Endpoint analysis performs the following basic steps:

- Examines an initial set of information about the user device to determine which scans to apply.
- Runs all applicable scans. When users try to connect, the Endpoint Analysis plug-in checks the user device for the requirements specified within the preauthentication or session policy. If the user device passes the scan, users are allowed to log on. If the user device fails the scan, users are not allowed to log on.
  Note: Endpoint analysis scans completes before the user session uses a license.
- Compares property values detected on the user device with desired property values listed in your configured scans.
- Produces an output verifying whether or not desired property values are found.

Attention: The instructions for creating endpoint analysis policies are general guidelines. You can have many settings within one session policy. Specific instructions for configuring session policies might contain directions for configuring a specific setting; however, that setting can be one of many settings that are contained within a session profile and policy.

Evaluating User Logon Options

April 23, 2019

When users log on, they can choose to skip the endpoint analysis scan. If users skip the scan, Citrix Gateway processes this action as a failed endpoint analysis. When users fail the scan, they can only have access to the Web Interface or through clientless access.

For example, you want to provide users access by using the Citrix Gateway plug-in. To log on to Citrix Gateway with the plug-in, users must be running an antivirus application, such as Norton Antivirus. If the user device is not running the application, users can log on with Receiver only and use published applications. You can also configure clientless access, which restricts access to specified applications, such as Outlook Web Access.

To configure Citrix Gateway to achieve this logon scenario, you assign a restrictive session policy as the default policy. You then configure the settings to upgrade users to a privileged session policy when the user device passes the endpoint analysis scan. At that point, users have network-layer access and can log on with the Citrix Gateway plug-in.
To configure Citrix Gateway to enforce the restrictive session policy first, perform the following steps:

- Configure the global settings with ICA proxy enabled and all other necessary settings if the specified application is not running on the user device.
- Create a session policy and profile that enables the Citrix Gateway plug-in.
- Create an expression within the rule portion of the session policy to specify the application, such as:

  (client.application.process(symantec.exe) exists)

When users log on, the session policy is applied first. If endpoint analysis fails or the user skips the scan, Citrix Gateway ignores the settings in the session policy (the expression in the session policy is considered false). As a result, users have restricted access using the Web Interface or clientless access. If endpoint analysis passes, Citrix Gateway applies the session policy and users have full access with the Citrix Gateway plug-in.

Setting the Priority of Preauthentication Policies

April 23, 2019

You can have multiple preauthentication policies that are bound to different levels. For example, you have a policy that checks for a specific antivirus application bound to AAA Global and a firewall policy bound to the virtual server. When users log on, the policy that is bound to the virtual server is applied first. The policy that is bound at AAA Global is applied second.

You can change the order in which the preauthentication scans occur. To make Citrix Gateway apply the global policy first, change the priority number of the policy bound to the virtual server, giving it a higher priority number than the policy bound globally. For example, set the priority number for the global policy to one and the virtual server policy to two. When users log on, Citrix Gateway runs the global policy scan first and the virtual server policy scan second.

To change the priority of a preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. On the Policies tab, click Pre-authentication.
4. Under Priority, type the priority number for the policy and then click OK.
Configuring Preauthentication Policies and Profiles

April 23, 2019

Warning
AAA preauthentication policy is deprecated from NetScaler 12.0 build 56.20 onwards and as an alternative, Citrix recommends you to use the Nfactor authentication. For more information, see Multi-Factor (nFactor) Authentication topic.

You can configure Citrix Gateway to check for client-side security before users are authenticated. This method ensures that the user device establishing a session with Citrix Gateway conforms to your security requirements. You configure client-side security checks through the use of preauthentication policies specific to a virtual server or globally, as described in the following two procedures.

Preauthentication policies consist of a profile and an expression. You configure the profile to use an action to allow or deny a process to execute on the user device. For example, the text file, clienttext.txt, is running on the user device. When the user logs on to Citrix Gateway, you can either allow or deny access if the text file is running. If you do not want to allow users to log on if the process is running, configure the profile so the process is stopped before users log on.

You can configure the following settings for pre-authentication policies:

- Expression. Includes the following settings to help you to create expressions:
  - Expression. Displays all of the created expressions.
  - Match Any Expression. Configures the policy to match any of the expressions that are present in the list of selected expressions.
  - Match All Expressions. Configures the policy to match all the expressions that are present in the list of selected expressions.

Tabular Expressions. Creates a compound expression with the existing expressions by using the OR ( ) or AND (&&) operators.
**Advanced Free-Form.** Creates custom compound expressions by using the expression names and the OR ( ) and AND (&&) operators. Choose only those expressions that you require and omit other expressions from the list of selected expressions.

- **Add.** Creates a new expression.
- **Modify.** Modifies an existing expression.
- **Remove.** Removes the selected expression from the compound expressions list.
- **Named Expressions.** Select a configured named expression. You can select named expressions from the drop-down list of expressions already present on Citrix Gateway.
- **Add Expression.** Adds the selected named expression to the policy.
- **Replace Expression.** Replaces the selected named expression to the policy.
- **Preview Expression.** Displays the detailed client security string that will be configured on Citrix Gateway when you select a named expression.

### To configure a preauthentication profile globally by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change pre-authentication settings.
3. In the Global Pre-authentication settings dialog box, configure the settings:
   a) In Action, select Allow or Deny. Denies or allows users to log on after endpoint analysis occurs.
   b) In Processes to be cancelled, enter the process. This specifies the processes to be stopped by the Endpoint Analysis plug-in.
   c) In Files to be deleted, enter the file name. This specifies the files to be deleted by the Endpoint Analysis plug-in.
4. In Expression you can leave the expression ns_true or build an expression for a specific application, such as antivirus or security software and then click OK.

### To configure a preauthentication profile by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, on the Profiles tab, click Add.
3. In Name, type the name of the application to be checked.

4. In Action, select ALLOW or DENY.

5. In Processes to be cancelled, type the name of the process to be stopped.

6. In Files to be deleted, type the name of the file to be deleted, such as c:\clientext.txt, click Create and then click Close.

   Note: If a file is to be deleted or a process stopped, users receive a message asking for confirmation. Steps 5 and 6 are optional parameters.

If you use the configuration utility to configure a preauthentication profile, you then create the preauthentication policy by clicking Add on the Policies tab. In the Create Pre-Authentication Policy dialog box, select the profile from the Request Profile drop-down list.

Configuring Endpoint Analysis Expressions

April 23, 2019

Preauthentication and client security session policies include a profile and an expression. The policy can have one profile and multiple expressions. To scan a user device for an application, file, process, or registry entry, you create an expression or compound expressions within the policy.

Types of Expressions

The expression consists of an expression type and the parameters of the expression. Expression types include:

- General
- Client security
- Network based

Adding Preconfigured Expressions to a Preauthentication Policy

Citrix Gateway comes with pre-configured expressions, called named expressions. When you configure a policy, you can use a named expression for the policy. For example, you want the preauthentication policy to check for Symantec AntiVirus 10 with updated virus definitions. Create a preauthentication policy and add the expression as described in the following procedure.

When you create a preauthentication or session policy, you can create the expression when you create the policy. You can then apply the policy, with the expression, to virtual servers or globally.
The following procedure describes how to add a preconfigured antivirus expression to a policy by using the configuration utility.

**To add a named expression to a preauthentication policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, select a policy and then click Open.
3. Next to Named Expressions, select Anti-Virus, select the antivirus product from the list, click Add Expression, click Create and then click Close.

**Configuring Custom Expressions**

April 23, 2019

A custom expression is one that you create within the policy. When you create an expression, you configure the parameters for the expression.

You can also create custom client security expressions to refer to commonly used client security strings. This eases the process of configuring preauthentication policies and also in maintaining the configured expressions.

For example, you want to create a custom client security expression for Symantec AntiVirus 10 and make sure that the virus definitions are no more than three days old. Create a new policy and then configure the expression to specify the virus definitions.

The following procedure shows how to create a client security policy in a preauthentication policy. You can use the same steps in a session policy.

**To create a preauthentication policy and custom client security expression**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, click Add. The Create Pre-Authentication Policy dialog box opens.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In the Create Authentication Profile dialog box, in Name, type a name for the profile and in Action, select Allow and then click Create.
6. In the Create Pre-Authentication Policy dialog box, next to Match Any Expression, click Add.
7. In Expression Type, select Client Security.
8. Configure the following:
   a) In Component, select Anti-Virus.
   b) In Name, type a name for the application.
   c) In Qualifier, select Version.
   d) In Operator, select ==.
   e) In Value, type the value.
   f) In Freshness, type 3 and then click OK.

9. In the Create Pre-Authentication Policy dialog box, click Create and then click Close.

When you configure a custom expression, it is added to the Expression box in the policy dialog box.

**Configuring Compound Expressions**

April 23, 2019

A preauthentication policy can have one profile and multiple expressions. If you configure compound expressions, you use operators to specify the conditions of the expression. For example, you can configure compound expressions to require the user device to run one of the following antivirus applications:

- Symantec Antivirus 10
- McAfee Antivirus 11
- Sophos Antivirus 4

You configure the expression with the OR operator to check for the preceding three applications. If Citrix Gateway detects the correct version of any of the applications on the user device, users are allowed to log on. The expression in the policy dialog box appears as follows:

```
av_5_Symantec_10
av_5_McAfeeVirus:11
av_5_sophos_4
```

For more information about compound expressions, see Configuring Compound Expressions.

**Binding Preauthentication Policies**

April 23, 2019

After you create the preauthentication or client security session policy, bind the policy to the level to which it applies. You can bind the preauthentication policies to virtual servers or globally.
To create and bind a preauthentication policy globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, click Change pre-authentication settings.
3. In the Global Pre-Authentication Settings dialog box, in Action, select Allow or Deny.
4. In Name, type a name for the policy.
5. In the Global Pre-authentication settings dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

To bind a preauthentication policy to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. In the configure Citrix Gateway Virtual Server dialog box, click the Policies tab and then click Pre-authentication.
4. Under Details, click Insert Policy and then under Policy Name, select the preauthentication policy.
5. Click OK.

Unbinding and Removing Preauthentication Polices

April 23, 2019

You can remove a preauthentication policy from Citrix Gateway if necessary. Before you remove a preauthentication policy, unbind it from the virtual server or globally.

To unbind a global preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, select a policy and then in Action, click Global Bindings.
3. In the Bind/Unbind Pre-authentication Policies to Global dialog box, select a policy, click Unbind Policy and then click OK.
To unbind a preauthentication policy from a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the configure Citrix Gateway Virtual Server dialog box, click the Policies tab and then click Preauthentication.
3. Select the policy and then click Unbind Policy.

When the preauthentication policy is unbound, you can remove the policy from Citrix Gateway.

To remove a preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, select a policy and then click Remove.

Configuring Post-Authentication Policies

September 10, 2019

A post-authentication policy is a set of generic rules that the user device must meet to keep the session active. If the policy fails, the connection to Citrix Gateway ends. When you configure the post-authentication policy, you can configure any setting for user connections that can be made conditional.

Note: This functionality works only with the Citrix Gateway plug-in. If users log on with Citrix Workspace app, the endpoint analysis scan runs at logon only.

You use session policies to configure post-authentication policies. First, you create the users to which the policy applies. Then, you add the users to a group. Next, you bind session, traffic policies, and intranet applications to the group.

You can also specify groups to be authorization groups. This type of group allows you to assign users to groups on the basis of a client security expression within the session policy.

You can also configure a post-authentication policy to put users in a quarantine group if the user device does not meet the requirements of the policy. A simple policy includes a client security expression and a client security message. When users are in the quarantine group, users can log on to Citrix Gateway; however, they receive limited access to network resources.

You cannot create an authorization group and a quarantine group by using the same session profile and policy. The steps for creating the post-authentication policy are the same. When you create the
session policy, you select either an authorization group or a quarantine group. You can create two session policies and bind each policy to the group.

Post-authentication policies are also used with SmartAccess. For more information about SmartAccess, see Configuring SmartAccess on Citrix Gateway.

Configuring a Post-Authentication Policy

April 23, 2019

You use a session policy to configure a post-authentication policy. A simple policy includes a client security expression and a client security message.

To configure a post-authentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
7. Under Client Security, click Override Global and then click New.
8. Configure the client security expression and then click Create.
10. In Error Message, type the message you want users to receive if the post-authentication scan fails.
11. Under Authorization Groups, click Override Global, select a group, click Add, click OK and then click Create.
12. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

Configuring the Frequency of Post-Authentication Scans

September 10, 2019
You can configure Citrix Gateway to run the post-authentication policy at specified intervals. For example, you configured a client security policy and want it to run on the user device every 10 minutes. You can configure this frequency by creating a custom expression within the policy.

**Note:** The frequency check functionality for post-authentication policies works only with the Citrix Gateway plug-in. If users log on with Citrix Workspace app, the endpoint analysis scan runs at logon only.

You can set the frequency (in minutes) when you configure the client security policy by following the procedure **Configuring a Post-Authentication Policy**. The following figure shows where you can enter a frequency value in the Add Expression dialog box.

**Figure 1. Dialog box for configuring the frequency of post-authentication scans**

---

### Configuring Quarantine and Authorization Groups

**April 23, 2019**

When users log on to Citrix Gateway, you assign them to a group that you configure either on Citrix Gateway or on an authentication server in the secure network. If a user fails a post-authentication scan, you can assign the user to a restricted group, called a quarantine group, which restricts access to network resources.

You can also use authorization groups to restrict user access to network resources. For example, you might have a group of contract personnel that has access only to your email server and a file share. When user devices pass the security requirements that you defined on Citrix Gateway, users can become members of groups dynamically.

You use either global settings or session policies to configure quarantine and authorization groups that are bound to a user, group, or virtual server. You can assign users to groups on the basis of a client security expression within the session policy. When the user is a member of a group, Citrix Gateway applies the session policy based on group membership.
Configuring Quarantine Groups

April 23, 2019

When you configure a quarantine group, you configure the client security expression using the Security Settings - Advanced Settings dialog box within a session profile.

To configure the client security expression for a quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
7. Under Client Security, click Override Global and then click New.
8. In the Client Expression dialog box, configure the client security expression and then click Create.
9. In Quarantine Group, select the group.
10. In Error Message, type a message that describes the problem for users and then click Create.
11. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

After you create the session policy, bind it to a user, group, or virtual server.

Note
If the endpoint analysis scan fails and the user is put in the quarantine group, the policies that are bound to the quarantine group are effective only if there are no policies bound directly to the user that have an equal or lower priority number than the policies bound to the quarantine group.

To configure a global quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
5. In Quarantine Group, select the group.
6. In Error Message, type a message that describes the problem for users and then click OK.

Configuring Authorization Groups

April 23, 2019

When you configure an endpoint analysis scan, you can dynamically add users to an authorization group when the user device passes the scan. For example, you create an endpoint analysis scan that checks the user device domain membership. On Citrix Gateway, create a local group called Domain-Joined Computers and add it as an authorization group for anyone who passes the scan. When users join the group, users inherit the policies associated with the group.

You cannot bind authorization policies globally or to a virtual server. You can use authorization groups to provide a default set of authorization policies when users are not configured to be members of another group on Citrix Gateway.

To configure an authorization group by using a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
7. Under Authorization Groups, click Override Global, select a group from the drop-down list, click Add, click OK and then click Create.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

After you create the session policy, you can bind it to a user, group, or virtual server.

To configure a global authorization group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
4. Under Authorization Group, select a group from the drop-down list, click Add and then click OK twice.

If you want to remove an authorization group either globally or from the session policy, in the Security Settings - Advanced dialog box, select the authorization group from the list and then click Remove.

**Configuring Security Preauthentication Expressions for User Devices**

April 23, 2019

Citrix Gateway provides various endpoint security checks during user logon or at other configured times during a session that help in improving security. Only the user devices that pass these security checks are allowed to establish an Citrix Gateway session.

The following are the types of security checks on user devices that you can configure on Citrix Gateway:

- Antispam
- Antivirus
- File policies
- Internet security
- Operating system
- Personal firewall
- Process policies
- Registry policies
- Service policies

If a security check fails on the device, no new connections are made until a subsequent check passes (in the case of checks that are at regular intervals); however, traffic flowing through existing connections continues to tunnel through Citrix Gateway.

You can use the configuration utility to configure preauthentication policies or security expressions within session policies that are designed to carry out security checks on user devices.

**Configuring Antivirus, Firewall, Internet Security, or Antispam Expressions**

April 23, 2019

You configure settings for antivirus, firewall, Internet security, and antispam policies within the Add Expression dialog box. The settings for each policy are the same: the differences are the values that
you select. For example, if you want to check the user device for Norton AntiVirus Version 10 and ZoneAlarm Pro, you create two expressions within the session or preauthentication policy that specify the name and version number of each application.

When you select Client Security as the expression type, you can configure the following:

- **Component**: The type of client security, such as antivirus, firewall, or registry entry.
- **Name**: The name of the application, process, file, registry entry, or operating system.
- **Qualifier**: The version or the value of the component for which the expression checks.
- **Operator**: Checks if the value exists or is equal to the value.
- **Value**: The application version for antivirus, firewall, Internet security, or antispam software on the user device.
- **Frequency**: Frequency with which a post-authentication scan is run, in minutes.
- **Error weight**: A weight assigned to each error message contained in a nested expression when multiple expressions have different error strings. The weight determines which error message appears.
- **Freshness**: Defines how old a virus definition can be. For example, you can configure the expression so virus definitions are no older than three days.

**To add a client security policy to a preauthentication or session policy**

1. In the configuration utility, in the navigation pane, do one of the following:
   a) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
   b) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:
   a) In Component, select the item for which to scan.
   b) In Name, type the name of the application.
   c) In Qualifier, select Version.
   d) In Operator, select the value.
   e) In Value, type the client security string, click OK, click Create and then click Close.
A service is a program that runs silently on the user device. When you create a session or preauthentication policy, you can create an expression that ensures that user devices are running a particular service when the session is established.

To configure a service policy

1. In the configuration utility, in the navigation pane, do one of the following:
   a) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
   b) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:
   a) In Component, select Service.
   b) In Name, type the name of the service.
   c) In Qualifier, leave blank or select Version.
   d) Depending on your selection in Qualifier, do one of the following:
      • If left blank, in Operator, select == or !=
      • If you selected Version, in Operator, in Value, type the value, click OK and then click Close.

You can check a list of all available services and the status for each on a Windows-based computer at the following location:

Control Panel > Administrative Tools > Services

Note: The service name for each service varies from its listed name. Check for the name of the service by looking at the Properties dialog box.
Configuring Process Policies

April 23, 2019

When creating a session or preauthentication policy, you can define a rule that requires all user devices to have a particular process running when users log on. The process can be any application and can include customized applications.

Note: The list of all processes running on a Windows-based computer appears on the Processes tab of Windows Task Manager.

To configure a process policy

1. In the configuration utility, in the navigation pane, do one of the following:
   a) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
   b) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:
   a) In Component, select Process.
   b) In Name, type the name of the application.
   c) In Operator, select EXISTS or NOTEXISTS, click OK and then click Close.

When you configure an endpoint analysis policy (pre-authentication or post-authentication) to check for a process, you can configure an MD5 checksum.

When you create the expression for the policy, you can add the MD5 checksum to the process you are checking for. For example, if you are checking to see if notepad.exe is running on the user device, the expression is:

CLIENT.APPLICATION.PROCESS(notepad.exe_md5_388b8fbc36a8558587afc90fb23a3b00) EXISTS

Configuring Operating System Policies

March 31, 2020
When you create a session or preauthentication policy, you can configure client security strings to
determine whether the user device is running a particular operating system when users log on. You
can also configure the expression to check for a particular service pack or hotfix.

The values for Windows and Macintosh are:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>macOS X</td>
<td>macOS</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>win8.1</td>
</tr>
<tr>
<td>Windows 8</td>
<td>win8</td>
</tr>
<tr>
<td>Windows 7</td>
<td>win7</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>vista</td>
</tr>
<tr>
<td>Windows XP</td>
<td>winxp</td>
</tr>
<tr>
<td>Windows Server 2008</td>
<td>win2008</td>
</tr>
<tr>
<td>Windows Server 2003</td>
<td>win2003</td>
</tr>
<tr>
<td>Windows 2000 Server</td>
<td>win2000</td>
</tr>
<tr>
<td>Windows 64-bit platform</td>
<td>win64</td>
</tr>
</tbody>
</table>

To configure an operating system policy by using the GUI

1. In the navigation pane, do one of the following:
   a) Navigate to Citrix Gateway > Policies and then click Session.
   b) Navigate to Citrix Gateway > Policies > Preauthentication.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. In Request Action select an existing action or create one.
5. Click Expression Editor.
6. In Select Expression Type, select Client Security.
7. Configure the settings for the following:
   a) In Component, select Operating System.
   b) In Name, type the name of the operating system.
   c) In Qualifier, do one of the following:
      • Leave the field blank
      • Select Service Pack
      • Select Hotfix
      • Select Version (for macOS only)
d) Depending on your selection in step 7, in Operator, do one of the following:
   • If Qualifier is blank, in Operator, select EQUAL (= =), NOTEQUAL (!=), EXISTS or NOT EXISTS.
   • If you selected Service Pack or Hotfix, select the operator and in Value, type the value.

8. Click **Done** and then click **Close**.

If you are configuring a service pack, such as client.os (winxp).sp, if a number is not in the **Value** field, Citrix Gateway returns an error message because the expression is invalid.

If the operating system has service packs present, such as Service Pack 3 and Service Pack 4, you can configure a check just for Service Pack 4, because the presence of Service Pack 4 automatically indicates that previous service packs are present.

### Configuring Registry Policies

**April 23, 2019**

When you create a session or preauthentication policy, you can check for the existence and value of registry entries on the user device. The session is established only if the particular entry exists or has the configured or higher value.

When configuring a registry expression, use the following guidelines:

- Four backslashes are used to separate keys and subkeys, such as
  
  HKEY_LOCAL_MACHINE\\SOFTWARE

- Underscores are used to separate the subkey and the associated value name, such as
  
  HKEY_LOCAL_MACHINE\\SOFTWARE\\VirusSoftware_Version

- A backslash (\) is used to denote a space, such as in the following two examples:
  
  HKEY_LOCAL_MACHINE\\SOFTWARE\\Citrix\\Secure\Access\Client_ProductVersion
  
  CLIENT.REG(HKEY_LOCAL_MACHINE\\Software\\Symantec\\Norton\AntiVirus_Version).VALUE
  
  == 12.8.0.4 -frequency 5

The following is a registry expression that looks for the Citrix Gateway plug-in registry key when users log on:

```
CLIENT.REG(secureaccess).VALUE==HKEY_LOCAL_MACHINE\\SOFTWARE\\CITRIX\\Secure\Access\Client_ProductVersion
```

**Note:** If you are scanning for registry keys and values and you select Advanced Free-Form in the
Expression dialog box, the expression must start with CLIENT.REG.

Registry checks are supported under the following most common five types:

- HKEY_CLASSES_ROOT
- HKEY_CURRENT_USER
- HKEY_LOCAL_MACHINE
- HKEY_USERS
- HKEY_CURRENT_CONFIG

Registry values to be checked use the following types:

- String
  For the string value type, case-sensitivity is checked.
- DWORD
  For DWORD type, the value is compared and must be equal.
- Expanded String
  Other types, such as Binary and Multi-String, are not supported.
- Only the ‘==’ comparison operator is supported.
- Other comparison operators, such as <, > and case-sensitive comparisons are not supported.
- The total registry string length should be less than 256 bytes.

You can add a value to the expression. The value can be a software version, service pack version, or any other value that appears in the registry. If the data value in the registry does not match the value you are testing against, users are denied logon.

**Note:** You cannot scan for a value within a subkey. The scan must match the named value and the associated data value.

**To configure a registry policy**

1. In the configuration utility, in the navigation pane, do one of the following:
   a) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
   b) In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:
   a) In Component, select Registry.
   b) In Name, type the name of the registry key.
   c) In Qualifier, leave blank or select Value.
   d) In Operator, do one of the following:
      • If Qualifier is left blank, select EXISTS or NOTEXISTS
      • If you selected Value in Qualifier, select either == or !==
   e) In Value, type the value as it appears in the registry editor, click OK and then click Close.

**Configuring Compound Client Security Expressions**

April 23, 2019

You can combine client security strings to form compound client security expressions.

The Boolean operators that are supported in Citrix Gateway are:

- And (&&)

Or ( )

- Not (!)

For greater precision, you can group the strings together using parentheses.

**Note:** If you use the command line to configure expressions, use parentheses to group security expressions together when you form a compound expression. The use of parentheses improves the understanding and debugging of the client expression.

**Configuring Policies with the AND (&&) Operator**

The AND (&&) operator works by combining two client security strings so that the compound check passes only when both checks are true. The expression is evaluated from left to right and if the first check fails, the second check is not carried out.

You can configure the AND (&&) operator using the keyword ‘AND’ or the symbols ‘&&’.

Example:
The following is a client security check that determines if the user device has Version 7.0 of Sophos AntiVirus installed and running. It also checks if the netlogon service is running on the same computer.

\[
\text{CLIENT.APPLICATION.AV(sophos).version==7.0 AND CLIENT.SVC(netlogon) EXISTS}
\]

This string can also be configured as:

\[
\text{CLIENT.APPLICATION.AV(sophos).version==7.0 && CLIENT.SVC(netlogon) EXISTS}
\]

**Configuring Policies with the OR ( || ) Operator**

The OR ( || ) operator works by combining two security strings. The compound check passes when either check is true. The expression is evaluated from left to right and if the first check passes, the second check is not carried out. If the first check does not pass, the second check is carried out.

You can configure the OR ( || ) operator using the keyword ‘OR’ or the symbols ‘ ’.

Example:

The following is a client security check that determines if the user device has either the file c:\file.txt on it or the putty.exe process running on it.

\[
\text{client.file(c:\\file.txt) EXISTS) OR (client.proc(putty.exe) EXISTS}
\]

This string can also be configured as

\[
\text{client.file(c:\\file.txt) EXISTS) (client.proc(putty.exe) EXISTS}
\]
Configuring Policies Using the NOT (!) Operator

The NOT (!) or the negation operator negates the client security string. 

Example:

The following client security check passes if the file c:\sophos_virus_defs.dat file is NOT more than two days old:

!(client.file(c:\\sophos_virus_defs.dat).timestamp==2dy)

Advanced Endpoint Analysis Scans

April 23, 2019

Advanced End-point Analysis (EPA) is used for scanning user devices for endpoint security requirement configured on a Citrix Gateway appliance. If a user device tries to access the Citrix Gateway appliance, the device is scanned for security information, such as operating system, antivirus, web browser versions and so forth before an administrator can grant access to the Citrix Gateway appliance.

The Advanced EPA scan is a policy-based scan that you can configure on a Citrix Gateway appliance for pre-authentication and post-authentication sessions. The policy performs a registry check on a user device and based on evaluation, the policy allows or denies access to the Citrix ADC network.

You can perform two types of EPA scan, OPSWAT scan and System scan. The following section explain the scan types and its details.

OPSWAT scan. The scan mechanism provides security at different levels such as:

- Product specific scan
- Vendor specific scan
- Generic scan

Product specific scan: You can configure scan criteria for a particular product (e.g. Avast! Free Antivirus) offered by a particular vendor (e.g. AVAST Software a.s.) for a category (e.g. Antivirus). The access is granted only to the computers fulfilling the specified criteria.

Vendor specific scan: You can configure scan criteria for a particular vendor (e.g. AVAST Software a.s.) of a category (eg. Antivirus). The configured scan checks for the specified criteria across all the products offered by the vendor. The access is granted only to the computers fulfilling the specified criteria.

Generic scan: You can configure scan criteria for a particular category (eg. Antivirus). The configured scan checks for the specified criteria across all the vendors and the products offered by the vendors.
The access is granted only to the computers fulfilling the specified criteria.

**System Scan.** The System scan provides security for system level attributes such as MAC address. You can configure scan criteria for a system attribute (e.g. **MAC Address**). The access is granted only to the computers fulfilling the specified criteria.

### Configuring Advanced Endpoint Analysis Scans

April 23, 2019

You can configure two types of EPA scan, OPSWAT scan and System scan.

#### Configuring OPSWAT Scan

The following OPSWAT scans are configured on a Citrix Gateway appliance.

- Product specific scan
- Vendor specific scan
- Generic scan

**Note:** Scans that are supported by a particular product get displayed in the GUI. Also, the following OPSWAT scan configuration takes pre-authentication EPA as an example. OPSWAT scan can be configured for post-authentication EPA as well.

#### Configuring Product specific OPSWAT Scan

To use the NetScaler GUI to configure product specific OPSWAT scan:

1. Navigate to **Configuration> Citrix NetScaler> Global Settings**.
2. On the **Global Settings** page, click **Change Preauthentication settings** link.
3. On the **Configure AAA Preauthentication Parameter** page, click **OPSWAT EPA Editor** link.
4. Under **Expression Editor** area, select the operating system.
5. Select the category, for example **Antivirus**.

6. Select the vendor, for example **AVAST Software a.s.**

7. Select the product, for example **Avast! Free Antivirus**.
8. Click + next to the product drop-down menu to configure the product scan.

9. Optionally enter a value for frequency of scan if you want a periodic scan.

Configuring Vendor specific OPSWAT Scan

To use the NetScaler GUI to configure Vendor specific OPSWAT scan:

1. Navigate to **Configuration> Citrix NetScaler> Global Settings**.
2. On the Global Settings page, click Change Preauthentication settings link.

3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.

4. Under Expression Editor area, select the operating system.

5. Select the category, for example Antivirus.

6. Select the vendor, for example AVAST Software a.s.
7. Select **Generic ‘AVAST Software a.s’ Scan** vendor specific scan.

8. Click + next to the product drop-down menu to configure your scan.

9. Optionally enter a value for frequency of scan if you want a periodic scan.
To use the NetScaler GUI to configure Generic OPSWAT scan:

1. Navigate to Configuration> Citrix NetScaler> Global Settings.
2. On the Global Settings page, click Change Preauthentication settings link.
3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.
4. Under Expression Editor area, select the operating system.
5. Select the category, for example Antivirus.
6. Select “Generic” category specific scan, for example **Generic Antivirus Product Scan**.

7. Click + next to the product drop-down menu to configure your scan.

8. Optionally enter a value for the frequency of the scan if you want a periodic scan.
Configuring System Scan

The following system scans are configured on a Citrix Gateway appliance.

- MAC Address
- Domain Check
- Numeric Registry
- Non-numeric Registry
- Windows Update

To use the NetScaler GUI to configure OPSWAT System scan:

1. Navigate to Configuration> Citrix NetScaler> Global Settings.
2. On the Global Settings page, click Change Preauthentication settings link.
3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.
4. Under Expression Editor area, select the operating system.
5. Select the desired system scan from the dropdown menu. For example, MAC Address.
6. Click on the + next to the product drop-down menu to configure your scan.

7. Optionally enter a value for the frequency of the scan if you want a periodic scan.

**Upgrade EPA libraries**

To use the NetScaler GUI to upgrade EPA libraries:

1. Navigate to **Configuration> Citrix NetScaler> Update Client Components**.
2. Under **Update Client Components**, click **Upgrade EPA Libraries** link.
3. Choose the required file and click **Upgrade**.
For the list of Windows and MAC Supported applications by OPSWAT for Citrix ADC scans click [https://support.citrix.com/article/CTX207623](https://support.citrix.com/article/CTX207623).

**To configure a preauthentication profile using Advanced Endpoint Analysis expressions**

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then the Policies subnode.
2. Select Preauthentication.
3. In the details pane, on the Profiles tab, click Add.
4. Enter a name for the profile.
5. Select an action.
6. Optionally, enter the names of any processes to be stopped or files to be deleted on the client endpoint system.
7. Click Create.

Your profile is now available for use in a preauthentication policy as a Request Action.

**To configure a preauthentication policy using Advanced Endpoint Analysis expressions**

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then the Policies subnode.
2. Select Preauthentication.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the policy.
5. From the Request Action menu, select the desired profile.
6. In the Expression pane, select OPSWAT EPA Editor.
7. In the first pull down menu, select a client operating system.
8. In the second pull down menu that appears, select a scan type.
9. When you finish building the policy, click Create.

You must bind your Advanced Endpoint Analysis preauthentication policy to enable it.

**To bind a preauthentication policy**

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then the Policies subnode.
2. Select Preauthentication.
3. In the details pane, on the Policies tab, click Add.
4. From the Action menu, select Global Bindings.
5. Click Bind.
6. In the Policies detail pane that appears, select the check box next to the desired policy.
7. Click Insert.
8. The policy is automatically assigned a priority (weight). Click the Priority entry to edit as needed.
9. Click OK to bind the policy.

To configure an Advanced Endpoint Analysis policy for specific sessions

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then the Policies subnode.
2. Select Session.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the policy.
5. In the Action menu, do one of the following:
   a. Select an existing action.
   b. Click the plus icon to display the configuration parameters that can be set by the session policy. Click the Override Global check box to the right of a configuration option to activate it. Select Create.
6. In the Expression pane, select OPSWAT EPA Editor.
7. In the first pull down menu, select a client operating system.
8. In the second pull down menu that appears, select a scan type.
9. When you finish building the policy, click Create.

You must bind your Advanced Endpoint Analysis session policy to enable it.

To bind a session policy

1. In the configuration utility, in the navigation pane, expand the Citrix Gateway node, and then the Policies subnode.
2. Select Session.
3. In the details pane, on the Policies tab, click Add.
4. From the Action menu, select Global Bindings.
5. Click Bind.
6. In the Policies detail pane that appears, select the check box next to the desired policy.
7. Click Insert.
8. The policy is automatically assigned a priority (weight). Click the Priority entry to edit as needed.
9. Click OK to bind the policy.
Advanced Endpoint Analysis Policy Expression Reference

April 23, 2019

This reference describes the format and construction of Advanced Endpoint Analysis expressions. The expression elements contained here are built by the Citrix Gateway configuration utility automatically and do not require manual configuration.

Expression format

An Advanced Endpoint Analysis expression has the following format:

```
CLIENT.APPLICATION (SCAN-type_ Product-id_ Method-name _ Method-comparator_ Method-param _…) 
```

Where:

SCAN-type is the type of application being analyzed.

Product-id is the product identification for the analyzed application.

Method-name is the product or system attribute being analyzed.

Method-comparator is the chosen comparator for the analysis.

Method-param is the attribute value or values being analyzed.

For example:

```
client.application(ANTIVIR_2600_RTP==TRUE) 
```

Note: For non-application scan types, the expression prefix is CLIENT.SYSTEM instead of CLIENT.APPLICATION.

Expression strings

Each of the supported scan types in Advanced Endpoint Analysis uses an unique identifier in expressions. The following table enumerates the strings for each type of scan.

<table>
<thead>
<tr>
<th>Scan type</th>
<th>Scan type expression string</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-phishing</td>
<td>ANTIPHI</td>
</tr>
<tr>
<td>Antispyware</td>
<td>ANTISPY</td>
</tr>
<tr>
<td>Antivirus</td>
<td>ANTIVIR</td>
</tr>
<tr>
<td>Scan type</td>
<td>Scan type expression string</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Backup Client</td>
<td>BACKUP</td>
</tr>
<tr>
<td>Device Access Control</td>
<td>DEV-CONT</td>
</tr>
<tr>
<td>Data Loss Prevention</td>
<td>DATA-PREV</td>
</tr>
<tr>
<td>Desktop Sharing</td>
<td>DESK-SHARE</td>
</tr>
<tr>
<td>Firewall</td>
<td>FIREWALL</td>
</tr>
<tr>
<td>Health Agent</td>
<td>HEALTH</td>
</tr>
<tr>
<td>Hard disk Encryption</td>
<td>HD-ENC</td>
</tr>
<tr>
<td>Instant Messenger</td>
<td>IM</td>
</tr>
<tr>
<td>Web Browser</td>
<td>BROWSER</td>
</tr>
<tr>
<td>P2P</td>
<td>P2P</td>
</tr>
<tr>
<td>Patch Management</td>
<td>PATCH</td>
</tr>
<tr>
<td>URL Filtering</td>
<td>URL-FILT</td>
</tr>
<tr>
<td>MAC address</td>
<td>MAC</td>
</tr>
<tr>
<td>Domain check</td>
<td>DOMAIN</td>
</tr>
<tr>
<td>Numeric Registry Scan</td>
<td>REG-NUM</td>
</tr>
<tr>
<td>Non-Numeric Registry Scan</td>
<td>REG-NON-NUM</td>
</tr>
</tbody>
</table>

**Note:** For Mac OS X specific scans, expressions include the prefix MAC- before the method type. Therefore, for antivirus and anti-phishing scans, the methods are MAC-ANTIVIR and MAC-ANTIPHI respectively. For example: client.application(MAC-ANTIVIR_2600RTP==_TRUE)

**Application Scan Methods**

In configuring Advanced Endpoint Analysis expressions, methods are used to define the parameters of the endpoint scans. These methods include a method name, a comparator, and a value. The following tables enumerate all of the methods available for use in expressions.

**Common Scan Methods:**

The following methods are used for multiple types of application scans.
<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>VERSION*</td>
<td>Specifies version of application.</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Version string</td>
</tr>
<tr>
<td>AUTHENTIC**</td>
<td>Check if given application is authentic or not.</td>
<td>==</td>
<td>TRUE</td>
</tr>
<tr>
<td>ENABLED</td>
<td>Check if application is enabled.</td>
<td>==</td>
<td>TRUE</td>
</tr>
<tr>
<td>RUNNING</td>
<td>Check if application is running.</td>
<td>==</td>
<td>TRUE</td>
</tr>
<tr>
<td>COMMENT</td>
<td>Comment field (ignored by scan).</td>
<td>==</td>
<td>Any text</td>
</tr>
<tr>
<td></td>
<td>Delineated by [] within expressions.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The VERSION string can specify a decimal string of up to four values, such as 1.2.3.4.

** An AUTHENTIC check verifies the authenticity of the binary files for the application.

**Note:** You can select a generic version for application scan types. When generic scans are selected, the product ID will be 0.

Gateway provides an option to configure Generic scans for each type of software. Using generic scan, admin can scan the client machine without restricting the scanning check to any particular product.

For Generic scans, scan methods will work only if the product installed on users system supports that scan method. To know which products support particular scan method, please contact Citrix support.

**Unique Scan Methods:**

The following methods are unique to the specified types of scans.
Table 2. Antispyware and Antivirus

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTP</td>
<td>Check whether real time protection is on or not.</td>
<td>==</td>
<td>TRUE</td>
</tr>
<tr>
<td>SCAN-TIME</td>
<td>How many minutes since a full system scan was performed.</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Any positive number</td>
</tr>
<tr>
<td>VIRDEF-FILE-TIME</td>
<td>How many minutes since virus definition file was updated (i.e. Number of minutes between virus definition file stamp and current timestamp).</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Any positive number</td>
</tr>
<tr>
<td>VIRDEF-FILE-VERSION</td>
<td>Version of definition file.</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Version string</td>
</tr>
<tr>
<td>ENGINE-VERSION</td>
<td>Engine version.</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Version string</td>
</tr>
</tbody>
</table>

Table 3. Backup client
<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAST-BK-ACTIVITY</td>
<td>How many minutes since last backup activity was completed.</td>
<td>$\langle, \leq, &gt;, \geq, !=, ==$</td>
<td>Any positive number</td>
</tr>
</tbody>
</table>

Table 4. Data loss prevention

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABLED</td>
<td>Check whether application is enabled or not and time protection is on or not on.</td>
<td>$==$</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

Table 5. Health check agent

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEM-COMPL</td>
<td>Check whether system is in compliance.</td>
<td>$==$</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

Table 6. Hard disk encryption

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENC-PATH</td>
<td>PATH for checking encryption status.</td>
<td>NO OPERATOR</td>
<td>Any text</td>
</tr>
<tr>
<td>ENC-TYPE</td>
<td>Check whether encryption type for specified path.</td>
<td>allof, anyof, noneof</td>
<td></td>
</tr>
</tbody>
</table>

**List with following options:**
- UNENCRYPTED
- PARTIAL
- ENCRYPTED
- VIRTUAL
- SUSPENDED
- PENDING
### Table 7. Web browser

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULT</td>
<td>Check whether set as default browser</td>
<td>==</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

### Table 8. Patch management

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCAN-TIME</td>
<td>How many minutes since last scan for patch was performed.</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Any positive number</td>
</tr>
<tr>
<td>MISSED-PATCH</td>
<td>Client system is not missing patches of these types.</td>
<td>anyof, noneof</td>
<td>ANY Pre-selected (Pre-selected patches on Patch Manager server)</td>
</tr>
<tr>
<td>NON</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDR</td>
<td>Check whether client machine MAC addresses are or are not in given list.</td>
<td>anyof, noneof</td>
<td>Editable list</td>
</tr>
</tbody>
</table>

### Table 10. Domain membership

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Comparator</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUFFIX</td>
<td>Check whether client machine exists or does not exist in given list.</td>
<td>anyof, noneof</td>
<td>Editable list</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
<td>Comparator</td>
<td>Possible values</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td>PATH</td>
<td>Path for registry check. In the format: HKEY_LOCAL_MACHINE\Access\Client\EnableAutoUpdate. No escaping of special characters is required. All registry root keys: HKEY_LOCAL_MACHINE, HKEY_CURRENT_USER, HKEY_USERS, HKEY_CLASSES_ROOT, HKEY_CURRENT_CONF</td>
<td>NO OPERATOR</td>
<td>Any text</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
<td>Comparator</td>
<td>Possible values</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>REDIR-64</td>
<td>Follow 64-bit redirection. If set to TRUE, WOW redirection will be followed (i.e. Registry path will be checked on 32-bit systems but WOW redirected path will be checked for 64-bit systems.) If not set, WOW redirection will not be followed (i.e. Same registry path will be checked for 32- and 64-bit systems.) For registry entries that are not redirected this setting will have no effect. See the following article for the list of registry keys that get redirected on 64-bit systems: <a href="http://msdn.microsoft.com/en-us/library/aa384253%28v=vs.85%29.aspx">http://msdn.microsoft.com/en-us/library/aa384253%28v=vs.85%29.aspx</a></td>
<td>==</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

**VALUE**

Expected value for above path. This scan works only for registry types of REG_DWORD and REG_QWORD.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Expected value for above path. This scan works only for registry types of REG_DWORD and REG_QWORD.</td>
<td>&lt;, &lt;=, &gt;, &gt;=, !=, ==</td>
<td>Any number</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
<td>Comparator</td>
<td>Possible values</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PATH</td>
<td>Path for registry check.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check Registry scan for Numeric type.</td>
<td>NO OPERATOR</td>
<td>Any text</td>
<td></td>
</tr>
<tr>
<td>REDIR-64</td>
<td>Follow 64-bit redirection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check registry scan for Numeric type.</td>
<td>==</td>
<td>TRUE</td>
<td></td>
</tr>
<tr>
<td>VALUE</td>
<td>Expected value for above path. For string type registry entries, the registry value is directly compared against the expected value. For REG_BINARY registry entry type, the registry value is converted into an uppercase hex string, and this string is compared against the expected value.</td>
<td>==, !=</td>
<td>Any text</td>
</tr>
</tbody>
</table>

**Troubleshooting Advanced Endpoint Analysis scans**

April 23, 2019

To assist in troubleshooting Advanced Endpoint Analysis scans, the client plug-ins write logging information to a file on client endpoint systems. These log files can be found in the following directories, depending on the user's operating system.

**Windows Vista, Windows 7, Windows 8, Windows 8.1, and Windows 10:**

C:\Users\<username>\AppData\Local\Citrix\AGEE\nsepa.txt

**Windows XP:**
You can manage user sessions in the configuration utility in the Active Users Sessions dialog box. This dialog box displays a list of active user sessions on the Citrix Gateway.

You can end user or group sessions in this dialog box by using the user name, group name, or IP address.

You can also view active sessions within this dialog box. Session information includes:

- User name
- IP address of the user device
- Port number of the user device
- IP address of the virtual server
- Port number of the virtual server
- Intranet IP address assigned to the user

**To view user sessions**

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Monitor Connections, click Active user sessions.
3. View the list of sessions under Sessions.

**To refresh the session list**

You can retrieve updated information about sessions to Citrix Gateway.

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Monitor Connections, click Active user sessions.
3. Click Refresh.
To end user or group sessions

You can terminate user and group sessions. You can also end a session that has a specific intranet IP address and subnet mask.

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Monitor Connections, click Active user sessions.
3. Under Sessions, select a user or group and then click Terminate.

To end a session by using an intranet IP address

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Monitor Connections, click Active user sessions.
3. Select Intranet IP
4. In Intranet IP, type the IP address.
5. In Netmask, type the subnet mask and then click Terminate.

AlwaysON

March 17, 2020

The AlwaysON feature of Citrix Gateway ensures that users are always connected to the enterprise network. This persistent VPN connectivity is achieved by automatic establishment of a VPN tunnel.

Note

AlwaysON feature supports captive portals for Citrix ADC 12.0 Build 51.24 and later.

When to Use AlwaysON

Use AlwaysON when you need to provide seamless VPN connectivity based on user location and have to prevent network access by a user who is not connected to a VPN.

The following scenarios illustrate the use of AlwaysON.

- An employee starts the laptop outside the enterprise network and needs assistance to establish VPN connectivity.
  Solution: When the laptop is started outside the enterprise network, AlwaysON seamlessly establishes a tunnel and provides VPN connectivity.
• An employee using VPN connectivity moves into the enterprise network. The employee is switched to enterprise network but remains connected to the VPN tunnel, which is not a desirable state.

**Solution:** When the employee moves into the enterprise network, AlwaysOn tears down the VPN tunnel and seamlessly switches the employee to the enterprise network.

• An employee moves outside the enterprise network and closes the laptop (not shut down). The employee needs assistance to establish VPN connectivity upon resuming work on the laptop.

**Solution:** When the employee moves outside the enterprise network, AlwaysON seamlessly establishes a tunnel and provides VPN connectivity.

• An enterprise wants to regulate the network access provided to its users when they are not connected to a VPN tunnel.

**Solution:** Depending on the configuration, AlwaysON restricts access, allowing users to access only the gateway network.

---

**Understanding the AlwaysON Framework**

AlwaysON automatically connects a user to a VPN tunnel that the client has previously established. The first time the user needs a VPN tunnel, the user must connect to the Citrix Gateway URL and establish the tunnel. After the AlwaysON configuration is downloaded to the client, this configuration drives subsequent establishment of the tunnel.

The Citrix Gateway client executable is always running on the client machine. When the user logs on or the network changes, the Citrix Gateway client determines whether or not the user laptop is on the enterprise network. Depending upon the location and the configuration, the Citrix Gateway client either establishes a tunnel or tears down an existing tunnel.

Tunnel establishment is initiated only after the user logs on to the computer. The Citrix Gateway client uses the client machine’s credentials to authenticate with Gateway server and tries to establish a tunnel.

**Automatic reestablishment of a Tunnel**

Automatic reestablishment of a tunnel is triggered when a VPN tunnel is torn down by Citrix Gateway.

**Note**

In End-Point Analysis failure, the Citrix Gateway client does not reattempt tunnel establishment, but does display an error message. If there is an authentication failure, the Citrix Gateway client prompts user for credentials.
**Supported user authentication methods for seamless tunnel establishment**

The supported user authentication methods are as follows:

- User name + AD password: If the Windows user name and password are used for authentication, the Citrix Gateway client seamlessly establishes the tunnel by using these credentials.
- User certificate: If user certificate is used for authentication and there is only one certificate on the machine, the Citrix Gateway client seamlessly establishes the tunnel by using this certificate. If multiple client certificates are installed, the tunnel is established after the user has selected the preferred certificate. The Citrix Gateway client uses this preference for later established tunnels.
- User certificate and User name + AD password: This authentication method is the combination of previously described authentication methods.

**Note**

All other authentication mechanisms are supported but the tunnel establishment is not seamless for any other authentication methods. User intervention is required for all other authentication methods.

**Configuration Requirements for AlwaysON**

Enterprise administrator must enforce the following for the managed devices:

- User must not be able to end the process/service for specific configuration
- User must not be able to uninstall the package for specific configuration
- User must not be able to change specific registry entries

**Note**

The feature might not work as expected if the user has administration privileges, as in the case of non-managed devices.

**Considerations While Enabling the AlwaysON feature**

Review the following section before enabling the AlwaysON feature.

Primary Network Access: When the tunnel is established, the traffic to the enterprise network is decided based on split-tunnel configuration. Additional configurations are not provided to override this behavior.

Proxy settings of client machine: Proxy settings of the client machine are ignored for connecting to the gateway server.
Note

The Citrix ADC appliance’s proxy configuration is not ignored. Only the proxy settings of the client machine are ignored. Users who have a proxy configured on their systems are notified that the VPN plug-in has ignored their proxy settings.

When the configuration value is set to “Deny,” the following changes apply:

- **Client UI** - The logoff and Exit options from the plug-in context menu and plug-in UI are disabled. Users are not allowed to change the Gateway URL.
- **Browser logon** - Browser log on to a different gateway is not allowed. Client controls are disabled.

Configuring AlwaysON

To configure AlwaysON, create an AlwaysOn profile on the Citrix Gateway appliance and apply the profile.

To create an AlwaysOn profile:

1. In the Citrix ADC GUI, navigate to **Configuration > Citrix Gateway > Policies > AlwaysON**.
2. On the AlwaysON Profiles page, click **Add**.
3. On the Create AlwaysON Profile page, enter the following details:
   - **Name** – The name for your profile.
   - **Location Based VPN** – Select one of the following settings:
     - **Remote** to enable a client to detect whether or not it is in the enterprise network and establish the tunnel if not in the enterprise network. This is the default setting.
     - **Everywhere** to let client skip the location detection and establish the tunnel regardless of the client’s location
   - **Client Control** – Select one of the following settings:
     - **Deny** to prevent the user from logging off and connecting to another gateway. This is the default setting.
     - **Allow** to enable user to log off and connect to another gateway.
   - **Network Access On VPN Failure** – Select one of the following settings:
     - **Full Access** to allow network traffic to flow to and from the client when the tunnel is not established. This is the default setting.
     - **Only To Gateway** to prevent network traffic from flowing to or from the client when the tunnel is not established. However, the traffic to or from the Gateway IP address is allowed.

   **Note:** In **Only To Gateway** mode, only the virtual server, DNS, and DHCP traffic are unblocked. To unblock other websites, IP address ranges, or IP addresses, you must set the `alwaysonwhitelist` registry with a semicolon-separated list of...
To apply the AlwaysOn profile:

1. In the Citrix ADC interface, select **Configuration > Citrix Gateway > Global Settings**.
2. On the Global Settings page, click the **Change Global Settings** link, and then select the **Client Experience** tab.
3. From the **AlwaysON Profile Name** drop down menu, select the newly created profile, and click **OK**.

**Note**
Similar configuration can be done in Session profile to apply the policies at a group level, server level, or a user level.

**Behavior summary of different configurations for admin users and non-admin users**

The table below summarizes the behavior for different configurations. It also details the possibility of certain user actions, which can affect AlwaysON functionality.

<table>
<thead>
<tr>
<th>networkAccessONVPNFailure</th>
<th>Client control</th>
<th>Non-admin user</th>
<th>Admin user</th>
</tr>
</thead>
<tbody>
<tr>
<td>fullaccess</td>
<td>Allow</td>
<td>The tunnel gets established automatically. The user can log off and stay off the network. The user can also point to another Citrix Gateway.</td>
<td>The tunnel gets established automatically. The user can log off and stay off the enterprise network. The user can also point to another Citrix Gateway.</td>
</tr>
<tr>
<td>fullaccess</td>
<td>Deny</td>
<td>The tunnel gets established automatically. The user cannot log off or point to another Citrix Gateway.</td>
<td>The tunnel gets established automatically. The user can uninstall Citrix Gateway Client or move to another Citrix Gateway.</td>
</tr>
<tr>
<td>networkAccessONVPNFailure</td>
<td>Client control</td>
<td>Non-admin user</td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------</td>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td>onlyToGateway</td>
<td>Allow</td>
<td>The tunnel gets established automatically. The user can log off (no network access). The user can also point to another Citrix Gateway, in which case, the access is given only to the newly pointed Citrix Gateway.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deny</td>
<td>The tunnel gets established automatically. The user cannot log off or point to another Citrix Gateway.</td>
<td></td>
</tr>
</tbody>
</table>

**Whitelisting URLs when AlwaysOn is down**

Users can access a few websites even when AlwaysON is down and the network is locked. Admins can use the `AlwaysOnWhitelist` registry to add the websites that you want to enable access to when AlwaysOn is down.

**Note:**
- `AlwaysOnWhitelist` registry is supported from release 13.0 build 47.x and later.
- `AlwaysOnWhitelist` registry location is `Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Secure Access Client`.
- Wildcard URLs/FQDNs are not supported in the `AlwaysOnWhitelist` registry.

**To set the AlwaysOnWhitelist registry**

Set the `AlwaysOnWhitelist` registry with a semicolon-separated list of FQDNs, IP address ranges, or IP addresses that you want to allow access to.
**Example:** example.citrix.com;10.103.184.156;10.102.0.0-10.102.255.100

The following figure displays a sample *AlwaysOnWhitelist* registry.

---

**AlwaysOn VPN before Windows logon (Formally AlwaysOn service)**

February 28, 2020

The **AlwaysOn VPN before Windows logon** feature enables user to establish a machine level VPN tunnel even before a user logs in to a Windows system. The tunnel remains active until the machine shuts down. Post user logon, the device-level VPN tunnel is taken over by a user-level VPN tunnel. After the user logs off the user-level tunnel is torn and a device-level tunnel is established. AlwaysOn VPN before Windows logon can be configured by using advanced policies only. For details see, [Configure AlwaysOn VPN before Windows logon](#).

**AlwaysOn VPN before Windows logon encompasses the following:**

- Windows machine can verify the user’s login credential using corporate active directory (AD) and Windows credentials on the machine are not cached. Also, new corporate AD users are enabled to seamlessly log on to the machine.
- Windows machine becomes a part of corporate intranet even before users log in, allowing IT administrators to access the client machine from the corporate network for debugging purposes.
- VPN tunnel for a Windows machine remains connected even when different users log in or log out to the machine.

**Points to note:**

- Citrix Gateway and VPN plug-in must be version 13.0.41.20 and later.
• If a client machine does not have internet connectivity, AlwaysOn VPN before Windows logon waits for the internet connectivity to become available before establishing the VPN tunnel.
• If a client machine is connected to a captive portal network, AlwaysOn VPN before Windows logon waits for the user to authenticate to the captive portal. After the user logs in and internet access is enabled, AlwaysOn VPN before Windows logon establishes the VPN tunnel.
• AlwaysOn VPN before Windows logon feature supports captive portals for Citrix ADC.
• If cached logon credentials option is not enabled for Windows, then users cannot log on in the following scenarios:
  – Machine has no internet connectivity
  – Machine is connected to a captive portal network

**Windows credential manager screen after AlwaysOn VPN before Windows logon configuration**

Upon configuring the AlwaysOn VPN before Windows logon feature, the Windows credentials manager screen is modified as follows.

When you click **Sign-in options** on the logon screen, the following information is displayed:
• Citrix Gateway icon suggests whether the machine is connected to Citrix Gateway or not.
• Depending on the user configuration mode, one of the following statements is displayed on the logon screen.
  – Citrix Gateway is connected in service mode
  – Citrix Gateway is connected in user mode

Configure AlwaysOn VPN before Windows logon

April 1, 2020

AlwaysOn VPN before Windows logon provides the following capabilities.

• Administrator provides a one-time password to the first time users working remotely using which users can connect to domain controller to change their password.
• Administrator remotely manages/enforces AD policies to the device even before the user logs in.
• Administrator provides a granular level of control to users based on the user group after the user logs on. For example, using user-level tunnel, you can restrict or provide access for a resource to a particular user group.
• The user tunnel can be configured for MFA as per user requirements.
• Same machine can be used by multiple users, the access to selective resources are provided based on the user profile. For example in kiosk, a machine can be used by multiple users without hassle.
• Users working remotely connect to domain controller to change their password.

Understanding AlwaysOn VPN before Windows logon

The following is the flow of events for the AlwaysOn VPN before Windows logon functionality.
• User turns on the laptop, machine-level tunnel is established towards Citrix Gateway using device certificate as identity.
• User logs in to the laptop with AD credentials.
• Post login, user is challenged with MFA.
• Upon a successful authentication machine-level tunnel is replaced with a user-level tunnel.
• Once user logs out, the user-level tunnel is replaced with the machine-level tunnel.

Configure AlwaysOn VPN before Windows logon by using the GUI

Prerequisite

• Citrix Gateway and VPN plug-in must be version 13.0.41.20 and later.
• Citrix ADC Advanced Edition and higher is required for the solution to work.
• You can configure the functionality only by using advanced policies.

The configuration involves the following high-level steps:

• Create an authentication profile
• Create an authentication virtual server
• Create authentication policies
• Bind the policies to the authentication profile
To configure the functionality using the GUI

Client certificate based authentication

1. On the Configuration tab, navigate to Citrix Gateway > Virtual Servers.
2. On the Citrix Gateway Virtual Servers page, select an existing virtual server and click Edit.
3. On the VPN Virtual Server page, click the edit icon.
4. Click Add next to the CA for Device Certificate section and click OK.
   
   Note: Do not select the Enable Device Certificate check box.
5. For binding a CA certificate to the virtual server, click CA certificate under Certificate section.
   Click Add Binding under SSL Virtual Server CA Certificate Binding page.
**Note:** All CA certificates (Root and Intermediate) that can potentially sign the Device Certificate issued to clients must be bound under the **CA for Device Certificate** section and also the **CA Certificate binding** section for virtual server in Steps 4 and 5. For more information on linking CA certificate with intermediate / subordinate, see **Install, link, and update certificates**.

6. Click the text, **Click to select** to select the required certificate.

![CA Certificate Binding](image)

7. Select the required CA certificate.

![CA Certificates](image)

8. Click **Bind**.

9. On the VPN Virtual Servers page, under Authentication Profile section, click **Add**.

10. On the Create Authentication Profile page, provide a name for the authentication profile, and click **Add**.
11. On the Authentication Virtual Server page, provide a name for the authentication virtual server, select IP Address Type as **Non-Addressable**, and click **OK**.

13. On the Policy Binding page click Add next to Select Policy.

14. On the Create Authentication Policy page;
   a) Enter a name for the advance authentication policy.
   b) Select EPA from the Action Type list.
   c) Click Add next to Action.
15. On the Create Authentication EPA Action page;
   a) Enter a name for the EPA action to be created.
   b) Enter `sys.client_expr("device-cert_0_0")` in the Expression field.
   c) Click Create.

16. On the Create Authentication Policy page;
   a) Enter a name for the authentication policy.
   b) Enter `is_aoservice` in the Expression field.
   c) Click Create.
17. On the Policy Binding page, enter **100** in **Priority** and click **Bind**.

**Note:** The machine-level tunnel configuration is now complete. You can skip steps 18–25 and proceed with the client side configuration, if you do not want the user-level tunnel after Windows logon.

**To replace a machine-level tunnel with a user-level tunnel after Windows logon, continue with the following configuration.**

18. Change the **Goto Expression** to **Next** instead of End for the policy bound in step 17.

20. On the Authentication Policy page, click the Add Binding tab.

21. On the Policy Binding page, click Add next to Select Policy.
22. On the Create Authentication Policy page;
   a) Enter a name for the “no authentication” policy to be created.
   b) Select action type as No_AUTHN.
   c) Enter is_aoservice.not in the Expression field.
   d) Click Create.

   Note: The expression is_aoservice.not is valid from Citrix Gateway version 13.0 build 41.20 and later.
23. On the Policy Binding page, enter 110 in Priority, click Add next to Select Next Factor.

24. On Authentication Policy Label page, create LDAP authentication policy. Refer to the following article to create LDAP authentication policy. For more details see To configure LDAP authentication by using the configuration utility.

25. Click Bind on the Policy Binding page.

Client side configuration

AlwaysOn, locationDetection, and suffixList registries are optional and only required if the location detection functionality is needed.

<table>
<thead>
<tr>
<th>Registry key</th>
<th>Registry type</th>
<th>Values and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlwaysOnService</td>
<td>REG_DWORD</td>
<td>1 =&gt; Enable AlwaysOn service without a user persona; 2 =&gt; Enable AlwaysOn service with user persona</td>
</tr>
<tr>
<td>AlwaysOnURL</td>
<td>REG_SZ</td>
<td>URL of the Citrix Gateway virtual server user wants to connect to. Example: <a href="https://xyz.companyDomain.com">https://xyz.companyDomain.com</a></td>
</tr>
<tr>
<td>AlwaysOn</td>
<td>REG_DWORD</td>
<td>1 =&gt; Allow network access on VPN failure; 2 =&gt; Block network access on VPN failure</td>
</tr>
</tbody>
</table>
Citrix Gateway 13.0

<table>
<thead>
<tr>
<th>Registry key</th>
<th>Registry type</th>
<th>Values and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>locationDetection</td>
<td>REG_DWORD</td>
<td>1 =&gt; To enable location detection; 0 =&gt; To disable location detection</td>
</tr>
<tr>
<td>suffixList</td>
<td>REG_SZ</td>
<td>Comma separated list of intranet domains. Used when location detection is enabled</td>
</tr>
<tr>
<td>ClientControl</td>
<td>REG_DWORD</td>
<td>1 =&gt; Allow users to log out or connect to other gateways. 0 =&gt; Block users to log out or connect to other gateways</td>
</tr>
</tbody>
</table>

For more information about these registry entries, see AlwaysOn.

To configure AlwaysOn VPN before Windows logon using Classic Policy, see Configure Always On VPN before Windows logon using Classic Policy.

Configuring Citrix Gateway

April 23, 2019

Citrix ADC with Citrix Gateway: One URL

Citrix ADC with Citrix Gateway enables simplified secure access to any application through a single URL for desktop and mobile users. Behind this single URL, administrators have a single point for configuration, security, and control of remote access to applications. And remote users have an improved experience with seamless single sign-on to all the applications they need along with login/logout once ease of use.

To accomplish this, Citrix ADC with Gateway, along with Citrix ADC’s Content Switching capacities and extensive authentication infrastructure, provides access to organizational sites and apps through this single URL. Additionally, remote users can use iOS or Android mobile devices and Linux, PC or Mac systems with the Citrix Gateway client plug-ins for uniform access to the Citrix Gateway URL, wherever they may be.

A Citrix Gateway deployment allows single URL access to the following categories of applications:

- Intranet applications.
• Clientless applications
• Software as a Service applications
• Preconfigured applications served by Citrix ADC
• Citrix Virtual Apps and Desktops published applications

**Intranet applications** may be any web-based application that resides inside the secure enterprise network. These are internal resources such as an organizational intranet site, a bug tracking application, or a wiki.

Typically also residing inside the secure enterprise network, the **clientless applications** Citrix Gateway provides single URL access to are Outlook Web Access and SharePoint. These applications provide access to Exchange email and team resources without dedicated client software which need to be available to remote users.

**SaaS applications**, also commonly know as Cloud Apps, are external, cloud-based applications that organizations depend on such as Sharefile, SalesForce, or NetSuite. SAML based single sign-on is supported with those SaaS applications that offer it.

Some organizations may have **preconfigured Citrix ADC served applications** deployed in an Citrix ADC ADC load balanced configuration; often times this is also referred as a ‘reverse-proxy’ application. Citrix Gateway supports these applications when a virtual server for the deployment resides on the same Citrix ADC Citrix Gateway instance or appliance. These applications may have their own authentication configuration which is independent of that for the Citrix Gateway configuration.

Any published **Citrix Virtual Apps and Desktops published applications** can be made available through a Citrix Gateway URL. SmartAccess and SmartControl policies can optionally be applied to granular policy and access control to these resources.

### The Citrix Gateway Configuration Wizard

The recommended method to configuring a Citrix ADC with Citrix Gateway deployment is to use the Citrix Gateway configuration wizard. The wizard walks you through configuration and creates all the necessary virtual servers, policies, and expressions, and applies settings based on the details provided.

After initial setup, the wizard can be used to manage your deployment and monitor its operation.

**Note**

The Citrix Gateway configuration wizard does not perform an initial systems configuration. Your Citrix Gateway appliance or VPX instance must have basic installation completed before configuring Citrix Gateway. Refer to the installation instructions for Configuring Citrix Gateway with the First-time Setup Wizard to complete basic configuration.

The Citrix Gateway elements configured by the wizard are:

• The Citrix Gateway primary virtual server
• An SSL Server Certificate for the Citrix Gateway virtual server
• A primary and any optional secondary authentication configuration
• A portal theme selection and optional customization
• The user applications that are to be accessed through the Citrix Gateway portal

For each of these elements, you need to provide configuration information. For a basic Citrix Gateway deployment, the following information is needed.

• For the primary Citrix Gateway virtual server, the public IP address and IP port number for the deployment. This will be the IP address that resolves in DNS to the Citrix Gateway URL's hostname. For example, if your Citrix Gateway deployment's URL is https://mycompany.com/, the IP address must resolve to mycompany.com.

• The signed SSL Server Certificate for the deployment. Citrix Gateway supports PEM or PFX formatted certificates.

• Primary authentication server information. The authentication systems supported for this authentication configuration are LDAP/Active Directory, RADIUS, and Certificate based. A secondary LDAP or RADIUS authentication configuration may be created as well. The authentication server IP address(es) must be provided along with any relevant administrator credentials or directory attributes. For Certificate authentication, the device certificate attributes and a CA certificate must be provided.

• A portal theme may be selected. If a customized or branded portal design is desired, custom graphics may be uploaded to the system with the wizard.

• For web-based user applications, the URLs for the individual applications must be specified. For web applications that are to utilize SAML single sign-on authentication, the utility collects the Assertion Consumer Service URL along with other optional SAML parameters. Gather the configuration details in advance for the applications that use a SAML authentication system.

• For Citrix Virtual Apps and Desktops published resources to be made available through the Citrix Gateway deployment, you need to specify the integration point (StoreFront, the Web Interface, or Web Interface on Citrix ADC). The utility requires the integration point's fully qualified domain name, the site path, the single sign-on domain, the Secure Ticket Authority (STA) server URL, and others depending on the type of integration point.

Additional Configuration Management

For site specific settings not available in the Citrix Gateway configuration utility, such as alternative SSL settings or session policies, you can manage the needed settings in the Citrix Gateway configuration utility. You can modify these settings on the Content Switching or VPN virtual servers once they are created by the Citrix Gateway configuration utility.
**Content Switching Virtual Server**

This is the Citrix ADC configuration entity behind the deployment's main IP address and URL. The SSL Server Certificates and parameters are managed on this virtual server. As this virtual server is the responding network host for the deployment, the ICMP server response and RHI state can be modified on this virtual server, if necessary. The Content Switching virtual server can be found under the Configuration tab at **Traffic Management > Content Switching > Virtual Servers**.

**VPN Virtual Server**

All of the other VPN parameters, profiles, and policy bindings for the Citrix Gateway configuration are managed on this virtual server, including the main authentication configuration. This entity is managed under the Configuration tab at Citrix Gateway > Virtual Servers. The relevant VPN virtual server's name will include the name given to the Content Switching virtual server during initial Citrix Gateway configuration.

---

**Note**

The VPN virtual servers created for a Citrix Gateway deployment are non-addressable and assigned the 0.0.0.0 IP address.

---

**Unified Gateway FAQ**

February 28, 2020

What is Unified Gateway?

Unified Gateway is a new feature in the Citrix ADC 11.0 release, providing the ability to receive traffic on a single virtual server (called a Unified Gateway virtual server) and then internally direct that traffic, as appropriate, to virtual servers that are bound to the Unified Gateway virtual server.

The Unified Gateway feature allows end users to access multiple services by using a single IP address or URL (associated with the Unified Gateway virtual server). Administrators can free up IP addresses and simplify the configuration of the Citrix Gateway deployment.

Each Unified Gateway virtual server can front-end one Citrix Gateway virtual server along with zero or more load balancing virtual servers as part of a formation. Unified Gateway works by leveraging the content switching feature of the Citrix ADC appliance.

Some examples of Unified Gateway deployments:

- Unified Gateway Virtual server -> [one Citrix Gateway virtual server]
• Unified Gateway Virtual server -> [one Citrix Gateway virtual server, one load balancing virtual server]
• Unified Gateway Virtual server -> [one Citrix Gateway virtual server, two load balancing virtual servers]
• Unified Gateway Virtual server -> [one Citrix Gateway virtual server, three load balancing virtual servers]

Each of the load balancing virtual servers can be any standard load balancing server that a hosts a backend service, such as Microsoft Exchange or Citrix ShareFile.

Why use Unified Gateway?
**

The Unified Gateway feature enables end users to access multiple services by using a single IP address or URL (associated with the Unified Gateway virtual server). For administrators, the advantage is that they can free up IP addresses and simplify the configuration of the Citrix Gateway deployment.

Can there be more than one Unified Gateway virtual server?
**

Yes. There can be as many Unified Gateway virtual servers as you need.

Why is content switching needed for Unified Gateway?
**

The content switching feature is required because the content switching virtual server is the one that receives traffic and internally directs it to the appropriate virtual server. The content switching virtual server is the primary component of the Unified Gateway feature.

In releases previous to 11.0, content switching can be used to receive traffic for multiple virtual servers. Is that use also called Unified Gateway?
**

Use of a content switching virtual server for receiving traffic for multiple virtual servers is supported in releases earlier than 11.0. However, content switching could not direct traffic to a Citrix Gateway virtual server.

The enhancements in 11.0 enable a content switching virtual server to direct traffic to any virtual server, including a Citrix Gateway virtual server.

What has changed with content switching policies in Unified Gateway?
**

1. A new command line parameter “-targetVserver” is added for the content switching action. The new parameter is used to specify the target Citrix Gateway virtual server. Example:

> add cs action UG_CSACT_MyUG -targetVserver UG_VPN_MyUG
In the Citrix Gateway configuration utility, the content switching action has a new option, Target Virtual Server, which can reference a Citrix Gateway virtual server.

2. A new advanced policy expression, is_vpn_url, can be used to match Citrix Gateway and authentication-specific requests.

What Citrix Gateway features are not currently supported in Unified Gateway?

All features are supported in Unified Gateway. However, a minor issue (issue ID 544325) has been reported with native logon through the VPN plugin. In this case, seamless single sign-on (SSO) does not work.

With Unified Gateway, what is the behavior of EPA scans?

With Unified Gateway, endpoint analysis is triggered only for Citrix Gateway access methods, not for AAA-TM access. If a user tries to access a AAA-TM virtual server even though the authentication is done on the Citrix Gateway virtual server, the EPA scan is not triggered. However, if the user is trying to gain clientless VPN/Full VPN access, the configured EPA scan is triggered. In that case, either authentication or seamless SSO is done.

**Setup**

What are the license requirements for Unified Gateway?

Unified Gateway is supported only for Advanced and Premium licenses. It will not be available for Citrix Gateway only or Standard license editions.

Does the Citrix Gateway virtual server used with Unified Gateway need an IP/Port/SSL configuration?

For a Citrix Gateway virtual server used with Unified Gateway virtual server, an IP/Port/SSL configuration is not needed on the Citrix Gateway virtual server. However, for RDP proxy functionality you can bind the same SSL/TLS server certificate to the Citrix Gateway virtual server.

Do I need to re-provision SSL/TLS certificates that are on Citrix Gateway virtual server for use with a Unified Gateway virtual server?

You do not need to re-provision certificates that are currently bound to your Citrix Gateway virtual server. You are free to reuse any existing SSL certificate(s) and to bind those to the Unified Gateway virtual server.

What is the difference between a single URL and a multi-host deployment? Which one do I need?

© 1999-2020 Citrix Systems, Inc. All rights reserved.
Single URL refers to the ability of the Unified Gateway virtual server handle traffic for one fully qualified domain name (FQDN). This restriction exists when Unified Gateway uses an SSL/TLS server certificate that has the certificate subject populated with the FQDN. For example: ug.citrix.com

If, however, Unified Gateway is using a wildcard server certificate, it can handle traffic for multiple sub-domains. For example: *.citrix.com

Another option is SSL/TLS configuration with Server Name Indicator (SNI) functionality to allow binding of multiple SSL/TLS server certificates. Examples: auth.citrix.com, auth.citrix.de, auth.citrix.co.uk, auth.citrix.co.jp

Single host versus multiple hosts is analogous to the way websites are typically hosted on a webserver (for example Apache HTTP server or Microsoft Internet Information Services (IIS)). If there is a single host, you can use site path to switch traffic the same way you use alias or “virtual directory” in Apache. If there are multiple hosts, you use a host header to switch traffic similarly to the way you use Virtual Hosts in Apache.

**Authentication**

What authentication mechanisms can be used with Unified Gateway?

All existing authentication mechanisms that work with Citrix Gateway work with Unified Gateway. These include LDAP, RADIUS, SAML, Kerberos, Certificate based Authentication, and so on.

Whatever authentication mechanism is configured on Citrix Gateway virtual server before the upgrade is used automatically when the Citrix Gateway virtual server is placed behind the Unified Gateway virtual server. There are no additional configuration steps involved, other than assigning a non-addressable IP address (0.0.0.0) to Citrix Gateway virtual server.

What is "SelfAuth” Authentication?

SelfAuth is not an authentication type per se. SelfAuth describes how a URL is created. A new command line parameter, ssotype, is available for VPN URL configuration. Example:

```bash
$ add vpn url RGB RGB "http://blue.citrix.lab/-vServerName Blue -ssotype selfauth
```

SelfAuth is one of the values of the ssotype parameter. This type of URL can be used to access resources that are not in the same domain as the Unified Gateway virtual server. The setting can be seen in the configuration utility when configuring a Bookmark.

What is "StepUp” Authentication’?

© 1999-2020 Citrix Systems, Inc. All rights reserved.
When additional, more secure levels of authentication are required for accessing a AAA-TM resource, you can use StepUp authentication. On the command line, use an authnProfile command to set the authenticationLevel parameter. Example:

```bash
> add authentication authnProfile AuthProfile -authnVsName AAATMVserver -AuthenticationHost auth.citrix.lab -AuthenticationDomain citrix.lab -AuthenticationLevel 100
```

This authentication profile is bound to the load balancing virtual server.

Is StepUp authentication supported for AAA-TM virtual servers?

Yes, it is supported.

What is login once/logout once?

Login Once: VPN users login once to either a AAA-TM or a Citrix Gateway virtual server. And from then on, VPN users have seamless access to all the Enterprise/Cloud/Web Applications. The user need not be reauthenticated. However, reauthentication is done for special cases, such as AAA-TM StepUp.

Logout Once: After the first AAA-TM or Citrix Gateway session is created, it is used to create subsequent AAA-TM or Citrix Gateway sessions for that user. If any of those sessions are logged out, the Citrix ADC appliance also logs out the user’s other applications or sessions.

Can common authentication policies be specified at the Unified Gateway level with AAA-TM load balancing virtual server specific authentication bound at the load balancing virtual server level? What are the configuration steps to support this use case?

If you need to specify separate authentication policies for AAA-TM virtual server behind Unified Gateway, you will need to have a separate, independently addressable authentication virtual server (similar to ordinary AAA-TM configuration). The authentication host setting on load balancing virtual server has to point to this authentication virtual server.

How do you configure Unified Gateway so that bound AAA-TM virtual server(s) have their own authentication policies?

In this scenario, the load balancing server must have the authentication FQDN option set to point to the AAA-TM virtual server. The AAA-TM virtual server must have an independent IP address and be reachable from Citrix ADC and clients.

Is a AAA-TM Authentication Virtual server required for authenticating users coming through a Unified Gateway virtual server?

No. The Citrix Gateway virtual server will authentication even the AAA-TM users.

© 1999-2020 Citrix Systems, Inc. All rights reserved.
Where do you specify Citrix Gateway Authentication policies—at the Unified Gateway virtual server or at the Citrix Gateway virtual server?

**

Authentication policies are to be bound to Citrix Gateway virtual server.

How do you enable authentication on AAA-TM Virtual servers behind a Unified Gateway content switching virtual server?

**

Enable authentication on AAA-TM and point the authentication host to the Unified Gateway content switching FQDN.

### AAA-Traffic Management

How do I add TM Virtual servers behind content switching (single URL vs. multi-host)?

**

There is no difference between adding AAA-TM virtual servers for a single URL and adding it for multiple hosts. In either case, the virtual server is added as a target in a content switching action. The difference between single URL vs multi-host is implemented by content-switching policy rules.

What happens to authentication policies bound to a AAA-TM load balancing virtual server if that virtual server is moved behind a Unified Gateway virtual server?

**

Authentication policies are bound to authentication virtual server, and the authentication virtual server is bound to the load balancing virtual server. For the Unified Gateway virtual server, Citrix recommends having the Citrix Gateway virtual server as the single authentication point, which negates the need to perform authentication on an authentication virtual server (or even the need for a specific authentication virtual server). Pointing the authentication host to the Unified Gateway virtual server FQDN ensures that authentication is done by Citrix Gateway virtual server. If you point the authentication host to content switching for Unified Gateway and still have an authentication virtual server bound, the authentication policies bound to the authentication virtual server are ignored. However, if you point an authentication host to an independent addressable authentication virtual server, the bound authentication policies bound take effect.

How do you configure session policies for AAA-TM sessions?

**

If, in Unified Gateway, no authentication virtual server is specified for the AAA-TM virtual server, the AAA-TM sessions inherit the Citrix Gateway session policies. If the authentication virtual server is specified, the AAA-TM session policies bound to that virtual server are applied.
**Portal Customization**

What are the changes to Citrix Gateway portal in Citrix ADC 11.0?

In Citrix ADC releases earlier than 11.0, a single portal customization can be set up at the global level. Every gateway virtual server in a given Citrix ADC appliance uses the global portal customization.

In Citrix ADC 11.0, with the portal themes feature, you can set up multiple portal themes. Themes can be bound globally or to specific virtual servers.

Does Citrix ADC 11.0 support Citrix Gateway portal customization?

Using the configuration utility, you can use the new portal themes feature to customize and create the new portal themes completely. You can upload different images, set color schemes, change text labels and so on.

The portal pages that can be customized are:

- Login Page
- Endpoint Analysis Page
- Endpoint Analysis Error Page
- Post Endpoint Analysis Page
- VPN Connection Page
- Portal Home Page

With this release, you can customize Citrix Gateway virtual servers with unique portal designs.

Are portal themes supported in Citrix ADC high availability or cluster deployments?

Yes. Portal Themes are supported in Citrix ADC high availability and cluster deployments.

Will my customizations be migrated as part of the Citrix ADC 11.0 upgrade process?

No. Existing customizations to the Citrix Gateway portal page that are invoked through rc.conf/rc.netscaler file modification or by using custom theme functionality in 10.1/10.5 will not be automatically migrated upon upgrade to Citrix ADC 11.0.

Are there any pre-upgrade steps to follow to be ready for portal themes in Citrix ADC 11.0?

Any existing customizations have to be removed from the rc.conf or rc.netscaler file(s).

The other option is that if custom themes are used, they have to be assigned the Default setting:

Navigate to **Configuration > Citrix Gateway > Global Settings**
Click **Change Global Settings**. Click **Client Experience** and select **Default** from **UI Theme** drop-down list.  

I have customizations that are stored on the Citrix ADC instance, invoked by rc.conf or rc.netscaler. How do I move to portal themes?  

Citrix Knowledge Center article CTX126206 details such a configuration for Citrix ADC 9.3 and 10.0 releases up to 10.0 build 73.5001.e. Since Citrix ADC 10.0 build 10.0 73.5002.e (including 10.1 and 10.5), the UITHEME CUSTOM parameter has been available to help customers retain their customizations across reboots. If customizations are stored on the Citrix ADC hard drive and you would like to continue using these customizations, back up the 11.0 GUI files and insert them into the existing custom theme file. If you want to move to portal themes, you must first unset the UITHEME parameter in the Global Settings or the Session profile, under Client Experience. Or, you can set it to DEFAULT or GREENBUBBLE. Then you are able to start to create and bind a Portal Theme.  

How can I export my current customizations and save them before upgrading to Citrix ADC 11.0? Can I move the exported files to a different Citrix ADC appliance?  

The customized files that were uploaded to the ns_gui_custom folder are on the disk and persist across upgrades. However, these files might not be entirely compatible with the new Citrix ADC 11.0 kernel and other GUI files that are part of the kernel. Therefore, Citrix recommends backing up the 11.0 GUI files and customizing the backups.  

Moreover, there is no utility in the configuration utility to export the ns_custom_gui folder to another Citrix ADC appliance. You have to use SSH or a file transfer utility such as WinSCP to take the files off of the Citrix ADC instance.  

Are portal themes supported for AAA-TM virtual servers?  

Yes. Portal Themes are supported for AAA-TM virtual servers.  

**RDP Proxy**  

What changed in RDP Proxy for Citrix Gateway 11.0?  

Many enhancements have been made to RDP Proxy since the Citrix ADC 10.5.e enhancement release. In Citrix ADC 11.0 this feature is available from the first released build.
Licensing changes

The RDP Proxy feature in Citrix ADC 11.0 can be used only with Premium and Advanced editions. Citrix Concurrent User (CCU) licenses must be obtained for each user.

Enable Command

In Citrix ADC 10.5.e there was no command to enable RDP Proxy. In Citrix ADC 11.0, the enable command has been added:

> enable feature rdpproxy

The feature must be licensed to run this command.

Other RDP Proxy Changes

A Pre-shared Key (PSK) attribute on the server profile has been made mandatory.

To migrate existing Citrix ADC 10.5.e configurations for RDP proxy to Citrix ADC 11.0, the following details should be understood and addressed.

If an administrator wants to add an existing RDP proxy configuration to a chosen Unified Gateway deployment:

- The Citrix Gateway virtual server’s IP address must be edited and set to a non-addressable IP address (0.0.0.0).
- Any SSL/TLS server certificates, authentication policies must be bound to the Citrix Gateway virtual server that is part of the chosen Unified Gateway formation.

How do you migrate a Remote Desktop Protocol (RDP) Proxy configuration based on Citrix ADC 10.5.e to Citrix ADC 11.0?

**

Option 1: Keep the existing Citrix Gateway virtual server with RDP Proxy configuration as is, with a Premium or Advanced license.

Option 2: Move the existing Citrix Gateway virtual server with RDP Proxy configuration, placing it behind a Unified Gateway virtual server.

Option 3: Add a standalone Citrix Gateway virtual server with RDP Proxy configuration to an existing Standard Edition appliance.

How do you set up Citrix Gateway for RDP proxy configuration using the Citrix ADC 11.0 release?

**

There are two options for deploying RDP proxy using the NS 11.0 release:
1) Using an externally facing Citrix Gateway virtual server. This requires one externally visible IP address/FQDN for the Citrix Gateway virtual server. This option is what is available in Citrix ADC 10.5.e.

2) Using a Unified Gateway virtual server front-ending the Citrix Gateway virtual server.

With Option 2 the Citrix Gateway virtual server does not require its own IP address/FQDN, because it uses a non-addressable IP address (0.0.0.0).

**Integrating with other Citrix Software**

Will HDX Insight work with Unified Gateway?

When Citrix Gateway is deployed with Unified Gateway, the Citrix Gateway virtual server must have a valid SSL certificate bound to it, and it must be in an UP state in order to generate AppFlow records for Citrix ADC Insight Center for the purposes of HDX Insight reporting.

How do I migrate my existing HDX Insight configuration?

No migration is needed. AppFlow policies bound to a Citrix Gateway virtual server carry over if that Citrix Gateway virtual server is put behind a Unified Gateway virtual server.

For existing data in Citrix ADC Insight Center for the Citrix Gateway virtual server, there are two possibilities:

- If the IP Address of the Citrix Gateway virtual server is assigned to a Unified Gateway virtual server as part of migration to Unified Gateway, the data remains linked to the Citrix Gateway virtual server
- If the Unified Gateway virtual server is assigned a separate IP address, AppFlow data from the Citrix Gateway virtual server will be linked to that new IP address. Therefore, existing data will not be part of new data.

**Deploying in a Double-Hop DMZ**

September 10, 2019

Some organizations use three firewalls to protect their internal networks. The three firewalls divide the DMZ into two stages to provide an extra layer of security for the internal network. This network configuration is called a double-hop DMZ.

Figure 1. Citrix Gateway appliances deployed in a double-hop DMZ
Deploying Citrix Gateway in a Double-Hop DMZ

September 10, 2019

Some organizations use three firewalls to protect their internal networks. The three firewalls divide the DMZ into two stages to provide an extra layer of security for the internal network. This network configuration is called a double-hop DMZ. You can deploy Citrix Gateway in a double-hop DMZ with Citrix Virtual Apps and StoreFront.

Figure 1. Citrix Gateway appliances deployed in a double-hop DMZ
Note: For illustration purposes, the preceding example describes a double-hop configuration using three firewalls and the Web Interface, but you can also have a double-hop DMZ with one appliance in the DMZ and one appliance in the secure network. If you configure a double-hop configuration with one appliance in the DMZ and one in the secure network, you can ignore the instructions for opening ports on the third firewall.

You can configure a double-hop DMZ to work with Citrix StoreFront or the Web Interface. Users connect by using Citrix Workspace app.

Note

If you deploy Citrix Gateway in a double-hop DMZ with StoreFront, email-based auto-discovery for Citrix Workspace app does not work.

**How a Double-Hop Deployment Works**

September 10, 2019

You can deploy Citrix Gateway appliances in a double-hop DMZ to control access to servers running Citrix Virtual Apps. The connections in a double-hop deployment occur as follows:

- Users connect to Citrix Gateway in the first DMZ by using a web browser and by using Citrix Workspace app to select a published application.

- Citrix Workspace app starts on the user device. The user connects to Citrix Gateway to access the published application running in the server farm in the secure network.

  **Note:** Secure Hub and the Citrix Gateway plug-in are not supported in a double-hop DMZ deployment. Only Citrix Workspace app is used for user connections.
• Citrix Gateway in the first DMZ handles user connections and performs the security functions of an SSL VPN. This Citrix Gateway encrypts user connections, determines how the users are authenticated, and controls access to the servers in the internal network.

• Citrix Gateway in the second DMZ serves as a Citrix Gateway proxy device. This Citrix Gateway enables the ICA traffic to traverse the second DMZ to complete user connections to the server farm. Communications between Citrix Gateway in the first DMZ and the Secure Ticket Authority (STA) in the internal network are also proxied through Citrix Gateway in the second DMZ.

Citrix Gateway supports IPv4 and IPv6 connections. You can use the configuration utility to configure the IPv6 address.

The following table suggests the double-hop deployment support for the various ICA features:

<table>
<thead>
<tr>
<th>ICA feature</th>
<th>Double-hop support</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartAccess</td>
<td>Yes</td>
</tr>
<tr>
<td>SmartControl</td>
<td>Yes</td>
</tr>
<tr>
<td>Enlightened Data Transport (EDT)</td>
<td>Yes</td>
</tr>
<tr>
<td>HDX Insight</td>
<td>Yes</td>
</tr>
<tr>
<td>ICA Session Reliability (Port 2598)</td>
<td>Yes</td>
</tr>
<tr>
<td>ICA Session Migration</td>
<td>Yes</td>
</tr>
<tr>
<td>ICA Session Timeout</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Stream ICA</td>
<td>Yes</td>
</tr>
<tr>
<td>Framehawk</td>
<td>No</td>
</tr>
<tr>
<td>UDP audio</td>
<td>No</td>
</tr>
</tbody>
</table>

**Communication Flow in a Double-Hop DMZ Deployment**

September 10, 2019

To understand the configuration issues involved in a double-hop DMZ deployment, you should have a basic understanding of how the various Citrix Gateway and Citrix Virtual Apps components in a double-hop DMZ deployment communicate to support a user connection. The connection process for StoreFront and the Web Interface is the same.

Although the user connection process occurs in one continuous flow, the steps are detailed in the four following topics:
Citrix Gateway 13.0

- Authenticating Users
- Creating a Session Ticket
- Starting Citrix Workspace app
- Completing the Connection

The following figure shows the steps that occur in the user connection process to either StoreFront or the Web Interface. In the secure network, computers running Citrix Virtual Apps are also running the Secure Ticket Authority (STA), XML Service, and published applications.

Figure 1. Double-hop DMZ user connection process

Authenticating Users

April 23, 2019

Authenticating users is the first step of the user connection process in a double-hop DMZ deployment. The following figure shows the user connection process in this deployment.

Figure 1. Communication flow for user authentication in a double-hop DMZ

During the user authentication stage, the following basic process occurs:
1. A user types the address of Citrix Gateway, such as https://www.ng.wxyco.com in a web browser to connect to Citrix Gateway in the first DMZ. If you enabled logon page authentication on Citrix Gateway, Citrix Gateway authenticates the user.

2. Citrix Gateway in the first DMZ receives the request.

3. Citrix Gateway redirects the web browser connection to the Web Interface.

4. The Web Interface sends the user credentials to the Citrix XML Service running in the server farm in the internal network.

5. The Citrix XML Service authenticates the user.

6. The XML Service creates a list of the published applications that the user is authorized to access and sends this list to the Web Interface.

If you enable authentication on Citrix Gateway, the appliance sends the Citrix Gateway logon page to the user. The user enters authentication credentials on the logon page and the appliance authenticates the user. Citrix Gateway then returns the user credentials to the Web Interface.

If you do not enable authentication, Citrix Gateway does not perform authentication. The appliance connects to the Web Interface, retrieves the Web Interface logon page, and sends the Web Interface logon page to the user. The user enters authentication credentials on the Web Interface logon page and Citrix Gateway passes the user credentials back to the Web Interface.

Creating a Session Ticket

April 23, 2019

Creating the session ticket is the second stage of the user connection process in a double-hop DMZ deployment.

During the session ticket creation stage, the following basic process occurs:

1. The Web Interface communicates with both the XML Service and the Secure Ticket Authority (STA) in the internal network to produce session tickets for each of the published applications the user is authorized to access. The session ticket contains an alias address for the computer running Citrix Virtual Apps that hosts a published application.

2. The STA saves the IP addresses of the servers that host the published applications. The STA then sends the requested session tickets to the Web Interface. Each session ticket includes an alias that represents the IP address of the server that hosts the published application, but not the actual IP address.

3. The Web Interface generates an ICA file for each of the published applications. The ICA file contains the ticket issued by the STA. The Web Interface then creates and populates a web page with a list of links to the published applications and sends this web page to the web browser on the user device.
**Starting Citrix Workspace app**

September 10, 2019

Starting Citrix Workspace app is the third stage of the user connection process in a double-hop DMZ deployment. The basic process is as follows:

1. The user clicks a link to a published application in the Web Interface. The Web Interface sends the ICA file for that published application to the browser for the user device.

   The ICA file contains data instructing the web browser to start Receiver.

   The ICA file also contains the fully qualified domain name (FQDN) or the Domain Name System (DNS) name of the Citrix Gateway in the first DMZ.

2. The web browser starts Receiver and the user connects to Citrix Gateway in the first DMZ by using the Citrix Gateway name in the ICA file. Initial SSL/TLS handshaking occurs to establish the identity of the server running Citrix Gateway.

**Completing the Connection**

September 26, 2019

Completing the connection is the fourth and last stage of the user connection process in a double-hop DMZ deployment.

During the connection completion stage, the following basic process occurs:

- The user clicks a link to a published application in the Web Interface.
- The web browser receives the ICA file generated by the Web Interface and starts Citrix Workspace app.
  
  Note: The ICA file contains code that instructs the web browser to start Citrix Workspace app.

- Citrix Workspace app initiates an ICA connection to Citrix Gateway in the first DMZ.

- Citrix Gateway in the first DMZ communicates with the Secure Ticket Authority (STA) in the internal network to resolve the alias address in the session ticket to the real IP address of a computer running Citrix Virtual Apps or StoreFront. This communication is proxied through the second DMZ by the Citrix Gateway proxy.

- Citrix Gateway in the first DMZ completes the ICA connection to Citrix Workspace app.

- Citrix Workspace app can now communicate through both Citrix Gateway appliances to the computer running Citrix Virtual Apps on the internal network.

The detailed steps for completing the user connection process are as follows:
1. Citrix Workspace app sends the STA ticket for the published application to Citrix Gateway in the first DMZ.
2. Citrix Gateway in the first DMZ contacts the STA in the internal network for ticket validation. To contact the STA, Citrix Gateway establishes a SOCKS or SOCKS with SSL connection to the Citrix Gateway proxy in the second DMZ.
3. The Citrix Gateway proxy in the second DMZ passes the ticket validation request to the STA in the internal network. The STA validates the ticket and maps it to the computer running Citrix Virtual Apps that hosts the published application.
4. The STA sends a response to the Citrix Gateway proxy in the second DMZ, which is passed to Citrix Gateway in the first DMZ. This response completes the ticket validation and includes the IP address of the computer that hosts the published application.
5. Citrix Gateway in the first DMZ incorporates the address of the Citrix Virtual Apps server into the user connection packet and sends this packet to the Citrix Gateway proxy in the second DMZ.
6. The Citrix Gateway proxy in the second DMZ makes a connection request to the server specified in the connection packet.
7. The server responds to the Citrix Gateway proxy in the second DMZ. The Citrix Gateway proxy in the second DMZ passes this response to Citrix Gateway in the first DMZ to complete the connection between the server and Citrix Gateway in the first DMZ.
8. Citrix Gateway in the first DMZ completes the SSL/TLS handshake with the user device by passing the final connection packet to the user device. The connection from the user device to the server is established.
9. ICA traffic flows between the user device and the server through Citrix Gateway in the first DMZ and the Citrix Gateway proxy in the second DMZ.

Preparing for a Double-Hop DMZ Deployment

April 23, 2019

To prepare appropriately and avoid unnecessary problems when configuring a double-hop DMZ deployment, you should answer the following questions:

- Do I want to support load balancing?
- What ports do I need to open on the firewalls?
- How many SSL certificates will I need?
- What components do I need before I begin the deployment?

The topics in this section contain information to help you answer these questions as appropriate for your environment.
Components Required to Begin the Deployment

Before you begin a double-hop DMZ deployment, ensure that you have the following components:

- At minimum, two Citrix Gateway appliances must be available (one for each DMZ).
- Servers running Citrix Virtual Apps must be installed and operational in the internal network.
- The Web Interface or Storefront must be installed in the second DMZ and configured to operate with the server farm in the internal network.
- At minimum, one SSL server certificate must be installed on Citrix Gateway in the first DMZ. This certificate ensures that the Web browser and user connections to Citrix Gateway are encrypted. You need additional certificates if you want to encrypt connections that occur among the other components in a double-hop DMZ deployment.

Installing and Configuring Citrix Gateway in a Double-Hop DMZ

April 2, 2020

You need to complete several steps to deploy Citrix Gateway in a double-hop DMZ. The steps include installation of appliances in both DMZs and configuring the appliances for user device connections.

Installing Citrix Gateway in the First DMZ

To install Citrix Gateway in the first DMZ, follow the instructions in Install the hardware.

If you are installing multiple Citrix Gateway appliances in the first DMZ, you can deploy the appliances behind a load balancer.

Configuring Citrix Gateway in the First DMZ

In a double-hop DMZ deployment, it is mandatory that you configure each Citrix Gateway in the first DMZ to redirect connections to either StoreFront or the Web Interface in the second DMZ.

Redirection to StoreFront or the Web Interface is performed at the Citrix Gateway Global or virtual server level. To connect to the Web Interface through Citrix Gateway, a user must be associated with a Citrix Gateway user group for which redirection to the Web Interface is enabled.
Installing Citrix Gateway in the Second DMZ

The Citrix Gateway appliance in the second DMZ is called the Citrix Gateway proxy because it proxies ICA and Secure Ticket Authority (STA) traffic across the second DMZ. Install the hardware to install each Citrix Gateway appliance in the second DMZ.

You can use this installation procedure to install additional appliances in the second DMZ.

After you install Citrix Gateway appliances in the second DMZ, you configure the following settings:

- Configure a virtual server on the Citrix Gateway proxy.
- Configure Citrix Gateway appliances in the first and second DMZ to communicate with each other.
- Bind the Citrix Gateway in the second DMZ globally or to a virtual server.
- Configure the STA on the appliance in the first DMZ.
- Open ports in the firewalls separating the DMZ.
- Install certificates on the appliances.

Configuring Settings on the Virtual Servers on the Citrix Gateway Proxy

December 18, 2019

To allow connections to pass between the Citrix Gateway appliances, you enable double-hop in the virtual server on the Citrix Gateway proxy.

When users connect, the Citrix Gateway appliance authenticates users and then proxies the connection to the proxy appliance. On the Citrix Gateway in the first DMZ, configure the virtual server to communicate with Citrix Gateway in the second DMZ. Do not configure authentication or policies on the Citrix Gateway proxy. Citrix recommends disabling authentication on the virtual server.

To enable double hop on the virtual server on the Citrix Gateway proxy by using the GUI

1. Navigate to Configuration > Citrix Gateway > Virtual Servers.
2. Select a virtual server and click Edit.
3. In the Basic Settings section, click the edit icon and then click More.
4. Select **Double Hop**.

5. Click **OK**.

To disable authentication on the virtual server on the Citrix Gateway proxy by using the GUI

1. Navigate to **Configuration > Citrix Gateway > Virtual Servers**.
2. Select a virtual server and click **Edit**.
3. In the **Basic Settings** section, click the edit icon and then click **More**.
4. Clear the **Enable Authentication** check box.
5. Click **OK**.

### Configuring the Appliance to Communicate with the Appliance Proxy

April 23, 2019

When you deploy Citrix Gateway in a double-hop DMZ, you must configure Citrix Gateway in the first DMZ to communicate with the Citrix Gateway proxy in the second DMZ.

If you deploy multiple appliances in the second DMZ, you configure each appliance in the first DMZ to communicate with every proxy appliance in the second DMZ.

Note: If you want to use IPv6, you configure the next hop server by using the configuration utility. To do so, expand Citrix Gateway > Resources and then click Next Hop Servers. Follow the steps in the following procedure and then select the IPv6 check box.

To configure **Citrix Gateway to communicate with the Citrix Gateway Proxy**

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Resources and then click Next Hop Servers.
2. In the details pane, click Add.
3. In Name, type a name for the first Citrix Gateway.
4. In IP address, type the virtual server IP address of the Citrix Gateway proxy in the second DMZ.
5. In Port, type the port number, click Create and then click Close. If you are using a secure port, such as 443, select Secure.
Citrix Gateway 13.0

You must configure each Citrix Gateway installed in the first DMZ to communicate with all Citrix Gateway proxy appliances installed in the second DMZ.

After you configure the settings for the Citrix Gateway proxy, bind the policy to Next Hop Servers in Citrix Gateway Global or to a virtual server.

To bind the Citrix Gateway next hop server globally

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Resources and then click Next Hop Servers.
2. In the details pane, select a next hop server and then in Action, select Global Bindings.
3. In the Configure Next Hop Server Global Binding dialog box, in Next Hop Server Name, select the proxy appliance and then click OK.

To bind the Citrix Gateway next hop server to a virtual server

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. On the Published Applications tab, under Next Hop Servers, click an item and then click OK.

You can also add a next hop server from the Published Applications tab.

Configuring Citrix Gateway to Handle the STA and ICA Traffic

April 23, 2019

When you deploy Citrix Gateway in a double-hop DMZ, you must configure Citrix Gateway in the first DMZ to handle communications with the Secure Ticket Authority (STA) and ICA traffic appropriately. The server running the STA can be bound either globally or to a virtual server.

After you configure the STA, you can bind the STA either globally or to a virtual server.

To configure and bind the STA globally:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Servers, click Bind/Unbind STA Servers to be used by the Secure Ticket Authority.
3. In the Bind/Unbind STA Servers dialog box, click Add.
4. In the Configure STA Server dialog box, in URL, type the path to the server running the STA, such as http://mycompany.com or http://ipAddress and then click Create.

To configure and bind the STA to a virtual server:

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. On the Published Applications tab, under Secure Ticket Authority, click Add.
4. In the Configure STA Server dialog box, in URL, type the path to the server running the STA, such as http://mycompany.com or http://ipAddress and then click Create.

Opening the Appropriate Ports on the Firewalls

September 10, 2019

You must ensure that the appropriate ports are open on the firewalls to support the different connections that occur among the various components involved in a double-hop DMZ deployment. For more information about the connection process, see Communication Flow in a Double-Hop DMZ Deployment.

The following figure shows common ports that can be used in a double-hop DMZ deployment.

The following table shows the connections that occur through the first firewall and the ports that must be open to support the connections.

The following table shows the connections that occur through the first firewall and the ports that must be open to support the connections.
The web browser from the Internet connects to Citrix Gateway in the first DMZ. **Note:** Citrix Gateway includes an option to redirect connections that are made on port 80 to a secure port. If you enable this option on Citrix Gateway, you can open port 80 through the first firewall. When a user makes an unencrypted connection to Citrix Gateway on port 80, Citrix Gateway automatically redirects the connection to a secure port.

Citrix Workspace app from the Internet connects to Citrix Gateway in the first DMZ.

---

The following table shows the connections that occur through the second firewall and the ports that must be open to support the connections.

<table>
<thead>
<tr>
<th>Connections through the second firewall</th>
<th>Ports used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Gateway in the first DMZ connects to the Web Interface in the second DMZ.</td>
<td>Open either TCP port 80 for an unsecure connection or TCP port 443 for a secure connection through the second firewall.</td>
</tr>
<tr>
<td>Citrix Gateway in the first DMZ connects to Citrix Gateway in the second DMZ.</td>
<td>Open TCP port 443 for a secure SOCKS connection through the second firewall.</td>
</tr>
<tr>
<td>If you enabled authentication on Citrix Gateway in the first DMZ, this appliance might need to connect to an authentication server in the internal network.</td>
<td>Open the TCP port on which the authentication server listens for connections. Examples include port 1812 for RADIUS and port 389 for LDAP.</td>
</tr>
</tbody>
</table>

The following table shows the connections that occur through the third firewall and the ports that must be open to support the connections.

<table>
<thead>
<tr>
<th>Connections through the third firewall</th>
<th>Ports used</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFront or the Web Interface in the second DMZ connects to the XML Service hosted on a server in the internal network.</td>
<td>Open either port 80 for an unsecure connection or port 443 for a secure connection through the third firewall.</td>
</tr>
</tbody>
</table>
Citrix Gateway 13.0

<table>
<thead>
<tr>
<th>Connections through the third firewall</th>
<th>Ports used</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFront or the Web Interface in the second DMZ connects to the Secure Ticket Authority (STA) hosted on a server in the internal network.</td>
<td>Open either port 80 for an unsecure connection or port 443 for a secure connection through the third firewall.</td>
</tr>
<tr>
<td>Citrix Gateway in the second DMZ connects to the STA residing in the secure network.</td>
<td>Open either port 80 for an unsecure connection or port 443 for a secure connection through the third firewall.</td>
</tr>
<tr>
<td>Citrix Gateway in the second DMZ makes an ICA connection to a published application or virtual desktop on a server in the internal network.</td>
<td>Open TCP port 1494 to support ICA connections through the third firewall. If you enabled session reliability on Citrix Virtual Apps, open TCP port 2598 instead of 1494.</td>
</tr>
<tr>
<td>If you enabled authentication on Citrix Gateway in the first DMZ, this appliance may need to connect to an authentication server in the internal network.</td>
<td>Open the TCP port on which the authentication server listens for connections. Examples include port 1812 for RADIUS and port 389 for LDAP.</td>
</tr>
</tbody>
</table>

Managing SSL Certificates in a Double-Hop DMZ Deployment

September 10, 2019

You must install the SSL certificates necessary to encrypt the connections among components in a double-hop DMZ deployment.

In a double-hop DMZ deployment, several different types of connections occur among the various components involved in the deployment. There is no end-to-end SSL encryption of these connections. However, each connection can be encrypted individually.

Encrypting a connection requires you to install the appropriate SSL certificate (either a trusted root or a server certificate) on the components involved in the connection.

The following table shows the connections that occur through the first firewall and the SSL certificates required to encrypt each of these connections. Encrypting the connections through the first firewall is mandatory to secure traffic sent over the Internet.
Citrix Gateway 13.0

Connections through the first firewall | Certificates required for encryption
--- | ---
The web browser from the Internet connects to Citrix Gateway in the first DMZ. | Citrix Gateway in the first DMZ must have an SSL server certificate installed. The web browser must have a root certificate installed that is signed by the same Certificate Authority (CA) as the server certificate on Citrix Gateway.
Citrix Workspace app from the Internet connects to Citrix Gateway in the first DMZ. | The certificate management for this connection is the same as the web browser to Citrix Gateway connection. If you installed the certificates to encrypt the web browser connection, this connection is also encrypted using those certificates.

The following table shows the connections that occur through the second firewall and the SSL certificates required to encrypt each of these connections. Encrypting these connections enhances security but is not mandatory.

<table>
<thead>
<tr>
<th>Connections through the second firewall</th>
<th>Certificates required for encryption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Gateway in the first DMZ connects to the Web Interface in the second DMZ.</td>
<td>StoreFront or the Web Interface must have an SSL server certificate installed. Citrix Gateway in the first DMZ must have a root certificate installed that is signed by the same CA as the server certificate on the Web Interface.</td>
</tr>
<tr>
<td>Citrix Gateway in the first DMZ connects to Citrix Gateway in the second DMZ.</td>
<td>Citrix Gateway in the second DMZ must have an SSL server certificate installed. Citrix Gateway in the first DMZ must have a root certificate installed that is signed by the same CA as the server certificate on Citrix Gateway in the second DMZ.</td>
</tr>
</tbody>
</table>

The following table below shows the connections that occur through the third firewall and the SSL certificates required to encrypt each of these connections. Encrypting these connections enhances security but is not mandatory.

© 1999-2020 Citrix Systems, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Connections through the third firewall</th>
<th>Certificates required for encryption</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFront or the Web Interface in the second DMZ connects to the XML Service hosted on a server in the internal network.</td>
<td>If the XML Service runs on Microsoft Internet Information Services (IIS) server on the Citrix Virtual Apps server, an SSL server certificate must be installed on the IIS server. If the XML Service is a standard Windows service (does not reside in IIS), an SSL server certificate must be installed within the SSL Relay on the server. StoreFront or the Web Interface must have a root certificate installed that is signed by the same CA as the server certificate installed on either the Microsoft IIS server or the SSL Relay.</td>
</tr>
<tr>
<td>StoreFront or the Web Interface in the second DMZ connects to the STA hosted on a server in the internal network.</td>
<td>The certificate management for this connection is the same as the Web Interface to XML Service connection. You can use the same certificates to encrypt this connection. (The server certificate must reside on either the Microsoft IIS server or the SSL Relay. A corresponding root certificate must be installed on the Web Interface.)</td>
</tr>
<tr>
<td>Citrix Gateway in the second DMZ connects to the STA hosted on a server in the internal network.</td>
<td>The SSL server certificate management for the STA in this connection is the same as described for the two previous connections discussed in this table. (The server certificate must reside on either the Microsoft IIS server or the SSL Relay.) Citrix Gateway in the second DMZ must have a root certificate installed that is signed by the same CA as the server certificate used by the STA and XML service.</td>
</tr>
<tr>
<td>Citrix Gateway in the second DMZ makes an ICA connection to a published application on a server in the internal network.</td>
<td>An SSL server certificate must be installed within the SSL Relay on the server hosting the published application. Citrix Gateway proxy in the second DMZ must have a root certificate installed that is signed by the same CA as the server certificate installed within the SSL Relay.</td>
</tr>
</tbody>
</table>
Using High Availability

April 23, 2019

A high availability deployment of two Citrix Gateway appliances can provide uninterrupted operation in any transaction. When you configure one appliance as the primary node and the other as the secondary node, the primary node accepts connections and manages servers while the secondary node monitors the primary. If, for any reason, the primary node is unable to accept connections, the secondary node takes over.

The secondary node monitors the primary by sending periodic messages (often called heartbeat messages or health checks) to determine whether the primary node is accepting connections. If a health check fails, the secondary node retries the connection for a specified period, after which it determines that the primary node is not functioning normally. The secondary node then takes over for the primary (a process called failover).

After a failover, all clients must reestablish their connections to the managed servers, but the session persistence rules are maintained as they were before the failover.

With Web server logging persistence enabled, no log data is lost due to the failover. For logging persistence to be enabled, the log server configuration must carry entries for both systems in the log.conf file.

The following figure shows a network configuration with a high availability pair.

Figure 1. Citrix Gateway Appliances in a High Availability Configuration
The basic steps to configure high availability are as follows:

1. Create a basic setup, with both nodes in the same subnet.
2. Customize the intervals at which the nodes communicate health-check information.
3. Customize the process by which nodes maintain synchronization.
4. Customize the propagation of commands from the primary to the secondary.
5. Optionally, configure fail-safe mode to prevent a situation in which neither node is primary.
6. Configure virtual MAC addresses if your environment includes devices that do not accept Citrix Gateway gratuitous ARP messages.

When you are ready for a more complex configuration, you can configure high availability nodes in different subnets.

To improve the reliability of your high availability setup, you can configure route monitors and create redundant links. In some situations, such as when troubleshooting or performing maintenance tasks, you might want to force a node to fail over (assign primary status to the other node), or you might want to force the secondary node to stay secondary or the primary node to stay primary.
How high availability works

April 23, 2019

When you configure Citrix Gateway in a high availability pair, the secondary Citrix Gateway monitors the first appliance by sending periodic messages, also called a heartbeat message or health check, to determine if the first appliance is accepting connections. If a health check fails, the secondary Citrix Gateway tries the connection again for a specified amount of time until it determines that the primary appliance is not working. If the secondary appliance confirms the health check failure, the secondary Citrix Gateway takes over for the primary Citrix Gateway. This is called failover.

The following ports are used to exchange information related to high availability between Citrix Gateway appliances:

- UDP port 3003 is used to exchange hello packets for communicating the status for intervals.
- TCP port 3010 is used for the high availability configuration synchronization.
- TCP port 3011 is used to synchronize configuration settings.

Guidelines for configuring high availability

Before configuring a high availability pair, you should review these guidelines:

- Each Citrix Gateway appliance must be running the same version of the Citrix Gateway software. You can find the version number at the top of the page in the configuration utility.
- Citrix Gateway does not automatically synchronize passwords between two appliances. You can choose to configure each Citrix Gateway with the user name and password of the other appliance in the pair.
- Entries in the configuration file, ns.conf, on both the primary and the secondary Citrix Gateway must match, with the following exceptions:
  - The primary and secondary Citrix Gateway appliance must each be configured with its own unique system IP address. Use the Setup Wizard to configure or modify the system IP address on either Citrix Gateway.
  - In a high availability pair, the Citrix Gateway ID and associated IP address must point to the other Citrix Gateway.
    For example, if you have two appliances, named AG1 and AG2, you must configure AG1 with the unique Citrix Gateway ID and IP address of AG2. You must configure AG2 with the unique Citrix Gateway ID and IP address of AG1.
    Note: Each Citrix Gateway appliance are always identified as Node 0. Configure each appliance with a unique node ID.
- Each appliance in the high availability pair must have the same license. For more information about licensing, see Licensing.
• If you create a configuration file on either node by using a method that does not go directly through the configuration utility or the command-line interface (for example, importing SSL certificates, or changing to startup scripts), you must copy the configuration file to the other node or create an identical file on that node.

• When you configure a high availability pair, make sure the mapped IP addresses and default gateway address of both the primary and the secondary appliances are identical. If necessary, you can change the mapped IP address at any time by running the Setup Wizard.

You can use the pre-installation checklist to view a list of the specific settings you need to configure in a high availability deployment, For details, see Pre-Installation Checklist.

Configuring settings for high availability

April 23, 2019

To set up a high availability configuration, you create two nodes, each of which defines the other’s Citrix Gateway IP address as a remote node. You can start by logging on to one of the two Citrix ADC appliances that you want to configure for high availability and add a node. Specify the other appliance’s Citrix Gateway IP address as the address of the new node. Then, log on to the other appliance and add a node that has the Citrix Gateway IP address of the first appliance. An algorithm determines which node becomes primary and which becomes secondary.

Before you configure the appliances, add a high availability node. This node represents either the first or second Citrix Gateway in the high availability pair. To configure high availability, you first create the node and then you configure the high availability settings.

To add a high availability node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, click Add.
3. In the High Availability Setup dialog box, in the HA Setup dialog box, in Remote Node IP Address text box, type the NSIP address of the Citrix ADC that is to be added as the remote node. If the Citrix Gateway IP address is an IPv6 address, select the IPv6 check box before entering the address.
4. If you want to add the local node to the remote node automatically, select Configure remote system to participate in High Availability setup. If you do not select this option, you will have to log in to the appliance represented by the remote node and add the node that you are currently configuring.

© 1999-2020 Citrix Systems, Inc. All rights reserved.
5. Click to enable Turn off HA monitor on interfaces/channels that are down.
6. If the remote appliance has a different user name and password, in Remote System Logon Credentials, click Login credentials for remote system are different from self node.
7. In User Name, type the user name of the remote appliance.
8. In Password, type the password of the remote appliance.
9. Click OK.

To enable or disable the secondary node

You can disable or enable the secondary node only. When you disable a secondary node, it stops sending heartbeat messages to the primary node, and therefore the primary node can no longer check the status of the secondary node. When you enable a node, the node takes part in the high availability configuration.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select the local node and then click Open.
3. In the HA Configure Node dialog box, in High Availability Status, select ENABLED (Do not participate in HA).
4. Click OK. A message appears in the status bar, stating that the node has been configured successfully.

To configure settings for high availability

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. In the HA Configure Node dialog box, in ID, type the number of the node identifier. ID specifies the unique node number for the other appliance.
4. In IP Address, type the system IP address and then click OK. The IP Address specifies the IP address of the other appliance.

Note: The maximum ID for nodes in a high availability pair is 64.

Changing an RPC node password

January 29, 2020
To communicate with other Citrix Gateway appliances, each appliance requires knowledge of the other appliances, including how to authenticate on Citrix Gateway. RPC nodes are internal system entities used for system-to-system communication of configuration and session information. One RPC node exists on each Citrix Gateway and stores information, such as the IP addresses of the other Citrix Gateway appliance and the passwords used for authentication. The Citrix Gateway that makes contact with another Citrix Gateway checks the password within the RPC node.

Citrix Gateway requires RPC node passwords on both appliances in a high availability pair. Initially, each Citrix Gateway is configured with the same RPC node password. To enhance security, you must change the default RPC node passwords. You can use the configuration utility to configure and change RPC nodes.

RPC nodes are implicitly created when adding a node or adding a Global Server Load Balancing (GSLB) site. You cannot create or delete RPC nodes manually.

**Important:** You must also secure the network connection between the appliances. You can configure security when you configure the RPC node password by selecting the **Secure** check box.

**To change an RPC node password and enable a secure connection**

1. Navigate to **System > Network > RPC**.
2. In the details pane, select the node and then click **Edit**.
3. In **Password** and **Confirm Password**, type the new password.
4. In **Source IP Address**, type the system IP address of the other Citrix Gateway appliance.
5. Click **Secure** and then click **OK**.

   **Note:** When you enable the **Secure** option, the appliance encrypts all communication sent from the node to other RPC nodes thus securing the RPC communication.

**To change an RPC node password by using the CLI**

At the command prompt, type:

```
set ns rpcNode <IPAddress> {
    -password
    [-secure ( YES | NO )]
}
```

**Example:**

```
Configuring the primary and secondary appliances for high availability

April 23, 2019

After changing the RPC node password and enabling secure communication, use the configuration utility to configure the primary and secondary Citrix Gateway High Availability nodes.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under High Availability Status, click Enabled (Actively Participate in HA) and then click OK.

Configuring communication intervals

April 23, 2019

When you configure Citrix Gateway as a high availability pair, you can configure the secondary Citrix Gateway to listen at specific intervals, measured in milliseconds (msec). These intervals are known as hello intervals and dead intervals.

The hello interval is the interval at which the heartbeat messages are sent to the peer node. The dead interval is the time interval after which the peer node is marked DOWN if heartbeat packets are not received. The heartbeat messages are UDP packets sent to port 3003 of the other node in a high availability pair.

When you configure the hello interval, you can use the values 200 to 1000. The default value is 200. The dead interval values are 3 to 60. The default value is 3.
To configure communication intervals for the secondary Citrix Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under Intervals, do one or both of the following:
   • In Hello Interval (msec), type the value and then click OK. The default is 200 milliseconds.
   • In Dead Interval (secs), type the value and then click OK. The default setting is three seconds.

Synchronizing Citrix Gateway appliances

April 23, 2019

Automatic synchronization of Citrix Gateway appliances in a high availability pair is enabled by default. With automatic synchronization, you can make changes to one appliance and enable the changes to propagate automatically to the second appliance. Synchronization uses port 3010.

Synchronization starts when the following occurs:

• The secondary node restarts.
• The primary node becomes secondary after a failover.

You can disable synchronization, which prevents the secondary Citrix Gateway from synchronizing its configuration with the primary Citrix Gateway when a change occurs on the primary appliance. You can also force synchronization.

You enable or disable high availability synchronization on the secondary node in the pair.

To enable or disable high availability synchronization

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. In the Configure Node dialog box, under HA Synchronization, do one of the following:
   • To disable synchronization, clear the Secondary node will fetch the configuration from Primary check box.
To enable synchronization, select the Secondary node will fetch the configuration from Primary check box.

4. Click OK. A message appears in the status bar stating that the node configuration is successful.

To force synchronization between appliances

In addition to automatic synchronization, Citrix Gateway supports forced synchronization between the two nodes in a high availability pair.

You can force synchronization on both the primary and secondary Citrix Gateway appliances. However, if synchronization is already in progress, the command fails and Citrix Gateway displays a warning. Forced synchronization also fails in the following circumstances:

- You force synchronization on a standalone system.
- The secondary node is disabled.
- You disable high availability synchronization on the secondary node.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. On the Nodes tab, click Force Synchronization.

Synchronizing configuration files in a high availability setup

April 23, 2019

In a high availability setup, you can synchronize various configuration files from the primary node to the secondary node.

Parameters for synchronizing files in a high availability setup

- Mode

The type of synchronization to be performed. The following descriptions include, in parentheses, the command-line argument that specifies the option.

- **Everything except licenses and rc.conf (all)**. Synchronizes files related to system configuration, Citrix Gateway bookmarks, SSL certificates, SSL CRL lists, HTML injection scripts, and Application Firewall XML objects.
- **Bookmarks** (bookmarks). Synchronizes all Citrix Gateway bookmarks.
- **SSL certificates and keys** (ssl). Synchronizes all certificates, keys, and CRLs for the SSL feature.
- **Licenses and rc.conf** (misc). Synchronizes all license files and the rc.conf file.
- **Everything including licenses and rc.conf** (all_plus_misc). Synchronizes files related to system configuration, Citrix Gateway bookmarks, SSL certificates, SSL CRL lists, HTML injection scripts, Application Firewall XML objects, licenses, and the rc.conf file.

Note: There are more options available if you install a Citrix ADC license on the appliance.

**To synchronize files in a high availability setup by using the configuration utility**

1. In the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under Utilities, click Start HA files synchronization.
3. In the Start file synchronization dialog box, in the Mode drop-down list, select the appropriate type of synchronization (for example, Everything except licenses and rc.conf) and then click OK.

**Configuring command propagation**

April 23, 2019

In a high availability setup, any command issued on the primary node propagates automatically to, and runs on, the secondary node before the command runs on the primary node. If command propagation fails, or if command execution fails on the secondary node, the primary node executes the command and logs an error. Command propagation uses port 3011.

In a high availability pair configuration, command propagation is enabled by default on both the primary and secondary nodes. You can enable or disable command propagation on either node in a high availability pair. If you disable command propagation on the primary node, commands are not propagated to the secondary node. If you disable command propagation on the secondary node, commands propagated from the primary are not executed on the secondary node.

Note: After reenabling propagation, remember to force synchronization.

Note: If synchronization occurs while you are disabling propagation, any configuration-related changes that you make before the disabling of propagation takes effect are synchronized with the secondary node. This is also true for cases in which propagation is disabled while synchronization is in progress.

**To enable or disable propagation on the primary node**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under HA propagation, do one of the following:
   • To disable high availability propagation, clear the Primary node will propagate configuration to the Secondary check box.
   • To enable high availability propagation, select the Primary node will propagate configuration to the Secondary check box.
4. Click OK.

**Troubleshooting command propagation**

April 23, 2019

The following list describes the reasons command propagation may fail, as well as solutions for restoring the setting:

- Network connectivity is not active. If a command propagation fails, check the network connection between the primary and secondary Citrix Gateway appliances.

- Missing resources on secondary Citrix Gateway. If a command execution succeeds on the primary Citrix Gateway but fails to propagate to the secondary Citrix Gateway, run the command directly on the secondary Citrix Gateway to see the error message. The error may have occurred because the resources required by the command are present on the primary Citrix Gateway and are not available on the secondary Citrix Gateway. Also, verify that the license files on each appliance match.

For example, verify that all of your Secure Sockets Layer (SSL) certificates are present on each Citrix Gateway. Verify that any initialization script customization exists on both Citrix Gateway appliances.

- Authentication failure. If you receive an authentication failure error message, verify the RPC node settings on each appliance.

**Configure fail-safe mode**

April 23, 2019

In a high availability configuration, fail-safe mode ensures that one node is always primary when both nodes fail the health check. Fail-safe mode ensures that when a node is only partially available, backup methods can activate and can handle traffic.
You configure high availability fail-safe mode independently on each node.

The following table shows some of the fail-safe cases. The NOT_UP state means that the node failed the health check and yet the node is partially available. The UP state means that the node passed the health check.

Table 1. Fail-safe mode cases

<table>
<thead>
<tr>
<th>Node A (primary) health state</th>
<th>Node B (secondary) health state</th>
<th>Default high availability behavior</th>
<th>Fail-safe enabled high availability behavior</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT_UP (failed last)</td>
<td>NOT_UP (failed first)</td>
<td>A (Secondary), B (Secondary)</td>
<td>A (Primary), B (Secondary)</td>
<td>If both nodes fail, one after the other, the node that was the last primary node remains primary.</td>
</tr>
<tr>
<td>NOT_UP (failed first)</td>
<td>NOT_UP (failed last)</td>
<td>A (Secondary), B (Secondary)</td>
<td>A (Secondary), B (Primary)</td>
<td>If both nodes fail, one after the other, the node that was the last primary node remains primary.</td>
</tr>
<tr>
<td>UP</td>
<td>UP</td>
<td>A (Primary), B (Secondary)</td>
<td>A (Primary), B (Secondary)</td>
<td>If both nodes pass the health check, no change in behavior with fail-safe enabled.</td>
</tr>
<tr>
<td>UP</td>
<td>NOT_UP</td>
<td>A (Primary), B (Secondary)</td>
<td>A (Primary), B (Secondary)</td>
<td>If only the secondary node fails, no change in behavior with fail-safe enabled.</td>
</tr>
</tbody>
</table>
## To configure fail-safe mode

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. In the Configure Node dialog box, under Fail-Safe Mode, select Maintain one Primary node even when both nodes are unhealthy and then click OK.

## Configuring the virtual MAC address

April 23, 2019

The virtual MAC address is shared by the primary and secondary Citrix Gateway appliances in a high availability setup.

In a high availability setup, the primary Citrix Gateway owns all the floating IP addresses, such as the mapped IP address or the virtual IP address. It responds to address resolution protocol (ARP) requests for these IP addresses with its own MAC address. As a result, the ARP table of an external device (such as a router) is updated with the floating IP address and the primary Citrix Gateway MAC address. When a failover occurs, the secondary Citrix Gateway takes over as the new primary Citrix Gateway. It then
Citrix Gateway 13.0

uses gratuitous address resolution protocol (GARP) to advertise the floating IP addresses that it acquired from the primary appliance. The MAC address, which the new primary appliance advertises, is that of its own interface.

Some devices do not accept GARP messages generated by Citrix Gateway. As a result, some of the external devices retain the old IP-to-MAC mapping advertised by the old primary Citrix Gateway. This situation can cause a site to become unavailable. To resolve the problem, you configure a virtual MAC address on both Citrix Gateway appliances of a high availability pair. This configuration implies that both Citrix Gateway appliances have identical MAC addresses. As a result, when failover occurs, the MAC address of the secondary Citrix Gateway remains unchanged and ARP tables on the external devices do not need to be updated.

To create a virtual MAC address, create a virtual router identifier (ID) and bind it to an interface. In a high availability setup, the user needs to bind the ID to the interfaces on both the appliances.

When the virtual router ID is bound to an interface, the system generates a virtual MAC address with the virtual router ID as the last octet. An example of the generic virtual MAC address is 00:00:5e:00:01:<VRID>. For example, if you created a virtual router ID of value 60 and bind it to an interface, the resulting virtual MAC address is 00:00:5e:00:01:3c, where 3c is the hex representation of the virtual router ID. You can create 255 virtual router IDs ranging from 1 through 254.

You can configure virtual MAC addresses for IPv4 and IPv6.

**Configuring IPv4 virtual MAC addresses**

April 23, 2019

When you create an IPv4 virtual MAC address and bind it to an interface, any IPv4 packet sent from the interface uses the virtual MAC address that is bound to the interface. If there is no IPv4 virtual MAC address bound to an interface, the interface's physical MAC address is used.

The generic virtual MAC address is of the form 00:00:5e:00:01:<VRID>. For example, if you create a VRID with a value of 60 and bind it to an interface, the resulting virtual MAC address is 00:00:5e:00:01:3c, where 3c is the hex representation of the VRID. You can create 255 VRIDs with values from 1 to 254.

**Creating or modifying an IPv4 virtual MAC address**

April 23, 2019

You create an IPv4 virtual MAC address by assigning it a virtual router ID. You can then you bind the virtual MAC address to an interface. You cannot bind multiple virtual router IDs to the same interface.
verify the virtual MAC address configuration, you should display and examine the virtual MAC address and the interfaces bound to the virtual MAC address.

Parameters for configuring a virtual MAC address

- **VrID**
  The virtual router ID that identifies the virtual MAC address. Possible values: 1 to 255.
- **ifnum**
  The interface number (slot/port notation) to be bound to the virtual MAC address.

To configure a virtual MAC address

1. In the configuration utility, on the Configuration tab, expand System > Network and then click VMAC.
2. In the details pane, on the VMAC tab, click Add.
3. In the Create VMAC dialog box, in Virtual Router ID, type the value.
4. Under Associated Interfaces, in Available Interfaces, select a network interface, click Add, click Create and then click Close.

After you create the virtual MAC address, it appears in the configuration utility. If you selected a network interface, the virtual router ID is bound to that interface.

To delete a virtual MAC address

To delete a virtual MAC address, you need to delete the corresponding virtual router ID.

1. In the configuration utility, on the Configuration tab, expand System > Network and then click VMAC.
2. In the details pane, select an item and then click Remove.

To bind and unbind a virtual MAC address

When you created the virtual router ID, you selected a network interface on Citrix Gateway and then bound the virtual router ID to the network interface. You can also unbind a virtual MAC address from the network interface, but leave the MAC address configured on Citrix Gateway.

1. In the configuration utility, on the Configuration tab, expand System > Network and then click VMAC.
2. In the details pane, select an item and then click Open.
3. Under Configured Interfaces, select a network interface, click Remove, click OK and then click Close.

**Configuring IPv6 virtual MAC addresses**

April 23, 2019

The Citrix Gateway supports virtual MAC addresses for IPv6 packets. You can bind any interface to a virtual MAC address for IPv6, even if an IPv4 virtual MAC address is bound to the interface. Any IPv6 packet sent from the interface uses the virtual MAC address bound to that interface. If there is no virtual MAC address bound to an interface, an IPv6 packet uses the physical MAC.

**Creating or modifying a virtual MAC address for IPv6**

April 23, 2019

You create an IPv6 virtual MAC address by assigning it an IPv6 virtual router ID. You can then you bind the virtual MAC address to an interface. You cannot bind multiple IPv6 virtual router IDs to an interface. To verify the virtual MAC address configuration, you should display and examine the virtual MAC addresses and the interfaces bound to the virtual MAC address.

**Parameters for configuring a virtual MAC address for IPv6**

- **Virtual Router ID**
  
  The virtual router ID that identifies the virtual MAC address. Possible values: 1 to 255.

- **ifnum**
  
  The interface number (slot/port notation) to be bound to the virtual MAC address.

**To configure a virtual MAC address for IPv6**

1. In the configuration utility, on the Configuration tab, expand System > Network and then click VMAC.
2. In the details pane, on the VMAC6 tab, do one of the following:
   - To create a new virtual MAC address, click Add.
   - To modify an existing virtual MAC address, click Open.
3. In the Create VMAC6 or Configure VMAC6 dialog box, in Virtual Router ID, enter the value, such as vrID6.
4. In Associate Interfaces, click Add, click Create and then click Close. A message appears in the status bar, stating that the virtual MAC address is configured.

**To remove a virtual MAC address for IPv6**

1. In the configuration utility, on the Configuration tab, expand System > Network and then click VMAC.
2. In the details pane, on the VMAC6 tab, select the virtual router ID that you want to remove and then click Remove. A message appears in the status bar, stating that the virtual MAC address is removed.

**Configuring high availability pairs in different subnets**

April 23, 2019

A typical high availability deployment is when both appliances in a high availability pair reside on the same subnet. A high availability deployment can also consist of two Citrix Gateway appliances in which each appliance is located in a different network. This topic describes the latter configuration, and includes sample configurations and a list of differences among the high availability configurations within one network and across networks.

You can also configure link redundancy and route monitors. These Citrix Gateway functions are helpful in a cross-network high availability configuration. The functions also cover the health check process used by each Citrix Gateway to ensure that the partner appliance is active.

**How independent network configuration works**

The Citrix Gateway appliances are connected to different routers, called R3 and R4, on two different networks. The appliances exchange heartbeat packets through these routers. A heartbeat packet is a signal that occurs at regular intervals that ensures the connection is still active. You can expand this configuration to accommodate deployments involving any number of interfaces.

Note: If you use static routing on your network, you must add static routes between all the systems to ensure that heartbeat packets are sent and received successfully. (If you use dynamic routing on your systems, static routes are unnecessary.)
When the appliances in a high availability pair reside on two different networks, the secondary Citrix Gateway must have an independent network configuration. This means that Citrix Gateway appliances on different networks cannot share mapped IP addresses, virtual LANs, or network routes. This type of configuration, in which the Citrix Gateway appliances in a high availability pair have different configurable parameters, is known as independent network configuration or symmetric network configuration.

The following table summarizes the configurable parameters for an independent network configuration, and shows how you must set them on each Citrix Gateway:

<table>
<thead>
<tr>
<th>Configurable parameters</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP addresses</td>
<td>Citrix Gateway specific. Active only on that appliance.</td>
</tr>
<tr>
<td>Virtual IP address</td>
<td>Floating.</td>
</tr>
<tr>
<td>Virtual LAN</td>
<td>Citrix Gateway specific. Active only on that appliance.</td>
</tr>
<tr>
<td>Routes</td>
<td>Citrix Gateway specific. Active only on that appliance. A link load balancing (LLB) route is floating.</td>
</tr>
<tr>
<td>access control lists (ACLs)</td>
<td>Floating (common). Active on both appliances.</td>
</tr>
<tr>
<td>Dynamic routing</td>
<td>Citrix Gateway specific. Active only on that appliance. The secondary Citrix Gateway should also run the routing protocols and peer with upstream routers.</td>
</tr>
<tr>
<td>L2 mode</td>
<td>Floating (common). Active on both appliances.</td>
</tr>
<tr>
<td>L3 mode</td>
<td>Floating (common). Active on both appliances.</td>
</tr>
<tr>
<td>Reverse Network Address Translation (NAT)</td>
<td>Citrix Gateway specific. Reverse NAT with a virtual IP address because the NAT IP address is floating.</td>
</tr>
</tbody>
</table>

**Adding a remote node**

April 23, 2019

When two nodes of a high availability pair reside on different subnets, each node must have a different network configuration. Therefore, to configure two independent systems to function as a high
availability pair, you must specify independent network computing mode during the configuration process.

When you add a high availability node, you must disable the high availability monitor for each interface that is not connected or being used for traffic.

To add a remote node for independent network computing mode

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, click the Nodes tab, and then click Add.
3. In the High Availability Setup dialog box, in the Remote Node IP Address text box, type the Citrix Gateway IP address of the appliance that is the remote node.
   To use an IPv6 address, click the IPv6 check box before entering the IP address.
4. If you want to add the local node to the remote node automatically, select Configure remote system to participate in High Availability setup. If you do not select this option, you need to log on to the appliance represented by the remote node and add the node that you are currently configuring.
5. Click to enable Turn off HA monitor on interfaces/channels that are down.
6. Click to enable Turn on INC (Independent Network Configuration) mode on self mode.
7. Click OK. The Nodes page displays the local and remote nodes in your high availability configuration.

To remove a remote node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, click the Nodes tab.
3. Select the node that you want to remove, click Remove and then click Yes.

Configuring route monitors

April 23, 2019

You can use route monitors to make the high availability state dependent on the internal routing table, whether or not the table contains any dynamically learned or static routes. In an high availability
configuration, a route monitor on each node checks the internal routing table to make sure that a route entry for reaching a particular network is always present. If the route entry is not present, the state of the route monitor changes to DOWN.

When a Citrix Gateway appliance has only static routes for reaching a network, and you want to create a route monitor for the network, you must enable monitored static routes for the static routes. The monitored static route removes unreachable static routes from the internal routing table. If you disable monitored static routes on static routes, an unreachable static route can remain in the internal routing table, defeating the purpose of having the route monitor.

Route monitors are supported on either enabled or disabled Independent Network Configuration settings. The following table shows what occurs with route monitors in a high availability setup and with Independent Network Configuration enabled or disabled.

<table>
<thead>
<tr>
<th>Route Monitors in high availability in disabled Independent Network Configuration mode</th>
<th>Route Monitors in high availability in enabled Independent Network Configuration mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route monitors are propagated by nodes and exchanged during synchronization.</td>
<td>Route monitors are neither propagated by nodes nor exchanged during synchronization.</td>
</tr>
<tr>
<td>Route monitors are active only in the current primary node.</td>
<td>Route monitors are active on both the primary and the secondary node.</td>
</tr>
<tr>
<td>The Citrix Gateway appliance always displays the state of a route monitor as UP irrespective of the whether the route entry is present or not in the internal routing table.</td>
<td>The Citrix Gateway appliance displays the state of the route monitor as DOWN if the corresponding route entry is not present in the internal routing table.</td>
</tr>
<tr>
<td>A route monitor starts monitoring its route in the following cases, in order to allow Citrix Gateway to learn the dynamic routes, which may take up to 180 seconds: reboot, failover, set route6 command for v6 routes, set route msr enable/disable command for v4 routes, adding a new route monitor</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>

Route monitors are useful when you disable Independent Network Configuration mode and you want a gateway from a primary node as unreachable as one of the conditions for high availability failover.

For example, you disable Independent Network Configuration in a high availability setup in a two-arm topology that has Citrix Gateway appliances NS1 and NS2 in the same subnet, with router R1 and switches SW1, SW2, and SW3, as shown in the following figure. Because R1 is the only router in this setup, you want the high availability setup to failover whenever R1 is not reachable from the current primary node. You can configure a route monitor (say, RM1 and RM2, respectively) on each of the
nodes to monitor the reachability of R1 from that node.

With NS1 as the current primary node, the network flow is as follows:

1. Route monitor RM1 on NS1 monitors NS1’s internal routing table for the presence of a route entry for router R1. NS1 and NS2 exchange heartbeat messages through switch SW1 or SW3 at regular intervals.
2. If switch SW1 fails, the routing protocol on NS1 detects that R1 is not reachable and therefore removes the route entry for R1 from the internal routing table. NS1 and NS2 exchanges heartbeat messages through switch SW3 at regular intervals.
3. Detecting that the route entry for R1 is not present in the internal routing table, RM1 initiates a failover. If route to R1 is down from both NS1 and NS2, failover happens every 180 seconds till one of the appliances is able to reach R1 and restore the connection.

**Adding or removing route monitors**

April 23, 2019
When the appliances of a high availability pair reside on different networks, the high availability state of Citrix Gateway depends on if the appliance can be reached or not. In a cross-network high availability configuration, a route monitor on each Citrix Gateway scans the internal routing table to make sure that an entry for the other Citrix Gateway is always present.

**To add a route monitor**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the Bind/Unbind Route Monitors dialog box, on the Route Monitors tab, click Action, and then click Configure.
3. Under Specify Route Monitor, in Network, type the IP address of the network of the other Citrix Gateway appliance.
   
   To configure an IPv6 address, click IPv6 and then type the IP address.
4. In Netmask, type the subnet mask of the other network, click Add and then click OK.

When this procedure is complete, the route monitor is bound to Citrix Gateway.

Note: When a route monitor is not bound to a Citrix Gateway, the high availability state of either appliance is determined by the state of the interfaces.

**To remove a route monitor**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. On the Route Monitors tab, click Action, and then click Configure.
3. Under Configured Route Monitors, select the monitor, click Remove and then click OK.

**Configuring link redundancy**

April 23, 2019

Link redundancy groups network interfaces together to prevent failover due to a failure on one network interface of an Citrix Gateway that has other functioning interfaces. The failure of the first interface on the primary Citrix Gateway triggers failover, although the first interface can still use its second link to serve user requests. When you configure link redundancy, you can group the two interfaces into a failover interface set, preventing the failure of a single link from causing failover to the secondary Citrix Gateway, unless all interfaces on the primary Citrix Gateway are nonfunctional.
Each interface in a failover interface set maintains independent bridge entries. The monitor interfaces that are enabled and high availability on an Citrix Gateway that are not bound to a failed interface set are known as critical interfaces, because if any of these interfaces fails, failover is triggered.

**To configure link redundancy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. On the Failover Interface Set tab, click Add.
3. In Name, type a name for the set.
4. In Interfaces, click Add.
5. Under Available Interfaces, select an interface and then click the arrow to move the interface to Configured.
6. Repeat Steps 4 and 5 for the second interface, and then click Create.

You can add as many interfaces as you need for failover between the interfaces.

**To remove interfaces from the failover interface set**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. On the Failover Interface Set tab, select a set and then click Remove.

**To remove a failover interface set**

If you no longer need a failover interface set, you can remove it from Citrix Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. On the Failover Interface Set tab, select a set and then click Remove.

**Understanding the causes of failover**

April 23, 2019

The following events can cause failover in a high availability configuration:

1. If the secondary node does not receive a heartbeat packet from the primary node for a period of time that exceeds the dead interval set on the secondary. For more information about setting
the dead interval, see Configuring Communication Intervals. Possible causes for a node not receiving heartbeat packets from a peer node include:

- A network configuration problem prevents heartbeats from traversing the network between the high availability nodes.
- The peer node experiences a hardware or software failure that causes it to freeze (hang), reboot, or otherwise stop processing and forwarding heartbeat packets.

2. The primary node experiences a hardware failure of its SSL card.
3. The primary node does not receive any heartbeat packets on its network interfaces for three seconds.
4. On the primary node, a network interface that is not part of a Failover Interface Set (FIS) or a Link Aggregation (LA) channel and has the high availability Monitor (HAMON) enabled, fails. The interfaces are enabled, but go to a DOWN state.
5. On the primary node, all interfaces in an FIS fail. The interfaces are enabled, but go to a DOWN state.
6. On the primary node, an LA channel with HAMON enabled fails. The interfaces are enabled, but go to a DOWN state.
7. On the primary node, all interfaces fail. In this case, failover occurs regardless of the HAMON configuration.
8. On the primary node, all interfaces are manually disabled. In this case, failover occurs regardless of the HAMON configuration.
9. You force a failover by issuing the force failover command on either node.
10. A route monitor that is bound to the primary node goes DOWN.

Forcing failover from a node

April 23, 2019

You might want to force a failover if, for example, you need to replace or upgrade the primary node. You can force failover from either the primary or the secondary node. A forced failover is not propagated or synchronized. To view the synchronization status after a forced failover, you can view the status of the node.

A forced failover fails in any of the following circumstances:

- You force failover on a standalone system.
- The secondary node is disabled.
- The secondary node is configured to remain secondary.

The Citrix Gateway appliance displays a warning message if it detects a potential issue when you run the force failover command. The message includes the information that triggered the warning and
Forcing failover on the primary or secondary node

April 23, 2019

If you force failover on the primary node, the primary becomes the secondary and the secondary becomes the primary. Forced failover is possible only when the primary node can determine that the secondary node is UP.

If the secondary node is DOWN, the force failover command returns the following error message: “Operation not possible due to invalid peer state. Rectify and retry.”

If the secondary system is in the claiming state or inactive, the command returns the following error message: “Operation not possible now. Please wait for system to stabilize before retrying.”

If you run the force failover command from the secondary node, the secondary node becomes primary and the primary node becomes secondary. A force failover can occur only if the secondary node’s health is good and the node is not configured to stay secondary.

If the secondary node cannot become the primary node, or if secondary node was configured to stay secondary (using the STAYSECONDARY option), the node displays the following error message: “Operation not possible as my state is invalid. View the node for more information.”

To force failover on the primary or secondary node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select the primary node, and then in Actions, click Force Failover.
3. In the Warning dialog box, click Yes.

Forcing the primary node to stay primary

April 23, 2019

In a high availability configuration, you can force the primary Citrix Gateway to stay primary even after appliance failover. You can only configure this setting on standalone Citrix Gateway appliances and on the Citrix Gateway that is the primary appliance in a high availability pair.
To force the primary node to stay primary

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under High Availability Status, click Stay Primary and then click OK.

You can clear this configuration only by using the following command:

clear configuration full

The following commands do not change the Citrix Gateway high availability configuration:

clear configuration basic

clear configuration extended

Forcing the secondary node to stay secondary

April 23, 2019

In a high availability setup, you can force the secondary Citrix Gateway to stay secondary, independent of the state of the primary Citrix Gateway. When you configure Citrix Gateway to stay secondary, it remains secondary even if the primary Citrix Gateway fails.

For example, in an existing high availability setup, suppose that you need to upgrade the primary Citrix Gateway and that this process takes a specified amount of time. During the upgrade, the primary Citrix Gateway could become unavailable, but you do not want the secondary Citrix Gateway to take over. You want it to remain the secondary Citrix Gateway, even if it detects a failure in the primary Citrix Gateway.

If the status of a Citrix Gateway in a high availability pair is configured to stay secondary, it does not participate in high availability state machine transitions. You can check the status of the Citrix Gateway in the configuration utility on the Nodes tab.

This setting works on both a standalone and a secondary Citrix Gateway.

When you set the high availability node, it is not propagated or synchronized and affects only the Citrix Gateway on which the setting is configured.

To force the secondary node to stay secondary

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
To return Citrix Gateway to service as an active high availability appliance

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and then click High Availability.
2. In the details pane, on the Nodes tab, select the appliance that is going to stay the primary node and then click Open.
3. Under High Availability Status, click Enabled (Actively Participate in HA) and then click OK.

Using Clustering

May 27, 2019

Citrix Gateway can be deployed in cluster configurations to provide high throughput, high availability, and scalability for VPN client traffic. In a cluster, a group of Citrix Gateway appliances or VMs operates as a single system image to coordinate user sessions and manage traffic to network resources. A Citrix Gateway cluster can be built with a minimum of two and a maximum of 32 Citrix Gateway appliances or VMs configured as cluster nodes.

You should read the Citrix ADC Clustering documentation before starting to configure your Citrix Gateway cluster. Pay special attention to the following topics in that documentation.

- See Hardware and Software Requirements to verify that the systems you plan to use meet the requirements.
- See How Clustering Works for a description of clustering concepts.
- See Setting up Inter-Node Communication to plan the deployment and identify any caveats that might be relevant to your environment.

A Citrix Gateway cluster operates as a spotted VIP configuration type Citrix ADC cluster.

Configuring Clustering

October 17, 2019

The primary tasks in setting up Citrix Gateway clustering are:
1. Decide which Citrix Gateway appliance or VM will be the configuration coordinator, and create a cluster instance on that system (if one is not already present).
2. Join Citrix Gateway systems to the cluster as nodes.
3. Create a node group on the cluster instance, with the STICKY option set.
4. Bind a single cluster node to the cluster node group.
5. Configure a Citrix Gateway virtual server on the configuration coordinator and bind it to cluster node group.

Multiple methods are available for configuring a Citrix ADC cluster. The following set of tasks uses the most direct method available in the configuration utility.

**To create a Citrix Gateway cluster instance by using the configuration utility**

Once you have all of the deployment details in order, begin the configuration on the Citrix Gateway that will be the configuration coordinator.

Caution: Creating the cluster instance clears the configuration. If you need to save the existing system configuration for reference, archive a copy before continuing with the cluster configuration. Any existing settings to be used in the cluster can be reapplied on the configuration coordinator after the cluster is established.

1. Log on to the Citrix ADC configuration utility at the NSIP address.
2. Expand the System node, then the Cluster subnode.
3. In the details pane, click Manage Cluster.
4. In the Cluster Configuration dialog box, set the parameters required to create the cluster.
   a) Enter a Cluster instance ID. This is the numeric identifier for the cluster instance. The default value is 1 but you can set it to any number from 1 to 16.
   b) Enter the Cluster IP address. This is the cluster's configuration coordinator IP address, which is the management IP address for the cluster.
   c) Select the preferred Backplane interface. This is this Citrix Gateway interface to use for communication among the cluster nodes.
5. Click Create.
6. At the prompt to confirm system reboot, click Yes.
7. After the node is UP and sync is successful, from the cluster IP address, change RPC credentials for both the node and cluster IP address. For more information about changing an RPC node password, see Change an RPC node password.
8. Wait for system to restart. Once available, log on to the configuration utility at the Cluster IP address configured in step 4(2).

**Note:** In the System Information detail pane, that the local node at the NSIP address is reported as configuration coordinator. This confirms that the base cluster instance is now operating.
The local node of the configuration coordinator is automatically added to the cluster. More nodes can be added in the following task.

**Adding Nodes to a Citrix Gateway Cluster**

Once the cluster instance has been established, you can begin to add other Citrix Gateway nodes to the cluster.

To add more Citrix Gateway systems to the cluster, you can use the configuration utility to remotely issue the cluster-node-creation and join-cluster settings.

Note: Adding nodes to the cluster should be completed before configuring your Citrix Gateway setup. This way, you will not have to repeat the Citrix Gateway configuration if something goes wrong with your cluster configuration and you want to remove the cluster and begin again.

1. Log on to the Citrix ADC configuration utility at the Cluster IP address.
2. Expand the System node, then the Cluster subnode.
3. In the details pane, click Manage Cluster.
4. In the Cluster Nodes details pane, click Add.
5. In the Create Cluster Node pane, enter a unique Node id for this node.
6. Enter the Citrix ADC IP address of the system to add as a cluster node.
7. In the Cluster Node credentials pane, enter the Citrix Gateway user name and password for the remote Citrix Gateway system.
8. In the Configuration Coordinator credentials pane, enter the password for the local authorized user.
9. Click Create.
10. When prompted, click YES to allow the system configuration to be saved and perform a warm reboot of the remote Citrix Gateway.
11. After the node is UP and sync is successful, from the cluster IP address, change RPC credentials for both the node and cluster IP address. For more information about changing an RPC node password, see [Change an RPC node password](#).

Repeat steps 4 through 11 for each additional remote Citrix Gateway system that you want to configure as a cluster node.

Verify that the cluster nodes are included in the Active Node List in the Cluster Nodes detail pane. If any nodes are missing, repeat steps 4 through 10 until all of the necessary nodes are listed.

**Creating a Cluster Node Group**

Once the cluster nodes have been added, a cluster node group can be created.

1. Log on to the Citrix ADC configuration utility at the Cluster IP address.
2. Expand the System node, then the Cluster subnode.
3. Click Node Groups.
4. In the details pane, click Add.
5. Enter a name for the cluster node group.
6. Select the Sticky option. This is required to support the Citrix Gateway virtual server type.
7. Click Continue.

The cluster node group is now established. Before leaving this area of the configuration utility, you can bind the local Citrix Gateway node to the new cluster node group. This is the only node bound to the cluster group.

**Bind the local cluster node to the cluster node group**

Because a Citrix Gateway cluster configuration is a spotted type, only one node can be bound to the node group. The following procedure binds the local node on the configuration coordinator to the node group, but any node in the cluster can be used for this binding.

1. In the Advanced pane, expand Cluster Nodes.
2. In the middle Cluster Nodes pane, select No Cluster Node.
3. On the Cluster Node configuration screen, click Bind.
4. Select the local node represented by the NSIP address for this Citrix Gateway system.
5. Click Insert.
6. Click OK.
7. Click Done.

The cluster is now populated and ready to share a Citrix Gateway virtual server as configured by the following task.

**Binding a Citrix Gateway Virtual Server to the Cluster Node Group**

With a cluster established, you can proceed to build the Citrix Gateway configuration the cluster deployment is intended to serve. To tie the configuration to the cluster, you need to create the Citrix Gateway virtual server and bind it to a cluster node group that is set to type Sticky. After the virtual server is bound to the cluster node group, you can continue to configure the Citrix Gateway.

If multiple Citrix Gateway virtual servers are configured, those must be bound to the cluster node group as well.

**Note:** If Citrix Gateway virtual servers have not yet been configured, you might have to first enable the Citrix Gateway and Authentication, Authorization, and Auditing features first under System > Settings > Configure Basic Features.

1. Log on to the Citrix ADC configuration utility at the Cluster IP address.
2. Expand the System node, then the Cluster subnode.
3. Click Node Groups.
4. In the Node Group pane, select the desired node group name, and then click Edit.
5. In the Advanced pane on the right, expand the Virtual Servers option, and then click the + icon to add a virtual server.
6. Choose the VPN Virtual Server type, and then click Continue.
7. Click Bind.
8. If the needed virtual server is listed, select it, then click Insert, and then click OK.
9. If you have to create a new virtual server, click Add. Proceed through the Citrix ADC Virtual Server configuration. Minimally, all that is needed is to create the virtual server so that it can be bound to the cluster node group.
10. Once the virtual server is available in the Citrix Gateway Virtual Servers list, select it, and then click Insert.
11. Click OK.
12. Click Done.

Note: If multiple Citrix Gateway virtual servers are configured, those must be bound to the cluster node group as well using this same method.

Maintaining and Monitoring the System

April 23, 2019

Once you complete configuration of your Citrix Gateway, you need to maintain and monitor the appliance. You can do so in the following ways:

- You can upgrade Citrix Gateway to the latest version of the software. When you log on to the Citrix web site, you can navigate to the Citrix Gateway download site and the download the software. You can find the readme for maintenance builds in the Citrix Knowledge Center.
- You can assign Citrix Gateway configuration and management tasks to different members of your group. With delegated administration, you can assign access levels to individuals which restricts them to performing specific tasks on Citrix Gateway.
- You can save the Citrix Gateway configuration either to the appliance or a file on your computer. You can compare the current running and saved configuration. You can also clear the configuration from Citrix Gateway.
- You can view, refresh, and end user sessions within the Citrix Gateway configuration utility.
- You can configure logging on Citrix Gateway. The logs provide important information about the appliance and are useful in case you experience problems.
Configuring Delegated Administrators

April 23, 2019

Citrix Gateway has a default administrator user name and password. The default user name and password is nsroot. When you run the Setup Wizard for the first time, you can change the administrator password.

You can create additional administrator accounts and assign each account with different levels of access to Citrix Gateway. These additional accounts are called delegated administrators. For example, you have one person who is assigned to monitor Citrix Gateway connections and logs and another person who is responsible for configuring specific settings on Citrix Gateway. The first administrator has read-only access and the second administrator has limited access to the appliance.

To configure a delegated administrator, you use command policies and system users and groups.

When you are configuring a delegated administrator, the configuration process is:

- Add a system user. A system user is an administrator with specified privileges. All administrators inherit the policies of the groups to which they belong.
- Add a system group. A system group contains systems users with specific privileges. Members of the system group inherit the policies of the group or groups to which they belong.
- Create a command policy. Command policies allow you to define what parts of the Citrix Gateway configuration a user or group is allowed to access and modify. You can also regulate which commands, such as command groups, virtual servers, and other elements administrators and groups are permitted to configure.
- Bind the command policy to the user or group by setting the priority. When configuring delegated administration, assign priorities to the administrator or group so Citrix Gateway can determine which policy takes precedence.

Citrix Gateway has a default deny system command policy. Command policies cannot be bound globally. You must bind the policies directly to system administrators (users) or groups. If users and groups do not have an associated command policy, the default deny policy is applied and users cannot execute any commands or configure Citrix Gateway.

You can configure custom command policies to define a greater level of detail for user rights assignments. For example, you can give one person the ability to add session policies to Citrix Gateway, but not allow the user to perform any other configuration.
Configuring Command Policies for Delegated Administrators

April 23, 2019

Citrix Gateway has four built-in command policies that you can use for delegated administration:

- **Read-only.** Allows read-only access to show all commands except for the system command group and ns.conf show commands.
- **Operator.** Allows read-only access and also allows access to enable and disable commands on services. This policy also allows access to set services and servers as “access down.”
- **Network.** Permits almost complete system access, excluding system commands and the shell command.
- **Superuser.** Grants full system privileges, such as the privileges granted to the default administrator, nsroot.

Command policies contain built-in expressions. You use the configuration utility to create system users, system groups, command policies, and to define permissions.

**To create an administrative user on Citrix Gateway**

1. In the configuration utility, in the navigation pane, on the Configuration tab, expand System > User Administration and then click System Users.
2. In the details pane, click Add.
3. In **UserName**, type a user name.
4. In **Password** and **Confirm Password** field, type the password.
5. To add users to a group, in **Member of**, click Add.
6. In **Available**, select a group and then click the right arrow.
8. In the Insert Command Policies dialog box, select the command, click OK, click Create and then click close.

**Creating Administrative Groups**

Administrative groups contain users who have administrative privileges on Citrix Gateway. You can create administrative groups in the configuration utility.

**To configure an administrative group by using the configuration utility**

1. In the configuration utility, in the navigation pane, on the Configuration tab, expand System > User Administration and then click System Groups.
Configuring Custom Command Policies for Delegated Administrators

April 23, 2019

When configuring a custom command policy, you provide a policy name and then configure the policy components to create the command specification. With the command specification, you can limit the commands administrators are allowed to use. For example, you want to deny administrators the ability to use the remove command. When configuring the policy, set the action to deny and then configure the parameters.

You can configure a simple or advanced command policy. If you configure a simple policy, you configure a component on the appliance, such as Citrix Gateway and authentication. If you configure an advanced policy, you select the component, called an entity group and then select the commands administrators are allowed to perform in the group.

To create a simple custom command policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > User Administration and then click Command Policies.
2. In the details pane, click Add.
3. In Policy Name, type a name for the policy.
4. In Action, select Allow or Deny.
5. Under Command Spec, click Add.
6. In the Add Command dialog box, on the Simple tab, in Operation, select the action that delegated administrators can perform.
7. Under Entity Group, select one or more groups.
   You can press the CTRL key to select multiple groups.
8. Click Create and then click Close.
To create an advanced custom command policy

1. In the configuration utility, in the navigation pane, on the Configuration tab, expand System > User Administration and then click Command Policies.
2. In the details pane, click Add.
3. In Policy Name, type a name for the policy.
4. In Action, select Allow or Deny.
5. Under Command Spec, click Add.
6. In the Add Command dialog box, click the Advanced tab.
7. In Entity Group select the group to which the command belongs, such as authentication or high availability.
8. Under Entity, select the policy.
    You can press the CTRL key to select multiple items in the list.
9. In Operation, select the command, click Create and then click Close.
    You can press the CTRL key to select multiple items in the list.
10. Click Create and then click Close.
11. In the Create Command Policy dialog box, click Create and then click Close.

When you click Create, the expression appears under Command Spec in the Create Command Policy dialog box.

After creating the custom command policy, you can bind it to a user or a group.

**Note:** You can only bind custom command policies to users or groups you create. You cannot bind a custom command policy to the user nsroot.

To bind a custom command policy to a user or group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System > User Administration and then click System Users or click Systems Groups.
2. In the details pane, select a user or group from the list and then click Open.
3. Under Command Policies, select the policy and then click OK.

Configuring Auditing on Citrix Gateway

April 23, 2019
Citrix Gateway 13.0

Citrix Gateway allows you to log the states and status information that the appliance collects. You can use the audit logs to view the event history in chronological order. The messages within the logs contain information about the event that generated the message, a time stamp, the message type, and predefined log levels and message information. You can configure settings that determine the information that is logged and the location where the messages are stored.

Citrix Gateway currently supports two log formats: a proprietary log format for local logs, and the syslog format for use with syslog servers. You can configure the audit logs to provide the following information:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMERGENCY</td>
<td>Logs major errors only. Entries in the log indicate that Citrix Gateway is experiencing a critical problem that is causing it to be unusable.</td>
</tr>
<tr>
<td>ALERT</td>
<td>Logs problems that might cause Citrix Gateway to function incorrectly, but are not critical to its operation. Corrective action should be taken as soon as possible to prevent Citrix Gateway from experiencing a critical problem.</td>
</tr>
<tr>
<td>CRITICAL</td>
<td>Logs critical conditions that do not restrict the operation of Citrix Gateway, but might escalate to a larger problem.</td>
</tr>
<tr>
<td>ERROR</td>
<td>Logs entries that result from a failed operation on Citrix Gateway.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Logs potential issues that could result in an error or a critical error.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Logs more in-depth issues than the information level log, but serves the same purpose as notification.</td>
</tr>
<tr>
<td>INFORMATION</td>
<td>Log actions taken by Citrix Gateway. This level is useful for troubleshooting problems.</td>
</tr>
</tbody>
</table>

The Citrix Gateway audit log also stores compression statistics for Citrix Gateway if you configure TCP compression. The compression ratio achieved for different data is stored in the log file for each user session.

Citrix Gateway uses the log signature SessionID. This allows you to track logs per session rather than per user. Logs that are generated as part of a session have the same SessionID. If a user establishes two
sessions from the same user device with the same IP address, each session has a unique SessionID.

**Important:** If you have written custom log parsing scripts, you need to make this signature change within the custom parsing scripts.

### Configuring Logs on Citrix Gateway

April 23, 2019

When you configure logging on Citrix Gateway, you can choose to store the audit logs on Citrix Gateway or send them to a syslog server. You use the configuration utility to create auditing policies and configure settings to store the audit logs.

**To create an auditing policy**

1. In the configuration utility, on the Configuration tab, expand **Citrix Gateway > Policies > Auditing**.
2. In **Name**, type a name for the policy.
3. Select one of the following:
   - Syslog if you want to send the logs to a Syslog server.
   - Nslog to store the logs on Citrix Gateway.
   - **Note:** If you select this option, logs are stored in the /var/log folder on the appliance.
4. In the details pane, click **Add**.
5. Type the following information for the server information where the logs are stored:
   - In **Name**, type the name of the server.
   - Under **Server**, type the name or the IP address of the log server.
6. Click **Create** and then click **Close**.

After you create the auditing policy, you can bind the policy to any combination of the following:

- Globally
- Virtual servers
- Groups
- Users

**To bind an auditing policy globally**

1. In the configuration utility, on the Configuration tab, expand **Citrix Gateway > Policies > Auditing**.
2. Select either **Syslog** or **Nslog**.
3. In the details pane, click **Action** and then click **Global Bindings**.
4. In the **Bind/Unbind Auditing Policies to Global** dialog box, under **Details**, click **Insert Policy**.
5. Under **Policy Name**, select a policy and then click **OK**.

### To modify an auditing policy

You can modify an existing auditing policy to change the server to which the logs are sent.

1. In the configuration utility, on the **Configuration** tab, expand **Citrix Gateway > Policies > Auditing**
2. Select either **Syslog** or **Nslog**.
3. In the details pane, click a policy and then click **Open**.
4. In **Server**, select the new server, and then click **OK**.

### To remove an auditing policy

You can remove an auditing policy from Citrix Gateway. When you remove an auditing policy, the policy is unbound automatically.

1. In the configuration utility, on the **Configuration** tab, expand **Citrix Gateway > Policies > Auditing**
2. Select either **Syslog** or **Nslog**.
3. In the details pane, click a policy and then click **Remove**.

### Configuring ACL Logging

April 23, 2019

You can configure Citrix Gateway to log details for packets that match an extended access control list (ACL). In addition to the ACL name, the logged details include packet-specific information, such as the source and destination IP addresses. The information is stored either in a syslog or nslog file, depending on the type of logging (syslog or nslog) that you enable.

You can enable logging at both the global level and the ACL level. However, to enable logging at the ACL level, you must also enable it at the global level. The global setting takes precedence.

To optimize logging, when multiple packets from the same flow match an ACL, only the first packet’s details are logged. The counter is incremented for every other packet that belongs to the same flow. A flow is defined as a set of packets that have the same values for the following parameters:
• Source IP
• Destination IP
• Source port
• Destination port
• Protocol (TCP or UDP)

If the packet is not from the same flow, or if the time duration is beyond the mean time, a new flow is created. Mean time is the time during which packets of the same flow do not generate additional messages (although the counter is incremented).

**Note:** The total number of different flows that can be logged at any given time is limited to 10,000.

The following table describes the parameters with which you can configure ACL logging at the rule level for extended ACLs.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logstate</td>
<td>State of the logging feature for the ACL. Possible values: ENABLED and DISABLED. Default: DISABLED.</td>
</tr>
<tr>
<td>Ratelimit</td>
<td>Number of log messages that a specific ACL can generate. Default: 100.</td>
</tr>
</tbody>
</table>

**To configure ACL logging by using the configuration utility**

You can configure logging for an ACL and specify the number of log messages that the rule can generate.

1. In the configuration utility, in the navigation pane, expand **System > Network** and then click **ACLs**.
2. In the details pane, click the **Extended ACLs** tab and then click **Add**.
3. In the **Create Extended ACL** dialog box, in **Name**, type a name for the policy.
4. Select the **Log State** check box.
5. In the **Log Rate Limit** text box, type the rate limit that you want to specify for the rule and then click **Create**.

After you configure ACL logging, you can enable it on Citrix Gateway. Create an auditing policy and then bind it to a user, group, virtual server, or globally.

**To enable ACL or TCP logging on Citrix Gateway**

1. In the configuration utility, in the navigation pane, expand **Citrix Gateway > Policies > Auditing**.
2. Select either syslog or nslog.
3. On the Servers tab, click Add.
4. In the Create Auditing Server dialog box, in Name, type a name for the server and then configure the server settings.
5. Click ACL Logging or TCP Logging and then click Create.

Enabling Citrix Gateway plug-in Logging

April 23, 2019

You can configure the Citrix Gateway plug-in to log all errors to text files that are stored on the user device. Users can configure the Citrix Gateway plug-in to set the level of logging on the user device to record specific user activities. When users configure logging, the plug-in creates the following two files on the user device:

- hooklog<num>.txt, which logs interception messages that the Citrix Gateway plug-in generates.
- nsssvpn.txt, which lists errors with the plug-in.

Note: The hooklog.txt files are not deleted automatically. Citrix recommends deleting the files periodically.

User logs are located in the following directories in Windows on the user device:

- Windows XP (all users): %SystemDrive%\Documents and Settings\All Users\Application Data\Citrix\AGEE
- Windows XP (user-specific): %SystemDrive%\Documents and Settings\%username%\Local Settings\Application Data\Citrix\AGEE
- Windows Vista (all users): %SystemDrive%\ProgramData\Citrix\AGEE
- Windows Vista (user-specific): %SystemDrive%\Users\%username%\AppData\Local\Citrix\AGEE
- Windows 7 (all users): %SystemDrive%\ProgramData\Citrix\AGEE
- Windows 7 (user-specific): %SystemDrive%\Users\%username%\AppData\Local\Citrix\AGEE
- Windows 8 (all users): %SystemDrive%\ProgramData\Citrix\AGEE
- Windows 8 (user-specific): %SystemDrive%\Users\%username%\AppData\Local\Citrix\AGEE

You can use these log files to troubleshoot the Citrix Gateway plug-in. Users can email the log files to Technical Support.

In the Configuration dialog box, users can set the level of logging for the Citrix Gateway plug-in. The logging levels are:

- Record error messages
- Record event messages
• Record Citrix Gateway plug-in statistics
• Record all errors, event messages, and statistics

To enable logging

1. On the user device, right-click the Citrix Gateway icon in the notification area and then click Configure Citrix Gateway.
2. Click the Trace tab, select the log level and then click OK.

**Note:** Users must be logged on with the Citrix Gateway plug-in to open the Configuration dialog box.

To monitor ICA connections

April 23, 2019

You can monitor active user sessions on your server farm by using the ICA Connections dialog box. This dialog box provides the following information:

• User name of the person connecting to the server farm
• Domain name of the server farm
• IP address of the user device
• Port number of the user device
• IP address of the server running Citrix Virtual Apps and Desktops
• Port number of the server running Citrix Virtual Apps and Desktops

1. In the configuration utility, in the navigation pane, click Citrix ADC Gateway.
2. In the details pane, under Monitor Connections, click ICA connections to view the monitoring dialog box.

Integrating with Citrix Products

April 23, 2019

If you are a system administrator responsible for installing and configuring Citrix Gateway, you can configure the appliance to work with Citrix Endpoint Management, StoreFront, and the Web Interface. Users can connect directly to Endpoint Management from the internal network or from a remote location. When users connect, they can access their web, SaaS, and mobile apps. They can also work with documents located in ShareFile from any device.
To allow user connections to a server farm through Citrix Gateway, you configure settings in either StoreFront or the Web Interface, and on Citrix Gateway. When users connect, they have access to published applications and virtual desktops.

The configuration steps for integrating Citrix Gateway with Endpoint Management, StoreFront, and the Web Interface assume the following:

- Citrix Gateway resides in the DMZ and is connected to an existing network.
- Citrix Gateway is deployed as a standalone appliance and remote users connect directly to Citrix Gateway.
- StoreFront, Endpoint Management, Citrix Virtual Apps, Citrix Virtual Desktops, and the Web Interface reside in the secure network.
- ShareFile is configured in Endpoint Management. For more information about ShareFile, see ShareFile topic and Configuring ShareFile for User Access topic.

How you deploy StoreFront and Endpoint Management depends on the apps you provide to mobile devices. If users have access to MDX apps that are wrapped with the MDX Toolkit, Endpoint Management resides in front of StoreFront in the secure network. If you are not providing access to MDX apps, StoreFront resides in front of Endpoint Management in the secure network.

**How Users Connect to Applications, Desktops, and ShareFile**

September 10, 2019

If you have Citrix Endpoint Management in your deployment, users can connect in the following ways:

- Citrix Gateway plug-in that establishes a full VPN tunnel to resources in the internal network. You create a session profile to select the Citrix Gateway plug-in for Windows or the Citrix Gateway plug-in for Mac. When users log on by using the plug-in, endpoint analysis scans can run on the user device.

  **Note:** To allow endpoint analysis scans to run on Mac computers, you must install Citrix Gateway 10.1, Build 120.1316.e or newer.

- Citrix Workspace app to connect to web, SaaS, and Enterprise applications, web links, and documents from ShareFile through Endpoint Management. When users log on with Citrix Workspace app, Citrix Gateway routes the connection to Endpoint Management. When Citrix Workspace app establishes the connection, users’ applications and documents appear in Citrix Workspace app. If users log on with Citrix Workspace app and connect to Endpoint Management directly, you must enable clientless access in Citrix Gateway. This deployment does not require StoreFront.
Citrix Gateway 13.0

- Citrix Workspace app to connect to published applications and virtual desktops through StoreFront or the Web Interface. When users log on with Citrix Workspace app, Citrix Gateway routes the connection to StoreFront or the Web Interface. When Citrix Workspace app establishes the connection, user applications and desktops appear in Citrix Workspace app.
- Secure Hub to connect to iOS and Android apps, including WorxMail and WorxWeb, from mobile devices through Endpoint Management. When users log on to Secure Hub, they have access to the mobile apps that you configure in Endpoint Management. When Citrix Gateway establishes the Micro VPN connection, users mobile apps appear in the Secure Hub window. Users can start the apps from Secure Hub. Some apps require users to download and install the app on the mobile device.

In any of the preceding scenarios, if users want to connect through Citrix Gateway, they do the following:

- Users log on by using the Citrix Gateway plug-in or Citrix Workspace app. To log on for the first time, users open a web browser and type the fully qualified domain name (FQDN) of Citrix Gateway or Citrix Workspace app. Users with mobile devices log on with Secure Hub.
- On the logon page, users enter their credentials and are authenticated.
- After authentication, the user session redirects to StoreFront or Endpoint Management depending on your deployment.
- If you deploy both StoreFront and Endpoint Management, Citrix Gateway contacts the first server in the deployment. For example, if you configure MDX mobile apps in Endpoint Management, you deploy StoreFront behind Endpoint Management. If you are not providing access to MDX mobile apps, you deploy Endpoint Management behind StoreFront.
- All of the users' desktops, documents, and web, SaaS, and Windows-based applications appear in Citrix Workspace app or Secure Hub.

If users need to access other resources in the internal network, such as Exchange, file shares, or internal web sites, they can also log on with the Citrix Gateway plug-in. For example, if users want to connect to a Microsoft Exchange server in the network, they start Microsoft Outlook on their computer. The secure connection is made with the Citrix Gateway plug-in which connects to Citrix Gateway. The SSL VPN tunnel is created to the Exchange Server and users can access their email.

**Important:** Citrix recommends configuring authentication on the Citrix Gateway virtual server. When you disable authentication in Citrix Gateway, unauthenticated HTTP requests are sent directly to the servers running the Web Interface, StoreFront or Endpoint Management in the internal network.
Deploying with Citrix Endpoint Management, Citrix Virtual Apps and Desktop

September 10, 2019

You can have users connect to Windows, web, SaaS, and mobile applications and virtual desktops hosted in your network. You can provide access to your applications and desktops for remote and internal users by using Citrix Gateway, Citrix Endpoint Management, and Citrix Virtual Apps and Desktops. Citrix Gateway authenticates users and then allows them to access their applications by using Citrix Workspace app or Secure Hub.

Users connect to their Windows-based apps published in Citrix Virtual Apps and virtual desktops published in Citrix Virtual Desktops by using Citrix Workspace app and StoreFront.

Citrix Endpoint Management contains Citrix Endpoint Management, which allows users to connect to web, SaaS, and MDX applications. Endpoint Management allows you to manage web, SaaS, and MDX applications for single sign-on (SSO), along with ShareFile documents. You install Endpoint Management in the internal network. Remote users connect to Endpoint Management through Citrix Gateway to access their applications and ShareFile data. Remote users can connect with either the Citrix Gateway plug-in, Citrix Workspace app, or Secure Hub to access applications and ShareFile. Users who are in the internal network can connect directly to Endpoint Management by using Citrix Workspace app. The following figure shows Citrix Gateway deployed with Endpoint Management and StoreFront.

If your deployment provides access to MDX applications from Endpoint Management and access to Windows-based applications from StoreFront, you deploy Endpoint Management in front of StoreFront as shown in the following illustration:

Figure 1. Deploying Citrix Gateway with Endpoint Management in Front of StoreFront
If your deployment does not provide access to MDX applications, StoreFront resides in front of Endpoint Management, as shown in the following illustration:

Figure 2. Deploying Citrix Gateway with StoreFront in Front of Endpoint Management

With each deployment, StoreFront and Endpoint Management must reside in the internal network and Citrix Gateway must be in the DMZ. For more information about deploying Endpoint Management, see Installing Endpoint Management topic. For more information about deploying StoreFront, see StoreFront topic.

**Accessing Citrix Virtual Apps and Desktops Resources with the Web Interface**

September 10, 2019

One or more computers running Citrix Virtual Apps and Desktops creates a server farm. If your enterprise network contains a server farm, you can deploy Citrix Gateway to provide secure Internet access to published applications or virtual desktops by using the Web Interface.

In such deployments, Citrix Gateway works with the Web Interface and the Secure Ticket Authority (STA) to provide authentication, authorization, and redirection to published applications hosted on a computer running Citrix Virtual Apps or to virtual desktops provided by Citrix Virtual Desktops.

This functionality is achieved by integrating Citrix Gateway with the Web Interface, Citrix Virtual Apps, and Desktops. This integration provides advanced authentication and an access control option to the Web Interface. For more information about the Web Interface, see the Web Interface documentation in the Citrix documentation library.
Remote connectivity to a server farm does not require the Citrix Gateway plug-in. To access published applications or desktops, users connect by using Citrix Workspace app.

**Integrating Citrix Gateway with Citrix Virtual Apps and Desktops**

April 23, 2019

When you configure Citrix Gateway for user connections, you can include settings for network traffic to Citrix Virtual Apps, Citrix Virtual Desktops, or both. To do so, you configure Citrix Gateway and the Web Interface to communicate with each other.

The tasks for integrating these products include:

- Creating a Web Interface site in the Citrix Virtual Apps and Desktops farm.
- Configuring settings within the Web Interface to route user connections through Citrix Gateway.
- Configuring Citrix Gateway to communicate with the Web Interface and the Secure Ticket Authority (STA).

You can also configure Citrix Gateway to communicate with a Citrix Virtual Apps server farm by deploying Citrix Gateway in a double-hop DMZ. For more information, see [Deploying Citrix Gateway in a Double-Hop DMZ](#).

Citrix Gateway and Web Interface use the STA and Citrix XML Service to establish user connections. The STA and XML Service run on the Citrix Virtual Apps and Desktops server.

**Establishing a Secure Connection to the Server Farm**

September 10, 2019

The following example shows how Citrix Gateway deployed in the DMZ works with the Web Interface to provide a secure, single point-of-access to published resources available in a secure enterprise network.

In this example, all of the following conditions exist:

- User devices from the Internet connect to Citrix Gateway by using Citrix Workspace app.
- The Web Interface resides behind Citrix Gateway in the secure network. The user device makes the initial connection to Citrix Gateway and the connection is passed to the Web Interface.
- The secure network contains a server farm. One server within this server farm runs the Secure Ticket Authority (STA) and the Citrix XML Service. The STA and the XML Service can run on either Citrix Virtual Apps and Desktops.
Process Overview: User Access to Published Resources in the Server Farm

1. A remote user types the address of Citrix Gateway; for example, https://www.ag.wxyco.com, in the address field of a web browser. The user device attempts this SSL connection on port 443, which must be open through the firewall for the connection to succeed.
2. Citrix Gateway receives the connection request and users are asked for their credentials. The credentials are passed back through Citrix Gateway, users are authenticated, and the connection is passed to the Web Interface.
3. The Web Interface sends the user credentials to the Citrix XML Service running in the server farm.
4. The XML Service authenticates the user credentials and sends the Web Interface a list of the published applications or desktops the user is authorized to access.
5. The Web Interface populates a Web page with the list of published resources (applications or desktops) that the user is authorized to access and sends this Web page to the user device.
6. The user clicks a published application or desktop link. An HTTP request is sent to the Web Interface indicating the published resource that the user clicked.
7. The Web Interface interacts with the XML Service and receives a ticket indicating the server on which the published resource runs.
8. The Web Interface sends a session ticket request to the STA. This request specifies the IP address of the server on which the published resource runs. The STA saves this IP address and sends the requested session ticket to the Web Interface.
9. The Web Interface generates an ICA file containing the ticket issued by the STA and sends it to the Web browser on the user device. The ICA file generated by the Web Interface contains the fully qualified domain name (FQDN) or the Domain Name System (DNS) name of Citrix Gateway. Note that the IP address of the server running the requested resource is never revealed to users.
10. The ICA file contains data instructing the web browser to start Citrix Workspace app. The user device connects to Citrix Gateway by using the Citrix Gateway FQDN or DNS name in the ICA file. Initial SSL/TLS handshaking occurs to establish the identity of Citrix Gateway.
11. The user device sends the session ticket to Citrix Gateway and then Citrix Gateway contacts the STA for ticket validation.
12. The STA returns the IP address of the server on which the requested application resides to Citrix Gateway.
13. Citrix Gateway establishes a TCP connection to the server.
14. Citrix Gateway completes the connection handshake with the user device and indicates to the user device that the connection is established with the server. All further traffic between the user device and the server is proxied through Citrix Gateway. The traffic between the user device and Citrix Gateway is encrypted. The traffic between Citrix Gateway and the server can be encrypted independently, but is not encrypted by default.
Deploying with the Web Interface

September 10, 2019

When you deploy Citrix Gateway to provide secure remote access to Citrix Virtual Apps and Desktops, Citrix Gateway works with the Web Interface and the Secure Ticket Authority (STA) to provide access to published applications and desktops hosted in a server farm.

Deploying Citrix Gateway in the DMZ is the most common configuration when Citrix Gateway operates with a server farm. In this configuration, Citrix Gateway provides a secure single point-of-access for the web browsers and Citrix Workspace app that access the published resources through the Web Interface. This section covers the basic aspects of about this deployment option.

The configuration of your organization’s network determines where you deploy Citrix Gateway when it operates with a server farm. You have the following two options:

- If your organization protects the internal network with a single DMZ, deploy Citrix Gateway in the DMZ.
- If your organization protects the internal network with two DMZs, deploy one Citrix Gateway in each of the two network segments in a double-hop DMZ configuration. For more information, see Deploying Citrix Gateway in a Double-Hop DMZ. Note: You can also configure a double-hop DMZ with the second Citrix Gateway appliance in the secure network.

When you deploy Citrix Gateway in the DMZ to provide remote access to a server farm, you can implement one of the following three deployment options:

- Deploy the Web Interface behind Citrix Gateway in the DMZ. In this configuration, as shown in the following figure, both Citrix Gateway and the Web Interface are deployed in the DMZ. The initial user connection goes to Citrix Gateway and is then redirected to the Web Interface. Figure 1. Web Interface Behind Citrix Gateway in the DMZ

- Deploy Citrix Gateway parallel to the Web Interface in the DMZ. In this configuration, both Citrix Gateway and the Web Interface are deployed in the DMZ, but the initial user connection goes to the Web Interface instead of Citrix Gateway.
Deploy Citrix Gateway in the DMZ and deploy the Web Interface in the internal network. In this configuration, Citrix Gateway authenticates user requests before relaying the request to the Web Interface in the secure network. The Web Interface does not perform authentication, but interacts with the STA and generates an ICA file to ensure that ICA traffic is routed through Citrix Gateway to the server farm.

The location in which you deploy the Web Interface depends on a number of factors, including:

- Authentication. When users log on, either Citrix Gateway or the Web Interface can authenticate user credentials. Where you place the Web Interface in your network is a factor that determines, in part, where users authenticate.
- User software. Users can connect to the Web Interface with either the Citrix Gateway plug-in or Citrix Workspace app. You can limit the resources users can access by using Citrix Workspace app only, or give users greater network access with the Citrix Gateway plug-in. How users connect, and the resources to which you allow users to connect can help determine where you deploy the Web Interface in your network.

**Deploying the Web Interface in the Secure Network**

April 23, 2019

In this deployment, the Web Interface resides in the secure, internal network. Citrix Gateway is in the DMZ. Citrix Gateway authenticates user requests before sending the requests to the Web Interface.

When you deploy the Web Interface in the secure network, you must configure authentication on Citrix Gateway.

If you deploy the Web Interface with Citrix Virtual Apps and Desktops, deploying the Web Interface in the secure network is the default deployment scenario. When the Desktop Delivery Controller is installed, a custom version of the Web Interface is also installed.

**Important:**

When the Web Interface is in the secure network, you should enable authentication on Citrix Gateway. Users connect to Citrix Gateway, type their credentials, and then connect to the Web Interface. When you disable authentication, unauthenticated HTTP requests are sent directly to the server running the Web Interface. Disabling authentication on Citrix Gateway is recommended only when the Web Interface is in the DMZ and users connect directly to the Web Interface.

Figure 1. Web Interface Located Inside the Secure Network
Deploying the web interface parallel to Citrix Gateway in the DMZ

September 10, 2019

In this deployment, the Web Interface and Citrix Gateway both reside in the DMZ. Users connect directly to the Web Interface by using a web browser or Citrix Workspace app. User connections are first sent to the Web Interface for authentication. After authentication, the connections are routed through Citrix Gateway. After users log on successfully to the Web Interface, they can access published applications or desktops in the server farm. When users start an application or desktop, the Web Interface sends an ICA file containing instructions for routing ICA traffic through Citrix Gateway as if it were a server running the Secure Gateway. The ICA file delivered by the Web Interface includes a session ticket produced by the Secure Ticket Authority (STA).

When Citrix Workspace app connects to Citrix Gateway, the ticket is presented. Citrix Gateway contacts the STA to validate the session ticket. If the ticket is still valid, the user’s ICA traffic is relayed to the server in the server farm. The following figure shows this deployment.

Figure 1. The Web Interface installed parallel to Citrix Gateway

When the Web Interface runs parallel to Citrix Gateway in the DMZ, you do not need to configure authentication on Citrix Gateway. The Web Interface authenticates users.
**Deploying the web interface behind Citrix Gateway in the DMZ**

September 10, 2019

In this configuration, both Citrix Gateway and the Web Interface are deployed in the DMZ. When users log on with Citrix Workspace app, the initial user connection goes to Citrix Gateway and is then redirected to the Web Interface. To route all HTTPS and ICA traffic through a single external port and require the use of a single SSL certificate, Citrix Gateway acts as a reverse web proxy for the Web Interface.

![Figure 1. Web Interface Located Behind Citrix Gateway](image)

When the Web Interface is deployed behind Citrix Gateway in the DMZ, you can configure authentication on the appliance but it is not required. You can have either Citrix Gateway or the Web Interface authenticate users because both reside in the DMZ.

**Setting Up a Web Interface Site to Work**

September 10, 2019

The Web Interface provides users with access to Citrix Virtual Apps applications and content and Citrix Virtual Desktops virtual desktops. Users access their published applications and desktops through a standard Web browser or through Citrix Workspace app.

You can use the Access Management Console to configure Web Interface 5.1 sites and the Web Interface Management console to create Web Interface sites for Versions 5.2, 5.3, and 5.4. You can install the consoles on Windows-based platforms only.

To configure the Web Interface to work with Citrix Gateway, you need to:

- Create the Web Interface site for the version you are using.
- Configure settings in the Web Interface.
Configure Web Interface settings on Citrix Gateway.

Web Interface Features

April 23, 2019

Before you configure the Web Interface to work with Citrix Gateway, you need to understand the differences between Citrix Virtual Apps Web sites and Citrix Virtual Apps Services sites.

- **Citrix Virtual Apps Web sites.** The Web Interface provides functionality to create and manage Citrix Virtual Apps Web sites. Users access published resources and streamed applications remotely using a Web browser and a plug-in.

- **Citrix Virtual Apps Services sites.** Citrix Virtual Apps is a plug-in designed for flexibility and ease of configuration. By using Citrix Virtual Apps in conjunction with Citrix Virtual Apps Services sites on the Web Interface, you can integrate published resources with users’ desktops. Users access remote and streamed applications, and remote desktops and content by clicking icons on their desktop or the Start menu, or by clicking in the notification area of their computer desktop. You can determine the configuration options your users can access and modify, such as audio, display, and logon settings.

  **Note:** If you select this option, access to virtual desktops is not supported.

For more information, see the Web Interface documentation in the Technologies node in the Citrix eDocs library.

Setting Up a Web Interface Site

September 10, 2019

If you deploy the Web Interface in the secure network and configure authentication on Citrix Gateway, when users connect to Citrix Gateway, the appliance authenticates users.

**Important:** Install and configure the Web Interface before you configure Citrix Gateway. For more information, see the Web Interface documentation in the Technologies node in the Citrix eDocs library.

The steps for creating a Web Interface site include:

- Select how users log on. This can be through a web browser, the Citrix Gateway plug-in, or Citrix Workspace app. For information, see Web Interface Features.
Citrix Gateway 13.0

- Identify where users authenticate from. Citrix Gateway or the Web Interface.

**Note:** When the Web Interface is in the secure network, you enable authentication on the virtual server on the Citrix Gateway. When you disable authentication, unauthenticated HTTP requests are sent directly to the server running the Web Interface. Disabling authentication on Citrix Gateway is recommended only when the Web Interface is in the DMZ and users connect directly to the Web Interface.

Make sure you install a valid server certificate on Citrix Gateway. For more information about working with certificates, see *Installing and Managing Certificates*.

**Important:** For the Web Interface to work properly with Citrix Gateway 10.1, the server running the Web Interface must trust the Citrix Gateway certificate and be able to resolve the virtual server fully qualified domain name (FQDN) to the correct IP address.

### Creating a Web Interface 5.4 Site

**April 23, 2019**

The Citrix Web Interface Management console is a Microsoft Management Console (MMC) 3.0 snap-in that enables you to create and configure Citrix Virtual Apps Web and Citrix Virtual Apps Services sites hosted on Microsoft Internet Information Services (IIS). Web Interface site types are shown in the left pane. The central results pane displays the sites available within the site type container selected in the left pane.

The Citrix Web Interface Management console enables you to perform day-to-day administration tasks quickly and easily. The Action pane lists the tasks currently available. Tasks relating to items selected in the left pane are shown at the top and actions available for items selected in the results pane are shown below.

When using the console, your configuration takes effect when you commit your changes using the console. As a result, some Web Interface settings may be disabled if their values are not relevant to the current configuration and the corresponding settings are reset to their default values in WebInterface.conf. Citrix recommends that you create regular backups of the WebInterface.conf and config.xml files for your sites.

The Citrix Web Interface Management console is installed automatically when you install Web Interface for Microsoft Internet Information Services. Run the console by clicking Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Management.

**Note:**

You must ensure that MMC 3.0 is present on the server on which you install the Web Interface as
Using Configuration Files

You can edit the following configuration files to configure Web Interface sites:

- Web Interface configuration file. The Web Interface configuration file, WebInterface.conf, en-
  ables you to change many Web Interface properties; it is available on both Microsoft Internet In-
  formation Services (IIS) and Java application servers. You can use this file to perform day-to-day
  administration tasks and customize many more settings. Edit the values in WebInterface.conf
  and save the updated file to apply the changes. For more information about configuring the Web
  Interface by using WebInterface.conf, see the Web Interface documentation in the Technologies
  node in Citrix eDocs.
- Citrix online plug-in configuration file. You can configure the Citrix online plug-in by using the
  config.xml file on the Web Interface server.

Configuring Sites By Using the Citrix Web Interface Management Console

April 23, 2019

The Citrix Web Interface Management console is a Microsoft Management Console (MMC) 3.0 snap-in
that enables you to create and configure Citrix Virtual Apps Web and Citrix Virtual Apps Services sites
hosted on Microsoft Internet Information Services (IIS). Web Interface site types are shown in the left
pane. The central results pane displays the sites available within the site type container selected in
the left pane.

The Citrix Web Interface Management console enables you to perform day-to-day administration tasks
quickly and easily. The Action pane lists the tasks currently available. Tasks relating to items selected
in the left pane are shown at the top and actions available for items selected in the results pane are
shown below.

When using the console, your configuration takes effect when you commit your changes using the
console. As a result, some Web Interface settings may be disabled if their values are not relevant to
the current configuration and the corresponding settings are reset to their default values in WebInter-
face.conf. Citrix recommends that you create regular backups of the WebInterface.conf and config.xml
files for your sites.

The Citrix Web Interface Management console is installed automatically when you install Web Inter-
face for Microsoft IIS. Run the console by clicking Start > All Programs > Citrix > Management Consoles
> Citrix Web Interface Management.
Note: You must ensure that MMC 3.0 is present on the server on which you install the Web Interface as this is a prerequisite for installation of the Citrix Web Interface Management console. MMC 3.0 is available by default on all the Windows platforms supported for hosting the Web Interface.

Configuring Citrix Gateway Settings in the Web Interface 5.4

May 9, 2019

To use Citrix Gateway in your deployment, you must configure the Web Interface support the appliance. To do this, use the Secure Access task in the Citrix Web Interface Management console.

To configure Citrix Gateway settings in the Web Interface

1. On the Windows Start menu, click All Programs > Citrix > Management Consoles > Citrix Web Interface Management.

2. In the left pane of the Citrix Web Interface Management console, click either Citrix Virtual Apps Web Sites or Citrix Virtual Apps Services Sites and then select your site in the results pane.

3. In the Action pane, click Secure Access.

4. On the Specify Access Methods page, do one of the following:
   - Click Add to add a new access route.
   - Select an existing route from the list and then click Edit.

5. From the Access method list, select one of the following options:
   - If you want to send the actual address of the Citrix server to Citrix Gateway, select Gateway Direct.
   - If you want to send the alternate address of the Citrix Virtual Apps server to Citrix Gateway, select Gateway alternate.
     
     Note: Citrix Virtual Desktops virtual desktops cannot be accessed if alternate addresses are used.
   - If you want the address given to Citrix Gateway to be determined by the address translation mappings set in the Web Interface, select Gateway translated.

6. Enter the network address and subnet mask that identify the client network. Use the Move Up and Move Down buttons to place the access routes in order of priority in the User device addresses table and then click Next.
7. If you are not using gateway address translation, continue to Step 10. If you are using gateway address translation, do one of the following on the Specify Address Translations page:
   - Click Add to add a new address translation.
   - Select an existing address translation from the list and then click Edit.

8. In the Access Type area, select one of the following options:
   - If you want Citrix Gateway to use the translated address to connect to the Citrix server, select Gateway route translation.
   - If you configured a client translated route in the User device addresses table and want both the Citrix client and Citrix Gateway to use the translated address to connect to the Citrix server, select User device and gateway route translation.

9. Enter the internal and external (translated) ports and addresses for the Citrix server, click OK and then click Next. When Citrix Gateway connects to the Citrix server, it uses the external port number and address. Ensure that the mappings you create match the type of addressing being used by the server farm.

10. On the Specify Gateway Settings page, specify the fully qualified domain name (FQDN) and port number of the Citrix Gateway appliance that clients must use. The FQDN must match what is on the certificate installed on the gateway.

11. Select Enable session reliability if you want the Citrix server to keep disconnected sessions open while the client attempts to reconnect automatically.

12. Select Request tickets from two STAs where available if you enabled session reliability and want to use simultaneous ticketing from two Secure Ticket Authority (STA) servers. When you enable this option, the Web Interface obtains tickets from two different STAs so that user sessions are not interrupted if one STA becomes unavailable during the course of the session. If for any reason the Web Interface is unable to contact two STAs, it falls back to using a single STA. Click Next.

13. On the Specify Secure Ticket Authority Settings page, do one of the following:
   - Click Add to specify the URL of a STA that the Web Interface can use.
   - Select an entry from the list and then click Edit.

   Use the Move Up and Move Down buttons to place the STAs in order of priority. STAs are included with the Citrix XML Service; for example, http[s]://servername.domain.com/scripts/ctxsta.dll.

   You can specify more than one STA for fault tolerance; however, Citrix recommends that you do not use an external load balancer for this purpose.

14. Select Use for load balancing to choose whether or not to enable load balancing between STAs. Enabling load balancing allows you to evenly distribute connections among servers so that no one server becomes overloaded.
15. Select Bypass failed servers for to specify the length of time that unreachable STAs should be bypassed.

The Web Interface provides fault tolerance among the servers on the STA URLs list so that if a communication error occurs, the failed server is bypassed for the specified time period.

**Creating a Web Interface 5.3 Site**

September 10, 2019

When you create a Web Interface 5.3 site, you can require users to log on with either a web browser, Citrix Workspace app, or Citrix Desktop Citrix Workspace app. You can use the Citrix Web Interface Management console to create multiple Web Interface sites.

You can only enable single sign-on with a smart card to the Web Interface with Web Interface 5.3. This version of the Web Interface can run on Citrix Virtual Apps 4.5, 5.0, and 6.0.

Web Interface 5.3 runs on the following operating systems:

- Windows Server 2003
- Windows Server 2008
- Windows Server 2008 R2

**Note:**

Citrix Virtual Apps 6.0 runs only on Windows Server 2008 R2.

**To create a Web Interface 5.3 site**

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Management.
2. In the left pane, select Citrix Virtual Apps Web Sites. Users log on to the Web Interface using a Web browser.
3. On the Action menu, click Create Site.
4. Keep the default Internet Information Services (IIS) site and path and then click Next.
   
   The default site path is /Citrix/Citrix Virtual Apps or you can specify a path.

   **Note:**

   If there are any preexisting Citrix Virtual Apps Web sites that use the default path, an appropriate increment is added to distinguish the new site.

5. In Specify where user authentication takes place, select one of the following:
Citrix Gateway 13.0

- At Web Interface to have users authenticate using the Web Interface.
  Select this option if the Web Interface is deployed as a standalone server parallel to Citrix Gateway in the demilitarized zone (DMZ).

- At Access Gateway to have users authenticate using the Citrix Gateway appliance.
  If you select this option, Citrix Gateway authenticates users and initiates single sign-on to the Web Interface if it is configured on the appliance.

  **Note:**
  If SmartAccess is configured on Citrix Gateway, this setting enables SmartAccess in Citrix Virtual Apps and Desktops.

6. Click Next.

7. In Step 5, in Authentication service URL, type the Web address to the Citrix Gateway authentication service URL, such as https://access.company.com/CitrixAuthService/AuthService.asmx and then click Next.

8. Under Authentication Options, select how users log on.
   - Explicit. Users log on by using a Web browser.
   - Smart Card. Users log on by using a smart card.

9. Click Next.

10. If you selected Smart Card in Step 8, select one of the following:

    | 1 | Prompt users for PIN. Users enter their personal identification number (PIN) when they start a published application or desktop. |
    | 2 | Users do not have to enter their PIN when they start a published application or desktop. |

You receive a summary screen showing your settings. Click Next to create the Web Interface site. When the site is successfully created, you are then prompted to configure the remaining settings in the Web Interface. Follow the instructions in the wizard to complete the configuration.

**Configuring Citrix Gateway Settings in Web Interface 5.3**

April 23, 2019

After you create the Web Interface 5.3 site, you can use Citrix Web Interface Management to configure settings for Citrix Gateway.
To configure Web Interface 5.3 settings for Citrix Gateway

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Management.
2. In the left pane of Citrix Web Interface Management, click Citrix Virtual Apps Web Sites.
3. In the Action pane, click Secure Access.
4. In the Edit Secure Access Settings dialog box, click Add.
5. In the Add Access Route dialog box, type the user device address, subnet mask, and in Access Method, select Gateway direct, click OK and then click Next. If you do not specify the user device address and subnet mask, the Gateway direct option applies to all user devices. The Gateway direct option is appropriate for user devices connecting from outside of the internal network, whereas the Direct option is appropriate for user devices connecting from within the internal network.
6. In Address (FQDN), type the Citrix Gateway fully qualified domain name (FQDN). This must be the same FQDN that is used on the Citrix Gateway certificate.
7. In Port, type the port number. The default is 443.
8. To enable session reliability, click Enable session reliability and then click Next.
9. Under Secure Ticket Authority URLs, click Add.
10. In Secure Ticket Authority URL, type the name of the master server running the XML Service on Citrix Virtual Apps, click OK and then click Finish. For example, type http://Citrix Virtual Appssrv01/Scripts/CtxSta.dll.

After you configure the settings in the Web Interface, you can then configure settings on Citrix Gateway.

Adding Citrix Virtual Apps and Desktops to a Single Site

April 23, 2019

If you are running Citrix Virtual Apps and Desktops, you can add both applications to a single Web Interface site. This configuration allows you to use the same Secure Ticket Authority (STA) server from either Citrix Virtual Apps and Desktops.

Note:
Citrix Virtual Desktops supports the Web Interface. The minimum required version of the Web Interface is 5.0.

If you are using Web Interface 5.3 or 5.4, you combine the Citrix Virtual Apps and Desktops sites by using the Web Interface Management console.

Note:
If the server farms are in different domains, you must establish two-way trust between the domains.

To add Citrix Virtual Apps and Desktops to a single site by using Web Interface 5.3 or 5.4

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Management.
2. In the left pane, select Citrix Virtual Apps Web Sites.
3. In the Action pane, right-click a site and then click Server Farms.
4. In the Manage Server Farms dialog box, click Add.
5. Complete the settings for the server farm and then click OK twice.

For the best experience when using Citrix Virtual Desktops, change the setting UserInterfaceBranding to Desktops in the WebInterface.conf configuration file.

Routing User Connections Through Citrix Gateway

September 10, 2019

In Citrix Virtual Apps and Desktops, you can configure the servers to only accept connections that are routed through Citrix Gateway. In Citrix XenApp 6.5, you configure a policy in Citrix AppCenter to route connections through Citrix Gateway. In Citrix Virtual Desktops 7.1, you use Citrix Studio to configure the settings.

To configure Citrix XenApp 6.5 server properties to accept connections routed through Citrix Gateway only

1. Click Start > Administrative Tools > Citrix > Management Consoles > Citrix AppCenter.
2. Expand NetScaler Resources > Citrix Virtual Apps > farmName, where farmName is the name of the server farm.
3. Click Policies.
4. In the center pane, click Computer or User and then click New.
5. In the New Policy wizard, in Name, type a name for the policy and then click Next.
7. Under Settings, next to Connection access control, click Add.
8. In the Add Setting - Connection access control dialog box, in Value, select Citrix Access Gateway connections only and then click OK.
9. Click Next two times and then click Create. Citrix Virtual Apps creates the policy.
To configure Citrix Virtual Desktops server properties to accept connections routed through Citrix Gateway only

You can restrict access to a Delivery Group’s machines. You can restrict access for users by using SmartAccess that filters user connections made through Citrix Gateway. You can perform this task in the Policy node in Studio, or through policy settings as described in Quick reference table.

1. In Studio, under Delivery Groups, select the Delivery Group you want to restrict.
2. Click Edit Delivery Group and then click Access policy.
3. On the Access Policy page, select Connections through Citrix Gateway. Only connections through the Citrix Gateway are allowed.
4. To choose a subset of those connections, select Connections meeting any of the following filters:
   a) Define the Citrix Gateway site.
   b) Add, edit, or remove the SmartAccess strings that define the allowed user access scenarios for the Delivery Group. For more information about configuring SmartAccess, see Configuring SmartAccess on Citrix Gateway.

Configuring Communication with the Web Interface

April 23, 2019

You can configure Citrix Gateway to communicate with the Web Interface running on Citrix Virtual Apps and Desktops. To do so, configure a virtual server on Citrix Gateway. Next, bind a signed server certificate and authentication, session, preauthentication, and post-authentication policies to the virtual server. Citrix Gateway uses the virtual server IP address to route user connections to the Web Interface.

The Published Applications Wizard allows you to configure Citrix Gateway to route user connections to the Web Interface. Citrix Gateway uses the Secure Ticket Authority (STA) for user connections.

Configuring Policies for Published Applications and Desktops

September 10, 2019

To establish communication with Citrix Virtual Apps and Desktops servers, you need to configure Citrix Gateway to recognize the servers. You can configure the settings globally or you can use policies that are bound to users, groups, or virtual servers.
To configure the Web Interface globally on Citrix Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. In the Global Citrix Gateway Settings dialog box, on the Client Experience tab, do the following:
   a) In plug-in type, select Java.
   b) In Clientless Access, select Allow.

   **Note:** Perform Step 3 to support VPN-capable Citrix Workspace app, such as Citrix Workspace app for iOS or Citrix Workspace app for Android. To support mobile Citrix Workspace app, you must install a minimum of Access Gateway 10, Build 69.6 or Access Gateway 10, Build 71.6014.e. If you are running Access Gateway 9.3, you do not need to perform this step.
4. On the Published Applications tab, next to ICA Proxy, select ON.
5. Next to Web Interface Address, type the Web address of the Web Interface and then click OK.

To configure a session policy for the Web Interface

You can configure a session policy and bind it to a virtual server to limit access to the Web Interface.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In the Create Session Policy dialog box, in Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In the Create Session Profile dialog box, in Name, type a name for the profile.
6. On the Client Experience tab, do the following:
   a) Next to plug-in type, select Override Global and then select Java.
   b) Next to Clientless Access, select Override Global and then select Allow.
7. Next to ICA Proxy, click Override Global and select ON.
8. Next to Web Interface Address, click Override Global, type the Web address of the Web Interface and then click Create.
9. In the Create Session Policy dialog box, next to Named Expressions, select General, select True value, click Add Expression, click Create and then click Close.

After you create a session policy, bind the policy to a virtual server.

To bind a session policy to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. On the Policies tab, click Session and then click Insert Policy.
4. Select a session policy from the list, enter the priority number (optional) and then click OK.

Configuring Settings with the Published Applications wizard

April 23, 2019

To configure Citrix Gateway with the Web Interface, you need the following information:

- IP addresses of servers running Citrix Virtual Apps and Desktops.
- Fully qualified domain name (FQDN) of the server running the Web Interface.
- Virtual server configured on Citrix Gateway.
- Session policy configured for SmartAccess.
- IP addresses of additional servers running the Web Interface if you are configuring Web Interface failover.

To configure Web Interface settings by using the Published Applications wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Getting Started, click Published Applications wizard.
3. Click Next and then follow the instructions in the wizard.

You can configure and activate the Secure Ticket Authority (STA) from within the Published Applications wizard. When you complete the Published Applications wizard, the settings are bound globally.

Configuring the Secure Ticket Authority on Citrix Gateway

April 3, 2020

The Secure Ticket Authority (STA) is responsible for issuing session tickets in response to connection requests for published applications on Citrix Virtual Apps and published desktops on Citrix Virtual Desktops. These session tickets form the basis of authentication and authorization for access to published resources.

You can bind the STA globally or to virtual servers. You can also add multiple servers running the STA when you configure a virtual server.
If you are securing communications between the Citrix Gateway and the STA, make sure a server certificate is installed on the server running the STA.

In a typical Citrix Gateway GSLB deployment, all gateway virtual servers (in each site) must be configured with the same back-end STA servers to avoid reconnection issues.

**To bind the STA globally**

1. Navigate to **Citrix Gateway > Global Settings**.
2. In the details pane, under Servers, click **Bind/Unbind STA Servers** to be used by the Secure Ticket Authority.
3. In the **Bind/Unbind STA Servers** dialog box, click **Add**.
4. In the **Configure STA Server** dialog box, enter the URL of the STA server, click **Create**, and then click **OK**.
5. In the **STA Server** dialog box, in URL, type the IP address or fully qualified domain name (FQDN) of the server running the STA and then click **Create**.

**Note:**
You can add more than one server running the STA to the list. The STAs that are listed in the Web Interface must match the STAs that are configured on Citrix Gateway. If you are configuring multiple STAs, do not use load balancing between Citrix Gateway and the servers running the STA.

**To bind a STA to the virtual server**

1. Navigate to **Citrix Gateway > Virtual Servers**.
2. In the details pane, select a virtual server and then click **Edit**.
3. On the **Published Applications** tab, under Secure Ticket Authority, click **Add**.
4. In the **Configure STA Server** dialog box, enter the URL of the STA server and then click **Create**.
5. Repeat Step 4 to add additional STA servers and then click **OK**.

**References**

- For details about STA, see the article [NetScaler Gateway Secure Ticket Authority](#).
- For details on configuring your Citrix Gateway to use a Cloud Connector as the Secure Ticket Authority (STA) server, see [How do I configure Citrix Gateway to use a Cloud Connector as a STA](#).
Configuring Additional Web Interface Settings on Citrix Gateway

If you deploy Citrix Gateway in a Web Interface environment, you can complete the following optional tasks:

- **Configuring Web Interface Failover** Configure Citrix Gateway to failover to a secondary server running the Web Interface.
- **Configuring Smart Card Access with the Web Interface** Configure user sessions to log on directly to the Web Interface by using Citrix Workspace app and smart card authentication.

Configuring Web Interface Failover

You can use the Published Applications Wizard to configure Citrix Gateway to fail over to a secondary server running the Web Interface.

Web Interface failover allows user connections to stay active if the primary Web Interface fails. When you configure failover, you define a new IP address in addition to the system IP address, mapped IP address, or virtual server IP address. The new IP address must be on the same subnet as the system or mapped IP address.

When you configure Web Interface failover on Citrix Gateway, any network traffic that is sent to the new IP address is relayed to the primary Web Interface. The virtual server that you select in the Published Applications wizard serves as the network address translation (NAT) IP address. The real IP address is that of the Web Interface. If the primary Web Interface fails, network traffic is sent to the secondary Web Interface.

To configure Web Interface failover

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click Citrix Gateway.
2. In the details pane, under Getting Started, click Published applications wizard.
3. Click Next, select a virtual server and then click Next.
5. Under Primary Web Interface, in Web Interface Server, type the IP address of the primary Web Interface.
6. In Web Interface Server Port, type the port number for the primary Web Interface.
7. In Virtual Server IP, type the new IP address for failover.
8. In Virtual Server Port, enter the port number for the virtual server.
9. Under Backup Web Interface, in Web Interface Server, type the IP address of the server running the Web Interface or select a server from the list.
10. In Web Interface Server Port, type the port number of the Web Interface and then click OK.
11. Click Next and then follow the instructions to complete the wizard.

Configuring Smart Card Access with the Web Interface

September 10, 2019

When you configure the Web Interface to use smart card authentication, you can configure the following deployment scenarios in order to integrate Citrix Gateway, depending on how users log on:

- If users log on directly to the Web Interface by using Citrix Workspace app and smart card authentication, the Web Interface must be parallel to Citrix Gateway in the DMZ. The server running the Web Interface must also be a domain member.

  In this scenario, both Citrix Gateway and the Web Interface perform SSL termination. The Web Interface terminates secure HTTP traffic including user authentication, the display of published applications, and the starting of published applications. Citrix Gateway terminates SSL for incoming ICA connections.

- If users log on with the Citrix Gateway plug-in, Citrix Gateway performs the initial authentication. When Citrix Gateway establishes the VPN tunnel, users can log on to the Web Interface by using the smart card. In this scenario, you can install the Web Interface behind Citrix Gateway in the DMZ or in the secure network.

**Note:**
Citrix Gateway can also use the smart card for authentication by using a client certificate.

For more information, see
Configuring Smart Card Authentication

Configuring Access to Applications and Virtual Desktops in the Web Interface

April 23, 2019
You can configure Citrix Gateway to give users access to published applications and virtual desktops with the Citrix Gateway plug-in instead of with Receiver. To configure access to applications and desktops, you change the configuration on Citrix Gateway from using Receiver only to connect to Citrix Gateway, to a configuration that enables connections by using the Citrix Gateway plug-in with single sign-on to the Web Interface. For example, you configure Citrix Gateway so that all users connect with the Citrix Gateway plug-in and use the Web Interface as the home page. This scenario supports single sign-on to the Web Interface.

In addition to access to applications and desktops, users can also run applications installed on the user device that make network connections through the VPN tunnel.

To start the configuration, use the following guidelines:

- Create a Web Interface site.
- Configure Advanced Access Control settings.
- Configure SmartAccess.
- Configure endpoint analysis on Citrix Gateway.
- Configure policies and filters on Citrix Virtual Apps and Desktops.
- Configure Citrix Gateway so users log on by using the Citrix Gateway plug-in to access published applications and virtual desktops.

For more information, see the following topics in Citrix eDocs:

- Setting Up a Web Interface Site.
- How SmartAccess Works for Citrix Virtual Apps and Desktops
- Configuring Endpoint Policies
- Configuring Citrix Virtual Apps Policies and Filters
- To configure policies and filters in Citrix Virtual Desktops 5
- Configuring Citrix Gateway to Communicate with the Web Interface

When configuring user logon to Citrix Virtual Apps and Desktops, you first create a session profile to select the Citrix Gateway plug-in for Windows. Then, you create a profile for intranet applications for access to Citrix Virtual Apps, Citrix Virtual Desktops, and the Web Interface.

**To configure global settings for the Citrix Gateway plug-in for access to applications and desktops**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Published Applications tab, next to ICA Proxy, select OFF.
4. In Web Interface Address, type the URL of the Web Interface site. This becomes the home page for users.
5. In Single Sign-On Domain, type the Active Directory domain name.
6. On the Client Experience tab, next to plug-in Type, select Windows/Mac OS X and then click OK.

**To configure the intranet application**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Resources and then click Intranet Applications.
2. In the details pane, click Add.
3. In Name, type a name for the application.
4. Click Transparent.
5. In Protocol, select the TCP, UDP, or Any.
6. In Destination Type, select IP Address and Netmask. For example, type 172.16.100.0 and the subnet mask 255.255.255.0 to represent all servers on the 172.16.100.x subnet. The IP address of the Web Interface, Citrix Virtual Apps, and all other servers to which users connect must be in one of the subnets defined as an intranet application.

After you create the intranet application, you can bind it globally or to a virtual server.

7. In IP Address and NetMask, type the IP address and subnet mask that represents your internal network, click Create and then click Close.

After you create the intranet application, you can bind it globally or to a virtual server.

**To bind an intranet application globally**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Intranet Applications, click Create mappings to TCP applications in the secure network for the Citrix Gateway plug-in for Java.
3. In the Configure VPN Intranet Applications dialog box, click Add.
4. Under Available, select one or more intranet applications, click the arrow to move the intranet applications to Configured and then click OK.

**To bind an intranet application to a virtual server**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, select a virtual server and then click Open.
3. In the configure Citrix Gateway Virtual Server dialog box, click the Intranet Applications tab.
4. Under Available Application Name, select the intranet applications, click Add and then click OK.

When users log on with the Citrix Gateway plug-in, the VPN tunnel is established and either Receiver or the Web Interface is used as the home page.

**Configuring SmartAccess**

September 10, 2019

You can use SmartAccess with Citrix Virtual Apps and Desktops to intelligently deliver published applications and virtual desktops to users.

SmartAccess allows you to control access to published applications and desktops on a server through the use of Citrix Gateway session policies. You use preauthentication and post-authentication checks as a condition, along with other conditions, for access to published resources. Other conditions include anything you can control with a Citrix Virtual Apps and Desktops policy, such as printer bandwidth limits, user device drive mapping, clipboard, audio, and printer mapping. You can apply a Citrix Virtual Apps and Desktops policy based on whether or not users pass an Citrix Gateway check.

Citrix Gateway can deliver Citrix Virtual Desktops by using the same options that are available with Web Interface, ICA proxy access, clientless access, and Citrix Gateway access.

This functionality is achieved by integrating Citrix Gateway components with the Web Interface and Citrix Virtual Apps and Desktops. This integration provides advanced authentication and an access control options to the Web Interface. For more information, see the Web Interface documentation in the Technologies node in the Citrix eDocs library.

Remote connectivity to a server farm does not require the Citrix Gateway plug-in. Users can connect with Citrix Workspace app. Users can use the Citrix Gateway plug-in to log on and receive their published applications and virtual desktops through the Access Interface, which is the default home page for Citrix Gateway.

**How SmartAccess Works for Citrix Virtual Apps and Desktops**

April 23, 2019

To configure SmartAccess, you need to configure Citrix Gateway settings on the Web Interface and configure session policies on Citrix Gateway. When you run the Published Applications Wizard, you can select the session policies you created for SmartAccess.

After you configure SmartAccess, the feature works as follows:
1. When a user types the web address of a virtual server in a web browser, any preauthentication policies that you configured are downloaded to the user device.

2. Citrix Gateway sends the preauthentication and session policy names to the Web Interface as filters. If the policy condition is set to true, the policy is always sent as a filter name. If the policy condition is not met, the filter name is not sent. This allows you to differentiate the list of published applications and desktops and the effective policies on a computer running Citrix Virtual Apps and Desktops, based on the results of the endpoint analysis.

3. The Web Interface contacts the Citrix Virtual Apps and Desktops server and returns the published resource list to the user. Any resources that have filters applied do not appear in the user’s list unless the condition of the filter is met.

You can configure SmartAccess endpoint analysis on Citrix Gateway. To configure endpoint analysis, create a session policy that enables the ICA proxy setting and then configure a client security string.

When the user logs on, the endpoint analysis policy runs a security check of the user device with the client security strings that you configured on Citrix Gateway.

For example, you want to check for a specific version of Sophos Antivirus. In the expression editor, the client security strings appears as:

```
client.application.av(sophos).version == 10.0.2
```

After you configure the session policy, bind it to a user, group, or virtual server. When users log on, the SmartAccess policy check starts and verifies whether or not the user device has Version 10.0.2 or later of Sophos Antivirus installed.

When the SmartAccess endpoint analysis check is successful, the Web Interface portal appears in case of a clientless session; otherwise, the Access Interface appears.

When you create a session policy for SmartAccess, the session profile does not have any settings configured, which creates a null profile. In this case, Citrix Gateway uses the Web Interface URL configured globally for SmartAccess.

**Configuring Citrix Virtual Apps Policies and Filters**

September 10, 2019

After you create the session policy on Citrix Gateway, you configure policies and filters on the computer running Citrix Virtual Apps that are applied to users according to the endpoint analysis configuration.
To configure Citrix XenApp 6.5 policies and filters

2. In the left pane, expand Citrix ADC Resources > Citrix Virtual Apps > farmName, where farmName is the name of the server farm.
3. Click Applications.
4. In the center pane, right-click an application and then click Application properties.
5. In the navigation pane, under Properties, click Advanced > Access control.
6. In the right pane, click Any connection that meets any of the following filters and then click Add.
7. In Access Gateway farm, type the name of the Citrix Gateway virtual server.
8. In Access Gateway filter, type the name of the endpoint session policy and then click OK.
9. In the Application Properties dialog box, clear Allow all other connections and then click OK.

To configure a session policy for SmartAccess

April 23, 2019

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In the Create Session Policy dialog box, in Name, type a name for the policy, such as ValidEndpoint.
4. In Request Profile, click New and in Name, type a name for the profile, such as Null and then click Create.
5. In the Create Session Policy dialog box, create a client security expression, click Create and then click Close.

The client security expression is used to differentiate between valid and invalid endpoints. You can provide different levels of access to published applications or desktops based on the results of endpoint analysis.

After you create the session policy, bind it either globally or to a virtual server.

Configuring User Device Mapping on Citrix Virtual Apps

September 10, 2019
You can use Citrix Gateway filters that are applied to policies on a computer running Citrix Virtual Apps. Filters give users access to Citrix Virtual Apps capabilities, such as user device drive mapping, printer mapping, or clipboard mapping based on the results of the endpoint analysis.

Citrix Workspace app supports the mapping of devices on user devices so users can access external devices within user sessions. User device mapping provides:

- Access to local drives and ports
- Cut-and-paste data transfer between a user session and the local clipboard
- Audio (system sounds and .wav files) playback from the user session

During logon, the user device informs the server of the available user drives and COM ports. In Citrix XenApp 6.5, user drives are mapped to the server and use the user device drive letter. These mappings are available only for the current user during the current session. The mappings are deleted when the user logs off and recreated the next time the user logs on.

After enabling the XML Service, you need to configure policies for user device mapping.

To enforce user device mapping policies based on SmartAccess filters, you create the following two policies on the server:

- A restrictive ICA policy that disables user device mapping and applies to all Citrix Gateway users.
- A full ICA policy that enables user device mapping and applies only to users who fulfill the endpoint analysis session policy

Note: The filtered non-restrictive ICA policy must be given a higher priority than the restrictive ICA policy, so that when it applies to a user, the non-restrictive policy overrides the policy that disables user device mapping.

You configure restrictive and non-restrictive policies on Citrix XenApp 6.5 by using Citrix AppCenter.

**To configure a restrictive policy on Citrix XenApp 6.5**

September 10, 2019

1. Click Start > Administrative Tools > Management Consoles > Citrix AppCenter.
2. In the left pane, expand Citrix Virtual Apps, expand the server and then click Policies.
3. In the Policies pane, click the User tab and then click New.
4. In Name, type a name for the policy and then click Next.
5. Under Categories, click All Settings.
7. In the Add Setting dialog box, click Disabled, click OK and then click Next.
8. Under Categories, click All Filters.
10. In the New Filter dialog box, click Add.
11. In Mode, click Deny.
12. In Connection Type, select With Access Gateway.
13. In AG Farm, type the virtual server name.
14. In Access Condition, type or select the session policy name that is configured on Citrix Gateway, click OK two times, click Next and then click Create to complete the wizard.

To configure a non-restrictive policy on Citrix XenApp 6.5

September 10, 2019

1. Click Start > Administrative Tools > Management Consoles > Citrix AppCenter.
2. In the left pane, expand Citrix Virtual Apps, expand the server and then click Policies.
3. In the Policies pane, click the User tab and then click New.
4. In Name, type a name for the policy and then click Next.
5. Under Categories, click All Settings.
7. Click Enabled, click OK and then click Next.
8. Under Categories, click All Filters.
10. In the New Filter dialog box, click Add.
11. In Mode, click Allow.
12. In Connection Type, select With Access Gateway.
13. In AG Farm, type the virtual server name.
14. In Access Condition, type or select the session policy name that is configured on Citrix Gateway, click OK two times, click Next and then click Create to complete the wizard.

Enabling Citrix Virtual Apps as a Quarantine Access Method

April 23, 2019

If you have endpoint analysis configured on Citrix Gateway, users who pass an endpoint scan can access all the resources that you configure on Citrix Gateway. You can put users who fail an endpoint scan in a quarantine group. These users can access published applications from Citrix Virtual Apps only. Success or failure of the endpoint analysis scan determines the access method available to users.

For example, you create an endpoint analysis scan to check whether or not Notepad is running on the user device when users log on. If Notepad is running, users can log on using the Citrix Gateway
plug-in. If Notepad is not running, users receive only the list of published applications.

To configure restricted user access, create a quarantine group on Citrix Gateway. You create the quarantine group within a session profile and then add the profile to a session policy.

Creating a Session Policy and Endpoint Analysis Scan for a Quarantine Group

September 10, 2019

To enable Citrix Virtual Apps as a quarantine access method, create a group on Citrix Gateway that you use as the quarantine group. Then, create a session policy where you select the group.

After you create the session policy, bind the policy to the quarantine group. After you configure the policies and bind them to the group, test the results. For example, for users to successfully log on, Notepad must be running on the user device. If Notepad is running, users can log on by using the Citrix Gateway plug-in. If Notepad is not running, users can log on with Citrix Workspace app.

For more information about configuring endpoint analysis policies, see Configuring Endpoint Policies.

To create an endpoint analysis scan and add a quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In the Create Session Policy dialog box, in Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In the Create Session Profile dialog box, in Name, type a name for the profile.
8. In the Create Expression dialog box, next to Match Any Expression, click Add.
9. In Expression Type, select Client Security.
11. In Name, type notepad.exe, click OK and then click Create.
12. In the Security Settings - Advanced dialog box, in Quarantine Group, select the quarantine group, click Create, click OK and then click Create.
13. In the Create Session Policy dialog box, next to Named Expressions, select True value, click Add Expression, click Create and then click Close.
Configuring Citrix Virtual Desktops for SmartAccess

April 23, 2019

Citrix Gateway enables Citrix Virtual Desktops to deliver secure desktops to remote users. Citrix Virtual Desktops can use the SmartAccess capabilities of Citrix Gateway to intelligently deliver desktops. When you use the Delivery Services Console in Citrix Virtual Desktops to create desktop groups, you then configure policies and filters for access control.

To configure Citrix Gateway to deliver published desktops, you use the same options that are available with the Web Interface, ICA proxy access, clientless access, and Citrix Gateway access.

When you create a session policy and configure settings on the Published Applications tab, use the web address for the Citrix Virtual Desktops Web Interface site. After you create the policy, bind it to a virtual server. Then, create a null session profile in which you do not configure settings. The Web Interface configuration is inherited from global settings.

To configure a session policy for SmartAccess with Citrix Virtual Desktops

March 31, 2020

You configure SmartAccess on Citrix Gateway to access Citrix Virtual Desktops by creating a session policy bound to a virtual server.

To configure a session policy for SmartAccess with Citrix Virtual Desktops by using the GUI:

1. On the Configuration tab, navigate to Citrix Gateway > Policies > Session.
2. Click Session Policies tab and then click Add.
3. In the Create Citrix Gateway Session Policy page, enter a name for the policy, such as Citrix Virtual DesktopsPolicy.
4. In Profile, click Add.
5. In the Create Citrix Gateway Session Profile page, enter the name for the profile, such as Citrix Virtual DesktopsProfile.
6. In the Published Applications tab, next to ICA Proxy, click Override Global and then select ON.
7. In Web Interface Address, click Override Global and then type the URL to the Citrix Virtual Desktops Web Interface site.
8. In Single Sign-on Domain, click Override Global, type the domain name and then click Create.
9. In the Create Citrix Session Policy page, in Expression, add the expression.
You also need to create a null session policy which is bound to the virtual server. The session profile does not contain any configuration, making it a null profile. In the session policy, add the True Value expression and then save the policy.

After you create both session policies, bind both policies to the virtual server.

To configure policies and filters in Citrix Virtual Desktops 5

April 23, 2019

You can configure settings in Citrix Virtual Desktops 5 by using either the Desktop Studio or the Group Policy Editor. When you configure Citrix Gateway settings in Citrix Virtual Desktops, use the Citrix Gateway virtual server name and the session policy name. Then, configure access control to allow connections to meet defined filters. You can also use SmartAccess policies.

1. On the Citrix Virtual Desktops server, click Start > All Programs > Citrix > Desktop Studio.
2. In the left pane, click to expand HDX Policy and then click the User tab in the middle pane.
4. In the New Policy dialog box, under Identify your policy and then in Name, type a name.
5. Click Next twice.
6. In the New Policy dialog box, on the filters tab, under Filters, click Access Control and then click Add.
7. In the New Filter dialog box, click Add.
8. In the New Filter Element dialog box, in Connection Type, select With Access Gateway.

   To apply the policy to connections made through Citrix Gateway without considering Citrix Gateway policies, leave the default entries in AG farm name and Access condition.

9. If you want to apply the policy to connections made through Citrix Gateway based on existing Citrix Gateway policies, do the following:
   a) In AG farm name, type the virtual server name.
   b) In Access condition, type the name of the endpoint analysis policy or session policy.

   **Important:** Citrix Virtual Desktops does not validate the Citrix Gateway virtual server, endpoint analysis policy, or session policy names. Make sure the information is correct.
10. Click OK twice, click Next and then click Create.
To add the Desktop Delivery Controller as the STA

March 31, 2020

To establish ICA connections with Citrix Virtual Desktops, you add the IP address of the Desktop Delivery Controller to the virtual server as the Secure Ticket Authority (STA).

To add a Desktop Delivery Controller as the STA by using the GUI:

1. On the Configuration tab, navigate to **Citrix Gateway > Virtual Servers**.
2. In the details pane, select a virtual server and then click **Edit**.
3. On the **Published Applications** tab, under Secure Ticket Authority, click **Add**.
4. In the **Configure STA Server** dialog box, enter the URL of the STA server, and then click **Create**.
5. Repeat Step 4 to add additional STA servers and then click **OK**.

Configuring SmartControl

September 10, 2019

Smart Control allows administrators to define granular policies to configure and enforce user environment attributes for Citrix Virtual Apps and Desktops on Citrix Gateway. Smart Control allows administrators to manage these policies from a single location, rather than at each instance of these server types.

Smart Control is implemented through ICA policies on Citrix Gateway. Each ICA policy is an expression and access profile combination that can be applied to users, groups, virtual servers, and globally. ICA policies are evaluated after the user authenticates at session establishment.

The following table lists the user environment attributes that Smart Control can enforce:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectClientDrives</td>
<td>Specifies the default connection to the client drives when the user logs on.</td>
</tr>
<tr>
<td>ConnectClientLPTPorts</td>
<td>Specifies the automatic connection of LPT ports from the client when the user logs on. LPT ports are the Local Printer Ports.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ClientAudioRedirection</td>
<td>Specifies the applications hosted on the server to transmit audio through a sound device installed on the client computer.</td>
</tr>
<tr>
<td>ClientClipboardRedirection</td>
<td>Specifies and configures clipboard access on the client device and maps the clipboard on the server.</td>
</tr>
<tr>
<td>ClientCOMPortRedirection</td>
<td>Specifies the COM port redirection to and from the client. COM ports are the COMmunication ports. These are serial ports.</td>
</tr>
<tr>
<td>ClientDriveRedirection</td>
<td>Specifies the drive redirection to and from the client.</td>
</tr>
<tr>
<td>Multistream</td>
<td>Specifies the multistream feature for specified users.</td>
</tr>
<tr>
<td>ClientUSBDeviceRedirection</td>
<td>Specifies the redirection of USB devices to and from the client (workstation hosts only).</td>
</tr>
<tr>
<td>Localremotedata</td>
<td>Specifies the HTML5 file upload download capability for the Citrix Workspace app.</td>
</tr>
<tr>
<td>ClientPrinterRedirection</td>
<td>Specifies the client printers to be mapped to a server when a user logs on to a session.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Policies</th>
<th>Action</th>
<th>Access Profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Edit</td>
<td>Delete</td>
</tr>
<tr>
<td>Show Bindings</td>
<td>Policy Manager</td>
<td>Action</td>
</tr>
</tbody>
</table>
Policies

An ICA policy specifies an Action, Access Profile, Expression and optionally, a Log Action. The following commands are available from the Policies tab:

- Add
- Edit
- Delete
- Show Bindings
- Policy Manager
- Action

Add

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. In the details pane, on the Policies tab, click **Add**.

3. The following screen appears. In the **Name** dialog box, type a name for the policy. This is a required field. All required fields are indicated by an asterisk.

4. Next to **Action** do one of the following:
   - Click the > icon to select an existing action. For details see [Select an action] under (#common-processes).
   - Click the + icon to create a new action. For details see [Create a new action] under (#common-processes).
   - The pencil icon is disabled.

5. Create an expression.

6. Create a **Log Action**. For more details see Create a Log Action.

7. Enter a message into the Comments box. The comment writes to the message log. This field is optional.

8. Click **Create**.

**Edit**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.

2. Select the ICA policy from the list.

3. In the details pane, on the Policies tab, click **Edit**.
4. Verify the policy name.

5. To revise the **Action** do one of the following:
   - Click the > icon to revise an existing **Action**. For detail see [Select an action] under (#common-processes).
   - Click the + to icon create a new **Action**. For detail see [Create a new action] under (#common-processes).
   - Click the pencil icon to revise the [Access Profile].

6. Revise the **Expression** as desired. For details see [Expressions] under (#common-processes).

7. To revise the **Log Action** do one of the following:
   - Click the + to create a new **Log Action**.
   - Click the pencil icon to configure an Audit Message.

8. Revise the comments as desired.

9. Click **OK**.

**Delete**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.

2. Select the desired ICA policy from the list.

3. In the details pane, on the Policies tab, click **Delete**.

4. Confirm that you want to delete the policy by clicking **Yes**.
**Show Binding**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. Select the ICA policy from the list.
3. In the details pane, on the Policies tab, click **Show Bindings**.

**Policy Manager**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. Select the desired ICA policy from the list.
3. In the details pane, on the Policies tab, click **Policy Manager**
4. From the Bind Point dialog box, select a policy from the drop down menu. These are the following choices:
   - Override Global
   - VPN Virtual Server
   - Cache Redirection Virtual Server
   - Default Global
5. From the Connection Type dialog box, select a binding policy from the drop down menu.
6. If you select either the VPN Virtual Server or the Cache Redirection Virtual Server, you connect to the server using the drop down box.
7. Click **Continue**.
Add Binding

1. After selecting Continue, this screen appears.
2. Select a Policy to attach the Binding.
3. Select Add Binding.

Policy Binding

1. After selecting Done, this screen appears.
   - Click the > icon to select an existing policy. For detail see Select an existing policy.
   - Click the + icon to create a new policy. For detail see Create a new policy.
Unbind Policy

1. Select the policy you want to unbind, and click the **Unbind** button.

2. Click **Done**

3. Click the **Yes** button on the pop-up screen to confirm that you desire to unbind the selected entity.

Bind NOPOLICY

1. Select policy that requires NOPOLICY, and click the **Bind NOPOLICY** button.
2. Click **Done**

**Edit**

You can edit from the ICA Policy Manager.

1. Select the policy you want to edit, and select **Edit**.

```
ICA Policy Manager
```

2. You have the option to make the following edits: [Edit Binding], [Edit Policy], [Edit Action].

```
ICA Policy Manager
```

For more information see [Edit Binding], [Edit Policy], [Edit Action].
Edit Binding

1. With the policy selected, click **Edit Binding**.

2. Verify that you are editing the desired policy. This Policy Name is not editable.

3. Set the Priority as desired.

4. Set Goto Expression as desired.

5. Click the **Bind** button.

Edit Policy

1. With the policy selected, click **Edit Policy**.

2. Verify the policy Name to ensure you are editing the desired policy. This field is not editable.
3. To revise the Action policy, do one of the following:
   - Click the < icon to select an existing Action. For details see [Select an action] under (#common-processes).
   - Click the + icon to create an action. For details see [Create a new action] under (#common-processes).
   - Click the pencil icon to revise the Access Profile. For details see [Select an existing Access Profile] under (#common-processes).

4. Revise the Expression as desired. For more details see [Expressions] under (#common-processes).

5. Select the desired type of message from the drop down menu. To create a Log Action, do one of the following:
   - Click the + icon to create an action. For details see Create a Log Action.
   - Click the pencil icon to revise the Configure Audit Message Action. For details see Configure Audit Message Action.

6. Enter Comments about the ICA Policy.

7. Click OK when the edit is complete.
Edit Action

1. With the policy selected, click **Edit Action**.
2. Verify the Action Name to confirm you are editing the desired Action. This field is not editable.
3. Next to Access Profile do one of the following:
   - Click the > icon to select a different Access Profile. For detail see Configure Action.
   - Click the + icon to select a new Channel Profile. Create a Access Profile.
   - Click the pencil icon to revise the Access Profile. For details see [Select an existing Access Profile] under (#common-processes).
4. Click **OK**.

Action

The Policies>Action commands are used to rename the action.

1. Select the desired ICA Action from the list.
2. On the ICA Policies tab, click Action. Select Rename from the drop-down menu.
3. Rename the action.
4. Click **OK**

**Action**

An Action connects a policy with an Access Profile. The following commands are available from the Policies tab:

- Add
- Edit
- Delete
- Action

**Add**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. In the details pane, on the Action tab, click **Add**.
Citrix Gateway 13.0

- Click the > icon to select an existing Access Profile. For detail see [Select an existing Access Profile] under (#common-processes).
- Click the + icon to create a new Access Profile. For detail see Create a Access Profile.
- The pencil icon is disabled for this screen.

3. Click **Create**.

![Create Action](image)

**Edit**

1. Select the desired ICA policy from the list.

![Policies and Action](image)

2. In the details pane, on the Action tab, click **Edit**.

**Configure Action**

1. Verify the Action Name to confirm you are editing the desired Action. This field is not editable.
2. Next to Access Profile do one of the following:
Citrix Gateway 13.0

- Click the > to select an existing Access Profile. For detail see [Select an existing Access Profile] under (#common-processes).
- Click the + to create a new Access Profile. For detail see Create a Access Profile.
- Click the pencil icon to Configure Access Profile.

3. Click OK.

Delete

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Action and then click ICA.
2. Select the desired ICA Action from the list.
3. In the details pane, on the Action tab, click Delete.
4. Confirm the Action you want to delete the policy by clicking Yes.
**Action**

The ICA Action>Action commands are used to rename the action.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Action and then click ICA.
2. Select the desired ICA Action from the list.
3. In the details pane, on the Action tab, click **Action**.
4. Select Action>Rename from the drop-down menu.
5. Rename the action.
6. Click **OK**

**Access Profiles**

An ICA profile defines the settings for user connections.

Access profiles specify the actions that are applied to a user’s Citrix Virtual Apps and Desktops environment ICA if the user device meets the policy expression conditions. You can use the configuration utility to create ICA profiles separately from an ICA policy and then use the profile for multiple policies. You can only use one profile with a policy.

You can create Access Profiles independently of an ICA policy. When you create the policy, you can select the Access profile to attach to the policy. An Access Profile specifies the resources available to a user. The following commands are available from the Policies tab:
Creating an Access Profile with the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. In the details pane, click the Access Profiles tab and then click Add.
3. Configure the settings for the profile, click Create and then click Close. After you create a profile, you can include it in an ICA policy.

Add an Access Profile to a policy using the configuration utility

1. In the configuration utility, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. On the Policies tab, do one of the following:
   • Click Add to create a new ICA policy.
   • Select a policy and then click Open.
3. In Action menu, select an Access Profile from the list.
4. Finish configuring the ICA policy and then do one of the following:
   a. Click Create and then click Close to create the policy.
   b. Click OK and then click Close to modify the policy.

Add

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click ICA.
2. In the details pane, on the Access Profiles tab, click **Add.**
3. In Name, type a name for the Access Profile. This is a required field.

4. Select Default or Disable from the pull down menus shown to create the Access Profile.

5. Click **Create**.

**Edit**

1. Select the Access Profile you want to edit.

2. In the details pane, on the Access Profiles tab, click **Edit**.
Configure Access Profile

1. Verify that the Name is the one you want to revise.

2. Select Default or Disable from the pull down menu to configure as required.

3. Click OK.

Delete

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Action and then click ICA.

2. Select the desired ICA Action from the list.

3. In the details pane, on the Action tab, click Delete.
4. Confirm the Access Profile you want to delete by clicking Yes.

Common Processes

Create a new action

1. Type a Name for the Action.

2. Select one of the following to supply the Access Profile:
   - Click the > to select an existing Access Profile. See for details [Select an existing Access Profile] under (#common-processes).
   - Click the + to create a new Access Profile. See for details Create an Access Profile.
   - The pencil icon is disabled.

3. Click Create.
Select an action

1. Select an Action by clicking the radio button to the left of it. The associated Access Profile specifies the allowed user functions.

2. Click the Select button.

Create an Access Profile

1. Name the Access Profile.

2. You have the option to configure the Access Profile from this menu.
Select an existing Access Profile

1. Select an Access Profile by clicking on it.

2. Click Edit.

3. Configure the Access Profile. For details see Configure Access Profile.

Expressions

1. To create or revise an existing Expression, select Clear.

These are the typical ICA Expressions. For the HTTP expressions enter the name with the "" and remove the ()

<table>
<thead>
<tr>
<th>ICA.SERVER.PORT</th>
<th>This expression checks that the port specified matches the port number on the Citrix Virtual Apps and Desktops that the user is attempting to connect.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICA.SERVER.IP</td>
<td>This expression checks that the IP specified matches the IP address on the Citrix Virtual Apps and Desktops that the user is attempting to connect.</td>
</tr>
</tbody>
</table>
HTTP.REQ.USER.IS_MEMBER_OF(“”).NOT
This expression checks that the current connection is access by a user that is NOT a member of the specified group name.

HTTP.REQ.USER.IS_MEMBER_OF(“groupname”) This expression checks that the user accessing the current connection is a member of the specified group.

HTTP.REQ.USERNAME.CONTAINS(“”).NOT
This expression checks that the user accessing the current connection is NOT a member of the specified group.

HTTP.REQ.USERNAME.CONTAINS(“enter username”) Specifies the resources for a username.

CLIENT.IP.DST.EQ(enter ip address here).NOT This expression checks that the destination IP of the current traffic is NOT equal to the specified IP address.

CLIENT.IP.DST.EQ(enter ip address here) This expression checks that the destination IP of the current traffic is equal to the specified IP address.

CLIENT.TCP.DSTPORT.EQ (enter port number).NOT
This expression checks that the destination port is NOT equal to the specified port number.

CLIENT.TCP.DSTPORT.EQ (enter port number) This expression checks that the destination port is equal to the specified port number.

2. Simultaneously, select Control and the Space bar; then your options are visible.

3. Type the period. Make your selection, and press the Space bar.
4. At each period of the expression in the table above, type the period. Make your selection, and press the Space bar.
5. Click OK.
Group Identification

Expression with a groupname variable are defined by the Preauthentic or Session functions.

Preauthentication

1. Select Preauthentication from the configuration pane.
1. Select a name from the Preauthentication Policies.
2. Select **Edit** from the Preauthentication Policies tab.

![Preauthentication Policies tab]

3. Select the **pencil** icon or + next to the Request Action dialogue box.

![Configure Preauthentication Policy]

4. Define the (“<groupname>”) in the Default EPA Group dialogue box.
Session

1. Select Session from the configuration pane.
Create a Log Action

1. In the Configure Policy screen, next to the Log Action dialog box select the + icon.

Create Audit Message Action

2. The Create Audit Message Action screen appears. Name the Audit Message. The Audit message only accepts numbers, letters or an underscore character.

3. From the pull-down menu specify the Audit Log Level.

<table>
<thead>
<tr>
<th>Log Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency</td>
<td>Events that indicate an immediate crisis on the server.</td>
</tr>
<tr>
<td>Alert</td>
<td>Events that might require action.</td>
</tr>
<tr>
<td>Critical</td>
<td>Events that indicate an imminent server crisis.</td>
</tr>
<tr>
<td>Error</td>
<td>Events that indicate some type of error.</td>
</tr>
<tr>
<td>Warning</td>
<td>Events that require action in the near future.</td>
</tr>
<tr>
<td>Notice</td>
<td>Events that the administrator should know about.</td>
</tr>
<tr>
<td>Informational</td>
<td>All but low-level events.</td>
</tr>
<tr>
<td>Debug</td>
<td>All events, in extreme detail.</td>
</tr>
</tbody>
</table>
4. Enter an Expression. The Expression defines the format and content of the log.

5. The check boxes.
   - Check the Log in newnslog to send the message to a new ns log.
   - Check Bypass Safety Check to bypass the safety check. This allows unsafe expressions.

6. Click **Create**.

![Create Audit Message Action](image)

**Revise a Log Action**

1. In the Configure Policy screen, next to the Log Action dialog box click the icon.

![Configure Policy](image)
Configure Audit Message Action

The following are editable fields:

1. From the pull-down menu specify the Audit Log Level.
2. Enter an Expression. The Expression defines the format and content of the log.
3. The check boxes:
   - Check the Log in newnslog to send the message to a new ns log.
   - Check Bypass Safety Check to bypass the safety check. This allows unsafe expressions.
4. Click OK.

Select an existing policy

1. Click the > icon to select an existing policy.
2. Select the radio button of the desired policy.
Create a new policy

1. In Name, type a name for the policy. This is a required field.
2. Click the + to create a new policy.
3. Create an Action. For details see Create a new action.
4. Name the Access Profile.
5. Configure the Access Profile from this menu.

6. Click **Create**.

7. Click **Bind**.

**Configuring pre-authentication and post-authentication end point analysis**

This section describes how to configure post-authentication and pre-authentication end point analysis (EPA).

To configure post-authentication EPA with Smartcontrol use the Smartgroup parameter from the VPN session action. The EPA expression is configured on the VPN session policy.

You can specify a groupname for the smartgroup parameter. This groupname can be any string. The groupname does not need to be an existing group on the active directory.
Configure the ICA policy with the expression, HTTP.REQ.IS_MEMBER_OF ("groupname"). Use the groupname that was previously specified for the Smartgroup.

To configure pre-authentication EPA with Smartcontrol use the Default EPA group parameter from the pre-authentication profile. The EPA expression is configured on the pre-authentication policy.

You can specify a groupname for the Default EPA group parameter. This groupname can be any string. The groupname does not need to be an existing group on the active directory.

You can specify a groupname for the Default EPA group parameter. This groupname can be any string. The groupname does not need to be an existing group on the active directory.

Configure the ICA policy with the expression, HTTP.REQ.IS_MEMBER_OF ("groupname"), use the groupname that was previously specified for the Default EPA Group.

**Post-authentication configuration**

**Use the following procedure to set up smart groups for Post-authentication configuration.**

1. Go to Citrix NetScaler>Policies> Session.
2. Go to Session Profiles> Add.

Create Citrix Gateway Session Profile

1. Select the Security tab.
2. Enter a Name for your Citrix Gateway Profile (action).
3. Select the box to the right of the pull down menu and select the desired Default Authorization Action.

Specify the network resources that users have access to when they log on to the internal network. The default setting for authorization is to deny access to all network resources. Citrix recommends using the default global setting and then creating authorization policies to define the network resources users can access. If you set the default authorization policy to DENY, you must explicitly authorize access to any network resource, which improves security.

4. Select the box to the right of the pull down menu and select the desired Secure Browse.

Allow users to connect through Citrix Gateway to network resources from iOS and Android mobile devices with Citrix Workspace app. Users do not need to establish a full VPN tunnel to access resources in the secure network.

5. Select the box to the right of the pull down menu and enter the Smartgroup name.

This is the group in which the user is placed when the sessionpolicy associated with this session action succeeds. The vpn session policy will do the post auth EPA check and if the check succeeds the user is placed in the group specified with Smartgroup. The is_member_of (http.req.user.is_member_of) expression can then be used with policies to check if EPA has passed on the user belonging to this smartgroup.

6. Click Create.


8. Go to Session Policies> Add.

9. Enter the Name in this field.

This the Name for the new session policy that is applied after the user logs on to Citrix Gateway.

10. Select the Profile action using the drop down menu.

This the Action applied by the new session policy if the rule criterion is met.

11. Enter Expression in this field.

This field defines the named expression that specifies the traffic that matches the policy. The expression can be written in either default or classic syntax. The maximum length of a literal string for the expression is 255 characters. A longer string can be split into smaller strings of up to 255 characters each, and the smaller strings concatenated with the + operator. For example, you can create a 500-character string as follows: "**\"** + "**\"**"
The following requirements apply only to the Citrix ADC CLI:

* If the expression includes one or more spaces, enclose the entire expression in double quotation marks.* If the expression itself includes double quotation marks, escape the quotations by using the character.* Alternatively, you can use single quotation marks to enclose the rule, in which case you do not have to escape the double quotation marks.

12. Click **Create**.
13. Go to **Session Policies**.
14. Select the **Name** of the Session Policy.
15. Select **Global Bindings** from the Action drop down menu.
16. Select **Add Binding**.
17. Select the > to choose an existing policy.
   
   **Note**: Select the + to create a new policy. For more details see [Create Citrix Gateway Session Profile](#).
18. Choose a name from the list and press the **Select** button.
19. Enter the **Priority** and click **Bind**.
20. Click **Done**
21. The check shows that your selection is Globally Bound.

![Session Policies Table](image)

**Pre-authentication configuration**

Use the following procedure to set up Pre-authentication configuration.

1. Go to Citrix NetScaler>Polices> **Preauthentication**.
2. Select the Preauthentication Profiles tab and select Add.
3. **Enter the Name**

   This is the Name for the preauthentication action. The name must begin with a letter, number, or the underscore character (_), and must consist only of letters, numbers, and the hyphen (-), period (.) pound (#), space ( ), at (@), equals (=), colon (:), and underscore characters. Cannot be changed after preauthentication action is created.

   **Note:** The following requirement applies only to the Citrix ADC CLI:
   If the name includes one or more spaces, enclose the name in double or single quotation marks.

4. **Select a Request Action** from the drop down menu. This is the action that the policy is to invoke when a connection matches the policy.

   **Note:** If you want to or create a Preauthentication Profile, select the +. For more information see Create Preauthentication Profile

5. **Enter an Expression**

   This is the name of the Citrix ADC named rule, or default syntax expression that defines the connections that match the policy.

6. **Click Create.**

7. **Go to the Preauthentication Policies tab and select the desired policy.**

8. **Select Global Binding** from the Action Drop down menu.

9. **Select Add Bindings.**

10. **Select the > to select an existing policy.**

   Select the + to create a new policy. For more details see, Create Citrix Gateway Session Profile.

11. **Select Policy.**

12. **Enter the Priority and click Bind.**

13. **Click Done.**

14. **The check shows that the Preauthentication Policy is Globally Bound.**
Create Preauthentication Profile

1. Enter the Name.
   This is the Name for the preauthentication action. The name must begin with a letter, number, or the underscore character (_), and must consist only of letters, numbers, and the hyphen (-), period (.), pound (#), space ( ), at (@), equals (=), colon (:), and underscore characters. Cannot be changed after preauthentication action is created.
   The following requirement applies only to the Citrix ADC CLI:
   If the name includes one or more spaces, enclose the name in double or single quotation marks.

2. Enter the Action from the drop down menu.
   This option will Allow or Deny logon after endpoint analysis (EPA) results.

3. Processes to be Cancelled
   This option identifies a string of processes to be terminated by the endpoint analysis (EPA) tool.

4. Files to be deleted
   This option identifies a string specifying the path(s) and name(s) of the files to be deleted by the endpoint analysis (EPA) tool.

5. Default EPA Group
   This is the default group that is chosen when the EPA check succeeds.

6. Click Create.

Configuring Single Sign-On to the Web Interface

April 23, 2019

You can configure Citrix Gateway to provide single sign-on to servers in the internal network that use web-based authentication. With single sign-on, you can redirect the user to a custom home page, such as a SharePoint site or to the Web Interface. You can also configure single sign-on to resources through the Citrix Gateway plug-in from a bookmark configured in the Access Interface or a web address that users type in the web browser.

If you are redirecting the Access Interface to a SharePoint site or the Web Interface, provide the web address for the site. When users are authenticated, either by Citrix Gateway or an external authentication server, users are redirected to the specified home page and logged on automatically. User credentials are passed transparently to the web server. If the web server accepts the credentials, users
are logged on automatically. If the web server rejects the credentials, users receive an authentication prompt asking for their user name and password.

You can configure single sign-on to web applications globally or by using a session policy.

You can also configure single sign-on to the Web Interface by using a smart card. For details, see Configuring Single Sign-On to the Web Interface by Using a Smart Card.

Citrix Gateway works with the following versions of the Web Interface:

- Web Interface 4.5
- Web Interface 5.0
- Web Interface 5.1
- Web Interface 5.2
- Web Interface 5.3
- Web Interface 5.4

Before you configure single sign-on, make sure the Web Interface is already configured and working with Citrix Gateway.

To configure single sign-on to Web applications globally

April 23, 2019

Applying single sign-on globally will allow a Web service to authenticate all Web application sessions rather than authenticating those sessions on the Citrix Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. In the Global Citrix Gateway Settings dialog box, on the Client Experience tab, click Single Sign-on to Web Applications and then click OK.

To configure single sign-on to Web applications by using a session policy

April 23, 2019

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Profiles tab, select a policy and then click Add.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. In the **Configure Session Profile** dialog box, on the **Client Experience** tab, next to Single Sign-On to Web Applications, click **Global Override**, click **Single Sign-On to Web Applications** and then click **OK**.

**To define the HTTP port for single sign-on to web applications**

April 23, 2019

Single sign-on is attempted only for network traffic where the destination port is considered to be an HTTP port. To allow single sign-on to applications that use a port other than port 80 for HTTP traffic, add one or more port numbers on Citrix Gateway. You can enable multiple ports. You configure the ports globally.

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway** and then click **Global Settings**.
2. In the details pane, under **Settings**, click **Change global** settings.
3. On the **Network Configuration** tab, click **Advanced Settings**.
4. In **HTTP Ports**, type the port number, click **Add** and then click **OK**.

**Note:** If web applications in the internal network use different port numbers, type the port number and then click **Add**. You must define the HTTP port number to allow single sign-on to web applications, including the Web Interface.

**Additional Configuration Guidelines**

April 23, 2019

When you configure the Web Interface for single sign-on, use the following guidelines:

- The **Authentication Service URL** must begin with https.
- The server running the Web Interface must trust the Citrix Gateway certificate and be able to resolve the certificate fully qualified domain name (FQDN) to the virtual server IP address.
- The Web Interface must be able to open a connection to the Citrix Gateway virtual server. Any Citrix Gateway virtual server can be used for this purpose; it does not have to be the virtual server to which users log on.
- If there is a firewall between the Web Interface and Citrix Gateway, firewall rules could prevent user access, which disables single sign-on to the Web Interface. To work around this issue, either relax your firewall rules or create another virtual server on Citrix Gateway to which the Web
Interface can connect. The virtual server must have an IP address that is in the internal network. When connecting to the Web Interface, use the secure port 443 as the destination port.

- If you are using a certificate from a private Certificate Authority (CA) for the virtual server, in the Microsoft Management Console (MMC), use the certificates snap-in to install the CA root certificate in the local computer certificate store on the server running the Web Interface.
- When users log on and receive an access denied error message, check the Web Interface event viewer for more information.
- For successful user connections to published applications or desktops, the Secure Ticket Authority (STA) that you configured on Citrix Gateway must match the STA that you configured on the Web Interface.

To test the single sign-on connection to the Web Interface

September 10, 2019

After you configure single sign-on for the Web Interface, from a client device, open a web browser, and test for a successful connection.

1. In a web browser, type https://NetScalerGatewayFQDN, where NetScalerGatewayFQDN is the fully qualified domain name (FQDN) in the certificate bound to the virtual server.
2. Log on to a domain user account in Active Directory. At logon, you are redirected to the Web Interface.

Applications appear automatically with no additional authentication. When users start a published application, Citrix Workspace app directs traffic through the Citrix Gateway appliance to servers in the farm.

Configuring Single Sign-On to the Web Interface by Using a Smart Card

April 23, 2019

If you use smart cards for user logon, you can configure single sign-on to the Web Interface. You configure settings on Citrix Gateway, and then you configure the Web Interface to accept single sign-on with a smartcard. Single sign-on is also called pass-through authentication.

Web Interface Versions 5.3 and 5.4 support single sign-on to the Web Interface using a smart card. If you enable the Web Interface on Citrix ADC feature available in NetScaler version 10, you can also use single sign-on with a smartcard. For more information about configuring this feature, see Using Smart Card Authentication for Web Interface through Citrix Gateway.
Users can be in multiple CN groups in Active Directory for single sign-on to work, as long as the user name extraction in the certificate action is SubjectAltName:PrincipalName. If you use the parameter Subject:CN, users cannot be part of multiple CN groups.

To configure Citrix Gateway for single sign-on to the Web Interface by using a smart card, you need to do the following:

- Install a signed server certificate from a Certificate Authority (CA). For more information, see Installing the Signed Certificate on Citrix Gateway.
- Install a root certificate on Citrix Gateway and the user device.
- Create a virtual server as the logon point for the Web Interface. When you configure the virtual server, you must set the client certificate SSL parameter to Optional. For more information about configuring a virtual server, see Creating Virtual Servers.
- Create a secondary virtual server in which client authentication is disabled in the SSL parameters. This configuration prevents users receiving a secondary request for their personal identification number (PIN).
- Create a client certificate authentication policy. In the User Name Field, use the parameter SubjectAltName:PrincipalName to extract users from multiple groups. Leave the Group Name Field blank.
- Create a session policy and profile on Citrix Gateway. Within the session profile, you enable ICA proxy and specify the Web Interface and domain that you use for single sign-on.

You can use the following procedure to create a session profile for single sign-on with a smart card.

**To create a session profile for single sign-on by using a smart card**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Policies and then click Session.

2. In the details pane, click the Profiles tab and then click Add.

3. On the Client Experience tab, next to Home Page, click Override Global and then clear Display Home Page.

4. Next to Single sign-on to Web Applications, click Override Global and then click Single sign-on to Web Applications.

5. Click the Published Applications tab.

6. Next to ICA Proxy, click Override Global and then select ON.

7. In Web Interface Address, click Override Global and then type the fully qualified domain name (FQDN) or the Web Interface.

8. In Single Sign-on Domain, click Override Global and then type the domain name.
Note: You must use the format domain and not the format domain.com.

6. Click Create and then click Close.
After you have completed the session profile, configure the session policy and use the profile as part of the policy. You can then bind the session policy to the virtual server.

To configure the client certificate for single sign-on by using a smart card

April 23, 2019

If you configure single sign-on to the Web Interface using a smart card, you must select Client Authentication on the Certificates in the virtual server dialog box and then configure the client certificate as Optional. If you select Mandatory, single sign-on to the Web Interface fails.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Virtual Servers.
2. In the details pane, click a virtual server and then click Open.
3. In the configure Citrix Gateway Virtual Server dialog box, on the Certificates tab, click SSL Parameter.
4. In the Configure SSL Params dialog box, under Others, click Client Authentication.
5. In Client Certificate, select Optional and then click OK twice.

To configure single sign-on for Citrix Virtual Apps and file shares

April 23, 2019

If users are connecting to servers running Citrix Virtual Apps and using SmartAccess, you can configure single sign-on for users connecting to the server farm. When you configure access to published applications by using a session policy and profile, use the domain name for the server farm.

You can also configure single sign-on to file shares in your network.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. In the **Configure Session Profile** dialog box, on the **Published Applications** tab, in Single-sign-on Domain, click **Override Global**, type the domain name and then click **OK** twice.

### Allowing File Type Association

September 10, 2019

File type association allows users to open documents in applications published through Citrix Virtual Apps or Desktops 7. You can use this permission to allow users to open and edit documents on servers in the trusted environment and avoid sending the document to the user device. You can use file type association only for document types that are associated with a published application and only if you correctly configure the virtual server properties on Citrix Gateway.

Providing file type association as the only means for editing resource documents can help to heighten security because it requires that editing occur on the server and not on the user device. For example, you might choose to grant file type association for a file share in which employees post reports of ongoing project meetings, without providing the ability to download or upload.

Providing file type association requires that:

- Users run Citrix Workspace app on the user device.
- Users connect through a virtual server that has a traffic policy bound to it and that you configure the policy for Citrix Virtual Apps.
- Users are assigned to the desired applications in Citrix Virtual Apps and Desktops 7.
- Administrators configure Citrix Virtual Apps to work with Citrix Gateway.

The steps for creating file type association include:

- Creating a Web Interface site.
- Configuring file type association using a traffic policy on Citrix Gateway.
- Defining file extensions in Citrix Virtual Apps and Desktops 7.

### Creating a Web Interface Site

April 23, 2019

To configure the Web Interface to work with file type association, you first create the Web Interface site. The Web Interface site can be in Direct or Advanced Access Control. Copy the following directories to your Web Interface site:

- app_data
When you copy these directories to the Web Interface site, the existing directories are overwritten.

If you are using Web Interface 4.6 or 5.0, open the web.config file in the Web Interface site directory and add the following code. You can download this code from the Citrix Support site at [http://support.citrix.com/article/ctx116253](http://support.citrix.com/article/ctx116253).

```xml
<httpHandlers>
    <add verb="*" path="*.ica" type="System.Web.UI.PageHandlerFactory"/>
</httpHandlers>
</system.web>
</location>

<httpHandlers>
    <add verb="*" path="*.rad" type="System.Web.UI.PageHandlerFactory"/>
</httpHandlers>
</system.web>
</location>
```

This code must be added after the following section in the web.config file:

```xml
<httpHandlers>
    <add verb="*" path="*.rad" type="System.Web.UI.PageHandlerFactory"/>
</httpHandlers>
</system.web>
</location>
```

Configuring Citrix Gateway for File Type Association

April 23, 2019

Before you configure file type association on Citrix Gateway, configure a Web Interface site to work with file type association. After you create and configure the Web Interface, you need to create settings
on Citrix Gateway. The steps include:

- Creating a new virtual server or using an existing one. For more information about creating a virtual server, see Creating Virtual Servers.
- Creating a new session policy and profile that has the Web Interface configured.
- Binding the session policy to the virtual server.
- Creating a traffic policy.

After you create the session policy and bind it to the virtual server, create the traffic policy and also bind it to the virtual server.

When you configure a traffic policy for file type association, you create an expression to define the file extensions. For example, you want to enable file type association for Microsoft Word and Microsoft Excel. An example expression is:

```
REQ.HTTP.URL == /*.doc || REQ.HTTP.URL == /*.xls
```

To create a session policy and profile for file type association

1. In the configuration utility, click the Configuration tab and then in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Published Applications tab, configure the following settings:
   a) Next to Web Interface Address, click Override Global and then type the Web address of the Web Interface.
   b) Next to Web Interface Portal Mode, click Override Global and then select either Normal or Compact.
   c) Next to Single Sign-on Domain, click Override Global, type the name of the domain in which the user accounts reside and then click Create.
7. In the Create Session Policy dialog box, next to Named Expression, select True value, click Add Expression, click Create and then click Close.

To create a traffic profile for file type association

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Policies and then click Traffic.
2. In the details pane, click the Profiles tab and then click Add.
3. In Name, type a name for the profile.
4. In File Type Association, select ON, click Create and then click Close.
To configure file type association in a traffic policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Policies and then click Traffic.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. In Request Profile, select a profile.
5. In the Create Traffic Policy dialog box, under Expressions, select Advanced Free-Form and then click Add.
6. In the Add Expression dialog box, do the following:
   a) In Expression Type, click General.
   b) In Flow Type, select REQ.
   c) In Protocol, select HTTP.
   d) In Qualifier, select URL.
   e) In Operator, select = =.
   f) In Value, type /*.FileExtensionType, where .FileExtensionType is the file type, such as .doc or .xls and then click OK.
7. In the Create Traffic Policy dialog box, under Expressions, next to Advanced Free-Form, click OR.
8. Repeat Steps 4, 5 and 6 for each file extension you want to include, click Create and then click Close.

Integrate Citrix Gateway with Citrix Virtual Apps and Desktops

September 10, 2019

StoreFront servers are deployed and configured to manage access to published resources and data. For remote access, adding Citrix Gateway in front of StoreFront is recommended.

Note

For detailed configuration steps on how to integrate Citrix Virtual Apps and Desktops with Citrix Gateway, see the StoreFront documentation.

The following diagram illustrates an example of a Citrix simplified Citrix deployment that includes Citrix Gateway. Citrix Gateway communicates with StoreFront to protect apps and data delivered by Citrix Virtual Apps and Desktops. The user devices run Citrix Workspace app to create a secure connection and access their apps, desktops, and files.
Users log on and authenticate using Citrix Gateway. Citrix Gateway is deployed and secured in the DMZ. Two-factor authentication is configured. Based on the user credentials, users are provided with the relevant resources and applications. Applications and data are on appropriate servers (not shown on the diagram). Separate servers used for security sensitive applications and data.

**Integrate Citrix Gateway with StoreFront**

April 23, 2019

**Citrix Virtual Apps and Desktops** wizard is used to integrate StoreFront with Citrix Gateway. The integration facilitates access to hosted virtual desktops (XenDesktop) and hosted Windows virtual apps (XenApp) through Citrix Gateway.

For seamless Citrix Gateway integration with Storefront, the Citrix Virtual Apps and Desktops wizard workflow is now enhanced with the following capabilities.

- **Retrieval of the Stores configured on supported StoreFront:** The Stores configured on supported StoreFront can be retrieved with a click. This helps avoid manual intervention therefore avoiding human errors (typos).
- **Export support for StoreFront configuration file:** The Storefront configuration files can be exported at Citrix Gateway. This file can then be downloaded and eventually imported on a supported StoreFront server. Once the file is imported, StoreFront completes the NetScaler integration.
- **StoreFront as an authentication server:** Authentication is simplified by introducing an advanced authentication action to use StoreFront as an Authentication Server for authentication services.
Note
The Authentication Server can be used for non–Citrix Virtual Apps and Desktops deployments as well.

How to configure Citrix Gateway to use with StoreFront

Prerequisites

You must have the following information to integrate NetScaler with StoreFront:

- IP address of the Citrix Gateway virtual server
- Fully Qualified Domain Name (FQDN) of StoreFront server
- A server certificate for the Citrix Gateway
- Authentication server details

Also ensure the following:

- Firewall port between Citrix Gateway and StoreFront is open
- StoreFront has LAN access

To Integrate StoreFront with Citrix Gateway using Citrix Gateway GUI:

1. Navigate to Configuration > Citrix Virtual Apps and Desktops.
2. Click on Get Started.
3. Select StoreFront and Click Continue.
4. Enter the values for the following fields in the Citrix Gateway area and click Continue.
   - Gateway FQDN – FQDN of Citrix Gateway
   - Gateway IP Address – IP address of Citrix Gateway
   - Port – Port of Citrix Gateway
5. Import the following files in the Server Certificate area and click Continue. Certificate File - Server certificate for the Citrix Gateway.
6. Provide the following information in the StoreFront area and click Continue.
   - StoreFront URL – URL of StoreFront server
   - Receiver for Web Path - Path to Receiver for Web site already configured on the StoreFront
   - Default Active Directory Domain - Single sign-on domain to be used for single sign-on applications in the internal network
   - Secure Ticket Authority URL – The secure ticket authority URL. This is typically present on the delivery controller.
7. With new Authentication settings user can create a new Authentication Policy or you can use existing Authentication policy.

To create a new Domain Based Authentication Policy, enter the values for the following fields in and click **Continue**.

8. **Choose Authentication Type** - Select Domain from the drop-down menu

9. Select **Add new server** or **Use existing server** based on your requirement

   - **IP Address** – IP address for the Domain server
   - **Port** – Port of the Domain server
   - **Base DN** - The base DN under which users are located
   - **Service Account** - The account used to query Active Directory
   - **Password** - The password required to log on to the Domain server
   - **Time out** - The time duration for which the Domain directory is looked up
   - **Server Logon Name Attribute** - The name attribute used by the NetScaler appliance to query the external Domain server or an Active Directory.

You can optionally click on **Test Connection** to ensure that the server is reachable and valid credentials are provided.

**Note:** To use an existing Authentication policy, select required **Authentication Type** from **Choose Authentication Type** drop-down and provide the information as listed above.

10. On the Citrix Gateway Settings page, Click **Done**.

11. Click **Download file**.

**Following are the configuration steps required at the StoreFront GUI:**

2. Click **Stores**.
3. Select **Manage Citrix Gateways** and click **Imported from file** link in **Manage Citrix Gateways** window.
4. Under **Select File** area in **Import NetScaler Configuration** window, click **Next**.
5. Under **Select Logon Type** area, optionally provide a **Callback URL** for StoreFront to contact Citrix Gateway and click **Next**.
7. Under **Review changes** click **Next**.
8. Click **Finish**.
Configuring Settings for Your Citrix Endpoint Management Environment

February 28, 2020

The Citrix ADC for Citrix Endpoint Management wizard guides you through the configuration of Citrix ADC features for your Citrix Endpoint Management deployment. You can use the wizard to:

- **Set up a Micro VPN.** In this scenario, remote users can access apps and desktops in the internal network.
  - For Citrix Endpoint Management MAM-only mode, you must use Citrix Gateway for authentication.
  - For MDM deployments, Citrix recommends Citrix Gateway for mobile device VPN.
  - For ENT deployments, if a user opts out of MDM enrollment, the device operates in the legacy MAM mode and enrolls using the Citrix Gateway FQDN.

- **Configure certificate-based authentication.** The default configuration for Citrix Endpoint Management is user name and password authentication. To add another layer of security for enrollment and access to Citrix Endpoint Management environment, consider using certificate-based authentication.

- **Load balance Citrix Endpoint Management servers.** Citrix ADC load balancing is required for all Citrix Endpoint Management device modes if you have multiple Citrix Endpoint Management servers or if the Citrix Endpoint Management is inside your DMZ or internal network (and therefore traffic flows from devices to Citrix ADC to Citrix Endpoint Management). In this scenario, the Citrix ADC appliance resides in the DMZ between the user device and the Citrix Endpoint Management servers to load balance encrypted sent data from mobile devices to the Citrix Endpoint Management servers.

- **Load balance Microsoft Exchange servers with email filtering.** In this scenario, the Citrix ADC appliance is between the user device and the Citrix Endpoint Management Citrix ADC Connector (XNC), and between the user device and the Microsoft Exchange CAS servers. All requests from user devices go to the Citrix Gateway appliance, which then communicates with the XNC to retrieve information about the device. Depending on the response from the XNC, the Citrix ADC appliance either forwards the request from a whitelisted device to the server in the internal network, or drops the connection from a blacklisted device.

- **Load balance ShareFile StorageZones Connectors based on the type of content requested.** This scenario prompts you for basic information about your StorageZones Controller environment and then generates a configuration that does the following:
  - Load balances traffic across StorageZones Controllers.
  - Provides user authentication for StorageZones Connectors.
Citrix Gateway 13.0

- Validates URI signatures for ShareFile uploads and downloads.
- Terminates SSL connections at the Citrix ADC appliance.

For more information about configuring ShareFile, see Configure Citrix ADC for StorageZones Controller.

**Important**

Before you use the Citrix Endpoint Management wizard, be sure to refer to these Citrix Endpoint Management Deployment articles for design and deployment information and recommendations:

- Citrix Endpoint Management Integration
- Integrating with Citrix Gateway and Citrix ADC
- SSO and Proxy Considerations for MDX Apps

**Authentication**

You can use the Citrix ADC for Citrix Endpoint Management wizard only once. If you want multiple Citrix Endpoint Management instances, such as for test, development, and production environments, you must configure Citrix ADC for the additional environments manually. The following support articles list the commands run by the wizard and provides instructions for running them to create a new Citrix ADC instance:

- Commands Generated by Citrix Endpoint Management Wizard on Citrix ADC - SSL Bridge
- Commands Generated by Citrix Endpoint Management Wizard on Citrix ADC - SSL Offload

**License Requirements for Citrix ADC Features**

You must install licenses to enable the following Citrix ADC features:

- Citrix Endpoint Management MDM load balancing requires a Citrix ADC standard license.
- ShareFile load balancing with StorageZones requires a Citrix ADC standard license.
- Exchange load balancing requires a Citrix ADC license or a Advanced license with the addition of an Integrated Caching license.

**Citrix ADC for Citrix Endpoint Management Wizard**

This section provides an example of using the Citrix ADC for Citrix Endpoint Management wizard to:

- Set up micro VPN access for remote user connections to Citrix Endpoint Management-managed resources in your internal network
- Configure certificate-based authentication. For information about obtaining and installing a public SSL certificate, see Installing and Managing Certificates.
• Configure load balancing for Citrix Endpoint Management servers.

To use the wizard:

1. In the configuration utility, click the **Configuration** tab and then click **Citrix Endpoint Management**.

2. Select your Citrix Endpoint Management version and then click **Get Started**.

3. Select the checkboxes for the features you want to configure. Keep in mind that you can use this wizard only once, so you’ll need to perform subsequent configuration manually. These instructions assume that you select the following settings: **Access through Citrix Gateway** (for Citrix Endpoint Management running in ENT or MAM modes)

   **Load Balance Citrix Endpoint Management Servers**

4. On the **Citrix Gateway Settings** page, enter values for the external facing **Citrix Gateway IP Address**, **Port**, and **Virtual Server Name**.
5. On the Server Certificate for Citrix Gateway page, from the Certificate File drop-down menu, choose the certificate file from Local or Appliance. If your certificate is on a local machine:

If your certificate is on the appliance:
6. In the Authentication Settings page, in the Primary authentication method field, select Client Certificate.

This will automatically select Use existing certificate policy and Cert Auth in the next two fields. The following steps assume that you already have a certificate policy.

If you need to create a certificate policy, click Create certificate policy and complete the settings. On the Citrix Endpoint Management Certificate screen, choose an existing server certificate or install a new certificate. If you’re running multiple Citrix Endpoint Management servers, you will add a certificate for each one. For Server Logon Name Attribute, specify userPrincipalName or samAccountName, per your requirements.

- a. Select Click here to change the CA certificate and then in the Browse list, navigate to the CA certificate you want.
b. With client certificate as your primary authentication type, you have the option of configuring LDPA (or RADIUS) as the secondary authentication type.

To use client certificate authentication only, leave **Second authentication method** as **None** and then click **Continue**.

To use client certificate + domain (LDAP) authentication, change **Second authentication method** to **LDAP** and configure the authentication server settings.

c. On the **Device certificate** screen, if the certificate is not already installed, you must export this certificate from the Citrix Endpoint Management console: From the console, click the gear icon in the upper-right corner to open the **Settings** screen.

d. Click **Certificate** and then choose the CA certificate from the list.

e. Click **Export**.

f. Return to the Citrix ADC wizard and select the certificate you exported (downloaded) to install it.

  g. Click **Continue**.

The Citrix Endpoint Management IP addresses that you’ve configured will appear.

7. Configure the **Citrix Endpoint Management App Management Settings**.
• Enter the **Citrix Endpoint Management FQDN**. This is the load balancing FQDN for MAM.

• Enter a MAM-only **Internal Load Balancing IP Address** for the virtual server that load balances Citrix Endpoint Management servers. Citrix Gateway communicates with the Citrix Endpoint Management through this MAM load balancing virtual IP.

• This is an SSL offload deployment, so select **HTTP** in **Communication with Citrix Endpoint Management Server**.

• The **Split DNS mode for MicroVPN** field automatically sets to **BOTH**.

If your deployment requires split tunneling, select **Enable split tunneling**. You must configure Intranet Application Binding, next, if you enable split tunneling.

By default, Secure Web access is tunneled to the internal network, which means that Secure Web uses a per-application VPN tunnel back to the internal network for all network access and the Citrix ADC appliance uses split tunnel settings.
8. To configure interception rules for user connections on Citrix Gateway, you must configure **Intranet Application Binding**. Click + to add a binding.
9. Complete the parameters for allowing network access and then click **Create**.
10. Add the Citrix Endpoint Management certificate. This will be used for the MAM load balancing virtual server.

11. Under **Citrix Endpoint Management Servers**, click **Add Server** to add the **Citrix Endpoint Management IP Address** to bind to the load balancing virtual IP.
12. On the Citrix ADC dashboard, confirm that Citrix Gateway and Citrix Endpoint Management load balancing are configured as follows.
If you will use sAMAccount attributes in the user certificates as an alternative to User Principal Name (UPN), configure the certificate profile as described in Manually Configuring Citrix Gateway for Client Certificate Authentication.
Configuring Load Balancing Servers for Citrix Endpoint Management or Citrix XenMobile Server

May 31, 2019

After using the Citrix ADC for Citrix Endpoint Management wizard for initial setup, use the Citrix Gateway configuration utility to configure load balancing, as described in this section. For Citrix Endpoint Management, use SSL Offload. For Citrix Endpoint Management Server, be sure to refer to the recommendations for load balancing modes under “Deployment Summary” in Integrating with Citrix Gateway and Citrix ADC.

To use SSL Bridge mode for Citrix ADC VIPs

Use SSL Bridge mode if Citrix Endpoint Management is in the DMZ. When you load balance Citrix Endpoint Management with Citrix ADC VIPs in SSL Bridge mode, Internet traffic flows directly to Citrix Endpoint Management server, where connections terminate. SSL Bridge mode is the simplest mode to set up and troubleshoot.

1. Before configuring SSL Bridge mode, go to Citrix Endpoint Management App Management Settings and verify that Communication with Citrix Endpoint Management Server is HTTPS.

2. After you log on to the configuration utility, on the Home tab, in MDM Server LB, click Configure.


4. In IP Address, type the IP address for the virtual server and then click Continue.

5. On the Load Balance Citrix Endpoint Management MDM Servers page, repeat Steps 3 and 4 and then click Create.

6. Verify that the settings are correct and then click Done.
To use SSL Offload mode for Citrix ADC VIPs

Use SSL Offload for Citrix Endpoint Management. Also use SSL Offload, if required to meet security standards, when the on-premises Citrix Endpoint Management is in the internal network. When you load balance Citrix Endpoint Management with Citrix ADC VIPs in SSL Offload mode, Internet traffic flows directly to the Citrix ADC appliance, where connections terminate. Citrix Gateway then establishes new sessions from the appliance to Citrix Endpoint Management. SSL Offload mode involves additional complexity during setup and troubleshooting.

1. Before configuring SSL Offload mode, go to Citrix Endpoint Management App Management Settings and verify that Communication with Citrix Endpoint Management Server is HTTP.

2. Log on to the configuration utility. On the Home tab, in MDM Server LB, click Configure.

4. In **IP Address**, type the IP address for the virtual server and then click **Continue**.

5. On the **Load Balance Citrix Endpoint Management MDM Servers** page, repeat Steps 3 and 4 and then click **Create**.

6. Verify the settings and then click **Done**.

7. When prompted to add a server certificate, choose the server certificate and click **Continue**.

8. Specify the CA certificate and click **Continue**.

9. Keep the same Citrix Endpoint Management IP address. Click **Done**.
10. To verify the load balancing configuration, go to Traffic Management > Virtual Servers.

Configuring Load Balancing Servers for Microsoft Exchange with Email Security Filtering

April 23, 2019

2. Under LB Virtual Server for Exchange CAS, in Name, type a name for the server.
3. In IP Address, type the IP address for the virtual server.
4. In Port, type the port number. To add more ports, click the plus (+) sign and then type the port number.
5. Click Continue.
6. Under **Certificates**, either choose an existing certificate or install one that’s on your computer (Local) or on the Citrix ADC appliance (Appliance).

7. Click **Continue**.

8. Under **Exchange CAS Service Instances**, type a name, IP address, and port number for the virtual server. Then, click **Add** and **Continue**.
When you click **Done**, the fields for configuring the Citrix Endpoint Management Citrix ADC Connector (XNC) ActiveSync Filtering appear.

## Configuring Citrix Endpoint Management Citrix ADC Connector (XNC) ActiveSync Filtering

April 23, 2019

The Citrix Endpoint Management Citrix ADC Connector (XNC) provides a device level authorization service of ActiveSync clients to Citrix ADC which acts as a reverse proxy for the Exchange ActiveSync protocol. Authorization is controlled by a combination of policies defined within Citrix Endpoint Management and by rules defined locally by the XNC.

1. Under **Citrix Endpoint Management Citrix ADC Connector (XNC) ActiveSync Filtering**, for **Callout Protocol**, select **http** or **https**.
2. In **XNC IPAddress**, type the IP address of the Citrix Endpoint Management Citrix ADC Connector.
3. In **Port**, type **9080** for HTTP network traffic or **9443** for HTTPS network traffic, and then click **Continue**.

Your configuration appears.
Allowing Access from Mobile Devices with Citrix Mobile Productivity Apps

May 27, 2019

The Citrix ADC for XenMobile wizard configures the settings required to allow users to connect from supported devices through Citrix Gateway to mobile apps and resources in the internal network. Users connect by using Secure Hub (previously, Worx Home), which establishes a Micro VPN tunnel. When users connect, a VPN tunnel opens to Citrix Gateway and then is passed to XenMobile in the internal network. Users can then access their web, mobile, and SaaS apps from XenMobile.

To ensure that users consume a single Universal license when connecting to Citrix Gateway with multiple devices simultaneously, you can enable session transfer on the virtual server. For details, see Configuring Connection Types on the Virtual Server.

If you need to change your configuration after using the Citrix ADC for XenMobile wizard, use the sections in this article for guidance. Before changing settings, make sure that you understand the implications of your changes. For more information, refer to the XenMobile Deployment articles.

Configuring Secure Browse in Citrix Gateway

You can change Secure Browse as part of global settings or as part of a session profile. You can bind the session policy to users, groups, or virtual servers. When you configure Secure Browse, you must also enable clientless access. However, clientless access does not require you to enable Secure Browse. When you configure clientless access, set Clientless Access URL Encoding to Clear.

To configure Secure Browse globally:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. In the Global Citrix Gateway Settings dialog box, on the Security tab, click Secure Browse and then click OK.
To configure Secure Browse in a session policy and profile:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, do one of the following:
   • If you are creating a new session policy, click Add.
   • If you are changing an existing policy, select a policy and then click Open.
3. In the policy, create a new profile or modify an existing profile. To do so, do one of the following:
   • Next to Request Profile, click New.
   • Next to Request Profile, click Modify.
4. On the Security tab, next to Secure Browse, click Override Global and then select Secure Browse.
5. Do one of the following:
   • If you are creating a new profile, click Create, set the expression in the policy dialog box, click Create and then click Close.
   • If you are modifying an existing profile, after making the selection, click OK twice.

To configure traffic policies for Secure Web in Secure Browse mode:

Use the following steps to configure traffic policies to route Secure Web traffic through a proxy server in Secure Browse mode.

1. In the configuration utility, on the Configuration tab, expand Citrix Gateway > Policies and then click Traffic.
2. In the right pane, click the Traffic Profiles tab and then click Add.
3. In Name, enter a name for the profile, select TCP as the Protocol, and leave the rest of the settings as-is.
4. Click Create.
5. Click the Traffic Profiles tab and then click Add.
6. In Name, enter a name for the profile and then select HTTP as the Protocol.
   This Traffic Profile is for both HTTP and SSL. CVPN traffic is HTTP traffic by design, regardless of the destination port or service type. Thus, you specify both SSL and HTTP traffic as HTTP in the traffic profile.
7. In Proxy, enter the IP address of the proxy server. In Port, enter the port number of the proxy server.
8. Click Create.
9. Click the Traffic Profiles tab and then click Add.
10. Enter the Name of the traffic policy and, for Request Profile, select the Traffic Profile you created in Step 3. Enter the following Expression and then click Create:
That rule performs a check based on the host header. To bypass the Activesync traffic from the proxy, replace `ActiveSyncServer` with the appropriate ActiveSync server name.

11. Click the Traffic Profiles tab and then click Add. Enter the Name of the traffic policy and, for Request Profile, select the Traffic Profile created in Step 6. Enter the following Expression and then click Create:

```
(REQ.HTTP .HEADER User-Agent CONTAINS Mozilla) &&
(REQ.HTTP .HEADER User-Agent CONTAINS com.citrix.browser) &&
REQ.TCP .DESTPORT == 80
```

12. Click the Traffic Profiles tab and then click Add. Enter the Name of the Traffic Policy and, for Request Profile, select the Traffic Profile created in Step 6. Enter the following Expression and then click Create:

```
(REQ.HTTP .HEADER User-Agent CONTAINS Mozilla) &&
(REQ.HTTP .HEADER User-Agent CONTAINS com.citrix.browser) &&
REQ.TCP .DESTPORT == 443
```

13. Navigate to Citrix Gateway > Virtual Servers, select the virtual server in the right pane, and then click Edit.


15. From the Choose Policy menu, select Traffic.
16. Click **Continue**.

17. Under **Policy Binding**, across from **Select Policy**, click >.

18. Select the Policy you created in Step 10 and then click **OK**.

19. Click **Bind**.

20. Under **Policies**, click **Traffic Policy**.


22. Under **Policy Binding**, next to the **Select Policy** menu, click > to view the policy list.

23. Select the policy you created in Step 17 and then click **OK**.

24. Click **Bind**.


27. Under **Policy Binding**, next to the **Select Policy** menu, click > to view the policy list.

28. Select the policy you created in Step 18 and then click **OK**.

29. Click **Bind**.

30. Click **Close**.

31. Click **Done**.

Be sure to configure the Secure Web (WorxWeb) app in the XenMobile console. Go to **Configure > Apps**, select the Secure Web app, click **Edit**, and then make these changes:

- On the **App information** page, change **Initial VPN Mode** to **Secure Browse**.
- On the **iOS** page, change **Initial VPN Mode** to **Secure Browse**.
- On the **Android** page, change **Preferred VPN Mode** to **Secure Browse**.

**Configuring Application and MDX Token Time-Outs**

When users log on from an iOS or Android device, an application token or an MDX token is issued. The token is similar to the Secure Ticket Authority (STA).

You can set the number of seconds or minutes the tokens are active. If the token expires, users cannot access the requested resource, such as an application or a web page.

Token time-outs are global settings. When you configure the setting, it applies to all users who log on to Citrix Gateway.

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway** and then click **Global Settings**.
2. In the details pane, under **Settings**, click **Change global settings**.

3. In the **Global Citrix Gateway Settings** dialog box, on the **Client Experience** tab, click **Advanced Settings**.

4. On the **General** tab, in **Application Token Timeout (sec)** enter the number of seconds before the token expires. The default is 100 seconds.

5. In **MDX Token Timeout (mins)**, enter the number of minutes before the token expires and then click **OK**. The default is 10 minutes.

### Disabling Endpoint Analysis for Mobile Devices

If you configure endpoint analysis, you need to configure the policy expressions so that the endpoint analysis scans do not run on Android or iOS mobile devices. Endpoint analysis scans are not supported on mobile devices.

If you bind an endpoint analysis policy to a virtual server, you must create a secondary virtual server for mobile devices. Do not bind preauthentication or post-authentication policies to the mobile device virtual server.

When you configure the policy expression in a preauthentication policy, you add the User-Agent string to exclude Android or iOS. When users log on from one of these devices and you exclude the device type, endpoint analysis does not run.

For example, you create the following policy expression to check if the User-Agent contains Android, if the application virus.exe does not exist, and to end the process keylogger.exe if it is running by using the preauthentication profile. The policy expression might look like this:

```
REQ.HTTP.HEADER
User-Agent NOTCONTAINS Android 
&&
CLIENT.APPLICATION.PROCESS(virus.exe) contains
```

After you create the preauthentication policy and profile, bind the policy to the virtual server. When users log on from an Android or iOS device, the scan does not run. If users log on from a Windows-based device, the scan does run.

For more information about configuring preauthentication policies, see [Configuring Endpoint Policies](#).
Supporting DNS Queries by Using DNS Suffixes for Android Devices

When users establish a Micro VPN connection from an Android device, Citrix Gateway sends split DNS settings to the user device. Citrix Gateway supports split DNS queries based on the split DNS settings you configure. Citrix Gateway can also support split DNS queries based on DNS suffixes you configure on the appliance. If users connect from an Android device, you must configure DNS settings on Citrix Gateway.

Split DNS works in the following manner:

- If you set split DNS to **Local**, the Android device sends all DNS requests to the local DNS server.
- If you set split DNS to **Remote**, all DNS requests are sent to the DNS servers configured on Citrix Gateway (remote DNS server) for resolution.
- If you set split DNS to **Both**, the Android device checks for the DNS request type.
  - If DNS request type is not “A”, it sends the DNS request packet to both local and remote DNS servers.
  - If DNS request type is “A”, the Android plugin extracts query FQDN and matches that FQDN against the DNS suffix list configured on Citrix ADC. If DNS request’s FQDN matches, DNS request is sent to remote DNS server. If FQDN does not match, DNS request is sent to local DNS servers.

The following table summarizes split DNS working based on type A record and suffix list.

<table>
<thead>
<tr>
<th>Split DNS setting</th>
<th>Is it a type A record?</th>
<th>Is it on suffix list?</th>
<th>Where the DNS request is sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>both Yes or No</td>
<td>both Yes or No</td>
<td>Local</td>
</tr>
<tr>
<td>Remote</td>
<td>both Yes or No</td>
<td>both Yes or No</td>
<td>Remote</td>
</tr>
<tr>
<td>Both</td>
<td>No</td>
<td>NA</td>
<td>Both</td>
</tr>
<tr>
<td>Both</td>
<td>Yes</td>
<td>Yes</td>
<td>Remote</td>
</tr>
<tr>
<td>Both</td>
<td>Yes</td>
<td>No</td>
<td>Local</td>
</tr>
</tbody>
</table>

To configure a DNS suffix:

1. In the configuration utility, on the **Configuration** tab, in the navigation pane, expand **Citrix Gateway > Policies** and then click **Session**.
2. In the details pane, on the **Policies** tab, select a session policy and then click **Open**.
3. Next to **Request Profile**, click **Modify**.
4. On the **Network Configuration** tab, click **Advanced**.
5. Next to **Intranet IP DNS Suffix**, click **Override Global**, type the DNS suffix and then click **OK** three times.
To configure split DNS globally on Citrix Gateway:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway and then click Global Settings.
2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the General tab, in Split DNS, select Both, Remote, or Local and then click OK.

To configure split DNS in a session policy on Citrix Gateway:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway > Policies and then click Session.
2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, click Advanced Settings.
7. On the General tab, next to Split DNS, click Override Global, select Both, Remote, or Local and then click OK.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True, click Add Expression, click Create and then click Close.

Configuring Domain and Security Token Authentication for Citrix Endpoint Management

April 23, 2019

You can configure Citrix Endpoint Management to require users to authenticate with their LDAP credentials plus a one-time password, using the RADIUS protocol. This section describes the required Citrix Gateway configuration for that two-factor authentication type.

Prerequisites

If you have not already run the Citrix ADC for Citrix Endpoint Management wizard, see the Citrix ADC for Citrix Endpoint Management Wizard section in Configuring Settings for Your Citrix Endpoint Management Environment. Make sure that your Citrix ADC configuration includes the following:

- **LDAP port number = 636** (which is the default port for secure LDAP connections)
- **Server Logon Name Attribute = samAccountName** or the **userPrincipalName** as per your requirements
To configure domain and security token authentication

1. Go to Citrix Gateway > Virtual Servers. Select the virtual server and then click Edit.

2. Click No CA Certificate.

3. From Select CA Certificate, choose a certificate, click OK, click Bind, and then click Done.

4. Go to Policies > Session > Session Profiles, select the profile which starts with AC_OS, and click Edit.

5. Click the Client Experience tab and go to the bottom of the page.
6. From **Credential Index**, choose **SECONDARY**.

7. Click **OK**.

8. Go to **Policies > Authentication > LDAP**, click the **LDAP Policy** tab, and click **Edit**.

9. To use separate Citrix Gateway VIPs for Citrix Endpoint Management and Citrix Virtual Apps and Desktops, in **Expression**, replace **NS_TRUE** with the following:
REQ.HTTP.HEADER User-Agent CONTAINS CitrixReceiver

10. Go to Policies > Authentication > RADIUS and then click the Servers tab.

11. Click Add, enter the Radius server details, and click Create.
12. Go to Policies and then click Add.

13. Enter a Name for the policy. From the Server drop-down menu, select the Radius server name (Radius_Server in our example).

14. For Expression, enter REQ.HTTP.HEADER User-Agent CONTAINS CitrixReceiver and click Create.
15. Select the virtual server and then click **Edit**.

16. Under **Primary Authentication**, click **LDAP Policy**.
17. Select the policy, click **Unbind**, and click **Close**.

18. On the **Authentication** row, click + to add the Radius authentication.
19. Under **Choose Type**, from **Choose Policy**, select **RADIUS**.

20. Click **Bind**.

21. Select the Radius authentication policy you created earlier and then click **Insert**.

22. Click **OK**.
23. To add LDAP as the secondary authentication policy: On the **Authentication** row, click +.

24. From **Choose Policy**, choose **LDAP**.

25. From **Choose Type**, choose **Secondary**.

26. From **Select Policy**, choose the LDAP policy.
27. Select the policy and then click OK.

28. Click Bind.

29. Click Done.
30. Verify that the policies you created have the highest priority. This ensures that they will have the highest priority even if additional policies get added for non-mobile users. For more information, see Setting Priorities for Authentication Policies

**Configuring Client Certificate or Client Certificate and Domain Authentication**

December 17, 2019

You can use the Citrix ADC for Citrix Endpoint Management wizard to perform the configuration required for Citrix Endpoint Management when using Citrix ADC certificate-only authentication or certificate plus domain authentication. You can run the Citrix ADC for Citrix Endpoint Management wizard one time only. For information about using the wizard, see Configuring Settings for Your Citrix Endpoint Management Environment.

If you’ve already used the wizard, use the instructions in this article for the addition configuration required for client certificate authentication or client certificate plus domain authentication.

To ensure that the user of a device in MAM-only mode can’t authenticate using an existing certificate on the device, see “Citrix ADC Certificate Revocation List (CRL)” later in this article.
Manually Configuring Citrix Gateway for Client Certificate Authentication

1. Under Traffic Management > Load Balancing > Virtual Servers, go to each virtual server (both 443 and 8443), update the SSL Parameters, and set Enable Session Reuse to DISABLED.

![SSL Parameters](image1)


![SSL Parameters](image2)

3. Create an authentication Certificate policy so Citrix Endpoint Management can extract the User Principal Name or the sAMAccount from the client certificate provided by Secure Hub to Citrix Gateway. For details, see Citrix ADC for XenMobile Wizard.

4. Set the following parameters for the certificate profile:

   Authentication Type: CERT

   Two Factor: OFF (for certificate only authentication)

   User Name Field: Subject: CN

   Group Name Field: SubjectAltName:PrincipalName
5. Bind only the certificate authentication policy as the Primary Authentication in the Citrix Gateway virtual server.

6. Bind the Root CA certificate to validate the trust of the client certificate presented to Citrix Gateway.
Manually Configuring Citrix Gateway for Client Certificate and Domain Authentication

1. Under Traffic Management > Load Balancing > Virtual Servers, go to each virtual server (both 443 and 8443), update the SSL Parameters, and set Enable Session Reuse to DISABLED.

2. Go to Policies > Authentication > Cert, select the Servers tab, and click Add.

3. Enter the Name of the profile, set Two Factor to ON, and from User Name Field, select SubjectAltNamePrincipalName.
4. Go to **Policies** and click **Add**.

5. Enter the **Name** of the policy, from **Server** select the certificate profile, set the **Expression** as **ns_true**, and click **Create**.
6. Go to **Virtual Servers**, select the virtual server, and click **Edit**.

7. Beside **Authentication**, click + to add the certificate authentication.
8. To select the authentication method: From Choose Policy, select Certificate.

9. From Choose Type, select Primary. This binds certificate authentication as the primary authentication with the priority same as the LDAP authentication type.

10. Under Policy Binding, click Click to Select to select the certificate policy created earlier.
11. Select the certificate policy created earlier and click **OK**.

12. Set the **Priority** to **100** and then click **Bind**. Use the same priority number when you configure the LDAP authentication policy in the subsequent steps.

14. Select the policy and then, from the **Edit** drop-down menu, click **Edit Binding**.

15. Enter the same **Priority** value that you specified for the certificate policy. Click **Bind**.

16. Click **Close**.

17. Under **Advanced**, click **SSL Parameters**.
18. Select the **Client Authentication** check box, from **Client Certificate** choose **Mandatory**, and click **OK**.

19. Click **Done**.
Citrix ADC Certificate Revocation List (CRL)

Citrix Endpoint Management supports Certificate Revocation List (CRL) only for a third party Certificate Authority. If you have a Microsoft CA configured, Citrix Endpoint Management uses Citrix ADC to manage revocation. When you configure client certificate-based authentication, consider whether you need to configure the Citrix ADC Certificate Revocation List (CRL) setting, Enable CRL Auto Refresh. This step ensures that the user of a device in MAM-only mode can’t authenticate using an existing certificate on the device. Citrix Endpoint Management reissues a new certificate, because it doesn’t restrict a user from generating a user certificate if one is revoked. This setting increases the security of PKI entities when the CRL checks for expired PKI entities.

Optimizing network traffic with CloudBridge

April 23, 2019

When users log on with the Citrix Gateway plug-in, the connection can be optimized by using the CloudBridge plug-in, which installs on the user device from CloudBridge. When the connection is optimized through the use of the CloudBridge plug-in, network traffic is compressed and accelerated through Citrix Gateway. When CloudBridge is enabled for a connection, TCP compression policies on the Citrix Gateway are disabled.

The CloudBridge plug-in is deployed and works with the Citrix Gateway plug-in.

Citrix Gateway supports Versions 5.5 and 6.1 of the Repeater plug-in and Versions 6.2 and 7.0 of the CloudBridge plug-in.
CloudBridge optimization and flow control take precedence over Citrix Gateway optimization features that require dynamic content modification. If CloudBridge optimization is enabled for HTTP traffic, the following Citrix Gateway features are not available:

- Single sign-on to Web applications
- File type association
- HTTP authorization

To allow single sign-on to Web applications, you can disable acceleration on HTTP. To do so, you use the command line. Log on to the Citrix Gateway serial console and then at a command prompt, type:

```
add vpn trafficAction ssoact http -SSO ON
```

Network traffic destined for a configured HTTP port on Citrix Gateway is excluded automatically from CloudBridge optimization. This is the default setting. If you configure a traffic policy for CloudBridge optimization on an HTTP port, the traffic policy is honored and the network traffic is optimized by CloudBridge. However, the Citrix Gateway optimization features are disabled for all traffic affected by that policy. CloudBridge can accelerate network traffic destined for non-HTTP ports without affecting other Citrix Gateway features.

You use a traffic policy to configure user connections to use the CloudBridge plug-in. You can then bind the policy to users, groups, virtual servers, or globally. The policy is prioritized based on where you bind the policy or by the priority number you give the policy.

**To create a traffic policy**

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix Gateway Policies and then click Traffic.
2. In the details pane, click Add.
3. In Name type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. In Branch Repeater, select ON and then click Create.
7. In the Create Traffic Policy dialog box, next to Add Expression, select or enter an expression that represents the traffic types to enable CloudBridge acceleration click Add Expression, click Create and then click Close.

When adding an expression, choose a network expression to use the same IP addresses and port ranges for which the CloudBridge is configured to accelerate. For CloudBridge acceleration to occur, the traffic types configured on Citrix Gateway must match the Service Class Policies configured on CloudBridge.

All TCP traffic benefits from CloudBridge acceleration. If you are planning to use single sign-on, do not accelerate HTTP traffic because the acceleration disables single sign-on.
RfWebUI Persona on Gateway UX Configuration

September 26, 2019

RfWebUI Persona is a theme that provides a new logon and portal page for Citrix Gateway users logging on through Citrix Gateway. The portal presents Receiver, Storefront, and Citrix Endpoint Management users with the same GUI as when they access one of those products directly.

When to Use RfWebUI Persona

Use the RfWebUI persona in Citrix Gateway when you need a single-pane view of all the applications provided by different CITRIX products, such as web and Software as a Service (SaaS) applications, virtual Windows applications, and desktops.

The following scenarios illustrate the use of RfWebUI Persona.

- A user accesses Storefront using Gateway and finds a GUI different than the one they see upon accessing the product without Gateway.
  Solution: When the user accesses Storefront using Gateway, the RfWebUI theme provides a similar user interface as they see upon accessing the product without using the Gateway.
- A user accesses Citrix Workspace app, Storefront, and Citrix Endpoint Management applications using Gateway and struggles to locate the desired applications as the applications are not grouped in a logical fashion.
  Solution: The RfWebUI persona provides a single pane view user experience by creating a logical bundling of applications provided by different products, such as Receiver, Storefront, Citrix Endpoint Management and so on.

Functionalities Provided by RfWebUI Persona

The new RfWebUI provides the following features:

- **GO**
- Aggregation of applications
- User Configured RDP proxy links
- Favorite applications

**GO**

**GO:** The Go feature provides access to web pages through clientless VPN (CVPN). The user just types the URL in the URL section on the Bookmark tab and clicks on **GO**.
Currently, the **GO** feature supports only Outlook Web Application (OWA) and SharePoint URLs.

**Note**
The **GO** tab is visible only if the `clientlessAccessVPNMode` parameter in the session policy is **Enabled**.

### Aggregation of applications

**Aggregation of applications**: The RfWebUI theme provides a single-pane view by bundling the applications provided by different products under descriptive banners. For example, all the VPN URLs configured by a Citrix ADC administrator are in a bundle named **Web and SaaS Applications**, and user-specific web bookmarks are under **Personal Bookmarks**. If Citrix Virtual Apps and Desktops application bundles are configured in StoreFront, the single pane view in Citrix Gateway lists these bundles as well.

#### User Configured RDP Proxy Links

Users can add Remote Desktop Protocol (RDP) proxy link as personal bookmarks. The personal bookmarks appear under the Desktops tab.

The following RDP modes are supported:

- Single gateway
- Stateless (Dual) gateway

**Note**
User can add RDP Proxy Links only if an **RDPclientprofile** is configured. For more information on RDP configurations, see **RDP Proxy** documentation.

### Favorite applications

Users can add the desired applications listed under **Web and SaaS Application** and under **Personal Bookmarks** to **FAVORITES** tab by clicking on **Add to Favorites** link present next to the application name. The applications once added can be seen under **FAVORITES** tab. The same can also be removed from the **FAVORITES** tab by clicking on **REMOVE** link present next to the application inside **FAVORITES** tab.

### Considerations While Enabling the RfWebUI Persona

The RfWebUI persona does not fully support the following:
**Fileshare feature** The fileshare feature, for accessing SMB file shares, is not supported.

**Email Home:** The Email Home VPN parameter is not available as an embedded view for the Citrix Gateway portal. It can be accessed as an application in the Web and SaaS Apps bundle under the APPS tab of RfWebUI.

**Java Client:** The browser based Java client for establishing a SSL tunnel is not available in this theme.

**Configuring RfWebUI Persona**

**To apply the RfWebUI Persona:**

1. In the Citrix ADC interface, navigate to Configuration > Citrix Gateway Portal Themes.
2. On the Portal Themes page, select the RfWebUI checkbox.
3. Click the Save icon on the top right corner of the Portal Themes page.
4. In the Save Confirmation dialog box, click Yes.

---

**RDP Proxy**

March 19, 2020

**RDP Proxy Overview and Enhancements through Citrix Gateway**

The following RDP Proxy features provide access to a remote desktop farm through Citrix Gateway:

- Secure RDP traffic through clientless VPN or ICA Proxy mode (without Full Tunnel).
- Single sign on (SSO) to RDP servers through Citrix Gateway. Also provides an option to disable SSO if needed).
- Enforcement (SmartAccess) feature, where Citrix ADC administrators can disable certain RDP capabilities through Citrix Gateway configuration.
- Single/Stateless(Dual) Gateway solution for all needs (VPN/ICA/RDP/Citrix Endpoint Management).
- Compatibility with native Windows MSTSC client for RDP without the need for any custom clients.
- Use of existing Microsoft-provided RDP client on MACOSX, iOS, and Android.
**Deployment Overview**

The following figure depicts an overview of the deployment:

![Deployment Diagram]

The RDP Proxy functionality is provided as part of the Citrix Gateway. In a typical deployment, the RDP client runs on a remote user’s machine. The Citrix Gateway appliance is deployed within the DMZ, and the RDP server farm is in the internal corporate network. The remote user connects to the Citrix Gateway public IP address, establishes an SSL VPN connection, and authenticates self, after which the user can access the Remote desktops through the Citrix Gateway appliance.

The RDP-proxy feature is supported in clientless VPN and ICA Proxy modes.

| Note: Citrix Gateway does not support Remote Desktop Session Host (RDSH)/Remote App/RDS multiuser RDP sessions. |

**Deployment Through clientless VPN**

In this mode the RDP links are published on the Gateway home page or portal, as bookmarks, through the ‘add vpn url’ configuration or through an external portal. The user can click these links to get access to the Remote Desktop.

**Deployment Through ICA Proxy**

In this mode a custom home page is configured on the Gateway VIP by using the wihome parameter. This home page can be customized with the list of Remote desktop resources that the user is allowed to access. This custom page can be hosted on Citrix ADC, or if external, it can be an iFrame in the existing Gateway portal page.

In either mode, after the user clicks the provisioned RDP link or icon, an HTTPS request for the corresponding resource arrives at the Citrix Gateway. The Gateway generates the RDP file content for the requested connection and pushes it to the client. The native RDP client is invoked, and it connects to
an RDP listener on Gateway. Gateway does SSO to the RDP server by supporting enforcement (Smar-
tAccess). In this, the gateway blocks client access to certain RDP features, based on the Citrix ADC configura-
tion, and then it proxies the RDP traffic between the RDP client and the server.

**Enforcement Details**

The Citrix ADC administrator can configure certain RDP capabilities through Citrix Gateway configu-
ration. Citrix Gateway provides the “RDP enforcement” feature for important RDP parameters. Citrix
ADC ensures that the client cannot enable blocked parameters. If the blocked parameters are enabled,
the RDP enforcement feature supersedes the client-enabled parameters, and they are not honored.

**Supported RDP Parameters for Enforcement**

Enforcement for following redirection parameters is supported. These are configurable as part of an
RDP client profile.
- Redirection of ClipBoard
- Redirection of Printers
- Redirection of Disk Drives
- Redirection of COM ports
- Redirection of pnp devices

**Connection Flow**

Connection flow can be divided into two steps:
- RDP resource enumeration and RDP file download.
- RDP Connection launch.

Based on the above connection flow, there are two deployment solutions:
- Stateless (Dual) gateway solution - the RDP resource enumeration and RDP file download hap-
pens through authenticator gateway but RDP connection launch happens through RDP Listener
gateway.
- Single gateway solution - the RDP resource enumeration, RDP file download, and RDP connec-
tion launch happen through the same gateway.
Stateless (Dual) Gateway Compatibility

The following figure depicts the deployment:

• User connects to the Authenticator Gateway VIP and provides the credentials.

• After successful login to the gateway, user is redirected to the home page or external portal, which enumerates the remote desktop resources that the user can access.

• Once the user selects an RDP resource, a request is received by the Authenticator Gateway VIP, in the format `https://vserver-vip/rdpproxy/rdptarget/listener` indicating the published resource that the user clicked. This request has the information about the IP address and port of the RDP server that the user has selected.

• The `/rdpproxy/` request is processed by the Authenticator Gateway. Since the user is already authenticated, this request comes with a valid Gateway cookie.

• The RDPTarget and RDPUser information is stored on the STA server, and an STA Ticket is generated. The information stored on the STA server is encrypted by using the configured pre-shared key. The Authenticator Gateway uses one of the STA servers that is configured on the gateway virtual server.

• The ‘Listener’ info obtained in the `/rdpproxy/` request is put into the .rdp file as the “fulladdress,” and the STA ticket (pre-pended with the STA AuthID) is put into the .rdp file as the “loadbalanceinfo.”

• The .rdp file is sent back to the client end-point.
The native RDP client launches and connects to the RDPLDListener Gateway. It sends the STA ticket in the initial packet.

The RDPLDelete Gateway validates the STA ticket and obtains the RDPTarget and RDPUser information. The STA server to be used is retrieved by using the ‘AuthID’ present in the loadbalanceinfo.

**Single Gateway Compatibility**

The following figure depicts the deployment:

In the case of a single gateway deployment, the STA server is not required. The authenticator gateway encodes the RDPTarget and the Citrix ADC AAA session cookie securely and sends them as the loadbalanceinfo in the .rdp file. When the RDP Client sends this token in the initial packet, the authenticator gateway decodes the RDPTarget information, looks up the session, and connects to the RDPTarget.

**License Requirements for RDP Proxy**

Premium edition, Advanced edition

**Note:** RDP Proxy function is not available to customers who have only a Gateway platform license or only the Standard edition.

RDP proxy feature must be enabled for RDP proxy to work.
Enable the Required Features and Modes

- enable ns feature ssl
- enable ns feature sslvpn
- enable ns feature rdpproxy
- enable mode usnip

Creating Bookmarks

1. Create bookmarks on the portal page to access the RDP resources: (The actualURL starts with rdp://).
2. Add vpn url `<urlName> <linkName> <actualURL>
   - The URL must be in the following format: rdp://<TargetIP:Port>.
   - For Stateless RDP proxy mode, The URL must be in the following format: rdp://<TargetIP:Port>/<ListenerIP:Port>
   - The URL is published on the portal in the format:
     `https://<VPN-VIP>/rdpproxy/<TargetIP:Port>
     `https://<VPN-VIP>/rdpproxy/<TargetIP:Port>/<ListenerIP:Port>
3. Bind the bookmarks to the user, or group, or the vpn virtual server, or vpn global.

Configuring a Client Profile

Configure the client profile on the authenticator gateway. The following is a sample configuration:
Associate the RDP client Profile with the vpn virtual server.

This can be done either by configuring a sessionAction+sessionPolicy or by setting the global vpn parameter.

Example:

add vpn sessionaction <actname> -rdpClientprofile <rdpprofilename>
add vpn sessionpolicy <polname> NS_TRUE <actname>
bind vpn vserver <vservername> -policy <polname> -priority <prioritynumber>
OR
set vpn parameter -rdpClientprofile <name>

Configuring a Server Profile

Configure the server profile on the listener gateway.

- add rdpServer Profile <profilename> -rdp <IPV4 address of the RDP listener> -rdpPort <port for terminating RDP client connections> -psk <key to decrypt RDPTarget/RDPUser information, needed while using STA>

The rdpServer Profile must be configured on the ‘vpn virtual server’:

- add vpn vserver v1 SSL <publicIP> <portforterminatingvpnconnections> -rdpServerProfile <rdpServer Profile>
Sample Configuration

- Enable the required features and modes
  - enable ns feature ssl
  - enable ns feature sslvpn
  - enable ns feature rdpproxy
  - enable mode usnip

- Add VPN URL for the user with target information

  ```
  1 add aaa user Administrator -password freebsd123$%^ 
  2 add vpn url rdp RdpLink rdp://rdpserverinfo 
  3 add dns addrec rdpserverinfo 10.102.147.132 
  4 bind aaa user Administrator -urlName rdp 
  ```

- Configure RDP client and server profile for the VPN connection

  ```
  1 add rdp clientprofile p1 -psk citrix -redirectClipboard ENABLE 
  2 add rdp serverprofile p1 -rdpIP 10.102.147.134 -psk citrix 
  3 add vpn vserver mygateway SSL 10.102.147.134 443 -rdpserverprofile p1 
  4 set vpn parameter -clientlessVpnMode ON -defaultAuthorizationAction ALLOW -rdpClientProfileName p1 
  5 add ssl certKey gatewaykey -cert rdp_rootcert.pem -key rdp_rootkey 
  6 bind ssl vserver mygateway -certkeyName gatewaykey 
  ```

- ADD SNIP for connection from Citrix ADC to target

  ```
  1 add ns ip 10.102.147.135 255.255.255.0 -type SNIP 
  ```
Option to Disable SSO

The SSO (Single sign On) feature with RDP proxy can be disabled by configuring Citrix ADC traffic policies so the user is always prompted for credentials. When SSO is disabled, RDP enforcement (SmartAccess) doesn't work.

Example Configuration:

```
1 add vpn trafficaction <TrafficActionName> HTTP -SSO OFF
```

Traffic policy can be configured as per the requirement, following are two examples:

- To disable SSO for all the traffic:
  
  ```
  1 add vpn trafficpolicy <TrafficPolicyName> "url contains rdpproxy" <TrafficActionName>
  ```

- To disable SSO based on Source/Destination IP/FQDN
  
  ```
  1 add vpn trafficPolicy <TrafficPolicyName> "HTTP.REQ.URL.CONTAINS("rdpproxy") && CLIENT.IP.SRC.EQ(<IP>)" <TrafficActionName>
  2 bind vpnvserver rdp -policy <TrafficPolicyName> -priority 10
  ```

Support for Single Listener

- Single Listener for Both RDP and SSL Traffic.
- The RDP file download and RDP traffic can be handled through the same 2 tuple (that is, IP and Port) on Citrix ADC.

Bookmark

RDP link generation through Portal. Instead of configuring the RDP links for the user or publishing the RDP links through an external portal, you can give users an option to generate their own URLs by providing targetIP:Port. For stateless RDP-proxy deployment, the administrator can include RDP listener information in FQDN: Port format as part of the RDP Client Profile. This is done under the rdpListener option. This configuration is used for the RDP link generation through the portal in Dual Gateway mode.
RDP Proxy Configuration

Do the following to configure RDP Proxy:

1. Expand Citrix Gateway, expand Policies, right-click RDP, and click Enable Feature.
2. Click RDP on the left. On the right, switch to the **Client Profiles** tab and click **Add**.

3. Give the Client Profile a name and configure it as desired. Scroll down
4. In the RDP Host field, enter the FQDN that resolves to the RDP Proxy listener, which is typically the same FQDN as the Citrix Gateway appliance’s FDQN.

5. Near the bottom is a Pre Shared Key. Enter a password and click OK. You need this later.
6. Give the Server Profile a name.

7. Enter the IP address of the Gateway Virtual Server you’re going to bind this.

8. Enter the same Pre Shared Key you configured for the RDP Client Profile. Click Create.

9. If you want to put RDP bookmarks on the Clientless Access portal page, on the left, expand Citrix Gateway, expand Resources, and click Bookmarks.
10. On the right, click **Add**.

11. Give the Bookmark a name.

12. For the URL, enter rdp://MyRDPServer using IP or DNS.

13. Check the box next to Use Citrix Gateway As a Reverse Proxy and click Create.

14. Create more bookmarks as desired.
15. Create or edit a session profile or policy.

16. On the Security tab, set **Default Authorization Action** to **ALLOW**. Or you can use Authorization policies to control access.
17. On the Remote Desktop tab, select the RDP Client Profile you created earlier.

18. If you want to use Bookmarks, on the Client Experience tab, set Clientless Access to On.
19. On the **Published Applications** tab, make sure **ICA Proxy** is **OFF**.

20. Modify or Create your Gateway Virtual Server.

21. In the **Basic Settings** section, click **More**.
22. Use the RDP Server Profile list to select the RDP Server Profile you created earlier.

23. Scroll down. Make sure ICA Only is not checked.
24. Bind a certificate.

25. Bind authentication policies.

26. Bind the session policy/profile that has the RDP Client Profile configured.

27. You can bind Bookmarks to either the Citrix Gateway virtual server or to a Citrix ADC AAA group. To bind to the Citrix Gateway virtual server, on the right, in the Advanced Settings section, click Published Applications.
28. On the left, in the **Published Applications** section, click **No Url**.

29. Bind your Bookmarks.
30. Since ICA Only is not specified for this Citrix Gateway virtual server, make sure your Citrix Gateway Universal licenses are configured correctly. On the left, expand **Citrix Gateway** and click **Global Settings**.

31. On the right, click **Change authentication AAA settings**.

32. Change the **Maximum Number of Users** to your licensed limit.
33. If you want to connect to RDP servers by using DNS, make sure DNS servers are configured on the appliance (Traffic Management > DNS > Name Servers).

34. If you want to use the short names instead of FQDNs, add a DNS Suffix (Traffic Management > DNS > DNS Suffix).

35. Connect to your Gateway and log on.
36. If you configured **Bookmarks**, click the **Bookmark**.

37. You can change the address bar to **/rdpproxy/MyRDPServer**. You can enter an IP address (for example /rdpproxy/192.168.1.50) or DNS name (/rdpproxy/myserver).
38. Open the downloaded .rdp file.

39. You can view the currently connected users by going to **Citrix Gateway Policies > RDP**. On the right is the **Connections** tab.

---

**Stateless RDP Proxy**

April 23, 2019

The Stateless RDP Proxy accesses a RDP host. Access is granted through the RDPLadder on Citrix Gateway when the user authenticates on a separate Citrix Gateway Authenticator. The information required by the RDPLadder for Citrix Gateway is securely stored on a STA Server.

The flow and new knobs created for this functionality are described here.

**Prerequisites**

- User is authenticated on Citrix Gateway authenticator.
- The initial /rdpproxy URL and RDP Client are connected to a different RDPLadder Citrix Gateway.
• The RDPLocal Gateway information is securely passed by the Authenticator Gateway using a STA Server.

Configuration

• Add a new rdpServer profile. The server profile is configured on the RDPLocal Gateway.

```
```

For stateless RDP proxy, the STA Server validates the STA ticket, which is sent by the RDP client, to obtain the RDP Target/RDPUser information.

The rdpServer Profile is configured on the vpn virtual server using the following command:

```
add vpn vserver v1 SSL [publicIP] [portforterminatingvpnconnections] -rdpServerProfile [rdpServer Profile]
```

**Warning**

Once the rdpServerProfile is configured on the vpn vserver, it cannot be modified. Also, the same serverProfile cannot be reused on another vpn vserver.

The rdp profile command was renamed as rdpClient profile and has new parameters. The multiMonitorSupport command was added. Also, an option to configure custom params, which are not supported as part of the RDP client profile, has been added. The clientSSL param was removed, since the connection is always secured. The client profile is configured on the authenticator Gateway.

```
add rdpClient profile <name> -rdpHost <optional FQDN that will be put in the RDP file as ‘fulladdress’> [-rdpUrlOverride (ENABLE | DISABLE)] [-redirectClipboard (ENABLE | DISABLE)] [-redirectDrives (ENABLE | DISABLE)]
```

```
[redirectPrinters (ENABLE | DISABLE)] [-keyboardHook <keyboardHook>] [-audioCaptureMode (ENABLE | DISABLE)] [-videoPlaybackMode (ENABLE | DISABLE)]
```

```
[rdpCookieValidity <positive_integer>][multiMonitorSupport (ENABLE | DISABLE)][rdpCustomParams <string>] The -rdpHost configuration is used in a single Gateway deployment.
```
• Associate the RDP Profile with the vpn virtual server.

This can be done either by configuring a sessionAction+sessionPolicy or by setting the global vpn parameter.

Example

```
1 add vpn sessionaction <actname> -rdpClientprofile <rdpprofilename>
2 add vpn sessionpolicy <polname> NS_TRUE <actname>
3 bind vpn vserver <vservername> -policy <polname> -priority <prioritynumber>
4 OR
5 set vpn parameter -rdpClientprofile <name>
```

Connection Counter

A new connection counter ns_rdp_tot_curr_active_conn was added, which keeps the record of number of active connections in use. It can be viewed as a part of nsconmsg command on NetScaler shell. Later, we will be providing a new CLI command to view this counters.

Connection Flow

There are two connections involved in the RDP Proxy flow. The first connection is the user’s SSL VPN connection to the Citrix Gateway VIP, and enumeration of the RDP resources.

The second connection is the native RDP client connection to the RDP listener (configures using rdppIP and rdppPort) on the Citrix Gateway, and subsequent proxying of the RDP client to server packets securely.
1. User connects to the Authenticator Gateway VIP and provides his/her credentials.

2. After successful login to the Gateway, user is redirected to the homepage/external portal which enumerates the remote desktop resources that the user can access.

3. Once the user selects a RDP resource, a request is received by the Authenticator Gateway VIP, in the format `https://AGVIP/rdpproxy/ip:port/rdptargetproxy` indicating the published resource that the user clicked. This request has the information about the IP and port of the RDP server that the user has selected.

4. The `/rdpproxy/` request is processed by the Authenticator Gateway. Since the user is already authenticated, this request comes with a valid Gateway cookie.

5. The RDPTarget and RDPUser information is stored on the STA server and a STA Ticket is generated. The information is stored as an XML blob which is optionally encrypted using the configured pre-shared key. If encrypted, the blob is base64 encoded and stored. The Authenticator Gateway will use one of the STA servers that is configured on the Gateway Vserver.

6. The XML blob will be in the following format

   ```
   <Value name="IPAddress">ipaddr</Value>
   <Value name="Port">port</Value>
   <Value name="Username">username</Value>
   <Value name="Password">pwd</Value>
   ```

7. The “rdptargetproxy” obtained in the `/rdpproxy/` request is put as the ‘fulladdress’ and the STA ticket (pre-pended with the STA AuthID) is put as the ‘loadbalanceinfo’ in the .rdp file.

8. The .rdp file is sent back to the client end-point.
9. The native RDP client launches and connects to the RDPListener Gateway. It sends the STA ticket in the initial x.224 packet.

10. The RDPListener Gateway validates the STA ticket and obtains the RDPTarget and RDPUser information. The STA server to be used is retrieved using the 'AuthID' present in the loadbalanceinfo.

11. A Gateway session is created for storing authorization/auditing policies. If a session already exists for the user, it is re-used.

12. The RDPListener Gateway connects to the RDPTarget and single signs on using CREDSSP.

**Single Gateway Compatibility**

If the RDP file is generated using the /rdpproxy/rdptarget/rdptargetproxy URL, we will generate a STA ticket, otherwise the current method of the ‘loadbalanceinfo’ referring to the session directly will be used.

In case of a single gateway deployment, the /rdpproxy URL comes to the Authenticator Gateway itself. A STA server is not required. The authenticator gateway encodes the RDPTarget and the AAA session cookie securely and sends this as the ‘loadbalanceinfo’ in the .rdp file. When the RDP Client sends this token in the x.224 packet, the authenticator gateway decodes the RDPTarget information, looks up the session and connects to the RDPTarget.
Upgrade Notes

Earlier configuration doesn't work with this new release, since the parameters rdpIP and rdpPort, which were earlier configured on vpn vserver has been updated to be part of the rdpServerProfile and ‘rdp Profile’ has been renamed as ‘rdp ClientProfile’ and the old parameter clientSSL has been removed.

Create RDP Server Profile

1. Go to Citrix Gateway > Policies > RDP.
2. Go to Server Profiles tab and click **Add**.

3. Enter the following information to create the RDP Server Profile.
Configure RDP Client Profile

1. Go to Citrix Gateway > Policies > RDP
2. Go to Client Profiles tab and click **Add**.
3. Enter the following information to configure the RDP Server Profile.

![Create RDP Client Profile](image)

**Setup a Virtual Server**

1. Go to Citrix Gateway > Virtual Server.
2. Click **Add** to create a new RDP Server.
3. Complete the data on this Basic Settings page and click OK.

4. Click the pencil to edit the page.
RDP connection redirection

May 27, 2019

A Citrix Gateway appliance now supports RDP connection redirection in presence of connection broker or session directory. An RDP proxy communication no longer requires an exclusive URL for every connection from client to the server. Instead, the proxy uses a single URL to connect to an RDP server farm, reducing the maintenance and configuration overhead for an administrator.

**Point to note:**

- RDP connection redirection is supported only when SSO is enabled and is supported in both single Gateway and Stateless or Dual Gateway mode along with enforcement (Smart Access).
- RDP Proxy feature is supported only with token-based redirection supporting IP cookies. IP-based routing tokens “msts=” are handed back by Windows session broker or Connection broker when “Use IP Address Redirection” functionality is disabled.
- Dedicated redirectors for RDP Proxy connection can be configured.
**Deploy RDPProxy in presence of connection broker**

RDPProxy in presence of connection broker can be deployed in the following two ways:

- With RD session host servers participating in RD connection broker load-balancing.
- In presence of RDP load-balancing feature.

**With RD session host servers participating in RD connection broker load balancing:**

In this case, the RDP URL link can be configured to point to one of the RDP server as destination server, which acts as redirector. Also, it is possible to have one of the RDP server in the farm as destination server. (In this case the server does not accept any RDP session). For more information, refer Load Balancing of Remote Desktop Protocol (RDP) Servers.

**In presence of RDP load-balancing feature:**

When connection broker load-balancing is not enabled, we can have RDP load-balancing feature available on Citrix ADC to do the required load-balancing of RDP sessions in presence of connection broker. In this case, the RDP URL link has to be configured to have RDP load-balancer as destination server. The RDP load-balancer can be on the same Citrix Gateway appliance as RDP-Proxy. For more information, refer Loading balancing rdp servers.

**Note:**

To support RDPProxy in presence of connection broker, RDP connection redirection should be enabled on Citrix Gateway.

**Configure RDPProxy in presence of connection broker**

**To configure RDP connection redirection by using the command line interface, at the command prompt, type:**

```
1  add rdpserverprofile <Name> -psk <string> -rdpRedirection ( ENABLE | DISABLE )
2
3  add rdpserverprofile serverProfileName -psk "secretString" - rdpRedirection ENABLE
```

**To configure RDP connection redirection by using Citrix ADC GUI:**

1. Navigate to **Citrix Gateway > Policies > RDP**.
2. Right click on **RDP** to **Enable** or **Disable** the RDP redirection functionality.
Populate RDP URLs based on LDAP attribute

April 1, 2020

You can configure a Citrix Gateway appliance to retrieve a list of RDP servers (IP/FQDN) from an LDAP server attribute. Based on the retrieved list, the appliance displays the RDP URLs for the servers that can be accessed by a user.

To populate RDP URLs based on LDAP attribute by using the CLI

At the command prompt, type:

```
1 add rdpclientprofile <Name> - rdpUrlLinkAttribute <string>
2 3 add rdpclientprofile clientProfileName - rdpUrlLinkAttribute
   rdpServerAttribute
```

In the above example, rdpServerAttribute corresponds to rdp server details for a given user on LDAP server.

**Note:** To fetch the LDAP attribute details from the LDAP server, the LDAP action must be configured with the same string that is configured with pUrlLinkAttribute as follows.

```
1 add authentication ldapAction dnpg_ldap -serverIP <IP address> - ldapBase
   "<domain name>" - ldapBindDn <username> - ldapLoginName
   sAMAccountName - ldapbindDnpassword <password>
2 3 add authentication ldapAction dnpg_ldap -serverIP 10.102.39.101 -
   ldapBase "dc=dnpg-blr,dc=com" - ldapBindDn sqladmin@dnpg-blr.com -
   ldapLoginName sAMAccountName - ldapbindDnpassword xxxx
4 5 add authentication ldapPolicy dnpg_ldap_pol ns_true dnpg_ldap
6 7 bind vpn vs vserver<name> -pol dnpg_ldap_pol
8 9 set ldapaction dnpg_ldap -attributes "rdpServerAttribute"
10 11 set rdpclientprofile ldap - rdpLinkAttribute rdpServerAttribute
```

LDAP server configuration

On the LDAP server, perform the following steps:
1. Navigate to a particular User.
2. In AD users and computers, click View, and click Detail.
3. Right-click user name and click Attribute Editor.
4. Change the required attribute (displayName) value and click OK.

To populate RDP URLs based on LDAP attribute by using the GUI

1. Navigate to Citrix Gateway > Policies > RDP.
2. On the RDP Profiles and Connections page, click the Client Profiles tab and select the client profile where you want to configure RDP link attribute.
3. In the Configure RDP Client Profile page, in RDP Link Attribute, enter the LDAP attribute name.

Randomize RDP file name with RDP proxy

April 23, 2019

When you click on an RDP URL, an RDP file is downloaded. Upon clicking the RDP URL again a new RDP file with the same name is downloaded, resulting in a pop-up for the replacement of the new file with the existing file. To avoid this, administrator can opt for randomizing the rdp filename. The file name is now randomized by appending output of time () function in the format <rdpFileName>_<outputof time()>.rdp. By doing this, the appliance generates a unique RDP file name every time you download a file.

Configure support for randomizing RDP file name with RDP proxy

To configure support for randomizing RDP file name with RDP proxy by using the command line interface at the command prompt, type:

```
1   add rdpclientprofile <profileName> -rdpfileName <filename> -randomizeRDPFilename <YES/NO>
2   add rdpclientprofile clientProfileName -rdpfileName testRDP -randomizeRDPFilename YES
```

To configure support for randomizing RDP file name with RDP proxy by using Citrix ADC GUI:

1. Navigate to Citrix Gateway > Policies > RDP.
2. On the RDP Profiles and Connections page, click Client Profiles tab and select the client profile where you want to configure randomizing RDP file name functionality.
3. On the **Configure RDP Client Profile** page, select **YES** in the drop-down next to **Randomized RDP Filename** field.

**Configure the file name for RDP apps**

May 13, 2019

Upon downloading an RDP app the app can be stored locally with the configured file name.

**Configure file name for RDP apps**

To configure file name for RDP apps using CLI, at the command prompt, type:

```
set rdpclientprofile <Name> -rdpfilename <filename>.rdp
```

To configure file name for RDP apps using GUI:

1. Navigate to **Citrix Gateway > Policies > RDP**.
2. On the **RDP Profiles and Connections** page, click **Client Profiles** tab. Select the client profile where you want to configure randomizing RDP file name functionality.
3. On the **Configure RDP Client Profile** page, enter a name for the rdp profile in the **RDP File Name** field. The name of the file must be in the following format, . A maximum of 31 characters are allowed for the name.

**Citrix Gateway Enabled PCoIP Proxy Support for VMware Horizon View**

April 23, 2019

Citrix Gateway 12.0 supports the PC-over-IP (PCoIP) protocol, which is the remote display protocol for several non-Citrix VDI solutions, including VMware Horizon View. PCoIP is analogous to Citrix HDX/ICA protocol and Microsoft RDP protocol. PCoIP uses UDP port 4172.

When PCoIP is proxied through Citrix Gateway, Citrix Gateway can replace the traditional PCoIP remote access solutions, like View Security Server, or VMware Access Point.

The following scenarios illustrate the use of Citrix Gateway enabled VMWare Horizon View Solution.
VMware Horizon PCoIP users needing to remotely access VMware Horizon View desktop pools and application pools through the Citrix Gateway without deploying a Horizon View Security Server or VMware Access Point.

- PCoIP users remotely accessing other PCoIP-based virtual desktop solutions through Citrix Gateway.

**Note**

Citrix Gateway is deployed as a remote access solution.

### Configuring Citrix Gateway Enabled PCoIP proxy for VMware Horizon View

April 23, 2019

**Prerequisites**

**Version** - Citrix ADC 12.0 or above

**Universal License** - PCoIP Proxy uses the Clientless Access feature of Citrix Gateway, which means every Citrix Gateway connection must be licensed for Citrix Gateway Universal. On the Citrix Gateway Virtual Server, ensure **ICA Only** is unchecked.

**Horizon View infrastructure** - A functional internal Horizon View infrastructure. Ensure you are able to connect to Horizon View Agents internally without Citrix Gateway. Ensure that the Horizon View **HTTP(S) Secure Tunnel** and **PCoIP Secure Gateway** are not enabled on the View Connection Servers that Citrix ADC will proxy connections to.

Following versions of VMware Horizon View are supported.

- Connection Server: 7.0.1 and above
- Horizon Client: 4.2.0 and above (Windows and Mac)

**Firewall Ports:**

Ensure the following:

- UDP 4172 and TCP 443 must be open from Horizon View Clients to the Citrix Gateway VIP.
- UDP 4172 must be open from the Citrix ADC SNIP to all internal Horizon View Agents.
- PCoIP Proxy is supported on Citrix ADC deployed behind NAT. Following are the important points to consider:
  - Support is based on VPN vServer FQDN parameter setting
  - Supports only publicly accessible FQDN and not IP
Certified Gateway 13.0

- Supports only 443 and 4172 ports
- Must be a static NAT


Authentication – An LDAP authentication policy/server using Classic Syntax.

Unified Gateway (optional) – If Unified Gateway, create the Unified Gateway before adding PCoIP functionality.

RfWebUI Portal Theme – For web browser access to Horizon View, the Citrix Gateway Virtual Server must be configured with RfWebUI theme.

Horizon View Client – The Horizon View Client must be installed on the client device, even if accessing Horizon published icons using the Citrix ADC RfWebUI portal.

To configure Citrix Gateway to support PCoIP proxy for VMWare Horizon View:

1. In the Citrix ADC management GUI, navigate to Configuration> Citrix Gateway> Policies> PCoIP.
2. Create a VServer profile and a PCoIP profile on the PCoIP Profiles and Connections page.
3. To create a VServer profile, on the VServer Profiles tab, click Add.
   a. Enter a name for the VServer profile.
   b. Enter an Active Directory Domain Name that will be used for Single Sign-on to View Connection Server, and then click Create.
   c. Click Login.
4. To create a PCoIP profile, on the Profiles tab, click Add.
   a. Enter a name for the PCoIP profile.
   b. Enter the connection URL for the internal VMware Horizon View Connection Server, and then click Create.

   Note: Only a single Active Directory domain is supported per Citrix Gateway Virtual Server. Also, the domain name specified here is displayed in the Horizon View Client.
   c. Click Login.
6. On the right, select the Session Profiles tab.
7. On the Citrix Gateway Session Policies and Profiles page, create or edit a Citrix Gateway Session Profile.
   a. To create a Citrix Gateway session profile, click Add, and provide a name.
   b. To edit a Citrix Gateway session profile, select the profile, and click Edit.
8. On the Client Experience tab, ensure that the Clientless Access value is set to On.
9. On the **Security** tab, ensure that the **Default Authorization Action** value is set to **ALLOW**.

10. On the **PCoIP** tab, select the required PCoIP profile, and then click **Create**. You can also create or edit PCoIP Profiles from this tab.

11. Click **Create** or **OK** to finish creating or editing the Session Profile.

12. If you created a new Session Profile, then you must also create a corresponding Session Policy.
   a. Navigate to **Configuration> Citrix Gateway> Policies> Session**.
   b. On the right, select the **Session Policies** tab.
   c. Click **Add**, provide a name for the Session Policy, and select the required session profile name from the **Profile** drop-down.
   d. If you wish to create the Session Policy using Default Syntax, in the Expression area, type “true” (without the quotes), and then click on **Create**. Note: Unified Gateway defaults to Classic Syntax.
   e. If you wish to create the Session Policy using Classic Syntax, first click on **Switch to Classic Syntax**. Then in the Expression area, type “ns_true” (without the quotes), and then click on **Create**.

13. Bind the created PCoIP VServer profile and session policy to a Citrix Gateway Virtual Server.
   a. Go to **Citrix Gateway > Virtual Servers**.
   b. On the right, either **Add** a new Citrix Gateway Virtual Server, or **Edit** an existing Citrix Gateway Virtual Server.
   c. If you are editing an existing Citrix Gateway Virtual Server, in the **Basic Settings** section, click the pencil icon.
   d. For both adding and editing, in the **Basic Settings** section, click **More**.
   e. Use the **PCoIP VServer Profile** drop-down to select the required PCoIP VServer Profile.
   f. Scroll down and ensure that ICA Only is unchecked. Then click **OK** to close the **Basic Settings** section.
   g. If you are creating a new Citrix Gateway Virtual Server, bind a **certificate**, and bind an LDAP authentication policy.
   h. Scroll down to the **Policies** section and click on the plus icon.
   i. The **Choose Type** page defaults to **Session** and **Request**. Click **Continue**.
   j. In the **Policy Binding** section, click on **Click to select**.
   k. Select the required Session Policy that has the PCoIP Profile configured, and click on **Select**.
   l. In the **Policy Binding** page, click **Bind**.
If you want to use a web browser to connect to VMware Horizon View, then on the right, under **Advanced Settings**, add the **Portal Themes** section. If you are only using Horizon View Client to connect to Citrix Gateway, then you don’t need to perform this step.

n. Use the **Portal Theme** drop-down to select **RfWebUI** and click **OK**.

o. Horizon View published icons are added to the RfWebUI portal.

**Steps to enable USB redirection**

USB devices connected to the client machine can be accessed from the virtual desktops and apps. Following are the steps to enable USB redirection:

1. Login to VMware Horizon Administrator Console.
2. Navigate to **Inventory –> View Configuration –> Servers**.
3. Select the **Connection Servers** tab.
4. Select a listed Connection Server and Click **Edit**.
5. Under the **General** tab, select **Use Secure Tunnel connection to machine** option under **HTTP(S) Secure Tunnel**. Provide NSG external URL in the **External URL** field.

**Update Content Switching Expression for Unified Gateway**

If your Citrix Gateway Virtual Server is behind a Unified Gateway (Content Switching Virtual Server), then you must update the Content Switching Expression to include the PCoIP URL paths.

1. In the Citrix ADC GUI, navigate to **Configuration> Traffic Management > Content Switching > Policies**.
2. Append the following expression under the **Expression** area, and then click **OK**.

   | http.req.url | http.req.url | http.req.url.path.contains("/pcoip-client") | http.req.url.path.contains("/ice-tunnel") |

**Use PCoIP Gateway**

1. To connect, you must have Horizon View Client installed on the client device. Once installed, you can either use the Horizon View Client’s User Interface to connect to Citrix Gateway, or you can use the Citrix Gateway RfWebUI portal page to view the icons published from Horizon.
2. To view the active PCoIP connections, go to **Citrix Gateway > PCoIP**.
3. On the right, switch to the **Connections** tab. The active sessions are displayed with the following data: user name, Horizon View Client IP, and Horizon View Agent Destination IP.
4. To terminate a connection, right-click on connection tab and click **Kill Connection**. Or click **Kill All Connections** to terminate all PCoIP connections.

**Configuring VMware Horizon View Connection Server**

April 23, 2019

To support PCoIP Proxy through Citrix Gateway:

1. Login to **VMware Horizon Administrator Console**.
2. Navigate to **Inventory –> View Configuration –> Servers**.
3. Select **Connection Servers** tab.
4. Select a listed Connection Server and Click **Edit**.
5. Under **General** tab, deselect **Use Secure Tunnel connection to machine** option under HTTP(S) Secure Tunnel.
6. Click **OK** to close the **Edit Connection Server Settings** window.
7. Run through Steps from 4 to 6 on all listed Connection Servers.

**HDX enlightened data transport support**

February 13, 2020

Enlightened Data Transport (EDT) support for Citrix Gateway ensures a high definition in-session user experience of virtual desktops for users running Citrix Workspace app.

Also, end-to-end encryption with DTLS 1.0 for EDT termination between Citrix Workspace app and VDA is facilitated. For more information on DTLS configuration, click **Support for DTLSv1.0 protocol**.

EDT enabled Citrix Gateway delivers a good user experience on both LAN and WAN conditions, without any administrative or user configuration when roaming from one to the other. The benefit is most visible in high-latency networks with moderate packet loss, where user experience would generally lag with alternatives.

**Support for DTLS 1.2 protocol**

From release 13.0 build 47.x, DTLS 1.2 protocol is supported on the Citrix ADC VPX appliance. You can enable or disable DTLS 1.2 using the **enable_dtls12_vpn_vserver** nsapimgr knob on the VPN virtual
server VPX appliance.

By default, DTLS 1.2 is disabled and the `enable_dtls12_vpn_vserver` knob is set to 0.

To enable DTLS 1.2, set the `enable_dtls12_vpn_vserver` knob to 1. After you change the knob value, switch off DTLS and switch it on again using the `set vpn vserver <servername> dtls <ON/OFF>` command for the knob to take effect.

**Important:** After you upgrade to 13.0 build 47.x or later, it is recommended to enable DTLS 1.2 using `nsapimgr` command if you have enabled DTLS and used only TLSv1.2 ciphers in earlier release builds.

## When to Use Enlightened Data Transport Support

**April 23, 2019**

The following scenarios illustrate the use of EDT enabled Citrix Gateway.

- A user wants an experience as good as in a LAN environment while remotely accessing business resources.
- A user wants a rich virtual application and desktop user experience on Wi-Fi and cellular networks where network quality is poor because of congestion, high packet loss, and high latency.

The following points are to be kept in mind while using EDT.

- The DTLS knob at the virtual server level is enabled by default.
- SNI with DTLS is not supported.
- IPv6 with DTLS is not supported.
- Smart control policies and ICA policies do not work if DTLS is enabled.
- Also, the appliance can now be configured for Double-hop functionality for EDT traffic between Receiver and VDA. For more information, click [Deploying in a Double-Hop DMZ](#).

**Note:** EDT is supported on the MPX FIPS platform in release 12.1 build 49.xx and later. On the Intel Coleto SSL chip based MPX devices, EDT is supported from release 12.1 build 51.16 and later.

## Configure Citrix Gateway to support Enlightened Data Transport and HDX Insight

**March 12, 2020**
EDT traffic through Gateway now has end-to-end visibility. Availability of both real-time and historical visibility data enables Citrix ADM to support a wide variety of use cases.

The following scenarios are supported:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>EDT support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Gateway</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway with High Availability (HA)</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway with High Availability (HA) optimization</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix ADC with Unified Gateway</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway with GSLB</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway with Cluster</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Workspace app to Citrix Gateway DTLS encryption</td>
<td>Yes</td>
</tr>
<tr>
<td>Dual Secure Ticket Authority (STA) on Citrix Gateway</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway ICA session timeout</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway Multi-Stream ICA</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway session reliability (Port 2598)</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway Double-Hop</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix ADC to VDA DTLS encryption</td>
<td>Yes</td>
</tr>
<tr>
<td>HDX Insight</td>
<td>Yes</td>
</tr>
<tr>
<td>Citrix Gateway in IPv6 mode</td>
<td>No</td>
</tr>
<tr>
<td>Citrix Gateway SOCKS (Port 1494)</td>
<td>No</td>
</tr>
<tr>
<td>Citrix ADC pure LAN proxy</td>
<td>No</td>
</tr>
</tbody>
</table>

**Configure Citrix Gateway to support Enlightened Data Transport**

If you use Enlightened Data Transport (EDT), Datagram Transport Layer Security (DTLS) must be enabled to encrypt the UDP connection used by EDT. The DTLS parameter must be enabled at the Gateway VPN virtual-server level. Also, Citrix Virtual Apps and Desktops components must be correctly upgraded and configured to achieve encrypted traffic between the Gateway VPN virtual server and the user device.
Note: UDP port (for example port 443) configured for the Citrix Gateway front end virtual server must be opened in the DMZ for the virtual server to receive the DTLS connections. DTLS and CGP are prerequisites for EDT to work with Citrix Gateway.

To configure Citrix Gateway to support EDT using GUI

1. Deploy and configure Citrix Gateway to communicate with StoreFront and authenticate users for Citrix Virtual Apps and Desktops.

2. On the Configuration tab in the Citrix ADC GUI, expand Citrix Gateway and select Virtual Servers.

3. Click Edit to display Basic Settings for the VPN Virtual Server, and then verify the state of the DTLS setting.
4. Click **More** to display other configuration options.
5. Select **DTLS** to provide communications security for datagram protocols. Click **OK**. The **Basic Settings** area for the VPN virtual server shows that the DTLS flag is set to **True**.

![Basic Settings for DTLS]

To configure Citrix Gateway for EDT support using CLI

```
set vpn vserver vs1 -DTLS ON
```

Configure Citrix Gateway to support HDX Insight

HDX Insight provides end-to-end visibility for HDX traffic to virtual apps and desktops passing through Citrix ADC. It also enables administrators to view real-time client and network latency metrics, historical reports, end-to-end performance data, and troubleshoot performance issues.

To configure Citrix Gateway to support HDX Insight using GUI

1. On the **Configuration** tab navigate to **System> AppFlow>Collectors**, and click **Add**.

![AppFlow Collectors]

2. On the **Create AppFlow Collector** page, populate the following fields and click Create.
   - **Name** – Name for the collector
   - **IP address** – IPv4 address of the collector
   - **Port** – Port on which the collector listens
   - **Net Profile** - Netprofile to associate with the collector. The IP address defined in the profile is used as the source IP address for AppFlow traffic for this collector. If you do not set this parameter, the Citrix ADC IP (NSIP) address is used as the source IP address.
Transport – Transport type of collector.


4. On the Create AppFlow Action page, populate the following fields, and click Create.
   AppFlow Action Name – Name for the action
   Comment – Any comment about the action
   Collector – Select the names of collectors to be associated with the AppFlow action.
Transaction Log – Transactions type to be logged.

Create AppFlow Action

6. On the **Create AppFlow Policy** page, populate the following fields, and click **Create**.

   Name – Name for the policy.

   Action – Name of the action to be associated with the policy.

   UNDEF - Name of the AppFlow action to be associated with this policy when an undefined event occurs.

   Expression - Expression or other value against which the traffic is evaluated. Must be a Boolean expression.

   Comments – Any comments about this policy.
7. Navigate to Citrix Gateway>Virtual Servers, select the virtual server and click Edit.

8. Scroll down the VPN Virtual Server page and under Policies section, click +.

9. On the Choose Type screen, in the Choose Policy drop-down menu, select AppFlow. In the Choose Type drop-down menu, choose Request or ICA Request and click Continue.

10. Click the highlighted arrow under Select Policy.
11. Select the **AppFlow policy** and click **Select**.

12. Finally click **Bind**.

**To configure Citrix Gateway for HDX Insight support using CLI, type the following command**

```bash
add appflow collector col3 -IPAddress<ip_mas>
```
Disable HDX Insight for non-NSAP HDX session

In a Citrix ADC appliance, you can now disable HDX Insight for the non-NSAP HDX sessions.

At the command prompt, type:

```
set ica parameter HDXInsightNonNSAP (YES | NO )
```

By default, HDX Insight for non-NSAP session is enabled.

L7 Latency Thresholding

April 17, 2020

The L7 latency thresholding feature in HDX Insight actively detects end-to-end network latency issues at the application level and takes proactive actions. The L7 latency thresholding feature performs live latency monitoring to detect the spikes and sends out notifications to the Insight Center if the latency exceeds the minimum observed latency.

Previously, average client side and server side L7 latency values were sent every 60 sec to the Insight Center. Any spikes seen within this interval were averaged out and hence remained undetected. Also, there was no live latency monitoring to detect these spikes.

How L7 latency is different from L4 latency

Network latencies are captured and displayed at the L4 level as well. These latencies are calculated from the TCP layer and do not require parsing of the ICA traffic. Therefore, they are relatively easy to obtain and are less CPU intensive. However, the major drawback of L4 latency is understanding end-to-end latency. If there are TCP proxies in the path, the L4 latency captures only the latency from the Citrix ADC to the TCP proxy. This might result in incomplete information and hence result in difficulties in debugging the issue.

L7 latency is calculated by parsing ICA traffic. L7 latency calculation is done at the ICA layer, and therefore intermediate proxies do not result in incomplete latency values. Thus, provides end-to-end latency detection.
The following figures display a deployment type with and without TCP proxies.

![Deployment Type Diagram](image)

**Difference between ICA RTT and L7 latency calculations**

ICA RTT represents the total round trip time from the Citrix Workspace app to Virtual Delivery Agent (VDA). L7 latency provides granular details regarding latencies on the client side and the server side. L7 client latency is the latency between Citrix Workspace app to Citrix Gateway. L7 Server latency is the latency between Citrix Gateway to VDA.

**Note:** Server side L7 latency calculation for the server is supported only for the Citrix Virtual Apps and Desktops versions 7.13 and later.

**Configure L7 latency thresholding using the CLI**

1. Add an ICA latency profile.
   ```bash
   add ica latencyprofile <name> [-l7LatencyMonitoring ( ENABLED | DISABLED )] [-l7LatencyThresholdFactor <positive_integer>] [-l7LatencyWaitTime <positive_integer>] [-l7LatencyNotifyInterval <positive_integer>] [-l7LatencyMaxNotifyCount <positive_integer>]
   ```

2. Add an ICA action.
   ```bash
   add ica action <name> [-latencyprofileName <string>]
   ```

3. Add an ICA policy.
4. Bind ICA policy to the VPN server or to ICA global bind point.

```
1 add ica policy <name> -rule <expression> -action <string> [-
    comment<string>] [-logAction <string>]
```

Or

```
1 bind ica global -policyName <string> -priority <positive_integer>
    [-gotoPriorityExpression <expression>] [-type (
    ICA_REQ_OVERRIDE | ICA_REQ_DEFAULT )]
```

Or

```
1 bind vpn vserver <name> -policy <string> [-priority <
    positive_integer>]
```

Or

```
1 bind cr vserver <name> -policy <string> [-priority <positive
    _integer>]
```

Arguments

- **Latency Monitoring**: Parameter to enable or disable L7 threshold monitoring. When this parameter is enabled, notifications are sent to the Insight Center when the set conditions are met.
  
  Default value: DISABLED

- **LatencyThresholdFactor**: Factor by which the active latency must be greater than the minimum observed latency to conclude that the threshold is exceeded and therefore notification must be sent to the Insight Center.
  
  Default value: 4
  
  Minimum value: 2
  
  Maximum value: 65535

- **LatencyWaitTime**: Time in seconds for the appliance to wait after the latency threshold is exceeded to send notification to the Insight Center.
  
  Default value: 20
  
  Minimum value: 1
  
  Maximum value: 65535

- **LatencyNotifyInterval**: Time interval in seconds for the appliance to send subsequent notifications to the Insight Center after the wait time has passed.
Default value: 20
Minimum value: 1
Maximum value: 65535

- **LatencyMaxNotifyCount**: Maximum number of notifications that can be sent to the Insight Center within an interval where the latency is above the threshold.
  
  Default value: 5

**Configure L7 latency thresholding using the GUI**

1. Navigate to **Configuration > NetScaler Gateway > Policies > ICA**.
2. Select **ICA Latency Profiles** tab and click **Add**.
3. In the **Create ICA Latency Profile** page, perform the following.
• Select **L7 Latency Monitoring** to enable L7 Threshold monitoring.

• In **L7 Threshold Factor**, enter the value by which the active latency must exceed the minimum observed latency to send notification to the Insight Center.

• In **L7 Latency Wait Time**, enter the time in seconds for the appliance to wait after the threshold is exceeded to send out notification to the Insight Center.

• In **L7 Latency Notify Interval**, enter the time in seconds for the appliance to send subsequent notifications to the Insight Center after the wait time has passed.

• In **L7 Latency Maximum Notify Count**, enter the maximum number of notifications that can be sent to the Insight Center within an interval where the latency is above the thresh-
4. Click **Create**.

**L7 Latency measurement model versus L7 latency threshold reporting model**

**L7 Latency measurement model**

In L7 latency measurement module, average client side and server side L7 latency values are sent to the Insight Center every 60 seconds. As a result, spikes seen within this interval are averaged out and hence remain undetected. Also, L7 latency measurement module does not have the live latency monitoring capability.

The following figure illustrates a sample L7 latency measurement model.

![L7 Latency Measurement Model](image)

**L7 latency threshold reporting model**

The L7 latency threshold reporting model has the live latency monitoring capability to detect spikes. Notifications are sent to the Insight Center if the latency exceeds the minimum observed latency.

Whenever a threshold factor is exceeded, latency increase is detected. After the configured threshold wait time expires, a notification is sent to the Insight Center. A subsequent notification is sent to the
Insight Center after the wait time has expired and the threshold factor is still exceeded. In case the latency value falls below the threshold factor before the wait time expires, no notification is sent to the Insight Center.

The following figure illustrates a sample L7 latency threshold reporting model.

The following parameters can be configured at run time:

- Threshold monitoring (ON/OFF)
- Threshold factor
- Threshold wait time
- Notification interval
- Maximum notification count

**Microsoft Intune Integration**

November 29, 2019

The integration of Microsoft Intune with Citrix Gateway provides best-of-class application access and data protection solution offered by Citrix Gateway and Intune.

You get the most complete suite of secure productivity apps, including email, calendar, contacts, note-taking, document editing, and remote access—all which can be centrally managed across different platforms. Intune and Citrix Gateway integration provides world-class mobile device management (MDM) functionalities, while the Citrix Gateway client side technology empowers these Intune enlightened applications to access corporate data and application securely through the Citrix Gateway.
The integration allows Citrix Gateway to pull compliance data from Intune, enabling conditional access policies. The conditional access policies give Citrix Gateway a finer control on regulating the access based on device functionalities and so on. For example, an administrator can create a policy wherein only the devices with “Camera” disabled are granted access.

Citrix Gateway supports Azure Active Directory Libraries (ADAL) token authentication once the Citrix Gateway virtual server is configured. Upon configuration, a mobile application wrapped with the Citrix Network-Only wrapper or SDK accesses Citrix Gateway by using an ADAL token that the app can fetch directly from AAD.

**Citrix micro VPN integration with Microsoft Endpoint Manager**

Citrix Gateway customers can use micro VPN with Microsoft Endpoint Manager (Intune). Citrix micro VPN integration with Microsoft Endpoint Management enables your apps to access on-premises resources.

Citrix micro VPN technology provides an on-demand VPN that reduces data transfer costs and simplifies security, as the VPN tunnel isn’t always active. Instead, it’s only active when needed, which reduces risk and optimizes the performance of the device for a better user experience. This also helps improve mobile battery life. The micro VPN technology from Citrix provides mobile users with secure access to internal business resources while providing them with the best user experience.

Micro VPN is supported only for following use cases:

- Intune mobile application management (MAM) only
- Intune mobile device management (MDM) and mobile application management (MAM)

**Important:**

- Citrix Gateway customers have the entitlement to use micro VPN with Microsoft Endpoint Manager at no additional costs until January 2021.
- Micro VPN requires a Citrix Gateway Advanced or Premium edition (VPX 3000 or higher) for SSL VPN functionality.

For details about setting up Citrix micro VPN integration with Microsoft Endpoint Manager, see [Set up Citrix Gateway for using micro VPN with Microsoft Endpoint Manager](#).

**When to Use the Integrated Intune MDM Solution**

April 23, 2019

The following scenarios illustrate the use of the integrated Intune MDM Solution:
A new customer decides to onboard Intune with on-prem Citrix Gateway deployment
An existing Citrix Gateway user wants to add mobile device management with Intune
An existing Intune user wants to allow mobile device and/or applications to access data located inside company network with a Citrix Gateway physical or virtual appliance in the company DMZ

Note
Only iOS and Android clients are supported.

Understanding the Citrix Gateway-Intune MDM Integration

April 23, 2019
Following is an example of flow of events in a typical Citrix Gateway-Intune MDM integration:

1. Enroll a mobile device with Intune.
2. Corporate approved applications and device-policies are pushed to the device.
3. Browse SharePoint (on premise application) from the device.
4. The browser request goes to Citrix Gateway.
5. The Citrix Gateway appliance checks with Intune for the enrolment status of the device.
6. If a compliant device is enrolled successfully, the SharePoint access is granted.

NetScaler – MS Intune Integration

When a Conditional Access (CA) policy is not met by the device, Citrix Gateway VPN client displays an error message to the user with a link to a page hosted by Intune to enroll or remediate the device compliance status.

Note: Administrators must ensure the following while pushing the certificates to Intune so that the users can differentiate between the various certificates on their device.
• Certificates must have a subject summary.
• The subject summaries for different certificates must be distinct.

Configuring Network Access Control device check for Citrix Gateway virtual server for single factor login

February 28, 2020

Important

The following section lists steps to configure Intune with Citrix Gateway. For information on configuring Citrix Gateway application on the Azure portal to obtain Client ID, Client Secret, and Tenant ID, refer Azure product documentation.

Citrix ADC Advanced Edition license is required for the following functionality.

To add a Citrix Gateway Virtual Server with nFactor for Gateway deployment

1. Navigate to Virtual Servers under the Citrix Gateway tree node.

   ![NetScaler Gateway](image)

2. Click Add.

   ![NetScaler Gateway Virtual Servers](image)

3. Provide the required information in the Basic Settings area and click OK.
4. Select **Server Certificate**.

5. Select required server certificate and click **Bind**.

6. Click **Continue**.

7. Click **Continue**.

8. Click **Continue**.
9. Click the plus icon [+ ] next to Policies and select Session from the Choose Policy list and select Request from the Choose Type list and click Continue.

10. Click the plus icon [+ ] next to Select Policy.

11. On the Create NetScaler Gateway Session Policy page, provide name for the Session policy.

12. Click the plus icon [+ ] next to Profile and on the Create NetScaler Gateway Session Profile page, provide name for the Session profile.

13. On the Client Experience tab, click the check box next to Clientless Access and select Off from the list.

14. Click the check box next to Plug-in Type and select Windows/Mac OS X from the list.

15. Click Advanced Settings and select the check box next to Client Choices and set its value to ON.

16. On the Security tab, click the check box next to Default Authorization Action and select Allow from the list.

17. On the Published Applications tab, click the check box next to ICA Proxy and select OFF from the list.

18. Click Create.

19. Enter NS_TRUE under Expression area on the Create NetScaler Gateway Session Policy page.

20. Click Create.

21. Click Bind.

22. Select Authentication Profile in Advanced Settings.

23. Click the plus icon [+ ] and provide a name for the Authentication Profile.
24. Click the plus icon [+] to create an authentication virtual server.

25. Specify name and IP address type for authentication virtual server under Basic Settings area and click OK. The IP address type can be Non Addressable as well.

26. Click Authentication Policy.

27. Under Policy Binding view, click the plus icon [+] to create an authentication policy.
28. Select **OAUTH** as an **Action Type** and click the plus icon [+] to create OAuth action for NAC.

29. Create OAuth action using **Client ID**, **Client Secret**, and **Tenant ID**.

   **Client ID**, **Client Secret** and **Tenant ID** are generated after configuring Citrix Gateway application on Azure portal.

   Ensure that you have appropriate DNS name server configured on your appliance to resolve and reach [https://login.microsoftonline.com/](https://login.microsoftonline.com/), [https://graph.windows.net/](https://graph.windows.net/), and *[.*manage.microsoft.com](https://*.manage.microsoft.com).
30. Create authentication policy for **OAuth Action**.

**Rule:**

```
http.req.header("User-Agent").contains("NAC/1.0")
&&
((http.req.header("User-Agent").contains("iOS")
&&
http.req.header("User-Agent").contains("NSGiOSplug"))

(http.req.header("User-Agent").contains("Android")
&&
http.req.header("User-Agent").contains("CitrixVPN"))
```
31. Click the plus icon [+] to create nextFactor policy label.

32. Click the plus icon [+] to create a login schema.
33. Select noschema as an authentication schema and click Create.

34. After selecting the created login schema, click Continue.
35. In Select Policy, select an existing authentication policy for user login or click the plus icon + to create an authentication policy. For details on creating an authentication policy, see Configuring advanced authentication policies.

36. Click Bind.
<table>
<thead>
<tr>
<th>Priority</th>
<th>Policy Name</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>ldap_policy_for_NAC</td>
<td>true</td>
</tr>
</tbody>
</table>

37. Click **Done**.

38. Click **Bind**.
39. Click **Continue**.

**Authentication Virtual Server**

**Basic Settings**

- **Name**: auth_vs_for_NAC
- **Authentication Domain**: -
- **IP Address**: 0.0.0.0
- **Port**: 0

**Advanced Authentication Policies**

- **1 Authentication Policy**
- **No** SAML IDP Policy

40. Click **Done**.
41. Click **Create**.

**Create Authentication Profile**

Name*
authn_profile_for_NAC

Authentication Virtual Server*
auth_vs_for_NAC

42. Click **OK**.

**Authentication Profile**

**Authentication Profile**
authn_profile_for_NAC

43. Click **Done**.

**Authentication Profile**

Authentication Profile authn_profile_for_NAC

Done
To bind authentication login schema to authentication virtual server to indicate VPN plug-ins to send device ID as part of /cgi/login request


![Virtual Server Configuration](image1)

2. Select the previously selected virtual-server and click Edit.

![Virtual Server Details](image2)

3. Click Login Schemas under Advanced Settings.

![Advanced Settings](image3)

4. Click Login Schemas to bind.

![Login Schemas](image4)

5. Click [>] to select and bind the existing build in login schema policies for NAC device check.
6. Select required login schema policy appropriate for your authentication deployment and click **Select**.

In the above explained deployment, single factor authentication (LDAP) along with NAC OAuth Action policy is used, hence `lschema_single_factor_deviceid` has been selected.

7. Click **Bind**.

8. Click **Done**.
Understanding Azure ADAL Token Authentication

April 23, 2019

Following is the flow of events in a typical Citrix Gateway-Microsoft ADAL token authentication:

1. When an app is launched in iOS or Android, the app contacts Azure. The user is prompted to log on with user credentials. After a successful logon, the app gets an ADAL token.

2. This ADAL token is presented to a Citrix Gateway, which has been configured to validate the ADAL token.

3. Citrix Gateway validates the signature of the ADAL token with the corresponding certificate from Microsoft.

4. After a successful validation, Citrix Gateway extracts the User’s Principal Name (UPN) and grants the app VPN access to the internal resources.

Configuring Citrix Gateway Virtual Server for Microsoft ADAL Token Authentication

April 23, 2019

To configure a Citrix Gateway virtual server for monitoring Microsoft ADAL token authentication, you need the following information:

- certEndpoint: URL of the endpoint that contains Json Web Key (JWK) for ADAL token verification.
- Audience: FQDN of the Citrix ADC virtual server to which the app sends the ADAL token.
- Issuer: Name of the AAD issuer. Gets populated by default.
- TenantID: Tenant ID for Azure ADAL registration.
- ClientID: A unique ID given to the Gateway app as part of ADAL registration.
- ClientSecret: A secret key given to the Gateway app as part of ADAL registration.
1. Create an OAuthAction:

```plaintext
add authentication OAuthAction <oauth_action_name>
-OAuthType INTUNE -clientid <client_id> -
clientsecret <client_secret>
-audience <audience>
-tenantid <tenantID>
-issuer <issuer_name> -
userNameField upn-certEndpoint <certEndpoint_name>
```

Example:

```plaintext
```

2. Create an authentication policy to associate with the newly created OAuth:

```plaintext
add authenticationPolicy <policy_name>
-rule true -action <oauth intune action>
```

Example:

```plaintext
add authenticationPolicy oauth_intune_pol -rule true -action tmp_action
```

3. Bind the newly created OAuth to AuthVS:

```plaintext
bind authentication vserver <auth_vserver>
-policy <oauth_intune_policy>
-priority 2 -gotoPriorityExpression END
```

Example:

```plaintext
bind authentication vserver auth_vs_for_gw1_intune -policy oauth_pol -priority 2 -gotoPriorityExpression END
```

4. Create a LoginSchema:

```plaintext
add authentication loginSchema <loginSchemaName>
-authenticationSchema <authenticationSchema"location">
add authentication loginSchemaPolicy <loginSchemaPolicyName>
-rule true -action <loginSchemaName>
```

Example:
add authentication loginSchema oauth_loginschema -authenticationSchema “/nsconfig/login-schema/LoginSchema/OnlyOAuthToken.xml”

add authentication loginSchemaPolicy oauth_loginschema_pol -rule true -action oauth_loginschema

5. Bind AuthVS with LoginSchema:

```
bind authentication vserver <auth_vs> -policy <oauth_pol> -priority 2 -gotoPriorityExpression END
```

Example:

bind authentication vserver auth_vs_for_gw1_intune -policy oauth_loginschema_pol -priority 2 -gotoPriorityExpression END

6. Add an authnprofile and assign it to a VPN virtual server:

```
add authnprofile <nfactor_profile_name> -authnvsName <authvserver>
```

```
set vpn vserver <vserverName> -authnprofile <nfactor_profile_name>
```

Example:

add authnprofile nfactor_prof_intune -authnvsName auth_vs_for_gw1_intune

set vpn vserver gw1_intune-authnprofile nfactor_prof_intune

---

Set up Citrix Gateway for using micro VPN with Microsoft Endpoint Manager

February 5, 2020

Citrix micro VPN integration with Microsoft Endpoint Management enables your apps to access on-premises resources. For details see, Citrix micro VPN integration with Microsoft Endpoint Manager.

System requirements

- Citrix Gateway version 12.0.59.x or 12.1.50.x or later.
  You can download the latest version of Citrix Gateway from the Citrix Gateway download page.
- A Windows desktop running Windows 7 or later (for Android app wrapping only)
- Microsoft
  - Azure AD access (with Tenant Admin privileges)
  - Intune-enabled tenant
Firewall rules

- Enable a firewall rule to SSL traffic from a Citrix Gateway subnet IP to *.manage.microsoft.com, https://login.microsoftonline.com, and https://graph.windows.net (port 443)
- Citrix Gateway must be able to externally resolve the preceding URLs.

Prerequisites

- **Intune environment**: If you don’t have an Intune environment, set up one. For instructions see the Microsoft documentation.
- **Edge Browser App**: The Micro VPN SDK is integrated within the Microsoft Edge app and Intune Managed Browser app for iOS and Android. For more information about the Managed Browser, see the Microsoft Managed Browser page.

Grant Azure Active Directory (AAD) application permissions

1. Consent to Citrix multitenant AAD application to allow Citrix Gateway to authenticate with AAD domain. The Azure Global Administrator must visit the following URL and consent:

2. Consent to Citrix multitenant AAD application to allow mobile applications to authenticate with the Citrix Gateway micro VPN. This link is only required if the Azure Global Admin has changed the default value for Users can register applications from Yes to No. This setting can be found in the Azure portal under **Azure Active Directory > Users > User Settings**.
   The Azure global administrator must visit the following URL and consent (add your Tenant ID) https://login.microsoftonline.com/%5Btenant_id%5D/adminconsent?client_id=9215b80e-186b43a1-8aed-9902264a5af7.

Configure Citrix Gateway for micro VPN

To use micro VPN with Intune, you must configure Citrix Gateway to authenticate to Azure AD. An existing Citrix Gateway virtual server does not work for this use case.

First, configure Azure AD to sync with the on-premises Active Directory. This step is necessary to ensure that authentication between Intune and Citrix Gateway occurs properly.

**Download script**: The .zip file includes a readme with instructions for implementing the script. You need to manually enter the information the scripts require and run the script on the Citrix Gateway to configure the service. You can download the script file from the Citrix Downloads page.
**Important:** After you have completed the Citrix Gateway configuration, and if you see the OAuth Status other than COMPLETE, see the Troubleshooting section.

### Configuring Microsoft Edge Browser

2. Publish the Edge App as you normally do and then add an app configuration policy.
3. Under Manage, click App configuration policies.
4. Click Add and then enter a name for the policy you want to create. For Device enrollment type, select Managed apps.
5. Click Associated App.
6. Select the apps to which you want to apply the policy (Microsoft Edge or Intune managed browser) and then click OK.
7. Click Configuration Settings.
8. In the Name field, enter the name of one of the policies listed in the following table.
9. In the Value field, enter the value you want to apply for that policy. Click off the field to add the policy to the list. You can add multiple policies.
10. Click OK and then click Add.

The policy is added to your list of policies.

<table>
<thead>
<tr>
<th>Name (iOS/Android)</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MvpnGatewayAddress</td>
<td><a href="https://external.">https://external.</a>companyname.com</td>
<td>External URL of your Citrix Gateway</td>
</tr>
<tr>
<td>MvpnNetworkAccess</td>
<td>MvpnNetworkAccessTunneledWebSSO or Unrestricted</td>
<td>MvpnNetworkAccessTunneledWebSSO is the default for tunneling</td>
</tr>
<tr>
<td>MvpnExcludeDomains</td>
<td>Comma-separated list of domain name to be excluded</td>
<td>Optional. Default=blank</td>
</tr>
</tbody>
</table>

**Note:** Web SSO is the name for Secure Browse in the settings. The behavior is the same.

- **MvpnNetworkAccess** - MvpnNetworkAccessTunneledWebSSO enables HTTP/HTTPS redirection through the Citrix Gateway, also known as Tunneled-Web SSO. The gateway responds to HTTP authentication challenges inline, providing a single-sign-on (SSO) experience. To use Web SSO, set this policy to **MvpnNetworkAccessTunneledWebSSO**. Full tunnel redirection is not supported currently. Use **Unrestricted** to leave micro VPN tunneling off.
- **MvpnExcludeDomains** - Comma-separated list of host or domain names to be excluded from being routed through the Citrix Gateway reverse web proxy. The host or domain names are...
excluded even though the Citrix Gateway configured split DNS settings might otherwise select
the domain or host.

Note: This policy is only enforced for MvpnNetworkAccessTunneledWebSSO connections. If MvpnNetworkAccess is Unrestricted, this policy is ignored.

**Troubleshooting**

**General issues**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The “Add Policy Required” message appears when you open an app</td>
<td>Add policies in the Microsoft Graph API</td>
</tr>
<tr>
<td>There are policy conflicts</td>
<td>Only a single policy per app is allowed</td>
</tr>
<tr>
<td>The “Failed to package app” message appears when wrapping an app. For the complete message, see below</td>
<td>The app is integrated with the Intune SDK. You do not need to wrap the app with the Intune</td>
</tr>
<tr>
<td>Your app can’t connect to internal resources</td>
<td>Ensure that the correct firewall ports are open, you correct tenant ID, and so on</td>
</tr>
</tbody>
</table>

**Failed to package app error message:**

Failed to package app. com.microsoft.intune.mam.apppackager.utils.AppPackagerException: This app already has the MAM SDK integrated.

com.microsoft.intune.mam.apppackager.PackagerMain.mainInternal(PackagerMain.java:198)
com.microsoft.intune.mam.apppackager.PackagerMain.main(PackagerMain.java:56)

The application cannot be wrapped.

**Citrix Gateway issues**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The permissions required to be configured for gateway app on Azure are unavailable.</td>
<td>Check if a proper Intune license is available. Try using the manage.windowsazure.com portal to see if the permission can be added. Contact Microsoft support if the issue persists.</td>
</tr>
</tbody>
</table>
## Issue Resolution

**Citrix Gateway cannot reach**

*login.microsoftonline.com* and *graph.windows.net.*  

From NS Shell, check if you are able to reach the following Microsoft website: `curl -v -k https://login.microsoftonline.com`. Then, check whether DNS is configured on Citrix Gateway. Also check that the firewall settings are correct (in case DNS requests are firewalled).

**An error appears in ns.log after you configure OAuthAction.**  

Check if Intune licensing is enabled and the Azure Gateway app has the proper permissions set.

**Sh OAuthAction command does not show OAuth status as complete.**  

Check the DNS settings and configured permissions on the Azure Gateway App.

**The Android or iOS device does not show the dual authentication prompt.**  

Check if the Dual Factor Device ID logonSchema is bound to the authentication virtual server.

## Citrix Gateway OAuth status and error condition

<table>
<thead>
<tr>
<th>Status</th>
<th>Error condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AADFORGRAPH</td>
<td>Invalid secret, URL not resolved, connection timeout</td>
</tr>
<tr>
<td>MDMINFO</td>
<td><em>manage.microsoft.com</em> is down or unreachable</td>
</tr>
<tr>
<td>GRAPH</td>
<td>Graph endpoint is down unreachable</td>
</tr>
<tr>
<td>CERTFETCH</td>
<td>Cannot talk to “Token Endpoint: <a href="https://login.microsoftonline.com%E2%80%9D">https://login.microsoftonline.com”</a> because of a DNS error. To validate this configuration, go to shell and type curl <a href="https://login.microsoftonline.com">https://login.microsoftonline.com</a>. This command must validate.</td>
</tr>
</tbody>
</table>

**Note:** When the OAuth status is successful, the status is displayed as COMPLETE.
Type of Service Support for UDP traffic

April 23, 2019

Type of Service (ToS) support for UDP ensures that once a ToS value is configured for a UDP packet by a sender, Citrix Gateway retains the value until the packet reaches its destination. On the basis of the configured value and the destination network's configuration, the destination network places the UDP packet in a prioritized outgoing queue.

**Note**
Using ToS information, you can assign a precedence to each IP packet and request a specific treatment such as high throughput, high reliability, low latency, and so on.

Proxy Auto Configuration for Outbound Proxy support for Citrix Gateway

April 23, 2019

When you configure the Citrix Gateway appliance to support Proxy Auto Configuration (PAC), the URL of a PAC file is pushed to the client browser. The traffic from the client is then redirected to the respective proxies as determined by the conditions defined in the PAC file.

Following are some common use cases for PAC for outbound proxy:

- To configure multiple proxy servers that handle client traffic.
- To load-balance the proxy traffic across subnets.

To use the command line interface to configure Citrix Gateway global parameters to support PAC for outbound proxy

At the command prompt, type:

```
set vpn parameter -proxy BROWSER -autoProxyUrl <URL>
```

To configure Citrix Gateway to support PAC in a session profile

At the command prompt, type:

```
add vpn sessionAction <name> -proxy BROWSER -autoProxyUrl <URL>
```

**Values**

- URL – URL for the proxy server
To use the Citrix ADC GUI to configure Citrix Gateway global parameters to support PAC for outbound proxy:

1. Navigate to Configuration > Citrix Gateway > Global Settings.
2. On the Global Settings page, click Change Global Settings, and then select the Client Experience tab.
3. On the Client Experience tab, select Advanced Settings, and then select the Proxy tab.
4. On the Proxy tab, select Browser, and then select Use Automatic Configuration.
5. In the URL To Auto Proxy Config File field, type the URL for the required PAC file.
6. Click Create.

To use the Citrix ADC GUI to configure Citrix Gateway to support PAC on Session Profile:

1. Navigate to Configuration > Citrix Gateway > Policies > Session.

To create a Citrix Gateway session profile, select the Session Profiles tab, click Add, and enter a name.

1. On the Client Experience tab, select Advanced Settings and then select the Proxy tab.
2. On the Proxy tab, select Browser, and then select Use Automatic Configuration.
3. In the URL To Auto Proxy Config File field, type the URL for the required PAC file.
4. Click Create.

Outbound ICA Proxy support

January 21, 2020

Outbound ICA Proxy support for Citrix Gateway enables the network administrators to avail SmartControl functionalities even when Receiver and Citrix Gateway are deployed in different organizations.

The following scenario illustrates the use of the Outbound ICA Proxy solution:

A network administrator requires control over the ICA session related capabilities when Receiver and Citrix Gateway are deployed in different organizations.

Understanding the Outbound ICA Proxy support

To bring the SmartControl functionality to the enterprise organization, company A, which has the receiver, we need to add a Citrix ADC appliance which acts as a LAN Proxy. The Citrix ADC LAN Proxy enforces SmartControl and proxies the traffic to the Citrix Gateway of Company B. In this deployment...
scenario, the Receiver forwards the traffic to the Citrix ADC LAN Proxy which allows the network administrator of Company A to enforce SmartControl. The deployment is depicted in the following figure.

In this scenario, the traffic between the LAN Proxy and the Citrix Gateway is over SSL.

**Note**
Client certificate based authentication must not be enabled on the Citrix Gateway.

**SSL support on Citrix ADC LAN proxy**

From release 13.0 build xx.xx, traffic between Citrix Workspace app and Citrix ADC LAN proxy is supported over SSL as well. The Citrix Workspace app encrypts the traffic it sends to LAN Proxy over SSL. SSL support on LAN proxy can co-exist with the existing deployment.

To enable traffic encryption over SSL between Citrix Workspace app and Citrix ADC LAN proxy, you must perform the following on the Citrix ADC LAN proxy:

- Disable authentication and enable double-hop on the VPN virtual server.
- Set the host on the Windows client to the IP address of the VPN virtual server.
- Enable SNI and certificate validation.
- Add appropriate CA certificates and enable them globally.

**Configuring outbound ICA Proxy**

January 23, 2020
Outbound ICA Proxy configuration involves configuring the Citrix ADC LAN proxy and Citrix Gateway.

**Configure Citrix ADC LAN Proxy for ICA outbound proxy**

You can perform the following steps to configure outbound ICA Proxy by using the CLI.

- Add a VPN virtual server.
  ```bash
  add vpn vserver <name> <serviceType> [IPAddress] [-range <positive_integer>] [-ipset <string>] [port] [-state (ENABLED | DISABLED)] [-authentication (ON | OFF)] [-doubleHop (ENABLED | DISABLED)]
  ```

- Set the VPN parameters.
  ```bash
  set vpn parameter [backendServerSni (ENABLED | DISABLED)] [backendCertValidation (ENABLED | DISABLED)]
  ```

- Add an SSL certificate-key pair.
  ```bash
  add ssl certKey ca_cert_verify -cert <certificate name>
  ```

- Bind the SSL certificate-key pair globally.
  ```bash
  bind vpn global -cacert ca_cert_verify
  ```

**Example:**

```bash
1 - add vpn vserver ssl_lan_proxy SSL 65.219.17.34 443 -authentication OFF - doubleHop ENABLED
2
3 - set vpn parameter backendServerSni ENABLED backendCertValidation ENABLED
4
5 - add ssl certKey dnpg_ca -cert dnpg_ca_cert.cer
6
7 - bind vpn global -cacert dnpg_ca
```

**Configure Citrix Gateway for ICA Proxy**

For details on configuring Citrix Gateway for ICA Proxy, see
**Note:** For SSL support on Citrix ADC LAN proxy, no changes are required in the Citrix Gateway configuration.

## Integrate Citrix Gateway with Citrix Virtual Apps and Desktops

September 10, 2019

StoreFront servers are deployed and configured to manage access to published resources and data. For remote access, adding Citrix Gateway in front of StoreFront is recommended.

**Note:**
For detailed configuration steps on how to integrate Citrix Virtual Apps and Desktops with Citrix Gateway, see the [StoreFront documentation](#).  

The following diagram illustrates an example of a Citrix simplified Citrix deployment that includes Citrix Gateway. Citrix Gateway communicates with StoreFront to protect apps and data delivered by Citrix Virtual Apps and Desktops. The user devices run Citrix Workspace app to create a secure connection and access their apps, desktops, and files.

![Citrix Gateway Diagram](image)

### Native OTP support for authentication

February 12, 2020

Citrix Gateway supports one-time passwords (OTPs) without having to use a third-party server. One-time password is a highly secure option for authenticating to secure servers as the number or passcode generated is random. Previously, OTPs are offered by specialized firms, such as RSA with specific
Citrix Gateway 13.0

devices that generate random numbers. This system must be in constant communication with client
to generate a number expected by the server.

In addition to reducing capital and operating expenses, this feature enhances the administrator’s con-
trol by keeping the entire configuration on the Citrix ADC appliance.

Note
Since third-party servers are no longer needed, the Citrix ADC administrator has to configure an
interface to manage and validate user devices.

User must be registered with a Citrix Gateway virtual server to use the OTP solution. Registration is
required only once per unique device, and can be restricted to certain environments. Configuring and
validation of a registered user is similar to configuring an extra authentication policy.

Advantages of having Native OTP support

• Reduces operating cost by eliminating the need to have an extra infrastructure on an authenti-
cating server in addition to the Active Directory.
• Consolidates configuration only to Citrix ADC appliance thus offering great control to adminis-
trators.
• Eliminates client’s dependence on an extra authentication server for generating a number ex-
pected by clients.

Native OTP workflow

The native OTP solution is a two-fold process and the workflow is classified as following:

• Device registration
• End user login

Important
You can skip the registration process if you are using third-party solutions or managing other
devices apart from Citrix ADC appliance. The final string that you add must be in the Citrix ADC
specified format.

The following figure depicts the device registration flow to register a new device to receive OTP.
The device registration can be done using any number of factors. The single factor (as specified in the previous figure) is used as an example to explain the device registration process.

The following figure depicts the verification of OTP through the registered device.

Prerequisites

To use the native OTP feature, make sure the following prerequisites are met.

- Citrix ADC feature release version is 12.0 build 51.24 and later.
- Advanced or Premium edition license is installed on Citrix Gateway.
- Citrix Gateway is configured with management IP and the management console is accessible both using a browser and command line.
- Citrix ADC is configured with authentication, authorization, and auditing virtual server to authenticate users.
- Citrix ADC appliance is configured with Unified Gateway and the authentication, authorization, and auditing profile is assigned to the Gateway virtual server.
- Native OTP solution is restricted to nFactor authentication flow. Advanced policies are required to configure the solution. For more details, see article CTX222713.

Also ensure the following for Active Directory:

- A minimum attribute length of 256 characters.
- Attribute type must be ‘DirectoryString’ such as UserParameters. These attributes can hold string values.
- Attribute string type must be Unicode, if device name is in non-English characters.
• Citrix ADC LDAP administrator must have write access to the selected AD attribute.
• Citrix ADC appliance and client machine must be synced to a common Network Time Server.

Configure Native OTP using the GUI

The native OTP registration is not just a single factor authentication. The following sections help you to configure the single and second factor authentication.

Create Login Schema for first factor

2. Go to Profiles and click Add.
3. On the Create Authentication Login Schema page, enter lschema_first_factor under Name field and click Edit next to noschema.
4. Click the LoginSchema folder.
5. Scroll down to select SingleAuth.xml and click Select.
6. Click Create.
7. Click Policies and Click Add.
8. On the Create Authentication Login Schema Policy screen, enter the following values.
   - Name: lschema_first_factor
   - Profile: select lschema_first_factor from the list.
   - Rule: HTTP.REQ.COOKIE.VALUE(“NSC_TASS”).EQ(“manageotp”)

Configure authentication, authorization, and auditing virtual server

1. Navigate to Security > AAA – Application Traffic > Authentication Virtual Servers. Click to edit the existing virtual server.
2. Click the + icon next to Login Schemas under Advanced Settings in the right pane.
4. Click the arrow and select the lschema_first_factor Policy.
5. Select the lschema_first_factor policy and Click Select.
6. Click Bind.
7. Scroll up and select 1 Authentication Policy under Advanced Authentication Policy.
8. Right-click the nFactor Policy and select Edit Binding.
9. Click the + icon present under Select Next Factor, create a Next Factor, and click Bind.
10. On the Create Authentication PolicyLabel screen, enter the following, and click Continue:
    - Name: OTP_manage_factor
    - Login Schema: Lschema_Int
11. On the Authentication PolicyLabel screen, click the + icon to create a Policy.
12. On the Create Authentication Policy screen, enter the following:
    - Name: otp_manage_ldap
13. Select the Action type using the ActionType list.
14. In the Action field, click the + icon to create an Action.
15. In the Create Authentication LDAP server page, select Server IP radio button, deselect the check box next to Authentication, enter the following values, and select Test Connection.
    - Name: LDAP_no_auth
    - IP Address: 192.168.10.11
    - Base DN: DC=training, DC=lab
    - Administrator: Administrator@training.lab
    - Password: xxxxx
16. Scroll down to the Other Settings section. Use the drop-down menu to select the following options.
    - Server Logon Name Attribute as New and type userprincipalname.
17. Use the drop-down menu to select SSO Name Attribute as New and type userprincipalname.
18. Enter “UserParameters” in the OTP Secret field and click More.
19. Enter the following Attributes.
    - Attribute 1 = mail
    - Attribute 2 = objectGUID
    - Attribute 3 = immutableID
20. Click OK.
21. On the Create Authentication Policy page, set the Expression to true and click Create.
22. On the Create Authentication PolicyLabel page, click Bind, and click Done.
24. On the **Authentication policy** page, click **Close** and click **Done**.

**Note**

The authentication virtual server must be bound to RFWebUI portal theme. Bind a server certificate to the server. The server IP ‘1.2.3.5’ must have a corresponding FQDN that is, otpauth.server.com, for later use.

**Create login schema for second factor OTP**

1. Navigate to **Security > AAA-Application Traffic > Virtual Servers**. Select the virtual server to be edited.
2. Scroll down and select **1 Login Schema**.
3. Click **Add Binding**.
4. Under **Policy Binding** section, click the + icon to add a policy.
5. On the **Create Authentication Login Schema Policy** page, enter Name as OTP, and click the + icon to create a profile.
6. On the **Create Authentication Login Schema** page, enter Name as OTP, and click the icon next to noschema.
7. Click the **LoginSchema** folder, select **DualAuth.xml**, and then click **Select**.
8. Click **Create**.
9. In the **Rule** section, enter **True**. Click **Create**.
10. Click **Bind**.
11. Notice the two factors of authentication. Click **Close** and click **Done**.

**Configure content switching policy for manage OTP**

The following configurations are required if you are using Unified Gateway.

1. Navigate to **Traffic Management > Content Switching > Policies**. Select the content switching policy, right click, and select **Edit**.
2. Edit the expression to evaluate the following OR statement and click **OK**:

   ```plaintext
   is_vpn_url HTTP.REQ.URL.CONTAINS("manageotp")
   ```

**Configure Native OTP using the CLI**

You must have the following information to configure the OTP device management page:

- IP assigned to authentication virtual server
To configure the OTP device registration and management page

Create authentication virtual server

1
2
3

Note

The authentication virtual server must be bound to RFWebUI portal theme. You must bind a server certificate to the server. The server IP ‘1.2.3.5’ must have a corresponding FQDN that is, otpauth.server.com, for later use.

To create LDAP logon action

add authentication ldapAction <LDAP ACTION NAME> -serverIP <SERVER IP> -serverPort <SERVER PORT> -ldapBase <BASE> -ldapBindDn <AD USER> -ldapBindDnPassword <PASSWO> -ldapLoginName <USER FORMAT>

Example:

1

To add authentication policy for LDAP Logon

add authentication Policy auth_pol_ldap_logon -rule true -action ldap_logon_action

To present UI via LoginSchema

Show user name field and password field to users upon logon
Display device registration and management page

Citrix recommends two ways of displaying the device registration and management screen: URL or host name.

- **Using URL**
  
  When the URL contains ‘/manageotp’
  
  ```
  add authentication loginSchema lschema_single_auth_manage_otp -
  authenticationSchema "#/nsconfig/loginschema/LoginSchema/
  SingleAuthManageOTP.xml"
  
  rule "http.req.cookie.value("NSC_TASS").contains("manageotp")"
  -
  action lschema_single_auth_manage_otp

  bind authentication vserver authvs -policy lpol_single_auth_manage_otp_by_url
  -
  priority 10 -gotoPriorityExpression END
  ```

- **Using hostname**
  
  When the host name is ‘alt.server.com’.
  
  ```
  add authentication loginSchemaPolicy lpol_single_auth_manage_otp_by_host
  -rule "http.req.header("host").eq("alt.server.com")"-action
  lschema_single_auth_manage_otp

  bind authentication vserver authvs -policy lpol_single_auth_manage_otp_by_host
  -
  priority 20 -gotoPriorityExpression END
  ```

To configure the user login page using the CLI

You must have the following information to configure the User Logon page:

- IP for a load balancing virtual server
- Corresponding FQDN for the load balancing virtual server
- Server certificate for the load balancing virtual server

**Note**

Reuse the existing authentication virtual server (authvs) for the two-factor authentication.

To create load balancing virtual server
Back-end service in load balancing is represented as follows:

```
1 > add service iis_backendsso_server_com 1.2.3.210 HTTP 80
2 > bind lb vserver lbvs_https iis_backendsso_server_com
```

To create OTP passcode validation action

```
add authentication ldapAction <LDAP ACTION NAME> -serverIP <SERVER IP> -
serverPort <SERVER PORT> -ldapBase <BASE> -ldapBindDn <AD USER> -ldapBindDnPassword
<PASSWORD> -ldapLoginName <USER FORMAT> -authentication DISABLED -OTPSecret
<LDAP ATTRIBUTE>
```

Example:

```
1 add authentication ldapAction ldap_otp_action -serverIP 1.2.3.4 -
serverPort 636 -ldapBase "OU=Users,DC=server,DC=com" -ldapBindDn
administrator@ctxnsdev.com -ldapBindDnPassword PASSWORD -
ldapLoginName userprincipalname -authentication DISABLED -OTPSecret
userParameters
```

**Important**

The difference between LDAP logon and OTP action is the need to disable the authentication and introduce a new parameter “OTPSecret.” The AD attribute value must not be used.

To add authentication policy for OTP passcode validation

```
1 > add authentication Policy auth_pol_otp_validation -rule true -action
ldap_otp_action
```

To present the two-factor authentication through LoginSchema

Add the UI for two factor authentication.

```
1 > add authentication loginSchema lscheme_dual_factor -
authenticationSchema ”/nsconfig/loginschema/LoginSchema/DualAuth.xml”
```
To create passcode validation factor via policy label

Create a manage OTP flow policy label for next factor (first factor is LDAP logon)

```
> add authentication loginSchemaPolicy lpol_dual_factor -rule true -action lscheme_dual_factor
```

To bind the OTP policy to the policy label

```
bind authentication policylabel manage_otp_flow_label -policyName auth_pol_otp_validation -priority 10 -gotoPriorityExpression NEXT
```

To bind the UI flow

Bind the LDAP logon followed by the OTP validation with authentication virtual server.

```
> bind authentication vserver authvs -policy auth_pol_lpol_dual_factor -priority 30 -gotoPriorityExpression END
```

Register your device with Citrix ADC

1. Navigate to your Citrix ADC FQDN (first public facing IP), with a /manageotp suffix. For example, https://otpauth.server.com/manageotp Login with user credentials.
2. Click the + icon to add a device.

![Image of device registration interface]
3. Enter a device name and press **Go**. A barcode appears on screen.

4. Click **Begin Setup** and then click **Scan Barcode**.

5. Hover the device camera over the QR code. You can optionally enter the 16 digit code.

Note
The displayed QR code is valid for 3 minutes.

6. Upon successful scan, you are presented with a 6 digit time sensitive code that can be used to log in.

7. To test, click **Done** on the QR screen, then click the green check mark on the right.

8. Select your device from the drop-down menu and enter the code from Google Authenticator (must be blue, not red) and click **Go**.

9. Make sure to log out using the drop-down menu at the top right corner of the page.

**Log in to Citrix ADC using the OTP**

1. Navigate to your first public facing URL and enter your OTP from Google Authenticator to log on.

2. Authenticate to the Citrix ADC splash page.
Push notification for OTP

February 28, 2020

Citrix Gateway supports push notifications for OTP. Users do not have to manually enter the OTP received on their registered devices to log in to Citrix Gateway. Admins can configure Citrix Gateway such that login notifications are sent to users’ registered devices using push notification services. When users receive the notification, they have to simply tap Allow on the notification to log in to Citrix Gateway. When gateway receives acknowledgment from the user, it identifies source of the request, and sends response to that browser connection.

If the notification response is not received within the timeout period (30 seconds), users are redirected to the Citrix Gateway login page. The users can then enter the OTP manually or click Resend Notification to receive the notification again on the registered device.

Admins can make push notification authentication as the default authentication by using the login-schemas created for push notification.

Important: Push notification feature is available with a Citrix ADC Premium edition license.

Advantages of push notifications

- Push notifications provide a more secure multifactor authentication mechanism. Authentication to Citrix Gateway is not successful until the user approves the login attempt.
- Push notification is easy to administer and use. Users have to download and install the Citrix SSO mobile app that does not require any administrator assistance.
- Users do not have to copy or remember the code. They have to simply tap on the device to get authenticated.
- Users can register multiple devices.
How push notifications work

The push notification workflow can be classified into two categories:

- Device registration
- End user login

### Prerequisites for using push notification

- Complete the Citrix Cloud onboarding process.
  1. Create a Citrix Cloud company account or join an existing one. For detailed processes and instructions on how to proceed, see Signing Up for Citrix Cloud.
  2. Log in to [https://citrix.cloud.com](https://citrix.cloud.com), and select the customer.
  3. From Menu, select Identity and access Management and then navigate to API Access tab to create a client for the customer.
  4. Copy the ID, secret, and customer ID. The ID and secret are required to configure push service in Citrix ADC as “ClientId” and “ClientSecret” respectively.

**Important:**

- Same API credentials can be used on multiple data centers.
- On premises Citrix ADC appliances must be able to resolve server addresses mfa.cloud.com and trust.citrixworkspacesapi.net and are accessible from the appliance. This is to ensure that there are no firewalls or IP address blocks for these servers over port 443.
Download the Citrix SSO mobile app from App Store and Play Store for iOS devices and Android devices respectively. Push notification is supported on iOS from build 1.1.13 on Android from 2.3.5.

Ensure the following for the Active Directory.
- Minimum attribute length must be at least 256 characters.
- Attribute type must be ‘DirectoryString’ such as UserParameters. These attributes can hold string values.
- Attribute string type must be Unicode, if device name is in non-English characters.
- Citrix ADC LDAP administrator must have write access to the selected AD attribute.
- Citrix ADC and the client machine must be synchronized to a common Network Time Server.

Push notification configuration

The following are the high-level steps that must be completed to use the push notification functionality.

- The Citrix Gateway administrator must configure the interface to manage and validate users.
  1. Configure a push service.
  2. Configure Citrix Gateway for OTP management and end user login.

     Users must register their devices with gateway for logging in to Citrix Gateway.
  3. Register your device with Citrix Gateway.
  4. Log in to Citrix Gateway.

Create a push service

2. In Name, enter the name of the push service.
3. In Client ID, enter the unique identity of the relying party for communicating with Citrix Push server in cloud.
4. In Client Secret, enter the unique secret of the relying party for communicating with Citrix Push server in cloud.
5. In Customer ID, enter the customer ID or name of the account in cloud that is used to create Client ID and Client Secret pair.
Configure Citrix Gateway for OTP management and end user login

Complete the following steps for OTP management and end user login.

- Create login schema for OTP management
- Configure authentication, authorization, and auditing virtual server
- Configure VPN or load balancing virtual servers
- Configure policy label
- Create login schema for end user login

For details on configuration, see Native OTP support.

Important: For push notification, admins must explicitly configure the following:

- Create a push service.
- While creating login schema for OTP management, select the SingleAuthManageOTP.xml login schema or equivalent as per the need.
- While creating login schema for end user login, select the DualAuthOrPush.xml login schema or equivalent as per the need.

Register your device with Citrix Gateway

Users must register their devices with Citrix Gateway to use the push notification functionality.

1. In your web browser, browse to your Citrix Gateway FQDN, and suffix /manageotp to the FQDN.
   This loads the authentication page.
   Example: https://gateway.company.com/manageotp

2. Log in using your LDAP credentials or appropriate two-factor authentication mechanisms, as required.
3. Click **Add Device**.

4. Enter a name for your device, then click **Go**.

   A QR code is displayed on the Citrix Gateway browser page.

5. Scan this QR code using the Citrix SSO app from the device to be registered.

   Citrix SSO validates the QR code and then registers with gateway for push notifications. If there are no errors in the registration process, the token is successfully added to the password tokens page.
6. If there are no additional devices to add/manage log out using the list at the top right corner of the page.

**Test one-time password authentication**

1. To test the OTP, click your device from the list and then click **Test**.
2. Enter the OTP that you have received on your device and click **Go**.
   
   The OTP verification successful message appears.
3. Log out using the list at the top right corner of the page.

**Note:** You can use the OTP management portal anytime to test authentication, remove registered devices, or register more devices.

**Log in to Citrix Gateway**

After registering their devices with Citrix Gateway, users can use the push notification functionality for authentication.

1. Navigate to your Citrix Gateway authentication page (for example: [https://gateway.company.com](https://gateway.company.com))

   You are prompted to enter only your LDAP credentials depending on the loginschema configuration.
2. Enter your LDAP user name and password, then select **Submit**.

A notification is sent to your registered device.

**Note:** If you want to enter the OTP manually, you must select **Click to input OTP manually** and enter the OTP in the **TOTP** field.

3. Open the Citrix SSO app on your registered device and tap **Allow**.
Citrix SSO

VPN Connections  Password Tokens

4

Citrix Gateway Logon
Tap Allow to send a logon request to

Cancel  Allow
Note:

- The authentication server waits for push server notification response until the configured timeout period expires. After the timeout, Citrix Gateway displays the login page. The users can then enter the OTP manually or click **Resend Notification** to receive the notification again on the registered device. Based on your selected option, gateway validates the OTP that you have entered or resends the notification on your registered device.

- No notification is sent to your registered device regarding login failure.

**Failure conditions**

- The device registration might fail in the following cases.
  - Server certificate might not be trusted by end-user device.
  - Citrix Gateway used to register for OTP is not reachable by client.
- The notifications might fail in the following cases.
  - User device is not connected to the internet
  - Notifications on the user device are blocked
  - User does not approve the notification on the device

In these cases, the authentication server waits until the configured timeout period expires. After the timeout, the Citrix Gateway displays a login page with the options to manually enter the OTP or to resend the notification again on your registered device. Based on the selected option, further validation occurs.
Citrix SSO app behavior on iOS – points to note

Notification shortcuts

Citrix SSO iOS app includes support for actionable notifications to enhance user experience. Once a notification is received on an iOS device, and if the device is locked or the Citrix SSO app is not in foreground, users can use the shortcuts built into the notification to either approve or deny login request.

To access notification shortcuts, users need to either force touch (3D touch) or long press the notification depending on the device’s hardware. Selecting the Allow shortcut action sends a login request to Citrix ADC. Depending on how the authentication policy is configured on the authentication, authorization, and auditing virtual server;

- The login request might be sent in the background without any need to launch the app into foreground or unlock the device.
- The app might prompt for Touch-ID/Face-ID/Passcode as an extra factor in which case the app is launched into foreground.
Deleting password tokens from Citrix SSO

1. To delete a password token registered for push in the Citrix SSO app, users must perform the following steps:

2. Unregister (remove) the iOS/Android device on gateway. QR code for removing registration from device appears.

3. Open the Citrix SSO app and tap the info button of the password token to be deleted.

4. Tap Delete Token and scan the QR code.

Note:

- If the QR code is valid, the token is successfully removed from the Citrix SSO app.
- Users can tap Force Delete to delete a password token without having to scan the QR code if the device is already removed from gateway. Force deleting might result in the device continuing to receive notifications if the device has not been removed from Citrix Gateway.

Configuring Server Name Indication Extension

April 23, 2019

A Citrix Gateway appliance can now be configured to include a server name indication (SNI) extension in the SSL “client hello” packet sent to the backend server. The SNI extension helps the backend server identify the FQDN being requested during the SSL handshake and respond with the respective certificates.
Citrix Gateway 13.0

**Note**
Enable SNI support when multiple SSL domains are hosted on same server.

*To configure Citrix Gateway to support SNI using GUI:*

1. In the NetScaler GUI, navigate to Configuration> Citrix NetScaler> Global Settings.
2. Click the Change Global Settings link and from the Backend Server SNI drop-down, select Enabled.

*To configure Citrix Gateway to support SNI using command line interface, at the command prompt, type:*

```bash
set vpn parameter backendServerSni <ENABLED><DISABLED>
```

Validating the Server Certificate During an SSL Handshake

April 23, 2019

The Citrix Gateway appliance can now be configured to validate the server certificate provided by the back-end server during an SSL handshake.

To configure Citrix Gateway global parameters to support PAC for outbound proxy by using the configuration utility

**Bind the CA certificate**

1. Navigate to Configuration > Citrix Gateway > Citrix Gateway Policy Manager > Certificate Bindings.
2. On the Certificate Bindings screen, click the + icon.
3. On the CA Certificate(s) Binding screen, click Add Binding and click Install.
4. Select the certificate file name in the Certificate File Name field and click Install.
5. On the CA Certificate(s) Binding screen, select the certificate and click Bind.
6. Click Done.

**Enabling the certificate validation:**

1. Navigate to Citrix Gateway> Global settings.
2. Click Change Global Settings.
3. Select Enabled from the Backend Server Certificate Validation drop-down menu and click OK.

To configure Citrix Gateway global parameters to support server certificate with the command line

At the command prompt, type the following commands:
Classic Policy Engine (PE) and Advance Policy Infrastructure (PI) are two different policy-configuration-and-evaluation frameworks that Citrix ADC currently supports.

Advance Policy Infrastructure consists of extremely powerful expression language. The expression language can be used to define Rules in Policy, define various parts of Action, and other entities supported. The expression language can parse through any part of the request or response and also enables you to look deeply through the headers and payload. The same expression language expands and works through every logical module Citrix ADC supports.

**Note:**
You are encouraged to use advanced policies for creating policies.

### Why Migrate from Classic Policy to Advance Policy?

Advanced Policy has a rich expression set and offers much greater flexibility than Classic Policy. As Citrix ADC scales and caters to vast variety of clients, it is imperative to support expressions which vastly exceed the Advanced Policies. For more information, see Policies and Expressions.

Following are the added capabilities for Advance Policy.

- Ability to access the body of the messages.
- Supports many additional protocols.
- Accesses many additional features of the system.
- Has more number of basic functions, operators, and data types.
- Caters to the parsing of HTML, JSON, and XML files.
- Facilitates fast parallel multi-string matching (patsets, etc.).

Now the following VPN policies can be configured using Advance Policy.

- Session Policy
- Authorization Policy
- Traffic Policy
- Tunnel Policy
Audit Policy

Also, End Point Analysis (EPA) can be configured as an nFactor for authentication feature. EPA is used as a gatekeeper for endpoint devices trying to connect to the Gateway appliance. Before the Gateway logon page is displayed on an endpoint device, the device is checked for minimum hardware and software requirements, depending on the eligibility criteria configured by Gateway administrator. The access to Gateway is granted based on the outcome of the performed checks. Previously EPA was configured as part of session policy. Now it can be linked to nFactor providing more flexibility, as to when it can be performed. For more information on EPA, see How endpoint policies work topic. For more on nFactor, see nFactor authentication topic.

Use Cases:

Pre-authentication EPA using Advanced EPA

Pre-authentication EPA scan happens before user provides the logon credentials. For information on configuring Citrix Gateway for nFactor authentication with pre-authentication EPA scan as one of the authentication factors, see CTX224268 topic.

Post-auth EPA using Advanced EPA

Post-authentication EPA scan happens after user credentials are verified. Under classic policy infrastructure, post authentication EPA was configured as part of the session policy or session action. Under Advanced policy infrastructure, EPA scan is to be configured as EPA factor in n-factor authentication. For information on configuring Citrix Gateway for n-factor authentication with post-authentication EPA scan as one of the authentication factors, see CTX224303 topic.

Pre-authentication and post-authentication EPA using Advanced policies

EPA can be performed before authentication and post authentication. For information on configuring Citrix Gateway for nFactor authentication with pre-authentication and post-authentication EPA scans, see CTX231362 topic.

Periodic EPA scan as a factor in nFactor authentication

Under Classic policy infrastructure, periodic-EPA scan was configured as part of session policy action. Under advanced policy infrastructure, it can be configured as part of EPA factor in n-factor authentication.

For more information on configuring Periodic EPA scan as a factor in nFactor authentication, click CTX231361 topic.
**Troubleshooting:**

The following points are to be kept in mind for troubleshooting.

- Classic and Advance policies of the same type (for example, Session policy) cannot be bound to the same entity/bind point.
- Priority is mandatory for all of the PI policies.
- Advance Policy for VPN can be bound to all bind points.
- Advance Policy with same priority can be bound to a single bind point.
- If none of the configured authorization policies get hit then the global authorization action configured in VPN parameter is applied.
- In authorization policy, the authorization action is not reversed if the authorization rule fails.

**Commonly used Advanced Policy equivalent expressions for Classic Policy:**

<table>
<thead>
<tr>
<th>Classic Policy expressions</th>
<th>Advance Policy expressions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ns_true</td>
<td>true</td>
</tr>
<tr>
<td>ns_false</td>
<td>false</td>
</tr>
<tr>
<td>REQ.HTTP</td>
<td>HTTP.REQ</td>
</tr>
<tr>
<td>RES.HTTP</td>
<td>HTTP.RES</td>
</tr>
<tr>
<td>HEADER “foo”</td>
<td>HEADER(“foo”)</td>
</tr>
<tr>
<td>CONTAINS &quot;bar&quot;</td>
<td>.CONTAINS(“bar”) [Note use of “.”]</td>
</tr>
<tr>
<td>REQ.IP</td>
<td>CLIENT.IP</td>
</tr>
<tr>
<td>RES.IP</td>
<td>SERVER.IP</td>
</tr>
<tr>
<td>SOURCEIP</td>
<td>SRC</td>
</tr>
<tr>
<td>DESTIP</td>
<td>DST</td>
</tr>
<tr>
<td>REQ.TCP</td>
<td>CLIENT.TCP</td>
</tr>
<tr>
<td>RES.TCP</td>
<td>SERVER.TCP</td>
</tr>
<tr>
<td>SOURCEPORT</td>
<td>SRCPORT</td>
</tr>
<tr>
<td>DESTPORT</td>
<td>DSTPORT</td>
</tr>
<tr>
<td>STATUSCODE</td>
<td>STATUS</td>
</tr>
<tr>
<td>REQ.SSL.CLIENT.CERT</td>
<td>CLIENT.SSL.CLIENT_CERT</td>
</tr>
</tbody>
</table>
Simplified SaaS app configuration using a template

April 23, 2019

SaaS apps configuration with single sign-on on Citrix Gateway is simplified by provisioning a template drop-down menu for popular SaaS apps. The SaaS app to be configured can be selected from the menu. The template pre-fills much of the information required for configuring applications. However, the information specific to the customer must still be provided.

Note: The following section has the steps to be performed on Citrix Gateway for configuring and publishing an app using template. The configuration steps to be performed on the app server is presented in the subsequent section.

Configuring and publishing apps using template - Citrix Gateway specific configuration

The following configuration takes the AWS Console app as an example to configure and publish an app using template.

Before you start, you need the following:
- Admin account for AWS Console
- Admin account for Citrix Gateway

The AWS Console configuration steps are as follows:
1. Configure AWS Console with the App catalogue.
2. Export AWS Console IdP metadata from Citrix ADC.
3. Configure IdP into AWS Console.

STEP 1: Configure AWS Console with App Catalogue

1. Click on Unified Gateway > Authentication.

The Unified Gateway Configuration screen appear.

2. On the Applications section, click on the edit icon. Now, click on the plus icon. The Application window appears.
3. Select **SaaS** from the Application type.

4. Select **AWS Console** from the drop-down list.

5. Fill the application template with appropriate values.
6. Enter the following SAML configuration details and click **Continue**.

   **Service Provider ID** – https://signin.aws.amazon.com/saml
   
   **Signing Certificate Name** – IdP certificate needs to be selected
   
   **Issuer Name** – Issuer name can be filled as per your choice
   
   **Attribute1** – [Role ARN, IdP ARN](https://aws.amazon.com/SAML/Attributes/Role)

7. Click **Done**.
**STEP 2:** Export AWS Console IdP metadata from Citrix Gateway.

1. Click on **Unified Gateway > Authentication**.

2. Scroll down and click on **AWS Console** template. The SaaS Application window appears. Click on **Export** link.

3. **Metadata** opens in a different window. Save the **IdP Metadata** file.

**STEP 3:** Configure IdP into AWS Console.

**Configuring and publishing apps using template - App server specific configuration**

Following are the links for pdf that has guidance on app server specific configuration for configuring and publishing popular SaaS apps using template.

- 15Five
- Absorb
- Accompa
- Adobe Captivate Prime
- Adobe Creative Cloud
- Aha
- Alertops
- Allocadia
- Ariba
- Assembla
- AWS Console
- BambooHR
- Base CRM
- BitaBIZ
- Bluejeans
- Blissbook
- Bonusly
- Box
- Bugsnag
- Buildkite
- CakeHR
- Cardboard
- Cedexis
- Celoxis
- Cisco Meraki
- ClearSlide
- CloudCheckr
- ConceptShare
- Concur
- Confluence
- Contactzilla
- Convo
• Citrix Gateway 13.0

  • Criconus
  • Dashlane
  • Datadog
  • Deskpro
  • Deputy
  • DigiCert
  • Docusign
  • Domo
  • Dropbox
  • Duo
  • efront
  • Ekarda
  • Envoy
  • ERP
  • Expensify
  • EZOfficeInventory
  • EZRentOut
  • Favro
  • Federated Directory
  • Feedly
  • Fivetran
  • Flatter Files
  • Flowdock
  • Freshdesk
  • Front
  • G-Suite
  • GitHub
  • GlassFrog
  • GotoMeeting
- Happyfox
- Helpjuice
- Help Scout
- Hoshinplan
- Humanity
- Igloo
- Illumio
- Image Relay
- iMeet Central
- InteractGo
- iQualify One
- Jira
- Kanban Tool
- Keeper Security
- Kentik
- Kentik
- Kissflow
- KnowBe4
- KnowledgeOwl
- Kudos
- LaunchDarkly
- Lifesize
- Litmos
- LiquidPlanner
- LogDNA
- Mango
- Manuscript
- Marketo
- Mingle
• Mixpanel
• MuleSoft
• MyWebTimesheets
• New Relic
• Nmbrs
• Nuclino
• Office365
• OneDesk
• OpsGenie
• Orginio
• Pagerduty
• Panorama9
• ParkMyCloud
• Peakon
• People HR
• Pingboard
• Pipedrive
• PlanMyLeave
• PlayVox
• Podio
• ProdPad
• Proto.io
• Proxyclick
• PurelyHR
• Quandora
• Rackspace
• RealtimeBoard
• Remedyforce
• Robin
• Rollbar
• Salesforce
• Samanage
• Samepage
• Sentry
• ServiceDesk Plus
• ServiceNow
• Shufflr
• Skeddy
• Skills Base
• Slack
• Slemma
• Sli.do
• Smartsheet
• Spoke
• Spotinst
• SproutVideo
• StatusCast
• Status Hero
• Statushub
• Statuspage
• Sumologic
• Supermood
• Syncplicity
• Tableau
• Targetprocess
• Teamphoria
• Testable
• TestFairy
• TextExpander
• TextMagic
• ThousandEyes
• Thycotic Secret server
• Tinfoil Security
• Trisotech
• Trumba
• TwentyThree
• Unifi
• UserEcho
• UserVoice
• Velpic
• VictorOps
• Vidizmo
• Visual Paradigm
• Weekdone
• Wepow
• When I Work
• Workday
• Workpath
• Workplace
• Workstars
• Workteam
• XaitPorter
• Ximble
• XMatters
• Yodeck
• Zendesk
• Zivver
Device Certificate in nFactor as an EPA component

September 11, 2019

Device Certificate can be configured in nFactor as an EPA component. Device certificate can appear as any factor as a part of EPA.

Following are the benefits of configuring Device Certificate in nFactor as an EPA component.

- The failure in device certificate validation does not result in a logon failure. Based on the configuration, the logon can proceed and the user can be placed under groups with limited access.
- Since the Device Certificate check is policy driven, you can selectively allow or block access of your corporate intranet resources based on Device Certificate authentication. For example, Device Certificate authentication can be used to provide conditional access to Office 365 application only on the corporate managed laptops.

Device certificate validation cannot be a part of a periodic EPA scan.

**Important:** By default, Windows mandates admin privileges for accessing device certificates. To add device certificate check for non-admin users, you must install VPN plug-in of the same version as the EPA plug-on on the device.

Configure Device Certificate in nFactor as an EPA component

**To configure Device Certificate in nFactor as an EPA component using the command line interface, at the command prompt, type:**

```
1 add authentication epaAction epa-act -cseceptr sys.client_expr("device-cert_0_0") -defaultgroup epa_pass -quarantine_group epa_fail
```

**To configure Device Certificate in nFactor as an EPA component for VPN virtual server using the Citrix ADC GUI:**

1. In the NetScaler GUI, navigate to **Configuration> Citrix Gateway>Virtual Servers.**
2. On the **Citrix Gateway Virtual Servers** page, select the Virtual server to be modified and click **Edit.**
3. On the **VPN Virtual Server** page, click on the Edit icon.

4. Click **More**.

5. Click **Add** next to the CA for Device Certificate section and click **OK**.

   Do not select the Enable Device Certificate check box. Enabling it enables the Device Certificate validation in the classic EPA.

6. In the NetScaler GUI, navigate to **Configuration > Security > AAA – Application Traffic > Policies > Authentication > Advanced Policies > Actions > EPA**.
7. On the **Authentication EPA Action** page, click **Add**. You can click **Edit** to edit an existing EPA action.

8. On the **Create Authentication EPA Action** page, provide the values for the required fields to create an authentication EPA action, and click the **EPA Editor** link.

9. Select **Common** from the **Expression Editor** list.

![Expression Editor](image)

10. Select **Device Certificate** from the subsequent list that appears and click **Done** to complete the configuration.

![Expression Editor](image)

To configure Device Certificate in nFactor as an EPA component for AAA virtual server using the Citrix ADC GUI:

1. In the Citrix DC GUI, navigate to **Security> AAA-Application Traffic>Virtual Servers**.

2. On the **Citrix Gateway Virtual Servers** page, select the Virtual server to be modified and click **Edit**.
3. On the Authentication Virtual Server page, click the Edit icon.

4. Click More.

5. Click Add next to the CA for Device Certificate section.

6. Select the certificate to be added and click OK to complete the configuration.

7. Repeat step 6 to step 10 listed in the previous section to complete the configuration.
Locations
Corporate Headquarters | 851 Cypress Creek Road Fort Lauderdale, FL 33309, United States
Silicon Valley | 4988 Great America Parkway Santa Clara, CA 95054, United States

© 2020 Citrix Systems, Inc. All rights reserved. Citrix, the Citrix logo, and other marks appearing herein are property of Citrix Systems, Inc. and/or one or more of its subsidiaries, and may be registered with the U.S. Patent and Trademark Office and in other countries. All other marks are the property of their respective owner(s).